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1. Introduction 

1.1. Definition 
ARCHLine.XP® is a Building Information Modeling (BIM) software. 
 
The NIBS (National Institutes of Building Science) defines BIM as the digital representation of physical and functional 
characteristics of a facility.  
A BIM is a shared knowledge resource for information about a facility forming a reliable basis for decisions during its life-
cycle; defined as existing from earliest conception to demolition. 
https://en.wikipedia.org/wiki/Building_information_modeling 
 
A BIM model contains information about the building or its parts as the geographical location, geometry, material 
properties and the technical elements, the phases of construction, maintenance. 
 
BIM is an intelligent design process. BIM is receiving and handling data for the efficient design and documentation of the 
project. The BIM-based design helps designers involved in the project, business co-operation. 
 
The BIM standard IFC file format contains all of the building data in relation to information collected or added, and this 
format can be used during the entire life of the building. 
The IFC format is a universal, neutral data format that is now considered as industry data exchange. 
 
ARCHLine.XP 2016 supports the IFC 2x3 standard file format, that provides 3D and data exchange between different 
CAD / BIM design software. 
 
The most valuable feature of the IFC format to preserve the architectural elements of the IFC file types and their 
properties. The wall, ceiling, etc. properties remain the same, although a few compromism may occur at the level of 
today's technology. 
THE IFC-based data exchange capacity is significantly higher than the content of the currently dominant DXF and DWG-
based data format information. 
 
"BIM oriented" design offers unique competitive advantages: more efficiency and productivity, fewer errors, less downtime, 
lower costs, greater interoperability, maximum sharing of information, a more accurate and coherent project. 

1.1.1. Introduction 

This manual provides detailed information on ARCHLine.XP® installation, basic principles and commands.  
This documentation represents all the functionality of ARCHLine.XP®. Functionality that is specific to Studio, Standard, 
Interior or other versions is marked. 
There are several tutorials that help you to increase your working knowledge. These tutorials are available on the Internet 
in downloadable PDF format from the www.archlinexp.com web site. 
 
You can also find the Training - Video Tutorials on that web site. This video series helps to learn how to use the program 
from the beginning till the advanced functions. 

1.1.2. Principles 

ARCHLine.XP® provides a very advanced designing tool for the architect and interior designer that is efficient in executing 
even the most complicated drawing tasks, and as an easy-to-use tool assists better productivity in design work from the 
early stages of a construction project through the project lifecycle to the construction documentation. The program 
facilitates planning in a highly-standard, technically correct, exigent way, supports 3D modelling, photorealistic 
visualization and does all this focusing on the architects and interior designer approach.  
 
ARCHLine.XP® stores all model information in one database, so you are able to work on floor-plans, views and sections 
even with your colleagues together. Every part of your project updates automatically, so that the plan and the 
documentation are one coherent unit through the lifecycle of it.  

1.1.3. Manual conventions 

� In the text, Menus, commands, keys, and controls will be highlighted in italic. 

� “Click the mouse" always means left-click unless otherwise stated.  
� “Double Click the mouse" always means press quickly twice the left button of the mouse.  
� SHIFT-click means when you hold down the Shift key while you click with your mouse. 
� CTRL-click means when you hold down the Ctrl key while you click with your mouse.  
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� "Drag the mouse" means click the mouse and move it while holding the button depressed. Release the mouse button 
when the desired effect has been achieved. 

� When describing keyboard operations, CTRL-key always means hold down the Ctrl key while pressing the designated 
key.  
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1.2. Installing ARCHLine.XP 

ARCHLine.XP® setup file is available via Internet download. Please follow the appropriate instructions. 

� For installation, you must have administrator privileges. 

1.2.1.  System requirements 

� Current system requirements are available on http://www.archlinexp.com/downloads/system-requirements website. 

 
To run ARCHLine.XP® or ARCHLine.XP Reader, the following software and hardware conditions are needed: 

For PC Users: 
� Microsoft Windows 64 bit versions: Windows 7 SP1 / Windows 8.1 or 10.  (Windows XP* is NOT supported and Windows 

Vista is NOT recommended.), 
� Intel Core 2 or AMD Phenom processor or better (i7 is recommended), 
� 1.5 GB available hard disk space on the installation drive and at least an additional 1.5 GB free space on the system drive 

(this is the C:\ drive in most cases), 
� Minimum 4 GB RAM, 
� Video card with DirectX 11 or DirectX 9.0c support. Suggestion: NVIDIA 6600 or higher or ATI X 600 series or higher with 

minimum 256 MB dedicated memory, 
� Integrated Intel video cards are NOT recommended, except Intel HD Graphics 2000 or better! 
� SVGA graphical visualization with 1024x768 resolution or higher, 
� 2 button, scroll-wheel mouse. 

For MAC Users: 
� Intel powered MAC, running MAC OS X v10.5.8 "Leopard" or MAC OS X v10.6.3 or later, 
� Boot Camp or Parallels Desktop 6 and later* or VMware Fusion 6 and later*, 
� Microsoft Windows operating system (Windows 7 / Windows 8.1 or Windows 10), installed on a virtual hard disk or a 

physical Boot Camp partition with all necessary drivers, 
� Minimum 4 GB RAM or more (recommended: 8 GB RAM or more), 
� At least 1.5 GB free hard disk space for the installation and running on the virtual or physical hard disk, 
� 2 button, scroll-wheel mouse, 

1.2.2.  Drivers and updates 

For the smooth running of ARCHLine.XP, always keep your device drivers and operating system updated. If necessary, 
please contact your system administrator. 

Operating system updates 
Operating system updates often include software components needed for the smooth running of currently installed 
software applications, therefore we recommend the frequent manual or automatic update of your operating system. 

Device drivers 
Please ensure the proper device drivers on your computer – if necessary, please update them from the manufacturers’ 
website. 

Video card driver update 
Video card plays main role in the proper running of ARCHLine, therefore it is highly recommended to install the latest 
available driver software. 
Before you can update the graphics driver, you need to know what kind of graphics card you have. For more information 
about how to find out what graphics card you have in your PC, do the following. 

• Click "Start". 
• In the "Start" menu, click "Run". 
• In the "Open" box, type "dxdiag" (without the quotation marks), and then click "OK." 
• The DirectX Diagnostic Tool opens. Click the "Display" tab. 
• On the "Display" tab, information about your graphics card is shown in the "Device" section. You can see the name of 

your card, as well as how much video memory it has. 

�  If you have an installed and running ARCHLine.XP application, the main system data ara available in the Help menu – 

About dialogue – System information button. 

 
Once you know the kind of graphics card you have, visit the manufacturer's website to download the latest driver. Here are 
links for downloading drivers from the most common graphics card manufacturers: 

� NVIDIA: http://www.nvidia.com/content/drivers/drivers.asp 
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� ATI from AMD: http://ati.amd.com/support/driver.html 
� Intel: http://support.intel.com/support/graphics/ 

1.2.3. DirectX support 

ARCHLine.XP® requires DirectX 9.0c or DirectX 11. Certain functions are available only with DirectX 11 compatibility. 
DirectX is included as an important part of the Windows operating system. Most of the installed Windows operating system 
contains the appropriate version of DirectX. 

1.2.4. Installing the single user software 

Installing ARCHLine.XP is really simple and straightforward. It only takes a couple of minutes and you are ready to go. 
There is no need for any code during the installation of ARCHLine.XP. The software is installed as trial version 
automatically. 
 
You can install a 32-bit version of ARCHLine.XP on a computer running a 32-bit or 64-bit version of Windows operating 
system.   
You can install a 64-bit version of ARCHLine.XP on a computer running a 64-bit version of Windows operating system. 
See the notes on Chapter 64-bit support. 
 
If you run the ARCHLine.XP first time after install, you will be asked to use the software as Architecture or Interior Design 
version. Choose it according to your purchased version or as a focus of your interest if you use the software in trial mode. 
 
Go to the website http://www.archlinexp.com/interior/download or http://www.archlinexp.com/downloads and follow the 
instruction to download the installation set to your computer. Click the download link provided by email. When prompted, 
click "Open" or "Run" if you want to install the program immediately. The installation wizard will launch. Follow the guided 
prompts on the installation wizard. 
 
After having installed the software press the Finish button. The program can be launched from the Start menu. 

1.2.5. Install the LAN (local area network) version 

In the case of network version the user needs only one USB hard lock. Using this hard lock the defined number of 
programs can be loaded through your local network according to the contract you signed. 
Follow these steps: 
 

� Install the hard lock according to chapter Installing the hard lock on the computer that is going to be the server of 
ARCHLine.XP® program. 

� Insert the hardlock into the USB port of this computer. 
� Install the AlServer program on this computer. 
� Install one by one the ARCHLine.XP® program on the computers of your network. 

Install the AL-server 

! You need to log in as Administrator! 

• Insert ARCHLine.XP® CD-ROM into the CD reader. 
• Select the AL-server folder on the CD with the help of the explorer; double click on the Setup.exe file within the folder. 

The system starts installing the AL-server program. 
•  
• Choose the Software install option. If you want to install debug functions choose Custom option. 
• If the installation was successful click on the Start menu - Programs - Quick launch - AlserverXP icon. This is 

necessary only for the first launch. 
• Select the appropriate IP address from the appearing dialog. If there are more than one IP addresses in the table, 

contact the administrator.  
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After this the Alserver becomes activated, its icon appears on the Quick launch:  

  
 

! If LAN hardlock is not inserted in the USB port, Alserver will not be running! 

Install ARCHLine.XP®  

Follow the section 1.2.3. 
If you have finished installation and launched ARCHLine.XP® on the computers, return to the computer on which the 
Alserver program is running. 

Double click on the icon of the Quick launch:    
In the appearing dialog you can see how many ARCHLine.XP® programs are running, and on which computers. 
 

  

1.2.6. Updating and reinstalling of single user and LAN softwares 

ARCHLine.XP released versions are available as full setup downloads from the current website or automatic updates. The 
automatic updates for a specific year are available only through a currently installed and running version. As an option, 
updates can be installed by downloading and running the full setup file (full setup file includes nut just the files to be 
updated, but whe whole set of setup files). Similarily to the normal update, in that case you do not have to uninstall the 
previous installation. 
 
Updates and reinstallations do not delete or modify your own contents (settings, styles, projects, materials, groups, objects 
and profiles). A frissítések és a program eltávolítása, valamint újratelepítése nem érinti az Ön által létrehozott tartalmakat 
(például a projekteket, anyagokat, csoportokat, objektumokat és profilokat). A telepítések végeztével folytathatja a munkát. 

1.2.7. USB hardlock driver installation 

Normally you do not need to install the USB hardlock driver because the driver installation is part of the full setup process. 
 
When you install the LAN version of ARCHLine.XP or you need to install the USB hardlock driver for some other reason, 
please download the latest available driver from ARCHLine.XP website. 
In a troubleshooting process, you may need to uninstall the USB hardlock driver. The removal can be done by uninstalling 
Sentinel System Driver Installer from Programs and features or by using other removal tools available on ARCHLine.XP 
website. 
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1.3. Registration 

You can find your unique serial code inside the ARCHLine.XP package—or in a confirmation e-mail if you purchased and 
downloaded ARCHLine.XP online.  
 
You have 30 days after installing ARCHLine.XP to register your serial code. If this 30-day period expires before you 
complete registration, some ARCHLine.XP features will stop working until you enter your serial code (demo mode). 
 
To registrate the software, open the dialog by clicking the Help menu, and then clicking „Buy now...” Type your 
ARCHLine.XP serial code. Click Ok, and then follow the instructions. ARCHLine.XP must be restarted in order to complete 
the process. 

1.4. Activation 
You have to activate ARCHLine.XP once or periodically according to your Perpetual or Subscription financial model. To 
activate the software, open the dialog by clicking the Help menu, and then clicking „Activate Product”.  
Activation requires an Internet connection to connect to the ARCHLine.XP web server on the Internet. 
If you have Internet connection you can select the Activation via Internet option and then follow the instructions. 
 
Attention! The Serial code is NOT the same as Activation code! 
 
If you have no Internet connection select the Activation via e-mail option, or call the phone number below the button. 
Type your ARCHLine.XP activation code obtained from your provider. Click Ok, and then follow the instructions.  
 
If you have no connection then you can choose the option to activate by telephone. 

Frequently Asked Questions 

Is product activation the same as registration? 
 
No. They are different procedures, but linked to each other. Registration is a separate process where you registrate your 
unique serial code which prevents unauthorized use of your license by another person.The activation verifies that your 
serial code is valid and the software has been activated only on eligible computers.  
 
I have entered my serial code but I cannot press the OK button to do registration. Why is the application not being 
registrated?  
 
Verify your serial code once again. The ARCHLine.XP cannot accept serial codes for 2012, 2011 or earlier releases. The 
OK button will be active only if you type the appropriate 16 digit serial code accurately. 
 
How often will the software connect to the activation server via the Internet? 
 
ARCHLine.XP connects to its activation server when it is first installed, when it is registered and activated. You can enable 
or disable Internet connection to activation server by clicking the Help menu and then clicking „Check for Updates”. If you 
have no Internet connection you have to registrate and activate manually by phone or by e-mail. 
However if you disable Internet connection you will not receive notification of important updates.  
 
Does the internet connection speed affect activation? Will dial-up access work? 
 
The amount of data transferred during activation is very small. Any stable internet connection will work. Slower 
connections such as dial-up access may take slightly longer to complete the activation steps. 
 
During activation what information is passed to the server? 
No personal information or information about your computer configuration is transferred. There is a one-way hash* of 
some machine configuration data, your serial code, and the optional email address sent to the server. If you do not provide 
the optional information (email address and registration information) then no personal information will be transferred. 
 
*One-way Hash: Codes that identify parts of the computer are put through a special function that turns the codes into a 
code number that is unique to your computer but cannot be deciphered to determine what those components are. Only 
this hash value is sent to the activation server and not the details on the computer parts. 
 
Can I move my license to another computer? 
 
Yes, this can be done easily. ARCHLine.XP's license specifically authorizes you to use the software on more than one 
computer if you are using hard lock protection. For example, you can install ARCHLine.XP's on your office computer and 
your laptop. Simply install the software on the other machine and click on the "Buy now” and later the "Activate product" 
button. You have to enter the same serial code and activation code. The software will run properly on that computer where 
you plug in the Hard lock protection 
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If you are using software protection without hard lock device you can use the software on one computer only. If you wish 
to move the software to another computer you should use the Activation via e-mail option to receive a new activation code 
valid for the computer where you move your license. Activating it on the second computer will automatically deactivate the 
license for the first computer. 
 
What is the serial code for? 
 
The serial code uniquely identifies your license. You will need the serial code if you ever need to reactivate your software 
(such as after a disk reformat and reinstall or moving the software to a new machine). The serial code will not change 
when you reactivate your software. We suggest that you write the serial code down in some permanent location. 
 
What is the email address for and is it mandatory? 
 
The email address on the activation dialog is mandatory if you choose the Activation via email button. You will be able to 
activate without email address if you choose activation via phone. Your email address will not be sold or provided to any 
third party. 
 
What if I have forgotten my serial code? 
 
During a registration the previously provided serial code is required. If the serial code has been lost and cannot be 
recovered (because an email address was not provided, or the email address is no longer valid) please contact us via our 
support form. We will be happy to reset your password. 
 
Will changes to my computer cause my application to stop working? 
 
There are no changes that will cause a permanent disabling of the software. Major changes (disk reformat being one such 
major change) will mean that you need to reactivate the software. If you have your serial code, this will be a fast and easy 
process. 
 
I wish to do an online activation but my firewall is set up to block such requests. What are the firewall settings? 
 
The following is the information that you need to setup your firewall: 
Server IP address: archlinexp.com 
Port: 80 (Standard HTTP) 
Domain: archlinexp.com 
 
 Why does ARCHLine.XP revert to demo mode? 
 
There might be several reasons:  
You forgot to register your serial code. 
You forgot to activate your license within the allowed time. 
You forgot to plug in your hard lock. 

1.5. 64-bit and multi-core processor support 

Beginning with Version 2013 release, CadLine offers both 32 and 64-bit versions of ARCHline.XP application. 
Minden leírás ezt a stílust használja. 
 

1.5.1. Why 64-bits? 

Modern software development and data processing is running up against a built-in memory limitation. 32-bit versions of 
Microsoft Windows can only allocate a maximum of 2 GB of memory to each running process, regardless how much real 
or virtual memory is available on a particular machine. It means that large projects over this limit cannot be open at all. 
 
64-bit system is not subject to the same memory limitation. Currently, the 64-bit version of Microsoft Windows 7 operating 
system supports up to 192 GB of installed memory. In practice, the maximum size of a large project is limited only by this 
huge amount of installed physical memory.  

1.5.2. Frequently Asked Questions about 64-bit Software 

Below are answers to the most frequently asked questions about 32-bit vs. 64-bit software. 
Will a 32-bit application run on a 64-bit version of Windows? 
Yes. 
Will a 64-bit application run on a 32-bit version of Windows? 
No. 
How can I tell if my system is running a 32 or 64-bit version of Windows? 
Open the Windows Control Panel, Select Icons (Windows 7), then open the System icon. The line labelled System type 
will specify either “32-bit Operating System” or “64-bit Operating System.” 
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My system is running a 64-bit version of Windows. Should I use 32-bit or 64-bit software applications? 
It depends. A 64-bit application will require more memory to open the same file than a 32-bit application, because the 
structures automatically become larger. The memory consumption grows by about 30 to 50%. If you have more memory 
the 64-bit version is recommended to install.  

1.6. What's New? 

Learn about new features and enhancements in the ARCHLine.XP 2016 release of the software. 

1.6.1. Architectural Enhancements 

Improvements for architectural features of the software: 
 

� BIM Support: ARCHLine.XP supports the IFC 2x3 standard file format, that provides 3D and data exchange between 
different CAD / BIM design software. 

� Shared Parameters: Shared Parameters allow the designer to create BIM objects. 
� Wall Framing: Wall Framing tool lets you generate timber structure for walls. 
� Arched Beams: Arched beams allow you to create structural or wood designs on vaulted ceilings or archways 
� Column and Beam with parametric recess and cut-outs: Custom profile operations provide greater control over wood 

or reinforced concrete structures. 
� Ramp with cross section profile: You can define the cross-sectional profile and later can be edited freely. 
� Curtain wall new properties– Glass, frame and mullion: the relative position of the components (a direction 

perpendicular to the wall) can be adjusted. 
� Section with crop region: The region displayed behind the section line can be adjusted. 
� Model to a photo: Align a photo of an architectural site with the 3D model. 
� Change Opening Angle for multiple Doors/Windows: Edit the opening angle for more selected openings together. 
� Balustrade: Edit node heights one by one with markers in 3D.  

1.6.2. Interior Design Enhancements 

Improvements for interior design features of the software 
 

� Recess or niche in wall:  Recess or niche is a void element hosted in the wall. Recess in wall works similar to window or 
door when you place it into the wall. 

� Recess or niche in slab:  Recess or niche is a void element hosted in the slab. 
� Tiling with predefined patterns: Herringbone, Hexagon, Four square finger and five square finger parquet. 
� Redesigned Design Center: Search field to browse by name, brands, product name and product categories. 
� New look for Showroom: The new Viewer displays and enables to select on one webpage the whole collection of 

Product types, Brands and Product families. 

1.6.3. Visual Enhancements 

Improvements for visual features of the software 
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� New, easy to use rendering module: The first-class Redway3D Render module is an integral part of the software 

(Professional version)  
� New texture quality properties for Rendering. 
� Shadow Animation in 3D views with DirectX11 graphic mode. 
� LED lights for Rendering 
� Real time mirroring and soft shadows in 3D views with DirectX11 graphic mode. 
� Bump mapping in 3D views with DirectX11 graphic mode. 

1.6.4. Documentation Enhancements 

Improvements for documentation of the software 

 
� 3D Printing support: You can export the 3D model in the .STL file format compatible with stereo lithography. 
� Project Navigator with Renderings: Render images that belong to the project are automatically integrated into the 

Project Navigator 
� Raster image selection options: Click on the clipping boundaries or click in the area 

1.6.5. Tutorials and Courses 

Check these resources that can help you learn how to use the software. 

Workshops 
The workshops are designed to give you the practical advice you need to be expert designer using ARCHLine.XP 
software. 

Courses 
Online, or In-person educational courses can help you improve your knowledge using ARCHLine.XP. 

Additional Videos 
YouTube for ARCHLine.XP provides access to more videos created by CadLine for customers. 
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2. Interface 

Once the program is loaded into memory, the ARCHLine.XP user interface will appear on the screen. 
 

 

1.7. User interface components: 

1. Application Title Displays the name of the current project. 

2. Menu bar Menu bar provides access to all ARCHLine.XP commands. Commands in the menu bar 

can be accessed through shortcuts. 

3. Quick access toolbars The Quick Access Toolbar is a system toolbar that contains a set of commands. You can 

move the Quick Access Toolbar freely on other location. 

4. Tool Palettes: It contains the Toolbox, Design Centre, Project Navigator and Properties Panel. 

5. Screen menu board: Touch-screen like menu display. 

6. Project container: List of all drawings within the current project. Click one of the objects in the list to open a 

drawing.. 

7. Input board: North, input mode and coordinate values of the cursor. 

8. Help First line information related to the current command 

9. Navigation centre Quick screen controls for zoom, pan, and rotation commands. 

10. Command line Execute a command by entering at the command line panel and pressing ENTER. When 

Dynamic Input is on you can enter command or value in a pop up window that is displayed 

over the cursor. 

11. Status bar: Collection of the most frequently used commands in ARCHLine.XP 

 
The objects 3,4,5,8,9,10 can be moved to any position, so the whole interface can be rearranged according to the 
user’s needs. 

1.8. Menus 
According to Windows standards most of the commands are available in menus. Menus can be: 
 

� Menu bar 
� Context sensitive menus 

1.8.1. Application menu 

The application menu is the main menu for an application. It provides access to most of the commands 
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File File handling 
Edit Edit drawing 
Modify Modify drawing 

View Modes of visualization 
Building Architectural design tools 
Interior  Interior design tools 
Manufacture  Create new library objects 
Drafting 2D drafting tools 
Dimension Dimension tools 
Tools Additional tools for design, customization or getting 

information,  
Plot Layout Prepare print layout 

3D Operations of 3D modeller 
Add-On Add-on modules 
Window Window operations 
Help Content of user manual in Help, Registration 

1.8.2. Recent files 

File menu displays the list of recently opened projects, the most recently used file at the top.  
 

 

1.8.3. Context sensitive menus 

If you move the cursor above an architectural or a drafting object, right click with the mouse the program displays the 
Context sensitive commands of the selected object.  
 
The shortcut menu might also appear when right clicking on the empty area, or when the program is waiting for selection.  

� Find detailed description in chapter 2.10.3. Single click with the right button. 

1.9. Toolbox 

Toolbox is a comprehensive catalog of commands using to create objects. They are arranged in groups. The content is 
corresponding with the groups in the Application Menu bar significantly. 

 
You can:  
-Drag the Toolbox.  
-Dock the Toolbox at the edge of a parent frame.  
-Pin a docked Toolbox open, or set it to hide itself. 
 
Main features: 

� The submenu displays within the main menu and remains open after the command selection. It requires less click to start 
the next command.  

� The order of command groups are changeable. 
� Search field to browse commands by name. 
� Favourites menu.  
� Optional menu for user defined command groups. 
� Mouse right click menu. 
� List or icons style. 
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� Info tooltip: Kind of on-the-spot "mini online help". It makes easier to understand the command. 

Using the Toolbox 
Toolbox is present on the screen when you activate the Window menu – Toolbar – Toolbox option. 
By default, the Toolbox is docked to the left edge of the ARCHLine.XP frame. If you wish, you can change the docking 
position. 
Toolbox displays a list of items with icons. 

 
Hiding the Toolbox 

By default, the Toolbox is always visible when docked.  If you prefer to hide it when it is not needed, click the push pin 
 in the top right corner. The Toolbox will then slide out of sight when it is not in use. 

 

• To make the Toolbox remain open  
To display the Toolbox when it is hidden, just move the cursor over the Toolbox label in the border. The Toolbox slides 
back out and remains visible as long as the cursor is over it. The push pin  now appears in  horizontal position. To keep 
the Toolbox expanded click the push pin icon in the top-right corner of the Toolbox. 
 

Moving the Toolbox to a different location 

Click on the Toolbox title and drag the Toolbox to the desired location. 
 

Docking the Toolbox 

Click on the Toolbox title and select the arrow that points toward the edge of the parent frame where you want to attach 
the Toolbox. 
 

To restore all default groups to the Toolbox, with their default position 

Click on the black gear  icon on the toolbox right corner and choose Default command 

 
Multiple expanded groups  

Multiple groups of the Toolbox can be expanded simultaneously, and the entire content is scrollable. 
To expand any group of the Toolbox, click to its name. To collapse an expanded group, click to its name again.  
 

Info Tooltip 

Info Tooltips, are those little balloons that can pop-up when you hover your mouse over a command. It provides a fast and 
easy method to display additional explanation. They're a kind of on-the-spot "mini online help". The Info Tooltip can be 
switch on and off in the Options menu. 
 

 
 

Favourites  

The Favorites list offers quick way to access frequently used commands. You can build more favourite lists for the most 
frequently used commands. 
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Use the right click on any Toolbox Items and select the Add to favourites command from its pop-up menu. Item is 
automatically added to the appropriate Favorites group on the Toolbox.  
You can add more Favourites group with different names. 
 

 
 
You can remove the items from Favourites groups but you cannot change the factory groups because they are part of the 
software installation. 

1.9.1. Toolbox settings 

Various methods are available to customize the appearance of Toolbox groups. To display the Toolbox context sensitive 

menu commands click on the black gear  icon on the toolbox right corner.  
 

 
 
It includes the commands described in the table below. 
 

Command  Description 

List view You can change view mode displaying the Toolbox contents using icons or label 

Integrated submenu Specifies that Toolbox submenu expands the group to display the submenu commands. 

Icons only Specifies that Toolbox displays commands with icons only. 

Multiple expanded groups Multiple groups can be expanded simultaneously. 

Background colour Specifies the Toolbox groups background colour 

Submenu background 

colour 

Specifies the Toolbox submenu background colour 

Headline colour Specifies the Toolbox groups headline colour 

Title colour Specifies the Toolbox groups title colour 

New favourites Creates new favourites group 

Default Restore all default groups to the Toolbox 

Tooltip enabled Info tooltip switch on/off 
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List view modes 

You can change view mode displaying the Toolbox contents using list or icons. The control has three view modes: 

 

 

 
List Icons only Icons with text 

 
The List mode displays icons with text but is always in a single column. The Icon only and Icon with text mode displays 
items in multiple columns.  

Integrated submenu 

There are two modes to manage sub menus.  
� The submenus may be integrated in the group. 
� The submenus will be displayed in a pop menu style. 

 

  
 

Integrated submenu is enabled Multiple Expanded Group is disabled  

Multiple expanded group 

Toolbox menu will automatically open the command groups when you click on it. 
You can choose to enable or disable multiple groups to be open at the same time. 
 
When Multiple Expanded Group is enabled it makes easier to find other items in the different groups, but if you see too 
many icons at the same time you may find it difficult to navigate in the groups. 
When Multiple Expanded Group is disabled only one group is allowed to be open at a given time. 
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Multiple Expanded Group is enabled Multiple Expanded Group is disabled  
 

1.10. Screen menu board 
Screen menu board is an easy to use touch-screen like menu display. 
Using the Screen menu board you can memorize the most frequently used commands, without mastering the complete 
software. 
 
The screen menu board shows categories such as Drafting, Building etc. Categories have objects within them. When a 
category is selected, the objects within that category will display. 
 
Screen menu board is an equivalent tool with the Toolbox menu used in the earlier ARCHLine.XP releases 

 

 
 
Further commands related to Screen menu board: 
Mouse right click -> Open Properties dialog of the selected object 
CTRL + Mouse left click > the command will select all of the objects with the same type in the drawing regardless of their 
properties. 
 
Components: 
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1.10.1. Control tool 

You find the control tool on the left side. Control tool enables to move, hide and show the Screen menu board. 

 

1.10.2. Menu board 

Screen menu board consists of three levels. The top level contains the main categories such as Project, Drafting, Building, 
etc. You can open and browse on the sub menus with simply moving the mouse over it or with a mouse left click. 
 
Hiding: 
Clicking on an object the related command is executed and the menu board automatically disappears. Closing the 
command the menu board comes up again. 
 
Close the menu board 
You can manage the menu board as a pop-up menu or you can switch it off if you wish to work without it. 

1.10.3. Multi-touch screen support 

ARCHLine.XP is a full feature design software that you can interact with using your fingers.  
 
To use ARCHLine.XP with multi-touch gestures, you need a tablet or a laptop with a screen that supports multi-touch or 
a desktop PC connected to a touchscreen that supports multi-touch. 
http://windows.microsoft.com/en-us/windows-8/tablets 
 
Move over mouse: When you use ARCHLine.XP with a tablet or touchscreen PC, you can browse your projects, zoom, 
pan, draw or edit - using nothing but your fingers. 
 
If you find difficult to use your fingers you can choose an alternative solution using a simple capacitive stylus. 
 
When you have multiple drawings open, switch between them by tapping on drawing pane bar. 
Need to zoom in? Place two fingers on the screen of a multi-touch tablet and spread them apart. 
To draw a wall, touch it with one finger and tap the screen with a second to place the starting and end point. 

Major User Actions -Currently supported by touch gestures 

Gesture User action Name Description 

 

 

Scale 

down 

(zoom 

out) 

pinch Touch surface with two fingers 

and bring them closer together 

 

Scale up 

(zoom in) 

 

spread Touch surface with two fingers 

and 

move them apart 

 

Pan two-

finger 

drag 

Move two fingers up, down or 

left, right across surface 
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Optimal 

view 

two-

finger 

tap 

Briefly touch surface with two 

fingers 

 

Rotate press 

and drag 

Touch surface with one finger 

and rotate second finger over 

surface without losing contact 

 

Cursor 

movement 

drag Touch surface with one finger 

and rotate second finger over 

surface without losing contact 

 

Input 

point  

press 

and tap 

Press surface with one finger and 

briefly touch surface with second 

finger   

(Valid in command mode while 

the program is waiting for input 

point) 

 

Select 

item 

tap Briefly touch surface with 

fingertip  

 

Display 

item's 

property 

dialog 

Double 

tap 

Briefly touch surface with 

fingertip  

(Equal to mouse double click) 

 

Display 
item 

context 

sensitive 

menu 

press 
and tap 

Touch first object with one finger 
and briefly touch surface with 

second finger 

(Valid in selection mode - equal 

to mouse right click) 

1.11. Design Centre  
The DC (Design Centre) is a very effective tool and integrates functions in a very compact manner. DC helps finding the 
items quickly with search function even in a large database. 
You can collect your most frequently used elements into My Favourites. 
The Design Centre integrates the Project Navigator including Project Manager, Templates and Zones.   
 
This chapter describes the interface elements you will encounter while you are using DC. 

1.11.1. Design Centre Interface 

The Design Centre (DC) graphical user interface consists of Main window, List view per Components (Building, Objects, 
Recent Models, My Favourites, Help and Project Navigator). 
 



 2. Interface 33 

 ARCHLine.XP® 

  

  

  
  

  
Main window Search results 

window 
Category  window Items list window Item property 

window 

 
Window Description 

Main window The Main window is where the DC components are displayed 

Search results window The Search results window displays the search results 

Category window The Category window displays the appropriate categories and subcategories 

Items list window The Items list window displays the items within the selected subcategory. 

Item property window Displays the principal properties of the selected item.. 

1.11.2. Activating DC components 

To open a DC component window, you can click the corresponding node in the Main window with mouse left button.  
When you activate one of these node in the Main window, the following action happens: 

 
Building, Objects The selected item’s categories are displayed in the DC. 

My Favourites or Recent 

Items 

The relevant items are displayed in the DC. Your Favourites or Recent Items are 

stored in a file on your computer, so it keeps its content even if you restart 

ARCHLine.XP. 

Brands Brands filter to search items with the selected Brands only. 

Project Navigator Project Navigator displays the project structure, sets and zones in a tree 

1.11.3. Design Centre structure 

DC comes with the ability to sort your items into categories. The selected item’s categories are displayed in the DC. The 
list displays the categories as a tree from root level to subcategories with folder icon or items with thumbnails as nodes. 

 
The GUI consists of the following components: 
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 Search bar 

The Search bar is on the top of the DC. This is the main search area, which lets you specify any specific terms you wish to 
search for. 
It consist of two controls: Search input field and Brands button. 
 
The Search Results window displays the search results after submitting a term. 
To search, just type a term in the Search input field, wait a second or click on the zoom icon on the right. ARCHLine.XP 
will take you to the search results page. 

 

 

The search results are displayed in a list. You can click a header line to activate 

the corresponding list. 

The header displays the number of hits in bracket (e.g. Materials (34)) in each 

category if the hits are greater than 3. To display all the hits in a category click on 

the header. 

 In this Example click on Objects (65) will display all the Wall hits.  

 
 

 

 
Wildcard * allow you to match single or multiple characters within words. It displays all items in the DC database. 



 2. Interface 35 

 ARCHLine.XP® 

Brands 

The Brands button displays the number of Brands available in the database.  
The filter by clicking on Brands allows you to narrow your search to only required Brands. 
 

 

 Path bar 

The path bar appears beside the home button in every DC window and displays your current location as a series of links 
separated by arrows. You can click any of them in the bar to go back to that location. 

Home button 

Clicking on Home button brings you back to the DC Main window.  

Back 

The back button appears below the home button in every list window and take you back to the previous window. 

Number of hits 

This number refers to the sum of all the items in the current window. 

 Categories  

DC allows you to sort items into categories. The main Categories are predefined and you cannot modify it.  
You can choose among the Subcategories or you can create a new Subcategory.  
You can relocate the items into another Category and another Subcategories as well. 
 
To sort in categories click on the black gear icon. 

 
 
When you relocate an item you cannot change its name. 

 Context sensitive menu commands 

Each window has its own specific menu commands. To display the commands click on the black gear icon. 
It includes the commands described in the table below. 
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Command  Description 

Multi Selection mode By default, a user can activate a single item with a click in a list window. You can 

set the Multi Selection Mode active to select multiple items simultaneously.  

New object Define new object. 

Sort in Categories Relocate the object into another category. 

Import Import a selection of DC items from an ARCHLine.XP .environment file. 

Export Export a selection of DC items to an ARCHLine.XP .environment file. 

2D / 3D You can change view mode displaying the window contents using 2D or 3D icons. 

Select All This button allows to select all items. You may need this when there are a lot of 

items to delete or export. Pressing Ctrl +A the program will select all the data in the 

window similar to how Select All works. 

Delete Delete the selected item. You can't delete the item if it is “in use”. 

1.11.4. Placement mode and selection mode 

You select an element in the DC by clicking its name or icon.  
While a single control is active, the DC is in placement mode, meaning that it is ready to place an instance of that control 
on the drawing. In this mode, clicking or dragging on the DC results an operation like placing an object or similar. 
 
To operate on multiple items simultaneously, you must be in selection mode called Multi Selection Mode. To put the DC in 
multi selection mode, click on the black gear icon where you see the DC Multiple selection mode menu (highlighted in the 
following illustration). 
 

 
 
In this mode, you can select one or more objects on the DC and export them, categorize or delete them. 
 

! You can activate the Multi Selection mode alternatively with pressing down CTRL and click on any item in the DC 

window. This action automatically activates the Multi Selection mode. 

Selection 

For actions to be performed on multiple Items at once, those items must be first selected via one of these methods:  



 2. Interface 37 

 ARCHLine.XP® 

� Select one or more Items at a time - To select a Category, the Multi Selection mode checkbox must be checked 
(clicked). It is possible to keep selecting more Categories by clicking on their respective icon or label.  

� Select all Items in DC window - All Items in a DC window can be selected by the Select All command or pressing the 
CTRL+A shortcut.  

� Reverse Selection - A Reverse Selection means checked items become unchecked, and unchecked items become 
checked. A Reverse Selection is accomplished by holding the CTRL key on the keyboard and clicking the Item. 

Actions 

Actions describe the commands to be performed when Multi Selection mode is checked. The follow describes these 
actions:  

 
 

� Delete - Deletes the currently selected DC items. 
� Export - Export the selection of DC items to an ARCHLine.XP .environment file. 

1.11.5. Using Placement mode 

By default you are working on DC in Placement mode. In this mode you can activate commands with drag and drop 
technique or select one from the DC Edit menu with a click on the black gear icon. 

Actions 

Actions describe the commands to be performed when Single Selection mode is on. The follow describes these actions:  
 

• Place with Drag and drop - Hover the mouse cursor over the item to be 
placed. Press down the mouse button then move the mouse with the left 
button down onto the drawing area and release the mouse button up. Follow 
ARCHLine.XP cursor during the placement. 

• Click on item - Click on the selected item. The DC Property window open 
automatically. 

 



38 2. Interface 

Manual 

• Settings - Open the DC Edit menu and click on Settings command. You can edit the item in its property dialog. 
• Add to favourites - Open the DC Edit menu and click on Add 

to favourites command. The item will appear in your DC My 
Favourites list window. 

• Convert to apparent material - This command is enabled 
when you are on a DC Texture window. You can convert the 
selected texture into apparent Material. 

• Categories - Open the DC Edit menu and click on Categories 
command. The program display the associated categories in a 
dialog. 

 

1.12. NaviBar 

ARCHLine.XP comes with a navigation bar on the bottom right 
side of the screen. You find here the tools to navigate on the 
work spaces with the zoom and pan commands, as well as 
rotation in 3D model.  
The NaviBar’s appearance in the 2D (2D floor plan, Printing Layout) and 3D (3D model, Section) is different.  
 
You can navigate with simple left mouse clicks or by dragging in some cases like zooming, panning or rotating. If you wish 
to zoom, pan or rotate continuously than you have to click on the appropriate command, hold down the mouse button and 
move the mouse. 

2D Navibar 

When your active view has 2D content (2D floor plan, Printing Layout), the Navibar displays one group of commands. 
 

 

3D Navibar 

When your active work space has 3D content (3D model, Section), the Navibar displays a second group of commands. 
This second group contains useful commands which facilitate setting up the view of the 3D model as 3D view, Walk, 3D 
visual styles, Shadow, Rendering and Perspective view. 

 

Move the Navibar 

You can move the navibar on any other place on the workspace that is best for you.  To move the navibar, move the 
mouse over the grip point on the right side and left click and drag it to where you want to place it and release the mouse 
button. 

Restore 

You can restore the navibar to its factory default state with a mouse right button click on the grip point. 

Close the Navibar 

To close the Navigation Wheel click on the little triangle on the bottom left corner. 
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1.12.1. Zoom 

You can zoom the drawing with this tool. It contains the following commands: 

 

Zoom in, out 

Click on the Magnifier with plus or minus sign icon to zoom in or out. 

Zoom all 

Click on the icon with four small arrows to see all the entities in the drawing. 

Zoom Window 

You are prompted to pick two corners of a box on the current window in order to enlarge that area to fill the window.  

1.12.2. Pan 

You can pan the drawing dynamically with this tool. The arrows show the pan direction. 

 

Dynamic pan 

Hold down the Hand pan button and move your mouse to use dynamic pan. 

Pan left, right 

Click on the Pan left icon to pan your drawing to the left or to the right. 

Pan upwards, downwards 

Click on the Pan upwards icon to pan your drawing upwards or downwards. 

1.12.3. Orbiting around the 3D model 

When you edit a model in 3D, you need to view it from all sides.In ARCHLine.XP you can orbit, zoom, and pan the view all 
the time. 
 
When you want to orbit the 3D model around, activate the Orbit tool that you find in the ARCHLine.XP interface: 
On a three-button mouse: Click and hold the scroll wheel. 
On a one-button mouse: Click on the Navibar central icon and you get the 2 ellipses centered in your view. The ellipses 
on the drawing area show the rotating direction. Click in and drag your cursor to continuously rotate it around.  
 
The axis icon on the left side in the navibar helps to pick a new rotation centre point. 
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Continuous Orbit. 

The Orbit tool that you find in the ARCHLine.XP interface: View > Continuous Orbit on the menu bar 
The command enables you to set the 3D view into continuous motion. 

1.12.4. View tools in 3D 

The NaviBar contains some useful commands which facilitate setting up the view of the model.  

Views 

Choose a specific, predefined view from the views list. You can also define a new rotation centre here. 

 

Walk / Fly / Rotate around / Look around 

You can choose from Walk / Fly / Rotate around / Look around modes from Walk and Fly list. With the help of these tools 
you can move around in the 3D model as you walk around in 3D space in real life. Rotate around command rotates the 3D 
model around the rotation centre with a continuous speed. Look around command rotates the camera around with a 
continuous speed. The speed of walk / fly / rotation can be set in File menu – Options – Display tab – Camera settings. 
These options can be seen when a 3D window is active. The same commands and settings are available in the View 
menu. 
 
In perspective view: 

 
 
In axonometric view: 

  

3D visual style tools 

Choose a visual style from the list. This will change the appearance of the 3D model. You can select from Wireframe to 
Consistent Color visual style. 
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Shadow and light switch 

Click on Shadow icon to turn shadows on/off and lights on/off. The shadows will be visualized based on the Sun settings. 

 

Rendering 

Click on rendering icon to start the photorealistic image preparation. 

 

Perspective view 

Click on Perspective view to set the camera in the 3D model. You will see the model in perspective through the camera.  

 

Enlarge active window 

Click on Enlarge active window to enlarge the selected active window. All inactive windows will be organized automatically 
by the software to the right side of the workspace. 
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1.13. Information bar 

ARCHLine.XP Information bar displays the actual prompt help concerning the command to be executed actually. 

 
 
By default you find it in the middle bottom part of the drawing window. It consists of 3 parts: Information button; Message 
field; Grip point. 

Information button 

You find the information button on the left side of the information bar. The information button can display two icons. 
 
Interactive Help – You can click on the button when displays the ‘i’ letter, and the program will open the interactive online 
help. 
 
Control tool info – When you move the mouse over the Drawing Pane, Coordinate bar, Navibar and Bubble menu the 
icon in the information bar changes to hand style and displays the name of the tool under the mouse actually. 

 

Message field 

ARCHLine.XP Information bar displays the actual prompt help concerning the command to be executed actually or the 
Control Tool Info. 

Move the Information bar 

You can move the information bar on any other place on the workspace that is best for you.  To move the information bar, 
move the mouse over the grip point on the right side and left click and drag it to where you want to place it and release the 
mouse button. 

 
 
The program saves the new place even when you restart it. 

Restore 

You can restore the information bar to its factory default state with a mouse right button click on the grip point. 

1.14. Coordinate bar 

 
 
The coordinate bar displays the North direction; the reference point command icon, the absolute or relative coordinate’s 
mode icon and the current cursor coordinate values. You can click on each of them to edit the relevant information.  

North 

Displays and specifies the north direction. If you click on the North icon you can change the Geographic location, the date 
and the North direction. 

Reference point 

The selected point becomes the reference point for next input. It replaces the last input point. 

Relative / absolute coordinate input 

There are two modes to enter coordinates in ARCHLine.XP: Absolute or Relative coordinates. 
Absolute coordinates uses the Cartesian System to specify a position in the X, Y to locate a point from the 0, 0 origin. 
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Relative coordinates are interpreted from the last input point. As relative coordinates much more frequently used than 
absolute, the default setting is relative. 
You find the Relative Input icon to change between absolute / relative mode on the left side. 

Display coordinate info 

The coordinate bar displays the coordinate values of the cursor in absolute or relative coordinate’s mode. 

Command input 

If you click on the coordinate info field you can type the coordinates of the point you want, like: X space Y. 
The X-value and Y-value is interpreted in the current input mode as absolute or relative coordinates 
 
Example:  
You are in absolute coordinate’s mode and in cm unit. 
If you type 20 8 for a position, ARCHLine.XP will locate the next point on 20 cm along the X-axis and 8 cm along the Y-
axis. Press ENTER to activate the input. 
 
ARCHLine.XP draws the objects in their real size. ARCHLine.XP offers the following units to input a value: mm, cm, m 
(metric) and inch (imperial). If you have 1 m length wall and your current unit is cm, then draw it as 100 cm length. 
ARCHLine.XP uses scale for plotting only. ARCHLine.XP drawing sheet is a limitless area. 

1.15. Drawing Pane 
A Drawing pane lists the drawings belonging to the project. The drawing pane contains three parts as Control bar, Drawing 
Selector and Pager. 
 

 
 
To make a drawing current, click on the image in the list. 

Control bar 

The left side control bar enables to display the workspace list, show and hide the drawing pane and resize it. 

 

Workspace list 

You can use the workspace list icon to switch between the drawings of the project too.  

 
It displays all workspace names in alphanumeric list. 

Show / Hide 

You can show / hide the Drawing Selector and Pager. 

  

Size up / down 

You can resize the Drawing Selector and Pager.  

 

Pager 

The Pager becomes visible when the number of drawings exceeds 8. Clicking on the pager the Drawing Selector displays 
the next or the previous drawing in the list. 

1.16. Options Bar  

The Options Bar bar contains conditional options that relate to the current command. 
The Options Bar is a floating bar and displays on the screen only when it is needed. 
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You can drag it anywhere on the screen with a click on the right side icon of the header. 
You can close the Options Bar list with a click on the little black triangle on the header left side. 
 

 
 

� If you do not want to execute any of the options, you do not need to choose from Options Bar. These are only options 

that you can use when necessary. 

1.17. Floating menu icon 
In ARCHLine.XP, before editing, you have to select one or more elements. Selection can be made during or before the 
execution of a command. 
At selection, the floating menu icon appears which includes the list of the most commonly used general commands and 
the element-specific commands. This latter is the same as the appearing element-specific menu when you click the 
element with right mouse button. 
The floating menu icon can be relocated bydragging, gripping it at the top. The selected element and the floating menu 
icon is connected by a dotted line between the click point and the grip point. 
This way the position of the click point becomes visible. It is very useful when the position of the click point is important. 
 
In case when there are more elements at the click for selection, a list with the selectable elements appears beside the 
floating menu icon.  

Examples: 

1. Selection, paging, relocating of floating menu icon 
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2. List of general commands and element-specific commands 

      

1.18. Command line 

You can input commands, values, texts or formulas by which you can use trigonometrically and arithmetical operators in 
two ways: 

Command line Input field 

If you click on the Command line, then you can use the Input field to take in the values.You can activate the typed value 
with the Enter button. 
 
Command line is present on the screen when you activate the Window menu – Toolbar – Command line option. 

Dynamic input field 

Dynamic input provides an alternative way to enter input values. When you are in a command and the program is waiting 
for next input, pressing any key the input field appears on the drawing area near to the cursor actual location. 
For example, displaying the value of length: 
 

 
 
You can activate the typed value with the Enter button. 

Command aliases 

Command aliases are shortcuts to commands that can be entered in the command line input field. This is a powerful tool if 
you have a good knowledge of ARCHline commands. You can see and customize the command alias list in a text file 
(Archline.pgp). This text file is accessible in Tools menu – Customize – Command alias.   
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You can find all the necessary information at the beginning of the text file in remarks (rows starting with “;” are remarks). 
For example the shortcut for line is L. When you type L then Enter will activate the line tool. 

Command history 

The list of commands you previously entered in the command line is listed in a drop-down list of the command line. 

1.19. Mouse 

ARCHLine.XP uses contemporary computer mouse, with the most common standard features: two buttons and a 
scroll wheel which can also act as a third button. 
 

1.19.1. Single click with the left button 

When clicking with the left button in ARCHLine.XP® the program executes a command. 
A command in general can be carried out with a simple click of the left mouse button in the Menu, Toolbox, and Toolbars. 
For example we can create a line with the following steps: 

� Click on the  Single line tool. 
� Click on the drawing to define the first point of the line. 
� Move the cursor to the desired endpoint of the line, and click to define it. 

! You can use the mouse with plain mouse clicks on the drawing area, not with the drag and drop method. This has many 

advantages, e.g.: 
 1. Faster work  
 2. The input of the angles and lengths are easier. 
 3. The forming of commands is easier during running because you need to keep pressing neither of the buttons of the 

mouse. 

1.19.2. Double click with the left button  

 

In ARCHLine.XP® the double click with the mouse is used 
to modify the properties of the selected object.  
The properties dialog of the selected object appears. 

The changes defined in this way have influence only on the properties of the selected object. 

1.19.3. Single click with the right button 

 

Clicking with the right button of the mouse in 
ARCHLine.XP-you can reach different functions, among 
which the most important are:  
 

� Terminating the actual command 
� Using context sensitive menus 
� Opening the Window handling menu 
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 Using shortcut menus -Right click customization 

If you select the File menu -Options command, and click on the User Interface button, you can select among the options 
regarding the right button action of the mouse. 
 

 

ENTER command 

Clicking with the right button of the mouse, the program executes the ENTER (terminating) command.  

Display Selection options 

 
When a command is waiting for selection 
press the right button of the mouse, the 
Selection menu appears with the following 
options: 
 

� These possibilities are available 

from the Selection menu of the status line 
as well. See there the description. 
 
Select the Enter command to close the. 
selection 

  

 Setting the properties of the objects 

If you right click on an icon of the drawing tools (e.g. Slab), then the properties dialog of the selected object appears. 
Having modified the properties the objects created later will have the set properties. At the same time the program opens 
the submenu of the drawing tool that makes planning quicker 

1.19.4. How to use the mouse when selecting commands from the menu 

The mouse is also used to select commands from the ARCHLine.XP® menus. We are going to demonstrate the selection 
of the different menu objects (main menu - pop menu - shortcut menu, lists). 

 Selecting an object of the menu 

To select a command or option from the menu: 
 

Click on the name of the adequate main menu (in case of pop menu or shortcut menu it appears 
automatically). Select the needed command from the list. If sub-command is belonging to it (�right arrow 
next to the option name), click on the needed command in the sub-list). 

 Fields of scroll lists 

In many dialogs there are so called ’list fields’. The objects of this list can be selected. 

• Click with the left button of the mouse on the field, or on the arrow to the side. The whole list appears (or a 
part of it). 

• Select an object of the list. Scroll down the list if there are more objects to be visualized than fits in the list 
field or 

• Click on the field and  
Type the value 
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1.19.5. Using the mouse wheel 

 

If your mouse has a wheel, you can use the functions of 
the graphical handling. This makes the work very easy. 
The three frequented window handlings are: 

 

Zoom in – Zoom out: Move the wheel forward means 
zoom in, move the wheel backward means zoom out. 

 

Moving the „Drawing sheet”: Press and keep pressing 
the mouse wheel while moving the mouse. 
 
Rotate: In a 3D window press and keep pressing the 
wheel and the Shift button, while moving the mouse. 

 Zoom in / out 

The mouse wheel can be moved forward or backward.  
The operation uses the zoom in - out command pointing to the actual place of the cursor. 
 

• Move the cursor to the point where you wish to activate the zoom. Move the wheel forward or backward. 
Moving forward the zoom in command will be activated; moving backwards you activate the zoom out. In 
case of zooming in the start point is moving towards the middle of the drawing area 

• When you have reached the needed view, let the wheel free to close the zoom command. 
You can also activate this command, if you 

� Select the  Zoom +/- icons from the NaviBar, or if you 
� Press the Ctrl key together with the +/- numeric keys on the floor plan or on a perspective view. 

 Moving the „Drawing sheet” 

Pressing the mouse wheel and moving the cursor at the same time the „drawing sheet” can be moved. 
 

• Press and keep pressing the mouse wheel. 
This operation activates the Moving the „Drawing sheet” command.  

• Move the cursor to the needed position and let the wheel free.  
 
You have now moved the whole drawing on the screen with a vector. 
The command also can be activated, if you  

� Select the  Pan icon from the NaviBar, or 
� On the floor plan press the Ctrl key together with an Arrow key. 

 

� The operations zoom and moving the „drawing sheet” can be used together. 

1.19.6. The shape of the cursor 

The cursor is a graphical sign that shows the actual position of the mouse  
The ARCHLine.XP® automatically changes the shape of the cursor according to the type of active operation 

  No operation - Arrow cursor 

When ARCHLine.XP® is waiting for a command (’Select a command’ mode); the cursor is in arrow shape.  
If you press Esc key the program closes all commands in progress and gets into ’Select a command’ mode. 

  Editing - Cross cursor 

If an editing command is active, so that ARCHLine.XP® is waiting for the definition of a point or a coordinate, the cursor 

becomes cross-shaped.  
You can switch on the Long cross cursor shape as well in the File menu -Options dialog, in the Other - Screen part. 
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  Selection - Selection cursor 

When a selection command is active, so that the program is waiting for the selection of one or more objects, the cursor 

gets into the selection shape. The size of the cursor signs the tolerance, so that the sensibility of the selection. The 
value of the tolerance can be set at the File menu -Options - Cursor snap dialog. Here you can define the radius of the 
tolerance circle in the percentage of the screen. 

 Snap to special points - Special shapes 

If an editing command is activated, and 
pressing the Ctrl key the cursor changes its 
shape to the sign of the special point (found 
inside the tolerance circle). The clicking 
snaps the cursor to the special point.  

� See description in 2.11.4 CTRL key chapter. 
 
The same effect can be achieved if you check in the Object Snap (OSNAP). This option is in the File menu -Options - 
Object Snap Options dialog. 

 HV cursor 

The HV cursor appears if you move the cursor vertically or horizontally relative to the previously defined point. 
The cursor marks the vertical and horizontal directions 

 

 Cursor information 

When you start a command in Az ARCHLine.XP, the cursor input box appears on the drawing area.  
 

 
 
With this transparent table you can easily monitor and modify the length, inclination, X spacing and Y spacing data during 
drawing an element. You can enter into the table and modify data by pressing TAB or F5, depending on the setting in File 
menu – Options- User interface – Special shortcut – Use TAB or F5 to change the reference point (TAB = 2011). Other 
cursor settings can be found on File menu – Options – Cursor and marker panel. 

1.20. Keyboard 

In ARCHLine.XP® the keyboard is used not only to define values and type texts, but with the help of keyboard shortcuts 
commands becomes quicker and easier. 
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Special characters in the name of group, profile, object  

You can create your own 2D groups, profiles and objects.  
You can use in the name the following special characters: 
& ! @ $ % + = ( ) [ ] { } ' ; , ~ 
 
You can’t use the following characters:  
? | > < : / * " 

1.20.1. Defining values  

In ARCHLine.XP® you can type numbers, texts, arithmetical expressions, coordinates. 
 
When a command asks you an input value, you can enter a text, number, arithmetical expressions or coordinate value at 
the command line or in Dynamic Input field. 
You can enter two-dimensional coordinates as either Cartesian (X, Y) or polar coordinates. 

� Polar coordinates can be used in AutoCAD® mode. Type the length and angle in the precise form, so that. 

In absolute coordinate system:  1<45 
In relative coordinate system:  @1<45 
 

� In arithmetic expressions, you can give values and operation sign which can be used between these values (addition, 

extraction, multiplication, division). 
 For example: to input 6.5, 3 as X, Y coordinate: 3+2*2-1/2, 3 

1.20.2. Enter key 

In ARCHLine.XP® with the key ENTER you can close an active command or subcommand during the operation. 
 
You can substitute the key ENTER with pressing the right button of the mouse, except if you have defined other settings 
for the right click in the File menu -Options - Right click customization field. 

 

� In a dialog window the right click does not substitute the OK button. 

1.20.3. Special keys 

With the special keys in itself no character or number can be given, but a command can be activated. 
Many keys and key combinations are predefined in ARCHLine.XP®, but there is possibility for the users to define freely 
shortcut keys. You can also change the predefined shortcut combinations. 

  
In the following you can read the description of those operations that can be activated with a special key or with a key 
combination.  
The important keys used in ARCHLine.XP®: 

       

 

Alt key 
Shift key 
Ctrl key 
 

 Delete with the CTRL key 

Deleting a part of an object is among the most often used commands.  
 
When the cursor is standing on an object, and no command is active, (cursor=Arrow), pressing the Ctrl key the part of 
an object will be deleted. In details: 
 

 

Ctrl+Shift+ Click=  

If you keep pressing the Ctrl and 
the Shift keys and click on an 
object, the program deletes the 
part of object that is between 
intersection points 

 

 
Delete (DEL) key 

 
If you select on an object on the drawing, and press the Del key, the program 
deletes the entire object.  
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 Ctrl+(+)/(-) key: Zoom 

If the 2D window is active, press the Ctrl and the +/- key to activate the Zoom in/out command.  
 

Ctrl + (+) Zoom in 
 

Ctrl + (-) Zoom out  
 
When the 3D view displays a perspective view: 
 

Ctrl + (+) The observer approaches to the object (perspective 
magnification). 

Ctrl + (-) The position of the observer diverges from the object 
 

� See the 2.5.1 Zoom in / out chapter. 

 

 Selection by object type with Ctrl key 

If an icon of the side menu was selected pressing the Ctrl key selects all the objects of the drawing area that is 
represented by the icon. 
 

• Move the cursor to a main icon of the side menu: e.g. Wall. 

• Press Ctrl key, and click on the icon. The program selects all the walls of the actual drawing. 

1.20.4. SHIFT key 

In ARCHLine.XP when Shift key is pressed it means: 
If an editing command is active:  Angle snap, to set a vertical or horizontal constraint 
If a selection command is active: Selection of more objects 

 Angle snap 

If Angle snap is not switched on you can still use it if you are pressing Shift key. Keeping Shift key pressed the cursor 
moves to the predefined angle direction. After having selected the needed direction go on with the command you wanted 
to execute. 
Shift key the most often is used to find the vertical and horizontal directions. 

HV indicator cursor 

The HV indicator appears if you move the cursor in vertical or horizontal directions in correlation with the previously given 
point 

 Selecting more objects 

With a single click the program selects only one object. Pressing the Shift key it is possible to select more objects 
together.  
Having selected an object on the drawing area, press the Shift key, and while pressing it click on the other objects. It is 
possible to exclude objects from the selection by clicking again on the objects already selected and keeping the Shift key 
pressed. 

 Combination of Shift and Ctrl keys 

Pressing the Shift and the Ctrl keys together the direction of the line or wall to be drawn can be defined by a predefined 
direction (Shift key), and its endpoint can be selected as a special point (Ctrl key). 
Using together the Shift and the Ctrl keys the handling of geometrical commands becomes easy:  

Example:  

Draw a wall from point 1 to point 3 in vertical direction. The point 3 is the horizontal projection of point 2. 
 

• Give the start point of the wall: press Ctrl key, and select point 1. 

• Move the cursor downwards, and press Shift key. The direction is snapped to the vertical. 

• To define the endpoint of the wall keep pressing Shift key, and while pressing Ctrl key click close to point 2. 
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1.20.5. ESC key 

If you press Esc key the program cancels any ARCHLine.XP command that may be in progress and gets into ’Select a 
command’ mode. Press Esc key if you cannot close a command with the Enter key or more Enters are needed to 
terminate the command. 
Esc key can be also used to interrupt heavy calculation commands in progress (dense hatch patterns, regeneration of 
shaded model in 3D view, etc.). 

1.20.6. ARROW keys 

The Arrow keys make possible the following operations: 
 

 

� Defining directions 
� Rotation 3D 

 Defining directions 

With the arrow keys of the keyboard the direction of moving, copying and the direction of an object to be drawn can be 
given. 
When a command of planning is active pressing an arrow key it automatically defines the direction of editing, and 
ARCHLine.XP is waiting for the definition of a distance or length value. 

 Rotating in the 3D window 

If the 3D window is active and 
there is at least one 3D object 
pressing the arrow keys you can 
rotate the 3D view into the direction 
of the arrow. 
 
 

 

Perspective view  

If the active 3D view has perspective view pressing the appropriate arrow you can rotate model.  
 

 
 

 
Rotates the position of the viewer into the direction 
of the arrow around the target point, while the 
position of the model is not changing. This is used 
when you want to walk around a building. 
 

1.20.7. Alt key 

Key 

combination 

Command 
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Alt + F3 
3D model generation from a rectangle selection on the 
actual floor 

Alt + A Copy properties.. 

Alt + C Creating new element based on the properties of the 
selected one 

Alt + R Spcifying a new reference point 

Alt + T 3D model generation from a rectangle selection on all 
floors 

Alt + W 
Activating the global workplane 

 Alt+A – Copy properties 

Copies the properties of the element to the selected elements. 

� See chapter 8.5.2. Copy properties 

� You can use the  Copy properties command from the Edit toolbar, too. 

 Alt+C – Create similar...  

This command creates a new element. The properties and and type of the selected element will be applied to the new 
element.  
 

• Press Alt + C key combination. 
• Select an element to take its properties and type. Only one element can be selected. 

 
The program takes the properties of the selected element and then starts to create a new element. The newly created 
element includes the properties of the previously selected element.  
For example, when you select a wall to take its properties, the program activates the Create wall command immediately. 

 Alt + F3 – creates cut-away 3D view of the actual floor 

You have to specify a rectangle. The partial 3D model – the 3D model inside the rectangle from the actual floor – becomes 
visible in 3D view. This way the rectangle cuts the model, so you can create a section view quickly. 

 

 Alt + T - creates cut-away 3D view of all floors 

You have to specify a rectangle. The partial 3D model – the 3D model inside the rectangle from the actual floor – becomes 
visible in 3D view. This way the rectangle cuts the model. 

1.21. Property manager 

The Property Manager is a user interface tool to visualize the properties of the selected objects and display and modify its 
values. The Property Manager replaces the double click on the object and the Modify selected from the local shortcut 
menu. 
 
The main part of the Properties grid shows properties for an object. Different object types have different properties, 
including different tabs. Related properties are grouped. To get help on a property, move the mouse over the field and the 
short context help is displayed at the lower part of the Property Manager Window. 

Single selection 

The information displayed in the grid is a snapshot of the properties at the time the object is assigned.  
You can change the editable property value of the selected object or objects. The new value is executed when you click 
on another field in the in the grid that causes the object to update with the new value. 
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The program denotes with light red background colour all the properties that cause the loosing of the assigned set name if 
you change any of those. This applies only to the objects that came from a set, of course. For example, in case of wall the 
WIDTH is such a property. 

 
 
You can set the visibility of an object to multiple floors. If you click on the browse (triple-dots) button you can select the 
desired floors. If you tick the all floors option ON then the 2D symbol of the object will be visible on all selected floors. 
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The last checkbox gives another option, a dynamic 2D representation can be chosen instead of the static 2D symbol of an 
object, to represent the real three-dimensional top view. You can switch between the two methods in the property window 
of the objects, columns, beams and pillars. 
 

 

Multiple selections 

In case of multiple selections the Property grid displays the common values of the selected objects. 
The not common property fields are filled with the VARIES indicator. 
 
If different sets belong to the selected objects the VARIES indicator appears in place of the set name too. 
 
In this case the program denotes with dark red colour and disables the modification of all the properties that would cause 
the loosing of the assigned set name if you change any of those. 
 

! In this case we recommend not changing the parameter denoted with dark red colour but choose the set that contains 

the required parameter.  
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1.21.1. Sub-Selection with Property Manager 

Property manager makes it possible to group the multiple selections according to the objects.  
When the selection is made up of different types of objects, the selection dropdown will indicate the word "Selected (n)". 
This is an indicator that (n) objects are selected and your selected objects are not all the same type (for example: you may 
have a selection made up of lines, walls, slabs and columns). By clicking the down button at the right of the dropdown list, 
you can access a subset of this total selection. 

 
 
This feature can be very useful for changing the properties of an object type with a common property, e.g. select all the 
walls on a complex floor plan. 

• Simply make a selection of the entire drawing. 

• Drop down the list and choose Wall (n). 

• Now you can change the properties common to selected walls. 

1.21.2. Intersection of two-or more selections 

The Properties Manager enables of intersection of two or more selections. You can access common part of two selections 
with this command to limit the objects that you want to modify for example to select all walls with the same wall width. 

Example:  

Supposing that we have a floor plan that contains walls and some of them have the property of wall width with the value of 
380 mm.  
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• Zoom all objects on the screen and click on the upper left corner on an empty area and next on the bottom 
right corner on an empty area. In This way you have selected all visible objects on the floor plan.  

• Now press the INTERSECTION  icon and click on QUICK SELECT  icon and choose the Wall width 
criteria. Type a value as 380 mm in the current measurement unit and press Ok. Press ENTER to close the 
current command.  
 
The program displays the common part of the two selections.  
Now you can modify all the walls that have the property of the same wall width. 

1.22. Markers 
ARCHLine.XP® markers are such interactive interface tools that help with modifying objects after their selection without 
using menus. 

Introduction 

The main point of using ARCHLine.XP® markers is that it is very easy to handle them. 
Appearance of markers can be various depending on their aim. After indicating every drawing object special markers 
belonging to that object appear and with help of special markers frequent modifications can be completed quickly. Using 
markers, reduces time, increases design speed and can be learned. 

 

1.22.1. Markers’ operation 

Markers appear when you select one or more objects. 

Markers can be used by left mouse button. 
There are different types of markers: 
Endpoint, edge marker, rotate, move dimension and delete marker. 

 
Clicking on a marker with left mouse button a menu appears where you can choose from possible commands: 

Example for endpoint: 
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Example for edge marker: 

It appears with clicking on the edge of the object: 

 

Delete marker 

When you select one or more objects, the Delete marker will appear together with other markers. Click with the left button 
on the red X marker and the selected objects will be deleted. 

 

Local menu marker 

ARCHLine.XP has many context sensitive tools. Most of these tools you can find in the local menu, which can be 
accessed by a right click, and also by left clicking on the object and selecting the Local menu marker. 

 
 
Click on this marker to see the menu, and access the commands in it. 

How to use? 

� Click on an object on the drawing. 
� The Local menu marker automatically appears right next to the click point, which is visualized by a tiny cross. 

Learning mode 

At first start of the program Learning mode is not switched on, markers have to be used as written above. 
 
Using Learning mode work can be quickened in this case markers remember the last command. Learning mode can be 
switched on with settings of dialog window Markers, which can be found in File menu – Options – Cursor and Marker, see 
chapter Markers’ settings. After switching on learning mode markers react on short and long clicks in a different way.  
 

Learning mode Effect 
 

Short click The last command is executed. 

Long click The menu appears. 
 

Moving the cursor above a marker its shape changes and the marker takes the shape of the last command icon 
used there: with a short click this command is executed. 
 

� The learning mode is recommended to advanced users only. 

1.22.2. Markers’ behaviours in different views 

Floor plan  

After selecting an object endpoints and edge markers always appear in Floor plan window. If the selected object is seen 
on the screen in too small size, move, rotate and dimension markers don’t appear. In this case if you want to use these 
markers, enlarge the object with help of mouse runner until the markers appear. 
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3D window 

Move, rotate and dimension markers appear in 3D window if the selected object is seen on the screen in quite a big size 
similarly to floor plan window. Rotate and dimension markers are not seen in certain views, in this case if you want to use 
these markers rotate the model with help of arrow keys until the markers appear. 

Section window 

In Section windows and in 3D windows representing profile a limited set of markers can be accessed. The commands 
here work on the level parallel to window level and not to model XY level.  

Main markers always aligned 

ARCHLine.XP organizes the most common markers next to each other, so they are always placed to the same position 
and you can use them efficiently. When you left click on an object, you will see the markers aligned next to each other 
right to the click point. 

 
 
The click point is also represented when you click on an object with the left mouse button. This will help you understand 
the selection, when you use the local menu marker and the context sensitive tools in it. 

1.22.3. Marker types and accessible commands 

 

Move markers 

 
 
Move markers take place in the centre of objects and they make their moving and lifting possible. In 3D window objects 
can be moved in parallel with floor plan’s level and they can be lifted at right angles to floor plan’s level. However, in case 
of objects fitted to vertical or inclined level there is a possibility of moving them on fitting level as well. Menu belonging to 
move markers generally contain the following commands:  

  Move or Move a Copy From (starting point of moving is the centre of object)  

  Move From or Move a Copy From (starting point of moving has to be given as well) 

In 3D window there are further commands: 

  Elevate or Elevate a Copy (starting point of lifting is the centre of object) 

  Elevate From or Elevate a Copy From (starting point of lifting has to be given) 

If you put an object into 3D window and during this process a certain level –which is different from horizontal – was given, 
in the 3D window instead of Lifting command the following commands can be found: 

  Move on its own level or Move a Copy on its own level (moving starting point is the centre of 
object) 

  Move From on its own level or Move a Copy From on its own level (moving starting point is has to 
be given) 
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 Rotate markers 

 
 
Rotate markers allow rotating and mirroring of objects. In 3D window objects can be rotate around an axis perpendicular to 
floor plan and they can be mirror to the plane perpendicular to floor plan. Menu belongings to move markers generally 
contain the following commands:  

 Rotate 90 ccw or Rotate 90 cw Copy (the centre of rotating is the move marker position) 

   Rotate or Rotate a Copy (the centre of rotating is the move marker and only the endpoint of 
rotating angle has to be given) 

  Rotate From or Rotate a Copy From (the centre of rotating and the starting- and endpoint of 
rotating angle have to be given) 

  Mirror or Mirror a Copy 

 Endpoint markers 

Endpoints indicate significant points of objects. A part of commands connected to them alter (change) the shapes of 
objects. For example an endpoint menu belonging to Hatch contour contains the following commands: 

 Move node 

 Delete node 

 Fillet 

In menus belonging to Endpoints generally commands for moving the whole object can be found as well: 

  Move or Move a Copy (moving starting point is the given endpoint) 

  Rotate or Rotate a Copy (rotating centre is the given endpoint) 

  Mirror or Mirror a Copy (first point of mirror axis is the given endpoint) 

In 3D window further commands can be found: 

  Elevate or Elevate a Copy (lifting starting point here is the given endpoint) 

 Edge markers 

Edge markers allow modifying the edges of objects. For example the menu of an edge marker belonging to Hatch contour 
contains the following commands: 

 Offset 

 Offset all 

 Insert Node 

 Insert Smooth Node 

 Turn to Curved Edge 

 Turn into Spline 

 Dimension markers 

Dimension makers indicate the dimension of walls, openings and lines. A certain dimension can be changed with a click 
on the dimension value. In case of modifying the length an arrow can be found at the end of dimension line and it shows 
that end of object which moves in modifying. Clicking on this arrow its direction can be reversed.  
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 Mirror marker 

In case of openings another mirror marker helps with transforming doors’ and windows’ position. 

Current reference point marker 

The Current reference point marker highlights the last used input point. When working with relative coordinates, it is useful 
to see the visual representation of it, to avoid false coordinate inputs or other false definitions. 

 

1.22.4. Design layered walls, slabs and roofs 

Each layer of layered walls, slabs and roofs can be designed with help of markers. For designing a layer you have to 
select an object with clicking left mouse button and at the same time you keep ALT key pressed down. Then edge 
markers appear on the object with dotted line, indicating that the given layer can be designed.  

  
If you select the object as written above, menus of holding points and edge markers contain such commands that help to 
design contour of the selected layer. 

 Layer changing markers 

Layer changing markers help to change layers of layered walls and roofs. Menu of these markers contains the following 
commands: 
 

 

1.22.5. Door, window ‘virtual’ dimensions  

The selected door, window displays “virtual” dimensions (width and height), providing the possibility to change the 
width and height of a window through the virtual dimension. 

 
 



62 2. Interface 

Manual 

 
 
 

1.22.6. Smart Distance marker 

Smart Distance is a fast tool to measure and change the distance between the first selected object and the later selected 
ones.  
ARCHLine.XP displays the first object with a different colour. The other selected object(s) will be easy to recognize as it 
will have another selection colour. 

How to use? 

� Click on the first object. 
� Press and hold the CTRL key on your keyboard and click on the second and more objects. 
� Click on the arrowhead if you wish to change direction of the movement. 
� Click into the distance value, type a new distance and press the ENTER key on your keyboard. 

Note: This feature doesn’t work when you select multiple objects by using the selection rectangle. In that case there is no 
object that can be distinguished as the first selected one. 

Practical examples: 

Example 1: Change the distance between two objects 
 

 
 
Example 2: Change the distance between more than two objects: 
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Example 3: The smart distance tool extended to measure distance between openings. It makes possible to shift a 
door/window relative to the other door/window. 

 
 
The colour of the first selected object can be changed. Please open the File menu - Options dialog and choose the Display 
panel. Choose the Colour of reference object in multi-selection option and set the colour by using the colour selection 
button. 

 

1.22.7. Main axis markers for 3D move 

ARCHLine.XP® makes the operations in the model space easy by interactive 3D cursors. 
 

 
 
When selecting a 3D object, the program shows the main axis for moving operations. With the help of these markers you 
can move the selected object in the space along the main axes. Each axis has different colour representation. The 
horizontal X axis is represented by green, the horizontal Y axis is represented by red, and the vertical Y axis is 
represented by blue colour. 

How to use 

Clicking one of the main axes starts the movement along the axis. You can set the new position by moving the mouse 
cursor to the desired point and then clicking again. 
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You can see possible overlaps while moving the mouse 
 

1.22.8. Editing 3D solids  

ARCHLine.XP® facilitates moving, copying, editing and deleting components of complex 3D solids created by means of 
Boolean operations like union or subtraction. 

 

 Selecting components 

The components of the 3D solids can be selected like wall or slab layers: by selecting the Edit Components command in 
the menu of the Move marker or by clicking the appropriate component while pressing and holding down the ALT key. 

A cone is the 
selected 
component 

An extruded solid 
is the selected 
component 

A cylinder-shaped 
hole is the is the 
selected 
component 

 

You can navigate between components by using the Previous component or Next component commands of the 
marker. The marker appears automatically if a solid component is selected and the 3D solid consists of at least two 
components. 
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� You can modify the shape of the solid which consists of only one component by selecting the single component. 

 

� You can select the holes in complex solids as components if they are created by subtracting one component from 

another, by clicking the inner surface of the hole while pressing and holding down the ALT key. 

 Editing an Extruded Profile 

The shapes of some components are based on one or more 2D profile. The cylinder is generated by extruding a circle 
along a straight path. By selecting the given component you can edit these profiles. 
 

 
Basic extruded solid 

 
Cone 

 
Solid based on two profiles 

 
Rotational solid 

 
Solid extruded along a path 

 
After selecting the desired component just click on an edge or node of the profile and select the appropriate command 
from the Marker menu. These menus contain the following common Profile editing commands: 
 

� Move Node 
� Delete Node 
� Insert Node 
� Fillet 
� Offset 
� Offset All 
� Turn Into Curved Edge 
� Turn Into Straight Edge 
� Change Arc 
� Change Radius 

 Editing the Path of Extrusion 

Some components are created by extruding a profile along a given path. After selecting these components it is possible to 
modify the path of extrusion. 
 

 
Solid extruded along a spline 

 
After selecting the desired component just click on an edge or node of the path and select the appropriate command from 
the Marker menu. (You can access the first and last point of the path by clicking on one of the arrows.) These menus 
contain the following commands: 
 

� Move Node 
� Delete Node 
� Insert Node 
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 Changing height and slanting 

Some components are created by extruding a profile along a given path. After selecting these components it is possible to 
modify their height or to slant them. 

 
Selecting the cylinder component 

 
Result of decreasing height  

Result of slanting 
After selecting the desired component just click on one of the arrows and select the appropriate command from the Marker 
menu.  These menus contain the following commands: 
 

� Change Height 
� Slant 

 Moving, copying and deleting components 

ARCHLine.XP® facilitates moving, copying and deleting components of complex 3D solids created by means of Boolean 
operations like union or subtraction. If a component is copied, the copy inherits the original one’s relations to the other 
components. For example, if the original component is a hole added by a „Subtract” Boolean operation, the copied 
component will be a hole, too; it will be subtracted from the same components as the original one. 
 

 
Copying the selected cone 

 
The copy inherits the original 
component’s relations to the other 
components. 

 
Copying the cylinder shaped hole 

 
The copy will be a hole, too. 

 
After selecting the desired component just click on one of the arrows or node markers and select the appropriate 
command from the Marker menu. These menus contain the following commands: 
 

� Move 
� Copy 
� Delete 

 

1.23. Toolbars 

A toolbar is a graphical presentation of commands optimized for efficient work because always displayed instead of being 
displayed on mouse click like menu bar commands. Toolbars provide direct access to the same commands like menu bar.  
 
The list of toolbars can be found in the Window menu: 
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Visualizing Toolbars: 

You can choose which toolbars of the program you need to visualize on your screen.  
If you check in the Show all command, all the toolbars appear on the screen.  

Moving the toolbars - Floating toolbars 

The toolbars are default on the side of the main window. From there you can replace them if you drag the toolbar from the 
dot line marking its side and move the cursor to the new place.  
 
If you place the toolbar in the middle of the drawing area, a floating toolbar appears with a heading. The floating toolbars 
can be resized moving their sides (if the cursor becomes a double arrow), dragging the header you can replace them and 
clicking on the X icon on the top right corner you can close them. 
 

Default position of toolbars 

If you have changed the position of toolbars or created new ones with the Window menu - Default position of Toolbars 
command you can restore the original arrangements.  

Big toolbar buttons 

The program by default has small icons, but selecting this command it is possible to visualize big icons on the screen. The 
Window menu - Big toolbar buttons command is a switch, and if it is active there is a tick in front of the option. If you 
check off the option the icons appear in the small, original size. 

Setting toolbars 

Selecting the Tools menu - Customize - Toolbars command a dialog appears, where just as in the Window menu 
toolbars can be activated. Here you can create and delete new toolbars. 
 

 

Create new toolbar 

• Click on the Create toolbar button to create new toolbar. The list of existing toolbars appears in the dialog. 

• Rename the new toolbar in the Name field: The new toolbar appears on the screen. 
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• Move the icons of existing 
toolbars into your new 
toolbar by keeping the left 
mouse button pressed.  
If you have selected an icon 
from the original system 
toolbar the program makes a 
copy of the icon. If an icon is 
not needed in the new 
toolbar simply pull it out of it 
with the mouse.  
 

• OK to close the dialog 
 

 
        

 
The method is the following to 
drag a command into a new 
toolbar: 
 

• Select from the icons on the 
left side of the dialog and 
choose a command among 
the objects of the menu or 
toolbars. 

• Drag the icon onto the 
needed toolbar. 

 

 

Delete toolbar 
Only toolbars created by the user can be deleted. Default toolbars cannot be deleted. 
 

• Select the toolbar to be deleted in the dialog. 

• Press the Delete button. OK. 
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1.23.1. Status bar 

The status bar is a collection of the most frequently used commands in ARCHLine.XP such as  
 

� Options,  
� Grid, Snap, Osnap, Ortho,  
� Selection control,  
� Floor/Perspective settings,  
� Generate 3D model,  
� Layer controls,  
� Reference point bar,  
� Move bar and  
� Edit bar commands. 

 

 

Options dialog  

You can customize the program settings and appearance in the Options dialog. 
The Options dialog is located in the bottom left-hand corner of the ARCHLine.XP Status bar and has a unified interface 
outlook. 
Click on the first icon (gear like) to display the Options dialog. 
 

 
You can also open the Options dialog in the File menu and click Options 
 

Grid, Snap, Osnap, Ortho, 

 
 
The 2-5 icon group changes the settings of grid, snap, object snap and ortho commands.  
 

Grid Grid can be switched on/off. 

Snap Snap grid can be switched on/off. 

Object snap Objects snap on/off. 

Ortho You can switch between orthogonal and normal mode. 

Grid 

A grid with arbitrary division can be visualized that helps orientation on the drawing. The grid is not part of the drawing. It is 
not printed with the drawing. 
 
Switching on the snap, the grid becomes a snap grid. This means that points defined by graphical tools will be attracted to 
the nodes of the grid, or to the proportional part of it.  

Angle snap 

In a graphical editing command the Angle snap defines the position of the second point in correlation to the first given 
point. The second point snaps to the nearest fix angle. The fixed default directions are: 0°, 45°, 90°, 135°, 180°, 225°, 

270°, and 315°.  
You can activate the angle snap and modify the default angles in the File menu -Options - Snap and grid dialog. 

Selection button 

Activates the Selection pop menu..  

� See description in 7. Selection chapter. 

Floors / 3D Perspectives control buttons group 

The contents of this group represent the actual workspace nature. 
 
2D floor plan workspace: 
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The floor plan structure is listed on the button.  
When you have more than one floor in your workspace, you can switch between them by clicking on the floor name in the 
list or go up, down one floor by clicking on the blue Up, Down icons on the bar. 
 
3D model workspace: 

 

 
 
The saved perspective views with a name are listed here.  
When the perspective opens, the title bar of the button changes to display the name of the current perspective. 
 
In addition, by clicking on the blue Up, Down icons, allows you to quickly switch between other saved perspective views. 
 
To open a new perspective: 

Click the Perspective button that displays the name of the current perspective. (This provides the same command 
as the View > Perspective view on the menu bar.) 
Define the perspective that you want to add and save it with a new name. 

Create 3D model 

Activates the Build up 3D model dialog.  � See description in chapter 6.2 Building 3D model. 

 

Create partial 3D model 

 
Build up 3D model by rectangle with clipping on all floors. � See description in chapter 6.2.1.4. By rectangle - on all floors 

 
 

 
Reference 
menu � See 2.16.5 Reference toolbar 

 
Move 
menu � See 2.16.4 Move toolbar 

 

1.23.2. Layer toolbar 

The Layer toolbar collects the main Layer management commands: 
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Layer manager 

This dialog manages layers and layer properties. You can change the current layer, create new ones, delete or turn 
on and off layers and lock/unlock them, change the printable status. In layer control mode you can assign 
properties such as colour and line type, line weight. 

Move Objects to New Layer 

This tool will move objects from one layer to another, by selecting the destination layer from a dialog.  

Layer Walk 

This tool displays objects on layers that you select in the Layer Walk dialog. This tool is very helpful to check which 
object lies on which layer. 

Change to Current Layer 

This tool moves objects to the current layer.  

Make Object’s Layer Current 

This command changes the current layer by selecting an object as reference. It will use the object’s layer as current 
layer. This command is accessible in layer control mode only. 

1.23.3. Edit toolbar 

The Standard toolbar includes the often-used general commands (Open file, Save, Print, etc.) and the often-used editing 
commands.  
 

 
 

 
New window Opens a new window that becomes the part of the project.  

 Open file Opens the selected drawing file. This function equals the File menu - Import 
command.  

 
Save project Saves the project. This function equals the File menu - Save project (Ctrl+S) 

command.  
If we work with drawings instead of projects, the current drawing is saved. 

 
Print Opens the Print dialog. (Ctrl+P) 

 
Cut Cuts the selected part of the drawing and puts it onto the clipboard. 

 
Copy Copies the selected part of the drawing to the clipboard. 

 
Paste Pastes the selected part of the drawing from the clipboard. 

 
Undo 
 

Revokes the last command. It is possible to revoke maximum 20 steps. (Ctrl+Z) 

 
Redo 
 

If the Undo command was used to restore the previous situation, the Redo 
steps forward in the 2D commands queue. (Ctrl+Y) 

 
Copy 

properties  
Copies the properties of the selected object to another object. (Alt+A) 

 Create Similar The Create Similar command allows you to create a new object that is similar to 
a selected object..  

 
Delete  
 

Deletes immediately the objects you click on. 

 
Delete 

between 

intersections 

Deletes that part of the selected object, which is between the two intersection 
points (or endpoints) nearest to the selected point. 

 
Trim first 

object 
This command deletes (or adjusts) the unnecessary (or missing) part of the first 
selected objects to connect it to the second selected object. 
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Trim both 

objects  
Adjusts two selected objects to each other. 

 
Define section You can define the section line. The program is going to use this line when 

creating the section. 
 

� See description of these commands in the 7. Bases of editing, 8. Bases of modifying and in 6.5 Section 

chapters. 

1.23.4. Move toolbar 

Using the Move toolbar you can define different geometrical transformation on the objects. 
 
This is also available from the Status line in a more compressed form as a list.   It saves space on your screen and you 
may enlarge the drawing area. 
 

 
 

Moving Move the selected objects with the defined vector. 

Mirroring Mirrors the selected object through a given axis. 

Rotation Rotates the selected objects. 

Scale Magnifies the selected objects. 

Duplication Copies the selected objects with a given vector. 

Duplicate 
and mirror 

Mirrors and copies the selected objects. 

Duplicate 
and rotate 

Duplicates and copies the selected objects. 

Duplicate 
and scale 

Scales and copies the selected objects. 

Multiply Makes given copies of the selected object along the defined distance. Divides 
the given distance into defined equal parts. 

Rectangula
r array 

Copies a given object according to the given matrix  
 

Polar array Copies a given object according to the given polar matrix  

Stretch Stretches the selected objects by a vector  

Shift and 
Rotate 

Move the selected objects with the defined vector and rotate. 

Duplicate 
and Rotate 

Copies the selected objects with the defined vector and rotate. 

Align Aligns and/or distributes the selected objects on floor plan. 

 

� See description of the commands in the 8. Editing commands chapter. 

1.23.5. Reference toolbar 

The objects of the Reference toolbar are used when the program is waiting for a coordinate input. 
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With some of the icons you can define the special points that the cursor has to find. With others you can lock coordinates, 
distances, directions, projections. 
This toolbar helps you to define precisely the input data. 
The commands can be combined with each other. 
 
This is also available from the Status line in a more compressed form as a list.   It saves space on your screen and you 
may enlarge the drawing area. 

� See 2.16.1. Status bar 

Snap to special points, defining direction and distance: 

 

 
Endpoint Defines the endpoint of the selected object. 

 
Midpoint Defines the middle point of the selected object. 

 
Distance from 

endpoint 
Defines a new point as a point on the selected 
object at a specified distance from the 
endpoint nearest to the selected point. 

 
Distance from 

intersection 
Defines a new point as a point on the selected 
object at a specified distance from the nearest 
intersection point. 

 
Half division 

point 
Divides the distance between two points into 
half. 

 
Centre point Defines the centre of an object. 

 
Intersection 

point 
Defines the nearest intersection point on the 
selected object. 

 
Apparent 

intersection 

point 

This command is able to find the intersection 
point of two selected objects. 

 
Reference point The selected point becomes the reference 

point.  

 
Nearest point Defines the nearest point of the selected 

object. 

 
Parallel direction The next input coordinate is in direction of the 

selected object or in the direction of the 
tangent of the selected object. 

 
Perpendicular 

direction 
The direction of the next input coordinate is 
perpendicular to the selected object or to the 
tangent drawn in the selected point. 

 
Relative distance The next point will be defined in X, Y distance. 

 
Relative polar 

distance 
Defines the new point at a given angle with a 
given radius from the last point. 
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Coordinate-, distance, locking direction: 

 

 
Lock X 

coordinate 
Locks the absolute / relative X coordinate of 
the new point. A line appears and the program 
recognizes only the points of this line. 

 
Lock Y 

coordinate 
Locks the absolute / relative Y coordinate of the 
new point. A line appears and the program 
recognizes only the points of this line. 

 
Lock radius Having locked the radius a circle appears, after 

this the cursor finds only the points of this 
circle. 

 
Lock direction If you lock the value of the angle a line appears 

in the given direction. After this the cursor finds 
only the points of this line. 

 Lock angle 
Locks the actual editing direction graphically. 
After this the cursor finds only the points of this 
line. 

 

Projections: 

 Reference 
direction 
perpendicular 

The new point will be in the intersection of the 
locked direction and the perpendicular 
projection of the selected reference point. 

 
Reference 

direction 

horizontal 

The new point will be in the intersection of the 
locked direction and the horizontal projection 
of the selected reference point. 

 
Reference 

direction vertical 
The new point will be in the intersection of the 
locked direction and the vertical projection of 
the selected reference point. 

 

� See description in 5.2. Defining angle. 

1.23.6. View toolbar 

The commands of View toolbar can be used in both the 2D and 3D drawing windows. 

 
 

 

Zoom all 
 

Modifies the scale of the active window to make 
the entire actual drawing visible. 

 

Zoom in 
 

Enlarges the selected rectangle of the actual 
drawing to the whole active window. 

Zoom 
out 
 

Reduces the window by a scale factor of 0.5. 

Redraw 
 

Redraws all windows containing the actual 
drawing. 

 

Pan Shifts the active 2D window on the actual 
drawing. 

 

Local 
Origin 

You can redefine the local coordinate system by 
giving the origin and the direction of the X axis. 

Previous 
view 
 

Restores the last defined view into the active 
window. 

Next 
view 

Reloads the next stored view in the active 
window. 
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Enlarge 
active 
window 

The active window appears on the left side of the 
screen. Other views get to the right above each 
other. 

 

� See detailed description of the commands in chapter 6.1. Setting view. 

1.23.7. 3D View toolbar 

The icons of 3D View Toolbar provide different ways to visualize the 3D model. 

 
 

 

Perspective 
settings 

Defines the perspective transformation by 
viewpoints on the 2D drawing. You can 
save the actual perspective view with a 
name in the Perspective dialog. 

 

 

Define right 
view 

Visualizes the right side view of the model 
in the 3D window.  

 

Define frontal 
view 

Visualizes the frontal view of the model in 
the 3D window.  

 

Define top view Visualizes the top view of the model in the 
3D window.  

 

Define 
axonometric 
view 

Visualizes the axonometric view of the 
model in the 3D window.  

 

Define back 
view 

Visualizes the back view of the model in 
the 3D window. 

 

Define left view Visualizes the left side view of the model 
in the 3D window. 

� See description of these commands in chapter 6.1. Setting view. 
 

1.23.8. 2D edit toolbar 

This toolbar collects the frequently used 2D edit commands.  
 

 
 
Or you find it in Status bar:  
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The 2D edit commands are as follows in order: 

 
Offset Defines a line that is parallel to the selected object, has the 

same length as the selected object. 

 

Trim both Adjust two selected objects to each other. 

 
Trim first Deletes (or adjust) the unnecessary (or missing) part of the 

first selected object to connect it to the second selected object. 

 

Trim multiple Deletes (or adjust) the unnecessary part of a group of objects 
to connect it to the first selected object. 

 

Delete area Deletes the section of the object within the selected area. 

 

Delete 
between 
intersections 

Deletes that part of the selected object, which is between the 
two intersection points (or endpoints) nearest to the selected 
point. 

 

Break Breaks an object into two objects at the point where the object 
intersects with another object. 

 

Lengthen by 
number 

Changes the length of the selected line with a specified value. 
The length specification can be absolute or relative. 

 

Chamfer Connects two objects with an angled line. 

 

Fillet Connects two objects with an arc. 

1.23.9. Sun setting toolbar 

The Sun setting toolbar can be switched on in the submenu of Window menu – Toolbars. With the help of this you can 
quickly set the date and time. This setting is analogous to the View menu – View Properties – Sun position dialog settings. 

The  Show shadow icon is analogous to the show shadows option in the View palette –Shadow dialog. 
 

Clicking on the  Sun position icon you can quickly access the Sun position dialog, which is analogous to the View 
menu – View Properties – Sun position command. 
 
Accordingly, this setting affects the shadows: 

� in the Image 3D window 
� in any 3D window 
� On the rendered images. 

 
With the use of the clock slider, an interactive shadow animation can be made in the Image window. 
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Shadow  Shadow can be switched on/off. 

 

Sun position  Sun setting dialog is displayed. 

Heliodon  Sun setting using Heliodon. 

 

Shadow Animation  The shadow animation displays the shadows change during 
the day between starting and ending time. 

 

1.23.10. Set toolbar 

ARCHLine.XP Interior dynamically changes the settings on the toolbar depending on what item type you are working on. 
For example, if you begin to draw a wall the list of the current wall-templates will appear. 
 
If you would like to change the active wall, click on the drop-down list and select the appropriate one. 
 

 
 

� The method is flexible, so you don’t need to interrupt the command. Switch seamlessly between sets to be used while 

the command is running. 

1.24. Window handling 

The real Drawing area is the largest part of the graphical screen. Graphical view windows appear here, that contain 
drawings for construction. Windows can be the following types:  
 

� 2D windows 
� 3D windows 
� Section windows. 

 
The 3D windows contain different 
3D views. 
 
Title bar of each window displays 
the name of drawing file. Windows 
can be moved by the title bar, and 
can be resized by their side. 
 
Commands of the Window menu 
helps handling of used windows 
and toolbars.  

 
 

3D view window 

An arbitrary number of 3D view windows can be created. The names are generated automatically. There can be two types 
of 3D windows: 
 

� 3D image mode window,  
� 3D vector graphics mode window  

 
An image window can be converted to vector graphics window and vice versa. For this you have to click with your right 
mouse button on the title bar of the window and select the last command: Image <-> Vectorial 
 
What are the differences among these two window types? 
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3D DirectX image window 

We recommend the use of Image window by default because it moves quickly the 3D model (rotation, zooming) 
regardless if the model is represented with hidden line, material colour or material pattern. In this case the 3D hidden line 
representation is much faster because the application can use the capabilities of graphics hardware acceleration. 
 

! Please be aware: if the content of a window is IMAGE then it is not suitable for drawing representation or copying its 

content to a 2D window! 
It is printable as a raster image. 

3D vector graphics mode window: 

Because of the drawing (vector graphics) content, the representation with hidden line, material colour or material pattern is 
slow because the generation of the model is based on software. We recommend to use for Sections. 

1.24.1. Activate window 

Before starting work in a window it has to be activated: 
It can be done: 
 

� By clicking on the window title or on the drawing area with the left mouse button or  
� In the bottom of the Window menu the actual windows are listed. There is a tick in front of the active one. Click on the 

window to be activated. 

The window selection tabs can be enabled or disabled in the File menu – Options – General – Toolbox settings 

dialog with the Show window selection tabs option. 

How to use the window selection button 

The window selection button can be seen on the top of the drawing pane.  
 

 

Switching between window 

Window selection button make easy to switch between active windows in the project. Click the name of the 
drawing you want to activate and the appropriate drawing will be active. 

1.24.2. Close window 

If You click to the X sign in the right upper corner of 
the activate window, the program close it. It reminds 
us to save the content of the window. There must 
be at least one window open on the screen 
Working with projects the closed window will not be 
seen, but it will not be deleted from the project.  A 
drawing can be deleted from the project in the File 
menu - Project properties dialog. 

   

1.24.3. Modify windows 

Size and position of a window can be changed according to Windows standard. 

1.24.4. Open new window 

Because the windows containing the drawings can be of two types: 2D windows, 3D windows. Type must be defined when 
a new window is created. The maximal number of visible windows is 16. 
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 New 2D window 

Choosing this command the program opens a new 2D window. 

• Define the name of the new window. 
 

  
 
New window will be created. 
 

� The command can also be activated with the Edit toolbar-  New icon. 

 New 3D window 

Choosing this command the program opens a new 3D window. 
The new 3D window visualizes the axonometric view of the actual 3D model.  
 

� The view can be changed by right clicking on the heading of the 3D window and selecting the adequate view command 
from the 3D view menu.  

� The same can be done with View menu - Show 3D - View option. 

1.24.5. Arrange windows  

The following commands help you to arrange windows on your computer screen in the most optimal way. 

 Magnify - F2 

Presents the active window enlarged to the entire screen. A tick in front of the command in the menu shows that the 
command is active.  

 
Click on the command again it will be switched off, and the original multi-window arrangement appears again. 

 
 

� Enlarge command can also be activated by the  button in the right top corner of the active window. 

 Zoom in active window 

The program divides the screen: the active drawing gets into the main window; the others will be presented under each 
other in the right side of the screen. 
Ratio between the main and lateral windows can be given by the following Zoom in active window with value@ command. 
 

� Command is also available in View toolbar -  Enlarge active window icon. 

 Zoom in active window with value 

You can set here the activate window’s width in %. The value can be between 15 and 85 %. 
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1.24.6. PiP (Picture in Picture) 

When you click on the view header the View menu appears. It contains the Picture in picture command: 
 

 

Pip (Picture in picture) - Always on Top 

PiP (Always on Top) forces the window to stay on top relative to other views. 
Always On Top allows controlling the view  'behaviour' by means of extra button placed near the standard 
Minimize/Restore/Close group that results in greater workspace e.g. for your floor plan and its accuracy. 

1.24.7. Second Monitor 

In the ARCHLine.XP it is easy to configure the display layout using the second monitor placing there one or more 2D or 
3D view windows.  
To adjust the display layout, you need to click on the active view header. 
Here you find the Second Monitor command.  Click on it to prepare the window movable to your second monitor. 
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Click on it to make the window movable to your second monitor.  The window layout will change and displays a wide 
header. 
 

 
 
Click on the header and you should be able to drag the window from one screen to the other without changing any 
settings. 

Object info 
Information window that 
appears when the cursor is 
moved above an object, and 
waits a little. Geometrical 
information is listed here.  
Tool tip with these data can 
be placed on the drawing by 
the last icon of Text menu 

  
This option can be switched 
on/off in File menu / 
Preferences / General / 

 
This option can be switched on/off in File menu / Preferences / General / Object snap option: 
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3. Customize ARCHLine.XP 

1.25. Options 
You can configure ARCHLine.XP global settings and its user interface in Option dialogs.   
 
The Options dialog box includes the following tabs:  
 

 

Graphics 

Controls options that relate to presentation and drawing settings, colours and other visual options. 

Open and Save 

Define paths for files and directories and set options to import/export and autorecovery settings.  

Units and angles 

Project unit and angle settings control how ARCHLine.XP interprets the length, coordinate and angle entries and how it 
displays lengths, coordinates and angles in the drawing and in dialog boxes. 

Snap and grid 

ARCHLine.XP provides drawing aids as snap and grid to provide alignment with existing geometry. Snap helps you to 
draw quickly and accurately. 

Cursor and marker 

Cursor and marker settings can be found here. 

User Interface 

Define options to change the behavior of the user interface. (Language, the toolbox modes and schemes of 
ARCHLine.XP). 

Item Settings 

Specify global parameters here that are not related to the given objects Property panel. 
 
* Star Icon  
Star icon before the option name signifies that an option is saved with the project. An option saved with the project affects 
only the current project. If you transfer the project to another computer the option will be valid on that computer as well. 
 
An option saved in the computer system registry (and for this reason not displayed with a star icon) affects all projects.  

1.25.1. Graphics Tab 

User can change the display of graphics. 
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Colour 

Changes the colour of the background in the drawing area. Click the colour value to specify a new background colour. 
Black background colour will cause black colour objects to display as white. 
 
Select that part of the user interface from the list whose colour will be changed. 

Inactive building colour: 
 

Inactive building colour is used for 
� Representing the inactive buildings when there are more buildings created 
� Inactive drawing objects in group work (multi-user) mode 
� For not active but visible floors. 

Cursor shapes 

Long cross cursor 
Check in the option. The cursor 
intersects the entire window. When 
an editing command is active, 
ARCHLine.XP is waiting for definition 
of a point the cursor represents this 
form. 

Origin indicator  
The marker that represents the 
coordinate system origin appears or 
remains in hidden.  

Line caps 
Set endings of lines: 
 

 
 

Fine All lines are drawn with rounded ends. 

 Square All lines are presented with square ends. 



 3. Customize ARCHLine.XP 85 

 ARCHLine.XP® 

 
 
Line width on 

If option is checked in, all lines will be drawn by the 
given line width. 
If it is checked off, all lines will be presented with 0 
widths. Objects do not lose the set line width, 
because this function serves only for the screen 
representation. 
 

� Settings for printing can be given by the switch in the Print dialog. 

Graphic Engines 

Two types of graphic engine windows are available: 
 

� DirectX mode (DirectX Graphics Library).  
� OpenGL mode (OpenGL). 

 
DirectX and OpenGL are competing application programming interfaces (APIs) which can be used in applications to 
render 2D and 3D computer graphics, taking advantage of hardware acceleration when available. 
 
Availability: 
Direct3D application development generally targets the Microsoft Windows platform. The OpenGL is an open standard, 
and implementations exist for a wide variety of platforms. 
 
See more: http://en.wikipedia.org/wiki/Comparison_of_OpenGL_and_Direct3D 
 
 

 

 View properties 

The following properties are common to floor plan views. You can specify them in the File menu - Options – Display 
dialog. 
 

Drawing properties  Description  

Opening scale  

The opening scale is the architectural detail level used 
to represent doors and windows in the floor plan. By 
changing the opening scale factor, you can affect the 
display of the same door/window geometry at 
different view scales. 

Section height visible Switch to apply Section height from floor 

Section height from floor 

Floor plan is understood to be drawn at a particular 
vertical position. Objects below this level are seen, 
objects at this level are shown 'cut' in plan-section, 
and objects above this vertical elevation are omitted 
or shown dashed. (Default elevation at 1000 mm 
above the floor) 

Wall display  
You can modify how the vertically layered walls are 
represented on the floor plan.  

Line weights scale  

When line weight is off it is displayed as one pixel 
wide. Otherwise line weights are displayed as a pixel 
width proportional to the real-unit value. This option 
has no effect on printing. 

Display proportional line weights  
Switch off on views the real line width with 1:10, 1:100 
etc. scales. This option has no effect on printing. By 
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default, line weights are plotted with the exact width 
of the assigned line weight value. 

Line width is displayed as one pixel. Turn on means to optimize performance on screen. 

Side marker to display wall reference line 
on screen" 

Switch on/off the visible marker what identifies the 
wall reference line 

Maximum number of visible periods of 
the line-type pattern 

When the number of line type pattern exceeds this 
value on the screen only the line is represented as 
continuous line.   

 Displaying the range of parameter values 

With the Show min-max values option it is possible to display the range of parameter values in the objects, doors and 
windows properties dialogs. 
This helps by specifying parameter values. 
 

 

 

1.25.2. Snap and Grid Tab 

Specify snap and grid settings. 
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 Grid 

Define horizontal and vertical distance between nodes of the grid. 
 
X Spacing: Specifies the grid spacing in the X direction. 
Y Spacing: Specifies the grid spacing in the Y direction. 
Colour: Specifies the grid colour 
Style of grid: point or line. 

 
The program limits the density of the grid when zoomed out. 
The grid is not displayed if its density is too high compared to the size of the drawing. In that case you must 
zoom in to make the grid visible. 

Activate grid  

Clicking on the status line – GRID or Tool menu - Grid command activates and deactivates grid.  

 Object snap 

Object snap enables to define precise locations on objects. You can specify an object snap whenever you are prompted 
for a point. 
In ARCHLine.XP® the special points are the following:  
Perpendicular point, Endpoint, Center, Midpoint, Nearest point, Intersection, Focus point and Tangent point.  
 
When OSNAP is on, the program finds the special points within the cursor tolerance circle and changes its shape, marking 
in this way the special points of the objects. When clicking the program snaps the cursor to the nearest special point if it is 
inside the tolerance radius. 
 
ARCHLine.XP identifies the following special points and displays a marker when you move the cursor over an object snap 
location on an object. 
 

  
Perpendicular 
point   

Nearest point  
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Extreme point 

  
Intersection  
 

  
Midpoint 

  
Focus (ellipse) 

  
Centre 

  
Tangential 

Objects snap (OSNAP) 

The gravity to the points is automatic if the OSNAP option is activated. In this case it is enough to move the cursor towards 
the object, and the program automatically snaps the cursor to the nearest special point. 
 
The OSNAP function helps your work remarkably. 
 

� The OSNAP can also be switched on with the Tools menu - Object snap option. 

Limit of Object snap  

Default value of OSNAP is 1.000 000. This means that if the number of objects of a drawing is above 1.000 000, the 
OSNAP switches off, so searching in a large database will not engage the computer and will not slows down the work. 
This value can be changed according to the capacity of the computer.  
 
If the OSNAP is switched off the special point recognition can also be activated by pressing the Ctrl key. When the 
program is waiting for the definition of a coordinate, pressing the Ctrl key the OSNAP becomes activated temporarily. 

Object Snap Tolerance 

You can also modify the radius of the searching circle (Size of the pickbox (in % relative to the screen size). This must be 
defined in percentage of the screen size. Default value is 1 %. 

 Angle snap 

Angle snap controls where to 
locate the second point in 
relation to the first point. The 
second point snaps to the 
nearest fixed angle. Default 
directions are the following: 0°, 
45°, 90°, 135°, 180°, 225°, 
270°, and 315°. 
 

 

Angle snap 

Select this option to enable or disable angle snap. 
If you enable angle snap, the cursor can only move towards the defined directions. This is a very strong control and can 
be used only in special cases. We recommend that you disable this option. 
When you define Length or press the Shift button, the program finds the default angles even if the Angle snap option is 
disabled. 

Angle snap increments 

Select this option to change angle snap values with dialog. 
Add 
You can modify a default value or specify a new one. 

• Select the value you want to modify, or 
enter the new value in the Input field. 

• Click on the Add button. 
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Delete 
Delete the selected value. 
 

• Select the value you want to delete. 

• Click on the Delete button. 
Delete all 
Delete all values from the list. 
 

� If angle snap is active, grid snap is automatically disabled. 

Ortho snap 

Using the Tools menu - Ortho command you can switch on the ortho snap. In this case you can move the cursor into 
horizontal and vertical direction.  
If the Angle snap and the ortho snap are switched on the program prefers the ortho snap. 

Using angle snap with disabled snap option 

When you have specified the first point of an object: 

• Move the cursor to the desired direction. 

• The program is waiting for you to specify length or distance. 
Enter the appropriate values. 

• The second point snaps to the nearest special angle. 

Example: 
To draw a 3,05 m long horizontal 
line: 

• Specify the starting point. 

• Move the cursor near the 
horizontal direction. 

• Enter the value: 3.05. 
 

 

1.25.3. Cursor and Marker 

Marker settings can be found in menu point File menu – Options – Cursor and Marker. 

 Marker Settings 
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Enable markers  

Markers can be switched on and off in the program with this switch. After installing the program the option is in switched 
on mode. 

Marker colour 2D  

You can set in the colours of markers that appear in the floor plan’s windows of the program. Click on the colour area on 
the right to modify (change) value then choose a colour from the colour charts and press down the key OK at last. 

Marker colour 3D  

You can set in the colours of markers that appear in 3D windows. To change value click on the colour are on the right then 
choose a colour from the colour charts and press down the key OK at last. 

Marker scale 

You can increase dimension of markers because of screen resolution or other facts. Choose one from the rolling list on the 
right to change the value. 

Learning mode  

In this mode you can set in that shortcut menu of markers can remember or not the last commands. If you switch on the 
option, it allows remembering the last used operations for the program. Then the program indicates the actual default 
command in shortcut menu in bold type.   
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Special Shortcut 

The CTRL + Left mouse click executes fast delete command. This shortcut can be switched on and off in the program with 
this switch. After installing the program the option is in switched off mode. 

 Sensible reference-markers 

Sensible reference-markers are appearing when you move your mouse cursor over a reference point and you keep it 
there for a short time. A green coloured vertical and horizontal line will appear. This is a reference marker. 
 
When you marked a reference point you can move your mouse over another reference point and keep it there for a short 
time. Another reference-marker will appear. 
 
You can repeat the previous steps to mark multiple reference points at a time. 
 

 

Practical examples: 

Horizontal / Vertical snap 
You can draw horizontally or vertically aligned objects as the mouse cursor will snap to existing reference-markers. 

Intersection with a line 
You can mark a reference point of an object and use the intersection of the reference marker with another object. 

 
 

Apparent horizontal/vertical intersection 

Mark the endpoints of two objects and you can use the intersection of two reference markers to draft the apparent 
horizontal/vertical intersection. 
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 Element information tooltip 

You can switch on or off the information window that appears when you move the cursor above an element and wait a little 
bit. The window includes geometry data of the element. 

 
 
With the Toolbox – Drafting – Text - Place tootlip command you can place tooltip on the floor-plan. 
 
Az Elem info tooltip kikapcsolható a Fájl menü – Opciók – Kurzor és marker panelen. 
 

 

 Tab/F5 billentyű a referenciavonal váltáshoz: 

Az opció bekapcsolása esetén a fal referenciavonala a TAB billentyűvel váltható a 2011-es verziónak megfelelően. Ekkor 
az F5 billentyűvel a kurzor információ táblázatban lehet lépdelni. Kikapcsolása esetén a funkciók megfordulnak. 
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Ez esetben a szoftver automatikusan az első értékre ugrik, amelyet megváltoztathat egy új érték begépelésével. A TAB 
ismételt megnyomásával a következő érték válik módosíthatóvá. 
 

 
 

Ha egy értéket módosít, majd megnyomja az Entert, a program bezárja a szerkesztőmezőt és a megadott 
értéket rögzíti. Így például könnyedén megadhatja egy fal irányát a hajlásszög rögzítésével. 
 

 

Kurzor input doboz ki- vagy bekapcsolása 

Kattintson a Fájl menü – Opciók – Kurzor és marker panel  Kurzor input doboz engedélyezett input mezőbe az input 
doboz ki- vagy bekapcsolásához. 

Kurzor input doboz tartalma 

A Kurzor input doboz megjelenése kétféle lehet: 
� Távolság és szög 
� Távolság szög és koordináták 

 

 

 
 

1.25.4. Units and Angles Tab 

You can set the units and angle options necessary for design.  
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 Units of measurement 

Every object you construct in ARCHLine.XP is measured in units. You have to set up the system of units within the 
software before creating the first elements. 
 

 

Length 

Specifies the measurement unit and the precision of drawing. The program offers the following units: mm, cm, m and inch. 

Rounding Off Decimals 

To specify precision click the pull-down list and choose the appropriate item: 
E.g.: choosing 0.12 means two decimal points of precision. 
 

 
 
 

Drawing-specific length unit 
It defines the drawing-specific measurement unit and its precision. It includes marker properties, text properties, dimension 
properties and hatch dimension.  
 

� Precision does not refer to the dimensional precision required (that can be set in Dimension general properties); it refers 

to the precision of the query. This is shown by the Cursor position tooltip and by the Cursor info tooltip. For further 
references, see Chapter 2.19.3. –Screen Properties and Chapter 10.1.3. Dimensioning - Format parameters. 

 Angle 

You can set what angle measure to use and the direction of angles. 
 
The program offers the following angle measures: 
 

Decimal Degrees Displays angles in decimal units (e.g.: 
30,5°) 

Deg/Min/Sec Degrees, minutes and seconds (e.g.: 
30°30'00'') 
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Grads An engineering unit with 400 grads 
 
To choose the unit of angle click on the corresponding option. 
 

� The result of angle definition is not displayed when setting the dimensions of the object (that can be set in Dimension 

general properties), only when querying. This is shown for example by the Cursor position tooltip and by the Cursor 
info tooltip. For further references, see Chapter 2.10.7 – Cursor Input Box and Chapter 10.1.3. Dimensioning - Format 
parameters. 
 
Angle Direction 
You can measure angles clockwise and counter clockwise or topographically. Clockwise and counter clockwise directions 
are defined from the compass direction East, while topographical directions are defined counter clockwise from the 
compass direction North. 
To specify a direction, click on Direction options or the icon on the right. 
 
Positive axis to left direction 
You can specify the direction of the X axis. By default, the X axis points to the right, so the program measures positive 
values on the right. Enable this option to measure positive values on the left. 

1.25.5. Open and Save Tab 

You can define paths for files and directories and set options to import/export and autorecovery settings types.  

 
 
You can specify the following properties in the File menu - Options – Open and Save tab. 
 

Properties  Description  

Project Default Path 
You can modify your project default path. The program offers the 
project default path when opening a new project. 

Archive display  You can switch the Archive option on/off.  
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Archive path 

Specify the directory where the archived files should be saved into. 
By default it points to the …\Draw\Archive subfolder according to the 
installation. 
 
Under the Project default path the program creates a folders with the 
current date. Partial backups of projects are created here in 
subfolders named according to the project names. 
During the archiving procedure the .asc floor plans and plot layouts of 
project will be archived here. 
This archiving option provides automatic backups on each day, 
enables to return for a given state of the working procedure by date. 
Folders created this way are not deleted automatically. After finishing 
the work the users should ensure the deleting of unnecessary files 
themselves. 
 
ATTENTION: With the archiving option you cannot save entire 
projects but floor plans (.asc) files only! 

Image Default Path Sets the initial directory displayed by the open image file dialog box. 

Save 3D database  

You can specify the saving option for 3D model in the project. 
It is switched off by default therefore the 3D model database is not 
saved in the project. The 3D model can be created from the floor plan 
any time. 
In a case when the program recognizes that the 3D view contains 
orphan 3D solids without reference to floor plan the program offers to 
switch on this flag to save the 3D solids as well.  
When it is on on the whole 3D database is saved. In this case the 
project size may considerably increase. 

Save hatch 
components   

When you load a project the program displays big drawing quicker. It 
may increase the project size.   

Template Import 
Wizard  

Import templates from the previous versions See more in 4.6.11. 

Project Parameters 
Yo can specify a group of project information such as building site, 
address, status and more. 

DXF/DWG 
Sets the initial directory displayed by the open DXF/DWG file dialog 
box. 

Autorecovery 
With Autorecovery you can avoid data losses due to black-outs or any 
other unexpected events. 

Save Autorecover 
information 

You can activate Autorecovery with the Save Autorecovery 
information checkbox. 

Save frequency 

After a definite number of drawing commands (Save frequency), the 
program saves the current project. When you restart the program after 
the unexpected events, the last used project will be loaded 
automatically from that folder. 

 
 

 ! This temporary folder for Autorecovery will be deleted when you exit the program, so Autorecovery does not substitute 

the saving of the project. If you fail to save your drawing, and then exit the program, your entire work will be lost. 

1.25.6. User Interface Tab 

Define options to change the behavior of the user interface.  

 Drawing window arrangement 

The Drawing Window in ARCHLine.XP is the area where you draw. It is divided into work spaces known as 2D Floor plan, 
3D model, Section, Animation and Printing Layout.  You work always in the active one and you can switch between them. 
You can choose among three drawing window arrangement styles or switch the active work spaces into full size view. 
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 Workspace skins 

You can customize the graphical appearance of ARCHLine.XP workspace layout choosing among different colour models.   
 

. 
 

 Project Navigator setting 

The Design Centre integrates the Project Navigator by default. 
Project Navigator displays the project structure manager, templates and zones in a tree.  

! You can place Project Navigator as a floating toolbar anywhere on the screen.Choose the Option dialog – User Interface 

panel and select the Project Project Navigator is integrated into the Design Center checkbox and switch it off. 

 

 

1.25.7. Item Settings Tab 

You can configure ARCHLine.XP global settings for various object types.  

Global Settings  Description 

Select Raster images by their frames 
only. (Press Shift+Left Click to select with 
a click over the image) 

For raster images you can choose between two 
selection modes. By default the raster image is 
selectable if you click over an image or on the frame 
either. 
You can configure the selection mode in the Option 
dialog > Item settings tab > Raster Image General 
Properties.  
 
If you wish to switch off the selection by a left click 
over the image activate the Select Raster images by 
their frames only mode. 
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Applying this mode you have to press Shift+Left Click 
to select with a click over the image. 
 
This mode is useful when you trace over an imported 
raster image and you do not want to click on the raster 
image. 
 
 

Automatic space recalculation 
Data of room books that have been created by walls 
follow the modifications on the plan automatically. 
 

Embedded wainscotings (ON: inside wall, 
OFF: inside the room) 

In different countries there are different requirements 
of modeling the wainscotings of rooms. 
In some countries the wainscotings are added to the 
walls. 
In other countries waincotings are included in the 
definition of walls. In that case wainscotings start from 
the inner side of the wall and goes toward outside of 
the wall. As a consequence, the thickness of 
wainscotings do not increase the wall thickness in the 
3D model. The same applies to other room border 
elements like slab, roof etc. 
 

Minimal height belonging to the net area 
(Norm I) 

For Norm I net area caclulations this height parameter 
is taken. 
 

Minimal height belonging to the net area 
(DIN 277) 

For DIN 277 net are calculations this height parameter 
is taken. 
 

Use Superscript2 Use superscript characters for the representation of 
area and volume units:: m², m³. Use Superscript3 

Side marker to display wall reference line 
on screen 

Switch on/off the visible marker what identifies the 
wall reference line 

Door Lining and Mounting gap visibility 
The dimension of wall openings is increased by lining, 
mounting gap, shutter space and lintel dimensions. 
 

Wall type colour The three states enable to distinguish demolishing and 
existing walls from new walls in case of building 
renewal or building extension.  
You can assign colours to existing and demolishing 
walls accoding to the standards. The program hatches 
the walls with the specified colours on the floor-plan. 
The assignment is global and therefore the settings are 
applied to all walls with demolishing or existing 
statuses. Demolishing walls have no 3D 
representation, of course. 

Demolishing wall 

Existing wall 

Wall not connected 

 

When you create such a wall, connections to other 
walls are not established. In all the other cases the 
walls are connected to each other automatically 

 3D work plane 

Use of 3D work plane is a great help in 3D design. It is easy to define points with it in 3D. After definition of the work plane 
the position of 3D and geometrical objects can be defined on it. Geometrical objects placed in this way in 3D keep their 
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view when rotating the model; they rotate together with the work plane. A mesh marks Work plane; its properties can be 
set separately. 
 
Opening a 3D window in the program the work plane by default appears. In the 3D work plane dialog set the 
representation properties of work plane. 

Delta X, Y: 
Set the work plane grid in X-Y distance. 

Colour: 
Colour of your work plane. 

Grid nodes X, Y: 
Define the number of rectangles of work plane in X-Y directions. 
 

 
 
You can switch on and off work plane with the 3D menu - Activate global work plane command. 
 

� The work plane does not appear on the printing layout. 

 Stair standards 

If you monitor continuously the ergonomic requirements defined by standards in case of stairs selected from the stair sets, 
it can help you in the drawing of stairs. You can find it in the File menu - Options - Stair standard dialog box. 
 
During the planning the program monitors continuously that part of the values, which represented according to the 
standard, the other part you can select optional. The program signs the exceeded limits in red colour, but it doesn’t forbid 
the creating of the stair, if it doesn’t come up to ergonomics requirements.  
 
You can pick your Stair categories and Rise and going from a pull-down menu. Their combination defines the limits that 
must be met according to the relevant standard. 

 
 

 



100 3. Customize ARCHLine.XP 

Manual 

 

 
 
 These are the following: 2R +G (two times riser plus going), stair width, Rise and Going. When drawing the stairs from 
the stair library, the program monitors the compliance with these limits; if you exceed them, it is indicated by red colour. 
 

 
 

You can enable the monitoring of the following parameters: 
 

� headroom height above stair: it is relevant when allowing stairs through the ceiling slab. 
� set the walking line between 1/2 and 2/3 of the width of the stairs 

 
� Use the measurement set in the dialog window. If you switch off the option, the values of stair parameters will appear in 

cm in the proper dialog windows.  
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 Text 

Text displayed with boundary rectangle  
This command replaces text by its text 
box. (Redraw is quicker in this mode.)  

 

 

Texts are delineated in contours without 
shading 

If this option is checked in, only the 
outlines of characters appear. 

 

Keep readability when rotated in:  

You can direct the readability of rotated text with this option.  
 
If the option is in switch on status, the readability rule is valid for the text in the defined angle area after the rotation too. 

 
If the option is in switch out status, then the program ignore the readability rule, so it applies the rotation transformation to 
the text too. 

 

1.26. Keyboard shortcuts 

Keyboard shortcuts are combinations of keyboard strokes and clicks that you can use to start commands.  
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Many keys and key combinations are predefined in ARCHLine.XP® the others can be defined freely. You can change also 
the predefined combinations. A shortcut key can be a single character, too. 
 
To define a shortcut click on the Tools menu - Customize - Toolbars command. 
 
In the dialog there are commands for the Menu, Toolbars and Keyboard Shortcuts groups, commands and the key or key-
combination assigned to them. 
You can change Keyboard Shortcuts. 
 

 
 

• Select a command group. 

• Select the command from the list. 

• Define the new key or combination to assign to the command. 

• Click on the Modify keyboard shortcut button. 

• With the Delete keyboard shortcut button you can delete a shortcut. 

• If you want to use the default shortcuts, click on the Reset All button. 

Copy shortcuts to the clipboard 

Now you can copy all shortcut settings to the clipboard, and then you can paste it in another application. Then you can 
print it out and use it as an aid to your work. 
 

• Click the Copy all to clipboard button to copy all shortcut settings to the clipboard. 

• Open a text editor or other application to paste the content of the clipboard.  

Sets - Export/import possibility 

You can save the shortcut assigns to a set. You can export the saved set into the .set file. This .set file can be loaded into 
the actual template file using the File menu - Import - Template option.  
 

� See the chapters 3.2.3. Using sets of properties and chapters and 4.6. Managing styles. 

1.26.1. Map of default shortcuts   

The shortcut keys make possible to activate the often used ARCHLine.XP® commands directly.  
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Shortcut key Command 

Alt+A Menu - Modify/Copy properties 

Alt+C Menu - Modify/Create Similar 

Alt+F3 Menu - View/2D -> 3D/By rectangle 

Alt+R Menu - Tools/New reference point 

Alt+T Menu - View/2D -> 3D/By rectangle on all 
floors 

Alt+W Menu - 3D/Activate global workplane 

Alt+A Menu - Modify/Copy properties 

Ctrl+1 Menu - Building/Wall/Single wall 

Ctrl+2 Menu - Building/Door/Drag and drop - 
openings 

Ctrl+A Menu - View/Zoom/Zoom all 

Ctrl+B Menu - Edit/Move 
Ctrl+C Menu - Edit/Copy to clipboard 
Ctrl+D Menu - Edit/Delete 

Ctrl+E Menu - View/Pan 

Ctrl+F Menu - Edit/Trim/First object 

Ctrl+G Menu - Tools/Grid 

Ctrl+L Menu - Edit/Lengthen/Lengthen by cursor 

Ctrl+N Menu - Edit/Lengthen/Lengthen by number 

Ctrl+O Menu - File/Open project 

Ctrl+P Menu - File/Print 

Ctrl+Q Menu - Edit/Mirror/Move 

Ctrl+R Menu - View/Redraw 

Ctrl+S Menu - File/Save project 

Ctrl+T Menu - Drafting/Group/Edit group 

Ctrl+U Menu - Edit/Duplicate 

Ctrl+V Menu - Edit/Paste from clipboard 

Ctrl+W Menu - Edit/Mirror/Duplicate 

Ctrl+X Menu - Edit/Cut 

Ctrl+Y Menu - Edit/Redo >> 
Ctrl+Z Menu - Edit/Undo << 

Ctrl+Shift+S Menu - File/Save project as 

PAGE UP Menu - View/Floors and building/Floor up 

PAGE DOWN Menu - View/Floors and building/Floor down 

F2 Menu - Windows/Magnify 

F3 Menu - View/2D -> 3D/By selection 

F4 Menu - View/Zoom In 

F7 Menu - View/Zoom/Previous 

F8 Menu - Tools/Ortho on 

F9 Menu - Windows/Toolbars/Design center On 

F10 Menu - View/Zoom all in all windows 
 
This list does not contain all Ctrl shortcuts. In ARCHLine.XP® there is possibility to define freely your own shortcuts. See 
Tools menu - Customize - Toolbars command. You can put the shortcuts from here to the clipboard, and then you can 
list them.   

1.26.2. Page up - Page Down keys 

On the floor plan the Page up - Page Down keys are used to move between floors of the building. 
In the 3D window they are used to change between the perspective views. 
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1.27. Customize Toolbars, Toolbox and Design Center  

The ARCHLine.XP interface is highly configurable, enabling you to adjust and arrange Toolbars, Toolbox, Design 
Center and keyboard shortcuts elements to meet your working preferences. All layout changes are saved as a 
Profile and you can switch among profiles. 

1.27.1. Handling Interface Elements 

You can add, hide or show various interface elements with toolbar buttons, menu items, or keyboard shortcuts. All 
layout changes are saved automatically. 

1.27.2. Creating a new Toolbar 

To create a new toolbar do the following: 

1. Choose Tools > Customize > Toolbars. The Customize user interface dialog box appears. 

 

The Menu and Toolbars panel contains a list of toolbar and Menu command categories as well as all commands in 
each category. 

2. Click on the Create Toolbar button. An empty toolbar will appear at the top-left corner of the application with a 
name ‘Toolbar 1’ or 2, 3, 4, etc. 
Click on the Toolbar 1 on the list. You can rename the toolbar with a click in the 'Toolbar 1' field on the right side 
editable field. 
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3. Click and hold on a Toolbar or Menu command name in the list of toolbars and Menu commands.  

4. Drag the toolbar or Menu command name to the desired position on the new toolbar. An insertion cursor should 
appear.  

 

5. Release the mouse button to place the toolbar or Menu command on the toolbar.   

Note: You can remove a button from the user toolbar in a similar way.  Click on a button then hold on and drag out 
from the toolbar.  Release the mouse button outside of the toolbar. 

1.27.3. Creating a new Toolbox entry 

To create a new toolbox entry do the following: 

1. Choose Toolbox > Options > New favourites command. 

The Options menu is represented by a gear like icon. 
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The new toolbox entry appears.  

 
Click on the header of the new toolbox entry called Favourites. You can rename it with a right click on the header 
field and type the new Title. 

 
How to insert an icon into the new toolbox entry? 

1. Choose Tools > Customize > Toolbars. The Customize user interface dialog box appears. 

2. Click and hold on a Toolbar or Menu command name in the list of toolbars and Menu commands.  
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3. Drag the toolbar or Menu command name to the desired position on the new toolbox entry. An insertion cursor 
should appear.  

4. Release the mouse button to place the toolbar or Menu command on the toolbox.   

 

Note: You can remove an icon from the user toolbox entry with a right click on the icon. Choose the Delete 
command from the pop-up menu. 

 

1.27.4. Customize the Design Center 

The DC customization requires manual editing. You have to create a new folder named Designcenter under the 
C:\Users\xxxx\AppData\Roaming\cadline\ARCHlineXP2016\Profiles\My Profile folder in this example. 
The folder must contain 2 files with the name DesignCenter.png and DesignCenter.xml as figured below. 
The XML file contains the DC new shape description. See example below. 

<DCController> 
      <m_nodes Count="1"> 
         <Item m_name="BALU_links"> 
            <m_commands Count="4"> 
                <Item m_name="Automatik" m_command="GROUP" m_UsericonID="0"> 
  <m_categories Count="1">   
  <Item>Holler\BALU\Automatik</Item> 
                 </m_categories> 
              </Item> 
   <Item m_name="Motor_Bau" m_command="GROUP" m_UsericonID="2"> 
  <m_categories Count="1">   
  <Item>Holler\BALU\Motor_Bau</Item> 
                 </m_categories> 
              </Item> 
  <Item m_name="Hand" m_command="GROUP" m_UsericonID="3"> 
  <m_categories Count="1">   
  <Item>Holler\BALU\Hand</Item> 
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                 </m_categories> 
              </Item> 
  <Item m_name="Gehtüren" m_command="GROUP" m_UsericonID="4"> 
  <m_categories Count="1">   
  <Item>Holler\BALU\Gehtüre_L</Item> 
                 </m_categories> 
              </Item> 
           </m_commands> 
         </Item> 
        </m_nodes> 
</DCController> 

 
 
Tags:  
 

m_UsericonID  

Each command in the Design Center is represented by a button containing an icon. When you create your toolbar, 
in addition to creating the buttons, you must populate it with the images you want to associate with each button. 
This is done through Image List file called DesignCenter.png. 
First you must create and populate an Image List, then associate it to the toolbar. All icons in an image strip have 
the same size (32 pixels) and the same colour depth. 
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How to add a new icon in the image strip? 

Open the image strip with an appropriate bitmap editor like Paint.net, Paint or similar application. 
When the selected image is open in the editor you can draw and modify the images or enlarge the bitmap 
horizontal size with 32 pixels or n times 32 pixels. 
When you finished resave the bitmap with the same name.  
m_UsericonID addresses the icons from 0. 0 means the first 32x32 pixel range in the strip.  
m_UsericonID =1 points the next 32x32 pixel range in the strip and so on. 
 
m_name 

The name of the button. 
Example : Item m_name="Automatik" 
 
m_command 

The ARCHLine.XP library category name that can be:  
GROUP, DOOR, WINDOW, STAIR, OBJECT, LAMP, MATERIAL, PROFILE, LIGHT_SOURCE,  RENDERING_STYLE. 
Example: m_command="GROUP" 
The second option when an ARCHLine.XP command is assigned to. 
Example: m_command="#object #sstair #path3D" 
 

 

 

1.27.5. How to create a new Profile 

You can customize the program settings and appearance in the Options dialog. 
The Options dialog is located in the bottom left-hand corner of the ARCHLine.XP Status bar. 
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1. Click on the first icon (gear like) to display the Options dialog. 

2. Choose the User Interface button 

3. Click on the Profile Package button. The Profile Package dialog box appears. 

4. Choose the left side button to save the current profile. 

 
Save it with a name you like to see your Profile when you restart the ARCHLine.XP.  

 

1.27.6. How to activate a new Profile 

You can customize the program settings and appearance in the Options dialog. 
The Options dialog is located in the bottom left-hand corner of the ARCHLine.XP Status bar. 

1. Click on the first icon (gear like) to display the Options dialog. 
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2. Choose the User Interface button 

3. Click on the Profile Package button. The Profile Package dialog box appears. 

4. Choose the right side button to import a new profile. 

 
Open an .environment file that contains your Profile.  

 
When the import is ready, select the new Profile from the Profiles List. 
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The new Profile will be active when you restart the ARCHLine.XP. 
 

 

1.28. Parameters 

Before you use any architectural object or the geometric drawing tool of the program, specify the properties of objects first. 
Use the commands in the Building menu, Drafting menu and Dimension menu - Properties command to set the 
properties. You can also access these properties by right-clicking the icons in the Toolbox. 

Introduction 

Properties are the graphical and structural features of objects and objects. 
 
All object types have: 

� general properties, such as colour, line width, line type, layer; and 
� special properties (e.g. in the case of walls height, thickness, hatching, layer properties, etc.). 

 

� For a detailed description of the special properties of object types see the Chapter on the Detailed 

description of the special properties of object types. 
 
You can save the edited set of properties of each object type in Sets and store the sets in the template assigned to the 
project. 
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� For detailed information on the use of the template see Chapter 4.6 on Managing templates. 

1.28.1. General properties 

In the Properties dialog box you can first set the general properties of each object, such as colour, line width, layer, line 
type, and priority. 
 
You can set the colour, line type, and line width: 

� Directly, by specifying the property explicitly (e.g. the colour is red). 
 

� Indirectly, so that the object acquires its general properties from the layer assigned to the object. 
� 1. If the Layer control mode in the Modify menu is turned off, to specify the colour, line type, and line width you must turn 

on each Layer property separately. E.g. for colour activate the Layer option. 
 
2. If the Layer control mode in the Modify menu is turned on, among the fields of general properties colour, line type, and 
line width are greyed out and are non-editable. In this case the program acquires these properties from the layer assigned 
to the object. 
 

� See Chapters 3.4. on Managing layers and using properties  

 Colour 

• Choose a colour from the colour palette by clicking the box of the desired colour. You can choose from the 
256 colours of the colour palette, or any other colour from additional colour palettes. 

• If you do not want to change the colour, click Cancel. 

• If you want to use the colour of the layer assigned to the object, activate the Layer option. 

 Layer 

This specifies the current layer. By using this mode, you can assign different layers to each object type. You can turn 
layers of a drawing on and off when drawing. (For the sake of an unobstructed view, it is recommended that you store 
dimensions on a separate layer as it is not necessary to display it as you work.) 
 
• Choose the layer to be assigned to the object from the pull-down menu. 
You can select the layers in the Properties dialog box only if you have already created them in the Layer dialog box. 
 

� See Chapter 3.4. Managing layers for a detailed description on layer handling. 

 Line type 

ARCHLine.XP® allows you to 
choose from predefined line types, 
or you can create your own custom 
line type. 
 

• Choose a line type from the 
list. 

 
 

• If you want to use the line type of the layer assigned to the object, select ’Layer’ in the pull-down menu. 
 

� It is not possible to set the line type in the Text general properties dialog box. 

To set a custom line type, use the Tools menu - 2D group - Create new line type command. 

 Line width 

This specifies the current line width. 
The line width can be set even at a minimum of 0.01 mm, there is no upper limit. 
A line width of 0 defines the thinnest line of the output device (plotter, printer, monitor, etc.). 
 

• Enter the line width or select one of the predefined values. 
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• If you want to use the line width of the layer assigned to the object, choose ’Layer’ in the pull-down menu. 

 Priority / Draw order 

You can set numerically the priority of elements: 1 – top-most, 8 – bottom-most. 
Element with a low priority number will be placed over elements with high priority number. 
This way you can define which element should cover other elements in case of overlaying elements. This is very important 
when printing. 
 
Using the Draw Order commands in the shortcut menu of an element you can set graphically the priority numbers. You 
have the possibility to put to front or back, to forward one or back one. You have also possibility set the priority relative to 
other one. 
 
The graphically set priority value will appear in the Properties dialog window – Priority field.  
 

 
 
To Front The priority number of the element will be 1 – top most. 
To back The priority number of the element will be 8 – bottom 

most. 
Forward one The priority number of the element will be decreased. 
Back one The priority number of the element will be increased. 
In front of The priority number of the element will be decreased 

relative to the priority number of the selected element. 
Send Under The priority number of the element will be increased 

relative to the priority number of the selected element. 
 

• Select a priority number (1-8) from the list. 
 

 

 

The hatched area has a level 5 priority, 
while the polygons representing 
houses have a level 8 priority, so the 
hatched area overlays the polygons. 
 
 
 
 
 
 
 
The hatched area has a level 8 priority; 
the polygons’ priority is higher (5), so 
the polygons are visible in the hatched 
area. 
 
 

1.29. Shared Parameters 

Shared Parameters have been developed in line with the BIM Object Standard. Shared Parameters allow the designer to 
create BIM objects. By using the BIM Object Shared Parameters the designer will gain consistency when scheduling and 
co-ordinating information. 
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Shared parameters are definitions of parameters that you can assign to styles or the project itself.  Shared parameter 
definitions are stored in a common text file, allowing to access this file from different projects equally.   
Note:  
You can download a widely used standard NBS BIM Object Shared Parameters file from 
http://www.nationalbimlibrary.com/nbs-shared-parameters.  
 

 

1.29.1. Create Shared Parameter Files, Groups, Parameters 

The shared parameter file contains the shared parameters definition.  
 
The Shared Parameter dialog is available from: File > BIM > Shared Parameters  
 
The Shared Parameters dialog opens. You can import an existing shared parameters file or you can create a new one 
where you can add groups, and parameters witihin the groups.  
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Adding a new group: 

� In the Groups box, click on New. 
� Enter a name for the parameter group, and click OK. 

Adding parameters: 
� From the Groups drop-down menu, select a group. 
� In the Parameters group box, click on New. 
� In the Parameter Properties dialog, enter the parameter name, discipline, and type of parameter. Type specifies the format 

of the information you can enter for the parameter value.  
 

 
You can save the shared parameters in a file with a click on the Save as button. Enter the file name, and navigate to the 
desired location. 

Rename Parameter Groups 

� Select the group from the Groups menu. 
� Click Rename. 
� Enter the new name, and click OK 

Delete Parameter Groups 

� Select the group from the Groups menu. 
� Click Delete. 

Move Shared Parameter 

You can move an existing shared parameter to a different group. 
 

� Select the parameter from the Groups menu. 
� Click Move. 
� Select the new group from the Selected Group list, and click OK 
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You cannot rename an existing shared parameter or change the type. 

 

Delete a parameter 

� Select the parameter from the Groups menu. 
� Click Delete. 

 

1.30. ARCHLine.XP Common Parameters 

In ARCHLine.XP you can manage custom parameters.  You can assign your individual custom parameters to any styles 
and any instances. The parameters assigned to styles are copied to the created objects. Using this method you can create 
your own ‘database’: 
 
You have two options to start assigning custom parameters: 
 

� You can add new parameters in the Properties dialog, or  
� You can import parameters from Excel spread sheet by dragging 

I. Add new parameters in Properties dialog  

Double click the selected object (e.g. wall) on the floor plan. The Properties dialog box then appears. 
 

 
 

• Click on the BIM Parameters button. The Manage Parameters dialog pops up. 

• Click on the Add parameter button 

• Define the parameter name and type of parameter. The available type of parameter depends on the object 
type. (It means the wall has different type of parameters like wall length, surface in, out, etc., and e.g. the 
roof comes with roof specific parameters as edge length, etc. 

• Close the dialog with ENTER. 

• You will see the new parameter in the Manage Parameters dialog where you can complete the definition 
adding Value and Description. See the figures below. 
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I. Import parameters from Excel  

• Open the Excel spread sheet. 

• Select the desired line. 

• By clicking the lower edge of the line, move the cells to the dialog box with the drag and drop method. Now 
the values are entered in the cells. 
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II. From the Excel spread sheet by dragging 

 
 

• Select the desired line in the Excel spread sheet. 

• Having selected the line click the lower edge of the line and move it to the wall in the drawing with the drag 
and drop method. Now the Import cell dialog box appears and the values are entered in the cells. 
 

• When two or more objects overlap and therefore selection by dragging is ambiguous, select the object to 
which you actually wish to assign the imported data in the dialog box displayed. Click Next. 
 

 
 
From this point on the two methods are similar: 
 
 
 
Here you have to assign the cell values to the variables. At first variables might not be assigned to the cells you want them 
to be associated with, as in the line of the Excel spread sheet the order of variables may be different. 
In this case, with the Field associations button you can specify for each variable from which cell the program should load 
its value. In our example the program obtained the code from the first cell, description from the second cell, and value from 
the fourth cell. 
 
The fields are editable after loading, so for example for unit you can specify the volume: 
 
Unit 
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You can specify any text for the unit, 
e.g. m3, or you can choose a code 
from the list. The Excel list will use 
this code for calculating the budget. 

 

 

Factor 
It only makes sense to set factors in the case of walls, slabs, roof surfaces and roof edge where the factor specifies the 
layer. Factors should be round numbers. 

 
If you do not wish to assign the value of variables from the Excel spread sheet, you can enter them by inserting a new line 

   
 
You can also indicate several variables (line) to an object.  

You can delete unnecessary lines with the  button. 
As from now on the wall has these attributes: 

 
 
Similarly to the above, you can assign variables to other floor plan objects. By copying properties you also have the option 
to transfer only those variables of an object to another that have been assigned. 

Budget calculation using the Excel spread sheet 

This function provides support for the calculation of the budget of certain building projects or other calculations. 
Essentially, in the case of floor plan objects you can assign the cost, unit, and factor to parameters such as area or 
volume, whereby you can obtain a combined costing spreadsheet in Excel format. 
 
Suppose you want to calculate the material cost of wall building and you know the volume. In this simplified example, a 
wall section has the following parameters: 
 



122 3. Customize ARCHLine.XP 

Manual 

 
 
In an Excel spreadsheet where you have an objectized list of all costs, it is easy to assign these data to ARCHLine.XP® 
objects. In the present example, one line of the spreadsheet indicates the material cost of the wall: 
 

 

Listing 

When you finish a plan, you can export the consignation in an Excel spreadsheet. You can access this list with the Add-
On – Quantity Take-Off - Building command. 

1.31. Create Annotation Labels 

Annotation is a powerful option for storing text (labels) to place on your drawing.  
An annotation label is a text table placeholder where you place substitution text for the labels. 
 
The Define Label dialog is available from File > BIM > Define Label  
 
You add label parameters by moving them from the left side Types, Group and Name listboxes. The annotation label uses 
the text properties. 

1.31.1. Edit Label Dialog 

When the dialog box opens, it will look similar like below. 
You can assign parameters to labels within the Edit Label dialog. 

1. Create a New Label. (1) 
2. Enter a name for the Label, and click OK 
3. Select the type from Types list (2) 
4. Select the Parameter Group from Group list 
5. Select the Parameter from the Name list 
6. Click on the -> button to move it into the Label Parameters window. 
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When you place it, Label displays the parameters from the first to the last as listed in the Label Parameters window. 
 
You can reorganize the label. Click on a parameter and shift its position using Up and Down button. 

1.31.2. Label Parameters Options 

You can edit the cells in the Label Parameters window. The parameter names are listed in the first column. 
 

� Visible. You can make this parameter visible or off. 
� Prefix. You can add a prefix to the parameter value by adding a text string in this option. 
� Sample Value. You can change how the place-holding text appears in the parameter. Empty cell means to display the 

value measured from the drawing. 
� Suffix. You can add a suffix to the parameter value by adding a text string in this column. 

1.31.3. Place Label 

You can place the predefined labels on the drawing. Label first. The parameter names are listed in the first column. 
 
The Place Label dialog is available from File > BIM > Place Label  
 

1. Select the appropriate type first 
2. The labels are listed in Labels combo box 
3. Select the label you are going to place on the drawing and click OK 
4. Select an object and place the label on the drawing. 
5. Select the next objects in a loop 
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1.31.4. Update Labels 

Labels are associative so you can update the values displayed in the annotation labels on the drawing.  
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The Update Labels command is available from: File > BIM > Update Labels 
 
The program scans the drawing database and updates all labels with the current values. 

1.32. Materials 
The Material properties manage render material settings for the selected objects. 
Rendering properties can be assigned objects that will be used with the integrated renderer. 
 
You can access the Material properties dialog in several ways;  

• you may select it from the View menu, or  

• in the object properties dialogs, or 

• in the Design Center: 

1.32.1. Material properties 

For the representation of architectural drawings and for a realistic display it is necessary to define materials. The program 
applies material properties to all architectural objects and 3D objects. You can specify material properties in the Material 
properties dialog box. To access these properties open the Material dialog box first where you can handle the materials.  

1.32.2. Managing materials 

You can access the Material dialog box and the Material properties dialog box within in several ways; you may select it 
from the Tools menu, or in the architectural objects properties dialog, 3D objects, or the Design center: 
 

� The Category manager dialog box appears instantly when you select Accessories - Material manager in the Tools menu. 
The dialog shows the previews and properties of the available materials. 

� See description of Category manager in chapter 3.3. 

 
� For access via architectural objects, click the box of the material in the properties of the selected architectural object. 

 

 
 

� For access via 3D objects, double click the material in the Object properties dialog box. 
 

 
�  
� For access via the Design center, first choose Material in the Design center and select one of the available material 

classes. Materials then appear in the content window of the Design center, where by clicking one of them the Material 
properties dialog box pops up. 

1.32.3. Managing material classes 

You find the material classes, subclasses, and categories in the left window of the Material properties dialog box 
arranged in a directory format. Materials are grouped into two classes: 
 

� In Model 
� Factory Materials 

In Model 

The In Model contains those materials that the user applies in a given project or places here. Therefore, these materials 
vary every project. For example if you render a material to an architectural object from the Program directory, the program 
automatically creates a copy of this material in the In Model directory and will subsequently use this copy. You cannot 
create any subclasses and categories in this directory. When saving the project, you also save the materials of the Project 
class. 
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Factory Materials 

By default tARCHLine.XP contains the factory materials sorted by categories. Once you start the program, these materials 
are always available. You can create new sub-categories. The factory materials are non-editable. Obviously the properties 
of user-created materials are editable. 

1.32.4. Creating materials in the Design center by dragging 

Once you created a category in the Material container, you may ’drag’ several texture images (.bmp or .jpg) in one step to 
the selected category with the drag and drop method. Do as follows: 
 

• Set the window of the Design center in such a way that the category in which you wish to place the new 
textures can be seen. For example: Tiles -> Paves 

• Select the textures in the window of Windows explorer. 
 

 
 

• Drag and drop the 
selected files to the 
category. 

• After dragging the 
Material properties 
dialog box appears, 
where you may assign 
similar properties to 
the materials thus 
created. (It is advisable 
that you create 
materials that have the 
same properties at a 
time.) In the dialog box 
the name, the 
replacement color and 
texture image box is 
now disabled. 
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1.32.5. Material properties 

Choose a material in the Tools menu – Accessories – Category manager dialog box then click Modify or Copy. The 
Material properties dialog box then appears. 

 
 

Create new material 

Select an image file to define the texture. Choose the Appearance tab to specify material settings for the selected texture. 
These settngs will be used with the integrated renderer.  
Replacement colour 
You can see the current texture in the left box. If you do not want to assign a texture, click the No texture button. In the 
photorealistic view colour will be displayed instead of texture, which you may set by clicking the colour icon next to the 
texture image. 
If you clicked the No texture button and lost the formerly assigned texture, you can recover it by clicking again. 
Colour icon 
This setting has two functions: 

� As referred to above, this colour will be displayed in the photorealistic view when there is no texture. 
� The 3D view toolbar - Shade with material colour command uses this colour in the vector graphics drawing. 

� For a description of colour settings see Chapter 3.8.6.5. on RGB colour management. 

 
Material texture 
If you wish to assign a different texture, click the box displaying the texture and select the desired texture by opening the 
corresponding .bmp or .jpg file in the Open picture dialog box. The name of the material will automatically be that of the 
name of the open file without the file name extension. 
 

 Appearence 

You can choose the rendering mode in a pull-down menu. Depending on the rendering mode you select, you can set 
different physical features that affect rendering. The physical features you can specify and their definitions are the 
following: 
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Transparency Determines the extent of the transparency of 
the material. 

Bump altitude Bump Mapping simulates the impression of a 
detailed 3D surface with shading as if the 
surface had lots of small angles, rather than 
being completely flat. The height of the bumps 
can be adjusted using the Amplitude control. 

Bump softness This control is use to set the amount of blur 
that is applied to the 'bump map' image. 

Ambient factor Shows how the material reacts to ambient light. 

Diffuse factor Shows how the material reacts to diffuse light. 
Lights, Sun, camera light. 

Specular factor The specular factor controls the reflection of 
light from a "shiny" object 

Exponent Determines the sharpness of the distribution. 
Roughness Light is more radiant on a smooth surface. If 

roughness is set to a low level, radiance is 
concentrated on a small surface; if it is set high, 
radiance is distributed on the surface. 

Specular colour You can specify the specular colour in the 
colour palette. 

Transmission 

factor 
Has the same effect as transparency in the case 
of glass. 

Mirror factor Shows how the material reflects light from the 
surrounding objects. 

Refraction This setting concerns the physical 
characteristics of glass. 

 
The rendering modes you can set are the following: 
Matte 
This reflection model ensures a dull and dim appearance. The extent of reflection from objects is determined by the 
ambient factor and the diffuse factor together. This model is suitable for displaying dull materials such as brick or textile. 
Metal 
This reflection model ensures a metallic appearance. The extent of reflection from objects is determined by the ambient 
factor and the specular factor together. The distribution of radiance is determined by roughness. At a low level of 
roughness the reflection of shine is sharper, and it affects a smaller area of the object. This model is suitable for displaying 
most metallic materials such as steel or copper. 
Phong 
This reflection model corresponds to the well-known Phong model, where reflection is highest in the direction opposite to 
the viewpoint direction. The extent of reflection is determined by the ambient factor, the diffuse factor, and the specular 
factor together. The sharpness of the shiny surface is determined by the level of the specular factor. If this level is low, 
transition from the shiny surface is smoother, but radiance is concentrated in a smaller area. The colour of the shiny 
surface can be determined by setting the specular colour. This model is suitable for displaying glittering or delicately 
polished materials such as ceramic or glass. 
Plastic 
This reflection model has the same shiny effect as the Phong model. The extent of reflection is determined by the ambient 
factor, the diffuse factor, and the specular factor together. The sharpness of the shiny surface is determined by roughness. 
At a low level of roughness the reflection of shine is higher and affects a smaller area of the object. The colour of the shiny 
surface can be determined by setting the specular colour. This model is suitable for displaying glittering or delicately 
polished materials such as plastic or varnished surface. 
Glass 
This reflection model is suitable for displaying glass-like materials that are characterized by both reflectivity and 
transparency. Secondary reflection and light transmission is displayed by ray tracing. The extent of reflection is 
determined by the specular factor, the transmission factor, and additional lights defined by the mirror factor together. The 
distribution of radiance is determined by roughness. At a low level of roughness the reflection of shine is sharper, and it 
affects a smaller area of the object. The program applies the same refraction factor to lights of all wavelengths. The default 
value equals the value in the case of glass. This model best imitates glass surface. 
Mirror 
This reflection model realizes secondary reflection by means of ray tracing. The extent of reflection is determined by the 
ambient factor, the diffuse factor, the specular factor, and additional lights defined by the mirror factor together. The 
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distribution of radiance is determined by roughness. At a low level of roughness the reflection of shine is sharper, and it 
affects a smaller area of the object. This model best imitates glass surface. 

Tips: 

� If you want to use specular tile lining, use the Mirror mode. 
� Use the Glass mode in the case of lamp globes: here you have to set transparency to a low level whereas the 

transmission factor should be high. 
If the transparency level is not zero, the object in question will cast no shadow. If you want a glass surface to cast shadow, 
e.g. a lamp globe, you have to set transparency to zero (that is you must bring the slide to the left). 

� Bump Mapping applied on Color material:  
You can add a predefined pattern to pure color material and it appears to be surface roughness. If you look closely, you 
see lots of detail on it. You can choose among wood, stone, plaster, leather, etc. effects. 
 

 ! Bump mapping is only a effect to make a rendered surface look more realistic, but it does not modify the shape of the 

underlying object. 
 

 

 Physical Properties 

It is possible to assign the horizontal and vertical sizes to a texture or let it undefined. In that case, the texture is stretched 
to fill the destination area. 
 

Physical Properties  

Position Position has two modes : 
When you stretch a texture on a face, the position is set on Stretch. The 
mapping size fields change to disabled. 
When you repeat a texture on a face, the position is set on Tile. 

Material 
mapping 
horizontal 
size 

Type a value in the input field to change the horizontal size of the 
texture.  

Material 
mapping 
vertical size 

Type a value in the input field to change the vertical size of the texture. 

Direction You can rotate the texture with a degree. i 

 
Keep aspect ratio 
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When the Keep aspect ratio button is ON that means the changes either on the width or the height will reflect on the other 
value as the software will recalculate the other keeping the aspect ratio between the two. 
 
If the Keep aspect ratio button is OFF the two values can be changed individually and it will have no effect on each other. 
 

 

This state of the button indicates that horizontal and vertical 
sizes can be specified separately. 

 

 

This state of the button indicates to keep relative horizontal 
and vertical sizes. Most of cases it is important to maintain the 
aspect ratio to avoid stretching the graphic out of proportion. 

 

 

 Thermal Parameters 

Thermal parameters are input values to define U-value, or thermal transmittance. 
 
Thermal transmittance, also known as U-value, is the rate of transfer of heat through a structure (which can be a single 
material or a composite), divided by the difference in temperature across that structure. The units of measurement are 
W/m²K. 
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Thermal Parameters 

Conductivity Thermal conductivity is a material property describing the ability to 
conduct heat. Thermal conductivity units is W/(m K) in the SI system. 

Density Mass density is a measure of the mass of a substance per unit volume. 
The SI unit of kilogram per cubic metre (kg/m3) 

Specific heat The specific heat is the amount of heat per unit mass required to raise 
the temperature by one degree Celsius. The units are usually Joules 
per kilogram-degree Kelvin (J/ kg-K ). 

Permeability Permeability is a measure of the ability of a porous material (often, a 
rock or an unconsolidated material) to allow fluids to pass through i 

Porosity Porosity is a measure of the void (i.e. "empty") spaces in a material, 
and is a fraction of the volume of voids over the total volume between 0 
and 1 

 

Copy and Paste: 

Copies the material to a new material. 

Hatches 

A material has 2 different hatches, depending how the material is displayed. 
 
For example in the case of a brick material: 

� You have to specify the hatch on section. In the case of a brick wall, we use 45-degree lines on the section. 
 

� If this brick can be used for outer walls, hatching is also important in the 3D view. 
To have the hatches in the 3D view you need to use the View menu – View properties – Image < - > Vector graphics 
command. 
In the case of a brick wall, we use the standard hatch on the floor plan that is 45-degree lines. This hatch is not the 
property of the material, but that of the wall; therefore, you have to specify it in the Wall properties dialog. 
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Hatch in 3D 
When setting material properties you must also specify 3D hatching, which enables you to display textures in the 3D 
model. For this option, you must activate the Display button.  
The hatch you specify here appears in the 3D model when you activate the Textured preview mode in the Navibar 
command. 
 
If the Display option is deactivated, the material appears with the assigned colour. 

Hatch on section 
Here you can specify what hatch you would like to represent the material on the vectorial section. To use this option, you 
must activate the Display button. 
This hatch appears only on the architectural section and on the condition that the File menu -Options - 3D Preferences - 
3D Objects- Section plane created with hatch is activated. You can switch on the option in the Section properties dialog 
window too. 
To activate hatch on section, use the hidden line mode. 
 
You can specify texture pattern colour and the texture background colour at the bottom of layer settings. 
When the Display is on, you can select the hatch pattern of the object and set its properties: horizontal and vertical density 
of the pattern and line direction defined in degree. 
 

• Click the pattern icon if you want to display and select hatch pattern types. 
 

 
 

You can choose from various pattern types in the dialog box by clicking either the pattern name or the pattern image. You 
can move hatch patterns to new categories; this way you can arrange patterns in a structure that best suits you. 
 
Copying hatch settings 
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When clicking this button you have the option to copy hatch settings. You can copy the settings of Hatch on section to 
Hatch in 3D, and conversely. 

1.32.6. RGB colour management 

Colour is among the properties of each ARCHLine.XP object. Objects are represented with their colours on the screen or 
on the printed documents. Besides the colour properties of objects, colours have important role at materials when you 
represent materials with colours. In both cases, the program uses RGB colours. 
 
Displaying various colours is not only important in presenting a photorealistic image of wall paints and facades, but also in 
the case of a coloured 3D view. The option of RGB colour use therefore is significant as it enables you to illustrate or print 
vector graphics drawings of various facades in true colours that are in realistic Ral, Sikkens or Pantone colours. 
 
Colour settings thus have two functions: 
 

� Click No texture in the Material properties dialog box to define the colour for the material. Now instead of the texture the 
colour appears in the photorealistic view, which you can set by clicking the colour icon next to the texture image. 

� The Navibar – 3D preview modes - Coloured command uses this colour on the vector graphics drawing regardless of 
whether you defined the colour or texture for the material. 

�  
�  

In the following example we use wall paint texture in the photorealistic view and yellow on the vector graphics drawing. 
 

  
 

 
 



134 3. Customize ARCHLine.XP 

Manual 

 
 
As we mentioned before, by clicking off the Use texture file button the given object will be displayed in the selected colour 
both in the coloured 3D view and on the photorealistic picture: 
 

 

Standard handling of colour tables 

 
Colours can be chosen from different colour tables. The handling of these colours became standard in ARCHLine.XP. 
 
Click on the colour icon in the 
properties dialog of any object (e.g. 
line) to access the Colour tables: 
 
The browser of the appearing Colour 
table dialog shows the name of the 
selected colour table. 

 
 

• Select the appropriate colour table. 
 
ARCHLine.XP® colour table 
The ARCHLine.XP colour table appears with 256 primary colours, from which you can choose a colour. In the name field 
only names of the first 16 colours appear. You cannot specify names for other colours. 
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AutoCAD® Colour table 
The AutoCAD® colour table appears with 256 primary colours, from which you can choose a colour. You cannot specify 
names here. 
If you import a drawing created in AutoCAD, the drawing objects will keep their AutoCAD colour table settings. Here you 
can modify the colour of an object. 
If all the drawing objects have colours from AutoCAD® colour table, you don’t need to convert colours at file export. The 
exported drawing will appear with the same colours in AutoCAD®. 
 

 
 
Custom colour table 
The standard Windows colour spectrum appears here. After selecting a colour you can specify its shading with a sliding 
arrow. 
In the name field you can specify a colour name. 
 

 
 
Ral, Sikkens, Panton colour tables 
Use the horizontal sliding arrow or the vertical sliding bar to browse for the appropriate colour group. Select the desired 
colour by clicking on it. The name of the colour appears in the Name field. 
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New material with colour 

If you create a new material by a Ral, Sikkens or Panton colour, the name of the colour will automatically specify the name 
of the material, too. You can modify this material name as well. 
 

 
 

Reference  

After selecting a new colour from a colour 
table, the selected new colour is displayed 
below the old colour.  
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Components 

The RGB code and the Hue, Luminosity, 
and Saturation values appear here. 

 

 

Layer 

Click the Layer button if you want to specify the colour of an object by a colour of a layer. The object picks up the colour 
property of the layer where the object belongs to. The colour property of the object follows the changes made later on the 
colour of its layer. 

No 

The No colour button becomes active only in the case when you wish to specify the background colour of a hatch. Clicking 
this button the hatch can be specified without background colour. 

New colour tables 

Different CAD applications can use numerous colour tables. Some of these colour tables are downloadable from the web. 
 
In ARCHLine.XP it is possible to load colour tables that follow the format of Adobe or AutoCAD® ColourBook. 
These files can have .acb extension in binary (Adobe) or XML (AutoCAD) file format. 
 

! It is not possible to load protected colour tables! 

 

• Copy or move the downloaded colour table in the …\Support\Colours subdirectory inside your program 
installation directory: 
 

 
 

• Restart ARCHLine.XP. 

• Open the Colour tables dialog. The program automatically loads the inserted colour tables. 
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Query the colour of an object 

Any colour you have specified can be queried later on. 
 
After you have specified a colour to an object, open the properties dialog of the object and click the colour button.  
The Colour table dialog appears with the appropriate colour table, showing the previously specified colour selected in that 
colour table. 
 
Under Components you can read the RGB codes and the Hue, Luminosity, and Saturation values. 
 
Here you can modify the colour, of course. 

1.32.7. Find material 

Find material command shows the material of the selected surface in the Design Center. 
Click the surface and then select Find material command. The Design Center appears and navigates automatically to the 
selected material. In this example, material S 0570-Y40R is selected. The command is very useful when you would like to 
apply the material of a 3D surface on another element but you don’t know the name or category of the material. 
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1.32.8. Texture management with apparent materials 

The whole concept of architectural and interior design may change with applying the new apparent material feature. 
Apparent materials are materials whose visual appearance changes depending on the real colour or texture at which they 
are actually associated and visualized. You can compare various solutions for the same building or room layout simply 
assigning different paint finishes, coatings without changing the 3D model.  
During the designing process the modification of the architectural or interior concept needs to apply new materials, 
colours. 
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1.32.9. Creating apparent material 

Apparent materials can be created from the Design Center, There are some already created materials in the Materials – 
Apparent materials category, which you are free to use in your designs or create new ones. 
We recommend that you use simple and descriptive names. The name has two parts. The first part is the reference, the 
second is the real material name. The real material name is between <> marks. You can find them with their orange colour 
in the library. For example, Fabric_bed < Cream_01>  
 
How to create an apparent material? 
 

• Click on the Settings icon and select the Create Apparent material command:  
 

 
 

• Enter the name of the apparent material in the dialog: for example, cabinet_color.  

• Enter the category name. We recommend that you keep the offered Apparent materials category so these 
materials are reachable from the same place. 

• Select a real material which you would like to add to this name. 
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� Create only as many apparent materials as it is absolutely necessary that you could show the different 

material variations on the typical, large surfaces. 

1.32.10. Apparent Material Manager 

Create the project with the apparent materials and use them on the characteristic surfaces of the project. Then you have 
the possibility to save the used apparent materials as a style. 
Create different versions and save them as styles. Use these styles to show different versions of the project materials and 
make snapshot or render if you wish.  

How to create new apparent material style and how to use them: 

• Click on the Settings icon in Design Center – Materials window.  

1.32.11. Select apparent material manager command in the menu. 

•  The Apparent material manager appears, it includes the apparent materials with the original material 
assignment in the project category. 

• Save this first version of materials as a style by clicking on the Undefined style button: for example, style_01. 
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Select material to the apparent materials one by one. This will be the second 
version of materials. 

• Save it to another style and so on. 

• Close the window and refresh the 3D model by clicking on Build 3D 

model. The material version of the activated style will appear in the 
model. 
 

The following examples show the different versions of materials by using apparent materials. 

 

   
  

Apply apparent material styles from Templates 

 

You can reach the created styles and use them in the project from Design Center – Templates: 

These styles are stored in Project – Apparent materials category. 

 

• Use drag and drop method, drag the selected style to the model. 
• Choose Activate in the menu and rebuild the 3D model. 



 3. Customize ARCHLine.XP 143 

 ARCHLine.XP® 

 

 
You can open the Apparent material manager by clicking on Options. 

 

1.32.12. Convert material to apparent material 

If your project is complete, the characteristic surfaces have the required materials and you would like to show different 
versions from it, this method is recommended. 
The use of the apparent materials in the library may cause extra work because they should be assigned to the surfaces 
again. It is possible to convert project materials to apparent materials. These apparent materials are available only in the 
mentioned project. 
 

• Select the object in the project which material you would like to convert to apparent material. 
• Click on the Settings icon in the Materials window and choose the Convert to apparent material command and 

then click OK. 

 

 

     
  



144 3. Customize ARCHLine.XP 

Manual 

 
The new apparent material appears in the properties window of the selected 
object. The apparent material is displayed in orange in the Design Center – 
Materials – In Model category as well. 
The apparent material will assume the name of the material and the original 
material is between <> marks: 
For example, Hazelnut <Hazelnut> 
 

   
 

! Only the materials in the In Model category are convertible to apparent materials. 

 
The created apparent materials are in the In Model category and they are in the 
Apparent material manager as well. Creating styles are recommended as 
described above. 
 
Example: 
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1.33. Managing layers 

Getting started 

Layers are a method of managing the visual layout of a drawing. The program makes it possible to apply several layers at 
a time. With the use of layers you can group or separate the objects of the current project according to various aspects. 
The program sets the Layer 0 layer as default, but you have the possibility to create additional layers. On the whole the 
program is able to manage 32 768 layers. 
 
In ARCHLine.XP® layers have the following properties: 
 

� Visibility: on and off status 
� Background: unlock and lock 
� Colour :      This feature is active in Layer control mode 
� Line type:   This feature is active in Layer control mode 
� Line width: This feature is active in Layer control mode 
� Printable:   Set the layer to either printable (on) or not printable (off) 
� Description: You can assign a description to layers – special information that is related to the given layer 

 
Layers can be turned on and off, and can be unlocked and locked. With the help of these commands you can group the 
objects of the different layers. 
3D views and the floor plan share a single layer structure: 

 

 
 
If you create, rename or delete a layer in the default 2D window, you can view the changes in the 3D window, and vice 
versa. 
 
When specifying the general properties of object types, you can define on which layer you wish to place the objects of an 
object type. 
You can place objects with different properties (different colour, line type, line width, even different type, etc.) on the same 
layer, which due to other aspects, you want to handle together. 
 
If you activate the Layer control mode in the Modify menu, when creating new objects the program can automatically 
assign the colour, line type, and line width of the layer on which you place the object to the general properties of the 
object. 
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1.33.1. Working with layers in Layer dialog 

Select the Layer Manager command in the Modify menu, or Click the  Layer button in the Layer bar. 
The command displays the list of the layers in the drawing and you can specify their properties here.  
 

 
 

! We suggest that you use a layer distribution and assign the objects to different layers. In this case you can group objects 

on the basis of layers. You can switch certain layers off, or use them as background. 
 
In the following we describe the use of the Layer dialog box in details: 

Add layers 

• To add new layer , click the  button. 
 

 
 

You can modify the properties of the new layer subsequently. 

� The pipe in front of the name of layer signs the active layer:  

See: 3.4.3. Activate layers chapter. 

Name layers 

The program automatically names layers you create 
Layer1, Layer2, etc. 
 

• Double click Name, and enter the desired 
name of the layer. 

• Repeat the command in the case of other 
layers. 

 

 
When clicking Name you can arrange the names in ascending or descending order. 
 

� The program maintains layer names even when you use the copy/paste command between different drawings. 

The name of the layer can contain maximum 48 characters; in case of longer name the program cuts the remaining 
characters.  

Delete layers 

To delete a layer: 
 

• Select the layer you wish to delete. 
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• Click the  button. 
 

 ! You can delete only empty, unreferenced layers. You cannot delete the active layer! 

Layer Group tree 

Layer group’s tree control which layers are displayed and used to make changes to a group of layers at a time. 
 
If a layer group is selected in the tree, the dialog displays only the layers in that layer group.  
The top node, All layers, displays all layers.  
The Used layers displays layers only that contain objects. 
 

 

1.33.2. Layer groups 

You can create layer groups that contain layers that you select and add to the group. 
 

 
You can find on the right side of the Layer Properties Management dialog panel the layer groups buttons and 
settings. 
Create layer group 

Click on the Create group button, then a new group is instituted with a default name. If you click with right mouse 
button on the name and select the Rename menu, you can give a unique name to the group. 
Add layers to a group 

Select one or more layers, then hold down the left mouse button draw them above a layer group, and then release 
the mouse button. Behind the name of the layer group the number of layers that are in the same group appears 
between brackets. 
Display Layer groups  

Select a layer group from the list of All layers, then on the left side of the dialog window only the layers belonging 
to the selected group appear. You can qualify the appearing list if you switch on the Show used layers button.  
The list of layers group contains two built in layer groups: if you select the All layers group, all the layers  of the 
given window appear, if you select the Used layers group then that layers will be visible from the all layers, which 
contain objects unrelated to  the position of Show used layers button.  
Transactions with Layer groups 
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If you click with right mouse button on the name of a layer group, with help of the appearing shortcut menu you 
can modify the preferences of all layers at once: you can represent (On), or hide (Off), lock or unlock all layers in 
the given group at once. 
Delete from group 

Select a layer group from the list of Layer groups, then on the left side of the dialog window only the layers 
belonging to the same group appear. Select one or more layers then click on the Delete from group button. 
The given layers are deleted only from the layer group, and they are available if you select the All layers group. 
If you select layers from All layers and Used layers group, instead of Delete from group button you find the Delete 
button, which deletes the layers definitely. 
Delete layers group 

Select a layer group then click on the Delete button on the upper right corner of the dialog window. Then only the 
layer group will be deleted, the layers in it are available further if you select the All layers group.   

� The layers groups have to be determined according to windows similarly to the layers.  
Example: 

In the following example it is a really great help using the layers group:  

• Start a new project. 

• Load in a DWG file, which contains more than 30 layers. 

• Create a new layer group: DWG layers. 

• Click on the right side on the Used layers group. Then on the left side only the layers imported from DWG 
drawing and the used layers can be found. 

• Move all layers from here to the DWG layers group. 

• Start design. 

• If the imported objects from DWG drawing are not needed, you can switch off or lock them in one step. 

1.33.3. Activate layers 

Always has to be an activate layer on the plan. The active layer is always turned on and unlocked, with the pipe displayed 

in front of its name:  
 
You can activate the layers:   

� automatically  
� in the Layer Properties Management 
� in the Layer list box 

 
The program always places the objects on the current layer. 
The method is different according to the Modify menu- Layer control mode turn on/off status: 

Layer control mode turned off: 

The program activates automatically the layer assigned to the object in the object properties window. It places the new 
object on this layer. Except if you activate a layer during the command, for example: creating line, from the Layer list box. 
Then the program set the objects on this layer till you close the command.  

Layer control mode turned on: 

The program set the objects, that layer, which is activated in the Layer Properties Management dialog window or in Layer 
list box. In this case the program disregards the layer assigned to the object type.  

Activate in the Layer Properties Management: 

• To activate the layer click on the selected layer and then click on the  button. 

Activate in Layer list box: 

In the Status next to the Layer settings button you can find a list box, in which there are the layers with them actual status. 
The selected layer become active, this appears on the main line of the list box.  
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� The automatic activate, the Layer Properties Management and the Layer list box are synchronized to each other.  

1.33.4. Layer properties 

Layers on and off (Visibility)  

By turning layers on and off you can select the layers the objects of which you display in the drawing windows. The objects 

of turned-on layers  are visible and you can make reference to them. 
Any time you can turn the layers on which have been turned off, then they become visible again. 
 

• To turn layers on and off click the desired layer in the list, then 

• Click the icon indicating the status of the layer next to Name field. 
 

� You can turn off layers by using the Layer off command in the shortcut menu of the drawing objects. Only the inactive 

layers can be turned off. 

 Locking and unlocking layers (Background)  

By locking and unlocking layers you can define which layers shall be editable and selectable. You can lock layers 
containing objects that are not to be edited in a given planning process, these layers become background layers. The 
objects of locked layers are visible, you can make reference to them, but you cannot select or edit them. 
 

• To unlock or lock a layer click the desired layer in the list, then 

• Click the icon indicating the status of the layer next to Name field. 
 
You can change the status of several layers at a time: 

• With the Ctrl or Shift buttons select the desired layers from the list. 

• Click the appropriate button in the list. 
 

 
 

 ! The active layer is always turned on and unlocked. 

 

 When the layer is turned on and unlocked: 
� its objects are visible 
� you can make reference to its objects 
� its objects are editable and selectable 

 

 When the layer is turned on and locked: 
� its objects are visible 
� you can make reference to its objects, but 
� its objects are not editable or selectable 
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 When the layer is turned off: 
� its objects are not visible, therefore 
� consequently you cannot make reference to its objects, and 
� its objects are not editable or selectable 

Colour 

• Click the  button next to the layer you wish to modify, and then select the colour of the objects on the 
layer from the colour palette. 

Line type 

• Click the  command next to the layer you wish to modify, then 

• Click the arrow next to the line type. 

• Select the line type of the objects on the layer in the pull-down menu. 

Line width 

• Click the  command next to the layer you wish to modify, then 

• Type in the desired line width, or 

• Click the arrow next to the line width and 

• Select the line width of the objects on the layer in the pull-down menu. 

Printable: 

• By turning layers on or off you can select the layers to plot. If you turn off the printable property for a layer, 
the objects on that layer are still displayed. 

Description:  

You can assign a description to layers – special information that is related to the given layer. 

1.33.5. Layer control mode 

The Modify menu - Layer control mode option is turned off by default.   
When setting the general properties of object types you must specify to which layer you want to assign the objects of the 
object type in question. 
You can place objects with different properties (different colour, line type, line width, even different type, etc.) on the same 
layer, which due to other aspects, you want to handle together. 
 
For example: 
When you select Layer1 in the Wall properties dialog box, it means that the program will place all walls created after 
setting with the given properties on Layer1. By turning a layer on or off or locking it, you can display, turn off, or use as 
background these walls together, where in the latter case you can only make reference to them but they are non-editable. 
 
Let’s see detailed, what’s the different between the turned on/off option of the Layer control mode:  

Layer control mode - turned off 

Let’s have the Layer control mode in the Modify menu turned off: 
 
In case of Layer control mode is off:  
 

� The program set the objects to the object type assigned layer in the Layer Properties dialog. Except if during the creating 
command activate another layer from the State - Layer list box.  

� When setting the general properties of the object you can specify the colour, line type, and line width directly by defining 
the property (e.g. the colour is red). 
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 Modify object properties: 
You can modify the properties of objects already existing on a layer similarly to the method described above. In the Modify 
object properties dialog box you can assign colour, line type, and line width separately to the layer or if these are already 
assigned, you can change them by directly specifying the properties. 

Layer control mode - turned on 

When the Layer control mode is on, open the Layer Properties dialog and assign the appropriate colour, line type, and line 
width properties to the layers. 
 
In case of Layer control mode is on:  
 

� the program set the new objects to the active layer and not to the object type assigned layer  
� The objects to be placed on the layer automatically acquire the layer properties. It means the colour, line type, and line 

width of the object comes from layer properties. 
 

 
Modify properties 
When modifying the properties assigned to the layer, the objects in the drawing which belong to the given layer and whose 
properties are layer associated, will automatically be updated. 
 
You can also modify layer associated properties subsequently:  
If, for example, the program constructs each object of Layer1 with green lines, but you subsequently change the line 
colour of one object to blue, the object in question, although it is placed on a green-line layer, will be blue in accordance 
with the modification. 
 

! The difference between the on and off status of the layer control mode is that if turned on, the program set the new 

objects to the active layer and not to the object type assigned layer and the objects to be placed on the layer 
automatically acquire the layer properties (colour, line type, line width) at once. At the same time you can assign layer 
properties even if the layer control mode is off, but only one at a time.  
There is no difference between the on and off status when modifying object properties. 

Example 1:  

• Make the Layer control mode turned on. 

• In the Layer management dialog box assign to the Dimension layer the colour green and a line width of 0.15. 
Make the layer active.  
 

 
 

• Draw a line and specify its size. 
 

 
 
You see that the dimension has acquired the properties assigned to the layer. Let’s see it in the Dimension general 
properties dialog box: 
 

• Double click dimension. 
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The word Layer appears in the colour box in the general properties. 

• Click colour. Next to the colour palette then displayed, the  option is activated indicating that 
the dimension has acquired the colour assigned to the layer. 
Next to the colour you see that line width is also assigned to the layer. 

• By clicking and modifying the colour box, the colour properties of the object are not layer associated 
anymore. 
 

 

1.33.6. Move Objects to New Layer 

This tool will move objects from one layer to another, by selecting the destination layer from a dialog.  
You can move certain objects from one layer to another with the Modify menu - Modify layer command. 
 

• In the dialog box displayed, choose the number of the new layer to which you want to assign the objects, 
and then click OK. 

• Select those objects you wish to move to the new layer (you may also use the commands in the Selection 

menu). 

• Enter Finish selection and close the command. 
 

! As soon as the selected object is moved to a given layer, the Visibility and Background properties of the layer also apply 

to the object. Additional layer properties, such as colour, line type, and line width modify only those properties of the 
moved object that are layer-associated. 

1.33.7. Layer Walk tool 

Layer walk tool helps you navigating through your existing layers of one drawing. The key point of using Layer walk is that 
is makes easy to switch on and off visibility of layers and visualize the effect at the same time on the drawing itself. The 
layer walk list shows the names of layers and the numbers of objects of one layer between bracelets “()”. 
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Layer Walk tool can be found on Layer toolbar and also in the main menu in Modify / Layer walk. 
 

Display empty layers 

This option enables the visibility of empty layers in the layer walk list. By default all empty layers are invisible. 
 

Using layer walk 

Select a layer 
When the layer walk list is open you can select a layer, by clicking on its name. The selected layer will be highlighted and 
its content will be automatically visible in the active window. 

 
 

Select multiple layers 
To add a layer to your selection please hold down Ctrl button and click on the layer name. The selected layers will be 
highlighted and their content will be visible in the active window. 

 
 

Select layers between first and last selection 
You can select every layer in the layer walk list between two selected list objects. Click on the first one, hold down the 
SHIFT button on your keyboard and click on the last object. Every layer between the selected ones will be selected, 
including the first and last. 
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The same selection is also available by mouse only. Move over the first object, and hold down the left mouse button. 
While holding the left button move the mouse towards the end of the list and when you are satisfied with the selection 
release the mouse button. All objects will be selected between the first selections until the list object where the left mouse 
button was released. 

Change to Current Layer 
This command moves objects to the current layer.  

Make Object’s Layer Current 
This command changes the current layer by selecting an object as reference. It will use the object’s layer as current layer. 
This command is accessible in layer control mode only. 
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4. File management 

1.34. Introduction 
In ARCHLine.XP® you can manage projects and standalone drawings. 

1.34.1. Projects 

The project contains all information needed to represent your design in floor plan, 3D views, sections, and printing layouts. 
The project is the single database of information and saved into one file with .pro extension. 
 
ARCHLine.XP saves all your settings together with the project and allows you to customize them at any phase in the 
design process.  
Moving project to another computer means to copy the one file with .PRO extension. 
 
As you work on your design in any view, ARCHLine.XP follows the changes throughout the project. It means the 3D 
model, any views of the model, sections, the floor plan, and the printing layouts automatically update to reflect the 
changes.  
 
We recommend to work with project. 

 

� If you double click on .pro and .asc files in the Explorer, ARCHLine.XP starts automatically, and the selected file is 

loaded. 
If ARCHLine.XP is running, you can load any .pro and .asc or image file from the Explorer by drag and drop. 

1.34.2. Manage Project information 

ARCHLine.XP provides option for project customization, including standard and user defined Project information 
parameters. The standard parameters are the following: 

Issue Date  
Status 
Project Name 
Author 
Project Number 
Client Name 
Project Address  
Postal Code 
Project Location 
Building Type 
Project Phase 
 

User parameters: 

Beside the standard parameters you can add any number of new project related information parameters.  
 
Project information parameters are linked to Project Layout Stamp and fills the appropriate fields automatically. 
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1.34.3. Building 

In ARCHLine.XP, the building is the highest logical unit. 
 
The building is made up of multiple floors, the architectural objects on the floors, and the layers that help the visualization 
and grouping of the objects. 
Architects can design several buildings within one ARCHLine.XP® project.  
The buildings can be drawn separately in different projects or they can be handled in the same project. 
One building is active at a time while the others are visualized with a lighter tone. Different altitudes can be assigned to the 
buildings. 

 

1.34.4. Floor 

In ARCHLine.XP® the building levels are defined as floors. Structural objects and Component objects are associated to 
these floors, so that changes to a floor's height automatically generate changes to the linked objects elevation and height.  
The floor corresponds to the architectural meaning of floor. Just as in reality a building is built up from floors, the plan is 
also realized floor by floor, level by level. Opening a new project Floor 0 is automatically created. Any other floors are to be 
created by the architect according to the needs of the design. 
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Floor 4 
 
Floor 3 
 
Floor 2 
 
Floor 1 

 Multiple visible floor plan structure 

The multiple visible floor plan structure control visibility and display on the floor plan.  
The visible range may contain more than one visible horizontal planes of a multi-story building. 
You can refer to the elements on a visible floor during the work. Visible floors are displayed with a common grey 
colour. 

 

1.35. Working with ARCHLine.XP project 

The Welcome dialog automatically opens when you are starting ARCHLine.XP or you are about to close an existing 
project and create a new one. 
 
In this dialog you can: 

� start a new project, 
� open any of the last projects used, 
� open a project browsing by name, 
� search a project by name and folders. 
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The Welcome dialog displays buttons and pages which you can use to create, open or download projects. 

Projects / Drawings switch 

This switch is represented by two buttons at the left bottom corner of the Welcome dialog. By using these buttons you can 
switch between Project or Drawing mode.  

New project / New drawing button 

If you click on the New project / New drawing button, the software will create a new project or drawing. 

Open project / Open drawing button 

If you click on the Open project / Open drawing button, the software will allow you to browse for an existing project or 
drawing, depending on your choice. 

Search 

The Search button opens the Drawing recovery tool, which allows you to find or recover previous projects or drawings, 
archives or backup copies even. 

Exit 

The Exit button will close ARCHLine.XP. 

Recent projects content window 

The Recent projects window displays the 30 recent projects used lately on the current computer. The recent projects in 
this list are represented by a tiny thumbnail and a few of their technical data, such as the location, the time they have been 
created and modified and the physical size on the storage drive. 

Web collection content window 

The Web collection content window shows the online collection of projects, shared by other people. This feature cannot be 
used offline. 
 
You can browse online and use different filters and if you would like to download a project, you just need to simply click on 
it. 

1.35.1. New project 

With File menu - New project command you can start a new project or load an existing one. 
When you start a new project, the new project uses default settings, which are defined in the default template. 
The default template comes from Factory, Local and My template in this order. You custom template saved in My template 
has the highest prioroty. 
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If you click on ‘New project’ ARCHLine.XP loads the default settings and creates the primary floor plan view.This view is 
the default view in any project. The default name displays in the title bar of the view. To assign a different name, click into 
the title bar and type the new name. It is not allowed to delete the primary floor plan view from the project. 
 

 
 
Take care! When a new project or drawing is created it is not automatically saved. You need to save it later. 

1.35.2. Search projects 

Introduction 
ARCHLine.XP gives an efficient helping hand to search former projects and drawings on the hard disks of the 
computer. 
You can use it simply, just determine the search position and conditions then you just have to select the proper 
one from the found projects or drawings. 
This function can be used excellently for searching former used works or their backup copies. 
Use search function 
You can start the command from the Tools menu – Accessories submenu or using the File menu – New project – 
Search icon.   
 

 
 
In the appearing dialog window determine, in which folder you want to search and give the name you are looking 
for, and the type of the file: 
 
Project / Drawing 
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You can set what and where you are looking for. Select the proper option.  
 
Folder 
Here can be seen that access path, where the program is searching. Click on the Browse button, you can select 
another folder or driver. The searching happens in all subfolder too. 
 
Search for 
Here you can determine the name of the file or the part of it, which you want to search for. For example, if you 
look for the original „klimahaus.pro” file, it is enough to write in the „klima” search condition. After clicking on the 
Search button the program is searching files in the given path that contain the „klima” detail. 
 

 
 
The search results appear similarly as above.  
 
Search results 

You can fine the search results. In course of searching the ARCHLine.XP® search not only among the saved projects 
according to the given conditions, but among the backup copies (PR$ extend files) and the automatically exist 
archives (Archive folder) as well. 
Select the proper option from the drop down list, if it is necessary. 
 

Project contents 

In this field you can select one design, which is in the selected project.  
 
Preview 

It shows the preview of the selected drawing from project contents list in miniature form. 
 
File info 

The program represents essential information from the selected file. 
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Open 

You can open the selected project or drawing, if you click on the Open button.  
 

� You can interrupt searching with pressing down the ESC button. 

1.35.3. Opening a project 

Opening the last used project 

Here you can select any of the last projects. The program loads the selected project, including all windows, displaying 
them in the last saved arrangement. 
You can display the full path name or only the name of the project. The latter is very useful when the path name is too long 
and you cannot see the name. 
 
 
The program loads the desired project with File menu - Open project command. After opening the project, each related 
drawing is displayed in a separate window. 
 

 
 
When you activate the Open project command, a dialog box appears where you can select which .pro file you want to 
open. By default, the program offers you the path of the last project you worked on. 
If you cannot find the desired file in the list, choose another directory. 
 

• Select the project to be open. 

Preview 

Enable the Preview option to display the name of the drawings related to the selected project in the right hand side of the 
dialog box. 
This helps you to clearly identify the project. 
The program displays images only if you click on the name of the drawing. This way you can scroll the names of the 
drawings within each project. 

Importing of floor plan from another project 

If you enable this option, the program will load the selected drawing only. 
 

• Click Open, and the program asks you the following question: 
„Are you sure you want to import a file from this project?” 
 
If you click Yes, you can: 
 

� either merge the imported drawing file into the current project, and then the drawing is created in a new window as a part 
of the project, 

� or create a new project. In case of a new project, give the name and the path of the project. By default the program offers 
the path of the last used project. 
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Merge into current drawing 
If the Import file option is enabled, you can add the imported drawing file to the active drawing of the current project by 
enabling Merge into current drawing option, so as to make it a part of the project. 
 

 
 

� Use this option if you want to place a finished drawing saved as a project onto the terrain. If you manage multiple 

buildings, you should load the buildings with this option. To do so, select the floor plan from project drawings. 
 
If you want to place the reference point of the drawing to a selected point instead of the global coordinate origin, press 
Open and enable the Place with new origin option in Merge files dialog box. The reference point of the drawing is the (0; 
0) point. 
 

! You can make full use of this option if you place the first object of the drawing to be merged at the (0, 0) point. Then the 

starting point of the first object will be the point of reference. 

 

� Import file option is similar to File menu - Import command; however, you can only import project files here. 

 
After selecting the name of the desired project (the File import option is switch off) and pressing Open, click OK in the 
Save project dialog box. If you have not saved changes to the current drawing, the program asks you if you want to do so. 
 
If you click Exit without saving, the program asks “Are you sure you want to exit without saving?” 

Drag and drop files in ARCHLine.XP 

To open a project, there are other options than using a dialog box. 
You can open files by drag and drop that is by dragging and dropping files from Windows Explorer to ARCHLine.XP®, as it 
is used in Windows. You can use the following files: 
 
Projects, ASC drawings, DXF, DWG, DWF drawings, image files (e.g. BMP and JPG files), SKP, 3D Studio objects (3DS). 

Double click on filename 

If ARCHLine.XP®  is not running, double click the project file name (.pro) or the .asc file name in Windows Explorer to start 
the program; the project and the drawing will be loaded. 

Opening last used files 

The last used 6 projects appear on the bottom of the File menu. You can load any of those by selection: 

File name rules 

Inside a project the renaming of files is not allowed, thus you can avoid creating name conflicts in a project. Only the 
changing of the pseudo name is possible in the Project properties dialog box. This new rule makes easier the handling 
and identifying of drawings on plot layouts, too. 
 

� The name of the first floor plan window is derived from the name of the project. 
� At the opening of other floor plan windows you have to define the new window name (e.g. 2D sections, 2D facades etc.). 
� At the opening of a 3D view window the new window name is generated automatically (View 1, View 2, etc.). 
� At the creation of a 3D section window the window name is generated automatically (Section1, Section2 etc.),  
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1.35.4. Import file into a project 

Importing of files can be done in three ways: 
 

� with the File menu -Import command, 
� With the drag & drop method: for example dragging from the Windows Explorer. 
� File menu – Open project - Import file command 

Importing of DXF/DWG file into a project 

If we import into an active a 2D floor plan with the File menu - Import command, the Merge to current drawing option is the 
default setting. The same applied when you use the drag & drop method. This way the unnecessary increasing of the 
number of 2D floor plan windows can be avoided. 
If we import into an active 3D window, the two methods work different:  
In case of File menu - Import command the Merge to current drawing option is the default, the drawing will be imported to 
a given drawing. When you use the drag & drop method, the drawing will be loaded into a newly created window. 

� See the Chapter 4.5.2. DXF/DWG import/export. 

Importing of ASC file into a project 

If we import into an active a 2D floor plan with the File menu - Import command, the Merge to current drawing option is 
switched off by default, therefore a new window will be created. In case of drag & drop method the drawing will be 
imported into a given drawing. 
If we import into an active 3D window with the File menu - Import command, the Merge to current drawing option is 
switched off by default, therefore a new window will be created. Also, in case of drag & drop method, a new window will be 
created and the drawing will be loaded there. 
 
If name conflict occurs at new window generation, the new window name will be generated by the concatenation of the 
original file name and the extension of .1. 
 

� See the Chapter 4.5.1. ASC Import. 

ASC file import from project into project 

If the drawing to be loaded is part of project, the Import command can’t be used. In this case, use the Open Project 
command, and select the Import file and Merge to current drawing option. 

� See the Chapter 4.2.3. Opening project – Import file option. 

1.35.5. Saving project 

When you save the project, each drawing (floor plans, facade views, sectional drawings and perspectives) goes into one 
file, with a .pro file extension. 
This project file contains all the information including materials created by the User, object properties, architectural 
settings, display settings, hatch patterns and line types. 
Only those sets are saved in the projects that are used within it.  
The 3D database is not saved in the project by default, only upon your request. 
 

� You can save your current projects with their names in the selected directory by File menu - Save project command, or 

with the Edit toolbar -  icon. 
 

Exit the program 

When you exit the program, start a new project or load another project, the program displays the Project properties dialog 
box showing the states of the drawings, and asks for confirmation. 
 

 
 
You can select the Quit without save option In this case you are to lose all changes made since the latest save. 
If you click Quit without save, the message appears: “Are you sure to close the project without save?”  Choose YES to exit 
from the project without saving. Choose NO to return to Project properties dialog. 

Save the current project 

Click on Save button if you want to resave the current project. 
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Making copies 

When the program saves the projects, it also saves the previous status as filename.pr$. This way you can always find a 
copy of the previous saving. The next saving will overwrite the copies. 

1.35.6. Saving project asU 

You can save your project under a new name. The appearing dialog box corresponds to the one popping up for Save 
project. 
After closing the dialog box, you can define the new name and path for the project in Save project dialog box. 
 

� If you want to export the project to earlier versions of ARCHLine.XP®: 
  
In the Save project file dialog select XP 4.5, 2015 or 2016  project format. You can open the project saved this way with 
the previous program versions. 

 
 

� You can load any project created with the previous versions. 
When saving the project in XP 4.5 format, the following message pops up: 

  
This means that the program will not overwrite the previous file version, and you can save the project with a new name in 
ARCHLine.XP 4.5 format. 
Drawings that make up the projects are also listed in the dialog box. 
Floor plans are marked with blue, 3D drawings are marked with black, and plot layouts are marked with green. 
 

  



 4. File management 165 

 ARCHLine.XP® 

Rename 

Double click on the selected File name. You can overwrite the drawing name here. 

State 

You can change the state of any drawing. 
You can delete any selected drawing in a project or you can turn them off temporarily. Drawing files can have three states: 
active or not visible and drawings to be deleted from the project. 
 

 

Active drawing:   
An active drawing is displayed on the screen and is part of the project. 

Not visible drawing:   
If you turn off the Light bulb icon, the selected drawing will be temporarily invisible, i.e. it will not have a window but it will 
remain part of the project. If you reload the project later on, the last saved state will be displayed, i.e. only the active 
drawings will appear. Click on the Light bulb icon in the Save project or Project properties dialog to activate the invisible 
drawing. 
You can also make the drawing invisible if you disable the window of the drawing. 

Drawing to be deleted:  
Click on the Sheet icon of any drawing to delete the drawing from the project; this also means that you delete the drawing 
from the hard disk and so it will not be accessible any more. 

Checkboxes: 

-Purge unused materials: 

The materials which are not applied on the floor plan and 3D model will automatically deleted from the project, if this 
function is switched on. As a consequence your project size may decrease significantly. 

! Remember not to delete the floor plan unless you do it for some specific reason. 

-Save 3D database 

� Off: 
It is switched off by default therefore the 3D database is not saved in the project. The 3D model can be created from the 
floor plan any time. 
If we use the 3D solid modeller and we do not save the object in the object library, we need to save the 3D model. 
In a case like this the program recognizes that the plan contains 3D objects which have not connection to the plan and 
when the project is saved the program offers the possibility of saving the 3D model as well. 

� On:  
If it is switched on the whole 3D database is saved. In this case the project size considerably increases. 

1.35.7. Notes 

You can add notes to the project. 
 

 
 
You can submit a note with the Enter key. For the case you exit from the dialog by clicking the Ok button, the new 
message will be saved, too. The messages appear in the message list. Click Cancel if you want to quit without saving the 
message. 
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1.35.8. Project locking 

File locking is a mechanism that restricts access to an open project, allowing only one user to work on it and meanwhile 
the other users can open it only in read only mode. ARCHLine.XP locking system prevents the interceding update, so the 
project is editable only for the user who accessed the project first. 
Other users can open the same project on the network but only in locked mode that disables to save any modifications 

1.36. Project manager 

When you save the project, each drawing (floor plans, facade views, sectional drawings, perspectives, rendered images) 
goes into one file, with a .pro file extension. 
This project file contains all the information including materials created by the User, object default properties, architectural 
settings, styles, display settings, hatch patterns and line types. 
The 3D database is not saved in the project by default, only upon your request. 
Drawings that make up the projects are listed in the Project Manager. 

1.36.1. Project manager in details 

The drawings that make up a project are 
grouped as Visible and Hidden drawings.  
What is the difference? The hidden 
drawings have no assigned window but 
remain part of the project when you save 
it. You can also move a drawing to the 
hidden drawings group if you click X button 
of the window as you close it. 
These visible and hidden folder contain the 
following sub groups:  
 

� 2D drawings (floor plans)  
� View (perspective and axonometric views, 

wall views) 
� Section (sections) 
� Print layout (list of print layouts) 
� Mood board 
� Rendering: rendered images 

 
You can visualize the buildings and floors 
of the 2D drawings as well with a click on 

 sign or with a double click on the 
drawing name. 
There is also a section named zones, 
detailed in 4.3.6. 

 

1.36.2. How to use the Project Manager? 

Active drawing 

The mouse left double click makes the selected drawing to active drawing. When the selected drawing is in the Hidden 
category it will be displayed on the screen and will be moved to the Visible category. 
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New drawing 

The mouse right click makes over the folder name offers to create the appropriate new drawing according to the folder 
name. 

 

2D drawing management 

Using the mouse right click over the 2D drawing name the following menu appears: 

  
 

� Create new enables to create a new 2D drawing. 
� Rename command enables to change the pseudo name of the drawing. You can overwrite the pseudo name of the 

drawing but the real file name of the drawing will not change. 
� Hide. The selected drawing will be temporarily invisible, i.e. it will not have a window but it will remain part of the project. 

The drawing moves to the Invisible group. 
� Properties command opens the 2D drawing related floor management dialog where you can modify the current floor 

structure. 
When you chose a 2D drawing in the Hidden folder with the mouse right click over the 2D drawing name the following 
menu appears: 

  
� Click on the Light bulb icon the Make visible command activates the hidden drawing and moves to the Visible folder. 
� Click on the Delete command to delete the drawing from the project. This means that you delete the drawing from the 

hard disk and so it will not be accessible any more.  

! Remember not to delete the 2D drawing (floor plan) unless you do it for some specific reason. 

3D view management 

The mouse left double click activates the selected view. 
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Using the mouse right click over the view names the following menu appears: 

1.36.3. Zones 

Concept 

Zones can be defined in a building. They are groups of several rooms. You can use zones to represent ownership, to 
design heating or air conditioning systems, to visualise areas with different acoustic requirements, etc. 

 
Air conditioning systems 

 
 
Ownership 

Categories 

You classify rooms on a building in many ways. As for the ownership you can differentiate between tenants, if you would 
like to deal with air condition it is possible to define zones based on the required cooling and heating systems.  
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Groups and priorities 

You can sort zones into several groups, if necessary. For zone groups you can define high or low priorities. Priorities are 
taken into consideration while calculating zone areas and volumes. If you use zone group priorities in a zone category, 
zone areas are extended by the thickness of the surrounding wall and slab structures according to the following figure: 

 

Colours 

Finally you can define zones and add rooms to them. In a zone category every room can be added to one zone. Zones 
can be visualised by a unique zone colour. 
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Managing zones 

 

 

Zones is a tree structure in Design Center. You 
can expand or collapse branches by clicking the 
+/- signs in front of the tree objects. By clicking 
on an object you can rename it. 
 
By clicking on an object with the right mouse 

button a Local pop menu appears and you can 
select a command in it. Below you can learn 
about local pop menus of different tree objects. 
 
 

Zones (main tree object) 

Create new category 

A new zone category is added to the tree, with a default name. You can rename it by clicking on its name with the left 
mouse button. 

Show zones with colours 

Rooms will appear with zone colours of the active zone category. 

Hide colours 

Rooms will appear as empty polygons. 
 

Zone category 

Activate 

It activates the current zone category.  Area calculation and zone colouring is based always on the active category. 

Create new zone group 

A new zone group is added to the tree, with a default name. You can rename it by clicking on its name with the left mouse 
button. 

Rename 

It renames the current zone category. 

Priorities and colours 

The Priorities and colours dialog appears, here you can set the colours of the zones and the priorities of the zone groups 
in the current zone category. 

Delete 

Deletes the current zone category. 
 

Uncategorized rooms 

Add rooms to this zone 

Select rooms on the floor plan and then press ENTER.  The rooms are moved to the uncategorized zone. 
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Zone group 

Create new zone 

A new zone is added to the tree, with a default name. You can rename it by clicking on its name with the left mouse 
button. 

Rename 

Renames the current zone group. 

Priorities and colours 

The Priorities and colours dialog appears, here you can set the colours of the zones and the priorities of the zone groups 
in the current zone category. 

Delete 

Deletes the current zone group. 

Zone 

Add rooms to this zone 

Select rooms on the floor plan and then press ENTER. The rooms are moved to the current zone. 

Rename 

Renames the current zone. 

Priorities and colours 

The Priorities and colours dialog appears, here you can set the colours of the zones and the priorities of the zone groups 
in the current zone category. 

Delete 

Deletes the current zone. 

Room 

Show on floor plan 

Selects the room on the floor plan. 

Rename 

Renames the current room. 

Room properties 

Opens the Properties dialog of the current room. 

Remove from zone 

The room is moved to the uncategorized zone. 

1.37. Standalone drawings 

Managing separately drawing files 

The program allows you to manage individual drawings. In this case the drawing is made up of the floor plan. You can 
create the 3D model from the floor plan with several projections and section views. Each drawing has an .ASC file 
extension. 

Disadvantages: 

• 3D views and sections are not saved when you save floor plans. You have to save each drawing as an 
standalone file. 

• The saved drawings are not connected to each other. 

• You cannot restore the floor plan from views. 

• Materials and settings created by the user are not saved in the ASC file, so you cannot transfer them to 
another computer. 

Note: 

If you prefer to use ASC files, we recommend you the following method, to be able to manage views in the ASC file, too: 
 



172 4. File management 

Manual 

When you finish the front view, the section and the pre-set perspective etc., by using Edit menu - Copy or Paste 
commands, copy e.g. the cross section from the cross section window to the floor plan to any floor not used for floor plan 
drawing, e.g. to Floor -1. The drawing created this way will lose its connection to the 3D model. If you modify anything on 
the floor plan that will not be followed by changes on the cross section on Floor 1 i.e. this will be a 2D drawing that you can 
modify, calibrate and label as you like. This way you can keep different views of different floors and save them into a 
single ASC file. You can transfer this single ASC file to another computer. 
 

� You can also convert views and sections into 2D drawings in projects. 

 
Commands for managing drawings: 
 

 
q 
 

 

1.37.1. New drawing 

This command allows you to create a new drawing or to load an existing drawing. 
If you have not saved changes of the current drawing, the program will ask you if you want to save the drawing. 

 

• Enable the Drawing option in the dialog box. The last specified status will be active. 
 

In the dialog box you can: 
 

� Create a new drawing, or 
� Open any of the last drawings, or 
� Open an existing drawing. 

 

� You can start a new floor plan with the  New icon of the Edit toolbar, and then you have to give the name of the 

new floor plan window. 
 

� The use of this dialog box corresponds to that of the New project dialog box. For a detailed description, see 

chapter 4.2. Project management. 

1.37.2. Opening drawings 

If you activate the Open drawing command, a dialog box appears, where you can select the drawing you want to open. 
The program automatically offers the path of the last used drawing. 
 
In drawing mode the next rules are applied for opening a drawing: 

� Each file keeps its name and location, 
� Renaming of files are not allowed, 
� A drawing can be loaded only once, 
� File name on the window title bar appears with its short path name. 

 
You can open multiple floor plans at one time. Please note, that the 3D models of different drawings will be displayed in 
the same 3D window. 

� The use of this dialog box is similar to that of the Open project dialog box; for a detailed description, see 

chapter 4.2. Project management. 
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� You can also open a drawing with File menu - Import command. Select .ASC for file type. 

1.37.3. Saving drawings 

With this command, you can save the current drawing under its name to the selected library. 

Exit 

When exiting the program or loading a project, the program asks if you want to save drawing files. 
If you click No, you will lose all changes made since the last saving. 
 

Creating backup copies 

When the program saves the drawing, it also 
creates a backup of the previous version with 
the name filename.as$. This way you can 
always find the copy of the previous saving. 
Backup copies are always overwritten by the 
next saving. 

  

1.37.4. Save drawing asU 

With Save as you can save the drawing under a new name. Type in the name of the drawing in the dialog box and give a 
new path if necessary. 
 
As a file format you can set: 

� ASC: saves the drawing in ARCHLine.XP®  format, whether or not you have saved the floor plan or the content of the 3D 
window 

� 3AS: saves the 3D model. 

Compatibility with the previous version 

You can save the drawing in ARCHLine.XP format which is readable with ARCHLine.XP 4.5. You can also save the 
content of the 3D window as .3as format of the ARCHLine.XP version. 

1.38. Import/Export 

ARCHLine.XP is compatible with many different design and display software. 

Import 

The drawings to be loaded can be the next files: 
 

.asc drawings created with ARCHLine.XP® and a 
previous version 

.dxf AutoCAD® DXF format 

.dwg AutoCAD® DWG binary format 

.dwf AutoDesk Design Web format 

.skp SketchUp file format 

.kmz File extension for a placemark file used by 
Google Earth. 

.3ds 3D Studio format 

.obj Wavefront format 

.hou drawings created with ARCHLine® 4.x 
versions 

.drw drawings created with ARCHLine® 4.x 
versions 

.ifc IFC 2x3 

Export 

In case of export, the ARCHLine.XP supports the following file formats:  
 

Format  Description  
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AutoCAD DWG (*.dwg)  Drawing file  

Autodesk DWF (*.dwf)  Autodesk Design Web Format  

AutoCAD DXF (*.dxf)  Drawing file  

SketchUp (*.skp)  Sketchup 3D model 

KMZ (*.kmz)  
File extension for a placemark file used by Google 
Earth. 

3D Studio (*.3ds)  3D Studio 3D model 

Wavefront (*.obj)  Wavefront  3D model 

Autocad 3D DXF (*.dxf) 3D model 

Autocad 3D DWG (*.dwg) 3D model 

ARCHLine.XP Render Studio (*.tgf)  3D model 

ARCHLine.XP ASCII (*.asc) Drawing file  

ARCHLine.XP ASCII 2004 format (*.asc) Drawing file  

ARCHLine.XP 3D (*.3as) 3D model 

Metafile (*.wmf)  Microsoft Windows ® Metafile  

Cinema 4D (*.c4d) 3D model 

Atlantis Render (*.atl) 3D model 

|Indigo Render (*.igs)  3D model 

Autodesk FBX (*.fbx)  3D model 

Portable Document (*.pdf)  Drawing file or 3D model 

JPEG (*.jpg)  Device-independent bitmap file 

|Thea Render (*.igs)  3D model 

|Autodesk Maya (*.ma)  3D modell 

|Luxology Modo (*.lxo)  3D modell 

|IFC 2.x3 (*.ifc)  3D modell 

|Green Building XML (*.xml)  3D modell 

1.38.1. ASC Import 

Besides allowing file transfer from other applications, the Import command is very useful when you want to merge a 
drawing saved as ASC into an existing drawing. This happens very often when you place a building on a terrain. To do so, 
enable Merge to current drawing option. 
If the drawing to be merged is the part of a project, you cannot use Import. In this case, you have to use Open project, and 
choose Import file and Merge to current drawing options. 
 
Importing of files can be done in three ways: 
 

� with the drag & drop method: for example dragging from the Windows Explorer. 
� with the File menu –Import command, 
� with the File menu – Open project - Import file command 

Importing of ASC file into a project –using drag & drop method 

If we import into an active a 2D floor plan using the drag & drop method the drawing will be imported into a given drawing. 
If we import into an active 3D window with the drag & drop method, a new window will be created and the drawing will be 
loaded there. 

Importing of ASC file into a project – using File menu –Import command 

Import allows you to merge the imported drawing to the current drawing or place that into a new window. 
 
If we import into an active a 2D floor plan/3D window with the File menu - Import command, the Merge to current drawing 
option is switched off by default, therefore a new window will be created. In case of drag & drop method the drawing will 
be imported into a given drawing. 
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• Select drawing file format: .asc 

• Select the drawing you want to open. 

Preview 

Enable this option to display the selected drawing in the dialog box in an optimized size.  

Merging to current drawing 

Enable the option to merge the imported drawing file to the current drawing; the imported file will be part of the current 
drawing. 
Disable the option to display the drawing in a separate window. 

Keeping original layers 

If you enable Keep original layers, the program loads the drawing while keeping the layers of the drawing. Disable the 
option to place each object on the current layer. 

ASC file import from project into project 

If the drawing to be loaded is part of project, the Import command can’t be used. In this case, use the Open Project 
command, and select the Import file and Merge to current drawing option. 

� See the Chapter 4.2.3. Opening project – Import file option. 

1.38.2. DXF/DWG import/export 

DXF/DWG file format allows you to exchange your drawings with other CAD users. You can export or import even DWF 
(Design Web Format) files as well. You can quickly select the file format you wish to save your work in. 

 DXF/DWG import 

Importing of files can be done in two ways: 
 

� with the drag & drop method: for example dragging from the Windows Explorer. 
� with the File menu –Import command, 

Importing using drag & drop method 

If we import into an active a 2D floor plan with the drag & drop method, the drawing will be imported to a given drawing. 
This way the unnecessary increasing of the number of 2D floor plan windows can be avoided. 
If we import into an active 3D window, the drawing will be loaded into a newly created window. 

Importing using File menu –Import command 

If we import into an active a 2D floor plan / 3D window with the File menu – Import command, the Merge to current 
drawing option is the default setting. This way the unnecessary increasing of the number of 2D floor plan windows can be 
avoided. 
 
The program is capable to process the latest DXF, DWG and DWF file formats and to load these files into your own 
project either as part of your project or as external references. 

� See chapter 11.11. External References. 
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If a DXF/DWG file is imported and the file is placed in a new window, the floors are not available in this window. This way 
the number of real floor plan windows is not increased when a DXF/DWG file is imported. Architectural objects cannot be 
placed in this window, of course. 
If the goal is to place the DXF/DWG drawing as a base and build the model on it, when the file is imported, switch on the 
Merge to current drawing option. The drawing will be placed in the real floor plan window, the design can be continued. 
 

 
 

� See the Chapter 4.5.1.ASC Import command. 

 
At DXF/DWG drawing import you can choose the following settings in the dialog. With these settings you can make the 
display of the imported drawing correct and fast. 

 

 

Disable gradient hatch creation 

Importing of gradient hatches can slow down the displaying of the imported drawings in ARCHLine.XP® . To avoid this 
problem, it is possible to have all gradient hatches displayed as solid hatches. 
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� Gradient hatch is 

analogous to the Shade 
option in ARCHLine.XP®. 

 

 

Explode dimensions 

With this option you can load the dimensioning exploded, so these will be handled as general drawing objects instead of 
real dimensions. The advantage is that the look will be identical with the AutoCAD® display. The drawback is that you lose 
the dimensioning properties. 

Explode dimensions with user arrow 

The look of dimensioning with user-defined arrows in ARCHLine.XP® is not the same as in the original AutoCAD® drawing. 
That’s why you have the possibility to explode these dimensioning. The advantages and drawbacks are the same as it 
was described above.  

Use line weight display setting 

In the File menu -Options - Other dialog there is a Line width ON switch. By selecting this option, lines will be displayed 
with their own thickness, otherwise all lines will be displayed with zero (the thinnest) thickness. 
 
In AutoCAD® drawings you can also apply the line weight settings. 
At file import it is possible to take over this setting. With this setting you will overwrite the Line width ON option found in the 
File menu -Options - Other dialog, and this option will be applied to the whole project. For this you have to select the Use 
line weight display setting option, so the program will use the AutoCAD® setting. 
 

� If we have imported several of drawings into the project, the settings applied in the last drawing will be in force in the 

whole project, of course. 

Colour table handling 

A higher level of colour table handling is available in the imported drawings, too. 
The program is able to recognize the original AutoCAD® colours of the objects in the imported drawings, which can be 
modified later in the specific colour table. When you export a drawing like this, there is no need to convert the colours 
because the drawing uses the same AutoCAD® colour table. 

Import 3D points / lines / arcs / circles 

By selecting this option, the points / lines / circles / arcs are created in the 3D.  
In this way the visualization measure up to the AutoCAD®  

Extension of DWG import  

The AutoCAD DWG files can contain 3D surfaces, which are created by drawing out lines, arches, and polygons in 3D, 
by determining the so-called Thickness of the objects. 
You can also create such surfaces in the ARCHLine.XP® (see in 3D extension of line nature objects chapter), and the 
program can import the AutoCAD DWG files containing these objects. 
 

�  The AutoCAD creates a surface from the straight lines that it draws out the line into the space perpendicularly to that 

plane, on which it was designed. 

DWG export – multiply floors together 

 
You can export a multiple floor plans workspace into a series of DWG files as one file for each floor in one step.  

 
Select  File / Export command 
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 Export 

The Export command is used to save 2D or 3D contents to various file formats. 
 
In File menu - Export specify the file name and file type. 
 
If you select any of the dwg or dxf file formats, you can customize the export settings in the appearing dialog. 
 

 
 
The following options are available: 

Explode 

You can export objects to other CAD programs in an exploded format (with lines). Select the objects you want to explode: 
walls, opening dimensions, all dimensions, texts and hatches. 
 
The aim of this function is the following: 
To offer the option to print drawings in AutoCAD® where the printed drawing will correspond 100% to that printed from 
ARCHLine.XP®. In this case, for example, it will not be a problem if certain fonts are missing from the other computer. 

Wall components 

You can explode walls in such a way that their main constituents (contour lines, hatches, doors, windows and opening 
dimensions) are placed on separate layers. 
 
The aim of this function: 
You can continue drawings in AutoCAD® using the groupings applied on the layers. 
Example: create a Wall contour line layer and use this layer for wall contours. 

File version 

You can choose from the released AutoCAD® versions. The exported file will be compatible with the selected AutoCAD® 

version. This way the exported file can be used by users with previous AutoCAD® versions. 

Scale 

You can rescale your drawing by setting a scale. 
 
The aim of this function: 
You can export your units of measurement to AutoCAD®. 
AutoCAD® will use mm in the exported drawing, so dimensioning will also use mm. You can define your units of 
measurement in ARCHLine.XP, e.g. if you set m, dimensions defined so far will be displayed in meters. This way 
dimensions in AutoCAD® will be given in m and mm (the program will display the values set in ARCHLine.XP® multiplied 
by 1000). To solve this problem, make sure to type 0.001 in the Scale factor field. 
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Convert multiline texts 

AutoCAD® can use one-line and multiple-line texts. When exporting, you can define whether you want to export 
ARCHLine.XP®’s multiple-line text as multiple one-line texts or as a single multiple-line text. 
Experience shows that it is advisable to use multiple one-line texts. 

Exporting buildings 

In the case of multiple buildings, you can define which building to export. With the building to be exported, you can also 
export the terrain of the plan. If you select the All building option, the terrain will also be exported to the AutoCAD® file. 

Export as 3D model 

You can specify whether you would like to export the plan view or the 3D model of the selected object. This way you can 
create plan view what contains special 3D objects 

 

Others 

Using these options you can enhance the appearance of your drawing objects in other CAD applications. 
� Export dimension measured value as text: the measured values of a dimension will be exported as fix values. This 

means that the dimension value of an object in AutoCAD® will not change automatically if you modify its size, for example. 
� Ignore invisible layers and its objects: invisible layers and the objects belonging to these layers will be ignored during 

the export. 
� Export group IDs as attribute: the ID numbers of groups will be exported as block attributes (you can see them among 

the block attributes). 
� Create log and audit files: during the export of a drawing two additional files can be created; a log file with the 

<filename>.log file name format and an audit file with the <filename>.aud file name format. The both files may include 
useful information for ARCHLine.XP® developers. Send these files along with the original end exported drawings to your 
local distributor if you find some errors in the exported file. 
 
Other export settings are available in the File menu - Options - Dxf and dwg export settings dialog. 
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The following options are available: 

Export of hatches 
You can define hatch conversion rules between ARCHLine.XP® and AutoCAD® hatches. You can 

� add new rule by clicking the New button, 
� delete a selected rule by clicking the Delete button, 
� modify a hatch pattern in the by clicking the  button, 

� modify a pattern proxy mode by clicking the  button. You can select either the Export as solid or the Explode options. 
Both selections will ignore the hatch conversion and only the ARCHLine hatch patterns will be exported in exploded or 
solid state. If you export exploded ARCHLine hatch patterns, the size of your exported file may increase substantially. 

Export of the patterns which are not in the list  
Because of the differences between CAD applications you may not find the proper rule for a hatch conversion or you 
simply do not want to create rules one by one. 
In that case you can export ARCHLine style hatches. 

� as exploded objects (Explode) 
� as solids (Export as solid) 
� as a hatch with the selected hatch pattern (Select a pattern). With this selection you can also specify the scale and rotation 

of the selected pattern. 
�  

 

Dimension arrowhead export settings: 
Similar to the hatch conversion rules you can define conversion rules between ARCHLine and AutoCAD® arrowheads. You 
can add new rule to the list by the New button, delete a selected rule by the Delete button, or change an existing 
conversion rule by the  buttons. 

 Settings: line type, font and dimensioning arrow assignments 

• By clicking on the Settings button you can make assignments between AutoCAD® and ARCHLine.XP® for 
special AutoCAD® line types, fonts (true type fonts not found in Windows by default) and dimensioning 
arrows. The assignments are saved and you can use them afterwards. 

 

� You can reach these settings through the File menu - Options - DXF and DWG import settings command. 
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� The user’s assignments are stored in the _dxfass.xml file in the Support subdirectory of the installation folder. 

 
In all the three cases you can find the list of AutoCAD® objects in the column on the left, while the columns on the right 
side include the assigned ARCHLine.XP® objects. 

Modify 

• Click the arrow beside the ARCHLine object. 

• Select the appropriate object from the list. 

New 

• Click the New button. The program adds a new ARCHLine object to the end of the list. You can modify this 
object. 

• Specify the AutoCAD® object that belongs to the new assignment. 

Delete 

• Select the row you want to delete, and then click on the Delete button. 
 
In the imported file there can be line types, fonts or dimensioning arrows which are not listed in the table. After the file 
import: 
 

� These line types will appear as user-defined line types in ARCHLine. 
 

� The program tries to 
use the same font 
type as the original. If 
it is not found, the 
program asks for a 
substitution. 

 
� After specifying the 

font substitutions in 
this dialog you can 
save it into the font 
assignment list. 

 
 

� To the arrows not listed in the assignments, the program assigns the default dimensioning arrow. 
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� The Explode dimensions and the Explode dimensions with user arrow settings will override the arrow assignments, of 

course. 

 AutoCAD® style hatches 

In case of importing AutoCAD® drawings, default AutoCAD® style hatches are recognized automatically and handled 
differently from ARCHLine style hatches. This means that scaling and rotating are the only possibilities for AutoCAD® style 
hatches, similarly as users can do it in AutoCAD®. 
 

ARCHLine style hatch settings AutoCAD® style hatch settings 

  
 
AutoCAD® style patterns data are stored in the acpatterns.xml file. This file can be found in the Support subdirectory of the 
program installation. 

 AutoCAD® style hatch selection 

For the selection of an AutoCAD® style hatch: 
 

• Click the Pattern icon in the Hatch properties dialog. 

• In the appearing window select the AutoCAD® style hatches option. 

• Double click on the required hatch. 
�  

 
�  

• After that it is enough to select from the list in the Hatch properties dialog: 
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 Merge to built-in patterns 

There are two categories of AutoCAD® style hatches. 
 

� AutoCAD® style hatches coming from the default program installation files are handled as Built-in category. 
� The user-defined AutoCAD® style hatches coming from the DXF/DWG import are put automatically into the Project 

category. In the Hatch parameters dialog these hatches are displayed with the same pattern and different names. 
 

 
 
Hatches in the Project category can be used only in the actual project (similarly to the new project materials). In a new 
project those will not appear automatically, therefore you have the possibility to move hatches from the Project category 
to the Built-in category by clicking the Merge to built-in patterns button. 
 

 
 

• Select pattern names from the Project category and click the right arrow button. 

• Click Ok to move the selected Project patterns to Built-in patterns. Later you can use these hatch patterns in 
any other project. 

 Limitation – maximum number of lines 

In the File menu -Options - AutoCAD® style hatches dialog you can set a limit for the maximum number of segment in a 
hatch. If any hatch on the drawing requires more segments than this limit, the drawing of hatches will stop when the limit is 
reached. By this the memory usage can be limited. This is handled analogous to AutoCAD®. 
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 Extension of DWG import  

The AutoCAD DWG files can contain 3D surfaces, which are created by drawing out lines, arches, and polygons in 3D, 
by determining the so-called Thickness of the objects. 
You can also create such surfaces in the ARCHLine.XP (see in 3D extension of line nature objects chapter), and the 
program can import the AutoCAD DWG files containing these objects. 
 

�  The AutoCAD creates a surface from the straight lines that it draws out the line into the space perpendicularly to that 

plane, on which it was designed. 
 

1.38.3. 3DS Import 

ARCHLine.XP allows you to import 3D Studio (3DS) files. You can import in three different ways: 
 

� Import a file using the File menu – Import command. In the Open dialog box, select the supported file type. 
� Dragging onto the drawing area by drag and drop 
� Dragging into the Design Center by drag and drop 

File menu - Import 

• Select the file to import. After clicking the Open button, the following dialog pops up: 
 

 

Specify import setting 

Before the placement you can scale precisely the dimensions of the incoming file. Choose a scale value from Units drop-
down list to import geometry at the correct scale.  

 

Click on Place. The model is converted into an object and saved into the object library. Then it appears in the drawing 
area and you can locate it either on the floor plan or 3D view. 

 

� A 3DS file has a field which indicates its unit. However sometimes it is missing and set to a generic value (such as 

millimeters). 

Open 
If the object is not appropriate, you can import another 3ds file. 
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1.38.4. SketchUp Import/export 

ARCHLine.XP® allows you to import SketchUp (.skp) files. You can import in four different ways: 
 

� Import a file using the File menu – Import command. In the Open dialog box, select the supported file type. 
� Dragging onto the drawing area by drag and drop 
� Dragging into the Design Center by drag and drop 
� Import a model from 3D Warehouse 

File menu - Import 

Select the file to import. After clicking the Open button, the following dialog pops up: 

 

 

Specify import setting 

Before the placement you can scale precisely the dimensions of the incoming file. Choose a scale value from Units drop-
down list to import geometry at the correct scale.  

 

Click on Place. The model is converted into an object and saved into the object library. Then it appears in the drawing 
area and you can locate it either on the floor plan or 3D view. 

 

� An SKP file has a field which indicates its unit. However sometimes it is missing and set to a generic value (such as 

millimeters). 

Open 
If the object is not appropriate, you can import another file. 

Import from 3D Warehouse 

Models made available through 3D Warehouse may be downloaded as a "SketchUp [x] Model" (*.skp - where [x] equals a 
version number) file depending on the application used to upload the model originally. 
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To download a model navigate to the item page and click the "Download" button then choose a " SketchUp [x] Model" 
option as presented. 

1.38.5. OBJ Import/export 

The OBJ file format is a simple data-format that represents 3-D geometry alone include only the position of each vertex, 
the UV position of each texture coordinate vertex, normals, and the faces that make each polygon defined as a list of 
vertices, and texture vertices. 
 
You can import Wavefront (.obj) files in three different ways: 
 

� Import a file using the File menu – Import command. In the Open dialog box, select the supported file type. 
� Dragging onto the drawing area by drag and drop 
� Dragging into the Design Center by drag and drop 

File menu - Import 

Select the file to import. After clicking the Open button, the following dialog pops up: 

 

Specify import setting 

Before the placement you can scale precisely the dimensions of the incoming file. Choose a scale value from Units drop-
down list to import geometry at the correct scale.  

 

Click on Place. The model is converted into an object and saved into the object library. Then it appears in the drawing 
area and you can locate it either on the floor plan or 3D view. 

 

� An SKP file has a field which indicates its unit. However sometimes it is missing and set to a generic value (such as 

millimeters). 
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Open 
If the object is not appropriate, you can import another file. 

1.38.6. KMZ Import/Export 

What is a KMZ File? 
 
A KMZ file consists of a main KML file and zero or more supporting files that are packaged using a Zip utility into one unit, 
called an archive.  
The KMZ file can then be stored and emailed as a single entity. When the KMZ file is unzipped, the main .kml file and its 
supporting files are separated into their original formats and directory structure, with their original filenames and 
extensions. 
Google Earth and Google Maps can read KMZ files directly, and they can save files as KMZ files. 
See more here: https://developers.google.com/kml/documentation/kmzarchives 
 
You can import KMZ file in two different ways: 

� Import a file using the File menu – Import command 
� Models made available through 3D Warehouse may be downloaded as a "Google Earth KMZ" (*.kmz) or "SketchUp [x] 

Model" (*.skp - where [x] equals a version number) file depending on the application used to upload the model originally. 
 

 
To download a model navigate to the item page and click the "Download" button then choose a "KMZ" option as 
presented. 

1.38.7. PDF import  

The PDF Import allows you to import a PDF documents in ARCHLine.XP as a raster image. 
 

Menu: File > Import > PDF as Image  
 
 

 

Resolution 

The PDF importer converts PDF files to image format. The resolution option enables to customize the resolution quality in 
DPI.  
 
You can choose among standard resolution values as: 

� 72 DPI 
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� 96 DPI 
� 150 DPI 
� 300 DPI 
� 600 DPI 

 

All pages 

The converter supports single and multiple-page PDF file import as well.  When the option All pages is enabled, every 
pages is imported as a new image. 

Selected pages 

If you import a multiple-page PDF file you can specify a selection to import. Type the page numbers or page ranges 
separated by semicolon for example: 1; 3; 6-12  

1.38.8. Showroom 

Virtual Showroom is a web application accompanying ARCHLine.XP. It contains high-quality fabric and wallpaper 
collections, colors, profiles, furniture, lamps and other 3D models from leading online suppliers. 
It displays and enables to select on one webpage the whole collection of Product types, Manufacturers and Product 
families 
Virtual Showroom helps to our interior designers’ community discovering your company products, downloading and using 
them directly into their projects. 
Showroom is the optimal tool to visualize realistic high-quality online products instead of generic ones. 
Using your products during the design phase, clients will more likely to purchase your products. 
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Downloading an element from Showroom  

• Please be sure that you have a live internet connection. 

• Click Showroom in File menu – Export ... 

• In the appearing categories/brands browse to the element you would like to download. 

• To start downloading, click Download. Wait until the downloading process is finished. 

• In case of successful downloading, a confirmation dialog appears with the appropriate information about the 
downloaded element. 

• Click Ok to accept the element. The element will be stored in the appropriate library for instant placement 
and/or further usage. 

Uploading elements to Showroom 

If you wish to add your products to Showroom, please follow the steps as follows: 

• Please be sure that you have a live internet connection. 

• Click Showroom in File menu – Export ... 

• Click Add Your Brand and follow the instructions in the pop-up window. 

1.38.9. Indigo render export  

ARCHLine.XP supports the Indigo native render file format. Indigo Renderer is an unbiased, physically based and 
photorealistic renderer. 
 
See more: http://www.indigorenderer.com/ 
 

• From the File menu, choose Export. 

• In the dialog box, the Files of type list displays the currently supported file types for export. 

• In the Files of type box, select the supported file type. 

• In the File name box, select or type a file name and click Save 

 

ARCHLine.XP creates the file with „. igs” extension and a folder with the same name and „.tex” extension that contains all 
the textures referenced in their 3D model. 
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 Note: In order to import properly the file with „. igs” extension with other applications on another computer remembers to 
copy the „.tex” extension folder together! 

1.38.10. Autodesk FBX export  

ARCHLine.XP supports the Autodesk® FBX® file format. Autodesk® FBX® provides higher-fidelity data export to several 
Autodesk packages as Autodesk® 3ds Max® and Autodesk® Maya® software. 
 
See more: http://en.wikipedia.org/wiki/FBX 
 

• From the File menu, choose Export. 

• In the dialog box, the Files of type list displays the currently supported file types for export. 

• In the Files of type box, select the supported file type. 

• In the File name box, select or type a file name and click Save 
 
ARCHLine.XP creates the file with „.fbx” extension and a folder with the same name and „.tex” extension that contains all 
the textures referenced in their 3D model. 
 

 Note: In order to import properly the file with „.fbx” extension with other applications on another computer remember to 
copy the „.tex” extension folder together! 

 

1.38.11. IFC Export / Import 

The standard BIM file format is the IFC, which contains all building information data gathered from or added to the project 
and this same format can be used during the whole life-span of the building. 
 
The Industry Foundation Classes (IFC) file format is developed and published by buildingSMART®.  IFC is a universal and 
manufacturer-independent industry standard file format for data exchange between CAD/BIM applications.  
 
The IFC-based data exchange exceeds the nowadays widely used DXF or DWG based data exchange and this means 
you can export and import a lot more information using IFC than using the regular drawing file formats.  
 
One of the highest value of the IFC format is the architectural elements keep their types and properties in it. The walls, 
slabs, and other architectural elements remain walls, slabs, etc. with the same properties when you open them in another 
BIM software - there might be little differences because of technological reasons. 

 Export a Project to IFC 

ARCHLine.XP provides fully certified export based on buildingSMART® IFC data exchange standards. 
ARCHLine.XP supports the IFC 2x3 standard file format, which guarantees an efficient and good quality data and model 
exchange between CAD/BIM applications. 
 
1. Select File / Export / IFC command.  

 

In the Export IFC dialog, navigate to the target folder for saving the IFC file. 

Enter a name for the IFC file In the File name box and click Save 

 

2. Select export options: 
 
Export base quantities includes base quantities for model elements in the export data. Base quantities are generated from 
model geometry to reflect actual physical quantity values. 
 
3. Supported IFC Classes 
 
Before exporting a project to IFC, you can assign to each object the appropriate IFC classes from the list below. 
 
Beam / IfcBeam 
BuildingElementProxy / IfcBuildingElementProxy 
Column / IfcColumn 
Covering / IfcCovering 
Curtain wall / IfcCurtainWall 
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Door / IfcDoor 
Flow Terminal / IfcFlowTerminal 
Footing / IfcFooting"   
Furnishing Element / IfcFurnishingElement 
Grid / IfcGrid 
Lamp / IfcLightFixture 
Member / IfcMember"  
Pile / IfcPile 
Railing / IfcRailing 
Ramp / IfcRamp 
Roof / IfcRoof 
Sanitary Terminal / IfcSanitaryTerminalType 
Site / IfcSite 
Slab / IfcSlab 
Space / IfcSpace 
Space Heater / IfcSpaceHeaterType 
Stair / IfcStair 
Wall / IfcWall 
Window / IfcWindow 
 

  
 
4. Click on Ok and the resulting IFC file is placed in the target folder. 
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 Import IFC 

ARCHLine.XP allows you to import IFC files.  
 
1. Select File / Import / IFC command.  

 

In the Import IFC dialog, navigate to the IFC file to import, and select it. 

Click on Open.  

 
ARCHLine.XP creates a new floor plan with the building and floor plan structure imported from the IFC file.  

 

2. Click on Status bar -  Build 3D model icon to regenerate the 3D model.  

 

3. Click on Enlarge active window to enlarge the selected active window.  
 
All inactive windows will be organized automatically by the software to the right side of the workspace. 
 

 

 

1.39. Managing styles 

Template management allows users to efficiently manage the design process. Using groups of the object properties 
optimizes the design speed and enables to create professional documents. 
 
You can save the group of object properties in a container called style.  
 
When you work with often-used object settings (such as wall or slab height, structure, 2D representation, cover materials 
etc.) styles can be a very useful way to store the settings and recall them later at any time.  
 
The styles are grouped in a template file. Template file let you store and organize the styles and the software allows you to 
load and merge more template files extending your existing styles with new ones. 
 
Templates can be stored on the local computer or a shared drive on the network. This allows users to prepare a local 
factory default which can be updated by an administrator and used by all other users. (Please note that read/write user 
privileges must be set by your system administrator on the network and not in ARCHLine.XP®.) 

1.39.1. Styles  

Style is a container that groups all the object properties. 
When you apply a style, all of the object properties in that style are applied at one time.  
When you start the program the objects are displayed with their default properties as saved in the default style.  
 
By default you can find three categories organized in a tree structure. The three categories are Project, My and Factory. 
All three categories include styles arranged by object types. Styles of an object can be sub-grouped in a tree structure. 

Project template 

Styles created and saved in a project are included in this category. Please be aware that these styles are not available in 

separate template file. These styles are denoted by yellow folder icon ( ). 
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My template 

Users’s favourite styles are stored here in order to make those available in a newly created project. These styles are 
loaded from a My.set file and modifications are saved into this file. My styles are distinguished from other template 

categories by a portrait icon ( ). 

Factory (built-in) template 

Styles found in Factory template come with the first installation of the program and imported in all languages. These built-

in styles are represented by red factory icon ( ). You have to know that these styles have read only property. These 
styles are stored in Factory.set file. 

Local (built-in) template 

Styles found in Factory template come with the first installation of the program and contains language dependend styles. 

These built-in styles are represented similarly by red factory icon ( ). You have to know that these styles have read only 
property. These styles are stored in the language subfolder and Local.set file. 

Loaded/Created template 

These templates include styles that have been loaded from an existing template file or copied into a newly created 

template file. These styles are represented by grey folder icon ( ). Behind each category there is a physical template file 
with .set file extension. 

1.39.2. Using styles in the property dialog 

Select an object type from the properties dialog box (e.g. wall) and click the style button displaying the current style name 

 
 

 
 

�When no style is loaded, the word is displayed. 
A new dialog box appears on the right where the program lists predefined styles. 
You can do the following operations with styles: 

• Create style  

• Activate style  

• Modify, delete, rename style  

• Export  

• Activate style and create new object with the active style  

• Copy properties with style  
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1.39.3. Create new style / new folder 

Once you have specified all properties of a given object in the Properties dialog box: 

� Click the Style button.  
� Click New, and  
� Enter the name of the new style.  

 

 
 

!  The created style is saved only into the project file. If you would like to access it from another project you 

will need to make a copy of it into another template. 

Creating new folder 

You can group the styles to folders. Use the New folder button to do this.  

!  We suggest grouping the new styles to folders! It makes the content less confusing and easier to manage. 

1.39.4. How to create a new template file? 

New category (template file) can be created to the existing ones. 
 

� In Project Navigator click Templates with right mouse button.  
� Select Create template command from local menu. 
� Enter a template file name in the appearing file browser. This file will be the container of the styles created 

in this template. The same name will appear in Project Navigator under Templates. 
 

1.39.5. How to load / save a template file? 

New category (template file) can be loaded to the existing ones. 
 

� In Project Navigator click Templates with right mouse button. 
� Select Load template command from local menu. 
� Select a file with .set extension in the appearing browser. Of course, it makes no sense to select My.set or 

Factory.set because those are for the already existing My and Factory categories. It makes sense to use this 
command if you want to load a category that have been imported from another PC or if you want to load 
again a previously created and saved template file on your PC. 

 Activate style 

By activating a style you can recall all the settings stored in it. This makes the workflow smoother and quicker when you 
need to use an object with different settings. You can activate a style when you define the settings of an object. 
You can activate a style In the Properties dialog box 

Properties dialog box 

• Open the Properties dialog box of an object. 

• Click the Style button to display the list of styles, then  

• Select the desired style from the list and click Activate 
or  

• Double click the style name  
OK Close the dialog box. 

�You may use this method in setting properties or modifying objects as you work. 
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 Modify, rename, delete style 

You can modify the properties of the current style, and rename or delete the style. 

Modify properties 

� Open the Properties dialog box and click the Style button.  
� Activate the style you wish to modify.  
� Change the properties you want to modify, then  
� Click Modify.  
� In the message box displayed, click Yes to overwrite the selected set.  

Rename style 

� Open the Properties dialog box and click the Style button.  
� Choose the desired style from the list.  
� Click Rename.  
� Enter the new name of the style.  

OK Close the dialog box. 

Delete style 

� Open the Properties dialog box and click the Style button.  
� Choose the desired style from the list.  
� Click Delete.  
� Click Yes to reconfirm and delete the selected style.  

 

How to save the modifications in templates? 

When you create a new style in a template, there is not automatic saving in the connected template files and 
folders. 
There are more possibilities for saving the modifications: 
 

� In Project Navigator click Templates with your right mouse button. 
� Select Save all templates command in the local menu. All modifications in all templates will be saved then. 
� In Project Navigator inside Templates group click a template with your right mouse button. Select Save this 

template command in the local menu. Only the selected template file will be saved then. Of course, this 
option is not available in the case of Project template because it doesn’t have separate template file. All 
settings and styles in Project template are saved in the project file. 
 

!  If you work with drawing files (.asc) instead of project file (.pro), settings and styles are not saved into the 

drawing (.asc) file. 

 
� At program exit a Yes/No question dialog appears if there are unsaved modifications in any of the used 

template files. At this point you can decide on saving the modifications or not. 

 

1.39.6. How to move template files to another computer? 

You may want to move your favourite settings or newly created templates to another computer. All styles 
except with styles in the Project template are stored in separate template files. These separate template files 
can be moved from one computer to another. This operation is recommended only for experienced PC users 
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who have a good knowledge in file handling operations. To avoid undesired data loss, before doing anything 
with copying template files, it is highly recommended to archive all files and folders involved. This way you 
can recover files and folders you may delete/overwrite accidentally. 

 Moving of My template 

Styles in My template are stored in My.set file and the connected My.tex folder. You can locate this file and folder on your 
computer by using the Load template command. This command is available in the Project Navigator when you click 
Template with right mouse button. 
 
A file browser appears then, showing the content of folder where My.set file and My.tex folder are located. 
In Windows 7 operating system this is the location by default if you use English language setting:  
C:\ProgramData\Cadline\ARCHlineXP2012\Support\Templates\Eng 
 
As soon as you located My.set file and My.text folder, close the program and move My.set file and My.tex folder to the 
appropriate folder on the target computer. 
 
When doing this moving operation, please check the followings: 

� Be sure that you want to move settings for the same ARCHLine.XP® version. For example, when you want to 
move template files from the source computer with ARCHline.XP 2012 installation, you have to search and 
replace files and folders that belong to ARCHline.XP 2012 on the target computer. 

� Before copying files and folders, create a backup copy of the original files and folders you have to replace. 

 Moving of a newly created template 

Newly created templates are stored in a *.set file and the connected *.tex folder, where ‘*’ means the name of the 
template. For example, when you create a new template with the name of ‘New_template’, New_template.set file and 
New_template.tex folder will include the styles and settings for that template. You can locate this file and folder on your 
computer by using the Create template command. This command is available in the Project Navigator when you click 
Template with right mouse button.  
 
A file browser appears then, showing the content of folder where My.set file and My.tex folder are located. 
In Windows 7 operating system this is the location by default:  
C:\ProgramData\Cadline\ARCHlineXP2012\Support\Templates\Custom 
 
As soon as you located *.set file and *.text folder, close the program and move *.set file and *.tex folder to the appropriate 
folder on the target computer. 
 
When doing this moving operation, please check the followings: 

� Be sure that you want to move settings for the same ARCHLine.XP® version. For example, when you want to 
move template files from the source computer with ARCHline.XP 2012 installation, you have to search and 
replace files and folders that belong to ARCHline.XP 2012 on the target computer. 

 
After copying *.set file and *.tex folder, start ARCHLine.XP® on the target computer and load the template in the Project 
Navigator. 

1.39.7. Template preferences 

A style with the same name but different settings may appear in different templates (Project, My, Factory, created or 
loaded templates). In that case the program takes the template preferences into consideration.  
Project template has the highest preference, followed by My and Factory. Between My and Factory templates you can find 
the newly created or loaded templates. Their preferences correspond to their listing order under the Templates group. You 
can change the preference order by clicking on a template with right mouse button and selecting from the 
Up/Top/Down/Bottom commands. 
 
Template preferences and even the representation of templates can be hidden by the Unified mode command. This 
command is available in the Project Navigator by clicking on Templates with right mouse button. Similarly, you can set 
back the visibility of templates and their preferences by the Detailed mode command.  

1.39.8. Other operations with templates 

Other operations are available by clicking on the template name with right mouse button in the Project 
Navigator: 
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Share template 

It is simply a Save as function for the *.set template file and the connected *.tex folder. After saving the file and folder to a 
commonly used storage, other users can access and load it into the program. This command is not available for Project, 
My and Factory templates. 
 

Unload template 

This is the opposite of Load template command. Styles of the unloaded template will be unavailable. This command is 
not available for Project, My and Factory templates. 
 

Rename 

When you load a template file, its name appears under the Templates group in the Project Navigator. You can modify the 
name with this command. This command is not available for Project, My and Factory templates. 
 

Copy from one template to another 

With this command you can copy all styles from one category to another. Be careful with using this command because 
identical style names in the source and target template may result in overwriting styles in the target template. To avoid 
accidental overwriting, a Yes/No message window appears: 
 

 
 
Template files can be stored on your local computer or on the network by sharing a storage drive. This makes available for 
users to create company-wide customized default settings/styles that can be controlled by an administrator. (Please be 
aware that file access rights for reading/writing are controlled by the network administrator and not by ARCHLine.XP®.) 
Handling and using styles in the Project Navigator 
If you don’t need to modify the properties of styles but you want to arrange, use or set the availability of styles, or you 
simply want to use the styles available in templates, it is recommended to use styles in the Project Navigator. 
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1.39.9. Handling styles in the Project Navigator 

By clicking with right mouse button on a style, the following commands are available: 

Activate 

With this command you can activate a style of a specific object. Next time the object will be placed with the properties 
stored in the style. 

 

Rename 

With this command you can rename a style. The property of objects that have been placed earlier with this style will not 
change. The name of built-in Factory styles cannot be modified. 
 

Delete 

With this command you can delete styles. Styles in Factory template cannot be deleted, of course. 
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Copy to template 

With this command styles can be copied from one template to another. Styles cannot be copied to the Factory template, of 
course. 

 
 
Right click on the new style and click on the Copy to template: My. 
The new style will be copied in to the My template. You can use it in the new project as well. 
 

 
 

1.39.10. Using styles in the Project Navigator by drag and drop 

More commands are available with styles by drag and drop method: 
� In the Project Navigator click on a style, press and hold down your left mouse button and drag the mouse 

cursor into the drawing area.   
� A local menu appears then, where you can select from the following commands: 

Activate 

By activating the style of a specific object you can set the properties of the specific object you place onto the 
drawing afterwards. 
 

Create new 

With this command you can start to draw a new object with the selected style. 
 

Copy properties 

With this command all the properties stored in the selected style can be copied to an existing object on the drawing area. 
Before copying the properties you have to select the target objects you would like to apply the changes to. 
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Beside the above mentioned commands – depending on the object type – you may apply other drag and drop commands, 
too. 
 

1.39.11. Template Import Wizard 

Import from the previous versions 

After downloading and installing ARCHLine.XP at the time of first run of the program the Template Import Wizard appears. 
You can select the previously used (in the previous version of ARCHLine.XP) templates, user objects and load them into 
the actual version. 
Please use the File menu – Import – Template command if you missed this method at the first run. 

• Choose the previous programversion (You can choose from the installed programversions on your 
computer.) 

• Select things you want to import (Template file, Shortcuts, Material libraries, etc.).  
The program is going to search the previous version and: 
 

� styles in the template will be merged to your current settings, 
� Object library contents will be merged. 

 

1.40. Group work 
ARCHLine.XP® supports group work. This means that engineers with different skills can work on different parts of the 
same project simultaneously. The project has an owner, who can assign authorization rights to different parts of the 
project. Only the engineers with the appropriate authorization rights, and the owner, of course, are allowed to work on 
different parts of the project. The others can load others’ plan but not allowed to make modifications on those. 
This method can be applied effectively when the architect, the building engineer and the electric engineer are working 
together, for example. They can involve the interior designer in the flooring design. 

1.40.1. Group work settings 

Working on a project in group requires special authorization rights. First of all, you have to switch to Group work mode. 
You have to create the first user, namely the owner. The owner has administrator rights, who can add or delete users. He 
can cancel the group work mode, making all parts of the project accessible. 
 

 

Creating a multi-user project 

• Select File menu - Group work - Create multi-user project command. In the appearing dialog create a user 
with name, password and status. 
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You can start group work at project start up, or you can switch this mode when you are working on an existing project. 
At project save you can add notes to the project. 
 

 
 
You can submit a note with the Enter key. For the case you exit from the dialog by clicking the Ok button, the new 
message will be saved, too. The messages appear in the message list. Click Cancel if you want to quit without saving the 
message. 
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In case of multi-user projects, messages can be viewed or added by selecting the File menu - Group work - Project history 
command. 

Opening a multi-user project 

In group work mode, at project file opening, first you have to select the user and enter this user’s password. Then you can 
open the project. 
 
Click on “Did you forget your password?”  button if you forgot your password. In the dialog you will get a temporary 
password created by the program. Enter that password then. 
This problem can be avoided by selecting the Remember my data option at first start. If you do that, next time, at file 
opening, the password will get into the password field automatically.  
 
If there are more users with authorization rights, you can select user names whose project parts you want to load in. The 
actual user’s project part will always be loaded. 

 

Change from multi-user mode to single-user mode 

With this command the project will be switched from multi-user mode to single-user mode. 
 

• Select the File menu - Group work - Convert multi-user project to single user command.  

• Save the project. 

• Exit from the project. 
Open the project again. From that point you can work in normal (single-user) mode. 

Administration 

The owner has administrator rights, with the possibility of adding or deleting users. The owner cannot be deleted. By 
deleting a user, the user’s rights will be inherited by the owner 
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Change user 

Designers can hand over their work to each other even on the same computer. After selecting the Change user command 
the program suggests to save the project. At this point you can add notes to the project.  
 
In the User logon, which is analogous to the dialog that appears at opening a multi-user project, you have to select 
another existing user and enter the password. You can select other users whose project parts you want to load in. The 
actual user’s project part will always be loaded. 
 
You can also change user by saving the project and exit, then again, load the project in. In case of large projects this 
method is slow.  
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When a user opens the projects, project parts from other users will be displayed by gray color. These parts cannot be 
modified. Modifications can be done only on own parts. 

  
 
In the example John Phelps architect (the owner) has access to the architecture plan - see figure on the left side. Tom 
Shelley can work only on the site plan - see figure on the right side. 

Hide other users 

By the Hide other users command you can make other users’ project part invisible during the design work. 

1.40.2. Import / Export 

In group work mode more engineer work on different parts of the same project file. There are two methods for 
synchronization: 

� Only one user works on the project at a time.  
After finishing the work, he/she saves the project and hands it over to another user. This linear method is the simplest one. 
In that case, the group work has the advantage that users can work only on those project parts, to which they have access 
rights. 
 

� More users work simultaneously on the copies of the same project (not in network.  
In that case, each user saves his/her own work into the project. They cannot hand over their projects to each other 
because they would overwrite each other’s work. How can they hand over their own parts? 
By exporting those parts from the project first and then other users can import those. 
The result of the export is a special file with .prox extension. 
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Export my part 

Each user can export his/her own project parts (for which he/she has authorization rights) into a file with a special 
extension: .prox. If the name of the group work is groupwork1.pro, the exported parts will be saved as groupwork1.prox. 
The first user hands over only this file to the second user. 

 

• Select File menu - Group work - Export my part command. 

• Save the project, if necessary. 

Import from other users 

Second user gets groupwork1.prox project parts from the first user. 
 

� If this file is found in the same directory where the groupwork1.pro is, and then he/she opens the project, project parts 
from the first user will be loaded automatically. After saving that project, groupwork1.pro will include both users’ work. 
 

� If the file has been saved into the same directory but the project was actually open at the time of saving, or, the file is 
found in another directory, the import must be done by the user. 
 

• Select File menu - Group work - Import from other users command. 
 

 
 

• Specify the file name to import. 

• Exit from the project. Save it, if necessary. 

• Log in as user, save the project and continue your work. 
The project will include both users’ work. 
 
 Before import   After import 

•   
•  
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1.40.3. Project history 

Different users can leave messages to each other with the help of a message box. 
Messages can be submitted at saving the project, or, by using the Select File menu - Group work - Project history 
command. 

 
 
On the top of the dialog you can enter flat texts. Press Enter key to save the message you entered. Messages can be 
filtered by users and date. 
 
Click Browser button to display the messages in your default html viewer. 
Messages can be filtered by users and from-to date 
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5. Data entry 

You can define data (numeric and alphanumeric values, points and vectors) by using 
 

� the keyboard, 
� toolbar icons, or 
� pop-up menus. 

 
This way you can specify values and use special points and vectors, which greatly simplifies the drawing process. 
In the following we will look at how to define points and vectors. 

Defining points 

You can define the value of a point the following ways: 
 

� by typing X and Y global or local coordinates 
� by moving the cursor in the preferred direction and typing the length 
� by clicking on the drawing area 
� with snap grid 
� by using special points 
� by fixing coordinates, distance or vector. 

Defining vectors 

The vector of the drawing can also be defined in various ways: 
 

� with snap angle 
� by pressing SHIFT 
� HV indicator cursor 
� with arrows 
� with the Reference toolbar. 

1.41. Defining coordinates 
In ARCHLine.XP , coordinates can be specified either globally, when the program calculates values in relation to the origin 
of the drawing, or relatively, when values are calculated in relation to the last point. 
 
This can be set in the Status bar. 
 

Global coordinate 
input 
 

Coordinates, values are calculated in 
relation to the origin of the drawing. 
 
 

Relative coordinate 
input 
 

Coordinates, values are calculated in 
relation to the last point. 
 

 
If you press any key, the command line or input field on the drawing area comes up automatically according to the File 
menu -Options - Cursor and Marker tab.  

� See the chapter 2.11.1. Defining values. 
 

• Enter the X and Y coordinate values, following each other, separated with a space: 

 or  

• Click Enter to close it.  
 

! Starting the project we suggest you to switch on the Global coordinate input and to place the first point of the drawing 

in the 0, 0. Later switch on the Relative coordinate input. In practice this simplifies notably to specify further points. 
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Coordinate field 
Coordinate values can be attained from the coordinate fields in the drawing status line. 

 

 

In case of global input ( ), the field 
displays the absolute X and Y coordinates 
of the cursor. 

 

In case of relative input ( ), the field displays the DX and DY values of the cursor in relation to the last point. 

1.41.1. Defining points with snap grid 

 
Snap grid is of great help when defining points. It locks the cursor into alignment with the grid points. 
 
You can enable this option with the Tools menu - Snap command. 
 

1.41.2. Defining points by using special points 

ARCHLine.XP® offers many possibilities to specify points in a simple way. 

Defining a special point with Reference commands: 

� See in detail in chapter 2.16.5 Reference toolbar. 

1.41.3. Cursor Input Box 

When starting a command, ARCHLine.XP displays the Cursor Input Box. 

 
 
This transparent box helps you to visualize and change the actual length, inclination or X and Y spacing of a linear object 
or definition. To enter into the Cursor Input and edit a value press TAB. 

 
 
The software will let you edit the first value of the box. When you press TAB again, you can jump to the following value. 

 
 
When you edit a value and hit the Enter on your keyboard, the software will close the edit field, and fix the value typed. 
This way you can fix the inclination of a wall for example when drawing it. 
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Turn on or Turn off cursor input Box  

Click on the Enable Cursor Input Box input button on the Options dialog to turn d Cursor Input Box on and off. 

Settings to display type 

Use the Cursor Input Box setting to display the information you want to see. 

 

 

 

 
 

1.42. Defining angle 

1.42.1. Direction by triangle 

Simple survey 

In the example below we demonstrate a very simple method for surveying. This method is not so complex like the survey 
module of ARCHLine.XP® but you can quickly define irregular rooms with a help of it. (As it is known, in the survey module 
the program uses a room-based surveying method, by which the walls with uneven thickness are come into existence.) 

The method is the following: 

Starting from the corner point, measure 
1 meter distance on the two adjacent 
walls. Using the constructed triangle 
gained from the measured data, the 
direction of the second wall relative to 
the first can be defined by the program. 
With this you can avoid the measuring 
of angles. On the figure the value of a 
is 1 m, b is the measured hypotenuse. 
 
Following this method it is easy to 
create the floor plan below: 
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• Draw the first wall. 

• When you get to point B, choose 
Direction by triangle command on 
the reference toolbar 

• The program asks for point A, 
which is located on the wall 1 m 
far from point B. Move the cursor 
downside along the wall ant type 1 
m. At this point you have got the 
point A. 

• In the appearing dialog enter the 
length of hypotenuse b. 

 

 

  
 

• The direction of the second wall becomes fixed because of the triangle. Enter the length of the second wall. 

 
Defining direction with Angle snap 

� See the detailed description in 2.20.1. Defining direction with Angle snap. 
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Angle snap 

Select this option to enable or disable angle snap. 
If you enable angle snap, the cursor can only move towards the defined directions. This is a very strong control and can 
be used only in special cases. We recommend that you disable this option. 
When you define Length or press the Shift button, the program finds the default angles even if the Angle snap option is 
disabled. 

Ortho snap 

Using the Tools menu - Ortho command you can switch on the ortho snap. In this case you can move the cursor into 
horizontal and vertical direction.  
If the Angle snap and the ortho snap are switched on the program prefers the ortho snap. 

Using angle snap with disabled snap option 

When you have specified the first point of an object: 

• Move the cursor to the desired direction. 

• The program is waiting for you to specify length or distance. 
Enter the appropriate values. 

• The second point snaps to the nearest special angle. 

Example: 
To draw a 3,05 m long horizontal 
line: 

• Specify the starting point. 

• Move the cursor near the 
horizontal direction. 

• Enter the value: 3.05. 
 

Direction control by using the Shift button 

You can also enable Angle snap by pressing the Shift button. If you press the Shift button continuously, the cursor moves 
towards the nearest predefined direction. After defining a direction, you can carry on with the command you want to apply. 
The Shift button is most frequently used to reinforce vertical or horizontal directions. 
You can combine Shift with cursor snap. With the help of the last three icons of the Reference toolbar, you can define 
which reference direction of the selected reference point to intersect the locked direction to specify a new point. 
 

�  Reference direction perpendicular 

�  Reference direction horizontal 

�  Reference direction vertical 
 

� If you do not use the icons, the reference direction will be defined by the actual status of the icon last used. 

Perpendicular is the default direction. 
These icons can also be used when the direction is not controlled by Shift, but specifying direction is contained in the 
command e.g. modifying the length of a simple wall. 

1.42.2. Defining direction with the HV cursor 

The HV indicator cursor can also show horizontal or vertical direction. You can enable the cursor in the File menu − 

Preferences − General − Other dialog box. 
The HV indicator cursor appears when you select a point and move the cursor in horizontal or vertical direction. (In this 
case, recognizing a special point also means selection.) 

1.42.3. Defining direction with arrows 

You can define in which direction to create an object with the arrow keys of the keyboard. 
In this case the arrow keys substitute the direction definition of the polar coordinate. 
 

 

• Press any arrow button to define 
drawing direction. 

• Specify the length of the object to be 
created. 
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The program creates the object of the 
specified length in the direction defined 
by the arrow. 

1.42.4. Defining direction with Reference toolbar 

You can use the Reference toolbar icons if you have to specify an angle different from the default directions. 
You can define directions with an angle, you can use the angle of an existing object or you can lock a direction. 
 

� For description see Chapter 5.1 Defining points by fixing coordinates, distance or vectors.  

1.42.5. Quick relative polar input 

Quick relative polar input is a handy way to draw walls, lines and other linear objects by defining their length and angle. 
This feature is turned on by default and works automatically if you use the following expression when drawing: 
 
length>angle 

How to use? 
� Start a tool to draw a linear object (e.g.: line) and set the first point. 
� Type the desired length, a “>” mark without quotation marks and the desired angle. 
� Finally press Enter. 

 
It is essential to not to use spaces in the expression as it will lead to a different result. 

1.43. AutoCAD® compatible coordinate input 

The comma as separator 

You can use the comma as separator for coordinate inputs. For this you have to switch off the Comma (,) in Decimal point 
allowed option in the File menu -Options - Unitsa and angles  
 

 
 
For example if you want to draw a line from point X=0; Y=0 to point X=3; Y=4, it is enough to do the followings: 

• Start the line drawing command. 

• Type 0,0 and press Enter to specify the coordinates of the start point of the line. 

• Type 3,4 and press Enter to specify the coordinates of the end point of the line. 
 

� By switching off the option the comma (,) is interpreted as a separator instead of a decimal point. Use the dot (.) 

character for decimal point. 
 
You can specify relative or global coordinates.  

Set the Global / Relative coordinate icon in the status bar to  global.  
With this setting the coordinate input works as follow: 

Absolute coordinate input 

In case of absolute coordinate input the syntax is the following:  
X,Y ENTER  
In that case the global origin is taken into consideration and the coordinate input is relative to this point. 
 
The symbol of the global origin on the floor plan is represented as follows:  
 

 

Relative coordinate input 

In case of relative coordinate input the syntax is the following:  
@X,Y ENTER  
In that case the last specified point is taken into consideration and the coordinate input is relative to this point. 
 
Use this possibility if it is easier to specify a point relative to previous point than specifying the global coordinates.  
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� If the Global / Relative coordinate icon is set to  relative, it is enough to use the X, Y ENTER syntax for the 

coordinate input. 

Polar coordinate input 

Often you know only the angle and length values. In that case use the polar coordinate input. It can be very helpful if you 
wish to draw a line with a length of 2.53 m and an angle of 32°. You can specify absolute or relative polar coordinates as 
well. 

Absolute polar coordinate input 

In case of absolute polar coordinate input the syntax is the following: 
numR<numFi, where 
numR is the distance from the global origin, 
numFi is the angle. 
  

� Use this input method when you know the distance and angle relative to the global origin. 

Relative polar coordinate input 

In case of relative polar coordinate input the syntax is the following: @numDir<numFi , where 
numDr is the distance from the previously specified point, 
numFi is the angle.  
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6. Project Views 

1.44. Setting view 
 
You can create different views of the building model, such as floorplan, sections, elevations, print layouts, moodboards 
and 3D views. 
 
In the 3D views you can set the view of the model; you can set named views, axonometric or perspective. 
You can also set how to display objects in 3D.  

1.44.1. 3D view graphics settings 

In the File -Options - Display dialog box or in the Property grid you can manage the 3D view graphics settings. 

Display options 

You can control the display of the 3D model in several visual styles. 
In a 3D view, click on Navibar – 3D styles icon, or 3D view toolbar icons. 

  
 
Wireframe 

In wireframe representation each edge of the model is visible.  

 

Hidden line 
In hidden line representation the program displays only the edges of the model that can be seen from the current view. 
The program doesn’t display the hidden lines in the background. 

 
Shaded 

Shaded means that the surfaces of the model are represented with the colour properties specified for the used materials. 
Only the surfaces that can be seen from the specific view are displayed. 
Material colour (With wireframe) 
This representation is the combination of Shaded and Hidden line rendering types. 

 
Realistic 

Realistic representation means that the surfaces of the model are displayed with the texture properties specified for the 
used materials (if the texture property is not specified for a material then the material colour is used instead). Only the 
surfaces that can be seen from the specific view are displayed. 

Realistic (With wireframe) 
This representation is the combination of Textured and Hidden lines rendering types. 

 
X-ray 

The X-ray rendering type is similar to the Textured (with wireframe). The difference is that non-transparent surfaces 
become transparent and therefore the structure of the model can be overviewed in unique and spectacularly way, similarly 
to an X-ray photo. 
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X-ray transparency (%) 
When X-ray is selected from the Render type options, you can specify the amount of transparency. You can specify a 
value between 0% and 100%. 

Consistent colour  
Consistent colour mode indicates how natural the colours of objects appear regardless of illuminated by a light source.  
Consistent colour display mode is essential for producing documents like wall elevation view, where it’s important that 
tiles, paintings, etc. display the accurate colour and appear as it looks on a normal noon day. 
 

Consistent colour rendition Textured Phong Shading 

Transparent surfaces 
The Transparency is very useful when you want to display internal volumes together with the entire model. Available in 
Hidden Line visual mode, you can display what is behind the external surfaces of the building. When you work in a room 
you can visualize what is behind the furniture, such as electrical accessories or pipes. 
The transparent surface effect can be set on a category or element. 
 
To apply the transparent surfaces on a 3D view, click on transparent surface button in the 3D Model Display dialog and 
select the category to override its graphic setting.  
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Join surfaces 
Join surfaces shows or hides the common edges of different surfaces. 
This option enables the quality of display of solids with same material to be controlled. When two surfaces have edge that 
match up entirely or partly, you can force to join them with the ‘Join surfaces’. checkbox. 
If you activate the Join surfaces option, the common edges between wall and wall, wall and slab are displayed in 
hidden-line mode, provided that the material of the joining surfaces is the same. 

 
 
These views are captured as ‘Join surfaces’ off and on. 
 

 

Approximation lines 

For the representation of arc surfaces you can switch on the displaying of approximation lines. 

Texture mixed with material colour 

This option displays the texture and its replacement colour together in texture view mode. 
 

 

Transparency 

Using this option you can make the edges behind surfaces with transparent materials visible. By default, only doors and 
windows have transparent surfaces. 
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1.44.2. 3D View Graphic Display Options 

The visual impact of the 3D view depends on the following graphic settings: 
 

Graphic Display Options Description 

Model Display  

Visual Style Select from predefined visual settings to set the visual style of the view.  

X-ray transparency (%) Controls the opacity of the x-ray visual style.  

You can scale it between 0 and 100%. 

Texture shading (%) The strength of the texture shading effect.  

You can scale it between 0 and 100%.  

Available only in views that use the Realistic or X-Ray visual style. 

Lighting and Shadow  

Light scheme Select from interior and exterior sun and artificial lighting combinations, such 

as Exterior: Sun only, or Interior: Sun and Artificial lights, or Artificial lights' 

solid only. Available only in views that use the Realistic or X-Ray visual 

style. 

Ambient light Sometimes it is quite difficult to place enough lights in your drawing to 

be fully realistic. Ambient light setting help with this, but it can 
produce a flat effect. By using ambient light you can add effective 

illumination and highlighting. 
You can scale it between 0 and 500. 

Sunlight Brightness of the direct light. You can scale it between 0 and 500. 

Show shadows This parameter controls the display of shadows in the view. 
Shadow type Soft or Hard shadow. Hard shadow means crisply defined, sharp edges. Soft 

shadow means less distinct view and fade off toward the edges. Soft shadow 

looks more realistic than hard shadows.  

Bump Mapping  Bump Mapping is simulating bumps and wrinkles on the surface of an object. 

Mirroring This parameter controls the display of a blurred reflection effect in the view. 

Do not confused it with a high-resolution photo-realistic image calculated 

with real reflections. 

Available only in views that use the Realistic visual style. 

Camera  

Walk speed 

 

It is called walking when we move the camera in the Walk or Fly function 

with the mouse or the keyboard arrow keys. The speed of walking can be 

specified here. The measure of this is meter/second. 

Run speed 

 

It is running when we move the camera in the Walk or Fly function with the 

move keys, while the Shift key is pressed and hold. The speed of running can 

be specified here. The measure of this is meter/second. 

Visual effects  

Joining Surfaces  Join geometry removes the visible edges between two adjacent surfaces 

having the same material. It works only if adjacent surfaces are in the same 

plane and they meet at a clean edge. 

Classes for Joining Surfaces Select object types to apply Joining Surfaces 

Joining Surfaces is disabled between roofs Switch off Joining Surfaces between roofs 
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Display of Facet Edges Display of Facet Edges (the edges between planar faces representing a 

surface). 

Dynamic section transparency You can change the transparency of the dynamic section plane in the 3D 

model window 

Anti-aliasing Anti-aliasing improves the quality of lines in the view, making edges display 

more smoothly. 

Hardware vertex processing The matter of how the calculations are made either by the CPU (software 

mode) or by the GPU (hardware mode). In software mode the CPU works 

more than if vertex are processed by the graphic card GPU.  

Texture optimization 

 

This parameter replaces the high-resolution textures with properly 

compressed and resized textures. 

Texture quality 

 

Depending on the selected option the program may override the original 

texture resolution and represents the materials on the surfaces with poorer 

quality than the original. 

Instancing  

 

Practice of rendering multiple copies of the same mesh in a scene at once. 
Frequently the 3D model contains numerous copies of the exact same 

geometry with just slight changes in position, scaling, colour, and so on. The 

one by one representation tends to be very inefficient and send a large amount 

of data to the graphics card.  

Instancing is a method of rendering in DirectX that eliminates this problem. 

 
Texture quality example: 

Some textures have 2048x2048 or higher resolution. Texture quality is reducing the texture size, and using proper 
compression on textures. 
 

  
 
Low      Medium 
 

  
 
High      Maximum 
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1.44.3. View toolbar 

� See the detailed description in 2.8.4. 
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1.44.4. Enlarging with View menu - Zoom 

With the View menu - Zoom commands and the Zoom all in all windows command you can increase or decrease the 
view. 
Zoom contains the following commands:  
 

 
 

� You can also activate these commands from View toolbar. For description, see the previous chapter: 6.1.3. 

View toolbar. 

 Zoom out 

This command decreases the size of the drawing with the specified value. Proportions do not change in the window. 
 

• Define the view box by its two opposite corners. 

 Zoom all in all windows (F10) 

The command modifies the zoom scale so that the whole drawing (all visible objects) would be placed within the window. 
The same is done in each window. 

 

1.45. Building 3D models 

The program offers several possibilities to create a 3D model of the designed building. You can display all objects of the 
model on every floor, or just certain floors or selected objects or a selected part of the model. 
The command can be activated from: 
 

� View menu - 2D -> 3D submenu. 

� Status bar -  Build 3D model icon, and 
� F3, Alt +F3, and Alt + T keyboard shortcuts. 

 
When you create the 3D model, the program opens a 3D view to display the 3D model of the floor plan. 
 
The model is shown in the Show hidden object display mode. This means that every object is displayed with hidden lines, 
but the objects do not hide the edges of other objects. You can change settings with the 3D toolbar icons. 
The 3D view follows the changes made on the original drawing. 

1.45.1. 2D -> 3D 

The menu contains the following commands to create and display a 3D model: 
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� The commands don’t modify the object itself, only the 3D appearance of it. 

 Building 3D view - by classes 

 
To display the Build 3D model dialog box, go to the View menu - 2D -> 3D - By classes command, or click on the 

 Build 3D model icon in the Status bar. 
 

  

Classes 

• Select the object classes to display in 3D or click the box on top to select all objects. 

Floors 

• Select an option: 



222 6. Project Views 

Manual 

 

Active floor 
The program only displays the active floors of the building. 

All floors 
All floors are displayed. 

Select floor 
For more complex buildings with a number of floors it is not enough to use the Active floor or All floors options to create 
the proper details of the 3D model. The Select floor option enables more varieties in the 3D model representation: 
 

• The Select floors dialog appears. 

• Select the floors from you wish to include in the 3D model generation. Use the SHIFT or CTRL keys for 
multiple selections. 

• Click Ok to close the dialog. 

• To change the floor selection, select either the Active floor or All floors option first, and then select the Select 

floors option again. 

All buildings 
Enable this option if you have more than one building in the drawing and you want to display all of them in 3D. If this 
option is disabled, the program only displays the active building. 
 

� Read about managing multiple buildings in Chapter 3.5. Floor management. 
 

Create 3D model in one material – Paper model  

In architecture there is a need to create section view, where is necessary to display the mass volume. 
The building itself is composed of different materials, which have in section view different hatching.  
Therefore, these materials must be replaced with one, to all materials combined in one and join surfaces in 3D. 
 
The paper model method enables to create the 3D model in just one material. 
 
This function temporarily changes every material to one material, but the project remembers the distributions of 
materials and next time switching off the paper model function the 3D model restores the assigned materials. 

Settings 

With laminate 

• Enable this option if you want to display the layers of the walls. 

Slab beams 

• Enable this option if you want to display the beams of slabs.  

Wall - slab - roof cutting 
With this option you can fit: 
 

� wall to slab, 
� slab to roof, 
� wall to roof. 

 
If you enable this option, the program automatically cuts the walls higher than the roof where they intersect it. To do this, 

you have to enable the cut option in roof properties.  
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Similarly, slabs overhanging the roof,  and walls reaching beyond the slab are cut. To do this, you have to 
enable the Slab cut option in the Slab general properties dialog box. 
 
Off On 

  

Keep 3D of this project 
If you enable this option, the program creates a new 3D model only for the selected object types, while keeping the 
contents of the previous 3D display. 

Delete entire 3D model 
If you disable the Keep 3D of this project option, the Delete entire 3D model option comes up. If you enable this option, it 
deletes the entire 3D model and creates a new one. 

Create tiles 
Enable this option to display the tiles that belong to layers of the wall or the slab. After enabling this option you can create 
tiles with zero or real width. If you use zero width, it significantly speeds up the display. 

Resolution 

With resolution you can set the smoothness of arched surfaces. The higher the resolution is, the smoother the arched 
surfaces are. However, high resolution can greatly slow down the speed of display. 
If you select high resolution, you can set the precise resolution value. 

 
 

Low Medium High  
 
OK Closes the dialog box. 

Face limit 

When you want to display a 3D model you can define the number of displayed surfaces. If there are too many surfaces, 
the number of the displayed surfaces can be decreased, so the display of the model can be optimized. 

Tiling surface number limit 

The 3D model size can be limited if you define the maximal number of displayed tiles. If there are too many tiles, the 3D 
model size may result too many surfaces, so the display of the model can be optimized with this number. 

 By selection (F3) 

The command displays the selected objects in 3D. 
 

• Select the objects you want to display in 3D:  
Enter Completes the selection. 

 By rectangle (Alt + F3) 

A rectangle-based block cuts the three-dimensional model; the outside parts are discarded and the rest is displayed. This 
command only selects and cuts objects on the active floor. 
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• Define the view box by its two opposite corners. 

 

 By rectangle - on all floors (Alt + T) 

A rectangle-based block cuts the three-dimensional model; the outside parts are discarded and the rest is displayed. 

• Define the view box by its two opposite corners. 

 By polygon 

A polygon-based block cuts the three-dimensional model; the outside parts are discarded and the rest is displayed. This 
command only selects and cuts objects on the active floor. 
 

• Define the points of the polygon. 

� If you need help to draw a polygon, read the description of Polylines   in Chapter 11.2.2. Creating 

lines. 

 By polygon - on all floors 

A polygon-based block cuts the three-dimensional model; the outside parts are discarded and the rest is displayed. This 
command only selects and cuts objects on the active floor. 
 

• Define the points of the polygon. 

 Outside the profile 

A profile-based block cuts the three-
dimensional model; the outside parts are 
discarded and the rest is displayed. This 
command only selects and cuts objects on 
the active floor. 

• Select the POPMENU keyword in the 
command line and define the type of 
profile in the Profile definition menu. 

 
  

1.45.2. 3D visual mode: Framing in wall, slab, roof 

The Framing mode displays wall, slab and roof framing together with the entire building. When you work in this mode you 
can visualize the framing elements with colours and the building is behind them in wireframe. 
To visualize the Framing structure of the building in 3D view, click on Transparent surfaces command in the 3D Navibar. 
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1.45.3. Show/Hide Floor Plan on 3D   

The floor plan consist of 2D items such as lines, dimensions and building components as walls, slabs, roof, etc. The 
Show/Hide Floor Plan on 3D command superimposes the 2D Floor Plan onto a 3D Model displaying them together.  
This kind of presentation including annotation and dimensions makes easier to understand the 3D view. 
The combined 2D-3D offers a very informative layout to communicate your ideas. 
 

 
 

Textured 3D view Floor Plan on 3D X-Ray view 
(Building) 

Floor Plan on 3D X-Ray view 
(Current floor only) 
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1.45.4. Creating 3D models with keyboard shortcuts 

You can also create 3D models with keyboard shortcuts. These are summarized in the following table: 
 

Alt + T 

Creates a rectangle, which cuts the model. The part of 
the 3D model which is enclosed in the rectangle becomes 
visible in the 3D view. The program displays the objects 
of all floors. 

Alt + F3 

Creates a rectangle, which cuts the model. The part of 
the 3D model which is enclosed in the rectangle becomes 
visible in the 3D view. The program only displays the 
objects of the active floor. 

F3 

Select an object and press the F3 button. The 3D model 
of the selected object appears,  
or 
if nothing is selected, press the F3 button. Select the 
objects on the floor plan you want to display. The 
program only displays the objects of the active floor. 

 

If you select an object and click the Build 3D 

model icon in the Status bar, the program only displays 
the selected objects in 3D. 
In this case the program does not activate the Build 3D 

model dialog box, but applies the previous settings. 

1.45.5. File -> Option menu: Refresh 3D 

This command enables to refresh the 3D model continuously. A tick marks if the command is enabled. 
If you set on, every modification of the floor plan becomes visible in the 3D view.  

1.46. 3D views 
After creating the model, you can display it in different views. When a 3D window is active, to set views you can use: 
the View menu − View Properties − Define View dialog box, or 

� the last six icons of the 3D view toolbar  for the main views: right side view, front view, top 
view, axonometric view, back view, left side view or 
 

� the objects of the 3D view shortcut menu, which comes up if you right-click the header of a 3D window. The commands of 
the shortcut menu are the same as the commands in the View dialog box. 
 

� When you apply these views, the contents of the open window are not deleted; the selected view appears in the actual 
representation mode and with optimal zoom. 

� While working you can use different views at the same time in different 3D windows. 

1.46.1. Define View  

You can choose from the following views in the dialog box: 
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Add new 

With this command you can save the current 3D projection and assign a new name to it. This new view is added to the list 
of default view options so later you can select this view from the list too. 
This command is useful mainly when you save different perspective projections.  

Delete new 

You can delete a 3D projection that you previously added to the list.  

Original 

Restores the original view and deletes all relative view transformations from the current window. 

Perpendicular projections 

These are the following:  
Top view, front view, left and right view, bottom and back view. 

Work plane on surface 

You can define the view with a plane surface of a selected object. It means that the view is the plane surface defined by 
the object’s surface area. 
The normal vector of the object surface aims at the viewer.  
In this case the origin of the local 3D coordinate system is the perpendicular projection of the global origin on the work 
plane. 
 

• Select the desired surface, or 
if it is not clear which surface to select, first click on the Select Solid and click a certain surface of the desired 
solid. 
 
ENTER Accepts the selected surface, or 
NO Select another one. 

Work plane by 3 points 

You can define a view by three points of a work plane. 
 
The first point defines the origin of the local coordinate system. The second and the third points define a vector, which 
determines the direction of the local x axis (its projected image is horizontal). The normal vector of the view is a vector 
perpendicular to the coordinate system that was defined by the three points. 
 

• Specify the origin of the view. 

• Specify a point on the positive x axis of the local coordinate system. 

• Specify another point of the view. 

Axonometric 

Automatically creates an axonometric view. 
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Dimetric 

Automatically creates a dimetric view. 
 

Axonometric Dimetric  

  

 

Current perspective 

Applies the last set perspective to the selected 3D window. 
 

� You can read about perspective in detail in Chapter 6.3.3. Perspective view. 

1.46.2. 3D view toolbar - Predefined views 

 

Right view Displays the right view of the model in the 3D 
window. 

 

Front view Displays the front view of the model in the 3D 
window. 

 

Top view Displays the top view of the model in the 3D 
window. 

 

Axonomet
ric 

Displays the axonometric view of the model in 
the 3D window. 

 

Back view Displays the back view of the model in the 3D 
window. 

 

Left view Displays the left view of the model in the 3D 
window. 

1.46.3. Perspective view 

You can set the 3D perspective view in the main menu: View – View Properties – Perspective view or press the 
perspective view icon on the Navigation Bar. The view is resizable, and on the left side you can see the top view of the 
model by default. 
 

 
When the project contains more than one floor plan, by clicking on the 2D view icon, a pop menu will appear letting you 
choose the one that contains the proper floor plan. 
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 Camera handling 

You can set the desired camera and target location. 
 

 

Camera tool 

The camera tool displays the camera location (blue point), the target location (grey point), the middle point between the 
camera and target location (red point) and the angle (green dots) with different colour of markers. You can move the 
markers with the “Drag and drop” method.  
The following camera handlings can be implemented using the aforementioned markers: 

Viewpoint setting 

You can set your viewpoint by moving the camera’s marker. The viewpoint always looks at the point of view or subject. 
The Viewpoint and the Point of view together set the view direction. 

Point of view setting 

You can set the point of view or subject by moving the correct marker. The viewpoint always points to the subject. The 
Viewpoint and the Point of view together set the view direction. 

Angle setting 

You can set the field of view of the camera by moving the corresponding markers. 

Camera handling (dolly) 

You can move the camera by moving the camera-marker. In this case the viewpoint will move with same extent and 
direction as the camera. Therefore we call this style of camera handling as dolly, also used to call in the film production, 
where the camera is moved by a cart. 
Thus the direction of the camera view is remain, only the spatial position changes. 

 Creating Scenes 

With this feature you can save your favourite views and present these views to other people precisely at any time or you 
can improve your photorealistic images using the same view. 
 
When you close the dialog and your active view is a 3D view, you can simply move form one view to another in many 
ways:  

� Pressing the Page Up and Page down buttons 
� Click on the Scene name in the Project Manager 
� Click on the blue UP and DOWN buttons in Status bar. 
� In the Status bar with the Perspective views button. Click on the arrow on the right side of the button to open the views 

list and select the new perspective view. 
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Saved views list 

The Saved views list manages the named views list to resave, add and delete named views.You can check your custom 
viewpoints in the Saved views list. 
 

  

Resave view 

Saves the current view as a named view. 

Add view 

Adds a new named view. You can edit the view by clicking on it. 

Delete view 

Deletes the selected named view. 

View properties 

You can edit the settings of the currently selected view by using the View Properties button. You can change the name 
and angle and set the details of the Camera and Object Position, which is updated and saved into the selected view 
automatically by pressing the OK button. 
 

 

1.46.4. Define view by two points 

Defines the perspective view by observer and observed points  
Before: 
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After: 

 

1.46.5. Navigation in 3D 

You can navigate in the model with the following tools. 
 

� Definition of the origin of rotation 
� Rotation 
� Zooming 
� Shifting 

 Definition of the origin of rotation 

The origin of rotation can be defined differently in axonometric and perspective views. 

Axonometric 
The origin of rotation is specified by the origin of a small co-ordinate system. The origin of rotation can be changed by the 
relocation of this co-ordinate system. 

• Click the Navigation bar - New rotation centre icon. 

• Specify the new origin of rotation. 

Perspective 
In perspective view the origin of rotation is the observed point. You can modify this many ways, for example in the 
Perspective settings dialog. 

 Rotation 

You can rotate the model around the origin of rotation with: 
 

� Shift + mouse wheel button pressed 
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� Arrows on keyboard 
� Navigation bar 

 Zooming 

You can zoom the model with: 
 

� Scrolling the mouse scroll 
� Shift + mouse right button pressed 
� Double click with the scroll button will zoom all 
� Navigation bar 

 
In perspective view, zooming means the modification of the distance between view point and observed point. 

 Shifting 

You can shift the model with: 
 

� Mouse middle button pressed 
� Navigation bar 

1.46.6. Add Background image 

You can insert an Image onto a view, set it to fill the background. The background image is visible in the view only, there is 
no influence on he rendered image. Background image for rendering can be set in Render dialog. 
 

• Click the File menu – Import – Background image command. 

• Select the background image in the dialog. The image size information appears below the image file path 
information. The background image always fills the Image window, independently from its size. 

• Use the Delete button to remove the background image from the window. 

 

   

1.46.7. Shadows 

When you have a vectorial 3D view with hidden-line or coloured or textured mode, you can display vectorial calculated 
shadows.  

Shadowing - Light direction 

Two types of shadowing are distinguished in architectural design: 

Sun shadow 
In this case the position of the sun is defined by azimuth and zenith values. The position of the sun is the same as the 
value set in the Sun settings dialog box. 
Click on Set to specify values. 

Elevation shadow 
In the case of elevation shadow, the sunray comes from a very distant point and reaches the building in an angle that 
you define. Usually this angle is 45° or 135°, depending on whether the light comes from left or right.  
Click on OK to specify values. 
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You can define the light source vector 
with its angle formed with the XY plane (1) 
and with the angle formed with the current 
work plane (2). 
 
Technical shadow is mainly displayed in 
the main views. 
 
 

 
In these two front views you can observe the difference between the technical shadow and the sun shadow: 
 

 
Elevation shadow Sun shadow 
 
The models are displayed in hidden-line mode. In both cases contour lines and hatches indicate the shadow, but shading 
is not added to the models. 

Shadow on vector graphics 3D view 

Besides light direction, you can specify how to display the shadow: 
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The shadow can be displayed with contour lines or with contour lines and hatches. Click on the icon to set hatch 
properties. 
 
If you choose without shadow, no shadows appear on the model, so you can set a shaded image. 
 
In the previous figure the shadow is made up of contour lines and hatches. Let’s compare it with the next figure, where we 
only displayed the contour of the shadow.  

 
 Shadow without hatches 

Position of the contour line 

Once you decide whether you want the shadow with contour lines or with contour lines and hatching, you can define on 
which layer to apply the contour lines. This way you can separate the lines from the model. The contour line is always 
black. 
In the hatch general properties dialog box you can specify on which layer to apply hatching. 
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Shading 

You can set the parameters for shading a model. The model can be displayed in hidden-line mode, with material colour or 
hatched with texture pattern. 
 

 

No (Hidden lines) 
Displays the model in hidden-line mode. 

Material colour 
 
You can display the model with the colours assigned to the materials. If you turn off the shadow (Without shadow) option, 
you get a shaded image without shadow. The colour is the same as the one assigned to the texture in the Material 
properties dialog box. 
 

 
With material colour, without shadow 
 
If you click on the Types to colour button, you can give, that on which objects apply the program the colouring. So for 
example, you can switch off the colouring of objects, which is very time-consuming in the vector graphics 3D window.  

With texture pattern and background colour 

 
You can display the model filled up 
with the hatch assigned to the 
materials and shaded with the 
background colour of the hatching. If 
you turn off the shadow, you get a 
hatched image without shadow. 
The colour is the same as the hatch 
background colour assigned to the 
texture in the Material properties 
dialog box. 
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With texture pattern and background colour 
 

� You can also display the shaded model with the 3D view toolbar  Hidden lines with hatch icon, which creates the 

shaded model or the model hatched with texture pattern depending on the values set. 

Transparency 

You can set whether the glass surfaces are transparent in the vector graphics image or not. 
 

 
 
Let’s see some examples for technical shadow with different settings: 
 

 
Shadow contour + Material colour  Shadow contour with hatches + Material colour 
 

  
Shadow contour + Texture   Shadow contour with hatching + Texture  
pattern  pattern 

 

� To disable Hidden lines with the hatch command press the 3D view toolbar  Hidden lines icon. 

Face limit 

When you want to display a 3D model you can define the number of displayed surfaces. If there are too many surfaces, 
the number of the displayed surfaces can be decreased, so the display of the model can be optimized. 
 

 
 
In brackets you can see the number of the model’s surfaces. We set the initial limit to 30000. 
If the model has more surfaces, the difference is ignored. 
The algorithm is the following: 
in static cases (3D model, rendering), the program examines the size and the distance of the surfaces. It ignores certain 
surfaces on the basis of the result of this multiplication. This means that nearer, bigger surfaces remain, the smaller, 
further surfaces are ignored. 
In dynamic cases (OpenGL, DirectX) the program only examines the size of the surface. 
 

� You can enable Face limit in the File -Options - 3D preferences dialog box. 
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1.46.8. Heliodon  

Heliodon is a tool that creates the appropriate geometrical relationship between an architectural scale model and a 
representation of the sun. By allowing adjustment for solar declination (season), the earth's rotation (time of day), and site 
location (latitude) a Heliodon can simulate sunlight penetration and shading for any combination of site location and time. 
The result is a useful representation of solar patterns for clear sky conditions. 
Heliodon provides an effective tool for the visualization and calculation of solar effects at the window, building, or site 
scale. 

Heliodon tools 

You can activate the Heliodon tool on the Sun Setting Toolbar in a 3D window.  

 
The program displays the Heliodon in the centre of the active 3D window. You can switch off the Heliodon with another 
click on the Sun setting toolbar or with a simple left click on any point of the 3D window except the Heliodon markers. 

 

 
Heliodon tool 

 
The Heliodon represents the sun position with its azimuth and zenith angle. 

Azimuth 

Azimuth is an angular measurement in a spherical coordinate system. The vector from an observer (origin) to a point of 
interest is projected perpendicularly onto a reference plane; the angle between the projected vector and the reference 
vector on the reference plane is called the azimuth. 
See more in http://en.wikipedia.org/wiki/Azimuth 
 
You can move the azimuth with the blue dot markers on the Heliodon’s flat surface with mouse left click.  
The Project Location dialog appears: 
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Azimuth movement 

Zenith 

The zenith is the point in the sky that appears directly above the observer. It helps to describe the location of the Sun  
See more in http://en.wikipedia.org/wiki/Zenith  
 
You can move the zenith with the small sun marker above the Heliodon’s vertical half-circle with mouse left click. The 
model illumination follows the changes and you can see how the building would look at various light conditions. 
 

  
Zenith movement 

Concentric rings 

Two rings represent the North and its perpendicular direction with dotted blue lines. When the designer sets up the right 
North direction the rings follows the changes. The N (North) sign displays the North direction. 
The other ring represents the East-West axis. 

1.46.9. Sun settings 

You can open the Sun settings dialog from the View - View Properties submenu. 
In the dialog box you can set the position of the sun, depending on the geographical position, the date and time. 
If you set a value, it appears in the Perspective dialog box. The rendered image is created on the basis of these values. 
ARCHLine.XP®  automatically displays the longitude and latitude of the selected town, as well as the zenith and azimuth 
values. 
The dialog box displays pictures of the towns. 
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Location 

If you select a town from the pull-down menu, the picture and the longitude and latitude values of the town appear. 
You can add new locations to the list with Add by entering the name, the longitude and latitude values of the town. You 
can also attach a picture. 
To delete a location from the list press Delete. 

Date 

You can set the day and month of the desired sun position. 

Time 

After setting the date, you can set the time of the Sun’s position. 
If the time you set is during the night, i.e. the sun is under the horizon, the model turns grey to indicate night. At sunrise 
the model regains full colour. 

North 

You can define North direction in 
relation to the horizontal 0 degree. You 
can set North by entering a new value 
or by moving the arm. Make sure the 
North direction set here and the North 
direction on the floor plan are the same. 

 
 

� If you want to define North direction graphically, apply the North direction command in the View menu / View Properties. 

 

• OK accepts changes and closes the dialog box. 
 

You can start a photorealistic rendering with the  Rendering icon to see the changes on a rendered image also. 

� You can also carry out a shadow analysis. The command can be activated from the Add-On - Animation 

submenu. You can read about Shadow analysis in chapter 13. 

1.46.10. North direction 

With this command you can define north graphically. 
 

• Make sure the floor plan window is active. 

• Click North direction. 
The program displays a rubber-band line starting from the middle of the screen. 

• Define the endpoint of the line. 
 
The direction of this line indicates North. 
 
The symbol in the bottom left corner of the floor plan window indicates North. 
If you modify the direction, the symbol follows the changes. This symbol does not show in print. 
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� If you want to specify North with numbers, go to the Sun position dialog box. 

 Show on floor plan 

Right-click on an architectural object in the 3D window, and in the shortcut menu choose the Show on floor plan 
command. The appropriate floor becomes active; in the centre of the window the program displays the selected object on 
the floor plan in optimal size. This command is useful in case of large drawings. 

1.46.11. Walk and Fly 

You can represent the 3D content of your projects in higher quality with the help of the View - Walk and Fly 

commands. This function will help you, when you would like to show the different details of the model in real. 
You can do it in that way, as you walk in the building in the reality. You can apply the commands excellently in 
course of work, because the different settings of perspective views and design are become simple. 
 
You can edit the different 3D objects, as if you stand in the model and work in the virtual space. 
 

You can start the Walk and Fly commands with clicking on the View -  Walk and  Fly icon. 
 
It works only in that case if you activate the 3D DirectX window.  

 Terminology 

The difference between the Walk and Fly is the moving method in the virtual model.   
Walk 

In course of walk – like in the reality – the viewpoint height of the spectator doesn’t change. When you move in the 
model with the help of walk, then it moves the viewpoint (the camera) on a fixed horizontal plane.  
Fly 

In course of fly the viewpoint height of the spectator can change as if it flies the model. This function can be 
important, when you need higher freedom of movement from Walk. You can reach down and up different levels 
(for example movement on the step) owing to the freedom open space coordination independently from the size 
of the model. 
 
Because of the things just mentioned we have to talk about the camera. The camera is that point in the open space 
from where we look at the part of the model.  
The observed point and the camera determine together the direction in which the spectator looks. 
The field of view is also important, because you might need wider visual angle in viewing narrow spaces to see the 
proper part of the model. 

 Handling 

You can start the Walk and Fly commands by clicking on the View -  Walk and  Fly icon. 
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When you use the Walk or Fly commands, the mouse cursor is disappeared and you can move in the space by the 
help of mouse and the keyboard. You can change the direction of view with the mouse, while you can move in the 
space with the proper button of keyboard. It is really similar to the movement in the reality, because you can move 
and look around at the same time. It is easier to understand if you imagine the mouse as the head of the spectator, 
and the keyboard as the body of the spectator. 
 
You can interrupt the Walk or Fly command by: 
 

� Pressing down ESC   
� Left click 
� Right click 

 
Using the mouse 

In course of using Walk and Fly functions the mouse determines the view and walk direction. You just have to 
move the mouse.  
 

Moving the mouse Walk Fly 
 
Forward Move forward Move up  
Back  Move back Move down 
Left  Move left Move left 
Right  Move right Move right 

 
Start a command, move your mouse and study the effect. 
 

Using the keyboard 

You can use two sorts of keyboard layout to the keyboard movement. 
 
1. Layout 2. Layout Effect 

 
Cursor up W  Move forward  
Cursor down S  Move backward 
Cursor left A  Move left 
Cursor right D  Move right 
Space  Space  Elevate viewpoint 
C  C  Lower viewpoint 
Shift  Shift  Run 
Page Up/Down Page Up/Down Jump to the next/previous saved perspective view 
 
You can interrupt the Walk or Fly command by: 
 

� Pressing down ESC   
� Left click 
� Right click 
 

Move in open space 
It is practical to learn the movement in open space to move efficiently in it. For this you need the mouse and the 
keyboard at the same time. 
 
Put one of your hands on directions button of the keyboard, and the other one on the mouse.  

Start the   Walk and  Fly command.  
After this, hold down the Move forward button, and release it when you would like to stop. Move the mouse to 
look around. Repeat this as many times as you wish. 
 

You will notice that it will move to the direction you are looking at. You can combine the movement keys as you wish 
according to the simple example mentioned previously, so you have a possibility to complex movement in the open space. 
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1.47. Hide and Isolate Objects 

ARCHLine.XP offers has group of commands that isolate the selected objects (hide everything except the selected ones) 
or hide the selected ones either in 2D or 3D workspace. 
It is very practical tool when you have a large drawing and need to display only one object or a small number of objects. 
 
Menu: View > Isolate 

Isolate Object 

The Isolate Object command hides all objects except the one you select.  

Isolate Selection 

The Isolate Selection command hides all objects except the selected ones.  

End Object Isolation 

The End Object Isolation command displays all objects again.  

Isolate with Wireframe 

The Isolate with Wireframe command sets the selected objects to be wireframe, enabling you to focus on the not selected 
ones. 
The model can be very impressive in texture mode, if you display certain parts of the model with wireframe. 

Hide Selection 

The Hide Selection command hides selected objects.  
 
Objects hidden on the floor plan do not show in print. 

Isolate classes 

The Isolate classes command displays the object classes marked with a tick only. Object classes without tick remain 
hidden. Click the box on top to select all classes. 

Select Similar 

The Select Similar command allows you to select objects that are similar to a selected object.  
The command will select all of the objects with the same type in the drawing regardless of their properties. 
You can apply editing commands in the Property grid that will be valid for the whole selection. The objects remain selected 
so you can apply more commands to the selected objects. 

1.48. Section 

Overview  

You create a section view in a drawing by cutting the model with a section line. The section view can be a straight cut 
section line or a polyline section defined by a stepped section line. 
There are 3 ways to create section views: 
 

� Section on floor plan.  
Section line can be created in floor plan horizontal, vertical, auxiliary, and aligned and optionally with polyline. 

� 3D model section. 
You can cut the model with a polygon. This command physically cuts the 3D model. 

� Dynamic 3D section plane 
Applying the dynamic cutting plane in a 3D window, you can represent the dynamic section in real time. 

1.48.1. Inserting a section view 

Activate the floor plan. 

• Click View menu - Section – Define section or Edit toolbar -  Define section icon to insert a new section 
line on the floor plan. 

• The Section properties dialog appears. Specify the properties of the section. 

• Set the start and the end point of the section line on the floor plan. 

• Click on the side of section line where the section is viewed from. The program places the arrows on that 
side of the section line. 
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• The section line is visible by default on the floorplan where it was created. 

• In the appearing message window confirm the creation of the section view. 

 

 

� Clicking on Yes will create the section.  
� Clicking on No will leave the possibility to create the section later by the View menu - Section – Create section command. 

The program creates the section view of the model according to the selected section line  
 
The section view is created in a new section view. 
 

� The program applies hatch to the cross-sectional cutting planes depending on the status of the Hatch section plane 

option in the Section properties dialog box.. 
 

 
 

� Besides the appropriate setting of view properties in the 3D window (right view, front view etc.), the section view is also 

capable of creating façade view. In that case, place the section line outside of the building. 
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Work on 3D section  

The objects in the section view are editable. You can edit objects in the section view as well as on the floor plan. 
 
Section view can be combined with vector graphics shadowing and with vector graphics hatching but it requires longer 
generation time. Vector graphic shadows can be calculated from the sun or from an arbitrary angle. 
 
There section view enables the visualization of objects crossing the section plane with or without material hatches and 
with thin or thick contour lines. 

Good to know 

� When creating a 3D section view, the name of the window will be generated automatically (Section1, Section 2 etc.). In the 
Project navigator dialog you can rename the section window (the original name of the file that represents the section 
window will not change). 

� One 3D section window belongs to each section line. This way the connection of one section line to more 3D section 
window, which makes the section unidentifiable after some time, can be avoided. 

� If a 3D section window that belongs to a section line is in invisible state (you can check it in the Project navigator dialog) 
then the Create section command will pop up a warning message and no new 3D section window will be created. 

� If a visible 3D section window belongs to an existing section line then the section window will be refreshed by the Create 
command. 

 Section properties 

You can set options for various aspects of section representation either in floor plan and section vew.  
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You can define the section properties in the dialog: 

 

Representation in 2D 

You can set the general section line properties like layer, colour, line type, line width and draw order. In addition, you can 
set: 
 

� the section’s Letter label :   
� Arrow head on section line  or Arrow head not on section line: 

 
 

� Visibility of letter label: Left or right visible or both. 
� Cut direction: Other side visible option moves the cut directon of view to the opposite side of the section line.  
� Visible on all the floors. Check this option if you want to make visible the section line on all floors on the floor-plan. 

Optionally, you can deselect this option and click the ellipsis button next to Display on additional floors. This way you 
can select additional floors on the floor plan to represent the section line. 

� Polyline section. With this option you can define a polyline section line on the floor plan, instead of a single line. 
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Representation in 3D 

� Raster image section. With this option you can create an image of the section view, instead of a vectorial drawing. If you 
select this option, you can set only the Graphics settings and Crop region. Depth parameters. Optionally, items behind 
the crop region can shown by checking the Show items behind the crop region, too. 

� Section lower limit/Section upper limit. With these options you can set lower/upper height limits for the representation 
of the section view. 

� Zero depth section. 3D model behind the section line is not represented in this view. 
� Crop region. Depth. The region displayed behind the section line can be adjusted .  
� Level annotation lines are visible. With this option the level annotation line appears at each floor level on the section 

view. If you check the box it displays the level annotation with its name and its height. If you uncheck the box, it will hide 
that annotation. 

� Symbol on the end of elevation gridlines. With this option a symbol is displayed on the end of elevation gridlines. Click 
the ellipsys to select a symbol. 

� Width of symbol. With this value you can set the size of the symbol displayed n the end of elevation gridlines. 
� Style of elevation gridlines. Here you can select a line style for displaying the elevation gridlines. 
� Stile of elevation gridline texts. Here you can select a text style for displaying the elevation gridline texts. 
� Hatch on section. Each material has a Hatch in 3D setting. On the section view the sectioned items are represented with 

this setting if the option is switched on. 
When you generate a section view, the program does not apply hatch automatically to the cutting planes, because in the 
case of big models it would take too long. If you want to apply hatching to the cross-sectional cutting plane, activate this 
option. 
 

     
 

� Hide all the objects. With this option you can omit all the objects from the section view. 
� Item types for applying the section Line weight. 

Using the section tool there is the possibility to set different line thickness based on the item type that was intersected by 
the section plane. 
This possibility gives you the ability to visualize main structural objects and other objects with different conditions. Click the 
ellipsys button and check item types in the Classes dialog. The Section line weight setting is applied to the selected 
classes in the section view. 
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Marker properties 

The following properties can be set: 
 

� Label on the ends of section line. 

On the ends of section line you can apply different labels instead of arrows. To do this, select this option. 
Click the belonging button and select the appropriate symbol from the Section endings library. 
Enter the value of the variables. For example A ‘1. 

  

 
 

� Width of symbol. In case of symbol selection you can set the size of the symbol. 
You can also set the 

� colour of the symbol/arrow, 
� line weights and arrowhead size and arrowhead type of the arrow, 
� arrowhead line length, 
� Projection Line weight. 

Defining the section line 
Close the Section properties dialog. 
The path of the section line which will be used for creating the section of the model can be defined as line or polyline. 

Line section 

• Specify the two end points of the section line. 

Polyline section 

• Define section line with a chain of lines and arcs. You can break the section line. 

• Enter  close the section line. 
 

• To define the direction of the section view, click on the side of the section line from which you observe the 
model. The program places the markers on this side of the sectioning line. 
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After the definition of the section line, the program offers the creation of it. 

 Section update  

The program automatically updates the section view when changes are made to the model. This is automatic when 
Refresh 3D section checkbox is on. 

 
 
When the Refresh 3D section checkbox is off you can update the section with right-click of the section line and select 

Create / Rebuild to update the section view. 
 

� If you work with a large model it is recommended to switch off the Refresh 3D section. It makes quicker to regenerate 

and display the 3D views. 

 Modifying section  

You can make changes to a Section View or the Section Line by editing the section properties. You can set these 
properties before or after creating the section view. 
 

To change the length or 
location of the section line 

Click on the section line on the floor plan. Markers appear on the 
section line. With the help of these markers the section line can be 
moved, resized, rotated. 

To edit the letter label on the 
section line: 

Select the section line and edit the letter label in the Section 
properties dialog. 

To change the cut direction as 
indicated by the arrows: 

Select the section line and change the Other side visible option in the 
Section properties dialog. 

To switch on or off the 
crosshatch pattern: 

Select the section line and change the Hatch on Section checkbox in 
the Section properties dialog. 

To display the elevation 
gridlines in section view: 

Select the section line and change the Elevation gridlines visible 
checkbox in the Section properties dialog. 

To Modify Section Line 
Properties 

Select the section line and change the  properties in the 
Representation 2D chapter in the Section properties dialog 

To make visible Section Line 
on all floors or selected floors 

Select the section line and change the Visible on all the floors 
checkbox or the Display on additional floors button in the Section 
properties dialog. 

 

Resize and reposition the section line 

You can resize and reposition the section line by dragging it with marker commands. 
The section window follows the section line: Moving, rotating or mirroring the section line on the plan view by any markers, 
the section view will be updated immediately 

 

• Click on the section line on the floor plan: 
 
Markers appear on the section line. With the help of these markers the section line can be moved, resized, rotated.  

  

1.48.2. Additional Editing of Section Views in Drawing 

You can copy and paste a section view to a different view like a floor plan than the parent view for further editing (texts, 
dimensioning etc.). 
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The copied drawing is detached from the section view, and it is freely editable, the section can be”dressed up”.  
For example, you can add dimensions, delete or add details you need. However, the copied drawing is a separate drawing 
the section update command has no eff3ct on it anymore. 
 
We recommend to do the following workflow: 
 
When you finished your work with the model, copy each section views into separate 2D drawing (named as Sections) on 
different floors. For example Section A-A floor, Section B-B floor etc. You can activate the requested section view by 
switching between floors. 
 

� It is not recommended to create as many 2D drawing windows as the number of section views! 

 
We recommend you to detail the section views in these 2D windows.  

How to do it? 

• Create a new window with the Windows - New window 2D command: for example 2D Sections. 

• Make the appropriate 3D section view active. 

• Use the Edit menu - Copy to clipboard (Ctrl+C) command. 

• Select all objects in the window. Enter - close the selection. 

• Specify a reference point on the drawing. 

• Make the newly created floor plan window (2D Sections) active. 

• Use the Edit menu - Paste from clipboard (Ctrl+V) command. 

• Place the drawing in the window by mouse click or keyboard input. Enter. 

• In the Edit floor levels dialog rename floor 0 to Section A-A, for example. Add new floors and then rename 
those accordingly. 

• Repeat the previous steps and copy each section view on the appropriate floor. 
 

• After this, detail the sections. You can add text and dimensions and additional lines, groups or hatches to 
finish up your drawing. 
 
There are major differences between 2D section 3D section view windows: 
 

� The 3D section window follows the changes in the model automatically; it is connected to the floor plan. 
� The connection between the 2D section window and the 3D model is lost; changes on the floor plan are not followed. It 

includes only 2D drawing objects (line, arch, hatchq); therefore you can edit it freely. 
�  

� The same method is recommended when you work on facades.  Pay attention to the setting of the correct view in the 3D 

(drawing) window, and then start the copying to the 2D floor plan window. 
 

Recommendation: 
The number of 2D floor plan windows is not limited but it is recommended to work with a maximum of 3 or 4 2D drawing 
windows, ensuring a clear structure of your project. 
 

� 1 floor plan window for the real floor plan; there are floor plans on different floors 
� 1 floor plan window for the 2D sections; there are different sections on different floors 
� 1 floor plan window for the 2D facades; there are different facades on different floors 
� 1 floor plan window for the site plan; floors are not used in that case. 

1.48.3. Cutting the 3D model 

You also have the possibility to cut with real bool operation the model in the 3D view window with a stepped section line. 
 
For this you have to use the following commands: 
 

• Activate a 3D view 

• Select View menu - Section - 3D model section command. 

• Select the Polygon option from the Profile definition tools appearing on the left side.  

• Draw the stepped section line with the polygon. Close the profile. 

• Click on the part of the solid, which you will keep after cutting. 

• Rotate the model in the window and the stepped section will appear. 
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The program cuts the model in the 3D view. The cut model remains in the 3D view until you regenerate the whole 3D 
model again. 
 
Advantage: 
As you cut the real 3D model, you can also create a rendered image of the stepped 3D section of the model. 

 

      

      
 

1.48.4. Dynamic 3D section plane 

Dynamic section displays the 3D model vertically sectioned in real time.  
It cuts the 3D model with an invisible (optionally angled) plane, so you can only see the content of one side of it. 
 
To use the command you have to start the create section command in a 3D window.  
 
The advantage of this function is that you can create a dynamic section defined by a section plane in real time. Therefore, 
it is not just a working tool for the architects but a spectacular representation of the building. 
 
You will get a section like it is shown on the picture. 
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Defining a section 

Create your 3D model in a 3D window and activate this window. Click  Define section on the Edit toolbar. 
 
Markers appear in the corners of the dynamic section plane. Click on these markers to see the dynamic section marker 
menu: 

� Move: With this command you can shift the section plane to a direction defined by a normal vector perpendicular to the 
section plane. 

� Rotate: With these commands the section plane can be rotated around horizontal and vertical axes. 
� Restore: With these commands you can restore the default position of the section plane. 
� Align view: With this command you can set the view to be parallel to the section plane. 
� Inverse: This command inverts the section. 
� Create section: With the help of this command you can create a dynamic architectural section.  
� Close: This command closes the dynamic section tool. The section plane disappears and you can see the whole actual 

model again. 

Limitations 

Be aware of the following limitations when you work with dynamic 3D section: 
 

� Size of the generated section: the size of the generated section is independent from the section plane you work with. You 
will see the whole section in every case. 

� The angle of section: in every case a vertical architectural section will be created, independently from the tilt angle of the 
section plane. 

� Section line created on the floor plan: along with the section a section line will be created on the floor plan. The length of 
this section line is equal with the width of the dynamic section plane. The position of the section line is defined as the 
horizontal centre line of the section plane projected on the floor plan. 

1.48.5. Sections table list  

You can create a graphic table list and place it on the drawing based on the section of the openings and the section lines. 
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Section lines 

Choose the Sections defined on draw command. 
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Door/window sections 

 

1.49. Opening and wall scale factor 
The View menu contains the following command to display the symbol of doors and windows on the floor plan with 
different scale factors: 
 

 

 
 
You can specify how walls are visualized independent from the scale factor of the whole drawing. 
The abovementioned independence means that e.g. you print your drawing in 1:100 scale, while you set 1:50 for the scale 
of doors and windows, so these appear on the plan in more detail. 
In the dialog box you can set: 

• the scale factor of doors and windows, 

• How walls are hatched and visualized on the floor plan. 

• Visibility of Door Lining and Mounting Gap parameters in 3D view. 
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I) Scale factor of doors and windows: 
Doors and windows have a standard form of display in all scales. Whichever scale you apply to doors and windows, it 
does not affect their physical size, only the form of display. 
ARCHLine.XP offers 5 scale factors to display doors and windows (1:20, 1:50, 1:100, 1:200, and 1:500).  
 

 
 

Floor plan without opening external and internal ref. line in 1:500  
 
In 1: 500 scale factor in 2D floor plan displays only the contours of the walls without any representation of doors / 
windows.  
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II) Wall display 
Walls are displayed with all their layers. 
 
 
 
Walls are displayed with the hatch applied to the 
displayed layer. 
 
 
 
Walls are displayed without layers and hatching. 
 
Independent of the hatching applied to the wall, the 
outside layer of the building’s outside walls are 
hatched black, as it is displayed in the figure. 

 

1.50.  Hand-sketching 

Activate the Tools − Accessories − Hand sketch style command to display the drawing hand-sketched. The quality of 
the freehand drawing depends on the parameters you set. 
 

  
 

� The hand – sketching is not available on 3D image views. 

1.50.1. Assign to all 

The command assigns freehand-style to the whole active drawing. 
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� To restore the previous style of the drawing, click on Assign to all again. 

1.50.2. Assign 

The command assigns freehand-style to a group of drawings. For instance, you can select the perspective drawing (which 
is a group) from other drawings on the plot layout, and you can assign freehand-style to it. Naturally, the floor plan is 
displayed in normal mode. 
 

• Select a group to which you want to assign this style. 

• Select other groups, or 
Enter to complete the command. 
The command deletes freehand-style from the selected areas of the active drawing. 
 

• Select a group to delete freehand-style from. 

• Select other such groups, or 
Enter to complete the command. 

1.50.3. Parameters 

The display of freehand drawings depends on the parameters set in the dialog box. 
 

 
 
You can modify the following 
values: 
 

� the number of iterations, which 
defines line width, and 

� the divider, which defines the 
length of lines. 
 
Try different values and choose 
the one you find best. 
 

 

Default 
Sets the values back to default. 

Set as default 
The values you set become default settings. 
 

• Ok The program applies the values you set to the existing and future freehand drawings. 
 
 

1.51. Magnifier tool 
Magnifier tool can be used in any design situation, when a fine mouse movement is needed to define a specific point. 
Using the Magnifier, you don’t have to change the actual view, because when you switch Magnifier on, you are able to 
zoom inside the magnifier borders.  
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During the use of Magnifier tool you can start and run any other design tool. 

Using the Magnifier 

You can find the Magnifier command in the View menu − Zoom menu. Click on it to switch on/off. 
 

  
 
When you switch the Magnifier on, you can move your mouse over the active drawing. You can see the borders of 
Magnifier. 
 

 
 
Use the wheel on your mouse to zoom in inside the borders of the Magnifier. This way you can enlarge the area inside the 
borders. You can see the actual Magnification value at the left top corner of the Magnifier’s rectangle. 

 
To exit Magnifier, please push the Magnifier icon again on the Status bar of ARCHLine.XP, or push the ESC key on your 
keyboard. 

Magnifier settings 

You can change the settings for the Magnifier tool. 
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You will see the following dialog. 

 

Width 

You can set the width of the border of the Magnifier rectangle in pixels. 

Height 

You can set the height of the border of the Magnifier rectangle in pixels.  

Zoom speed 

You can change the magnification step, which will be used when you scroll the mouse wheel. 

Default zoom factor 

By setting the Default zoom factor you can define the starting value of Magnifier, which you will see when you activate the 
Magnifier tool. 

Preserve zoom factor 

By setting the Preserve zoom factor, the software will remember the last used zoom factor, when you exit the Magnifier. 
Next time when you start Magnifier the software will start with the preserved value, instead of the default zoom factor. 
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7. Selecting objects 

General 

To apply most editing commands, it is necessary to select drawing objects. The set of the selected drawing objects can be 
expanded or restricted. 
The selected objects appear in highlighted colour. 
ARCHLine.XP® offers two methods for most editing commands: 
 

� According to the first method, you must select an object first and then specify the command to be executed on it. 
� When using the other method, you must specify the command first and then select the object the command is executed 

on. 
 
Choose the method that fits your needs the best. 
 
You can also select an object in different ways: 
 

� Clicking on the object with the mouse, or selecting by window (selection rectangle). 
� By using the Selection menu. 

1.52. Selection with the mouse 

As described in Chapter on ARCHLine.XP® Interface - 2.10. Mouse, objects can be selected by clicking with the left 
mouse button on an object, or a selection rectangle can be defined with the mouse. 
In the previous chapter we also described that you can apply an editing command in two different ways. Let’s see the first 
method: 

I. First choose the object then an editing command. 

When the mouse pointer is an arrow shape, the objects can be selected as follows. 

II. Activate an editing command then select the objects you want the command to be executed on. 

With this method you can select objects in a similar way to the previous method, with the following difference: The 
selection must be completed with the Enter key.  

1.52.1. Selecting one object 

• When the cursor is in arrow shape 

 (press the ESC button to get it) 
you can select an object with the 
mouse click on it. 

• The selected object is highlighted 

and  changes the colour to the 
selection colour.  
 

 

 
Note: If there are multiple objects at a certain click point, the quick selection menu pops up helping to choose the proper 
object. 
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1.52.2. Selecting more objects 

• While pressing the SHIFT 

button more objects can be 
added to the selection. 

• Clicking on an object, it is 
added to the selection. 
 

� The selected objects change their 
colour to the selection colour. 

� The objects selected at once only 
have a limited set of markers. 

1.52.3. Rectangle selection 

When the cursor is in Arrow shape , (that means the program is not in active command), there is the possibility to 
define a selection rectangle. If you click on an empty area of the drawing with the left button of the mouse, you can move 
the cursor and click again. The program selects the objects that are inside the rectangle. However it is not all the same 
which direction the cursor is moved.  
Define the selection rectangle with its two opposite corner points:  

• Click with the left mouse button to define the first corner point of the selection window. 

• Move the cursor and click to define the other corner point. 

•  
If you move the cursor from left to right, the program selects all the objects that are inside the rectangle. 

 
Moving from right to left the program selects all the objects that are inside the rectangle and those also that are cut by 
the rectangle. 

 
 
You can apply editing commands to the objects selected. 
 

� The Selection window highlights the selection area with transparent colour. The colour depends on that you select the 

area from right to left (green) or from left to right (blue). 

1.52.4. Quick Class selection 

• Open the Toolbox. 

• Press CTRL and click with the mouse left button on an icon. The command selects all objects on the drawing 
from the given object class. Example: The objects that are selected can be modified together using the 
Property manager. 

� For a detailed description of the option see the instruction 2.5 Toolbox. 
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1.52.5. Quick selection dialog 

Quick selection dialog can be helpful in case of complex drawings when more objects found by a left mouse click selection 
operation.  It can happen that you have to select the desired object from a range of 5, 10 or even more objects.  
 
Quick selection dialog makes the overview of more objects easy by creating a clear, user-friendly selection list. 

How to use 

When clicking a point with left mouse button on the drawing where more objects found, press TAB key repeatedly for 
switching between objects. At the same time the Quick selection dialog appears by which you can monitor the state of 
selection continuously.  

 
 
The Quick selection dialog doesn’t appear when you can’t switch to another object (for example there is no other object 
nearby). 
 
Quick selection dialog shuts down by cancelling the selection. 

Quick selection list 

The list appearing in the Quick selection dialog helps to choose the desired object from the list of more objects. Click the 
arrow down button for this. 
 

 
 
Click on the object in the list and then it will be highlighted on the drawing.  
 
After that you can modify the properties of the selected object in the appearing Property manager on the left or different 
operations like rotation or move can be executed. 

Forward/ Backward buttons 

With the help of Forward/Backward buttons you can switch to the next object in the selection list. This click is the same as 
pressing the TAB key repeatedly.  

1.53. Selection menu 

To select, you can use the  button in the Status bar that activates the Selection menu.  
 
With the pop menu you can select objects in the drawing by using different options. The Selection menu can be used for 
pre-selection of objects and also for selection within an editing command. In the latter case selection must be completed 
with Enter. 
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The Selection menu may pop-up when the program is waiting for selection, and you press the right mouse button.  Select 
the option Display Selection Options in File - Options – User Interface Tab - Customizing Mouse Behaviour instead of the 
Execute Enter command. 
 

 

1.53.1. Enter 

The selection is completed with the Enter key. Right-clicking is the same as pressing Enter. 

1.53.2. All Objects 

This command selects all objects. 

1.53.3. Select Similar 

The Select Similar command lets you choose all objects on the current floor with the type of the selected object, e.g. all 
walls. 

1.53.4. Isolate 

A group of commands that isolate the selected objects (hide everything except the selected ones) or hide the selected 
ones either in 2D or 3D workspace. 

1.53.5. Selection by window 

Options of selection by window: 

One floor - in 

The program selects all the objects on the current floor that are entirely within the selection window. 

One floor - out 

The program selects all the objects on the current floor that are entirely outside the selection window. 

All floors - in 

The program selects all the objects on all floors that are entirely within the selection window. 
 

� With this instruction it is easy to select the entire building. It is useful if you want the building to be placed to a definite 

location on the key plan or the terrain, or to be rotated as moved. For this transformation you can use the Move  
instruction and “Multitrans” option. 
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All floors - out 

The program selects all the objects on all floors that are entirely outside the selection window. 
 

• Specify a corner point of the window. 

• Specify the opposite corner point. 

1.53.6. Selection by polygon 

Options of selection by polygon: 

One floor - in 

The program selects the objects on the current floor that the selection polygon entirely encloses. 

One floor - out 

The program selects the objects on the current floor that are entirely outside the selection polygon. 

All floors - in 

The program selects the objects on all floors that the selection polygon entirely encloses. 

All floors - out  

The program selects the objects on all floors that are entirely outside the selection polygon. 
 

• Specify the first corner point of the polygon. 

• Specify the next corner points of the polygon. The polygon may also contain arcs. 

• Enter Ends the selection of the corner points. 

1.53.7. By fence 

Options of selection by fence: 

One floor 

The program selects all the objects on the current floor that intersect the specified fence. 

All floors 

The program selects all the objects on all floors that intersect the specified fence. 

• Define the fence as a series of lines, arcs with which you select the objects. 

1.53.8. Selection by properties 
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• Specify the criterion of selection. 

• Specify the operator that depends on the defined criterion. 

• Specify the value of the operator (if any). 
 

 ! In the case of a complex logical criterion, after specifying all criteria and selecting the appropriate logical operation, the 

dialog box must be closed with OK. You can continue specifying the criterion by recalling the Selection by properties 
dialog box. 

 

• Specify the logical connection by selecting the appropriate option: 

Add / Or relation: 

Expands the previous selection with objects meeting the new criterion. 

 Object type 

The program selects all objects that belong to a certain object type in the drawing.  
 
Operators associated with object types: 
 

 
• Select the desired object type. 

 
With this option you can select e.g. all walls on a given floor. 
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 Selection by object type with the Ctrl key 

Another, quicker way of selection by object type is the following: 
By choosing a main icon in the Side menu and using the CTRL key, the program selects all the objects in the drawing that 
are represented by the icon. 
 

• Press Ctrl and click one of the main icons in the Side menu, for example: Wall. The program selects all walls 
in the current drawing. 

 Colour 

You can carry out the selection with the defined colour. 
Operators associated with colour: 
 

� Add 
Selects the objects of a specified colour. 

� Except the following values 
Selects the objects that have different colour than the defined one. 
 

• Select the colours from the colour palette, or 
Enter the colour indexes in the Value field separating them by spaces. You can specify more colours at a 
time. 
 

 

 Layer 

You can carry out the selection with the defined layers. 
Operators associated with layers: 
 

� Select 
Selects all objects placed on a specified layer. 

� Except the following values 
Selects all objects that are not on the specified layer. 
 

• Select the desired layer 
from the pull-down menu, 
or 
enter its number or name 
in the Value field. 
You can also define more 
layers at a time, separating 
them by spaces. 
 

 Line type 

You can carry out selection with the defined line type. 
 

� Select 
Selects all objects of a defined line type. 

� Except the following values 
Selects the objects that have a different line type than the defined one. 
 

• Click the line type 
button. From the list 
displayed select the 
desired line type, or  
enter the index of 
the line type in the 
Value field. You can 
also define more line 
types at a time, 
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separating them by 
spaces. 
 

 Line width 

You can carry out selection with the defined line width. 
 

� Equal 
Selects the objects of a specified line width. 

� Not equal 
Selects the objects that have a different line width than the specified one. 

� Region 
Selects all objects the line width of which is within the specified region. 

� Out of region 
Selects all objects the line width of which is outside the specified region. 
 

• When applying the Equal and Not 

equal commands, choose the 
appropriate line width from the 
pull-down list of the Value field, 
or 
enter its value. 
You may define only one value. 
 

 

• When applying the Region and 

Out of region commands, enter 
the lower and upper limit of the 
region in the appearing fields. 
 
 

 Wall width 

Selects walls of a specified width according to different criteria. 
 

• See the selection properties as 7.2.5.5. Selection by line width.  

 Slab width 

Selects slabs of a specified width: 
 

• The selection unit is slab width. Otherwise see the selection properties as 7.2.5.5. Selection by line width.  

 Selection by group name 

As a result of the selection, you get all the groups that you defined by a given name. 
 

• Define the desired name.  

 Selection by style name 

As a result of the selection, you get all the objects the selected set name is assigned to. 
 

• Select the desired set name.  

 Selection by parameter 

As a result of the selection, you get all the groups that you defined by a given name. 
 

• Define the desired name.  

 Selection by object 

As a result of the selection, you get all the objects, that you defined by a given name. 
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• Select the desired name.  

 Selection by column 

As a result of the selection, you get all the columns, that you defined by a given name. 
 

• Select the desired name.  

 Selection by beam 

As a result of the selection, you get all the beams, that you defined by a given name. 
 

• Select the desired name.  

 Selection by ID 

As a result of the selection, you get the object that you defined by a given unique ID. 
 

• Define the desired ID.  

 Selection by Hatch Spacing 

Selects hatches of a specified width: 
 

• See the selection properties as 7.2.5.5. Selection by line width.  

 Selection by Intensity 

Selects light sources of a specified Lumen value: 
 

• The selection unit is Lumen (lm). Otherwise see the selection properties as 7.2.5.5. Selection by line width.  

1.53.9. Common part of selections / And relation: 

Selects only those objects that meet both the previous and the new criteria. 

1.53.10. Subtract 

Selects only those objects that meet the previous criteria but not the new ones. 
 

• Specify a new criterion and an operator that will be the new condition for selection. 

• OK Close the dialog box. 

• Enter End the instruction. 
 
Doing so, you can specify the selection even on the basis of a complex system of conditions in the same dialog box. You 
can also specify the system of conditions in different dialog boxes one after another. 
 
Let’s see the criteria and the associated operators. 

 

1.53.11. Last selection 

The program activates the last selection, thus the previously selected objects can be further edited. 
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8. Editing 

This chapter describes the editing 
commands, including: move, copy, 
rotate, mirror, scale, delete, stretch 
and offset. 
With the editing commands you 
can edit the selected objects. 
Except Undo and Redo, each 
command activates a geometrical 
transformation. 
These commands can be 
accessed: 
 

� From the Edit menu and  

 

 
 

� From the Edit toolbar or the Move toolbar menu on the Status bar. 
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� You can also access some editing 

commands from the General Shortcut 
menu. The General Shortcut menu 
appears if you open the General menu 
option in the File -Options - Right click 
customization dialog box and then right-
click on the empty drawing area. 

 

 

1.54. General editing commands 

1.54.1. Undo - Ctrl Z 

The program stores the last 15 editing steps, thus it is possible to restore the previous status. Each time you click "Undo”, 
the command reverses the last operation. 
 

! This instruction cannot be used to restore the commands in the View menu. 

1.54.2. Redo - Ctrl Y 

To redo a command reversed by Undo, you can use the Redo command. 
 

! It is not possible to use this instruction to recover the result of commands in the View menu. 

1.54.3. ARCHLine.XP clipboard 

� The ARCHLine.XP clipboard is a temporary internal memory. Part or all of a drawing can be placed to and removed from 
the memory. When turning off the program, the clipboard content will be lost. 

� The drawing placed to the clipboard overwrites the drawing previously placed there. 
� The ARCHLine.XP clipboard is not equivalent to the Windows clipboard. 
� This clipboard is used for inserting graphic information within ARCHLine.XP so after selecting the objects you always have 

to specify the reference point. 
 
The ARCHLine.XP clipboard is not equivalent to the Windows clipboard! 
 

� The clipboard provides an effective way to copy any 3D view, section to a floor plan window. The drawing thus copied 

has no connection with the 3D model in the floor plan window. Consequently, editing becomes optional, the view and the 
section can be edited as required. With this option the program provides freedom for the designer. 

 Cut - Ctrl X 

Move the selected objects to the clipboard. Erases the objects selected in the floor plan window. Retains the objects 
selected in the 3D window, so it has the same effect as the Copy command. 
 

• Select the objects to be moved. 
Enter Ends the selection. 

• Specify the reference point of the selected objects (Optional). 

 Copy - Ctrl C 

Copies the selected objects to the clipboard. The drawing copied to the program clipboard overwrites the drawing 
previously placed there. 
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• Select the object you want to copy. 
Enter Ends the selection. 

• Specify the reference points of the selected objects (Optional). 

 Paste – Ctrl V 

Inserts the clipboard content by the reference point into the specified point. 
You can activate the command only if you have already placed objects on the clipboard. 
 
The object or objects can also be rotated as placed. To do so, chooseone of the options: 
 

 

Options: 

Rotation angle… Specify the rotation angle in the form of a number 

Interactive rotation Specify the angle with its two sides 

Rotate and 

Transform 
Specify scaling and a rotation angle before 
placement 

Origo Place to the global 0 0 origin. 

1.54.4. Copy bitmap to clipboard 

When activating this command the program copies the image of the active view to the Windows clipboard in a picture file 
format. This way it is easy to insert the drawing as a picture e.g. into a Word document. 
 

� In Windows use the Edit - Paste (Ctrl + V) command to paste. 

 In ARCHLine.XP® use the Edit menu Paste bitmap from Clipboard command to paste the content of the Windows 
clipboard to the active view. 

1.54.5. Paste bitmap from clipboard 

Paste bitmap from Clipboard pastes the content of the Windows clipboard to the active view as a raster image. 

1.54.6. Snapshot 

Snapshot is a raster image that is taken in a 3D window.  
Snapshot enables you to create attractive coloured documentation of elevation views and floor plans. 
The Snapshot function helps you to move and calibrate a raster image into the 2D floor plan exactly in the right place and 
size.  
It is a special raster image that keeps the 3D model vertex points so you can precisely measure distances and angles on 
that 3D view raster image. 
 

Floor plan with Snapshot Wall view 
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You can start the command from Edit menu when a 3D image window is active. It displays the following dialog. 
 

 
 

Resolution 

The raster image resolution defines the document quality. You can choose as: 
 

� Same as window size 
The software captures a screen shot of your 3D active window to an image with the same resolution. 
 

� Custom size 
Choosing the custom size option you can select a predefined resolution from the drop-down list at the right, as the 
resolution for the image’s largest size. Choose a larger value to set the final result more detailed. Using larger values will 
make the project file size growing larger also. Please choose the size of the snapshot carefully, as you want your project 
not to grow too large, because handling larger projects could make workflow slower on some machines. Otherwise if you 
choose a small resolution, the final image may be pixelated which can make it less useful. Please choose from the drop-
down list. 

Saving format 

You can choose the snapshot image’s file format from the drop-down list. This file format will be used during the process 
of the snapshot. Different file formats store images with different file size and quality conditions. Please select the desired 
file format. 

 

Target drawing 

Select the target drawing where to insert the snapshot image. 

 

Save 

Use the Save button to save the snapshot image into an image file on your hard drive instead of a target drawing. Please 
specify the path and name of the file in the appearing Save as... dialog window. 

 How to make a snapshot 

To create a snapshot of the 3D content you need to choose the 3D window that you want to use as the theme of the 
snapshot. (For example: a top view of the 3D model). 
 
As a second step you need to start Edit menu – Snapshot tool. In the appearing dialog window set the resolution for the 
snapshot image, set its format and please set the target drawing from the drop-down menu as well. When finished please 
press the OK button. 
 
The software will automatically create the snapshot image of the previously set 3D content, and it will be placed soon into 
the selected target drawing. The result of snapshot will be scaled.  
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Top view of the 3D model 
(theme of the snapshot) 
 

Original 2D drawing (the 
drawing, which is set as the 
target) 
 

Result - 2D drawing and 
Snapshot combined 

 
 
 

Wall elevation view snapshot tool 
This command makes a frontal view of the selected wall together with a part of the 3D model.  
 
You can select the wall and the visible wall side. 
The program makes visible the part of the 3D model that is inside the polygon limited by the wall endpoints and the visible 
part click point.  
 
You can edit these polygon nodes and when you press the ENTER button the 3D partial model is created.  
 
The perpendicular view of the wall will be placed as an image onto the selected floor plan. 
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Here is an example of the result: 
 

 
 
 

How to use the tool 
� Start the View menu / Section / Wall elevation view snapshot tool. Also you can use the Wall elevation view tool in the 

Documentation part of the left side Toolbox. 
� Choose the side where you would like to see the elevation from. 
� Edit the automatically recognized contour as you wish, if necessary. 
� Press Enter 

Set the properties and click on OK. 

 Snapshot and object snap 

Snapshot is able to copy and paste any 3D view into another 2D drawing in correct scaling, and it is also able to keep the 
reference points of the original 3D view. This will happen automatically when using the Snapshot tool.  
 
This way you can use snapshots as individual drawings too. The software will recognize the reference points of the 
snapshot, so for example you are able to place dimension on it. 
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Snapshot with dimensions 

 Contour of a snapshot 

Contours of a snapshot equal to the contours of the original 3D view.  
 
This feature is great when you want to place some specific drawing or 2D group behind the snapshot.  

  
 
2D group in front of a snapshot 

 
2D group behind a snapshot 

 Refresh 

Snapshots can be refreshed once they are placed on the target drawing as they are keeping their connection to the 
original model view. Just use the context menu of a Snapshot, select Refresh and wait for the result. 

 Refresh all  

Use the Refresh All option to refresh all the Snapshots on the current drawing. This option can be found in the context 
menu of the Snapshot. Simply click on it and wait for the result.  
When you have multiple large or detailed snapshots, it can take a while until the software will finish the refreshing of all the 
snapshots. 
This tool is extremely useful when you have multiple snapshots of the same model and after changes you would like to 
update all the snapshot drawings. 

 Modify view parameter 

Modify view parameter will open the Graphics settings dialog where you can set changes for the representation of the 
snapshot view (for example change visual style from Textured to Hidden lines representation). 

 Modify resolution 

Each snapshot has a resolution measured in pixels. As the snapshot is a raster image, larger resolution means a much 
detailed representation but also a larger size in the project. If you have a raster image which you feel is a little bit rough at 
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the representation, you can change the resolution to a higher value, but please keep in mind that your project file will be 
larger also and a larger snapshot takes longer to refresh. 

1.54.7. Move  

Using the Move command you can move the selected objects. 
Several methods are available for moving one or more selected objects. 
 

• Choose one of the following methods: 
 

� Use the shortcut CTRL + B to start the command  
� Select object(s) and click on the anchor marker on the view and choose Move or Move from command. (See the image 

below) 
� Select the object(s) and then click on Edit menu - Move command (using preselection) 
� Click on Edit menu - Move command, select the object(s) to move, and then press Enter. 
� Click on the Move icon on the Move toolbar to start the command. 
� Use the program clipboard to cut and paste object(s) with Ctrl+X and Ctrl+V. 

 

 
 

• Specify the reference point for moving (first point).  

• Move the cursor in the direction that you want the element to move. The preview cursor displays the objects 
new position. 

• Specify the new place of the reference point to complete the move (second point), or you can type a value 
for the distance to move the objects, and press Enter (for more precision), or Select object(s) and move with 
Arrow Keys: Use arrow keys on the keyboard and type a value for the distance to move selected object(s) 
vertically or horizontally. 
 

� If you hold Shift while you specify the second point, the new position of the selected object(s) will be orthogonally 

vertical or horizontal. 
 

� The Move command is different than the Cut to Clipboard and Paste.  

Use the Move command when you want to place a selected object and place it immediately in the same view.  
Use the Cut to Clipboard and Paste commands, when you need to change the view before placing the selected objects. 
On the Options Bar, you may select the following command: 

 Origo - Specify the new place of the reference point into the origin. Equal as typing 0 0 and Enter. 
 

1.54.8. Duplicate 

Using the Duplicate command you can copy the selected objects. 
Several methods are available for duplicating one or more selected objects. 
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• Choose one of the following methods: 
 

� Use the shortcut CTRL + U to start the command  
� Select object(s) and click on the anchor marker on the view and select Move a copy from command. (See the image 

below) 
� Select the object(s) to duplicate, and then click on Edit menu - Duplicate command (using preselection) 
� Click on Edit menu - Duplicate command, select the object(s) to duplicate, and then press Enter. 
� Click on the Duplicate icon on the Move toolbar to start the command. 
� Use the program clipboard to copy and paste object(s) with Ctrl+C and Ctrl+V. 

 

Place multiple copies: 

On the Options Bar, you may select the following command: 
Repeat: to place multiple copies. 
 

• Specify the reference point for copying (first point).  

• Move the cursor in the direction that you want the element to duplicate. The preview cursor displays the 
objects new position. 

• Specify the new place of the reference point to complete the copy (second point), or you can type a value for 
the distance to copy the objects, and press Enter (for more precision). 
 

� If you hold Shift while you specify the second point, the new position of the selected object(s) will be orthogonally 

vertical or horizontal. 
 

� The Duplicate command is different than the Copy to Clipboard and Paste.  

Use the Duplicate command when you want to copy a selected object and place it immediately in the same view.  
Use the Copy to Clipboard and Paste commands, when you need to change the view before placing the selected 
objects. 

 On the Options Bar, you may select the following command: 
 Origo - Specify the new place of the reference point into the origin. Equal as typing 0 0 and Enter. 
 

1.54.9. Rotate 

Using the Rotate command you can rotate the selected objects. 
Several methods are available for rotating one or more selected objects. 
 
Rotate is not a valid command for all types. For example, spaces do not rotate in any views. Windows and doors cannot 
rotate without their walls. 
 
Select Rotate a Copy command to rotate a copy of the selection. The original remains in place. 
 

• Choose one of the following methods: 
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� Select object(s) and click on the anchor marker on the view and select one of the rotation command. (See the left image 

below) 
� Select object(s) and click on the blue rotation icon on the view and select one of the rotation command. (See the right 

image below) 
� Select the object(s) to rotate, and then click on Edit menu - Rotate command (using preselection) 
� Click on Edit menu - Rotate command, select the object(s) to rotate, and then press Enter. 
� Click on the Rotate icon on the Move toolbar to start the command. 
� Use the program clipboard to copy and paste object(s) with Ctrl+C and Ctrl+V. 

 

    
• Specify the rotation centre if requested (Edit menu – Rotate). 

• Specify the rotation angle if requested (Edit menu – Rotate). 

•  

On the Options Bar, select any of the following: 

� Rotation angleU:   Type the angle of rotation and press Enter.  
� Interactive rotation:  Specify the angle with with start ray and end ray of rotation 

 

How to define the angle with start ray and end ray of rotation? 

 

• Click to specify the start ray of rotation. The cursor line displays to indicate the start ray.  

• Move the cursor to place the end ray of rotation, or type the angle of rotation, and press Enter. 

 

Options: 

Rotate from Specify the rotation centre and then specify the angle with start ray 
and end ray of rotation. 

Rotate 90 ccw or 

Rotate 90 cw 
Rotate 90 degrees counterclockwise or 90 degrees clockwise. The 
rotation centre is the anchor marker position. 

 



278 8. Editing 

Manual 

� Use the Copy to Clipboard and Paste commands, when you need to change the view before placing the selected 

objects. On the Options Bar, select any of the following: 
 Rotation angleq - Type the angle of rotation and press Enter. 
 Interactive rotation - Specify the angle with with start ray and end ray of rotation. 

1.54.10. Copy by matrix 

Copy (the centre of rotating is the move marker position) 

 Multiply 

With the Multiply -  icon in the Move toolbar menu you can place elements of a certain number at an equal distance 
from each other along the specified line. 
 
Suppose you want to place columns on a wall. You know the number of the columns and that there is an equal distance 
between them. However, you do not know exactly this distance. 
 

• Draw the wall and place the first column on it. 

• Choose the Multiply -  command. 

• Select the element you want to multiply. Complete the selection with Enter. 

• Specify the number of copies. 

• Specify the base point of the distance you want to divide. (Specify the point of the first element that will 
touch - in the case of the last element - the endpoint of the distance you want to divide.) 

• Specify the other endpoint of the distance you want to divide. Before specifying the endpoint you can 
choose REPEAT in the More options menu if you want to change the number of copies. 

 

 

 Array 

It copies a given object according to the given number of row and column.  

 
• Start the Array tool.  

• Select the element, that you would like to multiply. Close the selection with Enter. 

• Set the starting point of the move.  

• Determine the array in the appearing dialog window. OK.  
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I) Graphical 

It places a specific number of elements equidistant from each other on the selected grid.  
 

• Determine the place of the last element in the first row. So you can fix the divided distance, and also give the 
direction of the row.  

• Determine the place of the last element in the last row. So you can fix the divided distance. If the Column 

and row are perpendicular option is switch off, the given point determines the direction of columns too.  

II) Value 

It places a specific number of elements in the given distance (Shift horizontal and vertical) from each other on the selected 
grid.  
 

• Determine the direction of the matrix first row.   
It places specific number objects in the given distance from each other in this direction by the line. The columns of the 
matrix are perpendicular to the rows.  

 Polar array 

It will create arrays of the selected objects by giving angle to fill and repeat factor.  

 
• Start the Polar Array tool.  

• Select the objects that you would like to multiply. Close the selection with Enter. 

• Specify the center point of the array.  

• Enter the angle to fill with equally spaced objects. 

• Enter the number of objects in array. 
 
In this example the command places 4 objects equally spaced around 360 degrees. 
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1.54.11. Mirror 

Reverses the position of a selected objects by applying the mirror transformation. 
 
Two types of mirror transformation are available: 
 

� Mirror by axis 
� Mirror by point reflection 

 
Several methods are available for mirroring one or more selected objects. 
 
Mirroring is not a valid command for all types. For example, spaces do not mirror in any views. Windows and doors cannot 
mirror without their walls. 
 
Select Mirror a Copy command to mirror a copy of the selection. The original remains in place. 
 

• Choose one of the following methods: 
 

� Select object(s) and click on the anchor marker on the view and select one of the mirror command. (See the left image 
below) 

� Select object(s) and click on the blue rotation icon on the view and select one of the mirror command. (See the right image 
below) 

� Select the object(s) to mirror, and then click on Edit menu - Mirror command (using preselection) 
� Click on Edit menu - Mirror command, select the object(s) to mirror, and then press Enter. 
� Click on the Mirror icon on the Move toolbar to start the command. 
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• Specify the first point of the mirror axis.  

• Specify the second point to draw a line and use it as a mirror axis. If you press Enter, the program reflects the 
selected object(s) around the first point. 

• The program moves or copies the selected object(s) and reverses its position opposite the selected axis 
 
On the Options Bar, you may select the following command: 
On selected object: Select a line to use as a mirror axis, or select a line to use as a mirror centre. 

1.54.12. Scale 

Enlarges or multiplies the objects. 
 
Commands that you can apply here:  
 

 

Scale - Move 

With the Edit -  Scale - Move command you can enlarge/reduce the selected objects. 
 

• Select the objects you want to enlarge. 

• Enter accepts the selected objects. 

• Specify the scale centre. 

• With the mouse specify a point that defines the scale factor. The distance between the specified point and 
the scale centre defines the scale factor. This factor is indicated by the mouse pointer info tooltip. 
Choose Scaling in the More options menu if you want to specify the scale factor. 
A scale factor less than 1 reduces the objects. A scale factor greater than 1 enlarges the objects. 

Options: 

Scaling… Specify the scale factor 

X Scale only in x direction 

Y Scale only in y direction 

Scale - Duplicate 

With the Edit -  Scale - Duplicate command you can enlarge/reduce the selected objects. You can also multiply the 
copies. 

Option: 

REPEAT When making multiple copies, specify the number of 
copies. 

 

� For a detailed description of the command see Chapter.8.1.12.1 on Scale - Move. 
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1.54.13. Align 

The Align command aligns and/or distributes the selected objects on floor plan.  The alignment applied only along the 
horizontal and vertical axes. 
 
Menu: Edit > Align 
 
The Move with Align dialog box displays. 
Select a line as horizontal and vertical axes. 
Select the objects to be aligned  or  aligned proportional (distributed) 
 

 
 

Left 

Align to the horizontal axes by the left side of the selected objects with offset value. 

Right 

Align to the horizontal axes by the right side of the selected objects with offset value. 

Top 

Align to the vertical axes by the upper side of the selected objects with offset value. 

Bottom 

Align to the vertical axes by the lower side of the selected objects with offset value. 

Offset 

Distance between the horizontal or vertical axes and the selected objects. 

Align proportional 

Aligns the selected objects keeping their location relative to each other. 

Align proportional 

Aligns proportionally the selected objects on the distance between the two far position objects. 
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1.54.14. Select all 

We can select all items in the same time with this command. 

1.54.15. Delete single (Ctrl + D) 

Deletes the selected objects in the current drawing one by one. 
 

•  Start the tool. 

• Click the object you want to delete. 

• Select further objects to be deleted, or 
Enter Ends the command. 
 

! All objects associated with the selected object are also deleted. (For example, if you assigned dimension to an object, 

when deleting the object, the dimension lines are also deleted.) 
 
If you delete an object in the 3D window, the Select a surface option appears in the More options menu. With this 
keyword you can delete the patterns placed on the surface of the solid (2D group) 

� You can activate the command in the following ways: 

� By clicking the Delete -  icon in the Edit toolbar, or 
� In the Shortcut menu of each object as well. In this case right-click the object. 
� If the mouse pointer is an arrow shape: hold the Ctrl key and click an object, then the entire object is deleted (only with 

specific settings in File menu – Options – General / Marker settings – Special shortcut). 
� If you click an object in the drawing and press the Del key, the program deletes the entire object. 

1.54.16. Delete 

With the commands in the Edit - Delete menu object you can delete the objects or the specified part of the objects in the 
current drawing. 
The menu object contains the following commands: 
 

 
 

� The Delete, Select, Delete area, Delete all instructions can be applied to all object types.  

The other delete instructions can only be applied to geometric objects, but not to architectural ones. Thus, for example, 
with the Delete between points command it is not possible to delete the part between the two intersections of the wall. 
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 Delete between points 

The program enables you to delete the section of an object between the intersections (or endpoints) nearest to the 
selected point. If the object does not have or has only one intersection with other objects, this command corresponds to 
the delete operation. 
 

• Select the object to be deleted between its nearest intersections. The program immediately deletes that part 
of the object. 

• Repeat the previous step if you want to delete further parts of the object, or 
Enter Ends the command. 
 

� You can activate the command in the following ways: 

� By clicking the Delete between intersections -  icon in the Edit toolbar. 
� When the mouse pointer is an arrow shape: hold the Ctrl and Shift keys and click an object, and then the program deletes 

the section of the object that is between the intersections. 

 Partial delete 

Deletes the section of the 
object between the selected 
points. 
 

• Select the base point of the 
line you want to delete: 
Point 1 

• Select the endpoint of the 
line you want to delete: 
Point 2 

• Select further lines to be 
deleted, or  
Enter Ends the 

command. 
 

 

 

� The Partial Delete can be applied to dimension projection lines as well.  

 Delete selected 

The command deletes the selected objects in the current drawing. 
 

• Select the objects to be deleted. 
Enter Ends the selection and deletes the objects. 

• Repeat the previous step if you want to delete further objects, or 
Enter Ends the command. 
 

� To select a group of objects you can apply the commands in the Status bar - Selection menu. 

 

� You can also activate the command with the Delete selected -  icon in the Edit toolbar. 

 Cut rectangle 

With this command you can delete objects in the following ways: 
 

� You can delete the objects or their sections that are inside a specified rectangle or area. 
� Before deleting you can pre-select the objects on which the deletion will be carried out. 

 
If an object is not entirely enclosed by the rectangle or area, only its section inside the rectangle or area is deleted. The 
contour of the selection area is shown by broken line. 



 8. Editing 285 

 ARCHLine.XP® 

Deletes all objects or all sections of an object inside a specified rectangle: 

• Specify the first point of the selection window. 

• Specify the other point of the selection window. 

• Repeat the command, or 
Enter Ends the command. 

 

Deletes all objects or all sections of an object inside a specified area: 

• Choose POLYGON in the More options menu. 

• Define the polygon within which you delete all objects or all sections of an object. 

• Enter Completes the definition of the polygon, and the program executes the deletion. 

Deletes all objects or object sections inside a specified area, but you can select the objects on which deletion will be 
carried out: 

• Choose PRESELECT in the More options menu. 

• Select the objects the deletion will be applied to. 

• Specify the polyline that is necessary for the deletion. 

• Enter Completes the definition of the polyline, and the program executes the deletion. 
 

� If you specified an open polyline, the program automatically connects the first and the last point of the polyline to create 

a closed polyline (polygon). 

 Cut polygon 

Deletes all objects or all sections of an object inside a specified area. 
If an object is not entirely enclosed by the area, only its section inside the area is deleted. The contour of the selection 
area is shown by broken line. 
 

• Define the polygon within which you delete all objects or all sections of an object. 

• Enter Completes the definition of the polygon, and the program executes the deletion. 

Options: 

Circle The selection area is a circle  

Parallel shifted… Before defining the polygon specify the offset value. 
It means that the area will be an area enclosed by 
the contour of the reference point enlarged or 
reduced by offsetting. 

Width… The selection area is a polyline with a specified 
width. 

 

Arc The next object of the polyline is an arc.  

Select an object The next object of the polyline is an existing object.  

Spline The next object of the polyline is a spline. 

 Area 

The command deletes the objects that are entirely inside the selection area. The contour of the selection area is shown by 
broken line. After closing the selection area you can select the objects to be deleted one by one. 
 

• Specify the polyline necessary for deletion. 

• Enter Completes the definition of the polyline. 
 

• Select the objects the deletion will be applied to. 
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• Enter Ends the selection, 

• Enter The program executes the deletion. 

 All 

The command deletes all objects in the current drawing. 

1.54.17. Stretch 

The Edit - Stretch command stretches the sections of an object that are completely inside a selection area. 
 

� If the object is a single line or a segment of a polyline, the program moves its endpoints only, and connects them again 
with a straight line. 

� The ’curves’ (circle, arc, ellipse, elliptic arc, splines) intersected by the area are cut at the intersection. The instruction 
connects the intersections with a straight line at the same time retaining the geometrical relations. 

� All hatchings and dimensions assigned to the object follow the changes of the stretched object. 
� In addition to the geometric objects the command is also valid for the wall and the slab. After stretching the wall 

connections are restored. 

 
You can specify the area in the following ways: 
 

� By selection rectangle or 
� With the Polygon option. 

Window 

• Specify the corner point of the window. 

• Specify the other corner point of the window. 

• Specify the start point of the offset vector. 

• Specify the endpoint of the offset vector. 

Area 

• Choose Polygon in the More options menu. 

• Specify a chain of lines and arcs. Enter. 

• Specify the start point of the offset vector. 

• Specify the endpoint of the offset vector. 
Enter Ends the command. 
 

� For a detailed description of the options of Polygon see the instruction 8.1.12.5 Delete – Cut polygon. 

1.54.18. Offset 

With the Edit menu - Offset command you can create a contour around the selected object at a specified distance. The 
contour of lines, polylines, arcs and splines retains its original type during the offset transformation, while circles are 
transformed into arcs, and the contour of ellipses and elliptic arcs into splines. 
 

Select the object to offset or select an option: 
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Select one by one 

Select an open chain 

Select one by one 
You must select the components of the closed chain one by one. 

Select an open chain 
You can specify the open chain by clicking near one of its endpoints. 
You can specify a segment of the chain by selecting any part of it (except its endpoint). Then you can choose the chain 
starting from the selected object to the endpoint that is farther from the centre of the selected object. 
 

Offset type 

• Select the desired offset type by clicking the option: 
 
Parallel 

 
Offsets the chain of one or more 
objects at a specified distance from 
the selected objects. 

 

Rounded 

 
Offsets the chain of one or more 
objects at a specified distance from 
the selected objects. Should the new 
profile become geometrically 
distorted, the program rounds the 
corners off.  

Select mode 

• Specify the select mode: 
 

Offset distance 

Offset distance: distance of the new contour from the selected objects. 
After the selection, the program asks you to specify the offset distance: 

• Drag the mouse pointer to the direction where you want to create the offset. Enter the offset value.  

1.54.19. Trim 

With the options in the Edit menu - Trim command, you can trim objects by trimming or extending them, so that their 
endpoints closest to the selected points coincide. 
Select a subcommand: 
 

 

 Both objects 

The command trims the two objects by trimming or extending them. Adjustment involves the intersection closest to your 
selection. 
 

• Select the first object you wish to trim. 
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• Select the second object you want to trim. 
Enter Completes the command. 

 

� You may also activate the command with the Edit toolbar - Trim both objects icon. The command can be used for 

walls and corresponds to the L connection. 

 First object - CTRL + F 

The command trims (or extends) the unnecessary section (missing section) of the first selected object compared with its 
intersection with the second object. 
Adjustment concerns the intersection nearest the selected section. 
The second selected object only helps selection and is not modified with this command, just as the other endpoint of the 
first object is left intact. 
 

• Select the object you want to trim. 

• Choose the object you want the first object to intersect with. 
Enter Completes the command. 

 

� You may also activate the command with the Edit toolbar -  Trim first object icon. The command can be used for 

walls; it corresponds to the T connection. 

 Multiple 

The command trims all subsequently selected objects to the first defined object.  
It trims or extends that section of the objects you define after the first selected object, which is closer to the intersection. 
The first selected object and the other endpoints of the specified objects are not modified with this command. 
 

• Define the object to which you wish to adjust the objects selected subsequently. 

• Specify the objects you want to adjust. 

• Press Enter to complete the command. 

 

 All 

The command trims to the segments all objects falling between the two given bordering segments. This means that the 
objects are trimmed or extended to their intersection with the adjacent segments. 
 

• Select the first line to which you wish to adjust the objects. 

• Select the second reference line. 
Press Enter to complete the command. 
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1.54.20. Break 

Breaks the objects at a point defined with another object. Using this command, you can split an object in two separate 
parts. 
The program transforms circles into arcs, and ellipses into elliptical arcs. 
Choose a subcommand: 
 

 

 Break first object 

Breaks the first selected object in two new objects at the point where it intersects the second (reference) object closest to 
selection. The command does not break the second object. 
 

• Choose the object you want to break. 

• Choose the object that intersects the first object. 

• Press Enter to complete the command. 

 Break both objects 

Breaks both selected objects in two new objects at their intersection closest to selection. 
 

• Choose the object you want to break. 

• Choose the second object you want to break. 

• Press Enter to complete the command. 

 By cutting edge 

You can break the selected objects with the help of an imaginary reference line. 
The cutting points will be at their intersections with the reference object. 
 

• Define the start point of the cutting edge. 

• Define the endpoint of the cutting edge. 

• Select the object to be break at its nearest intersection. 
Press Enter to end selection. 
Press Enter to complete the command. 

 Between two objects 

By using this command, you can break the object at its two intersections closest to a surrounding selection. 
 

• Select the object you want to break between two intersections. 

Press Enter to complete the command. 
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1.54.21. Lengthen 

You can modify the length, radius, endpoint and resolution of the objects with this command. 
Select a subcommand: 
 

 

 Length by number - CTRL+N 

With this command you can alter the length of a selected object (segment, arc, elliptical arc) by moving its endpoint 
closest to selection and specifying the new value in the form of a number. 
 

• Select a line, arc or elliptical arc. 
The Length modification dialog box appears displaying the current value of length. 
 

 
 
Choose an option and define the new value. 

Absolute Specifies the length of the object. 

Relative Specifies by what value the length of the object should be increased/decreased. 
 

OK Completes the command. 

 Lengthen by cursor - CTRL+L 

You can alter the length of the selected line, arc or elliptical arc by moving one of its endpoints to the desired place without 
changing its direction. With circles you can graphically modify the radius, whereas with ellipses the minor and the major 
axes. 
 

• Select the endpoint of the line segment, arc or elliptical arc along which you move the object. (The endpoint 
closest to selection will be moved.) 

• Define the new place of the endpoint graphically. Using the expand line departing from the endpoint, you 
can move the specified endpoint to its new place, or 
 

Option: 

Beam Extends the selected beam. 
 
Press Enter to complete the command. 
 

� Once you select the object, you may also modify its length or radius with the hotspots. See the Tools -2.10.1 Clicking 

with the left mouse button Chapter. 

 Relocate endpoint 

You can modify the selected line segment, arc or elliptical arc by moving one of its endpoints to the desired place. 
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• Select a line segment, arc or elliptical arc. 

• Move the endpoint closest to selection. Specify its new position. Using the expand line departing from the 
other endpoint of the object; you can move the selected endpoint. 
Enter Ends the command. 

 Convert spline to arcs 

With this command you can alter the resolution of arched objects. The value defined for resolution specifies how many 
linear segments a polyline representing circles or ellipses should consist of. 
 

• Specify the value of resolution. 

• Select the objects the resolution of which you want to modify. 
Enter Ends the command. 

1.54.22. Chamfer 

Connects two objects with an angled line. 

1.54.23. Fillet 

Connects two objects with an arc. 

1.55. Main axis markers for 3D move 
With the effective usage of 3D technology ARCHLine.XP® makes the operations in the model space easy by interactive 
3D cursors. 
 

 
 
When selecting a 3D object, the program shows the main axis for moving operations. With the help of these markers you 
can move the selected object in the space along the main axes. Each axis has different colour representation. The 
horizontal X axis is represented by green, the horizontal Y axis is represented by red, and the vertical Y axis is 
represented by blue colour. 

How to use 

Clicking one of the main axes starts the movement along the axis. You can set the new position by moving the mouse 
cursor to the desired point and then clicking again. 

 
You can see possible overlaps while moving the mouse 
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1.56. Modification 

You can modify both the properties and the geometry of the created objects. 

Modifying properties 

Some opportunities to modify the properties are available from the Modify menu. But the modification of any object is 
available with the Properties command from the Shortcut menu or in the Property manager. 

Modifying geometry  

The geometry modifying commands are available as follows: 
 

� Click on the appropriate icon in the Toolbox or the Main menu , or 
� Right click on the object from the Shortcut menu. 

 

1.57. Specifying properties 
Before you create any object, you can set the properties of the object in the Properties dialog box. You can activate the 
dialog box in several ways: 
 

� With the Building menu - Properties commands, or 
� With the Drafting menu - Properties  commands, or 
� With the Dimension menu - Properties  commands, or 
� Right-click on the icon of the object in the Toolbox tool. 

 
Here you can specify the global properties that will be associated with all corresponding object types created 
subsequently. 

1.58. Modifying properties 

You can modify the properties of objects already created in the following ways: 
 

� One by one, by selecting the desired property in the Shortcut menu - Properties dialog box. 
� By copying the properties of a reference object with the Modify menu - Copy properties command. 
� Using the Property manager, see the Chapter 2.14. 
� With the Modify menu – Create similar command it is possible to create new objects, using the properties of an object 

already created.  
� In the Substitute material dialog the he selected texture can be changed to the desired one in all the objects in the plan. 
� You can modify the material of the objects using the Design center.  

1.58.1. Modifying the properties of certain objects 

You can modify the properties of certain objects if you: 
 

� The Property Manager visualizes the properties of the selected objects and modify its values  
� Right-click the object, then select Shortcut menu - Properties. 
� Select the object and click on the Properties marker. 

 
When the Properties dialog box displayed you can specify properties that will be assigned only to the selected object. 
 

� You can find the detailed the specification and modification of the properties of each object type in the 
corresponding chapters. 

1.58.2. Copy properties 

With the Copy properties command you may also modify the properties of an object group if you copy all or certain 
properties of a selected object to a group of objects. 
 
You can activate the command: 
 

� In the Modify menu, 
� Right-click the object, then selecting the Copy properties option in the Shortcut menu displayed, or 

�  With the Copy properties icon -  in the Edit toolbar. 
 

• Activate the command, and 

• Choose an object the properties of which you wish to copy, or select the option corresponding to the desired 
object type in the command line if selection is ambiguous, that is when objects overlap. 
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• Select the desired properties in the Properties dialog box. E.g. in the case of wall the following dialog box 
appears: 

• By clicking the checkbox in front of a property you can turn that property on and off. If you click the box in 
the heading you can turn all properties on and off. 
The program assigns only those properties to the selected objects that have been selected. 

• You can decide whether you copy the parameters (which may contain important data for quantity 
calculation) assigned to the object. 

 
• Select the objects you wish to modify. 

Enter Completes the command. 
 

In case of objects, you can copy properties between floors as well.  
For this please select the Go to: Lower floor or Go to: Upper floor keyword from the More options menu. 

Options: 

Go to: 

Lower floor 

The software activates the following lower floor if there is 
any. 

Go to: 

Upper floor 

The software activates the following upper floor if there is 
any. 

 

� In case of object if the “Name” option is switched on, the objects to be modified will inherit the object type as well. 

1.58.3. Layer control mode 

In the ARCHLine.XP® program the Modify menu - Layer control mode option is turned off as default.   
When setting the general properties of object types you must specify to which layer you want to assign the objects of the 
object type in question. 
You can place objects with different properties (different colour, line type, line width, even different type, etc.) on the same 
layer, which due to other aspects, you want to handle together. 

� For a detailed description of the options of Layer control mode see the instruction 3.4.5. Layer control mode. 
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1.58.4. Create similar 

� You can create a new object with the properties of an existing object by using the Modify menu - Create similar 
command. 
 
You can activate the command: 
 

� In the Modify menu or, 
� By right-clicking the object and selecting the Create Similar@ option in the Shortcut menu displayed. 

 

• Activate the Modify menu - Create similar command. 

• Select an object to open its property list. 
 
The program reads the properties of the selected object and enters the create object command. The object drawn 
subsequently will have the properties of the selected object. 
 
If for example you select a wall to read its properties, the program offers the Create wall command. 

1.58.5. Layer 

With the use of layers you can group or separate the objects of the current project according to various aspects. 

� For a detailed description of the options of Layer see the instruction 3.4 Managing layers. 

Layer Manager 

This dialog manages layers and layer properties. You can change the current layer, create new ones, delete or turn on 
and off layers and lock/unlock them, change the printable status. In layer control mode you can assign properties such as 
colour and line type, line weight. 

� For a detailed description of the Layer manager command see Chapter 2.16.2. Layer toolbar. 

Move Objects to New Layer 

This tool will move objects from one layer to another, by selecting the destination layer from a dialog. 

� For a detailed description of the Move Objects to New Layer command see Chapter 3.4.6. Move Objects to New Layer. 

Layer walk 

This tool displays objects on layers that you select in the Layer Walk dialog. This tool is very helpful to check which object 
lies on which layer. 

� For a detailed description of the Layerwalk command see Chapter 3.4.7. Layer walk tool. 

Change to current Layer 

This command moves objects to the current layer. 

Activate the Layer of selection 

This command changes the current layer by selecting an object as reference. It will use the object’s layer as current layer. 

1.58.6. Lock architectural object in 3D 

With this command you can lock 3D models to architectural objects (the architectural objects in the Building tool from wall 
to object) independent of their 2D symbol. This way you can create detailed drawings, such as decorated walls, without 
displaying their details on the 2D drawing. Once you lock an architectural object, you may make any modification in the 2D 
drawing; its 3D view will not be altered. 
 

� We suggest that you only decorate walls and use the Lock in 3D mode when you have completed the construction of 

the building structure. In this case, you will not have to make frequent modifications. 
 
The commands are the following: 
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Lock shape 

Example: 

You can create a wall with its foundation without displaying the foundation in the 2D view. You can see how this command 
works in the following example: 
 

• Draw a wall with its foundation. To create a foundation draw a wall with the following parameters for 
example: 
wall thickness: 0.05 m, 

height: 0.6 m, 

wall material: stone-2 
 

• Select the Lock architectural object in 

3D - Lock shape command. Choose an 
architectural object (the wall in the 
model), to which you want to attach 
additional objects and whose 3D model 
you wish to lock. 

• Select the additional objects for locking 
their 3D model. 
(Select foundation.) 
Enter Completes selection.  

 

� Once you locked an architectural object’s 3D model, the 3D fixed option is activated in the properties dialog box of the 

object. 
 

The 3D view of the wall with foundation is 
now locked. From this time on you can delete 
the 2D view of the wall, its 3D view will not 
change. 
For example, if you place a window on the 
wall, the window will only be displayed on the 
2D symbol of the wall. In the 3D view the 
window will only be indicated by the 
wireframe model, as the 3D model of the wall 
has been locked. 

 
 

 

� If you wish to display the new shape of the wall (with the window), you have to use the Lock architectural object in 3D - 

Unlock commands under 3D menu - Architectural object ->3D solid. 

Unlock 

With this command you can unlock the selected objects, and work with them as ordinary architectural objects. 
 

• Select an architectural object the 3D view of which you want to unlock. 
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� The 3D fixed option is deactivated in the Properties dialog box. 

 

In this case select the wall to unlock its 
solid 3D view. The program now 
displays the wall with the inserted 
window. 
 

 
 
We suggest you that before unlocking use the 3D menu – Arch. object -> 3D solid command, thus the 3D model of the 
foundation will be saved. 
Repeat the Lock shape command for the wall and the foundation to save the new layout of the wall. (If you regenerate the 
wall without using this command, you will lose the foundation.) 

1.58.7. Substitute material 

With the Modify - Substitute material command you change the selected texture of each object of the drawing to the one 
you specify. This concerns all architectural objects of a drawing and involves all floors. 
 
When you activate the command the Material dialog box appears. 

• Select the material category you wish to replace. Click Select. 

• In the dialog box then displayed select the new material. Click Select. 

Substitute materials using the Design center 

By using the Design center you can modify the material of selected objects in an instant without activating the Properties 
dialog box and browsing in the Select by object dialog box. 
Using the Design center you can modify the material of objects on the floor plan and in the 3D view in different ways. 

Modifying materials on the floor plan 

! You can use this command for all architectural objects except doors and windows. 
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You find the materials 
applied in the program 
arranged in classes and 
categories in the Materials 
directory of the Design 
center. 
 

• Open the desired 
category, e.g. Program 

Materials class - 

Colours. The program 
displays all materials 
within that category. 

 

• Click the name/picture of the texture with the left mouse button. 

• While holding the mouse button, drag the texture on the object you wish to modify. 

• Once the texture is on the object, release the mouse button. 

 

 
• In the menu then displayed 

choose the option you wish. 
 

 

Modifying materials in 3D 

The command changes the texture selected with a plane of the model to the material you choose in the Design center. 
 

• Select the desired material in the appropriate material category, and then click its name/picture with the left 
mouse button. 

• While holding the mouse button grab the texture over the plane to which you assigned the texture you wish 
to modify. 

• Click the requested plane. The program then selects the plane. 
 
The program automatically opens a menu and you can choose an option. 
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1.58.8. Explode by selection 

You can explode compound objects (such as text, dimension, hatch, groups and architectural objects) into their 
components. 
 
Explode what object into what objects 
Text Line, elliptical arc, spline, hatch 
Dimension Line, text 
Hatch Line 
Group Objects it contains 
Architectural objects Graphical components or subgroups 

 
You can explode objects in the following way: 

•  

• Select the compound objects you wish to explode. 

• Choose the Modify menu - Explode by selection command. 

• Select the next object, or 

• Enter Completes the command. 

Option: 

Text Explodes the selected multiline texts into multiple single-
line texts. 

1.58.9. Explode  

• In the displayed dialog box click on a class to explode all objects in the selected class. 

• Click OK. 

•  
The program explodes the selected objects. 
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1.59. Specifying profile 

When applying more commands to 
create or modify objects it is necessary to 
edit profile. 
For example, profiles are used when 
specifying the contour to be cut into the 
wall or slab, when defining the slab, roof 
with a contour or when creating a terrain. 
 

� When a command is waiting for the 
specifying a profile, the Profile 
definitions tool appears the commands 
of which can be used for specifying the 
profile. To close the Profile definitions 
tool, use the first icon, the Enter icon. 

 

 

1.59.1. Polygon 

Creates a polygon that can be used as a profile. 
 

• Specify the polygon as a chain of lines and arcs. 
Enter Closes the polygon. 

Options: 

Arc The next object of the polyline is an arc.  

Select an object The next object of the polyline is an existing object.  

Smooth The next object of the polyline is tangential to the 
previous object. 

1.59.2. Rectangle HV 

Creates a rectangle that can be used as a profile. The sides of the rectangle are horizontal and vertical.  
 

• Specify the first corner of the rectangle.  

Specify the opposite corner of the rectangle. 

1.59.3. Rectangle 

Creates a rectangle that can be used as a profile. 
 

• Specify the first corner of the rectangle. 

• Specify another point of the rectangle’s base line, or 

• Specify the corner opposite to the first corner of the rectangle. 

Options: 

Width… Creates the rectangle with a specified width. 

Define 

rectangle X/y 

size… 

Creates the rectangle with a specified width and 
height  
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� See the description of the Polyline drawing commands -  General rectangle in Chapter 11.3.2.4. 

1.59.4. Circle 

Creates a circle that can be used as a profile. 
 

• Specify the centre point of the circle, or 
use the Devise 3 points, Axis keywords. 

1.59.5. Circle 3P 

This command creates a circle from 3 points. 
• Enter the first and second point of the circumference of the circle. 
• These two points define the arc and can determine the third one. 

1.59.6. Point of profile 

This command makes a profile from the closed polyline created in the active window. Just click inside the polyline and the 
program will search for the closed chain. 
 

• Specify an internal point of the profile. 

1.59.7. Chain one by one 

This command creates a profile from a closed polyline by selecting its segments one by one. 
 

• Select the sides of the profile one by one. 
Enter Ends the selection. 

1.59.8. Select item 

It applies the contour of the closed object or the hatching in the drawing 

1.59.9. Editable profile 

When modifying architectural objects, 
you may need to edit the geometry of 
a formerly created profile. 
 

� When you use a profile editing 
command, in the Toolbar the Edit 
profile tool pops up whose commands 
can be applied for editing the profile. 
Use the first, Enter icon to close the 
Edit profile tool. 
 

 

Lengthen a part 

The program recognizes the direction of the selected section of the contour line. By entering the value of modification 
(relative length) you increase or decrease the length of the selected section by that value. 

Add 

Inserts a new node between the nodes closest to where you click in the contour. 
 

• Select the section of the profile where you wish to insert the new node. 

• Define the place of the new node in the drawing. 

• You can repeat the command, or 
Enter Completes the insert node command. 
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Move 

Moves the selected profile.  
 

• Select the profile you wish to move. 

• Define the new place of the profile.  

• You can repeat the command by selecting a new profile, or 
Enter Completes the move command. 

Rotate 

With the  Rotate icon you can rotate the selected objects. 

� For a detailed description of the Rotate command see Chapter 8.1.9. Rotate. 

Mirror 

Places or copies objects by applying mirror transformation. 

� For a detailed description of the Mirror command see Chapter 8.1.11. Mirror. 

Scale 

Enlarges or multiplies the objects. 

� For a detailed description of the Scale command see Chapter 8.1.12. Scale. 

Insert profile in drawing 

The requested or modified profile can be placed on the drawing with this command. 

1.59.10. Select from list 

Profiles are grouped into different categories of the profile directory. 
With this command you can choose a predefined profile from the appropriate category of the profile directory. 
 

 
 

• Choose the desired profile category and type from the list; the shape of the selected profile and the list of its 
geometrical characteristics appear. You can modify the values; after modification press Redraw to update 
the drawing area of the dialog box. 

• To place, activate the desired reference point.  
The eligible reference points are shown by small squares in the drawing area that can be activated by 
clicking. The active reference point is red while the others are green.  

• Use the Mirror and Rotate buttons for the optimal setting of the profile. 
OK Closes the dialog box. 
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The profile directory can be extended with closed and open profiles. To do so, use the Building menu – Accessories – 
Define closed profile or Define open profile instructions.  

� For the description see Chapter 9.11.5 on Creating profiles. 

1.59.11. Last value 

The selected profile is the last defined profile (if any).  
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9. Site design 

Introduction 

Site design in ARCHLine.XP helps you to design the overall environment around your architectural project.  You can 
model the terrain model together with its components as plateau (building pads), streets, sidewalks, parking lots and mass 
studies. 

1.60. Google Maps integration 

When you create a project, specify the project location on the globe using the nearest major city or the latitude and 
longitude. This project-wide setting is useful for generating location-specific shadows for views that use them, such as 
solar studies, walkthroughs, and rendered images.  
 
You can locate your project exactly on the planet using Latitude and Longitude or GPS coordinates. The project location is 
represented by a place mark on the Google Maps. The GPS coordinates are automatically saved into the ARCHLine.XP 
project and viewable each time you start Google Maps. 
 

� This command requires internet connection. 

 

1.60.1. Project location by Google Maps 

The Project Location dialog is available from: 
1. Building > Google Maps Integration > Project Location 
2. File > Project Information dialog > Project Location 
 
You can then quickly go to the marked location at any time by clicking on the Project location by Google Maps button. 
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To change the location chose one of the next steps: 
1. Click Search box and type your address. 
2. Click Project’s Location to update your location. 
 

1.60.2. Project Location by Predefined City List 

Alternatively you can choose a predefined city to enter Project Location.  
Select your city from the Location list in the Location and Sun Settings dialog box. 
Choosing a city will automatically fill out the Latitude, Longitude fields. 
 

� You can add new cities to the cities list with Add button. 

 
It is recommended to use the Project location by Google Maps because it provides maximum accuracy, instead of 
choosing from predefined city list. 
 

1.60.3. Exporting your data into Google Earth 

Use the Data Export feature to import your custom geographic data into Google Earth and view it as you would any of the 
layers in the Layers panel. When you use this import feature, you can import two basic kinds of data: 
 

• Vector Data 

Vector data consists of 3D model that you define in ARCHLine.XP. Once you import vector data into the Google Earth 
application, you can change its appearance or content in the same way you would when editing place marks and folders. 
In addition, you can use Style Templates to format your data in visually meaningful ways. 

• Imagery Data 

You can import imagery data such the 2D view overlay and have the imagery properly projected over the base imagery in 
the 3D viewer. For this to work, the imagery file itself must be exported from ARCHLine.XP in the proper KMZ file. Imagery 
of this type is referred to as 'GIS imagery'. 

https://support.google.com/earth/answer/148102?hl=en&ref_topic=2376768 
 
Save the imagery overlay as a KMZ file 
You can save the 2D view overlay as a KMZ file to your computer's hard drive or other accessible file location. After that, 
you can open this KMZ file in Google Earth. 
 
Opening Imagery in Google Earth 
Use any one of the methods below to open the imagery file in Google Earth: 
• Select Open from the 'File' menu. 
• Drag the desired file from an explorer window and drop it over the viewer. 
Google Earth then attempts to project the image to a WGS84 coordinate system. From this, it creates an overlay with the 
image converted to PNG format. 
 
Move the imported imagery to remain in your 'My Places' folder 
 
If you move the imagery overlay from Temporary Places to the 'My Places' folder, any changes you make to it are 
automatically saved and viewable each time you start Google Earth. 
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1.61. Terrain 

Introduction 

You can define the terrain in several ways: with points, terrain contours, or by loading data from files. You have to 
regenerate the 3D model of the terrain upon each creation and modification. 
 
You may add plateaus, roads and zones, or install building models and the constructed building on the terrain model. 
ARCHLine.XP® automatically calculates the amount of earthworks needed. 
 

! You have to define the terrain elevation values in meter all cases, independent that, which model unit is given. 

1.61.1. Terrain properties 

Before you create a terrain, specify its properties. 

You can access these properties by right-clicking the Terrain tool -  Properties icon, or by selecting the Building 
menu - Properties - Terrain command. 
Any changes you make to terrain properties in the appearing dialog box will be valid for all terrains created afterwards. 

Visualization properties 

As all other objects in ARCHLine.XP® terrain has colour, layer, line type, and line width and priority properties. 
 

� See: 
� the description of General properties in Chapter 3.2.1 Specifying general properties, 
� the description of Sets in Chapter 3.2.3. Using sets of properties. 
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Terrain general properties 

� Arc resolution  – This value specifies the resolution at which the program displays arcs and splines that constitute the 
contours of the terrain when creating the 3D model. 

� Base height  – Specifies the base height of the terrain. 
� Terrain material  – Specifies the material of the terrain. 
� Road material  – Specifies the material of the road on the terrain. 
� Plateau material  – Specifies the material of the plateau on the terrain. Also, if you create a new zone, this will be the 

default material if other material is not selected. 

Example: 
The following schematic example 
shows how this function operates:  
Suppose the 2D drawing of the 
following terrain is available. The 
side length of the rectangle is 10 m, 
its terrain height is 0 m, the 
diameter of the circle is 5 m, its 
terrain height is 3 m: 
 
Now, if you set Arc resolution = 8, 
you get the following top view and 
axonometric view of the 3D model: 

 

 

 

 
 
You can see that the program divided the entire arc into 8 segments in the 3D model. 

Height information 
� Height text set – Specifies the text set used to display the elevation values of terrain points. 
� Numbers text set – Specifies the text set used to display the numbering of terrain points. 
� Height text position – Specifies the position of the displayed elevation value relative to the terrain point. 
� Numbers text position – Specifies the position of the displayed numbering of the terrain point relative to the terrain point. 

 
Different settings can be stored in sets. 
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1.61.2. Visibility on different floors 

It is possible to define the visibility of terrain on the floor plan for each floor. This setting is available in the Terrain 
dialog by clicking Modify… in the shortcut menu. 
 

 
 
By switching the All floors checkbox on, terrain will be represented on each floor. By switching this checkbox off, 
you can use the ellipsis button to specify the visibility of terrain on each floor in the appearing dialog. 

 
�  

Use CTRL/SHIFT keys and mouse click for floor selecting/deselecting. 
 
When you open a file for print layout and click Floor, the status of Terrain will be visible in the floor plan checkbox 
defines the visibility of terrain on the plot layout. 
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Terrain materials 

In the Terrain properties dialog it is possible to define two materials for the terrain, one for the terrain surface and 
another one for the terrain body. 
 

 
 

 

1.61.3. 3D representation 

The terrain properties include its 3D representation. 
You can define the way the program represents the terrain in 3D. These settings apply to all terrains. The options are the 
following: 
 

� Triangle, 
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� Contours, 
� Grid. 

 

 
 
The commands can be accessed from Toolbox menu and Terrain shortcut menu 

Settings 

You can specify the 3D representation of the model, and enter values in the appearing dialog box. 
 

 
 

 
 

This representation cuts up the terrain into triangles. The model 
is created this way. 

 
 

The terrain is represented by contours. 
Height: Define the starting height of the terrain contours. 
Height difference: Define the height difference between the 
contours. 

 
 

The terrain is represented by a grid, i.e. it is divided by 
horizontal and vertical lines. 
Delta X / Y: Define the distance between the lines. 

 
The 3D model of the terrain acquires the selected representation when, you build again the 3D model. 
 
On the other hand, when you choose the following commands the program automatically applies the selected 
representation to the 3D model. Use the parameters specified in the Settings dialog box. 
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Triangle 

The program automatically displays 
the 3D model of the terrain by 
triangles. 
 

 

Contours 

The program displays the terrain by 
contours in the 3D model. 

 

 

Grid 

The program displays the terrain 
by a grid in the 3D model. 

 

1.61.4. Opening and creating terrains 

With the following commands, you can create a terrain by different methods: 
 

� by loading data from files (TXT, XLS, DXF, DWG) 
� with points 
� with contours 

�  

1.61.5. Terrain from file 

For the creation of terrains it is possible to load terrain data from AutoCAD® dxf/dwg files or files including terrain point’s 
data. These terrain points’ data are mostly come from txt and xls files, or databases. Terrain point’s data from geodetic 
survey are often stored in files with dat extension. In case of terrain points data, being in any file format, terrain points are 
defined by their X, Y and Z coordinates. Besides, input files can include the numbering of terrain points and notes, too. 
ARCHLine.XP® gives the possibility to load these files in. 
 

• Click  Terrain  Terrain from file command to start the Terrain Import Wizard dialog. 

• Click Next on the welcome page. 

• First you have to choose a file including terrain data. Define the file format you wish to open, and then 
choose the terrain file to load in.  
 

 
 
Depending on the terrain file format you import, the loading process can be different. 

 Loading terrain from DXF, DWG file 

In case of opening a dxf or dwg file the program quits from the Terrain Import Wizard dialog and starts to load the terrain. 
 

• Optionally you can display the elevation values and the numbering of terrain points. 
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• Specify the required DXF/DWG import options. The terrain will be loaded. 
 

� To create the 3D model of the loaded terrain, choose the  Build 3D model icon from the Status line. 

 

 

 

 Loading terrain from points data 

Terrain point’s data can be loaded from Text files (*.txt or *.dat), 
 
Points data in any file format should include the surveyed points defined by their X, Y and Z coordinates.  
 
TXT file format includes semicolon separated columns for the X, Y and Z coordinates of the terrain points and another 
column for the numbering of terrain points.  
 
No;X;Y;Z; 
1;98;20;20.1; 
2;64.5;49.5;8.2; 
3;45.7;50;5.1; 
 
DAT file format includes comma separated columns for the X, Y and Z coordinates of the terrain points and another 
column for the numbering of terrain points.  
 
1,98,20,20.1, 
2,64.5,49.5,8.2, 
3,45.7,50,5.1, 
 

Load a terrain file 

• Choose one file that includes the terrain data. The program tries to recognize the data source type and 
displays it under the file selection: 

 Create terrain by points or contours 

With this command you can build up a new terrain with points or contours, or you can add new contours to existing 
terrains. 
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Creating a new terrain by points 

• Use the POPMENU keyword and select the Point command in the Profile definition menu. 

• Locate the point in the drawing and define its height. 

• You can query the height from the design. Click on the Height value from draw button and click on the 
existing object. 

 

 
 

• Locate the other points in the drawing and define their height. 
Enter Ends definition of points. 
Enter Ends the construction of the terrain. 

•  

� If you designated the terrain points in a raster grid, we suggest that before starting the command you should define grid 

spacing and turn on grid snap. When creating the terrain, you can quickly assign height by selecting the points in the grid 
one by one. 

Creating a new terrain by contours 

Terrain height remains the same along a contour. You can use this method in the case of a contour map or a key plan. 
 

• Use the POPMENU keyword and choose from the Profile definition menu (any but the point command). 

� For a description of the Profile definition, see Chapter 8.9. Specifying profile.  
 

• Draw a contour and define its height. 

• You can query the height from the design too, if you click on the existing object. 

• Specify all contours and define their height. 

• Enter Ends definition of contours. 

• Enter Ends the construction of the terrain. 
 

 
 

� You can combine the two methods. 

Example: 
If you have a contour map on paper, to create the terrain model the quickest possible way, use the following method: 
 

• Scan the map and save it as an image file. 

• Load the image file by using the Drafting menu - Raster image command. 
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• You can calibrate the overlay so that it is fit to scale: Adds–on menu – Raster image Calibration –Calibrate 
raster - new. 

• Use the Adds–on menu - Raster image Calibration - Raster to vector command. 

• Turn off the overlay. 
 

Now you have the vector image of the contour map. 
 

• Click  Create by point  

• Choose the By chain command (Open or Closed) in the Profile definition menu. 

• Click on the contours one after another while defining their height. 
 
The program recognizes open or closed chains, assigns their height and creates the terrain model. 

Adding a new point or contour to the terrain 

 
 

 
 

• Select the Add Points command and select the terrain to which you wish to add a new contour. 

• Specify the new point/contour by using the POPMENU keyword in the command line. 

• Define the height of the point/contour. 

• Insert additional point/contours, or 

• Enter Ends the command. 

 Terrain import from Google Earth 

 With ARCHLine.XP it is possible to import terrain from Google Earth. 
 

� For using of this function you need to have Google Earth 4 or newer version installed on your computer. It can be 

downloaded and installed for free from http://earth.google.com/. Also, for Google Earth you need a live internet 
connection. 
 
Terrain import from Google Earth in ARCHLine.XP® works as follows: 
 

• Click Building menu – Terrain – Import from Google Earth command. ARCHLine.XP® starts Google Earth 
application. Before importing a small dialog appears with some instructions. Click Yes button to start the 
import or click No to cancel it. 
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• Navigate to the desired position in Google Earth. Use mouse scroll for zooming, left mouse button for 
panning the map or use the search field to look for an exact address. You can find further information about 
using Google Earth in the help or on http://earth.google.com/intl/hu/userguide/v5/ web page. 

• Wait until the completion of downloading the whole terrain part. (Downloading of a terrain part is 
completed when the small ring icon on the bottom-right corner of Google Earth window doesn’t spin.)  

 
• Only maps in top view can be processed correctly in ARCHLine.XP®. In case of tilted map view please use the 

SHIFT+UP arrow key combination to achieve the correct view. 

• Before importing, set the desired terrain resolution in the appearing message box (low: 24x24, medium: 

32x32, high: 64x64 terrain points) and then click OK for starting the import. Please wait until ARCHLine.XP 
has finished downloading the map and creating of terrain. 

•  

•  
 

 
Downloaded map on the 
floorplan 

in 3D 
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The downloaded terrain appears on the floor plan and in 3D and then it works like other terrains. 
 

� ARCHLine.XP® places exactly the same image what you see in Google Earth on the surface of the terrain. If you find 

disturbing navigation buttons or texts on the surface of the terrain, you can eliminate those by switches in the View menu 
of Google Earth. 
 

 

1.61.6. Creating and modifying plateaus and roads 

You can map plateaus (building sites) and roads on the finished terrain. 
You can obtain information on the earthworks necessary for their creation in the Add-On menu – Quantity Take-Off-
Building calculation dialog box. 
 
In the following example we have created a plateau (building site) and a road in the terrain. The list shows the volume to 
be backfilled and excavated for the building site. We can define the width of the working room and the plateau inclination 
angle as well. 
The Cut volume value is the volume removed (where the new surface is lower than the original surface). 
The Fill volume value is the volume added (where the new surface is higher than the original surface). 
The Width of the working room value is the distance later restored when the building is ready. 
 

  
 

The plateau is a horizontal plane, but you can modify its inclination. 
The commands can be accessed from the Terrain tool and Terrain shortcut menu: 
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 Create and delete plateau 

You can create a plateau or delete the selected plateau. The program cuts the required parts of the terrain, or completes 
and fills in the missing areas according to plateau height. 

 Creating a plateau 

• Select the terrain. 

• Specify the contour of the plateau by using the Profile definition tool in Toolbox. 

� For a description of the Profile definition, see Chapter 8.9. Specifying profile.  

 

• Define the height of the plateau. 

• Specify the angle of the slope (relative to vertical). 
 

  
 

 

 Deleting a plateau 

• Select the terrain. 

• Select the contour of the plateau you want to delete. 
 
The program restores the original terrain by deleting the selected plateau. 

Modifying plateau height 

You can modify plateau height with the  Modify terrain heights command. 

 Modify plateau inclination  

 Modify slop on all side 

The command modifies the angle of the slope (relative to vertical). 
 

• Select the slope the angle of which you want to modify by clicking its contour line. 

• Enter the new value of inclination in the dialog box. Ok. 

 Modify slop on this side 

The command modifies the angle of the slope (relative to vertical) one by one. 
 

• Select the slope the angle of which you want to modify by clicking its contour line. 

• Enter the new value of inclination in the dialog box. Ok. 

Sloped plateau for existing plane plateau 

The plateau by default is plane, but you can modify its inclination using the Shortcut menu commands:  
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Slant base by 3 points 
Give three points of the terrain and define its height. 

Slant base by reference lines. 
Define the reference line of the plateau and the inclination angle. 

 Modify plateau contour 

Using this command you can modify the contour of the horizontal plateau. 
 

• Select the plateau you wish to modify. 

• Modify the contour of the plateau with the commands of the Edit Profile tool displayed in the Toolbox (e.g. 
move nodes, round off). 

• Enter Ends the command. 
 

� See the description of the Edit Profile tool in Chapter 8.9.9 Editable profile. 

 Plateau - Work area width 

In the Terrain shortcut menu you can define the work area. 
The work area indicates the wide band in the plateau-defined trench that has to be backfilled after the building has been 
constructed. 
 

 
 

• Right-click the plateau, which originally you added to calculate excavation, and select Plateau - Work area 

width from the shortcut menu. 

• Define the work area width (band), which has to be backfilled after construction from the edge of the 
plateau towards the inside. 
 
The program calculates the volume to be backfilled accordingly. You can query this data in the Add - On menu – Quantity 
Take – Off - Buildings calculation dialog box. It has no 3D representation. 

Example 

For the construction of the building indicated above, the following quantitative data are available before defining the work 
area width of the plateau: 
 

 
 
We see that the width of the area to be backfilled and its volume are zero for the moment. Now if we define a work area 
width of 2 m, the parameters will be the following: 
 

 
 
As we can see, the program displays the specified work area width (width of area to be backfilled) and the volume of 
backfilling for the building site (plateau) in question. 
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 Road 

With this command you can create or delete the trace of a road. 
The program cuts the required parts of the terrain, or completes and fills in the missing areas according to road height. 

Creating a road 

• Select the terrain. 

• Specify the points of the road. Doing so you define the axis of the road.  
Enter Ends definition of the road. 

• Specify road width. 

• One by one assign the height to the specified points of the road. 

Option: 

SHIFT You can define the road (axis) by shifting it by a given 
distance from the trace.  

 

  

Deleting a road 

• Select the terrain. 

• Choose the trace of the road you want to delete. 
 
The program restores the original terrain by deleting the selected road. 

Modifying road height 

You can modify road height with the  Modify terrain heights command. 

1.61.7. Vertical shift of road/discontinuity line 

When setting node height of a road/discontinuity line, modification of the height of all points can be executed by 
switching the Move all the nodes option on. 
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In that case all points are shifted vertically by the relative change of height of the selected road node. 

1.61.8. Profile section definition of road 

Section profile can be added to roads by the Add section profile command.  
 

 
 
Using this command you can temporarily place the section profile on the screen and then you can use the Edit 

profile commands to modify road section. The road cuts out the surrounding terrain according to the section 
profile. 
 

 
 
 
Six nodes appear by default as an H letter. The upper and lower nodes define the slant angle above and below the 
road surface, respectively. You can only move these nodes. The line between the middle two nodes defines the 
profile of the road top surface. Here you can add/delete nodes. 
 

 

1.61.9. Road node height edition on layout 

Using the Edit node height on the layout command you can place the layout of the vertical section of the road on 
the screen and then you can use the Edit profile commands to modify nodes.  
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1.61.10. Terrain zone 

Zones are special areas inside a terrain by which you can gain information about bigger areas. In addition to this you can 
use zones to modify a terrain in a similar way as you do it with the plateaus. 

Create zone  
� There are different possibilities to define a zone; by polygon, rectangle or point inside a closed polygon, etc. 

 

• Select a terrain to an area of which you want to assign a material. 

• Specify the profile of the new area by using the Profile definition tool in the Toolbox. 

� For a description of the Profile definition, see Chapter 8.9. Specifying profile.  
 

 
 

• Define the name of the zone and assign a material 

• Choose the zone type: 

Fit to terrain 

On the selected area the zone fits to the height of the terrain. Only its material representation can be different from the 
terrain. 

Base level by 3 points 

Slant zone can be created. Fits the terrain points to the plane defined by three points. 

Base height 

On the area of the zone elevates the terrain points to the specified height.  
Ok close the dialog. 
 
The difference between plateau and zone is that a zone fits the terrain points to the specified heights but no operation is 
performed on the solid. 
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The following example shows the difference between zone and terrain when a plain surface is created on the original 
terrain: 

Original terrain: 

 

Terrain with plateau 

 

Terrain with Zone 

  

Modify zone 

From the shortcut menu you can choose the following commands: 
 

 
 
A zone can be modified similarly to the plateau. 
New zone can be added to a zone. 
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1.61.11. Terrain change elevation for all terrain points 

Pop Up Menu: Terrain > Raise/lower terrain height 
 
The command helps to raise or lower all terrain points except the Zone and Plateau in one step. 

 

 
 

 
 
The result looks similar like that: 
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1.61.12. Terrain 3D commands 

Zone, plateau, road and discontinuity line definition and modification is available in 3D. When you use a terrain command 
in 3D, there is no automatic switch to the floor plan. 
Modify and Select shortcut menu commands are available in 3D window, too. Change height marker command is 
available for changing the height of each terrain point in 2D/3D windows. 

 

 
 
Terrain shortcut commands are rearranged: 
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Terrain subtype recognition 

When going over the terrain with the mouse cursor, terrain subtypes (road, plateau, and zone and discontinuity line) are 
recognized automatically in 2D/3D windows. Depending on the recognized terrain subtype, the appearing shortcut menu 
includes the appropriate commands. 

 
 

 
 

 
 

 

Terrain zone 

When creating a zone, instead of adding new points to the terrain inside the contour of the zone, zone contour is added to 
the terrain as discontinuity line. Compared to the previous versions, this enables a better zone representation, as 
especially at the border of the zone. 
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Previous zone representation: 
 

  
New zone representation: 
 

 

1.61.13. Modify terrain 

Clicking on the terrain the Property manager visualizes the terrain property or clicking on the terrain Shortcut menu – 
Property command the Terrain properties dialog box appears. 
You can modify the terrain property.  
 
You can access additional modifying commands: 
 

� In the  Terrain Tool: 
 

 
 

 

 
� In the Shortcut menu: 

 

 

 Modify terrain heights 

With this command you can modify: 
 

� a point of the terrain, 
� a horizontal plateau, or 
� road height. 

 

• Select the object of the terrain the height of which you wish to modify. 

• Define the new height in the dialog box. Ok. 
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• Select further objects, or 

• Enter Ends the command. 

 Terrain resolution in 3D 

You can modify terrain resolution. The smaller value you define, the more detailed the resolution will be. 
 

• Select a terrain to modify its resolution. 

• Specify the new value (>= 1). 
 
If the number defined as the value of resolution is n, the program will cover the terrain with cubes having edges the length 
of which equals n. Points of the terrain falling within the same cube are merged into one point and their height is calculated 
by means of weighting. The program reconstructs the model from the points thus defined. 
 

 
Original terrain The same terrain at a higher 

resolution 

 Automatic contours 

For better understanding of terrains with contour-lines, certain contour-lines should be outlined. 
For example, when the step height between the contour-lines is 1 m, you might want to display every fifth contour-lines by 
red colour, and every tenth contour-lines by yellow colour. 
In ARCHLine.XP®  it is possible to solve the above mentioned task, namely the program can display certain contour-lines, 
depending on the height differences, with different colour, line width and line type. 

• Select the  Automatic contours command. You can select this command when the 3D model of the 
terrain exists already. 

 
The command adds new contour-lines or modifies the properties of the existing ones, depending on the specified step 
heights. This results in a more precise display on the floor plan, without any effect on the 3D model. 
This command is useful when the terrain is defined by terrain points. In that case there are no contour-lines on the floor 
plan. With this command you can add contour-lines to such terrains. 
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In the appearing dialog you can specify: 

 
� the step heights and 
� the general properties: colour, line width, line type and layer of the contour-lines. 

 
If you place the contour-lines on different layers, you will be able to hide or show certain contour-lines. 
The Step parameter defines the height difference between the adjacent contour-lines. Each table row represents a 
contour-line. 
The height parameter of the default contour-line is equal to the step parameter; therefore you cannot enter its height 
parameter in the table. You can set its general properties. 
 

• Click Add button to add a new contour-line to the table. 

• Set the contour line properties. 

• Only the multiple of step value is accepted here as height parameter. 

• Click Delete button to delete an unnecessary contour-line. 

• You can delete all contour-line definitions, except with the default contour-line, by clicking Delete All button. 

•  
The contour lines settings are saved into the Support/TerrLines.xml file so next time the program will remember to the 
previously defined parameters. 
 

� Changing the value of step will change the height values of all contour-lines proportionally, too. 

 

 

 Insert sub-terrain 

The command inserts the selected sub-terrain into the original terrain. The result depends on the following operations: 
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The sub-terrain can be a road or plateau, or even a fully designed garden. 
The structure is modelled by a terrain each height point of which - as is the case with the terrain - must be specified. So 
practically speaking, the sub-terrain is a pre-constructed terrain which you insert into the original terrain by using this 
command. 
 

The sub-terrain is not identical to the road and the plateau you create with the  Road and  Plateau icons. Sub-
terrains are a lot more sophisticated objects: 
When you apply the Road function, the shape of the road will be fixed. 
When you apply the Plateau icon, the foundation of the building will be horizontal. If you create a terrain as a sub-terrain 
and insert it into the original terrain, you obtain a much more complex configuration. You can freely alter its contour and it 
can also have an inclined surface. 
 

• Select the terrain you wish to use as a part of another terrain. 

• Specify the origin of the selected terrain. 

• Select the target terrain. 

• Insert the sub-terrain into the target terrain by its origin. 

• Enter Ends the command. 
 

 
 

 

 Discontinuity lines 

You can define edges by a chain of lines specifying the height of points in the chain. The program automatically cuts up 
the terrain into smaller triangles along the created discontinuity line. The inserted discontinuity lines gain significance in 
the case of e.g. roads, clefts, and pipes. 
 

• Select the terrain in which you wish to draw a discontinuity line. 

• Specify the first node of the chain of lines that defines the discontinuity line. 

• Define the other nodes, then 

• Enter Ends definition of the chain of lines. 

• Define the height of the discontinuity line. 

• Select the nodes of the discontinuity line to which you want to assign different heights and specify their 
heights. Enter. 

• Define another discontinuity line in the terrain, or 

• Enter Ends the command. 
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 Area with other material 

You may select an area of any terrain by contour and assign its material. The areas appear in accordance with their 
assigned material in the 3D model of the terrain. 
So for example you can display lakes, rivers, and woods in the terrain. 
 

• Use the Terrain Tool – Zone command 

 Terrain hatch 

With this command you can display the terrain in colours on the floor plan. The colours indicate different heights, or 
inclinations. 
 

• Select the terrain on the floor plan to which you want to assign colour hatches. 

• The Terrain properties dialog box pops up. 
 

 

Different heights 

If the Colour by inclination angle option is turned off, the colours indicate the different heights of the terrain. You can set 
the following properties: 
 

• with Delta X and Y the properties of the hatch grid in the x and y direction, 

• Division, with which you set the height spacing of the grid. 

• the colour of terrain hatch. The colours indicate the areas of the terrain that have different heights. 
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Different inclinations 

If the Colour by inclination angle option is turned on, the colours indicate the areas of the terrain that have different 
inclinations. 

Settings 

If you click the Settings button, in another dialog box you can assign various colours to areas of the terrain that have 
different inclinations. 
 

 

 Modify base height 

With this command you can modify the base height of the terrain. This change has no effect on the contour heights of the 
terrain. 
 

• Select the terrain you wish to modify. 

• Define the new value of the terrain base height in the dialog box. Ok. 
 

 
Original value -30 m 

 Modify material 

With the Material browser command you can modify the material of the selected terrain object (plateau, road). 
 

• Select the terrain object the material of which you want to modify. 
In the Material dialog box then displayed choose the new material. Ok. 
Enter Exits the command. 

 Elevation information 

With commands in the submenu you can display or hide terrain information on the drawing. 

 Query height 

You can query the height of a given point of the terrain and insert its value in the drawing. 
 

• Select the terrain the height of which you wish to query at a given point. 

• Click on the point to query its height. 
OK Insert the value of the height in the drawing, or 
Cancel Do not insert the value of the height, exit the command. 
 

� Terrain height of a terrain point is displayed in the tooltip when you go over the terrain point with your mouse. 
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� Display elevations – Displays the elevation values of the terrain points. 
� Hide elevations – Hides the elevation values of the terrain points. 
� Display numbers – Display the numbering of terrain points. 
� Hide numbers – Hides the numbering of terrain points. 
� Text size enlargement – Increases the font size of the displayed information. 
� Text size reduction – Decreases the font size of the displayed terrain information. 

 Information 

You can gain information about roads, plateaus, zones of an existing terrain in a dialog in tables. 
 
I 
 
In the title of the dialog the ID of the terrain is displayed in bracket. In the top right part of the dialog you can read general 
information about the terrain. You can use the Road, Plato and Zone tabs to switch between tables with information about 
the appropriate parts of the terrain. 
 
With the Add Parameter and Delete Parameter buttons you can add/delete columns to the tables so you can add your own 
information (for example notes) to each table row. 
With the Save to Excel file button you can save the whole list in an XLS file, which can be viewed right after exporting the 
file if you use the View output file option.  
 
Close the dialog with the OK button after you finished with the modifications 

 Cutting perimeter 

With this command you can erase unneeded parts of the terrain. If the form of the terrain on the floor plan is concave, as 
default the program displays the terrain in its entire convex form in 3D. 
You can specify the contour by which you cut the 3D model, so that the unnecessary parts created by the bordering 
concave parts are erased. 
 

• Right-click the terrain on the floor plan. In the appearing shortcut menu select the Cut perimeter command. 
Then the contour of the terrain appears:  

 



332 9. Site design 

Manual 

 
 
Using the Edit Profile tool you can quickly modify the contour of the terrain, so for example 

• With the  Add node icon you can select a segment of the contour profile and insert a new node.  
Doing so, you can adjust the convex form of the terrain to its concave form on the floor plan. 

 

 
 
If you regenerate the terrain after modification, it will be displayed in a concave form also in the 3D model. 
 

 

� See the description of the Edit Profile tool in Chapter 8.9.9 Editable profile. 
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1.61.14. Terrain consignation 

Using the Add-On menu Quantity Take-Off – Terrain consignation command you can save terrain data in Excel (.xls or 
xlsx) file.  Terrain, Road and Plateau data can be found on different worksheets. 
ARCHLine.xP reports cut and fill volumes related to the terrain. It helps to define the costs of landscape modification 
during site development. 

1.62. Conceptual building model  

Introduction 

You can start an aRCHLine.XP project by designing a conceptual model. 

 
In ARCHLine.XP® you can determine the biggest floor space available for the building, on the base of this the biggest 
volume, which is suitable for the local building up regulations (like maximum height and solar access) can be determined 
in a simple way. 

  

1.62.1. Creating Building volume 

Command for creating and editing a Building Volume is in the Toolbox menu Terrain in the main menu Building/ Terrain. 

The basic contour and height of the building volume  

First you have to draw the basic contour of the building volume, so that polygon from which the building volume will rise. 
Use the proper commands from the Profile definitions on the left side. 
You can determine the maximal height of the building volume with value or graphically. It depends on that you started the 
command from the floor plan or from the 3D window. 
Later you can modify this value. 
Then the Building volume dialog window appears. 

The volume of the building 

In the Building volume dialog window you can detail the rule system referring to the surfaces border the building volume 
control.  
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Parameters 
The left side picture helps to understand the meaning of parameters. 

 
A The angle of selected plane compared to perpendicular. You can determine the angle value between 0 and 

89 degree. In case of giving false value, the field’s colour will be red. The angle counts from the line 
determined in B.   

B The frontal height of the selected side: If you use this option, the C option can’t be reached. 
C Shifting the starting line of oblique limiting on the base plan: If you use this option, the B option is not 

definable. 
D Inside perpendicular limit: You can use the option independently. You can determine with its help such 

building volume limits, which can’t be definable in any other way.   
E The maximum height of the building volume: Here you can see and modify the value of height determined at 

building volume base contour.  

For all sides 
After switching on the option all sides of the refreshed volume model change according to the selected A-B-C-D-E values. 

Information list 
These information help to get a picture continuously from the designing volume model according to the geometry 
information.   

Select sides 
The sides of the polygon by creating base contour determine the sides of the volume model, which is lifted out from this. 
You can see the simplified plan of the volume model in the top view window. The selected side appears as a grey area. 
You can select between the sides with the button above the window. The numerical value shows how much sides exist 
and which one is selected now. 8/8 means, that there are 8 sides and the last one is selected. You can also select in the 
window if you click on the proper side. 

Preview 
You can look at the changes during the drawing in the pre-view window. Each new change in the drawing can be 
transformed to the Pre-view window by clicking on the Update button. 

Internal cuttings 

If you use the internal cuttings, you can graphically determine complex rules. In the appearing dialog window you can 
determine detailed limits on the selected side.   
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You can make a new rule with the Insert new button, so even periodic structures can be determined. The explaining figure 
helps with determine different rules and you can follow the changes on the actual volume model as well by clicking on the 
Update button.   

Parameters 

 
A The angle of the new cutting compared to perpendicular. 
B The base height of the new cutting compared to the base line of the selected side. After the changing the C 

value is refreshed automatically.  
C The value of shifting the base line of the new cutting plane compared to the base line. After the changing the 

B value is refreshed automatically.  
 
D The depth of the new cutting compared to the perpendicular plane of baseline. 
F The left side base plane of the new cutting. The limiting surface of the two side’s vertical cutting is 

perpendicular to the vertical plane of the base line.  
G The width of the new cutting. This value determines also the place of the perpendicular limiting on the right 

side. 

1.62.2. Editing volume model  

You can edit the building volume model from: 
� Shortcut menu: click on the Properties command. 

   
Building volume dialog appears where you can continue defining of the rules.  
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10. Building model 

Introduction 

Architectural objects (walls, doors, windows, slabs, etc.) are used to design 2D floor plan drawings and to develop 3D 
model of a virtual building. The modification of the position or dimensions of any of the architectural objects updates the 
model. 
In this chapter you can find the commands to create a virtual building. 

1.63. Floor and building management 

In ARCHLine.XP levels allow designers to organize the walls, slabs, roofs and other elements of the building to the 
object's physical location. Levels help determine where all the important heights are in the building. 
 
When you start a new project, a default floor structure is created automatically. 
Other floors have to be created by the architect. 
 
Floors in ARCHLine.XP are not physical boundaries but comprise a single logical unit. An object located on a certain floor 
belongs to that floor; however, floor properties (i.e. headroom and height) do not influence its geometry. This means that 
any object placed on the floor does not have to be physically within the floor boundaries but may overhang. This is 
necessary for split-level buildings. 
 
You can speed up drawing if you copy the objects of an existing floor to another floor. This is very useful when creating 
main walls on a number of floors, as their floor plans usually correspond to each other. 
 
In ARCHLine.XP® one drawing may comprise a number of buildings. These buildings can be created: 
 

� as separate projects, which are imported to a single drawing by Import and Merge to current drawing, or 
� within one drawing, where you can create several buildings. 

 
Depending on the terrain, you can assign different heights above sea level to buildings. There is only one active building at 
a time; others are displayed with a lower colour tone.  
 
Floor properties are: number, name, height above sea level and own height. You can modify these at later stages. 

Example 
Let’s see an example of wall and slab arrangement in the case of two floors: 
 

� ground floor starts at 0 m, with a height of 3 m, 
� wall starts at 0.0, with a height of 2.7 m, 
� slab starts at 0.0 m, with a width of -0.3 m, 
� floor starts at 3 m, with a height of 3 m, 
� ceiling slab starts at a relative 0.0 m, with a width of -0.3 m. 
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Floor 

 
 
 
 
 
 
 
 
 
 
Ground 

floor 

 
This means that the slab (floor slab) is situated under the wall and overhangs the height of ground floor. The 0.3 m space 
between the top of the wall and the height of the floor is occupied by a slab of the same position and of 0.3 m width. 

Floor management 

You can manage floors from different parts of the program: 
 

� in View menu: Floors and building: 
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� In Project Manager:  
Choose the appropriate drawing to display 
buildings and floors in Project Manager.  
Click on the floor name to activate the requested 
floor. 

 

 

 

� In the Status bar   with the Floor icon: 
� Click on the arrow to open the current floor list and select the new active floor. 

  
 

� Click on the button to display Edit levels dialog box, where you can create and edit floors. The properties in the dialog box 
always refer to the current building. 
 

  
 
Let us see the options in this dialog box: 

1.63.1. Creating floors 

When you start a new project, the floor plan view and the ground floor level on the floor plan is created automatically. 
By default, floor height is 0 m and the full height is 3 m. 
 
You can create and manage floors with these commands: 
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 Add up 

Insert new floor above the top-most floor 
 

 Add down 

Insert new floor under the top-most floor 

 Insert new floor below 

New floor between two floors, under the active 
one 

 Delete floor 

 

 Activate a floor 

 

 MAnage visible floors 

 

 

1.63.2. Activate a floor 

Floors have three states: active, off and visible. 
You can define the state of the desired floor by clicking the State column. 

 
 

Active 

The program places the objects on the active floor. Only one floor can be in active state. By default, you can only see the 
objects of the active floor in the floor plan window, but by clicking Visible you can make the objects of another floor visible, 
too. 
 

� You can activate the desired floor with the PAGE UP/PAGE DOWN keys or with View − Floors and building − Floor 

up/ Floor down as well. In these cases, you can activate the the floor above or below only. 
You can also activate the desired floor in the Project Manager in the Design Center by clicking on floor name. 

Off 

If you activate a floor, the previously active floor turns off. 

Visible 

When editing, you may want to refer to some points of an object which is not on the active floor. This option helps you with 
this. 
 
When a floor is visible, the selected floor will also be visible on the floor plan and you can refer to the objects on that level, 
without editing them. Visible objects will be displayed highlighted in grey. 
 

� More floors can be in visible state. 

 
If you do not need to display the visible floor, either choose Off or use PAGE UP/PAGE DOWN to switch between floors 
to activate the desired floor. 

1.63.3. Insert a floor 

The command will create a new floor under the active floor. 
By default, any new floor will have the properties of the floor above which it has been inserted. 
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! When you Insert a new floor make sure that the active floor is the one under which you want to insert a new floor.  

 
When you insert a new floor, a message box informs you the command has no Undo option. 
 

  

1.63.4. Floor properties 

You can assign the following properties to floors: 
 

� Name 
� Floor height 
� Height 

 

 

Name 

To change the name of a floor: 

• Double click the Name field to be changed, and 

• Type in the name of the floor and press Enter. 

Floor height 

Floor height refers to the starting height of the floor (floor-to-floor height). When you can place an object on the active 
floor, its height is specified according to the active floor’s height. 
 
To change floor height: 

• Double click the Floor height field to be changed, and 

• Type in the floor height and press Enter. 

Height 

Refers to the full height of the floor. This height defines the floor height of the next floor. Objects belonging to this floor do 
not need to be within this height. 
To change height: 
 

• Double click the Height field to be changed, and 

• Type in the height and press Enter. 
 

� You can set 0.0 as floor height. You may need to set this value in some cases — e.g. in the case of pseudo copies, 

where there is no 3D modelling, so there is no height extension either.  

1.63.5. Building properties 

Buildings are described by the following properties: 
 

� Height above sea level 
� Environment level visible 
� Split levelling 
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Height above sea level 

Gives the absolute height of the building compared to the sea level. This is important when placing the building in its 
environment, i.e. on the terrain. Modifies the 0.0 m floor height of the building with the height above sea level. 
 

• Type in a new value and press Enter. 

Environment level visible 

You can only place the terrain on the environment level. 
If you disable this option, the terrain placed on the drawing will not be visible in the floor plan and the 3D-model. If you 
enable this option, the terrain will be visible with each level.  

Split levels 

As we have mentioned before, an object placed on the floor belongs to that floor, though its geometry is not affected by 
floor properties (floor height and height). This means that it is not necessary for an object placed on the floor to be 
physically within floor boundaries, but it can overhang these boundaries. 
 
Modify floor levels − Level difference shifts the floor height of the active floor with the specified value. The program will 
place the subsequent architectural objects at this height. 

• Type in the value of the level difference and press Enter. 

•  

� The value of level difference is displayed on the Floor button in the Status bar, separated from the name of the floor by a 

hyphen: . The level difference is valid for all floors. 

Example: 
The living room and the dining room are on the same floor in the house, on the ground floor. However, there is a 1 m 
difference between the levels of these two rooms with the dining room located higher. 
 
You should place both rooms on the ground floor on the drawing, because they have to be displayed on the ground floor. 
The objects of the living room (e.g. walls) are placed on the 0.0 m height of the ground floor. The objects of the dining 
room are 1 m higher.  
 

� In the case of the dining room objects, level difference can be defined by setting the height above floors to 1 m in the 
Properties dialog box for each architectural object. 

� The other solution is that we set Level difference to 1 m in the Modify floor levels dialog box. In this case you do not have 
to set height for each object individually. 
Please note, that if you want to place objects in the living room, you have to reset level difference to 0.0 m. 

 

1.63.6. Floor management 

In ARCHLine.XP, you can manage floors with the following commands: 
 

� Delete floor 
� Copy objects to other floor 
� Move objects to other floor 
� Renumber floors 
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� Separate floors 
 

 Deleting a floor 

To delete the selected floor: 

• Click the desired floor in the Edit floor levels dialog box, and 

• Click Delete. 
 
If you delete a floor, the floor height of the floors above the deleted floor will be reduced by the height of the deleted floor. 

 Copy or move objects to other floors 

You can copy or move the selected objects with this command to one or more existing floors. The command can be 
activated only if you have several floors. 
 

• In the Edit floor levels dialog box, click the Copy objects to other floor or Move objects to other floor button. 

• Select the objects to be copied or moved on the drawing and press Enter. 

• Select the floors you where want to copy or move the selected objects. Hold Ctrl and Shift to select more 
than one floor. If you click the name of the floor, you can see the current content of the selected floor in the 
drawing field. 
 

 

Making pseudo copies 

You can also use levels for other purposes as well. 
 
You can copy the floor plan display of objects to another floor, without having a 3D model for these objects. This is what 
we call a pseudo copy. 
The copied object is displayed as a 2D group object on the desired floor. 
This group is still connected to the original object. If you delete the object, the group is also deleted. 
 
You can place the selected object as a pseudo 
copy. Going back to the floor plan, you can 
define the pseudo copied object by a rectangle 
profile or by a polygon profile. The program 
cuts the object at the boundaries of the 
rectangle or the polygon.  

 
You can change the properties of the object created as a pseudo copy. In the group, you can modify the line type of the 
object. This method is very useful when e.g. you want to mark the location of the framing beams with a dotted line on other 
floors, too. 
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Buffer level Garage level 

1.63.7. Managing multiple buildings (for advanced users only) 

In ARCHLine.XP® one drawing can contain several buildings. You can create these buildings: 
 

� as separate projects, then you can place these on the same drawing by the Import command −Merge to current drawing 
option, or 

� as new buildings within the drawing. 
 
Depending on the terrain, you can assign different heights above sea level to each building. There is only one active 
building at once; others are displayed with lower colour saturation. 
 

� Buildings marked with grey (i.e. inactive buildings) will be printed in real colour. 

 Importing buildings 

Having completed building drawings in separate projects: 
 

• Open the project in which you want to place the building. This can be a new project. 

• Load the floor plan from another project, which is imported into the open project as a new building. To do 
this, follow this method: 

• Select the project desired in File menu - Open project dialog. 

• In the Open project dialog box, enable Import file and Merge to current drawing options. Click Ok. 
 

 
 

• Enable Place with new origin option in the dialog box. 

• Enable Place as new building option. 
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� If the floors of the building to be loaded differ from that of the building in the project, you cannot enable the Place as new 

building option (greyed) and the program creates a new building automatically. 
 
Then you can find multiple buildings in the drawing.  

 
 

 
The Edit floor levels dialog box contains the properties of the current building. Height above sea level applies to that 
current building only. 
 
You can choose the building desired from the Current building pull-down list. 
Building names correspond to the original floor plan file names. 
 
To change the name of the current building, click Rename building. 
 
Click Delete building to delete the current building. Once you accepted this command, you cannot undo it. 
 
To activate the building, select its name. You can go on with the drawing of this building. The other buildings are visible, 
but you cannot modify them. 
 
In the following example you can see three buildings placed on the terrain at different heights above sea level. The 
building in the middle is active. The other buildings have lower colour tones. 
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! When creating your 3D-model, enable the Each building option in the dialog box. The program will create a 3D model 

for each building. 

 Creating a new building 

You can also draw multiple buildings in one project. In this case you cannot load the completed building from the project 
file, but you draw the building within the project. 
This happens as follows: 
 

• Create a new project. Draw building as usual.  

• Select View menu - Floors and building - Create new building command. 

 
 

• You can take over the floor structure from the active building or you can define the number of floors 
independently. 

• Give the name of the new building. This building will be active, although at this point it is an empty building. 
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• The new building is active from now on; other buildings are deactivated and displayed in lower colour tones. 
 

� You can define height above sea level in the Edit floor levels dialog box, and you can also modify the number of floors 

there. 

 Activating other buildings 

You can activate another building by: 
 

� Using the View menu - Floors and building - Activate another building command. Click the building desired. 
 
Or 

� by selecting the name of the building desired from the Current building pull-down list in the Edit floor levels dialog box. 

 Deleting buildings 

To delete redundant buildings: 
 

� Click View menu - Floors and building - Delete building and select the building to be deleted, or 
� select the name of the building to be deleted in the Current building pull-down list in the Edit floor levels dialog box and 

click Delete building. 

1.63.8. Horizontal floor management 

Horizontal floor management allows you to handle the 3D vertical floor structure of your building in a horizontally aligned 
mode. It will let you handle floors as they would drawings next to each other, like it is used to do in some other 2D CAD 
software and AutoCAD as well.  

 
 
This means that the content of your levels are visually aligned next to each other while they still keep their original position 
in the 3D model. 
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The horizontal floor management function comes with a couple of useful tools, which will help you to reorganize the 
contents and the connection between the objects and their floors. 
 

 
If horizontal floor management is enabled, an anchor point belongs to each floor. The 3D model is built up based on these 
anchor points: the floors will be aligned so that the anchor points of different floors will get on a vertical line, above each 
other. 

 Creating the horizontal floor structure 

Enabling / disabling horizontal floor management 

If your model has more floors, these floors can be represented in a horizontal floor structure. Select View menu / Floors 
and Building / Floors command. You can enable/disable the horizontal floor management in the appearing dialog. 

 
 

If you enable the horizontal floor management for the first time, the floors will be shifted automatically to avoid overlapping 
each other. You can customize the resulting layout by using the Shift floor marker command on the active floor border. 

 Building up a floor structure from a 2D drawing 

You can start an ARCHline project by importing a DWG (or other 2D) drawing. These drawings haven’t got floor structure, 
different floor levels are usually represented as simple floor plans next to each other. To build up a floor structure based 
on drawings like this select View menu / Floors and Building / Build floor structure command. Select an object of a 
floor, click on the reference point (anchor point) and repeat these steps for the other floors, finally press ENTER. The next 
figure shows how to build up a floor structure of a drawing with 3 floor plans in 6 steps: 
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Use a relevant point (like a corner of a chimney, a structural column, etc.) as reference point. Later you can refine or 
modify the position of these reference points selecting one of the anchor marker commands. 
 
Once you have selected the objects of a floor and set the reference point a new floor will be created and the selected 
objects will be moved onto the new floor. Objects which do not belong to any floor created (like drawing stamps, frames) 
remain on their original floor. Therefore the previous example will contain finally 4 floors. You can delete the original floor if 
you do not need it anymore. 
 

 

 Marker commands 

Once the horizontal floor structure is enabled, you can manage it by using the marker commands of the floor markers 
(borders and anchors). 

Simple marker commands  

You can access these commands if floor marker commands are enabled. If floor markers are disabled, you can enable 
them by clicking on the active floor marker (the solid border line) and selecting the Switch on/off floor markers command. 

Activate floor 

By clicking inside the dotted border of an inactive floor the clicked floor will be activated. 

Floor name 

By clicking on the floor name you can rename it. 

Floor elevation 

By clicking on the floor elevation you can change it. Values which change the order of floors will be rejected. To change 
the order of floors see Move active floorq commands of an inactive floor. 
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Active floor commands  

You can access these commands by clicking the solid border of the active 
floor. 

Shift floor on 2D 

You can rearrange your floor plan by shifting the active floor. This command 
moves the whole active floor with the anchor; therefore this command has 
no effect in the 3D window. 

 Switch on/off floor markers 

You can switch on/off the floor markers except for the border of the 
active floor. If floor markers are disabled, you can enable them again by 
clicking on the active floor marker (the solid border line) and selecting the Switch on/off floor markers command again. 

 
Floor markers enabled 

 
Floor markers disabled 

 Inactive floor commands  

You can access these commands by clicking the dotted border of an inactive floor. If floor markers are disabled, you can 
enable them by clicking on the active floor marker (the solid border line) and selecting the Switch on/off floor markers 
command. 

 

Move/Copy objects from active floor 

Select objects on the active floor and press ENTER. The selected objects will be moved or copied to the inactive floor. 

Move active floor above/below this 

You can rearrange floors by using these commands. They remove the active floor from its current position and insert it 
above/below the selected inactive floor. 

Switch on/off floor markers 

You can switch on/off the floor markers except for the border of the active floor, see the Active floor commands. 

 Anchor Commands 
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You can access these commands by clicking the anchor marker  of the active floor. 

Move anchor - global 

Moving the anchor globally means that you move the anchor points of each floor by a given vector. Use this command to 
find an appropriate point (like a corner of a chimney) to align two or more floors to each other. The position of anchor 
points relative to each other do not change, therefore this command has no effect in the 3D window. 

 

 

 

Move anchor - local 

Moving the anchor locally means that you move the anchor point of a given single floor only. Use this command to align a 
floor to other ones. In the 3D window the floors are aligned to each other based on the anchor points, therefore moving the 
anchor locally is interpreted in the 3D window as moving all the objects of the active floor while the anchor point keeps its 
position. 

 
 

 
 

 

Switch on/off floor markers 

You can switch on/off the floor markers except for the border of the active floor, see the Active floor commands. 

 Floor marker setting 

You can set the colour of the floor markers in File menu / Preferences / General / Cursor and marker settings 

1.64. Wall 

Introduction 

Walls are drawn on 2D floor plan, but they have 3D characteristics as they are created. A wall, in ARCHLine.XP® is not a 
series of lines drawn in floor plan, but represents a 3D shape having a width and a height structure.  
The walls can take any 3D shape (sloped, curved, layered, freely profiled) and you can then place a door or window in it. 

Surveying 
If you started the drawing with the survey of an old building, you will have a surveyed room with walls transformed into real 
walls. Now you can continue your work with drawing the new part of the building and connecting it to the old building, of 
course, depending on the actual task. 

New building 
You can start drawing - without any preparation - with the creation and modification of walls, and the drawing of the floor 
plan. 

In both cases you will use the  Wall tool commands. 
Walls are made up of one or more vertical layers (single or sandwich walls). Walls are independent and separate objects 
that are not linked to rooms, and they can be straight or curved.  
 



 10. Building model 351 

ARCHLine.XP® 

In this chapter we will discuss the setting of wall properties, the creation of walls, wall editing and wall modification. 

1.64.1. Wall properties 

Define wall properties before starting drawing. 

You can set these properties by right-clicking  Wall tool or with the Building - Properties - Wall command. If you 
modify any of the wall properties that will affect the walls created later on. 
 

  

 Wall General Properties 

Like any other architectural objects of ARCHLine.XP®, walls have also their colour, layer, line type, and line width and 
priority properties. 

� See:  
� the detailed description of general properties in Chapter 3.2.1.Specifying general properties, 
� the description of cost variables in Chapter 3.2.4. Assigning cost variables. 

 
Walls have further general settings: specific hatch direction and the position of the reference line, or enabled side marker. 
You can also set the exterior and interior wall material. 

Hatching directions 

 

 

 
You can select the 
global hatching 
direction or you can 
disable this option if 
you want to use a 
hatching direction 
related to the wall 
direction. 
 
You can see a 
hatching angle of 45° 
in this example. 

Side marker 
This is a global switch for marking wall reference lines on each wall. Side marker will not be plotted. 
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Offset  

  

 

Enter the distance to specify how far the wall’s 
reference line will be offset from the cursor line. 
 

Exterior and interior wall material 

 

 

You can define different interior 
and exterior wall materials and 
the body material for the wall. 

• Press the button referring to 
the material. 

• Select material type in the 
Material dialog box. 
Click on the right side Link button 
to use identical interior and 
exterior wall materials. 

� You can perform material selection by selecting the appropriate material in the Design Center, Material set and dragging 

and dropping onto the wall. See chapter 8.5. Modifying properties for a detailed description. 

Wall status 

There are four possible wall statuses: 
 

� New wall 
� Existing wall 
� Wall to be demolished 
� Wall not connected 

 

New wall 
The New wall status is the default. Should be used for drawing walls in general if other statuses are not necessary to 
visualize.   

Existing, Wall to be demolished 
The first three statuses make it possible to distinguish existing walls, walls to be demolished and new walls on your 
drawing in the case of the reconstruction or extension of an existing building. 
You can assign colours to the existing walls and to the walls to be demolished in accordance with standards in force. The 
program will colour walls in the drawing with these colours. Colour assignment is global, so the program will apply settings 
to all the existing walls and walls to be demolished in the drawing. Walls to be demolished will not have 3D model. 

Wall not connected 
In construction, you might have situation that you want to keep walls separately. In these cases, you need to prevent wall 
ends from joining. You can do this by disallowing the wall joins. 
Using the Wall not connected property, the end of the wall cannot join to the end of another wall. 

Slanted wall 

• Specify the angle of inclination. The positive direction is specified by the wall reference line. 

 
•  

Slanted walls are displayed on the floor plan with their section view at the height of 1 m. 
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Wall – No hatch under elevation 1m  
There is no wall hatch displayed when the wall elevation plus the wall height is under the section height from floor value. 
You can set this value in the Property grid when 2D floor plan is the active window. 

 

Geometry properties 

In Geometry properties you can define the geometry specific properties of the wall: wall height, wall height related to the 
current floor and wall thickness. 

 

 
 
Wall unconnected height 
 
You can define the unconnected height of a wall to a fixed value. In this case, wall height will take the value set in the 
Modify floor elevation dialog box. 
 
Wall height is attached to floor height 
 
If you select the Height is attached to Floor height in the pull down list, the height of the wall will change in line with the 
actual floor elevation. 

 
 
Attaching Top 
You can attach walls to roofs, slabs and ceilings. The effect is, that if you build the 3D model the wall shape will be limited 
by the roof and slab geometry. 
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Walls do not automatically attach to roofs and ceilings. You have to explicitly attach them using the checkbox in the Build 
3D model dialog. 

 Compound Wall 

A compound wall is a wall that consists of multiple vertical layers.  
You can set the thickness, hatch (pattern), material (such as concrete, insulation, and interior finish) and function of these 
layers. 
You can create compound walls, consisting of up to 25 layers. You can select multi-layered wall structures from the sets or 
you can create your own compound wall layer by layer. It is worth creating and saving the compound wall often used. 
Click on the Wall Layers tab in the dialog. 

 

 
 

Click on the Insert new (green plus) button to add new layers. Layers before the insertion will be intact, while layers after 
the insertion will be shifted. 
Click on the Delete (red X) button to delete the wall layer selected. 
The program displays the total thickness of the compound wall under the preview window on the left side. 

Displayed layer 
Select the layer in the list you want to display and click on the Displayed layer button. The Arrow will jump to the number 
of the layer to mark the representative layer (usually a brick or concrete layer). 
This is very useful when displaying walls on the floor plan or in 3D without any layer. The program will use the marked 
layer’s properties to display the wall. 

 
In the case of the floor plan: 
Enable the second icon at the wall in the View 
menu - Doors, windows, and wall scale dialog 
box. 
The wall will have the properties of the hatches 
of the displayed layer. 
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In 3D:  
If you want to see the layered 
wall in 3D, the wall will be 
displayed with the properties 
of the displayed layers. 
To display layers, enable the 
With laminate option in the 

 Build 3D model dialog 
box. You can see layers of 
different width in the 
example. 

 

Layer properties 

 
 
Click on the field to activate the desired wall layer. To modify layer name, material, height, elevation and thickness, 
double-click on the actual field. You can also define wall height with specifying elevation. To do so, select the Floor 
elevation option in the drop down list. 

Layer priorities 
When walls are joined, certain rules for joining apply that define how the different layers meet and intersect. The priority is 
a number ranging from a minimum of 0 to a maximum of 10. High priority layers will cut through low priority layers. 
ARCHLine.XP connects layers with the highest priority first before connecting layers with a lower priority. 

  
 

Layer line 
You can set the width and colour of the 
line between the layers of the multi-layer 
wall layer by layer. 
 
The program will offer the 0 line width as 
a default. 

  
 

 
 

 
Line width between layers: 0 
 
 
Line width between layers: 
0.3 mm. 
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Layer hatching 

Select Layer hatch on the left hand side of the window to set the hatching parameters of the selected wall layer when 
displayed on the floor plan. 
 

• Select the layer in the Layers dialog box, and 

• Click on the Modify layer hatch button.  
 

 
 
You can set the general hatching properties of the wall in the upper side of the dialog box, i.e.: colour, line type, line width. 
In the specific parameters section you can set the background colour, the pattern, the hatch density, the transparency, the 
visibility of hatch boundary, the angle of wall hatching and you can also turn it into a solid pattern. 
 

� In the case of walls you also have to define hatching parameters for the cross-section view. You can set this parameter 

by changing the appropriate material’s properties of the actual layer. 
 

� See Chapter 4.2.3.5 Material properties dialog box and Chapter 11.3.1 Hatching properties. 

 

   
 

 Walls with layer axis line representation 

On the floor plan, the active wall layer axis line can be represented with different line properties.  
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The line properties can be set in the Displayed layer axis line panel: 
 

 
 

 Walls with different inner and outer line representation 

On the floor plan, the other side of the wall contour line can be represented with different line properties.  
Other side means the opposite side to the wall reference line. 
The line properties can be set in the Other side panel: 
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 Visibility of the sides 

 

 Wall sets 

 
 
 



 10. Building model 359 

ARCHLine.XP® 

Sets 
You can save your own wall 
properties into the sets, and 
you can also load wall 
properties from the sets. 
 
The program contains default 
wall properties; you can select 
any of them or add new 
properties. 
 

� See the description of sets 

in Chapter 3.2.3. Using sets 

of properties. 
 

 Property grid – Wall properties 

 

Wall – No hatch under elevation 1m  
There is no wall hatch displayed when the wall elevation plus the wall height is under the section height from floor value. 
You can set this value in the Property grid when 2D floor plan is the active window. 

1.64.2. Creating walls 

You can create walls in different ways using  
 

� Building menu - Wall commands or  
� Toolbox – Building - Wall tools.  

Reference line 

When you draw a wall, there are several options for the reference Line (in the Options Bar):  

• Wall centerline  
• Interior line 
• Exterior line 
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This image shows the wall line in all cases below. 

 

 

 

 
 
The wall will be placed on the right 
side of the reference line. 
 
 
The wall will be placed onto the axis. 
 
 
 
 
The wall will be placed on the left 
side of the reference line. 

 

 Single Wall 

With this command you can draw one or more walls along a reference line. Define the wall corner points one by one. 
 

• Specify the start point of the wall and then the endpoint. 

• Specify the endpoint of the next wall (the wall start point coincides with the end point of the preceding wall), 
or 

• Enter start drawing a new wall, irrespective of the previous one. 

• Enter completes the command. 
 

� Wall direction depends on the reference line orientation. Press F5 to flip the interior/centre line/exterior orientation of the 

wall. 

  

Options: 

In the middle Places the reference line centred. 

Right side / Left side Places the reference line on the right / left side of the wall. 

Smooth The next wall will be joined to the preceding one tangentially. 

Arc Draws arc wall. 

Tangent If the first object of a polyline is an arc, you can define a tangential vector for the arc. 
You can continue an existing wall with a tangential arc. 

Select an object Places the selected object into the contour of the profile.  

Inverse Places wall reference line to the other side. 

Draw by polygon option 

With this option you can draw a series of walls in one step. The wall endpoints will be connected. The reference line may 
contain arcs and lines too. It is different from the previous function because the program will draw wall alignment only until 
you end the command. 
 

• Define the starting corner point of the wall and then the other nodes. The endpoint of the wall coincides 
with the starting point of the next wall. 

• Define the endpoint of the next wall, or 

• Enter you can start drawing a new wall, irrespective of the previous one. 

• Enter  completes the command. 
The program will display the walls like that: 
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Draw by rectangle option 

With this option you can create wall along a rectangle contour with the base line and height. 
 

• Define one corner of the rectangle base line and then the second one. 

• Move the cursor into the perpendicular direction and define the height of the rectangle with its other corner 
point. 

• Enter completes the command. 

� See Chapter 11.3.2 Commands for drawing polylines - General rectangle. 

Wall by existing chain options 

Use these options to place one or more walls along one predefined open or closed polyline. 
 

• Select the corresponding option and the endpoint of the polyline and the program will draw the walls. The 
profile may contain lines and arcs. 
The program creates the wall along the profile. 

• Enter  Exits the program. 

•  

 

 
 

� The polyline actually indicates the position of the reference line, because the program will place the walls depending on 

the value of the reference line settings which can be changed with the options. 

 Curved wall 

With this command you can draw arc wall passing through three points. 
 

• Define the starting point, endpoint and an internal point of the arc wall. The wall endpoint coincides with the 
starting point of the next wall. The joint can be normal or tangential, and the next wall can be linear or arc. 

• Define the endpoint of the next wall, or 

• Enter you can start drawing a new wall, irrespective of the previous one. 

Press Enter to close the command. 
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In ARCHLine.XP you can create a full-circle wall as 2 arcs joined together. 

 

 

 Walls on DWG drawing 

The Walls on DWG drawing command is used to convert a 2D drawing into a 3D model, by using its lines. 

 
Example: 
Imported DXG/DWG drawing 

 

 
 
2D lines converted into drawing & 3D model 

 
How to use the tool 
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� Start the Walls on DWG drawing tool. 
� Left click on a line near to its endpoint, which line represents one side of the wall.  
� Left click on the same line, near to its other endpoint.  
� Left click on the second line, which represents the thickness of the wall. When the tool is finished, you will see the wall 

object on the 2D and in 3D. 
 

 Further wall creating commands  

Insert Curved wall:  

1. Select wall, 2. Select arc starting point on the wall, 3. Select arc endpoint on the wall, 4. Enter radius 
 

 

Insert Square add-on:  

1. Select wall, 2. Select starting point on the wall, 3. Select endpoint on the wall, 4. Offset the selected 
section 

  

 

Insert Angle add-on: 

1. Select wall, 2. Select starting point on the wall, 3. Select endpoint on the wall, 4. Offset the selected 
section, 5. Define symmetrical trapezoid 

 

1.64.3. Joining walls 

When you create walls, ARCHLine.XP automatically joins them at their intersections.  
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Cleaning Wall Joins 

 
Cleaning up wall joins affects display in a floor plan view only. Applying the Wall not connected status, you can create a 
special wall by which will not be automatically connected to other walls and cannot be connected manually also. 
 
To prevent a join on a wall 
1. Select the wall where you want to disallow the join. 
2. Click on the Properties command. 
3. Select Wall not connected from the list box. 
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If you want to allow the join again between walls, Select New wall from the list box. 

 T connection 

This command will join the first selected wall to the second one. The first wall will keep its selection side part, and the 
second wall will remain intact. Not joined endpoints of the first wall will keep their original position as well. 
 

 

• Select the wall 
object you want to 
join to another 
wall. Select the 
section of this 
object you want to 
keep. 

• Select the wall 
object you want to 
join to the 
previous one. 

• Enter

 Completes the 
command. 
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Walls connected perpendicularly 

In the case of an existing L connection you can convert the corner connection to a perpendicular wall connection. For this, 
you have to use a T connection. 

Example: 

• Draw two walls of different height, having an L connection. 

 

 

 
 
You can see in the hidden line 3D drawing that the walls do not close perpendicularly. Use a T connection to join them 
properly. 

• In the wall Shortcut menu select T connection or the  Trim first object (wall) icon in the Edit toolbar. 

• Click on wall 1 and then wall 2 (See figure). 

 

 
 

 
Now you have the proper connection with perpendicular walls. 

 L connection 

This command will join two walls by cutting them at their intersection or lengthening them at their user defined part. 
 

 

• Click on the wall 
you want to adjust 
to the other one. 
Select that part of 
the object you 
want to keep. 

• Select the wall you 
want to join to the 
previous one. 

• Click Enter to end 
command. 
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• Click on the wall you want to adjust to the other wall. Select the part of the architectural object you want to 
keep. 

• Select the wall you want to join to the other wall. 
 

� You can join the walls besides the Shortcut menu commands, also with the Edit toolbar -  Trim first object and 

 Trim both objects commands. 

 X connection 

This command will join two walls by cutting both of them at their intersection. In the wall Shortcut menu select X 
connection. 
 

• Right click on the wall you want to adjust to the other one 

• Select X connection from the pop menu Connections (See figure). 

 

1.64.4. Editing walls 

You can edit the walls. When editing, you can edit the entire wall (i.e. both sides together) or one side only. 
�  Use the Shortcut menu commands. Right click on the wall to display the shortcut menu 
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You can find edit commands for the entire wall and for one side of the wall in the Shortcut menu. The menu can be found 
on both the 2D and 3D views. 
 

 Change length 

When modifying the length of a wall ARCHLine.XP® automatically recognizes the direction of it. It is enough to select the 
endpoint and move the cursor to the appropriate direction, then type the relative length value on the keyboard. The 
positive value is measured in the selected direction along the direction of the object. 
You can find this command in the Shortcut menu - Wall – Edit Change length or click on the wall endpoint marker. 
 

  
 

 
• Define the new length by moving the mouse, or use your keyboard for entering the shift value. 

  

Modify length by typing the absolute length 

• Click on the wall and next click on the length value. 

• Use keyboard for entering the new absolute length. The length will change relative to the wall direction 
marker.  

 
• If you wish to change the order of start point and endpoint positions click on the direction arrow marker to 

move it to the other endpoint of the wall. 

•  



 10. Building model 369 

ARCHLine.XP® 

 

 Move endpoint 

This command will change the location of any corner point of the wall without changing wall thickness. 
You can find this command in Shortcut menu - Wall - Edit Move endpoint or click on the wall endpoint marker. 
 

• Select the endpoint you want to move. 

• Define a new location for the endpoint. 

 

Move endpoint on one side of the wall 

You can move a node to one side of the wall only, which will change wall thickness and the geometry of that wall side. 
You can find this command in Shortcut menu - Wall - Edit one side – Move endpoint  
 

 

 Insert endpoint 

This command splits a wall to two connected walls by adding a new node on the selected side of the wall. 
 
You can find this command in Shortcut menu - Wall - Edit– Insert Endpoint or click on the wall edge marker. 
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Define a new location for the inserted point. 

 

 Insert node on one side of the wall 

You can insert a node to one side of the wall only, which will change wall thickness and the geometry of that wall side. 
You can find this command in Shortcut menu - Wall - Edit one side - Insert node. 

 
• Specify the location of the new node. 

Options: 

Polygon You can define a polyline as new closed contour of the 
wall side. Specify the corner points to be inserted one by 
one.  

 

  
  Polygon 

 Delete node 

You can delete a node from the selected wall, if you have inserted that node to one side of the wall. 
  
You can find this command in the Shortcut menu - Edit one side – Delete node. 
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• Select a wall by clicking close to the node to be deleted.  

 

 Turn into curved edge 

This command will convert straight linear walls to arc walls, or modifies the radius of an existing arc wall. 
You can find this command in Shortcut menu - Wall – Edit - Turn into curved edge - or click on the wall edge marker. 

 
• Select the wall to be modified. You can select arc walls as well. 

• Click on the desired point to define graphically the arc to be intersected by the arc wall. 

 

Converting lines to arc on one side of the wall 

You can convert one wall side to arc only, which will modify wall thickness and the geometry of the wall side concerned. 
You can find this command in Shortcut menu - Wall - Edit one side - Turn into curved edge 

 

 Turn into straight edge 

This command will convert an arc wall to a linear one. 
You can find this command in Shortcut menu - Wall – Edit - Turn into straight edge - or click on the wall edge marker. 

 
• Select the arc wall you want to convert to linear one. 

• Enter Completes the command. 

Converting arc walls to linear on one side of the wall 

The command will convert one side of the wall to linear only. 
 
You can find this command in Shortcut menu - Wall - Edit one side - Turn into Straight Edge. 
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 Cut with wall  

This command will split the wall into two at the point of intersection nearest to the selected point. 
You can find this command in Shortcut menu - Edit - Cut with wall. 
 

� The program will create two new walls as the result of this operation. 
�  

�  
�  

This is also very useful when the intersecting walls are connected. This command will delete the wall T or L connection. 

 
 
 

• Select the wall you want to split. 

• Select further walls, or 

• Enter Completes the command. 

 Cut with line 

This command will cut the selected wall along a specified line. 
You can find this command in Shortcut menu - Wall - Edit - Cut with line. 
 

• Specify the wall you want to split (point 1). 

• Specify the starting point and the endpoint of the secant line. 

• Enter Completes the command. 

 

 Hide/Show wall outline 

This command will delete a part of the wall contour line. 
You can find this command in Shortcut menu - Wall - Accessories - Hide wall outline and Show wall outline. 

  
• Select the appropriate part of the wall. 

• Click on the start point of the wall outline from where it will be hidden. 

• Click on the endpoint of the hidden part. 
 
Using the Wall shortcut menu- Accessories - Show wall outline command you can show the hidden part of the wall 
contour. 
 

• Select an endpoint of the hidden part of the contour to make it visible. 
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 Insert wall(s) into wall 

You can insert a segment of walls to the wall with these group of commands. 

Insert Curved wall:  

1. Select wall, 2. Select arc starting point on the wall, 3. Select arc endpoint on the wall, 4. Enter radius 
 

 

Insert Square add-on:  

2. Select wall, 2. Select starting point on the wall, 3. Select endpoint on the wall, 4. Offset the selected 
section 

  

 

Insert Angle add-on: 

1. Select wall, 2. Select starting point on the wall, 3. Select endpoint on the wall, 4. Offset the selected 
section, 5. Define symmetrical trapezoid 

 

 

1.64.5. Sketching wall elevation, cross section 

When you draw a new wall ARCHLine.XP draws a rectangular wall. The wall editing commands allows you to modify the 
shape freely in any dimension with polylines, curved, or circular items. 
 
To edit a wall's elevation select one of the following commands: 
 

� Building - Wall – Profile   



374 10. Building model 

Manual 

 
 

� Shortcut menu: you can activate the commands from the floor plan or the 3D window. 
 

 

 Edit Wall Elevation - top profile only 

This command modifies the wall elevation top profile only. You can modify the wall on the floor planand in the 3D window 
as well. 
 

• Select one side of the wall you want to change with a right click and choose from the appearing menu 
Profile/Edit Wall Elevation – top profile only. 

 

Note: Most of the case the interior and exterior side of the walls are different. Please click on the appropriate side you 
want to edit! 

 

Your screen should appear the elevation view of the selected wall in editable mode: 

The 4 lines that appear represent the wall in an elevation view along the selected side. (If you have modified a wall profile 
before, the program displays the current elevation of this wall.) 

Options: 

NEXT You can select next corner point of the elevation to 
specify the reference point. Press F5 on keyboard to 
execute the command. 

STAIR The stair side view connected to the wall will appear on 
the wall elevation view - this helps the definition of the 
wall profile under the stair. 

 

• Place the wall elevation view anywhere on the drawing. 

• Specify a polyline over the elevation view. If it is a closed profile, the program randomly deletes a part of it. 
Select any option to specify the profile in the Toolbox – Profile definition tool. 

• When you are finished, press Enter. ARCHLine.XP applies the new profile on the wall. The new shape will be 
displayed in the 3D views 

� For a description of the Profile definition, see Chapter 8.2. Specifying profile 
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� You can create a new profile with the menu Building/Object  Open profile command; and you can save your profiles 

in the profile library. 

 Edit Wall Elevation 

This command modifies the wall elevation profile on each side. You can modify the wall on the floor plan and in the 3D 
window as well.  
You will create a closed profile modifying the wall. The operation of this command corresponds to that of the Edit Wall 
Elevation – top profile only command. The difference is that you have to specify now a closed profile. 
 

� See Chapter 9.1.5.1. Edit Wall Elevation – top profile only for description. 

1. Example: the Edit elevation profile in 3D 

• Select the wall you want to change with a right click on the wall surface in 3D and from the appearing pop menu choose 
Profile / Edit Wall Elevation. 

• Use the Edit profile tools to change the shape of the wall surface. 

 

• Press Enter to complete the command. 

2. Example: Setting the wall elevation profile under the stair 

Option: 

STAIRS The layout image of the stair attached to the wall will be 
displayed on the front view of the wall. This helps you to 
define the profile. 
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• Select the stair to which you want to adjust the wall. 

• When you set the profile define the closed profile under 
the stair. 

 

 
 

 

 Edit Wall Elevation - bottom profile only 

This command modifies the wall elevation profile on bottom side only. You can modify the wall on the floor plan and in the 
3D window as well.  
You will create an open profile with this command; modifying the wall. The operation of this command corresponds to that 
of the Edit Wall Elevation – top profile only command. The difference is that you have to specify now the bottom profile. 

� See Chapter 9.1.5.1. Edit Wall Elevation – top profile only for description. 

 Edit Wall Section 

This command modifies the wall cross-section profile. 
 

• Select the wall to be modified in the floor plan. The program will automatically create the wall cross-section 
profile. (If you have modified a wall profile before, the program will display the current cross-section of this 
wall.) 

Options: 

NEXT You can select next corner point of the elevation to 
specify the reference point. Press F5 on keyboard to 
execute the command. 

 

• Place the wall cross-section view anywhere on the drawing. 

All changes you make to the wall you will do in this preview. 

• Specify a closed profile with which you can define the new cross-section of the wall.  
Select any option to specify the profile in the Toolbox – Profile definition tool. 

When you are finished, press Enter. ARCHLine.XP applies the new profile on the wall. The new shape will be displayed in 
the 3D views 
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� For a description of the Profile definition, see Chapter 8.2. Specifying profile.  

   
 

� If you wish to use a predefined profile, choose the Select from the list command and you can use any of the predefined 

objects of the profile library. 

  
To create a new profile, use menu Building/Accessories/Define closed profile command; and you can save your profile in 
the profile library. 

 Mirror section profile  

This command mirrors the wall cross section profile. The mirror axis is the imaginary middle axis of the wall cross section. 
 

• Select a wall in the floor plan to mirror its assigned cross section profile. 

• Enter Completes the command. 

 Edit section profile  

This command highlights the wall cross-section profile and you can edit it directly. 
 

• Select the wall to be modified in the floor plan. The program will automatically create the wall cross-section 
profile. (If you have modified a wall profile before, the program will display the current cross-section of this 
wall.) 

• Place the wall cross-section view anywhere on the drawing. 

Use the Markers’ operation tools to modify the cross-section of the wall.  

� For a description of the Markers operation, see Chapter 2.15.1. Markers’ operation.  

 

• When you are finished, press Enter. ARCHLine.XP applies the new profile on the wall. The new shape will be 
displayed in the 3D views. 
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 Delete wall elevation 

This command removes the modified elevation profile and restore the wall to its original status. 
 

• Select a wall in the floor plan to delete its elevation profile. 

• Enter Completes the command. 

 Delete wall section 

This command removes the modified cross-section profile and restore the wall to its original status. 
 

• Select a wall in the floor plan to delete its section profile. 

• Enter Completes the command. 

 Place elevation layout 

This command places on the drawing the wall elevation layout with openings and tiling. The wall layout indicates the wall 
orientation with the four cardinal directions, commonly denoted by their initials - N, S, E, W, or the intermediate directions 
as north-east (NE), north-west (NW), south-west (SW), and south-east (SE). 
 

• Select any wall in the floor plan to place its facade. 

• Place the facade view of the wall on the drawing. 

• Enter Completes the command. 
 
To place a wall's elevation view select the following commands: 
 

� Building - Wall – Profile - Place elevation layout 
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 Elevate endpoint  

This command elevates the wall start or endpoint in the 3D window. The other endpoint of the wall keeps its elevation. 
 

� Right click near to the wall endpoint in 3D and from the appearing pop menu choose Profile / Elevate endpoint. 
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� Set the elevation graphically and left click or type a distance and press ENTER. 
 

  

1.64.6. Wall Framing  

The Wall Framing tool in ARCHLine.XP lets you generate timber structure for walls. 
Walls can be individually framed with the following framing parts, such as:  

• Connections,  

• Studs,  

• Plates,  

• Blocking,  

• Cripple studs,  

• Headers,  

• Sills.  
 
Wall Framing includes: 
 

• Bottom plate 

• Top plate, 

• Wall stud – left, 

• Wall stud – right, 

• Inner stud, 

• Cripple stud, 

• Header, 

• Saddle or sill, 

• King stud, 

• Horizontal bar" 
 
 
The timbered buildings in the design you can specify the characteristics of the wall frame structure in detail. The allocation 
rules using settings according to the characteristics of the various systems work and of course arbitrary - you can use 
cross-sections too - even completely unique. 
 
Doors and windows by changing the wall structure immediately create the necessary wall framing elements 
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You can save the wall framing structures into style, so you can use them for new plans or you can even share the co-
planners. 

 

1.64.7. Other commands to modify walls 

You can find other commands to modify walls in the Shortcut menu. 

 Full Curtain wall 

Curtain walls can be created two ways: 

� 1. By creating a corner window by the Building/Window -  Edit custom/corner window command. This command is 
advisable to use if you want to create windows with complex profiles and glass plane patterns in a single wall or in two 
connected walls at the corner. 

� 2. Convert the whole wall into window use the Wall shortcut menu- Opening - Full Curtain Wall command.  
 

 
 
This command will convert the whole wall into a window. The glass properties can be set in the Building/Properties - 
Curtain wall dialog. 
 

� See Chapter 9.3.4.5. Corner window for a description. 
 
Curtain wall has the following properties: 
 

� The window can extend as far as the wall ends. 
�  Divisions can be created in X an Y directions by specifying either the number of divisions or the glass plane dimensions in 

horizontal and vertical directions. It is possible to define unequal divisions, too. 
� At the sides of the window it is possible to switch off the frames so you can see only the glass plane edges. 
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 Tiling 

Activate this command to assign a new material to the selected wall by specifying a contour. This way you can specify the 
plinth on the wall, the tiling etc.; these will be clearly represented in the photorealistic display. You can edit, delete etc. this 
contour later on. 
You can access this command in the Shortcut menu. 
 

   
 

� You can check out the result of this command in the 3D window. To activate the latter one, go to the  Build 3D 

dialog box and enable the options. 
 

� See Chapter 15.1. Decoration -Tiling for the description of the command. 

 Layers 

The reference line of the wall defines the sequence of the layers in the case of layered walls. 
 

 
 
The wrong selection of the reference line may cause the inappropriate sequence of layers. As a result, layers cannot be 
connected. In this case you have to reverse the layers. 
Use any of the following commands to reverse layers: 
 

 

Mirror layers 

In the case of layered walls, click on the Mirror Layers command to change the layer order to be mirrored. 
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Mirroring + shifting 

With this command you can mirror the selected wall layers. The mirroring axis is the user specified side of the wall, which 
means that the wall will be offset at a distance corresponding to the value of the wall thickness. To achieve the proper 
status, use the Shift command, which will offset the wall automatically to its place: 

Shifting 

You can offset the selected wall at a distance corresponding to its own thickness. This distance will be measured from the 
side you select. 
You can use this command when reversing layers as well as when simply offsetting walls with their own thickness. 

Switch reference line 

Wall is placed along its reference line on the left, right or in the middle. Reference lines on the left or right can be 
exchanged.  
 
When you need to exchange the reference line of an existing wall, click the existing object with your right mouse button. 
Select the Switch the reference line command from the appearing shortcut menu.  You can choose more walls to change 
the reference line. 
In the property grid you can change also the reference line of the selected wall. Here click on the Switch reference line 
option. 

 
Before using the command, it is recommended to use the Side marker option in the general properties dialog of the wall.  
The command exchanges the reference line of the wall without changing the position of the wall. 
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! The command changes only the location of the reference line used for the construction, and has no effect on the 

material settings of the wall surfaces. 

 Hatching 

You can use different tools to display hatching: 
You can reach the command in View menu – Show 2D. 

 
 

Display modes other than normal can speed up drawing without having an effect on hatching values set by the user. 
You are suggested to use normal display when printing. 
Display settings are valid for all the walls in the drawing, so it has got a global effect. 

Normal 

Use this command to hatch the wall with the value specified in the dialog box. This value is used when printing. 

Full colour 

Use this command to hatch the wall with the color specified at hatching. 

Empty 

Use this command to display walls without any hatching. This display mode is fast, but will not inform the user about the 
actual hatching. 
 
Normal Full color 

 
Empty 
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 Data 

You can number walls and delete wall numbers when needed. 
 

 

Wall numbering 

Wall numbering means the sequential numbering of walls, starting from 1. 
 

 

Wall numbering with ID 

Besides wall numbering, you can use wall IDs, together with a mark “W” (meaning wall). The same ID will be used in the 
List menu - Word, Excel and Building calculations lists. This way you can associate walls with their corresponding 
calculations.  
 

 
 

 
 

� In the case of Excel lists, you can speed up the assignment of walls to the relevant calculations if you use the 

 command. The program will select the requested object in the drawing according to 
the ID of the object on the Excel list. See Chapter 12.2.3. Excel list. 
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Delete wall numbering 

This command deletes all wall numbering in the drawing automatically. 
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1.65. Structural and decorative objects 

Structural objects 

Structural objects are components of the building’s supporting structure, e.g. columns, beams, plinth.  
When making calculations, the Structural objects can be collected and the data can be exported into static software. 
The program offers the same method for creating columns and beams: 
After selecting the column or the beam profile, the program creates the object of the specified height and length. The 
architectural object thus created is not part of the object library. 
Such objects placed as supporting structures are not identical with the columns and beams placed taken the object library. 
 

 

Decorative objects 

The simplest method for creating individual facade decorations, foundations, string courses and gutters is dragging a 
selected profile along a specified trajectory on the floor plan. By doing this the object is created, its trajectory appears on 
the floor plan and the 3D model is displayed. 
The architectural objects thus created do not belong to the object library either.  
No calculation is made about the decorative objects. 
 
You should specify the properties of the columns, beams and decorative objects when creating them. You can modify their 
properties later.  
It is a common feature of the structural and decorative objects that both object types should be specified by the cross-
sectional profile. 

Objects of the Beam tool:  

 

Objects of the Column tool:  

  

Objects of the Balustrade tool: 

 
 

1.65.1. Column 

A column in structural engineering is a vertical structural object that transmits, through compression, the weight of the 
structure above to other structural objects below. 
 
ARCHLine.XP® enables you to place columns on the current layer or on the terrain. Such columns can be placed into the 
wall and doing so the column and the wall will form one structural object.  
The column properties can be set in the Building - Properties - Column dialog. 
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Profile selection 

Columns are characterized by their cross-sectional profile. First, specify the cross section in the Edit profile dialog by 
clicking Profile from library or clickcing User profile and specify a custom profile on the floor-plan. 

� See the details of Profile editing in chapter 8.9.9. Editable profile. 

 
The cross section previously specified appears in the drawing field on the left side of the dialog box. You can see/modify 
the width/height parameter of the profile in the Width/Height input field. 

Hotspot 

You can select the column’s hotspot for placing it. The active point is marked with red marker, while the other points are 
marked with green markers. Click on a green marker to select a new hotspot.  

Visualization 

In the upper part of the dialog box you can set the general properties: colour, layer, line weights, line type, draw order. 
Other visualization properties are: 
 

On which floors 

visible?  

 

Hatch 

 

 

 

Solid material 

 

 

 

Surface material 

 

Check All floors option to make it visible on all floors or 
use the ellipsis button to select floors. This option is 
available only in the properties of a placed column. 
 
Check this option and use the ellipsis button to set the 
hatch properties if you want to represent the column by 
hatch on the floor-plan. 
 
It defines the solid material of the column. By clicking 
the material name/icon you can select the appropriate 
material type in the Materials dialog box. 
 
It defines the surface material of the column. By clicking 
the material name/icon you can select the appropriate 
material type in the Material dialog box. 
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Same materials Use this checkbox to apply solid material to surface 
material as well. 

 
 

� See:  

the detailed description of the general properties in Chapter 3.2.1 Specifying general properties,  
the detailed description of the hatch in Chapter 11.7.1. Hatch properties,  
the description of Sets in Chapter 3.2.3 Using sets of properties. 

Constrains  

Set the following properties of the column: 
 

Base offset from 

the floor 

 

Height 

 

Angle of 

inclination 

 

 

Direction of 

inclination 

 

Height relative to 0 m of the active floor 
 
 
Column height or pick up the floor elevation as column 
height. 
 
It defines the inclination angle of the column according 
to the direction of inclination 
 
Rotating the inclination defines the direction the solid 
will be inclined by the inclination angle. The result 
cannot be seen on the floor plan, only in the 3D view, 
since it is only symbolically displayed on the floor plan. 

 

 

 
 
 
Axonometric 
view 
 
 
 
 
 
 
 
 
Top view 

 

Floor plan  
Direction of inclination: 0º  0º  90º 
Inclination angle:   0º  80º  80º 

 
The floor plan view is the same in all the three cases. 
 

Rotation angle 
You can specify the Z-rotation angle to be used 
when placing. This rotation has an effect on the 
floor plan as well. If you do not specify the rotation 
angle at this point, you can also define it upon 
placing. 

 

Insert into wall 
Automatically inserts the column into the wall, cutting its hole in the wall. This way the program does not display the wall 
hatch and the wall contour ’behind’ the column. The object inserted into the wall has the same connection with the slabs 
and roofs as the wall itself. The object thus inserted becomes part of the wall, so when deleting the wall, the object is 
deleted as well. 
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Columns inserted into wall 

Make only hole in the wall 

 

Automatically inserts the 
object into the wall, but in 
the 3D view extracts it from 
the wall, that is makes only 
its hole in the wall. This 
option can be activated only 
after turning on the Insert 

into wall option. 
With this method you can 
create vents, stacks and 
ducts.  
When requesting 
calculations concerning the 
wall, the program extracts 
the ’column holes’ from the 
volume of the wall.  

 

� You can also access the last two options from the shortcut menu of the object. 

Slab-roof cutting 

When the Wall-slab-roof cutting option is turned on in the Build 3D model dialog box, the slabs and walls for 
which cutting was selected will cut the columns together with the walls. The result is irrespective of whether the column is 
part of the wall.  

Other parameters 

Cutout – Recess – Attachment 

 
In addition to the prior mentioned possibilities, you can add cutout, recess and attachment to the column. Click the ellipsis 
button next to the Cutout – Recess – Attachment.   
The additions are listed in a table in the dialog. The selected addition in the list is highlighted in the preview window so you 
can easily identify it. 
 



 10. Building model 391 

ARCHLine.XP® 

 

 

 
 
cutout 
 
 
recess 
 
 
attachment 
 

Adding a cutout/recess/attachment 

• To add a cutout/recess/attachment, click Insert new button. In the top-left part of the dialog a new addition 
appears in the list with parameters of index, type, reference plane, profile, width, height and visibility.  

• To define the type of addition, select cutout, recess or attachment for Type. 

• Select the reference plane where the profile of the cutout/recess/attachment is applied. The 
front/back/bottom/top/right side/back side reference planes are defined by the sides of the bounding box of 
the column.  

• To modify the profile of cutout/recess/attachment, click the ellipsis button next to the profile name. In the 
Edit profile dialog you can define the shape, size and reference point of the profile. 

• The witdth and height parameters of the profile defined in the Edit profile dialog appear in list of additions in 
the Cutout – Recess – Attachment dialog. 

• To create a custom profile, click Edit profile button and edit the profile on the floor-plan. 

• To make a cutout/recess/attachment invisible, check the checkbox in the Invisibility column.  

• Set the parameters of the selected addition: 
Start of attachment/recess from the reference plane (>0: outwards from the solid). Of course, this parameter is not 
available for cutouts. 
Thickness of attachment/ Depth of recess. In case of attachment/recess, the profile of attachment/recess is swept 
along a path. The path start at the start of attachment/recess. The length of the path equals with the thickness of 
attachment/depth of recess. Of course, this parameter is not available for cutouts. 
Surface material defines the material on the surface of cutout/recess/attachment. To modify, click the name of material. 
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Material of end plane defines the material of end plane in case of recess/attachment. To modify, click the name of 
material. Of course, this parameter is not available for cutouts. 
Placement of profile reference point parameters define the position of the reference point of the profile defined for 
cutout/recess/attachment. The horizontal and vertical distances relative to the left/middle/right and bottom/top of the 
column can be defined. 
The figures follow the increase. With this option the rotation angle of the cutout/recess changes together with the 
inclination of the column.  

• Use the Move up/Move down/Delete buttons to move the additions in the list up/down or to delete an 
addition. 

• Use the Rotate/Mirror on X/Mirror on Y buttons to rotate/mirror the profile of the 
cutout/recess/attachment.  
 

2D not visible 
If you enable this option, the column is shown by a dotted line on the floor plan, while the model is displayed in the 3D 
window. 
The column doesn’t appear on the floor plan in print. 

Show 3D 
If you disable this option, the model of the column is not represented in the 3D window. 

2D representation by top view 
If you enable this option, the column is represented on the floor-plan by its top view in the 3D window. 

Bottom (start) ending/Top (other) ending/Exchange endings 
Clicking on the ellipsis button you can define the bottom/top ending of the column in the Beam ending dialog. If you do not 
apply the Equal to bottom (start) ending option to the top ending, you can swap the bottom/top endings by clicking the 
ellipsis button next to Exchange endings. 
 

 
Slant columns with horizontal ends.  Slant beam with vertical ends. 
 

         
Columns with perpendicular ends.   Beams with perpendicular ends 

 

Place on terrain 
You can place a column not only on architectural floors but also on the terrain. 
 

• After closing the dialog box, select a point of the terrain the height of which the program specifies.  

• Place the column on it.  
The program places the column on the terrain at the height of the point you selected.  

Matrix 

Clicking the matrix button enables you to place more columns in the matrix window at a time.  
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If you select the Value option, you can specify the number of the objects of the matrix and the distance between them. 
If you select the Graphical option, the total width, height and the direction should be graphically specified so that the 
program can place the objects of the specified number. 
If you select the Single option, you can restore the one by one placement. 
 

 

 

BIM Parameters 

Click BIM Parameters button to assign BIM parameters to the column.  

Placing 

After setting the column properties and closing the dialog box with OK. 
 

Place the column with the selected hotspot in the drawing. If necessary, use the floating menu with the placement 
options. 

1.65.2. Beam 

A beam is a structural object that is capable of withstanding load primarily by resisting bending. 
 
ARCHLine.XP® enables you to place beams on the current layer or on the terrain. Such beams can be placed into the wall 
and doing so the beam and the wall will form one structural object.  
The beam properties can be set in the Building - Beam - Properties dialog 

 

The dialog box is very similar as in the case of the Column command.  
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The following options cannot found: 

� Hatch 
� Direction of inclination 
� Rotation 

 
However, it has the following options: 

Visualization 

Representation by centreline 
You can give all type of beam representation with centre line on the floor-plan. 

Constrains 

Arch beam 
With this option you can define an arch beam by specifying the Bulde direction (left/right/updide/downside) and the 
Chord height. In case of arch beam, beam length always means the length of a straight line drawn between the start and 
end ponint of the beam. 

Reference line 
The program marks the centre line of the beam with a dotted line. 
 

 
 

Other 

Cut in column gravity points 
Let’s place a beam with its starting and end point the way, that arch through more columns. When you switch on the 
option, the program divides the beam to each other joining parts.  

 

! It’s important, that beam fits to the columns.  

Enable to adjust ends in beam chain  
Switch on the option if you want to connect the beams in the chain. 
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You can modify the adjust ends enabled beams to disabled, but if you didn’t switch on the adjusting advanced, you can’t 
set the adjust ends enabled afterwards.  

See the  Open chain of beams and  Closed chain of beams commands. 

Placing beam on the drawing 

After setting the beam properties  
 

• You can place beam in 2D drawing and 3D view as well. 

• Specify the starting point then drag the cursor in the proper direction and define the endpoint of the beam. 
Beside the endpoint appears the profile of the beam, which signs the active reference point. 

 
 
The placing options in the floating menu are similar to the column, but completed with the followings: 
 

Mirror You can mirror the profile of the beam by clicking on the 
command  

Rotate You can rotate the profile of the beam by clicking on the 
command  

 

� You have to give the length of the beam, when you place it. The length field in the dialog box has only role, when modify: 

it signs the real length of the beam, or if you give the value you can modify the length.  

1.65.3. Sweep - Profile along path 

With this command you can create any decorative object, foundation, string course or gutter. 
You should apply the following method: drag the selected profile along the specified trajectory. By this the object is 
created, its trajectory appears on the floor plan and the 3D model is also displayed. 
The method is the following: 
 

� First specify the trajectory you will drag the profile along. The trajectory can be open or closed.  
� You must select the profile and set the appropriate parameters. 

Specifying trajectory 

• Choose a keyword on the command line, thus you can freely specify the trajectory of the profile. 

Options: 

OPEN You can specify an open trajectory for the profile. 

CLOSED You can specify a closed trajectory for the profile. The 
command connects the endpoints of the decoration. 

 

• Specify the points of the trajectory one after another.  
The trajectory may contain both lines and arcs. These can also be tangential to each other: TANGENTIAL and 
ARC keywords  
Enter completes the command. 

Path points with the same height 

After specifying the nodes of the path and pressing Enter, the Profile with path dialog will appear. On the last panel of this 
dialog you can specify a height. This height will be assigned to all nodes of the path. This means a quick solution for that 
common case. 

Path points with different heights 

• After specifying the nodes of the path you can select the node to which you want to assign a different 
height. 

• Give the height of the node relative to the base points. 
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• Repeat the node selection and height specification with any other nodes. At this point we don’t assign 
heights to the base points. 

• Pressing Enter, the Profile with path dialog will appear. The height of the base points can be given on the last 
panel of this dialog. 

Stair 

For giving the height value you can choose a point of a stair. 
 

• After selecting the node and the STAIR keyword, choose a point of a stair to obtain its height. 

Roof 

Similarly, for giving the height value you can choose a roof. 
 

• After selecting the node and the ROOF keyword, choose a point of an edge of a roof to obtain the required 
height. By default, the top height of the roof plane at the selected point will be assigned. By selecting the 
BOTTOM keyword, you can assign the bottom height of the roof plane at the selected point. 

Move profile along path in the 3D window 

• Start the command from the 3D window. 

• Specify the profile and its reference point in the Insert profile dialog. 

• Define the path by selecting the next 3D curve clicking on the edges of the objects to sweep the profile along 
it. 

• Using the CLOSED keyword it is not necessary to define the last curve; the program makes the connection 
automatically. 

• During the path definition the NEXT/DEFHOTSPOT/MIRRORING/ROTATE keywords help you to redefine the 
reference point of the profile you defined previously in the Insert profile dialog. 

• Use the BACKWARD/FORWARD keywords to undo/redo your moves. 

• After specifying the path, the Profile with path dialog will appear. On the last panel of this dialog you can 
view the result. 

•  

  

Profile definition  

After specifying the trajectory, the program automatically displays the Loft dialog: 
 



 10. Building model 397 

ARCHLine.XP® 

  
 

The decorative object is characterized by its cross-sectional profile. Click the button Select profile and select the cross-
sectional profile in the Insert profile dialog box and define the cross-sectional parameters of the decorative object. 
 

� For a detailed description of the Insert profile dialog box see Chapter 8.9.10. Select from list. 

 
Click OK to activate the Profile with path dialog box again. 
 
The selected profile appears in the drawing field, and its properties can be set in the list below. 

Hotspot 

Select the object’s hotspot of placement. The active point is red, the other points are green.  

Shift 
You can define the horizontal and vertical distance between the selected hotspot of the profile and the selected trajectory. 
As it can be seen in the figure below, you can specify negative and positive values. 

Material 
Clicking the No material button the Material dialog box appears in which you can select the material you want to assign to 
the decorative object. 

General settings 

Click the Next button to display the General settings dialog box. 
Here the program displays the entire profile according to the specified values. 
You can set the layer you want place the decorative objects on, or specify the colour and line width you want to use on the 
floor plan or in the 3D view. 

Representation by centre line 
You can give all type of decorative object representation with centre line on the floor-plan. 

Height 
In the last field you can set the base height of the specified trajectory.  
After setting the profile properties in the dialog box, and closing it with OK, the trajectory of the decoration appears on the 
floor plan. The decoration can also be displayed in 3D. 
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1.65.4. Sweep by points in 3D 

With this command it is possible to define decorative objects in the 3D windows by the path definition 
 

� with 3D objects, 
� with 3D points, or 
� with work plane. 
�  

• Start the command from the 3D window. 

• Specify the profile and its reference point in the Insert profile dialog. 

• The Solid with path and profile dialog will appear which works the same like the Sweep – Create command in 
the 3D Object modeller. 

• The difference is the result: instead of a 3D object, a real architectural object is created. 
 

� If you start the command from the 2D window, it will draw the decorative object along the side of the stair. The command 

is similar to the Stair tool -  Balustrade command, with the difference, that here places just the handrail.   

1.65.5. Place object in wall 

The command inserts the object or the structural object into the wall while cutting out its hole from the wall. This way the 
program does not display the wall hatch and the wall contour ’behind’ the object. 
  
To execute the command use the Object or Column or Beam shortcut menu- Place it into wall command. 
This command can be replaced by enabling the Object - Column - Beam properties - Insert into wall option. 
 

� The inserted object becomes part of the wall. The editing commands (delete, move, copy, etc.) are valid for the whole 
group. 

� The inserted objects do not acquire the wall hatch.  
�  

• Select walls to be inserted into the 
appropriate wall. 
Enter Completes the command. 

 
Chimney inserted into wall: 
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� The object inserted into the wall does not acquire the automatic slab-roof cutting that you set for the wall. Cutting 

depends on whether the Slab-roof cutting option in the Object - Column - Beam properties dialog box is turned on. 

1.65.6. Extract object from wall 

The command extracts the previously inserted and then selected object from the wall. 
  
To execute the command use the Object or Column or Beam shortcut menu- Extract from wall command. 
This command can be replaced by disabling the Object - Column - Beam properties - Insert into wall option. 
 
Following the extraction: 

� The object regains its original properties and can be regarded as an individual object. 
� Wall hatch is applied to the object as well. 
�  

• Select architectural objects you want to extract from the appropriate wall. 
Enter Completes the command. 
 

Chimney inserted into wall Chimney after extraction 

1.65.7. Modifying column, beam and decoration  

In the case of columns, beams and decorations the modification of object properties works in the same way as for all 
objects. 
Clicking on the object the Property manager visualizes its property or clicking on the Shortcut menu – Property command 
the Properties dialog box appears. 
You can modify the object’s property.  
 
If you have locked the objects with the Modify menu - Lock architectural object in 3D command, the 3D fixed option is on 
in the Properties dialog when the object is modified. 
By turning off the option you can unlock the selected objects. You cannot lock the selected objects in the dialog box. 
Locking enables you to render 3D images to architectural objects, independent of their 2D drawing. This way you can 
create detailed 3D views without displaying these details in the 2D drawing. 
In the Decoration shortcut menu you can select further commands to modify decoration trajectory. These are the 
following: 
 

 
 

 
 

� For a detailed description of the commands see Chapter 9.7. Creating and editing balustrades. 

1.65.8. Place plinth 

The program enables you to place plinths from a predefined plinth library.  

Select the Building - Beam tool Place plinth icon. You can set the plinth properties in the Position object dialog. 
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� See 9.11.1.  Object properties and placement chapter. 

1.65.9. Define custom plinth 

You can also create your own plinth and save it into a library in the following way. 
 

• Design your custom plinth object in a 3D window. 

• Select the Building - Beam tool  Define custom plinth icon.  
 
Now you will create a 3D object: 

• Select the objects of the 3D group. 

• Specify the gravity point of the plinth. 

• The Free object dialog will appear. First select the appropriate 2D and 3D group, and then specify the object 
name. 

• Save your custom plinth into your own plinth library. 

1.65.10. Closed chain of beams 

With this command you can draw a closed chain of beams along a reference line, defining nodes with each click. The 
reference line may contain arcs and lines, too. 
You can use this command to create footing, so the footing will get to the structure objects, when listing.  

• Select the Building - Beam tool  Closed chain of beams icon. The beam dialog will appear where you can 
set the beam properties. Click Ok to exit from the dialog. 

• Define the starting point of the chain and then the other nodes. The endpoint of the beam coincides with the 
starting point of the next beam. The joint can be normal or tangential, and the beam can be linear or arc. 

• Define the next endpoint of the beam, or 

• Enter  completes the command, and the last beam will be automatically drawn if the chain of beams you 
specified is not closed. 

• The program displays the beams. 

Options: 

SMOOTH The next beam will be joined to the previous one 
tangentially. 

ARC Draws arc beam 

TANGENT If the first object of a polyline is an arc, you can 
define a tangential vector for the arc. You can 
continue an existing beam with a tangential arc. 

SELOBJECT Places the selected object into the contour of the 
profile.  

BACKWARD Steps back with one command if you make a 
mistake. 

FORWARD Steps ahead with one command. 

INVERSE Places beam reference line to the other side. 
 
In the Beam properties dialog use the Enable to adjust ends in beam chain option if you want to connect the ends of 
beams: 
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Adjust ends enabled 

 
Adjust ends disabled 

 

� You can modify the adjust ends enabled beams to disabled, but if you didn’t switch on the adjusting advanced, you can’t 

set the adjust ends enabled afterwards.   

1.65.11. Open chain of beams 

This command works analogous with the Closed chain of beams command. The only difference is that the chain won’t 
be closed by the program automatically and the adjustment of beam ends will not work in the last node. 
You can use this command to create footing, so the footing will get to the structure objects, when listing. . 

1.65.12. Truss 

 
In architecture and structural engineering, a truss is a structure comprising one or more triangular units constructed with 
straight slender members whose ends are connected at joints referred to as nodes. 
ARCHLine.XP® manages planar truss where all the members and nodes lie within a two dimensional plane.  
For more details about truss see http://en.wikipedia.org/wiki/Truss. ARCHLine.XP® enables you to place truss on the 
current layer. 

 Truss preferences 

Before you place a truss, you have to determine its properties. 
The truss properties can be set in the Building - Properties - Truss dialog. 
After the selection of command a dialog window appears with properties of Truss.  

General properties 

First there are the general properties of the truss: layer, colour, line type, line width, priority.  

Structure Type 

You can select the following types:  
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Vierendeel, Brown, Howe, Pratt, Warren 1, Warren 2. 

 

Relative height 

The height of the actual floor compare to its 0 level. 

Middle height 

The distance between the under and upper belt in the middle of the truss. 

Middle elevation 

The height of the middle point of under belt compare to the height of the side points. 

Symmetric 

In switched on status the length of the truss right and left side, the height of the truss on the two outside points, and the 
number of right-and left side divisions are the same. You can define these parameters separately in switched off status.   

Divisions 

The number of perpendicular beams, that connect the under and upper belt on the right or left side. You can set the height 
of the right side only in that case if the Symmetric button is switched off. 

Side height 

The distance between the under and upper belt on the right or left side of the truss: You can set the height of the right 
side, if the Symmetric button is switched off. 

Side width (%) 

The length of the right or left side compare to the length of the truss, expressed in %: You can set the height of the right 
side, if the Symmetric button is switched off. 

Profile sections 

Trusses are characterized by their cross-sectional profile. Therefore first select the cross section in the Select profile 
dialog box and specify the cross-sectional parameters of the column. You can assign profile for the following parts of the 
truss: 
Bottom, Top, Side, Vertical, Diagonal 

� For a detailed description of the Select profile dialog box see Chapter 8.9.10. Select from list. 

Cost parameters 

You can assign cost parameters to the truss, as to any other objects.  
You can create beam-structures with truss. 

 Placing truss 

After setting the truss properties  
 

• You can place truss in 2D drawing and 3D view as well. 
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• Specify the starting point then drag the cursor in the proper direction and define the endpoint of the truss. 
Beside the endpoint appears the profile of the truss, which signs the active reference point. 
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1.66. Door, window  

Introduction 

ARCHLine.XP® contains the set of door and window models organized into categories in the Door and the Window 
folders. All types have parameters, which can be changed when defining the properties. This way you can place the same 
object with different values on the drawing, without increasing the size of the directory. 
However, there cannot possibly be a directory that contains each and every measured or individual door/window. 
Therefore, as you will see, the program offers you the possibility to create individual doors/windows. 
After selecting the appropriate type of door/window and its properties, the functions of the Door/Window tool allow to 
place the doors/windows in walls, and modify them, as necessary. 
You can place a door/window on walls of any shape, both on their straight and arched sections. The doors/windows adapt 
to the modifications of the wall they belong to. 
In ARCHLine.XP® doors/windows are represented by 2D symbols, the representation of which depends on the value of 
the door/window scale. This can be defined by the View menu - Opening and wall scale command. 
The door/window connects to the wall and cannot be separated from it; it is placed on the layer of the wall (except if you 
have placed it with the   Door/window without wall icon). 
 

 
 

 

Custom doors/windows 
ARCHLine.XP® allows the architect to create a door or window with an individually drawn form. 
 

� The doors/windows created with the Define custom door/window command are saved in the directory, so they can be 
used in any other drawing. 

� With the Edit corner window command you can design a door/window with individual shape and divisions on any wall or 
wall corner. You can use it even on an arched wall, where the glass will also be arched. An object created with this 
method is not part of the directory. 

� Full curtain wall: You can transform the wall to full curtain wall. Just use the Wall shortcut menu - Full curtain wall 
command. 
 

   

1.66.1. Door/window properties 

Before you place a door/window, you have to define its properties. 
Properties can be activated by selecting the Building - Door/window tool, with a right-click on the icon, or by activating 
the Building menu -Properties - Door/window command. 
 

� You can select the openings from the Design Center too. See chapter 2.16.9. Design Center. 
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The door/window properties dialog box appears. Here you can set the properties which are the most important for you to 
appear in the dialog box. 
 
The properties of the window are basically the same as those of the door. 

 
You can select the type of door/window from the categories and set the current geometric values for the selected 
door/window, its material, etc. Any change in the dialog box is valid globally, which means that the doors/windows installed 
subsequently in the drawing will have similar values to the ones defined here. 
 

 
 

� Doors/windows created with the Define custom door/window command also appear among the types. These have only 

three variables (X, Y, Z values), all the other values are fixed. 
 
The properties of doors/windows are discussed under the following headings: 

 Select the type of the door/window 

Select a category within the door/window directory, and select a type from the list there. Then you see the 2D symbol, the 
3D image and the geometrical parameters of the selected type, which can be modified, as necessary. 

 Main and other parameters 

With clicking on the height, width, thickness fields, you can modify the main properties of the selected door/window. 
 

� Doors/windows other parameters become visible when you activate the Show other parameters checkbox. 

 

 
 
With double-clicking on the other parameter value, you can modify that. 
Among the parameters threshold thickness and opening angle need to be discussed in more details. 
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With the Show min-max values option in the File menu -Options -Other dialog it is possible to display the range of 
parameter values in the doors, windows and object properties dialogs. 
This helps by specifying parameter values. 

Threshold thickness: 

This value influences not only the 3D model but the 2D representation as well: 
  
Threshold thickness = 0: Threshold thickness = 0.02 
 

   
 

Here 1:50 is set as the scale of the door/window in the View menu. 
 

Door/window angle: 

Doors/windows can be open. You can 
enter a value between 0º and 90º. For 
the most part of the window you can 
also define a value between 0º and -
15º, which means that the window is 
represented as a hopper window. 
This parameter only affects the 3D 
model.  

  

Materials 

• Define the material of the door/window. 
Double-click the name of the material and the 
Material dialog box appears. Here you can 
define the materials of the objects. 

 

 

� See also chapter 3.2.2 Material properties. 
 
If you modified the parameters of the selected door/window, press Redraw to see the result of modification in the dialog 
box. 
 

� When you set the other parameters, the program verifies the specified values on the basis of various internal criteria. If a 

value fails to meet the criteria, after clicking the Redraw button the program informs you that the values cannot be 
accepted and restores the original settings. 
Therefore we suggest that if you alter more parameters you should click the Redraw button after each value definition so 
that the program can instantly indicate if it accepts the specified value or not. 

Parameters of instalment into wall 

� Distance from wall line 
The distance between the frame of 
the door/window and the wall 
reference line. 
 

 
 

� Parapet height 
The program measures the parapet height from the bottom of current level, and not that of the wall. 
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In the picture the wall starts at 20 cm height. 90 cm have been entered for parapet height, which means that the distance 
is 70 cm between the bottom of the wall and that of the window. 
Of course, you can also decide to define the internal floor elevation in the Door/window properties - Dimensioning 
dialog box. 

Different interior and exterior sill height 

You can define the interior and exterior sill height separately relative to the finished floor level or the external slab level. 
When you assign dimension to the door or window the displayed sill height value depends on the size of the wall where 
you click on. 

 

 

 General properties 

Define the colour, line type, line width and priority of the door/window. You can edit the Distance from wall corner 
when you modify an existing door/window. This field is disabled at definition. 

 
 

� See:  
� the detailed description of the general properties in chapter 3.2.1. Specifying general properties, 
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� the description of sets in chapter 3.2.3. Using sets of properties. 
� the description of cost variables in Chapter 3.2.4. Assigning cost variables. 

 Door / Window Frame around - Lining and architrave 

You can assign frame to the inside or the outside of the doors or windows, and specify cross section. 
The frame is the property of the door or window, so it stays, when you copy it. You have to specify separately the inside 
and the outside properties of the frame 

Frame properties 

You can assign full frame or down open frame. 
The cross section can be rectangular or profile selected from the library. 
You can put covering between the frame and reveal, and you can assign thickness and material to it. 
If you don’t assign any material to the frame or covering, then it copies its material from the wall. 
Click on the Door / Window Properties - Lining and architrave button to define the frame properties. 
 

 
 

 

Changing the position of the cross section 

• After clicking on the door / window on the floor plan the profile of the assigned frame is displayed. 

• You can mirror or rotate the profile by clicking on the profile and choosing Mirroring or Rotate keywords in 
the command line. 

• Enter finishes the command. 
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The advantage of the method is (contrary to changing Insert profile window in the Property window) the result of the 
changing is viewable on the floor plan as compared to the door or window, so it is evident. 
 
Expanding frame                                           Tapering frame 

   
 

              
 

Show on floor plan - lining and architrave 

You can display the lining and architrave section on the floorplan. It makes easier to place elements like switches 
and sockets more precisely. 

 
 

 

 Visualization group 

When you click the  sign in front of the Visualization group, you can specify the following properties: 
 

 
 

Where names are followed by the icon, double-click the name or click the  icon to see the dialog box. 
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Representation in 3D 

If you switch this function off, the 3D model of the door/window does not appear. 
The door/window will only have a 2D symbol, the contour cuts an opening in the wall in the 3D model, but there will be no 
3D representation. 
This can be useful when drawing staircases for instance. This way the door/window installed on the ground floor has the 
full height, it has got a 2D symbol, and also a 3D model. The window on the next floor has no 3D representation, but it has 
a 2D symbol. The contour of this window cuts an opening in the wall, which is filled by the full height door/window installed 
one level lower. 
 

 

Reference line 

If you switch on the options the program draws the external and internal reference line of the wall at the door/window.  
You can define the type of the internal/external reference line from the pull-down list: 
 

 
 

 

Threshold line type 

In case of doors we can represent the line of threshold on the openings’ floor plan symbol, if we determine the height of 
threshold (>= 1 mm) between the parameters. (Naturally the threshold will appear in the 3D model too.) 
In case of parametric doors in General category, there is a possibility to represent the threshold’s line with the external, 
internal reference line type (for example: in case of hidden threshold). 
 

• Set the thickness of threshold among the door parameters. 

• Switch on the external, internal reference line. 

• Select the reference line type. 

• Switch on the Use reference line type for threshold 

•   
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3D fixed 

If you use the Modify menu - Lock architectural object in 3D command to lock the 3D image of a door/window to a wall 
for instance, the 3D fixed option is switched on. By switching it off you can unlock the object. You cannot switch on the 3D 
fixed option in the dialog box. 
 

� For a detailed description see chapter 8.5.6. Locking in 3D 

Form reveal - Bend layers 

You can define a door/window by a reveal. To do so, you need to define the reveal width among the parameters you set 
when installing into wall. 
Reveal width means the overhanging of the external side of the wall on the frame of the door/window. It equals the total 
width of the bending wall layers. 
 

 

 
 
If the reveal width is higher than zero, 
the program displays it by default as 
shown in the picture; wall layers are 
not bent to the frame of the 
door/window. 

 
In the case of layered walls you need to bend layers to form a reveal: 
Layers can only bend if: 
 

� the wall containing the door/window consists of at least two layers, and 
� the value of reveal width is not 0. 

 

• Define reveal width in the 
Parameters group: 0.1 m 

 

• Click the Bend wall   icon to 
see the dialog box appear. 

• Select from the list the number 
of wall layers you wish to bend 
to the frame (max. 6). 

• Define the width of each layer to 
bend. The total of these values 
cannot exceed the reveal width 
of the door/window. 
 

 
 
The width of wall bending can 
be 0 as well: 
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Opening Direction 

In the windows properties dialog you have the possibility to specify the possible opening directions. In ARCHLine.XP® you 
have the option to represent these opening directions in the 3D model of windows by drawing opening direction symbols 
on windows. This can be very useful in case of more detailed façade drawings. 
 
There are two prerequisites to represent the opening direction symbols in 3D: 

� The represented window should be closed. You can set this in the door/window properties dialog. 
� The Draw opening direction option checkbox must be checked in the Build 3D model dialog. 

 

 
 

 

2D shape - For doors only 

You can choose from among six different 2D 
shapes for the doors. You can apply them for 
various types. 
Ways of visualization depend on the scale of 
representation. Scale can be set in the View 
menu - Door/wall and wall scale dialog box. 

Click the 2D shape  icon to see the dialog 
box: 
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 Standard frame 

 

 Timber lining frame 

 

 Metal frame of angle 

 

 Simplified standard frame 

Same as the representation of pocket frame, but it is simplified in 1:100. 
 

 
 

 Shadow line frame 
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 Opening direction: dashed line instead of an arc 

 

 Simplified symbol 

 
 

� In 2D representation threshold appears, if, among the main geometrical parameters, the value of threshold thickness is 

not 0. 

Dimensioning 

When you click the Dimensioning  icon, the dialog box appears where you can specify the dimensioning properties of 
the door/window. 

The Dimension  Dimension - Openings command places the dimensioning of the door/window with the values set 
here. 
When you switch on the Associate a dimension to the opening option, dimensioning will also appear automatically 
when placing the door/window. 
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Specifies the parameters fitted to the dimension. 

 
By clicking the icons: 

 
 

Dimensioning is parallel with the 
direction of the door/window. 
 
You can specify the distance of the 
measurement line in the field. This 
value can be negative as well, in that 
case dimensioning is put on the other 
side of the door/window. 

 
 

Dimensioning is put on the axis of the 
door/window. 
 
This way you can define the length of 
the line at the side of the text or on 
the other side. You cannot enter a 
negative value here. 

 

If you switch on consignation, you can 
enter a number in the dimension 
circle of the door/window. If the 
number is 0, the program replaces it 
with the ID number of the 
door/window in the field. 
You can complete the consignation 
number with an alphanumeric 
expression.  

 
 

 
External dimensioning of the 
door/window (with frame). 

 
 

Internal dimensioning of the 
door/window (width of casement, 
which means the width of the 
door/window without frame). 

Height minus reveal on top/bottom (where exist) 
When you use reveal for the opening, you can define, the height of the opening contains the reveal or not. 
You can switch on / off the Height minus reveal on top/bottom (where exist) option: 
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OFF 
 
 
 
 
 
 
ON 

 
 

� If you use an opening with rectangle form, you have to set the state of the chamfer to go on the top or 

around also. 

Height minus frame 
By switching on this option the height of the door/window is calculated without its frame. 

Height plus sill 
With this option you can decide whether or not to include the height of the threshold in the height of the door. In case of 
windows it is important if the parapet wall under the window is removed and replaced with the structure of the window. In 
this case the total height of the window has to contain the height of the parapet wall („threshold”) as well. 
 

 
Here you can decide whether to 
change the width of the window 
when forming the reveal. (According 
to the standard you should keep this 
option switched on.) 

  

 

When the Parapet height option is 
switched on, the parapet height is 
also entered after the text given in 
advance (for instance: ph =   ). 
You can enter the internal floor 
elevation in meters. This way the 
parapet height is measured from this 
level. 

  Parameters group 

External, internal sill: can be switched on, values can be specified: 
 

• width: 
Defines the width of the 
external/internal sill, measured 
from the external/internal frame 
level overhanging (ext): 

overhanging of the 
external/internal sill, parallel with 
the wall. 

• height 

Specifies the thickness of the 
external/internal sill. (The upper 
level of the sill is the same as the 
lower level of the window.) 
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• material: material of the 
external/internal sill can be 
specified. 

 
 

� The sill only appears on the floor plan if the door/window scale is 1:50 or 1:20 (View menu). 

 

 Reveal group 

Reveal width 

Overhanging of the external side of the wall on the frame of the door/window. 

Chamfer types 

It is possible to create a door/window with a chamfer. You can modify the opening-wall connection line with the Move 
insert point command from the Shortcut menu – Wall connection. 
You can create various types of chamfer: 
 

 

 
The chamfer is created only on the two sides of the 
door/window. 
The chamfer is created on the two sides and the top of 
the door/window. 
The chamfer surrounds the door/window. 

Material of wall connection 

This command can be important when working 
in 3D view. The material of the wall ending 
around the door/window can be set here. 
Material (switch off), this material is the same 
as the wall texture. Once you have turned on 
this option, by clicking the name you can select 
another material for the wall connection from 
the Material dialog box (for instance Wall 
paint) instead of the current material. 
 

 

  

Void underneath 

Gap under door (called void underneath) is a technical extension of the door opening hole at the bottom side of the door. It 
extends the door hole in the wall by a value defined in the properties dialog. It can be used to make space for floor layers 
to create the proper connections. 
 
The void underneath value can be found in the Door properties dialog, in the Wall connection section. Its default value is 
Zero. 
 
Door with void underneath as 100 mm: 
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 Parameters of placing 

Reference axis 

 
 

It installs the door/window by its 
corner point. 
It installs the door/window by its axis. 

 

� When using the   Install door/window from wall corner command, press TAB to change the Reference axis 

defined here. This way you can also select the other corner point as reference axis. 

Sign 

The program puts the value entered in the box parallel with the door/window. If a # character is entered, parapet height 
appears. 
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Distance from wall corner 

When setting the properties, this field appears in gray in the dialog box. If you want to modify the door/window that you 
have already installed it in the wall, the Door/window properties dialog box shows the distance of the Reference axis of 
the door/window from the wall corner. Now you can modify the distance between the door/window and the wall corner. 
 

 

 Multiple bubbles for openings 

Enhanced Detail Bubbles—Control the appearance and placement of bubbles on custom form for even more graphic 
detail.  

     
 
The bubble radius is defined in % relative to the text size.  
Further display and layout options: 
 

 
 

1.66.2. Installing a door/window 

It is useful to install the window on the internal side of wall by default. This way its floor plan symbol (scale 1:20), the 
door/window dimensioning, the opening direction of window casement in the 3D model, and, in case of a window with 
reveal, the reveal is put to the appropriate place. 
In practice, however, you often know the external values only, so it is more useful to install the window on the external 
side. In such cases, the door/window has to be mirrored to obtain a correct representation. 

Ways of installing a door/window: 

� by defining the distance between the nearest wall endpoint and the door/window. 
� to the left or to the right from a given point of the wall, 
� by defining to points on the wall, thereby determining its width, 
� as an individual object, independent of a wall, 
� on a given roof plane, 
� by creating an individual door/window, and installing it anywhere in the wall, even as a corner window. 
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Reference points 

 

The door/window is connected to the wall by its 
reference points. Every floor plan representation 
contains four reference points (two at both wall 
connections). The door/window appears on the 
external or the internal side of the wall depending 
on your choice of side at the time of installing the 
door/window. 

 

By default, reference points are created 
perpendicular to the internal wall, but you can 
move them with the help of the Move insert 

point command. 
 

Reference axis 

The reference axis can be the right or left reference point, or the middle axis of the door/window. The program installs the 
door/window by the reference axis set in the Properties dialog box. In the case of Install door/window from wall corner 
command, press TAB to change it. 

Opening direction 

The opening direction of doors can be modified by clicking on the required side, or later using the Change opening 
direction command in the shortcut menu. 
 

 

You can install a door/window: 

� using the icons of the Toolbox - Door / Window tool: 
 

 
 

 
 

� using the Building – Door or Building – Window menu commands: 
 



 10. Building model 421 

ARCHLine.XP® 

 
 

 
 
 

� from the Design center: 
 
Dragging the object to the drawing area 
with the right mouse-button; you can 
select the placement type from the list 
appearing. 
 

 
 

 

 Place door/window from wall corner 

With this command you can install the door/window in several ways: 
 

� graphically on the floor plan, 
� at a given distance from one wall endpoint on the floor plan, 
� at a given distance from one wall endpoint by repeat on the floor plan, 
� Graphically in 3D view. 

Installing by graphically on the floor plan 

• Select the wall where you would like to place a door/window. 
 
When you move the mouse pointer, the program indicates the distance of window endpoints from wall endpoints. The 
window can be moved by the set snap spacing. 
With this method you can define the place of the door/window graphically. 
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You can switch on and enter snap 
in direction in the File menu -
Options -Snap Grid dialog box 

 
 

 
 

• Before you insert a door/window, press TAB so that you can switch the reference axis of the door/window. 
Thus by selecting the other corner point as reference axis, moving by snap in direction also takes place in 
relation to the other corner point of the wall. 

 
 

• If you click on the MIRRORING keyword, the program will mirror the openings on the wall. 

• Use the keyword if for example you clicked on the external side of the wall to place the window, because the 
external size is available.  In this case You have to mirror the window to be- it’s floor plan symbol (1:20 
scale), the scale of openings, the opening direction of the casements in the 3D model, or in case of reveal 
window the place of the reveal -in the right place. 

• Place also graphical the opening. 

• In case of door click on the placed opening to set the proper opening direction. 
Enter Finish opening direction selecting. 
Enter Finish the command. 
 

Installing by a given distance on the floor plan 

• Select a wall where you would like to place a door/window.  

• When you move the mouse pointer, the program indicates the distance of window endpoints from wall 
endpoints. 

• Pressing TAB, the reference axis of the door/window can be changed, if needed. 

• By clicking MIRROR the program mirrors the door/window on the wall.  
 

• Instead of inserting the door/window graphically, enter the distance between the reference axis of the 
door/window and the wall corner point.  
 
If the reference axis is on the axis of the door/window, the program records the distance from the wall endpoint closer to 
the click. 
If the reference axis is a corner point of the door/window, the distance is measured from that wall corner point between 
which and the reference axis the wall section does not contain the door/window to be inserted. 
 

• Enter Finishes selecting the direction. 

• Enter Completes the command. 

Installing on the floor plan with repeat: 

• Select the wall. 

• Select the REPEAT keyword. 

• Enter the number of copies: e.g. 4. Enter.  
Enter the distance between the doors/windows: e.g. 1. 

• Enter the distance from the selected wall node: e.g. 2 m. 

• In the case of doors, click on the installed door to set the appropriate opening direction. 

• Enter Finishes selecting the direction. 
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• Enter Completes the command. 
 

 
 

� When installing a door/window, a message may warn you if it is outside of the wall, or intersects other objects. When 

using the REPEAT keyword, the program inserts only that number of doors/windows for which there is enough room 
without intersecting other objects. 
 

� When you insert a door/window with repeat, the program uses the reference axis set in the Door/window properties 

dialog box. 

Installing in 3D view: 

• Activate the 3D window, 
and, after selecting the 
command, click a 
vertical plane of the wall 
where you would like to 
place the door. 

• Place the door/window 
on the wall plane. It 
places the opening 
always to the given 
parapet height in 
relation to the layer.   

Enter Completes the 
command. 
 

 

Option: 

SOLID Use this keyword, if the selection of the surface is not evident. 
Click the appropriate wall, then one of its vertical surfaces. 
Enter. 

 Installing door/window by drag and drop 

By this command you can install door or window mostly graphically on the floor plan or in 3D. 

Installing door/window on the floor plan 

• Move the mouse pointer over a wall or use the Wall keyword to select a wall where you would like to place a 
door/window. When you move the mouse pointer, the program indicates the distance of door/window 
endpoints from wall endpoints, reference points of placement and opening directions. 

 
• Using the mouse pointer and/or keywords and/or entering the distance values you can define the final place 

of door/window. 

• Use the Repeat keyword and then enter the required distance values to place multiple doors/windows with 
equal distances from each other. 

• Click with your left mouse button to finish the placement graphically or press ENTER to finish entering the 
distance value measured from wall endpoint.   

• In the case of doors, click the door installed to set the appropriate opening direction. 

• Install subsequent doors/windows or close the command by ENTER or right mouse button click. 
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Installing in 3D view  

• Use the mouse pointer to select a wall plane where you would like to place door or window. 

• Using the mouse pointer and/or keywords and/or entering the distance values you can define the final place 
of door/window. 

• Click with your left mouse button to finish the placement graphically or press ENTER to finish entering the 
distance value measured from wall endpoint. 

• Install subsequent doors/windows or close the command by ENTER or right mouse button click. 

 Place door/window to arbitrary point 

This command installs the door/window by putting its reference axis to a selected point of the wall. 
The program uses the reference axis set in the Door/window properties dialog box. 
 

• Select a reference point on the wall where you put the reference axis of the door/window. 

• When the reference axis is other than the middle axis of the door/window, select in which direction to put 
the door/window from the reference point. Click the appropriate direction. 

• In the case of doors, click the door installed to set the appropriate opening direction. 

• Enter Finishes selecting the opening direction. 

• Enter Completes the command. 
 
Reference point Direction 

  

To a given distance from intersection point  

By usi 

 Place door/window by two points 

This command allows you to insert a door/window by defining its width graphically, giving its starting point and endpoint. 
This way the program ignores the width values set in the Door/Window properties dialog box. 
 

• Click a point of the selected side of the wall to define the place for the endpoint of the door/window. 

• Drag the mouse pointer in the appropriate direction, and click on the appropriate place to define the place 
of the other endpoint, thereby specifying the width of the door/window graphically, or after selecting the 
direction enter the width of the door/window: 1 m. Enter.  
The program inserts the door/window in the wall. 
 

 

 Door/window non-hosted by wall. 

With this command, doors/windows can be placed to arbitrary places as individual objects, non-hosted by wall. 
 
Door/window is typically an architectural element. Receiving project from structural engineers this method makes 
unnecessary to go in and place doors in structural walls. 
 

• The command warns you that the doors/windows installed from then on are created without wall 
connection. 

• OK Close the warning dialog box. 

• Install the door/window. 
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Options: 

XANGLE Rotates the door/window by a given angle before 
placement.  

GRAPHIC Enter the origin of the door/window, and then define the 
direction of its axis graphically. 

 

Enter Completes the command. 
 

� The opening direction of doors installed this way, can only be changed by the Shortcut menu - Change opening 

direction command. 

 Place roof window 

With this command you can place a roof window on the selected roof plane. The program identifies the angular offset of 
the roof plane, and cuts an opening in the roof under the window. 
 

• Select a roof plane where you wish to place the roof window. 

• Select the required window type from the Roof window category in the appearing dialog box. Ok. 

• Select the place of the roof window. 

• Enter Completes the command. 
 

� The Roof shortcut menu- Info - Level line -out and - Info - Level line -in command can help installing windows more 

precisely. 
 

 

Modify roof window 

Click on the roof window, in the toolbox the Property manager visualizes the individual parameters: 
  

 
 

• Define the required parameters: 
 

� Distance from roof plane: Defines the distance between the plane of the window and the roof plane. 
� Top hole: In the pull-down list you can decide about the top hole of the roof window in relation to the roof plane:  

Perpendicular  
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At angle 

Horizontal 
� Angle of top hole: If you define the top hole with angle, the value of the angle means the angle from the horizontal plane 

upwards. 
� Bottom hole: In the pull-down list you can decide about the bottom hole of the roof window in relation to the roof plane:  

Perpendicular  
At angle  
Vertical 

� Angle of bottom hole: If you define the bottom hole with angle, the value of the angle means the angle from the vertical 
plane towards the roof plane. 
This way you can define the following roof window - roof connection: 
 

  

 Design center - Doors/Windows 

If you activate the Design Center it 
appears on the left side of the screen by 
default. Here you can select the Doors and 
Windows directory where the door/window 
types are classified into different categories 
(so-called .oli files). 
 

� For the detailed description of the 

Design center see Chapter 2.16.9. 

Design center. 
 

 
Doors/windows already selected and assigned the appropriate properties can be placed on the drawing by dragging. This 
is the so-called ‘drag and drop’ method, which, in the case of doors/windows, consists of the following steps: 

Inserting with a right-click 

• Right-click the appropriate door/window. 

• Hold the right mouse button, and drag the object to the drawing area. 

• Release the button. Select the way of placement from the appearing shortcut menu: 
 

 
 
The program will install the door/window according to the selected placing command. 
 

� If you continue dragging the object to the drawing with the left mouse-button, the placing command already selected 

from the list is activated automatically. 
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Inserting with a left-click 

• Left-click the appropriate door/window. 

• Hold the left mouse button, and drag the object to the drawing area. 

• Release the button. 

• This will activate the door/window placing command already selected when dragging with a right-click. 

 

1.66.3. Edit or modify doors/windows 

The commands below modify doors and windows in the drawing. You can select these commands:  
 

� from the Shortcut menu which can be accessed with a right-click on a door or window 

 
� Using marker 

Clicking on the opening the marker appear 

 

 

 

 Move door/window in wall 

With the help of this command you can move the selected door/window in different ways: 

Move graphically on the floor plan  

• Select the door/window you would like to move. 

• When you move the mouse pointer, the program indicates the distance of window endpoints from wall 
endpoints. The window can be moved by the set snap spacing.  
With this method you can define the place of the door/window graphically. 
You can switch on and enter snap in direction in the File menu -Options -Snap Grid dialog box. 
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Move by a given value on the floor plan 

• Select the door/window you would like to move.  

• Move the mouse pointer in the appropriate direction, and enter the value of the distance. 

• Enter Completes the command. 

Options: 

ENDDISTANCE You can place the reference axis of the 
door/window at a given distance from the selected 
wall endpoint.  

 

� On the floor plan, the active reference axis of the door/window is the one which is near to the selected door/window. 

In 3D: 

You can move a door, a window, or even a roof window directly in 3D view, horizontally along the wall. The floor plan 
representation of the moved object follows the modifications. 
 

• Click on the door/window with mouse right click, 

• Select from the Shortcut menu the Move in wall command. 
You can switch between reference points with the help of the PREVIOUS and NEXT keywords. 

• Move the door/window to its new place. 

  

Move using markers 

 Arrow control - Moving opening control  
 
Clicking on the arrow control you can move the opening. 
 

• Click on the arrow control. 

• Move your mouse cursor to the desired position and click again (for graphical movement) or use your 
keyboard for entering the shift value. 

In 2D: 
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In 3D: 

 

Dimension text control - Distance modification 

In case of the openings the dimension text control displays the distances from the wall endpoints. You can change the 
distance typing a new value. 
 

 
 

• Click on the dimension text and type the new value in the popup editing field.  

  Resize door/window 

The command changes the width of the selected door/window. The command can be used both in 2D and 3D view. 

In 2D: 

 
•  

• Select from the Shortcut menu the Resize command  

• By moving the mouse pointer, define the new width value for the door/window, or  

• Enter a relative value by which you wish to increase or reduce the width of the door/window. 

•  

 
In 3D: 
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• Click on the door/window in 
the side of the door/window 
you would like to move with 
mouse right click 

• Select from the Shortcut menu 
the Resize command 

• Define its new place with the 
help of the mouse to resize 
the door/window in 3D. The 
door/window 2D 
representation follows the 
modifications.  

•  

 

 Create similar door/window 

When you select a door/window installed earlier, the program puts its copy to the required place.  
The command can be used both in 2D and in 3D view. Wall connection is also copied. 
 

• Click on the window with mouse right click. 

• Select from the Shortcut menu the Create similar command.  

• Select the UPPER or BELOW keyword from the command line, if you would like to copy the door/window to 
another floor. You can step up or down any number of floors. 
 

 
 
The program records the type and parameters of the selected door/window. The Place door/window from wall corner 
command is activated afterwards. 
 

 

 Copy properties - one by one 

The program copies the properties of the selected doors/windows to the required doors/windows. 
This command can be used both in 2D and in 3D view. The program also copies the wall connection. 
 

• Click on the door/window with the required properties with mouse right click. 

• Select from the Shortcut menu the Copy properties / One by one command  

• Select the doors/windows you wish to modify. 
Enter Closes the command. 

Options: 

BELOW Select a door/window one floor lower. 

UPPER Select a door/window one floor higher. 

 
For Copy properties of doors/windows, this command and its further subversions can be found in the Shortcut menu. 
These are the following:  



 10. Building model 431 

ARCHLine.XP® 

 

 

To all similar on current floor 

The program copies the properties of the selected door/window to all other doors/windows of the same type on the current 
floor. 

To all similar on all floors 

The program copies the properties of the selected door/window to all other doors/windows of the same type on all floors. 

Modify and copy to all similar on current floor 

With this command you can modify a door/window, the properties of which the program later copies to the other 
doors/windows on the current floor automatically. 
 

• Select a door/window which shows the properties you wish to copy to the other doors/windows. 

• The Door/window properties dialog box appears, where you can define the required values.  
Ok Closes the dialog box and copies the properties. 

Modify and copy to all similar on all floors 

With this command you can modify a door/window, the properties of which the program later copies to the other 
doors/windows on all floors automatically. 
 

� When the Shortcut menu - Copy and paste command is used, the UPPER and BELOW keywords can be selected from 
the command line; the door or window can be copied to another floor. 
 

� If you would like to copy the properties of doors and windows you can also use the Modify menu - Copy properties 
command. In this case you can select which properties of the door or window you want to copy. 
 

 Move insert point 

With this command you can move the connection points of the door/window on walls to create a chamfer. The chamfer 
belongs to the door/window, and not to the wall, which means that it cannot be changed by editing the wall or moving the 
door/window. When copying properties of the door/window, this property is also copied. 
 

• Click on the door/window 
near to the corner point of 
the door/window that you 
would like to move with 
mouse right click. 

• Select from the Shortcut 

menu the Wall connection / 
Move insert point command. 

• Specify the new place of the 
corner point on the wall, or 
define the distance of the 
corner point’s displacement 
after moving the mouse 
pointer in the required 
direction. 
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• Select another door/window 
corner point to move, or 
press 
Enter Completes 
the command. 

 

 

  

Options: 

 

ENDDISTANCE Defines the distance of the corner point measured 
from the selected wall corner. 

 Complex editing 

With this command you can edit the connection between the window and the wall. The program offers the options of the 
Profile editing tool, with the help of which you can edit the connection. The only limitation is that the edited profile cannot 
fall outside of wall thickness. 
 

• Click on the door/window near to the corner point of the door/window that you would like to edit with 
mouse right click. 

• Select from the Shortcut menu the Wall connection / Complex editing command. 
  

! Warning! Don’t select the corner point of the door/window! 

 

• Select an editing command from the Toolbox - Profile editing tool.  

� See the description of the Edit Profile tool in Chapter 8.9.9 Editable profile. 
 
In the course of editing the program retains the original contour and indicates modification. 
 

Enter  Finishes editing. You can select another connection point of the door/window to create a 
chamfer, or  

Enter Finishes the command. 
 
In order to create the chamfer shown in the 
picture, first use the Move corner point 
command, then add nodes with the Edit 
door/window-wall connection command, and 
finally use the Line > Arc command to chamfer. 
When editing is complete, the finished chamfer 
appears. 
Apply the Mirror door/window-wall connection 
command to create a chamfer on both sides of 
the door/window.  
 

 

 

Add new point  

If you only want to add new points to the wall connection when the chamfer is edited, use the Shortcut menu - Add new 
corner point command. 

Examples: 
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 Delete door/window-wall connection  

This command deletes the door/window connection points created earlier from the wall, and restores the default 
connections. 
  

• Click on the door/window with mouse right click. 

• Select from the Shortcut menu the Wall connection Default command  

• Select the door/window you would like to delete the chamfer. 
Enter Completes the command. 

•  

 
 

 

 Mirror door/window-wall connection 

This command mirrors the selected corner connection point of the door/window on the axis of the door/window. 
  

• Click on the door/window with mouse right click. 

• Select from the Shortcut menu the Wall connection Mirror command  

• Select that corner of the door/window whose connection you wish to mirror. 
Enter Completes the command. 
 

 
 

 

 Area of doors/windows  

Calculates the area of the selected doors and windows, and totals the result. The identification number of the 
doors/windows is indicated in the list in brackets. 
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• Select the required doors/windows. 

• Enter Completes the selection. 
 

The command creates a list containing the type, identification number and area of all selected doors and windows, and the 
total area of all doors and windows. 
 

 
 

Press the Copy to clipboard button to transmit these data to Word or Excel.  

 Change opening direction 

Changes the opening direction of doors installed earlier. 
 

• Click on the door with mouse right click. 

• Select the two triangles marker. 

• Select the appropriate command. 
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 Mirror 

The command mirrors the selected door/window on the wall. 
 

• Click on the door with mouse right click. 

• Select the two triangles marker. 

• Select the appropriate command. 
 

 
It is useful to place the window on the internal side of the wall by default. This way its 2D symbol (scale 1:20), the 
dimensioning of the door/window, the opening direction of the casement and, in case of a window with a reveal, the reveal 
is put to the appropriate place.  
 

However, in practice the architect 
often knows external values only, 
so it is more useful to place the 
window on the external side (for 
instance 1.50 m).  
 
In this case use the Mirror 
command to obtain a correct 
representation in the 
abovementioned cases. 

 
 

! Don’t mix up the mirroring with the opening direction change! 

 Convert to door/window 

By activating this command the Door/window properties dialog box appears. You can select a door instead of a window, 
or a type of window instead of a door. 
  

• Click on the door/window with mouse right click. 

• Select from the Shortcut menu the Convert to door or the Convert to Window command.  
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 Survey 

In case of a survey you can connect or disconnect doors or connect rooms with the available commands. 
 

 
 

� For the description of these commands see also 15.5. Survey. 

 Doors and windows aligning in 3D 

You can align doors and windows on the same façade but different floors in the 3D window. 
The only requirement is that the walls on different floors (where you want to insert the doors/windows and make the 
alignment) must be identical. Also, the doors and windows must be placed on the same side of the walls. 
 
This command is very useful when you just drop the doors/windows on the façade in 3D window. In that case, of course, 
the distances from the wall corners are not correct. It is enough to specify the correct doors/windows positions on one 
floor, and then you can align the doors/windows on the floors below/above. 
 

• Activate a 3D view (axonometric, for example). 

• Click with your right mouse button on the door/window to which you want to make the alignment. 

• Select the Align command from the shortcut menu. 

• Select the door/window you want to align. 

• Repeat the command with each door/window by selecting the reference door/window first, and then the 
door/window you want to align. 

 

 

1.66.4. Define custom door/window 

If you cannot find any appropriate type of door/window among the objects of the directory, you can create your own 
door/window, as complex as you like. 
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The program offers you several ways of defining a door/window 
: 

� Define by 2D hatches:  
Defines a new object of the directory on the basis of the front view and 2D symbol of a door/window of any form.  
Draw the front view of the door/window in 2D. After identifying by different hatches the surfaces in different planes, define 
the thickness of surfaces, and select their place. Save the object created this way in the given category of the Door or 
Window directory. For this method use the Building or Toolbox - Accessories - Define custom door/window in 3D 
command, and enable the Define by 2D hatches option. You will have to provide the 2D symbol. 

� Define by solid modeller:  
You can use solid modeller, and save the solid created this way in the appropriate category of the door or window 
directory. 
To do so, use Building or Toolbox - Accessories - Define custom door/window from 3D model command, but this time 
disable the Define by 2D hatches option. When you use this command, it is your task to select the reference points.  
There is a fast way of creating the door/window from the solid model. To do so, use Building or Toolbox -  Door/Window - 
Simplified definition of custom door/window command. This way reference points are created automatically.  

� The Door Wizard 
Using the door wizard you can design complex door structures in a few steps. This tool is designed to offer simple and 
easy to use options and possibilities to create a new hinged door. It is possible only by setting the main properties such as 
the Handles, Materials (even photos of the original door), framing with profile, threshold with profile, additional object 
Accessories and Profile tool for decorating the door surface. 

� Edit in the layout of wall: 
You may often need an individual door/window that is not part of the directory, and is not needed anywhere else, which 

means you do not want to overload the directory with it. With the Building or Toolbox –  Curtain wall  Edit 
corner window command you can create a corner window drawn in 2D on the layout of the wall, or a divided door/window 
of any form. 
If the wall where you install the door/window is arched, the glass will also be arched.  
 

• Full curtain wall:  

You can transform the wall to the curtain wall using the Wall shortcut menu - Full curtain wall command see 
also 9.1.5.1. Full curtain wall. 

1.66.5. Define custom door/window - Define by 2D hatches  

With this command you can freely create as complex doors/windows as you wish, but it requires careful preparation. 
 
Preparations: 

� Prepare the floor plan symbol of the door/window. 
� Draw the front view of the door/window. 
� Assign the same hatch to surfaces in the same plane and with the same thickness. 

Using the Building or Toolbox – Accessories - Define custom door/window in 3D command: 
� Assign a thickness to the surfaces with the same hatch, and define the depth of position. 
� Define the contour that the door cuts from the wall in 3D. 

1. Preparing the 2D symbol of the door/window  

With the help of the geometric objects (lines, arcs, etc.) draw the 2D symbol of the required door/window with the 
appropriate values. The program will use this symbol to put the door/window on the wall. 
 

 
 

Defining a group: 

Create a 2D group by using the Tools 

menu - 2D group - Create command.  
Select the objects of the 2D symbol and 
define the reference points. This 
method requires four points, which will 
be the connection points between the 
wall and the door. The order of 

defining the points is important. 
Define the points following the 
numbers in the picture.  
Assign a name to the group in the 
appearing dialog box: door1, and save 
it to the appropriate category. 
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If you do not define any category, and the User defined category has not been created yet, press OK to create it, and save 
the group there. 
 

�  You can use an already existing 2D symbol as well: Apply the Door/window without wall command to install an 

appropriate door/window, which has the 2D symbol you can use. Convert it into lined drawing by Modify menu - 
Explode command. Watch out for the hidden lines that also appear on the 2D drawing. 

2. Creating front view for the door 

• Draw the front view of the door in 2D. 
Use the Drawing tool of the Toolbox (line, arc, 
etc.). 

 
Define the components: 
The components of a door include the frame, 
leaves, threshold, glass, etc., which all have 
different depth values.  

3. 2D hatch 

Identify the different components of the door with 
different hatches (for instance with a different colour, 
pattern, direction, etc.). This means that the same 
type of hatch is assigned to surfaces in the same 
level and of the same thickness.  

 

 

 

4 Using the Building or Toolbox - Accessories - Define custom door/window in 3D command 

 
Select the command. In the 
appearing dialog box: 
 

• Click the name of the 2D 
group. 

• Enter the name of the new 
door. 

• Enable the Define by 2D 

hatches option. Ok. 

• Select the 2D hatches with 
the same properties, i.e. 
surfaces in the same plane 
and of the same thickness.  
Enter  Completes the 

selection. 
 

 
A dialog box appears where you can define the 3D properties belonging to the selected parts of the door: 
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• Specify the width of the selected components. 

• Enter the distance of the component measured backwards from the median plane. This way you can define 
the distance of the parts with different hatches from the median plane.  
In this dialog box you can also modify the colour and material of the different parts of the door/window. 

• If the material of the selected component is glass, activate the Transparency option.  
Setting the resolution can be important in case you create an arched form in the door.  

• Define resolution. It is important for arched objects.  

• Ok Closes the dialog box. 

• Select other hatches with the same properties in the front view of the door, and enter the required values in 
the dialog box. 

• Go on selecting further hatches.  

• Enter Completes the selection. 

5. Defining the opening around the door  

• Define the profile that is the contour of the front view of the door. 
You can use the appearing Profile definition tool in Toolbox. 

Options: 

ENTER Select the ENTER option, if you wish to put the 
door/window in a rectangle-shaped opening. 

 

� For a description of the Profile definition, see Chapter 8.9. Specifying profile.  

 

• Example: Select the Polygon command, and outline the contour of the front view of the door. 

• Mark the reference point of the opening profile, by selecting the lower left corner of the front view of the 
door. This is also the first reference point of the door.  
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The program shows you the dimensions of the door, and asks if 
you would like to save the door you just created.  
 
The program saves the new door in the given category of the 
Door directory.  
 

 

 
 
If you do not name any category, and the User defined category has not been created yet, press OK to create it and save 
the door there.  

Create an opening  

The method is the same as above: 
 

• Draw the 2D form of the opening, and create 
the 2D group.  

 
• Draw the front view of the opening in the 2D 

window.  

• Apply the Building or Toolbox - Accessories - 
Define custom door/window in 3D command. 

• Select the 2D group: opening1 

• Enter the name of the new door: opening1. 

• Select the Openings option in the dialog box. 

 
 

 
 

• Define the profile that describes the contour of the front view of the opening around the door. 

• Select the Polygon command in the menu, and outline the external contour of the shape of the opening. 

• Select the reference point of the opening profile (lower left corner).  
This is also the first reference point. 
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The program shows you the dimensions of the door, and asks if you would like to save the opening you just created to the 
required category of the Door/window directory. 
 

 
 

 

 
 

1.66.6. Define custom door/window - from a 3D model 

First you have to prepare a 3D solid model of the required door/window. 
The complexity of 3D modelling allows you a great deal of freedom in creation. You can also define a door/window whose 
surface is not plain. 
 
Preparations: 

� Prepare the 3D model for the door/window. 
� Create a 3D group from the model. 
� Prepare the 2D symbol of the door/window  

using the Building - Accessories or Toolbox - Door/Window - Define custom door/window from 3D model command: 
� Select the 2D and 3D groups you already prepared.  
� Define the opening around the door.  

1. Create a model in 3D  

Create the 3D model of the door/window with the help of the solid modeller. 
 
For example: 
In order to extrude the two profiles in the picture use the Extruded solid icon: 

� for the front view of the frame of the door, and  
� for the left side view of the decorated central part of the door.  

 

         

2. Preparing the 2D symbol of the door/window  

Prepare the 2D symbol as described in 9.3.4.1. Define by 2D hatches. 

3. Creating the 3D group  

 

• Create a group in 3D by the 3D menu - Group 

in 3D - Define object command: 

• Enter the name of the group: newdoor1. 

• Select the solids constituting the new door.  

• Define the reference points of the 3D group 
according to the picture.  
If the reference points are the four corner 
points of the box enclosing the solid, it is 
enough to click the ENTER keyword.  

•  
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When you create a 3D group, 2D symbols are generated automatically as the top-view of the 3D model. These are a 
usually not suitable door/window symbol, that is why you have to create your own symbol.  

4. Using the Building or Toolbox - Door/Window   Define custom door/window  

• Select the 2D group in the dialog box which will be the 2D representation of the door: newdoor1.  

• Select a 3D group: newdoor1.  

• Enter the name of the door/window. 

• Ok Closes the dialog box. 

5. Creating the profile of the opening  

• Select a profile for the opening to be cut from wall. 
Define the profile which is the contour of the front view of the door. 
To do so, it is useful to copy the front view of the 3D model to the 2D window, and define this as profile.  
If you select the ENTER keyword from the command line, the program automatically defines the rectangle 
enclosing the opening as profile.  
 
The program shows you the dimensions of the door, and asks if you would like to save the new door. The program saves 
the new door in the required category within the Door directory.  
The door/window dialog box shows the main dimensions of the new door/window: its height, width and thickness. All of 
these can be modified.  

1.66.7. Door / Window wizard 

ARCHLine.XP comes with a very detailed parametric library of doors and windows. Beyond these build-in doors and 
windows ARCHLine.XP offers custom door and window designer tool that guides you to design openings to your own 
specification. 
 

 
 
The door / window wizard is designed to offer simple and easy to use options to create a new hinged door or window. It is 
possible only by setting the main properties such as the Handles, Materials (even photos of the original opening), framing 
with profile, threshold with profile, additional object Accessories and Profile tool for decorating the door surface. 
 
The new custom door and window can be saved in the appropriate library category to use it later on any project.  Doors 
and windows can be drag and drop on place on wall either in 2D or 3D from their category within the Design Center. The 
wall openings automatically created on the fly. Clicking on a door or window and selecting the “Opening properties” 
command you can reopen the door and window wizard to edit the structure and redefine the current opening or create and 
save a new type in the library.  
 
While drafting takes place in 2D, walls, doors windows and other objects include height data so a 3D model is actually 
being built in parallel. This makes it easy to produce elevations and sections and the entire design can also be viewed in 
an interactive 3D preview window. 
 
 
 
The structure of Door Wizard contains different parts: the left side Control bar, the middle Properties panel, the right side 
3D preview. 
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Control bar Properties 3D preview 

 

 How to use the Door / Window wizard 

 
 
Open the Door Wizard and edit the properties. When a value is changed, you can build it in 3D by pressing the Refresh 
button at the top of the 3D Preview. When you finished with the settings, you can type the name of the new door at the left 
side of the Control bar pane and press the OK button to save the new door type and place it on a wall right away. 

 Control bar 

On the control bar you can navigate between pages of the Property panel. Some features like handles, accessories etc. 
can be entirely enabled or disabled by using the corresponding checkbox front on the control bar. 

 Scheme 

 
 
On the Scheme page you can select an opening scheme. Any other settings on the opening wizard depend on this 
selection. 
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 Main parameters 

 
 
On the General page you can set the main sizes of the opening. Depending on the selected scheme you can see different 
values here. 
Horizontal and vertical sizes are grouped into two different groups. You can mark a single parameter in each group as 
“stretched” by pressing the  button. Once a parameter is marked this way, this value will follow the changes while 
other parameters remain unchanged. 
 
For example, if the left panel is marked as ”stretched”, it will be compressed when we change the full width from 1.8m to 
1.5m. The wing width remains unchanged. 

 

 

 

 
 

  
 

 Representation 

 
On the Representation page you can set some options related to the 2D and 3D representation of the opening.  
 

Show threshold in 2D 

If enabled, a simple threshold symbol appears on the floor plan. (The 3D threshold can be adjusted on the Threshold page 
separately.) 
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Threshold in 2D disabled Threshold in 2D enabled 

 

Show frame profile bounding box on 2D symbol 

If enabled, the frame profile is represented as a rectangle on the floor plan instead of the real profile shape. 

  
Frame profile bounding box 
disabled 

Frame profile bounding box 
enabled 

 

Opening direction symbol 

You can choose one of the available symbols to represent the opening direction on the floor plan. The shape of the 
symbol depends also on the “Opening angle in 2D” setting of the Panel page. 

   

 

Arc Triangle None  
 

Show opening direction in 3D 

If enabled, opening direction symbols appear on the 3D views. 

  

Show opening direction disabled Show opening direction enabled 

Open panels in 3D 

If enabled, panels are represented as open on the 3D views according to the “Opening angle in 3D” setting of the Panel 
page. 
 

  
Open panels in 3D disabled Open panels in 3D enabled 
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 Frame 

  On the frame page you can edit different 
frame parts of the opening separately. On the top of the page you can see the available frame parts; the content of this list 
depends on the current scheme. All of the settings below concern the selected frame part only. 
 

 and  buttons serve for copying and pasting frame data. For example, to make the top frame similar to the side 

frame, first select the side frame, press  button, select the top frame and then press  button. 
 

By pressing  or  buttons you can switch between profile and material list. 

Width and Height 

These values define the width and height of the chosen profile (size in the X and Y direction). These values override the 
corresponding profile settings. After modifying a value press the Refresh button to apply changes. 

X and Y Offset 

The offset value changes the position of the profile horizontally and vertically. X and Y directions are interpreted in the 
plane of the profile; see the related figure on the dialog. After modifying a value press the Refresh button to apply 
changes. 

 Threshold 

 
 
On the threshold page you can assign a profile and a material to the threshold. .  

By pressing  or  buttons you can switch between profile and material list. 
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Enable threshold 

You can enable or disable the 3D threshold. The threshold lines on the 2D symbol can be enabled or disabled on the 
Representation page independently. 

Width and Height 

These values define the width and height of the chosen profile (size in the X and Y direction). These values override the 
corresponding profile settings. After modifying a value press the Refresh button to apply changes. 

X and Y Offset 

The offset value changes the position of the profile horizontally and vertically. X and Y directions are interpreted in the 
plane of the profile. After modifying a value press the Refresh button to apply changes. 

Additional Length 

The Additional length extends the original length of the threshold. After modifying a value press the Refresh button to 
apply changes. 

 Panel 

 
 
On the panel page you can edit different panels of the opening separately.  
 

 
 
On the top of the page you can see the available panels; the content of this list depends on the current scheme. All the 
setting below is related to the selected panel only.  
 

 and  buttons serve for copying and pasting panel data. For example, to make the right wing similar to the left 

one, first select the right wing, press  button, select the left wing and then press  button. 
 

Opening direction 

You can define the opening direction by choosing one icon from the list and setting the in/out and left/right directions. To 
visualize this setting enable Open panels in 3D or Show opening directions in 3D on the Representation page. 

Opening angle 2D and 3D 

You can define the opening angle in the 3D window here. Note that if Open panels in 3D checkbox is not checked, the 
Opening angle 3D setting has no effect. After modifying a value press the Refresh button to apply changes. 

By pressing ,  or  buttons you can set the front, back and edge materials of the door panel, respectively. 
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 Geometry  

On the geometry page you can find the detailed geometry settings of the panel. 
 

  
 
On the geometry page you can edit different panels of the opening separately. On the top of the page you can see the 
available panels; the content of this list depends on the current scheme. All of the settings below concern the selected 
panel only.  

Thickness 

The thickness value defines the door panel thickness, without decorations and handles. 

Offset 

The Offset option is for setting up a distance between the door panel and the framing, if necessary. If the value is 0, then 
the door is perfectly aligned to the primary plane of the opening. If the value is different than 0 then the door panel will be 
shifted perpendicularly to the panel surface in a positive or negative direction face (forwards or backwards), depending on 
the sign of the value. 

Edge offsets 

The Edge offset option is for setting up a distance between the door panel edges and the framing. If the value is 0, then 
the door is perfectly aligned to the reference line of the corresponding frame profile. If the value is different than 0 then the 
door panel will be reduced (positive value) or enlarged (negative value) at the selected edge. 

 Edge profile 

On the Edge profile page you can customize the edges of a selected panel. 
 

.    
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On the Edge profile page you can edit different panels of the opening separately. On the top of the page you can see the 
available panels; the content of this list depends on the current scheme. All of the settings below concern the selected 
panel only.  
 

 
 
Once a panel is selected, you can customize the edges together or separately.  

Enable 

If you would like to customize the panel edge by a given profile, enable this checkbox. 

Profile and materials 

By pressing  or  buttons  you can switch between profile and material list. 

Width and Height 

These values define the width and height of the chosen profile (size in the X and Y direction). These values override the 
corresponding profile settings. After modifying a value press the Refresh button to apply changes. 

X and Y Offset 

The offset value changes the position of the profile horizontally and vertically. X and Y directions are interpreted in the 
plane of the profile, see the related figure on the dialog. After modifying a value press the Refresh button to apply 
changes. 

Align profile and Subtract profile 

You can align the selected profile to the middle, to the front or back face of the panel or stretch it to the panel width. If you 
enable Subtract profile, the selected profile will be subtracted from the panel, otherwise the panel will be reduced by the 
edge profile width and the profile itself will be added to the panel. See the eight combinations in the table below: 
 

 Add profile Subtract profile 

Stretch profile to panel 
width 

  

Align profile to inner 
side 

  

Align profile to middle 

  

Align profile to outer 
side 

  

 Define panel profile for doors/windows 

Before creating holes or insets in a panel, you may need to add new panel profile to your existing panel profile library. You 
can do it with the Building menu – Accessories – Define panel profile for doors/windows command.  

• Start the command and read the necessary steps of the procedure on the Additional information dialog. Click 
Ok to start the procedure. 

• Use the Profile definitions commands to draw a closed chain (e.g. Rectangle). This will be the outline of the 
hole in the door panel. 
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• Once you have the hole outline, you can draw opened chains into it with the Profile definitions commands 
(e.g. Polygon). Press Enter to close the definitions. 

• In the Create new 2D group/object dialog specify the name of the new panel profile and select Opening 

panel frontal profiles category. 

• Click Ok to save the new panel profile in the library. 

 Inset 

On the Inset page you can create holes or insets in a panel 

.  
 
On the inset page you can edit different panels of the opening separately. On the top of the page you can see the 
available panels; the content of this list depends on the current scheme. All of the settings below concern the selected 
panel only.  
 
Once a panel is selected, you can add, remove inset profiles. All the setting below is relative to the selected profile only. 

 

Use offsets for all 4 sides 

If enabled, you can define the position and side of the selected inset profile by setting the distances between the panel 
and the inset, otherwise the midpoint coordinates and the sizes of the profile must be defined. 

Use offsets for left/right/top/bottom side 

If “Use offsets for all 4 sides” is enabled, here set the distances between the panel and the inset. In case of complex 
geometries, the offset is interpreted as the distance between the bounding boxes of the panel and the inset. 

Inset width/height/X offset/Y offset 

If “Use offsets for all 4 sides” is disabled, you can set here the midpoint coordinates and the sizes of the profile.  

Inset thickness 

The setting this value to zero results an empty hole in the panel. 

Profile and materials 

 

By pressing  or  you can switch between profile and material list. The first object in the profile list is a custom one:  
Automatic profile is created by shifting the sides of the original panel profile with the offset values of the 4 sides, 
separately. 

 Inset edge profile  

On the Inset edge profile page you can customize the edges of a selected panel’s insets. 
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On the top of the page you can see the available panels; the content of this list depends on the current scheme. All the 
setting below is related to the selected panel only.  
 

 
 
On the top of the page you can see the available panels; the content of this list depends on the current scheme. All the 
setting below is relative to the selected panel only. 
 
Once a panel is selected, you can select one of the inset profiles defined on the inset page. You can customize the edges 
of the selected inset profile together or the outline and splitters separately.  

Enable 

If you would like to customize the inset edge by a given profile, enable this checkbox. 

Profile and materials 

By pressing  or  you can switch between profile and material list. 

Width and Height 

These values define the width and height of the chosen profile (size in the X and Y direction). These values override the 
corresponding profile settings. After modifying a value press the Refresh button to apply changes. 

X and Y Offset 

The offset value changes the position of the profile horizontally and vertically. X and Y directions are interpreted in the 
plane of the profile, see the related figure on the dialog. After modifying a value press the Refresh button to apply 
changes. 

Align profile and Subtract profile 

You can align the selected profile to the middle, to the front or back face of the panel or stretch it to the panel width. If you 
enable Subtract profile, the selected profile will be subtracted from the panel, otherwise the panel will be reduced by the 
edge profile width and the profile itself will be added to the panel. See the eight combinations in the table below: 

 
 Add profile Subtract profile 

Stretch profile to panel 
width 
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Align profile to inner 
side 

  

Align profile to middle 

  

Align profile to outer 
side 

  
 

 Inner and outer handle 

On the Inner handle page you find the geometry settings for the door handles and knobs. 
  

    
 
On the top of the page you can see the available panels; the content of this list depends on the current scheme. All the 
setting below is related to the selected panel only.  

Enable handle 

The Has Handle option enables the handle and lock for the current door panel. Enable this option if you would like to use 
handles and locks.  

Handle type 

The list allows you to select a handle and also to choose any object you can access with the Design Center. Click on the 
combo box to open the dropdown list and choose Standard, Circle Shaped, Sphere Shaped or Custom. Each choice will 
define a different door handle with lock.  
 

To define an object for the door handle, select Custom from the list, and click on the Browse button.  When you do 
so, the Insert objects dialog will appear, in which you can use the Object Selection button to browse a new object. 

Rotation around X/Y Axis 

You can rotate the selected handle by changing the values of the Rotation around X/Y/Z Axis. The default is 0, 0, 0 and 
the unit is degrees. Select the desired angle to rotate the handle by a specific angle. 

X/Y/Z Offset 

The X/Y/Z Offset values of the door Handle properties let you to define a free offset of the selected handles in every 
direction. The left bottom alignment point is the origin (0,0,0). The three values are the X, Y, and Z directions. 
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Handle and Lock Together 

The Handle and Lock Together option will weld the handle and lock object into one object if Standard, Circle Shaped or 
Sphere Shaped handle was selected. If Custom handle is selected, the Handle and Lock Together option won’t change 
anything. 

Mirror handle 

You can mirror the handle by this setting to position the handle correctly 

Material 

You can set the material of the handle here. This setting has no effect if a custom handle (an object) is selected. 

 Accessories 

 
 
On the Accessories page you can add accessories to the door and you can define the geometry settings of the 
accessories. 
 
On the top of the page you can see the available panels; the content of this list depends on the current scheme. All the 
setting below is relative to the selected panel only.  

 

 

Accessories list 

The Accessories list shows list of added objects and lets you select one to edit. If there is no object added yet, this list is 
not visible.  

X Offset 

Change the X Offset value to displace the current accessory to the left or right direction.  
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Y Offset 

Change the Y Offset value to elevate the current accessory up or down. 

Z Offset 

Change the Z Offset value to displace the current accessory perpendicular to the door surface. 0 (zero) means that the 
object is on the surface. 

Rotation around X/Y/Z Axis 

Change the Rotation around X/Y/Z Axis values to rotate the current accessory. 0 (zero) is the default position. The values 
are the X/Y/Z rotation angles in this order. 

Side 

The Side list has two options to define the placement side for the actual accessory.  

Object – Select Object 

The Select Object button opens the Insert objects dialog. You can browse for an object to set it as an accessory object for 
the current door. 

Positioning 

The Accessories Positioning grid helps you to set the alignment point of the actual accessory. Tick the desired radio 
button to set the accessory position to one of the alignment points. 

Add Object 

Use the Add Object button to add a new accessory. By pressing the Add Object button, the Insert object dialog window will 
open, to let you browse any object. When an object is selected, you will return to the Door wizard Accessories page and 
you can set the properties of the accessory. The selected object name will be visible at the top of the page in the 
Accessories list with a numbering. 

Remove Object 

Use the Remove object to remove the current accessory object. Note that this operation cannot be undone. If you 
accidentally remove an accessory object, you might need to browse it again. 

 Data 

 

Name 

Use the Name field on the Data page of the Door wizard to type a unique name for the newly created door. 

Producer 

Use the Producer field on the Data page of the Door wizard to define a producer. 

Article number 

Use the Article number field on the Data page of the Door wizard to type an article number or bar code. 

Description 

Use the Description field on the Data page of the Door wizard to type a short description text. 

U-Value 

Use the U-value to define the door’s U-value for possible energy calculations.  
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 3D Preview panel 

 
On the right side of the Door wizard dialog you can find the 3D preview panel. Use this panel and its controllers to 
examine the changes during the design process in the wizard. 

Refresh button 

On the top of the 3D preview panel you can find the Refresh button. This can be used to refresh the 3D preview content 
after changing certain values in the Door Wizard. When you press the Refresh button, the software will update the door 
preview by using the current values. 

Presentation settings button 

The Representation settings button can be used to switch between Wireframe, Hidden lines and textured views. Click on 
the button to switch to the next view. When you reach the last view, click on it again to set the first visual style again. On 
slower machines, this button can be used to turn off the 3D preview also, by setting the “X” state on it. 

3D Preview area 

The 3D preview area is the largest part of the 3D preview panel on the Door wizard dialog. Click and hold your left mouse 
button and move your mouse to rotate the preview content. Use the scroll-wheel of the mouse to zoom in or out and pan 
the 3D preview content. 

1.66.8. Corner window  

Similarly to other ARCHLine.XP® objects, you can set the properties of corner window end curtain walls – together called 
glass structure. You can store these properties in sets. Glass structures are created with their actual properties. 
 

� First specify the properties of glass structure.  
For this use the Building menu –Properties –Curtain wall command. 

� In case of full size curtain wall select the Full curtain wall command from the shortcut menu of wall. 
or 

� In case of curtain with custom size wall select the Building menu - Curtain wall – Edit corner window command. 

Corner window 

With this command you can create a corner window drawn in 2D on the layout of the wall, or a divided door/window of any 
complex form. 
If the wall where you install the window is arched, the glass will also be arched.  
 
Use this command when you create an individual window, which does not need to be saved in the directory. 
  
Definition consists of two phases: 

� defining the profile, 
� setting the properties. 

Defining the profile 

The real work is done on the front layout image of walls. In the course of drawing it is possible to: 
 

� define a rectangle of almost the appropriate size. Values can be adjusted in the appearing dialog box.  
� construct the window profile precisely. 



456 10. Building model 

Manual 

• After selecting the Building or Toolbox - Curtain wall  Edit corner window icon, click the wall where you 
wish to place the window. If you create a corner window, click on the wall, from its midpoint in the direction 
of the required corner, as shown in the picture.  
The program then lays out the front view of the selected wall and the other wall connected to it.  
 

 
 
If you selected that part of the wall which is not connected to another wall, the layout image shows only this wall.  
 

 
 

• Place down the layout image. The program asks whether or not to display the layout image.  
Choose the latter if you have already drawn the profile for the door/window, and now you would like to use 
it without, for instance, the corner edge hanging into the profile. In this case it is important that you put the 
reference point of the virtual visible layout to the appropriate point of the drawn profile.  
 
Then follows the definition of the profile, for which you have two possibilities: 
 

� defining the profile on a rough estimate  
� defining the profile by drawing 

Defining the profile on a rough estimate  

• Select the Rectangle HV command from the Toolbox - Profile definitions tool.  

• Define the lower left corner point of the rectangle. The starting point has to be at that point where the 

window will start. Therefore, use the  Relative distance icon from the Reference toolbar. With the help 
of this, place the starting point to -1.2 m to the left and 1m up from the wall corner point. (You last clicked 
on the wall corner; therefore values are measured from there.)  

• Define the upper right corner of the rectangle. An approximate value defined graphically is enough this time. 
  

 
 
In the Glass definition dialog box appearing you can define the width and height of the rectangle, that is the width and 
height of the window, in the Enclosing box length and Enclosing box height field.  
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Defining the profile by drawing  

• If you would like to draw the profile precisely, place down the layout image of the wall.  

• Ask for displaying the layout image. 

• Press Enter to finish the Edit window corner command. The visible layout image remains in the drawing.  

• Select the appropriate geometrical objects from the menu to create the required profile.  

Example:  

• With the help of the Polyline tool - General Rectangle – BOXSIZEs option, place a rectangle sized 2.4 m x 1.5 
m with its lower mid-reference point 1m high from the wall corner.  

• Delete the edge of wall corner within the profile. 

•  

 
 

• Activate the  Edit corner window command again. 

• Click the previous wall. The program lays out the image wall again.  

• Place the layout image precisely on top of the previous one. 

• The program asks whether or not to display the layout image. Select No. This is necessary so that corner 
edge does not hang into the window profile.  

• Select the Point of profile command from the Toolbox - Profile definitions tool. 

• Click the window profile. The program takes the whole rectangle for the profile.  
 
Lattice window settings dialog box appears.  

Setting the properties 

The structure of the dialog similar to the normal window properties dialog except with the Main parameters and Curtain 
wall properties pages. 
On the Main parameters page the Enclosing box width and Enclosing box height refer to the size of the entire opening, so 
width in this case means the total of the width of the windows located on two sides of the corner. If you defined the profile 
on a rough estimate, you have to enter the exact values now. If you drew the profile precisely, the exact values appear 
here. 
The next fields refer to the first window only, the one to the left from the corner. You can specify the same parameters for 
the second window, the one to the right of the corner, after clicking OK. 
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Curtain wall properties 

On that page you can define the glass structure of the lattice window: Mullion properties, Curtain wall properties and 
Frame properties. 
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Mullion properties 
� You can define the thickness, width and material of mullion. 
� The position of mullion can be defined either by the Offset of mullion option, specifying the exact distance from the 

reference side of the corner window, or relative to the glass by the Mullion placement setting (outside/middle/inside). 

Curtain wall properties 
� Here you can define glass width, glass material and the offset of glass relative to the reference side of the corner window. 
� You can switch on/off the glass transparency. 
� Fixed distance. If you switch off this option, you can determine the sectioning with the No. of glasses in horizontal/No. of 

glasses in vertical values. The Horizontal Spacing and Vertical Spacing are not available in that case. Then you will get 
glass faces in the same size (equal division).  

Unequal division of glasses 

If you switch on the Fixed distance option, you can define the exact number and size of glasses horizontally and vertically 
by the Horizontal Spacing and Vertical Spacing settings.The divisions can be set one by one in both horizontal and vertical 
directions. 
  

• For this please click on the Horizontal Spacing / Vertical Spacing button. 

• In the Horizontal Spacing/Vertical Spacing dialog you will see the glass plane sizes (width or height data) 
according to the previously defined number of glass planes. After clicking the One by one button the sizes 
will appear for each division. 
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• Modify: The numbering sequence is left to right in horizontal direction, and bottom to top in vertical 
direction. 
Click on the dimensions to modify. 
If the sum of the defined glass plane dimensions is greater than the full window size, the program removes the 
unnecessary rows from the table and corrects the dimension in the last row, if necessary. 
If the sum of the defined glass plane dimensions is smaller than the window size, the program will add new rows to the 
table. 

• Click Insert to increase the number of divisions. The insertion is always made above the selected row. If 
there is no row selected, the insertion will be made above the first row. 

• You can delete a selected row by the Delete button. 
 

• Using the One by one button 
you can let the program to 
recognize the REPETITIONS in 
the defined divisions. For 
example we can define two 
divisions for a 10 m long 
curtain wall: 1 m and 2 m. In 
that case the program 
assumes the repetition of this 
division pattern and adds the 
missing rows automatically. 

 

Frame properties 
Here you can define the width, thickness and material of the frame. You can make the top/bottom/left/right frame visible by 
checking the appropriate options on. With the Corner column exists option you can put a column in the corner.  
Mullion on right side when frame is OFF/Mullion on left side when frame is off: when you do not define frame on the 
left side/right side, you can put there mullions instead. 
 
The corner window consists of two windows; therefore, after you closed the dialog box, another one appears, containing 
the properties of the second window, the one to the right from the corner.  
The full size of the opening cannot be modified this time, but all other parameters still can. 
After closing this dialog box, the corner window will be generated. 
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Apart from creating corner windows, this method can also be used for normal windows placed on the wall the user defines 
him/herself. With regard to its really simple nature, we can recommend this method beside the 3D solid modeller and 
definition by 2D hatches.  
 

 
 
You can use this technique for defining windows if you would like to place a window on an arched wall. Contrary to the 
other methods, the glass will also be arched this time, which means it follows the arch of the wall. 
  

      
 

 

 

Unequal division oblique glass wall 

 
 

Full curtain wall 

Full Curtain walls can be created when you use the selected wall Shortcut menu - Full Curtain wall command.  
This command will convert the whole wall into a curtain wall. The glass definition of this curtain wall can be made in the 
Building menu -Properties – Curtain wall: Glass structure settings dialog. 
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1.66.9. Openings in the Curtain wall  

You can prepare complex glazed structures, curtain walls. After preparing the main structure objects you can fit without 
restriction openings to the curtain wall fitting to the structure objects.  

 

Use 

First prepare the curtain wall, and set the position of the main structure objects: set the properties of Number of glasses 
and Glass dimensions (After selecting the object these properties can be found in the Property manager under the 
Structure settings headword or they can be found in the shortcut menu under the Properties menu point after clicking on 
the object with right mouse button.  

 
 
After setting place the division ribs, you can also set the openings fitted to these ribs in the floor plane. Select from the 
Toolbox the Door - Window by two points command, then click on the proper points of the border ribs of the future 
opening. 
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If the external contour of the opening is modified as the result of fitting in the opening the reveal structure of the curtain 
wall follows these changes.  

1.66.10. Converting object to door / window 

Selected objects can be converted to door or window and saved into OLI libraries with the Create door / window 
command in the shortcut menu of objects. 
For example, using this function you can convert door or window objects imported from 3D warehouse to architectural 
door or window that can be placed into wall.  

1. Step.  

Import object from Google 3D warehouse. 

  

2. Step.  

Place the object on the drawing then click with right mouse button on the object. Choose the Create door / window 
command. 

 
 

1. 2. 
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3. Step.  

Relocate the 4 hotspots of the door/window on the left side by drag & drop, if necessary, according to reference drawing 
on the right side.  

 
 
Use the mouse wheel to zoom the door or window shape and locate the hotspot precisely.  
 

  
Choose the Door or Window category or type the type name and the new category name. 
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4. Step.  

Select the door from the library and place it into a wall. 
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1.67. Slab 

Introduction 

Use the slab commands to create regular or irregular slabs, sloping slabs, and foundations and to cut slabs and also to 
modify slab properties. 
You can create single layered slabs (single slabs) or layered slabs. 
You can modify individual layers in the case of layered slabs. This way you can create standard structures complying with 
the detailed construction drawing and also elaborate wall to slab connections in the floor plan and in the 3D drawing. 
You can create beams in the slab, and you can order the beams to slab layers.  
If you give the cross section profile, you can place for example  beam to the slab. 
You can even create slab with wood beams.   
Modify slab profiles to create custom made slabs, like annular vaults, cross vaults, etc. 
In ARCHLine.XP® you can define floor tiling and ceiling patterns. You can assign different materials with the proper size 
and direction to these patterns. You can display tiling in the floor plan, and in the case of the 3D drawing and the 
photorealistic display. You can make a list from the quantity of used floor tiling.  

1.67.1. Slab properties 

Before placing the slab, you have to define slab properties. 
Right-click the Toolbox Slab tool to access these properties, or use the Building menu-Properties - Slab command. The 
dialog box with slab properties pops up. 

 

General properties 

Firstly, you can modify general slab properties, like colour, line width, layer and line type. 

� For the description see Chapter 3.2.1. Specifying general properties. 

Sets  

You can save your customized slab properties into sets and you can store sets in the environment. This way you can use 
the desired slab structure in any of your drawings. If you click on the button, the pre-defined slab sets will be displayed on 
the right side of the dialog box. 
 

� For the description see Chapter 3.2.3. Using sets of properties. 

Slab material properties 

Under general properties, you can set slab material and slab-to-slab height. 
Enable the Same materials option to assign the same material to all 3 sides of the slab. 
 

 

 

• material for top surface - 
floor 
 

• material for side surface 
 

• material for bottom surface – 
ceiling 
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If you click on the Material name, the Material dialog box will pop up. 
 

• Select material type. 

• OK Ends selection. 
 

� For the description see Chapter 3.2.2. Material properties. 

 

 
• Enter the relative height of the slab as 

compared to the active floor. 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Active floor 

 
 
Slab width: 
 -0,30 

Angle of the sloped slab 

In the case of sloped slabs you can modify slope angle in the Slab properties dialog box. This field is greyed (i.e. 
disabled) when defining general properties. 

Slab cut 

You can set automatic cutting of slabs by walls or by the roof. 
 

� Cutting by walls 
The slab cuts down wall sections over the slab. You can use any of the following options to cut walls: 
 

 

 

• own floor, 

• all floors, 

• no cutting - the slab will not cut any wall 

• the slab cuts walls on its own floor and 
below. 

 
This method is very useful if you want to create an arched slab and you want to cut walls so as to fit this arched slab. 
 

� In the case of columns and other objects placed into the wall, slab cutting works only if you enable it in the object 

property dialog box. This means that you can cut any wall with a slab without cutting the chimney in the slab. 
�  
� Cutting by roof 

You can cut slabs with roofs in the following ways: 
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• the roof cuts the slab at each floor 

• the roof does not cut the slab 

 
If you draw an alpine-style building for instance, it is necessary to enable the cut all floors option: 
 

No cutting: 

 

Cutting by the floor: 

 

 

� You can see the result of these two cutting options if you enable the Wall - slab - roof cutting option in the  Build 

3D model dialog box.  

Extract Slab or Foundation from Terrains 

The Extract Slab or Foundation from Terrains Feature cuts the slab body from terrain. 
 

 
 

 

 Slab layers 

If you click on Slab Layers, the Slab layers dialog box appears. 
 
With this option, you can create multilayered slabs (15 layers maximum). You can select such slab structures from the pre-
defined sets or you can create your own slab layer by layer. It is worth creating and saving your most often-used slab 
structures. You can display nodal points on cross sectional drawing with the elaborateness of a construction drawing. To 
achieve this, you should use layered walls. 
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Insert new button 
You can add new layers to the slab with the Insert new button. The new layer added will always be topped onto the 
previous layer and will have the properties of that layer. 
Other layers remain intact. Layer 1 is the bottom-most one. 

Delete button 
Use the Delete button to delete any selected layer. Layers above the deleted one will shift one layer down. 

Displayed layer 
In the list click on the layer you want to be displayed, and then click on the Displayed layer button. The Arrow will jump to 
the number of the desired layer, indicating that this is the displayed layer on the floor plan. 
This is very useful if you want to edit slabs layer by layer, i.e. there are different layers with different geometry. 
The layered slab editing commands are only valid for the displayed layer. 

Layer properties 

 
 
Click on the field to select the desired layer. Double-click this field to modify layer name, material and width. 
If the layer width is negative, the layer should be measured downwards, and if layer width is positive, it should be 
measured upwards. 
The dialog box will display the 3D image of the layered slab with its total width. 

Use the   Arrow button to return to the Properties dialog box. 
 
Visibility of a layer can be set for each slab layers one-by-one in the slab layer settings dialog. 

 

 Slab with beams 

Slab properties 

Similarly to the rafters in the roof, it is possible to define slab with beams. In the Beam properties dialog you can switch on 
the building up of beams and their representation in 2D. 
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Build up beams 
By switching this option on the program builds up the beams. This will appear in the 3D model only when the Slab beams 
option is selected in the Build 3D model dialog. 

2D representation 
This option allows you to see slab beams on the floor plan. Beams are connected a slab layer. You can specify this 
connection in the Layer of beams field.  
Beams are visible on the floor plan (by switching on the 2D representation option) only when the layer to which the beams 
are connected is activated. 

Beam representation with centreline 

With this option, beams can be represented by their centrelines on the floor-plan.  
 

 

Delete and rebuild all beams 
An existing slab with beams can be modified by the Slab shortcut menu - Slab framing commands. After you have carried 
out modifications with these commands, the original state can be reset by this option. 

Colouring of slab 

With the selection of a colour you can represent a slab with a solid hatch on the floor plan:  

Beams properties 

 

 
In the beams dialog you can specify the properties of 
beams. 
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Distance between layer and beam bottoms 
Here you can set the distance between the bottom surface of the beams and the bottom surface of the layer of beams. If 
you specify a negative distance, the beams will appear below the slab layer. 
 

 
 
You can specify the A distance between slab and beam ends and the B beam gap (see the figure in the dialog). 
 

 

Cross-section - C, D 
The cross-section profile of the beams is rectangle, which values can be set. Beside a rectangle cross section, you can 
choose any other profile as cross section from the profile library.  
 

 

Creating slab with beams 

Creating of slab with beams goes the same way as the creating of simple slab. 
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If the 2D representation option is switched off or the displayed slab layer is different from the layer to which the slab 
beams had been connected in the properties dialog, beams and their direction are represented only with a symbol: 
 

 
Switched off   Switched on  
 
In the slab properties dialog you can specify a solid hatch for the slab representation on the floor plan. 
 

  

Modify the slab beams 

Slab beams can be modified by the Slab framing shortcut menu commands. These commands are similar to the Roof 
framing commands. 
 

 

Modify direction 
With this command you can modify the direction of the beams. Of course, this command deletes and rebuilds all beams, 
thus you will lose all of your modifications you made before. 

1.67.2. Creating slabs 

Click the Toolbox – Building - Slab tool to access these commands, or use the Building menu- Slab menu commands. 
You can create the following types of slabs: general slab/ceiling, foundation and sloped slab. 
 

� Ceiling is a slab where the Height is attached to floor elevation option is switched on automatically so it will 

be placed at the height of the active floor. 

  Creating slab with selection 

You can define slabs with their contour lines. 
There are many options to define the contour: 
 

� The area defined by the walls defines the slab. 
� Subcommands can be used to define contours in a more complex way. There are many options to define contours. For 

example you can offset slab at a defined distance related to the contour. This is very useful if the slab overhangs walls or 
fails to reach the outer isolating wall layer in the case of multiply layered walls. 

Areas defined by walls 

• Pick walls one by one or select the room/building by the selection rectangle. The slab will be created along 
the outer contour. 
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• Enter Ends selection. 

Using subcommands 

• Instead of selecting walls, select one of the available subcommands and follow the instructions. 

Shifting slab contours 

• Before selecting walls, click Parallel shifted… subcommand.  

• Select Type the value… from the appearing distance setting options.  

• Specify the distance of shifting. If the slab is smaller than the contour defined by the walls, give shifting 
distance as a negative value. 

• Select walls and then close the command by pressing Enter. 

 Creating slab with polygon 

You can Create slab by sketching it, using the Polyline tool.  
 

• Before specifying the points select the Parallel Shifted option if you want to place the slab to a given distance 
from the sketched contour. Specify the distance for the shifting. If the slab is smaller than the contour, use a 
negative value to specify the distance for shifting. 

• Specify slab profile using the Profile definition menu commands. 
 

� For a description of the Profile definition, see Chapter 8.9. Specifying profile.  

Further options 

You can use any of the following options to define slab contours with polylines: 

Options: 

CIRCLE The polygon forms a circle. 

SHIFT Enlarges or reduces the limiting polygon with a defined 
distance.  

WIDTH The limiting polygon is a polyline with a given line width. 

 
 
 
 
 
WIDTH = 
1.50m 

  Creating closed foundation 

With this command you can create closed foundations. Foundation height and elevation will be defined by the values set 
in the Slab properties dialog box. 
 

• First define the width of the foundation in the dialog box popping up. 

• Define the closed contour of the foundation. 

Options: 

CIRCLE The closed contour will be a circle 

DIAMETER Specify the internal diameter of the circle shaped 
foundation. Use the LIKE option to pick up the 
diameter of an existing circle or arc. 

RADIUS Specify the internal radius value of the circle shaped 
foundation Use the LIKE option to pick up the radius 
of an existing circle or arc. 
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CPOINT Specify the centre point of the circle shaped 
foundation 

P3 Specify the internal contour of the circle shaped 
foundation with three points 

AXIS Specify the two end points of the internal diameter of 
the circle shaped foundation. 

SELOBJECT Select an object to draw the foundation along its 
contour. 

 
Options not mentioned above shall be those referred to in line drawing. 
 

• Enter Ends the command and closes the contour by connecting the last defined point with the first one. 

  Creating open foundation 

This command is similar to the one for creating closed foundations, with the only difference that the foundation cannot be 
closed within itself. 
 

• In the dialog box popping up enter the width of the foundation. 

• Specify the open contour of the foundation. 

Options: 

SELOBJECT Select an object to draw the foundation along its 
contour. 

 
Options not mentioned above shall be those referred to in line drawing. 
 

• Enter Completes the command. 

  Sloped slab with reference points 

With this command you can create sloped slabs by defining three reference points. 
 

• Create slab by sketching it, using the Polyline tool.  

• Before specifying the points select the Parallel Shifted option if you want to place the slab to a given distance 
from the sketched contour. Specify the distance for the shifting. If the slab is smaller than the contour, use a 
negative value to specify the distance for shifting. 

• Specify slab profile using the Profile definition menu commands. 

• Pick on a boundary point to specify its elevation. If you want to specify an upper surface point of the slab, 
use the keyword UPPER. 

• Specify elevation value or select the keyword LIKE to select an object and pick up its elevation in the click 
point. Click on the UPPER or BELOW to define the height of the selected point in the top or bottom point of 
the selected object. The program will display height value in a dialog box; you can accept or refuse this value: 

• Specify the elevation in a similar manner for the other two reference points. 
Enter Completes the command. 

� For a description of the Profile definition, see Chapter 8.9. Specifying profile.  

  Creating sloped slabs with reference lines 

With this command you can create a sloped slab by defining a reference line and the angle of the sloped slab. 
 

• Create slab by sketching it, using the Polyline tool.  

• Before specifying the points select the Parallel Shifted option if you want to place the slab to a given distance 
from the sketched contour. Specify the distance for the shifting. If the slab is smaller than the contour, use a 
negative value to specify the distance for shifting. 

• Specify slab profile using the Profile definition menu commands. 

� For a description of the Profile definition, see Chapter 8.9. Specifying profile.  
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•  After defining the slab profile, specify the reference line with 
two points. These points will have the same elevation. The 
slope arrow perpendicular to the reference line displays the 
sloping direction. 
If the slope arrow direction is not acceptable, prior to the 
definition of the second point, press ENTER to return to the 
definition of the first point once again. 
A dialog box will pop up where you can enter the elevation of 
the reference line and the slope angle.  

•  
Ok Completes the command. 

 

  

 Angle of the sloped slab 

The angle of sloped slab can be modified in the Slab properties dialog afterwards. 
 

 

1.67.3. Editing commands for whole slabs 

With this command you can edit the corner points and edges of the entire slab. In the case of layered slabs, editing will 
affect each layer. 
You can access editing commands from the Shortcut menu: 
 

 

 Move node 

Click on any corner point of the slab to change its position. 

 Parallel shifting (offset) 

With this command you can offset one side of the slab or enlarge or reduce the entire contour of the slab. 
 

• Select the slab side you want to offset. 

• Specify the new position for the slab side. You can also specify the offset by entering its value; to do so, 
move the mouse pointer in the desired direction and enter the value; 
or 
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• Select the ALL option of the prompt to move each side of the slab contour together. 
Enter Completes the command. 

 

 

 Inserting nodes 

Click on any side of the slab to insert a new node. 
 

SPOLYGON If you select the SPOLYGON keyword, this will activate the 
Add polyline command  

 Adding polylines 

Click on any side of the slab to add multiple nodes by a polyline to the slab. 
 

 

 Deleting nodes 

This command deletes any selected corner point of the slab. 

 Converting lines to arcs 

This command performs the following conversions: 
The command converts linear slab sides to arced ones; you can also modify the radius of the arch in the case of an arced 
slab. 
 

• Select the slab side to be converted. 

• Specify a point. The arced slab will intersect this point. Select one of the following options: 

OPTIONS: 

DIAMETER Enter diameter value. 

RADIUS Enter radius value. 

PERIMETER Enter perimeter value (arc length). 

ARC Enter chord value for the arc. 

 Converting arcs to lines 

Use this command to convert arced slab sides to linear ones. 
 

• Select any arced slab side to be converted. 
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1.67.4. Editing commands for slab layers 

With these commands you can edit the corner points and edges of the displayed (i.e. active) layers of slabs. 
Select the displayed layer in the Slab properties - Layers dialog box. An arrow marks the displayed layer. 
 

 
 
You can access editing 
commands from the 
Shortcut menu: 
 

 
 

� The operation of this command corresponds to those described in chapter 9.4.3. Editing commands for 

whole slabs. 

 Moving nodes 

Click on any corner point of the active slab layer to modify its position 
 

 

 Parallel shifting (Offset) 

With this command you can offset one side of the active slab layer or enlarge or reduce the entire contour of the slab. 

 

 

 Inserting nodes 

Click on any side of the active slab layer to insert a new node to that layer. 

 Adding polylines 

Click on any side of the active slab layer to add multiple nodes by a polyline to the slab. 
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 Deleting nodes 

This command deletes any selected corner point of the active slab layer. 

 Converting lines to arcs 

This command performs the following conversions: 
The command converts linear slab sides to arced ones; if the selected side of the slab is arced, you can also modify the 
radius of the arch. 
 

 

 Converting arcs to lines 

Use this command to convert arced slab sides to linear ones. 
 

• Select any arced slab side to be converted. 

1.67.5. Creating and editing slab holes 

You can access these commands from the Shortcut menu: 
 

 

 Creating slab holes 

In most cases you need slab holes when editing stairways and chimneys. Slab holes always comprise parts of slabs, you 
can specify their form without any restriction and you can edit them afterwards. 
 
You can access the command from the Toolbox, the Building menu and the Shortcut menu. 

Creating slab holes over stairs 

You can create slab holes for stairs with the STAIR keyword of the command. You can select the stairs under the slab and 
then the hole will be created automatically for the actual stairs. In this case the profile will not be displayed as the top view 
of the stairs; therefore it is preferable not to use this function for stair spaces created with galleries. 
 
The program will calculate the contour as follows: 
 

� The width of the hole is defined by the width of stairs. 
� For the depth the program will find the particular stair with a distance to the bottom of the slab equalling the free height set. 

This aims at allowing an adult to walk up the stairs in an upright position. 
You can set the “Free height above stair” value in the dialog box File menu - Options - Stair standard: 
 

 
 

• Select a slab you want to open. 

• Specify the slab hole profile by the Profile definition tool in the Toolbox. Draw the profile with the option 
selected, or 

• Select the keyword STAIR from the prompt. 
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• This command will automatically create the hole in the slab for the actual stairs under this slab. If there are 
no stairs under this slab (the program warns you about it), select the keyword BELOW. Use this keyword to 
select the stairs of the next floor downwards. 
Enter Completes the command. 
 

� For a description of the Profile definition, see Chapter 8.9. Specifying profile.  
 

! If you select stairs, the stairs must be under the slab. 

 Creating slab holes in multiple slabs 

It is often the case that there are slabs covering the entire floor of a building and there are different layered slabs in each 
room. This means that there are several slabs on each other. 
In this case you have to create a slab hole in the reinforced concrete slab and also in the layered slab. 
This command offers a very simple solution to this problem. You can create slab holes on multiple slabs. To do so, select 
the slabs for the slab holes. Enter. 
 

� The operation of this command corresponds to those described in Chapter 9.4.5.1. Creating slab holes. 

 Creating slab holes in layered slabs 

This command creates slab holes in the active slab layer. 
Slab holes always comprise parts of slabs, you can specify their form without any restriction and you can edit them 
afterwards. 
 

� The operation of this command corresponds to those described in Chapter 9.4.5.1. Creating slab holes. 

  Deleting slab holes 

With this icon you can delete existing slab holes. 
 

• In order to delete, select the contour of the slab hole. 
Enter Exits the command. 

  Moving slab holes 

With this command you can move existing slab holes. 
 

• To move, select the contour of the existing slab hole. 

• Specify the reference point of the slab hole for moving. 

• Specify the new position of the slab hole. 
Enter Completes the command. 

  Copying slab holes 

You can copy slab holes within particular slabs. 
 

• After selecting the command, specify the reference point of the slab hole, or select the keyword REPEAT if 
you want to create multiple copies, and then enter the number of copies. Ok. 

• Specify the position of the new slab hole. Enter.  

1.67.6. Decoration 

With this command you can specify tiling for the floor and the side of slabs and also patterns for the ceiling. You can 
assign different materials with the proper size and direction to each pattern. You can display tiling in the floor plan, and in 
the case of the 3D drawing and the photorealistic display, you can use tiling with materials. In the case of multiple layered 
slabs, the tiling will be created on the active layer. 
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You can access the commands in the 
Shortcut menu  
 

 

� For a detailed description of this command see chapter 15.1. Tiling. 
 

 

1.67.7. Modifying slab profiles 

Use the following commands to modify the whole (i.e. entire) and bottom slab profiles and to delete them. 
 
You can access the commands in the Shortcut menu: 
 

 

 Total slab profile 

If you want to create special slab structures (like arched slabs), you have to modify the front view profile of the slab. With 
this command you can create closed profiles. You can place the profile on either side of the slab, and you can cut the 
profile from several sides. The program cross-sects these profiles, so you can create sophisticated structures like cross 
vaults. You can modify the profile in the floor plan and in 3D if you want. 

Modifying slab profiles on the floor plan: 

• Select one side of the slab to be modified in the floor plan. The program lays out its front view. (If you have 
modified a slab profile earlier, the program will use dotted lines to display the actual front view.) 

• Place the laid out image. Use the NEXT keyword to change the reference point of the image laid out. 

• Specify a closed profile to represent the frontal shape of the slab using the Profile definition tool in the 
Toolbox: 

� For a description of the Profile definition, see Chapter 8.9. Specifying profile.  

 

If you want to use a pre-defined profile of the profile library, click the Select from list command. 
 

� Use the  Object tool-   Closed profile command to create library profiles. 

 

If the View menu - Automatic refresh option is enabled, you can see the result in the 3D view. 
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Reference point 

 
 

 

Example 

You can cut a profile onto a slab having an arced side connected to the cut side. In this case you have to complete the 
automatically laid out slab side so that the profile will contain the entire projection. Otherwise the Bool operation will cut the 
arced side of the slab. 
 

 

 Bottom open profile 

In the case of the previous command (Add whole profile) you had to define a new, full profile of the slab. When creating an 
open profile, you define a section (which can comprise arcs and lines too). The program connects this open profile with the 
lower part of the slab and then cuts this profile out of the slab. 
If the profile selected is a closed one, the program automatically deletes one side of it to create an open profile. 
 

 

 

 Deleting slab profiles 

Deletes the profile assigned to the slab. 
 

• Select any slab on the floor plan to delete the profile assigned to it. 
Enter Completes the command. 

1.67.8. Split the slab 

The command splits a slab into two slabs. All properties will be copied to the separated slabs as layer, geometry, materials 
etc. 
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1.67.9. Assign materials 

When defining slab properties, you can define the material of the top and bottom surface and also the side surface of the 
slab. When you define the material of the side surface, you can apply the same material on each side of the slab. If the 
building has got walls of different colour, you may have to define a slab colour corresponding to that of the wall. To do so, 
you have to use the command Assign material, by which you can assign new materials to the selected slab or to particular 
layers of that slab. 
In the example below you can see that in the case of walls of different colours we changed one side of the slab to 
correspond to the colour of the wall and to share the same texture. 
 
Options for assigning materials: 
You can access commands in the Shortcut menu: 
 

 

On one side 

• Select the slab to whose side you want to assign material.  

• Select the desired material in the dialog box. OK. 

•  

          

On one side of a layer 

• Select the desired slab having the side with the displayed layer you want to assign the new material to. 

• Select the material from the dialog box popping up. OK. 

Deleting on one side 

• Select the slab on whose side you want to delete the material. 
Enter Completes the command. 

Deleting on one layer of a side 

• Select the slab having the displayed layer with the material you want to delete. 
Enter Completes the command. 
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1.68. Ceiling 

Ceiling is a host element. It means the ceiling is able to host components into its structure. It can include light fittings, 
ceiling fans, CCTV cameras, etc. Placing a ceiling will create 3D model and it appears in Sections and 3D Views. 
 
You can create a ceiling three ways:  
1. in Sketch mode drawing out the boundary of the ceiling,  
2. with clicking in a room, and 
3. automatically in all rooms in one step 
 
Ceiling is displayed with boundary lines, along the ceiling perimeter. 
Ceilings have two main types:  
 
1. Plain ceilings (such as plasterboard) and  
2. Grid ceilings (such as a suspended grid system). 

 

1.68.1. Grid Ceiling properties 

The parametric ceiling editor allows you to parametrically control the Ceiling object, set the grid, along with additional 
ceiling accessories like ventilator diffusers, lights and fire-safety objects. 

 
 

Type and distribution – You can specify the main geometrical parameters like grid size, direction, alignment, etc. 

 Default units of the ceiling 
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 Ceiling lights 

 Fire protection unit 

 Air distribution units  

 Other units, like CCTV 

 Main runner, cross runner 

 Holes and insets 

 General settings 

 Save 
 

 Type and distribution 

You can specify the default ceiling parameters here. 

 

Strip or suspended grid ceiling 

You can define the ceiling structure as strip or suspended grid ceiling. 

Grid width  

You can specify the grid width. 

Grid height 

You can specify the grid height. 

Direction 

You can specify the grid main direction. 

Reference point 

The eligible reference points are shown by small circles in the dialog that can be activated by clicking. The active 
reference point is black while the others are white.  

Alignment to unit corner 

The alignment is calculated relative to a selected cornerpoint.  

Alignment to unit centerpoint 

The alignment is calculated relative to the ceiling centerpoint. Proper alignment helps you to achieve professional-looking 
result by balancing the borders around the edges of the room.  

Main runner offset  

You can specify the main runner offset relative to the reference point. 

Cross runner offset  

You can specify the cross runner offset relative to the reference point. 

 Default units for ceiling  

You can specify the default units for each component here. 



 10. Building model 485 

ARCHLine.XP® 

 

 Default units 

 
You can specify here the default unit for each component that will apply in the entire ceiling. 
 
Select the proper object from the predefined ones or choose a new one from the Design Centre.  
 

� In general the default unit means that whenever a different objects for that setting is not specified at local scope, the 

default unit will be applied.  

  

 Lighting  

You can specify the default built in lamp unit. 

 Fire protection 

You can specify the default fire protection unit. 

 Air Distribution 

You can specify the default air distribution unit. 

 Unit distribution 

You can specify the distribution rules independently for the following four units: 

 Ceiling light units 

 Fire protection unit 

 Air distribution units 

 Other units 
 

 

Layouts 

You can choose among the following layouts: 
� One object - Only one object is placed – example: fire protection unit. 
� One row  - The objects are placed in a row. 
� One column - The objects are placed in a column. 
� Grid  - The objects are placed in a grid structure. 
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 Main runner grid step 

You can specify the Main runner grid step here. 

 Cross runner grid step 

You can specify the Cross runner grid step here. 

 Main runner offset 

You can specify the Main runner offset here. 

 Cross runner offset  

You can specify the Cross runner offset here. 

Priority 

Criteria for priorities. When coincidence case occurs, the priority should be used to define the rules governing the 
situation, e.g if you place two units on the same position the program displays the unit with higher priority. 

Hide panel units 

You can define a beam ceiling when you switch on the Hide panel units option. 

 
 

Allow not whole units 

The distribution rules may occur units along the border which are greater than the space available. When this checkbox is 
on the distribution cuts these units. When this option is off the distribution will place the whole units only. 

 
It is recommened to switch on this checkbox mainly for lighting or air distribution units to prevent the design of unreal 
layout. 

 Unit 

You can specify the object you will place using the Layout rule. 

 

Apply the default 

You can overwrite the default unit with a local selection when you switch this checkbox off.  

1.68.2. Main and cross runner 

You can specify on this panel the main runner, cross runner and perimeter wall angle units, extension, offset distances 
and rotation values. 

Main runner  

Main runner can be defined by two methods: 
1. Select existing main runner object from the Favourites. 
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2. Click on the blue plus icon. Select the new main runner object in the upcoming DC dialog. Press Ok to return.The 
selected profile will be inserted into the Favourites List. 

 

 Cross runner 

Cross runners can be defined in the same way as main runners. 

 

 Perimeter wall angle unit 

Perimeter wall angle can be defined in the same way as main runners. 

 

1.68.3. Lighting on Plain ceiling 

Lighting on Plain ceiling allows you to distribute lamps on the ceiling  

Lighting path 

You can specify the Automatic profile as a path or you draw the path to place the lamps along it.  
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 Element on Moulding path 

 

Moulding path 

 

1.68.4. Holes and insets 

 

You can select profiles from the favorites or from the existing profile libraries ( ). You can create ( ) custom profile 

or edit ( ) the currently used profile. Custom profiles can be saved ( ) into the profile libraries. The orientation of a 

pre-defined profile can be modified ( ). 

1.68.5. General settings 

You can specify the general properties of the ceiling, for example relative height, the 2D representation properties, the 
color, the layer, etc. 

 

Relative height 

You can specify the relative height of the ceiling from the floor level. 

Absolute height 

Elevation including the floor level. This field is not editable. 

General properties 

You can specify the general properties of the ceiling, like colour, line width, layer, line type, priority. 

Representation in 2D 

You can specify the 2D representation properties.  
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There are four modes of representation in 2D: 
� Top view – shows the ceiling in hidden line removal mode, 
� Symbolic – shows the ceiling in hidden line removal mode together with the 2D symbol on the place of lamps, 
� Top view – shows the top view. 

1.68.6. Save 

You can save the created or modified ceiling into the Design Centre by using Save or Save as option. Here you can load 
those ceilings which are already exist and modify them as well. 

 
 

1.68.7. Create ceiling 

You can create ceiling in a various way related to a room, a free polygon shape and for all rooms in one step 

 Grid Auto Ceiling 

If the room is bounded by walls use the Grid Auto Ceiling command to place a ceiling.  
 

• Select the  Grid Auto Ceiling command.  

• Click inside the room bounded by single walls,  
The ceiling is created. 
 

� You can also set the ceiling properties before the placement. Click on Ceiling tool with the right button of the mouse, or 

use the Building menu - Properties – Grid Ceiling or Plain Ceiling command. 

 Grid Auto Ceiling in all rooms 

By this command you can quickly create ceilings for all rooms in one step on the actual floor. 
 

• Select the  Grid Auto Ceiling command.  
All ceilings on the actual floor are created automatically. 

           

 Grid ceiling by polygon 

Using the command the ceiling is created by the user defined polygon. 
You can modify its boundary and the ceiling calculation follows the modifications.  
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• Select the  Grid ceiling by polygon command.  

• Define a closed polygon. 

• The ceiling is created. 
 

! This command does not consider the surrounding walls only a right prism with a polygon base will be created. 

 

 Profilok kezelése és szerkesztése 

Automatic profile 

 
Automatic profile is created by shifting the sides of the original profile with the offset values of the 4 sides, together or 
separately. 

Same offsets  

If enabled, you can define the offset values of the 4 sides together. 

Use offsets for left/right/top/bottom side 

If “Same offsets” is off, you can specify the offset values separately. In case of complex geometries, the offset is 
interpreted as the distance between the bounding boxes of the panel and the inset. 

Edit Profile 

You can edit the profile with Edit profile command.  
At this point you can edit the profile on the floor plan (in top view). 
 
You have to place the profile on the drawing and edit it with clicking on the curves or corner points. When you finish the 
profile definition press ENTER and the dialog comes back again displaying the ceiling with the new profile. See on the 
picture below. 

� See the description of the Edit Profile tool in Chapter 8.2.9 Editable profile. 
 

Resize profile 

 
You can resize the profile width and height values here. 
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1.68.8. Multiple lamps 

Design the lighting with groups of lamps 

Multiple lamps command allows you to plan lamps on the ceiling, or running front of the cornice, or build recessed lighting 
with profiled mouldings, or with false ceiling. 
 

 
 

With the Multiple lamps command you can quickly create variations of lighting with the changes of  

 
� location of the luminaires, 
� the number of light sources, 
� the host wall or ceiling’s profiles, shape, colour, texture. 

 Place multiple lamps 

Multiple lamps command allows you to plan lamps on the ceiling, or running front of the cornice, or build recessed 
lighting with profiled mouldings, or with false ceiling. 
You can find this command in  
You can find this command in Interior menu / Lighting or in the Interior menu of Toolbox / Lighting. 
 
Draw an open or closed chain along which the lamps will take place. You can use the appearing commands to draw the 
chain. By clicking on the right mouse button you can reach the Profile definitions commands. When entering a closed 
chain lights can be created within the enclosed area. 
After drawing the chain the Lighting dialog box shows up. Here you can specify the final allocation of lights. 
 
In the Lighting dialog box you can follow up the changes on top in the 3D and in the 2D preview in the right side of the 
window. Use the tab buttons (left side in the middle) to change between pages with various operations. 

 Lamp selection 

Select the lamp what you would like to use. If you would like to search for another lamp or modify the properties of the 
object, use the buttons on the right side. Use the Mirror option if you would like to mirror the object. 
It is possible to rotate objects around the X/Y/Z axes or move them along the X/Y/Z axes. 

 Profile 

You can specify the properties of the profile on the path and false ceiling in this tab with the use of three buttons on the left 
side of the window.  

 On the Section Profile tab you can add the profile section of a solid which you would like to create on the path. 
Using the buttons next to the selection of profiles you can choose another profile from the library or define a new one with 
profile editor commands. The width and height values of the predefined profiles are flexible, you can edit them and save 
the changes. Switch off the Show profile on the path option if you don’t want a profile along the drawn shape. If the False 
ceiling option is on and you define a closed chain as a profile, a false ceiling will be created in the enclosed area. To 
specify thickness of the false ceiling, enter a value into Thickness. 

 The program cuts the solid or false ceiling around the lamps. It is possible to specify these holes with a profile. This 
command (with the chosen profile) creates the hole from the bottom to the top of the lamp. Using the buttons next to the 
selection of profiles you can choose another profile from the library or define a new one with profile editor commands. The 
width and height values of the predefined profiles are flexible, you can edit them and save the changes. Switch off the 
Make holes in false ceiling option if you don’t want holes around the lamps. 
 

  On the Material tab you can specify the material of the created swept solid. 
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 Distribution mode 

On this tab you can specify the distribution of the lamps along the path. If you placed the group of lamps along a closed 
path, you can distribute the lamps in the enclosed area. 

 You can define on this along path tab the distribution of the lamps along the path and on nodes and endpoints. You 
can allow the lamps along the path with the Lamps enabled on path option and choose between the Full path or Each path 
one by one distribution. According to this you can enter the Number of items, Distance, First and Last value (because it 
depends on placement options). Fix these values with the padlock buttons next to them or the program calculates 
automatically them. 
Specific parameters: 
Number of items – the number of placed lamps 
Distance – the distance between the lamps 
First – the distance of the first lamp from the starting point 
Last – the distance of the last lamp from the endpoint 
Use the Lamps enabled on nodes option to place lamps on nodes of the path.  

 On this Area tab you can define the matrix distribution of the lamps in the enclosed area by the path if the Lamps 
enabled on area option is on. This tab is disabled in case of open chain. The details of the distribution and the placing 
options are similar to the distribution in along path tab but the values of rows and columns of matrix can be specified 
separately in the left/ right side if the same as horizontal option is switched off. It is possible to enter the rotation angle of 
the matrix as well. 

 General settings 

You can specify the general properties of the group of lamps, for example relative height, the 2D representation 
properties, the colour, the layer, etc. 
There are four modes of representation in 2D: 

� Top view – shows the false ceiling and the lamps in hidden line removal mode, 
� Symbol – shows only the selected 2D symbol on the place of lamps, 
� Top view  with profile – shows the top view and the profile of the path, 
� Symbol with profile – shows the symbol and the profile of the path. 

 Save 

You can save the crated or modified group of lamps into the Design Centre by using Save or Save as option. Here you 
can load those group of lamps which are already exist and modify them as well. 

 Modify some lamps in the group 

You have the possibility to modify the items of group of lamps one by one in 2D and 3D window as well. 

• Press Alt on the keyboard and click with the mouse in the same time on the group of lamps. The items of the 
groups become visible and the (open or closed) path. 

• It is possible to show or hide lamps, turn on or off the lights, move, rotate, elevate and mirror by clicking on 
the markers of the items of the group. 

• Choose Reset to delete these modifications. 

• You can delete all of the individual modifications by clicking on Reset custom lamps in the local menu of the 
group. 
 

 
 
 

�  The Elevate is enabled only in 3D window. 

 



 10. Building model 493 

ARCHLine.XP® 

!  The specific changes or a part of them may be lost if your modification of group of lamps in Lighting dialog box affects 
the distribution of lamps as well. 

 Modify the light source of the Multiple lamps  

The group of lamps uses only one kind of lamp and light sources of these lamps have the same settings. So one lamp 
represents the whole group.  
How to reach the light source settings? 

• Select the group of lamps. 

• Click on light sources button in the Properties tab. The light source properties of the selected group shows 
up. 

• The method of set light source properties is the same as in case of custom lamps. 
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1.69. Room and area 

Introduction 

The room collects general information about the closed areas in the building. 
 
Room has a closed boundary of room bounding elements, which can be walls or room contour lines. 
The room bounding elements are used to make rooms and compute area, volume and other detailed information. 
 
You can specify the floor finish and the wall finish for each room. 
Inside a room it is possible to define detailed facing materials for walls, ceilings and floors along with the connected 
material and labour costs. Layers with negligible thickness but high costs like scouring or smoothing can be also defined. 
 
With a help of Room the program automatically recognizes the inner border surfaces of a room and matches the defined 
covering layers of walls, ceilings and floors to the room dimensions. All these can be represented in 3D so the internal 
surfaces of various rooms will get realistic facing materials, which have special importance in interior architecture. 
Room functionality includes predefined room templates. Room templates make available to change or give the same 
internal covering layers to similar rooms. In room templates even user defined settings can be saved. Room follows the 
modifications made on the project. 
Detailed cost estimations can be created on the covering layers and rooms. 
 

 

Norms 

It is very important to ensure that the format and data of room stamps satisfy the requirements of various norms. In 
addition to the difference between various norm requirements architects have to cope with a lot of calculations that would 
be time consuming with the use of conventional methods. With a help of Room these calculations are made automatically 
which improves the architects’ work efficiency a lot. With certain limitations it is also possible to alter from the standard 
formats, which gives more flexibility to the user. 

Bordering surfaces 

Room is not only for creating standard room stamps which include the area, volume and other geometry parameters 
information but makes available the determination of real covering materials on side walls, slabs (on floors and ceilings) 
and roofs on the border surfaces inside a room. This means that all the inner covering information about bearing and 
partitioning walls, slabs (floors and ceilings) and roofs can be provided for a room, including plasters, coating materials, 
footings etc. The coverings of border surfaces of a room will determine 3D representation of a room inside. Additionally, 
basic data are provided for various cost estimations. These border surfaces may consist of more covering layers so the 
modelling of different work phases is also possible. This way Room will tell the information if the wall is wallpapered, 
painted or tiled, or if the floor is covered by carpet or parquet. 
 
Room makes difference between 4 basic surfaces inside a volume: 
 

� sidewalls, 
� footing, 
� floor, 
� ceiling. 
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Cost estimation 
Since Room includes geometry information (area, perimeter, volume etc.), materials and properties (thickness, layers, 
costs etc.) of the inside coverings (floor, wall, ceiling, footing), it makes cost estimations available. These estimations may 
include both material and labour costs. Lists can be created about the calculations in a required Excel format. 
Room is a complex object including a lot of data. Its properties can be specified in Room wizard dialog. The data are 
categorized and the left side gives information about the required inputs. At the bottom left of the dialog there is a preview 
of the actual Room that is being prepared. 
 

Room types 

The Room has two types: 

Room inside a wall 

If the room is bounded by walls use the  Room inside a wall command. Clicking inside the area bounded by walls the 
Room is created. The Room is associated to the walls. This means the Room follows the modification of the walls 
automatically or after the refreshing. 

Room inside a free polygon 

We suggest you to use  Room inside a free polygon command if the rooms haven’t got side walls, e.g.: balconies or 
rooms that have different functionalities but are not separated by walls or other border surfaces. 
In this case the Room is created by the user defined polygon. 
You can modify its boundary and the Room calculation follows the modifications. Of course this type of the Room is not 
associated to the walls, therefore does not follow the wall modifications. 
 
The Room tooltip signs the type of the Room. 

1.69.1. Room inside a wall and Room wizard 

If the room is bounded by walls use the  Room inside a wall command.  
Clicking inside the area bounded by walls the Room is created. The Room is associated to the walls. This means the 
Room follows the modification of the walls automatically or after the refreshing. 
 

• Select the  Room tool -  Room inside a wall command with the left button of the mouse.  

• Click inside the room bounded by single walls,  
The Room wizard dialog appears. This is the place where you can define the data you would like to visualize on the room 
stamp. 
 

� You can also set the Room properties before the placement. Click  Room tool with the right button of the mouse, or 

use the Building menu - Properties - Room command. 
 
First we describe how the Room wizard works in general, independently from the geometrical parameter inputs. It will 
help us in the area calculations of rooms defined by free polygon contours, too.  
 
When you place a Room you have to give the settings in the sub dialogs that can be found on the left side of the main 
dialog. The order of definition is arbitrary; it depends only on the optional area definitions you would like to take into 
consideration. These options can be found in the Norms and rules dialog. This is the place where other graphical 
information is needed from the drawing. (E.g.: freely defined areas have to be added or the transparent doors are also 
considered, etc.) In these cases you must enter the data of Room wizard in more steps.  
 

• First fill in the data of Norms and rules and Clear height sub-dialogs. If you select at least one option among 
the optional rules to which you have to define an input, the other dialogs (Room stamp text, Abbreviations, 

Border surfaces, Properties) become gray until you give all input necessary for applying the rules. Gray 
dialogs will be unavailable (see the gray colour text below because of the Minus freely defined area without 

condition option).  
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• Click Ok to leave the dialog temporarily and give the necessary information from the drawing (in our 
example you have to define a freely defined area that should be subtracted from the room area). 

 

• After giving the necessary optional 
inputs the Room wizard appears again 
and you can go on defining the Room in 
the Room stamp text, Abbreviations, 

Border surfaces, Properties and 2D 
borders sub-dialogs in an arbitrary order. 
When you get back after the inputs have 
been defined, the Norms and rules and 
the Clear height sub-dialogs are going to 
be gray. 
 

 

• OK Close the Room wizard. 

• Insert the Room on the plan. 

• Insert also the flat name if the Flat option is switched on in the Room stamp text dialog. 
 
The Room tooltip signs the type of the Room:  
Room inside a wall 

 Norms and rules 

 

 
Click Norms and rules to specify the norms and 
rules that have to be considered for creating a room 
stamp. 

Norms  

Three norms are available: 
 

� DIN 277 
� WoFIV (Wohnungsfläche Verordnung) 
� Norm I 

 
In each norm (depending on the norm) you can specify rules that should be considered in Room calculations. The norm 
defines which parameters have to be considered to create the area calculations. We are not going into details concerning 
the norms here. Based on the selected norm optional areas can be considered when the room stamp is calculated. These 
are as follows: 

DIN 277 auxiliary rules 

Minus freely defined area without condition 
With this option you can specify areas that should be subtracted in room area calculation.  

Plus freely defined area without condition 
With this option the user-specified areas should be added to the room area calculation. 
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If the stair has more than three steps 
For stairs with more than three steps you can specify if the stair area that goes below 2 m or the whole stair area should 
be subtracted in room area calculation. 
 

� At Din 277 auxiliary rule you don’t have to consider the area under the door in calculation.  

WoFIV auxiliary rules 

Minus freely defined area without condition 
With this option you can specify areas that should be subtracted in room area calculation. 

Plus freely defined area without condition 
With this option the user-specified areas should be added to the room area calculation. 

If the stair has more than three steps 
For stairs with more than three steps you can specify if the stair area that goes below 2 m or the whole stair area should 
be subtracted in room area calculation. 

Include area under doors 
With this option room area under doors should be also considered, too. 

Norm I auxiliary rules 

Minus freely defined area without condition 
With this option you can specify areas that should be subtracted in room area calculation. 

Plus freely defined area without condition 
With this option the user-specified areas should be added to the room area calculation. 

Minus stair area under height 
It doesn’t consider the stair area under height. You can determine this with the value on the right side. This rule considers 
all stairs inside the room.  

Plus niche area if > 
With this option niche areas will be added in the room area calculation if the recess of the niche is bigger than the value 
given in the input field. 
 

� This rule applied to such niches that have been created by objects using Insert into wall and Make only hole in the wall 

options.  

Transparent doors 
This option has importance in transparent area calculation. If you check this option the program will ask you to select 
doors with transparent parts (doors with windows).  

Minus columns area if > 
With this option only column area bigger than the value given in the input field will be calculated in the room area.  

Norm I other options 

Automatic search for columns 
With this option, all columns inside the room will be identified automatically and their areas will be considered in room area 
calculations according to the other settings. (Otherwise you have to select each column you would like to include in room 
area calculations manually.) 

 Clear height 

The usage of the Clear height dialog depends on what you want to specify within the room. You can either define the inner 
wainscotings in details, using the border surfaces or simply the total thickness of wainscotings should be defined. 
In the last case switch on the Disable room border surface templates option in the Border surfaces dialog. 

 

However, you can use the Clear height dialog to define the total thickness of wainscotings. This wainscoting thickness will 
be taken into consideration in the area and volume calculations. 
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In case of building in attic the following figure appears in the dialog: 
 

 
 
By turning on the Disable room border surface templates option the input fields for wainscoting thickness appear. These 
wainscotings will not appear in 3D representation but the thickness values will be taken into consideration in the area and 
volume calculations according to the selected norm. In this case 3 thickness parameters can be defined: 
 

� Thickness of the wainscoting of the floor (in the example above it is 20 cm). 
� Thickness of the wainscoting of the wall (in the example above it is 5 cm). 
� Thickness of the wainscoting of the ceiling (in the example above it is 10 cm). 

 
By turning off the Disable room border surface templates option the 3D model representation includes the wainscoting 
layers according to the settings made in the Border surfaces dialog. The wainscoting layer thickness will be taken into 
consideration in the area and volume calculations. 
 

� It is a general rule that surfaces under the level of Room height will be covered by the wainscotings. 

Room height 

Room height means the height of the room without wainscotings and this is the basis of the clear height calculation.  
The room height can be defined one of the followings: 
 

� an input value, 
other room bordering architecture objects: 

� the bottom face of slab, 
� the highest point of the roof inside. 
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Input value 

Room height means the height where the wainscoting of the ceiling starts from downwards (in the example above it is 270 
cm). (This way suspended ceilings can be created.) In case of building in the attic the top plane of the ceiling will be 
placed on this height. Above that height the roof will not be covered inside. 

Coating up to the slab 

The room height will be defined by the bottom face of the slab above the room. The requested wainscotings start from this 
height and go downward. 

Coating up to the roof 

In this case the room height will be defined by the highest point of the roof inside. This means that the whole roof will be 
covered inside. 

 Room stamp text 

 

Click Room stamp text to specify the room stamp data 
you want to place on the 2D drawing. 

 
Depending on the norms you can check the following data: 

DIN 277 norms 

Room kind parameters 
� Room name. Select a name from a roll down list or submit another one. (The list is loaded on the basis of DIN277.* file of 

the Support directory.) 
� Room code. Select a standard code from the roll down list.  
� Flat. You can decide to which flat the room should belong, and whether to place the flat name in the room stamp or not. 
� Undercutting type. Select a standard type from the four different types of the combo box. 

 
Room parameters 

� Gross area. Automatically calculated by the program or specified by the user. 
� DIN 277 area. Automatically calculated according to DIN 277 standards or specified by the user. To calculate the net area, 

the program uses the 1.90 inner height according to the norms 
� WoFlV area. Automatically calculated according to DIN 277 standards or specified by the user. 
� Illumination area. Automatically calculated by the program or specified by the user. Net value includes only the surface of 

the transparent materials. Gross value includes the area of frames and dividers of openings, too. 
� Perimeter. Automatically calculated by the program or specified by the user. 
� Height. Equal with the ceiling height given in the Clear height sub dialog or specified by the user. 

 
Other parameters 

� Hatch. The background colour of the room on the 2D drawing can be specified here.  
� Room number. Any numbering or text can be specified here. 
� Floor level. The floor level can be specified here independently from the values given in the Clear height sub dialog. 
� Slab level. The slab level can be specified here independently from the values given in the Clear height sub dialog. 
� Floor material. Select a floor material from the roll down list or specify another one. 
� Wall material. Select a wall material from the roll down list or specify another one. 
� Ceiling material. Select a slab material from the roll down list or specify another one. 

WoFlV norms 

Room kind parameters 
� Room name. Select a name from a roll down list or submit another one. 
� Flat. With this option you can select a name from a roll down list or specify another one. After placing a room stamp you 

can place this string separately on the 2D drawing.  
� Room kind. Select a standard type from the roll down list. 

 
Room parameters 

� Gross area. Automatically calculated by the program or specified by the user. 
� DIN 277 area. Automatically calculated according to DIN 277 standards or specified by the user. 
� WoFlV area. Automatically calculated according to DIN 277 standards or specified by the user. 
� Illumination area. Automatically calculated by the program or specified by the user. Net value includes only the surface of 

the transparent materials. Gross value includes the area of frames and dividers of openings, too. 
� Perimeter. Automatically calculated by the program or specified by the user. 
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� Height. Equal with the ceiling height given in the Clear height sub dialog or specified by the user. 
� Area factor. Depending on the type of room you may have to apply a factor for the official area calculations. Select a factor 

from the roll down list. Room areas will be multiplied by the area factor. 
 
Other parameters 
The same as for DIN 277. 

Norm I norms 

Room kind parameters 
� Room name. Select a name from a roll down list or submit another one. 
� Room code. Select a standard code from the roll down list. 
� Flat. With this option you can select a name from a roll down list or specify another one. After placing a room stamp you 

can place this string separately on the 2D drawing.  
 
Room parameters 

� A - Net area. Automatically calculated by the program or specified by the user. 
� Volume. Automatically calculated by the program or specified by the user. 
� Illumination area. Automatically calculated by the program or specified by the user. Net value includes only the surface of 

the transparent materials. Gross value includes the area of frames and dividers of openings, too. Calculation results 
depend from the settings under Light transmission of openings. 

� Ratio (Area). The ratio between illumination area and room area. 
� 1/A. With this option the Ratio (Area) is given in 1/A form, where A is an integer.  
� Perimeter. Automatically calculated by the program or specified by the user. 
� Height. Equal with the ceiling height given in the Clear height sub dialog or specified by the user. 

 
Other parameters 
The same as for DIN 277. 
 
Illumination area calculation 

� Openings. Select an opening to set its light transmission parameters. On the right side the drawing of the selected opening 
appear in a small window so that it could ease the identification. The first number of the field is an identification that is also 
a part of the gray header of the Tooltip, and identifies all objects of the drawing. 

� A - Net area. Transparent area of the opening calculated by the program according to the subsequent settings. 
� Under slab. With this option you can specify a ratio. Net area will be calculated using this multiplier. Generally it is used for 

openings that are partially hidden from light (for example openings under balcony). 
� Ratio (Area). This is the multiplier the program will use if the Under slab option is checked. 
� Considered part under 60cm. In case of doors glass surfaces below the height of 60 cm are considered in illumination 

area calculations. 

 Abbreviations 

 

Click Abbreviations to specify the abbreviations 
assigned to the room stamp text data. 

 
You can specify the abbreviations for each room stamp text data. The abbreviations and room stamp text data will appear 
together on the room stamp: 
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 Border surfaces 

 

Click Border surfaces to specify the finishing (covering 
materials, work phases) of the room border surfaces. 

 

 

 Here you can specify the 
covering materials and the 
connected work phases of room 
border surfaces. These are real 
layers with thickness and other 
properties that can be 
represented by 3D generation. 
On the right side you can select 
from the room border surface 

templates that have already 
been prepared.  

 
 

• Switch off the Disable room border surface templates, and then the names become active.  
 

 
 
These are the templates which can apply covering materials and work phases to the given border surfaces according to 
the materials of the room border surfaces (wall, slab, roof). It means that when the wall is created we define the material of 
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it (brick wall, glass wall, steel structure, etc), and we create rules within the templates. These rules define the covering 
materials of the given room border surfaces (floors, walls and ceilings). The program creates these layers automatically 
based on the settings of the templates. (They can be visualized in 3D and they are also a part of the cost calculation list.) 
These Room border surface templates can either be modified or new can be created according to your own needs. 

 
Do not forget that the modification of these Room border surface templates modifies all the room stamps of this kind that 
have already been placed.  
E.g.: If you have selected the Flat/WC room border surface type for the toilettes of the building and you change the 
covering material to a more expensive one in this Flat/WC room border surface type, the covering will be modified in all 
rooms of the building that uses this room border surface type. The advantage of this function is that these kinds of 
modifications can be compared to each other; therefore cost calculations can be made quickly. 

  
If there is a type you would like to use, select it from the list. If you cannot find the room border surface template you like, 
create your own as it is defined below, or modify the existing types, or just have a look at their contents. The usage of the 
following dialog defined below is offered only for advanced users: 
Double clicking on the selected room border surface template the Conditional material surfaces dialog appears.  
On the left side of the dialog you can find the template names in a directory structure, on the right side the conditional 
material surface settings can be seen: 

 

 
 
If room border surface materials are known in the rooms, room border surface templates determine the subsequent 
finishing materials and the connected work phases. The program searches for room border surface materials on the room 
border: on floor, wall plane and ceiling. Depending on the found material the program assigns subsequent covering 
(finishing) materials and work phases to each border surface. 
 
The program searches for the room border surfaces first: the floor border surface must be slab, the wall plane border 
surface must be either wall or column, and ceiling border surface must be slab or roof. After that the finishing (covering 
materials and work phases) will be created for each border surface depending on the Room wizard - Border surfaces 
settings. 
 

� The files for room border surface templates can be found in the installation directory in 

Support\AttrsetsEng\RoomTemplates folder. These files are in XML format.  
 
Conditional material assignments to the wall plane, footing, ceiling and floor can be specified for each selected 
template on the right side of Conditional material surfaces dialog. 

Conditional material surface settings for floors, wall planes, ceilings and footings 

Material and work phase assignments to wall planes, ceilings and roofs go the same way. 
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• First select a material category from the combo box. A ‘*’ before the category name denotes that some 
assignment already exists to that category: 
 

 
 

Each room border surface material belongs to a material category. Depending on the material category of a room border 
surface you can define the finishing (covering materials, work phases) of the surface in table rows, going inside towards 
the inner part of the room. 
 

� Material assignments to the material categories (except with the category named Any) can be found in the installation 

directory in Support\RoombookEng.mc file. This file has XML format. Material names in the categories refer to the 
material names found in .mtr material description files (by default these .mtr files can be found in the installation dir in the 
Materials folder. Click Edit material categories to modify these categories. See the details later in this chapter. 
 
If the surface material of a bordering architecture object (wall, slab, column,) is not found in any material category then the 
Any category will be considered for that surface. 

• Click  to assign a new description code to a material category. A description code can be either a 
covering material or a work phase. Description codes can be selected in the Select code name dialog. See the 
details later in Handling of description codes.  

• Code, thickness, description, factor and material fields can be specified in one row. By clicking on the code 
field you will get back to Select description code dialog. Thickness, factor and material fields are freely 
editable in this dialog.  
The Factor field is a multiplier for the cost calculations. The Material filed shows the name of the material 
that is used when this layer is visualized in 3D.  

• Click  to delete an existing layer. Select the row first: click in the thickness, description or factor fields to 
do so. 

Conditional material surface settings for footings 
Conditional material surface settings for footings works similarly to the conditional material surface settings for wall planes, 
floors and ceilings. The difference is that instead of thickness and factor there are width and base height fields. The value 
given in base height field determines the bottom height of the footing. The value given in the width field determines the 
strip width of the footing. This way more decoration strips can be created. Footings are different from the other border 
surfaces. Footings have no material thickness so they will appear in 3D visualization as decoration stripes. 

Handling of room border surface templates 
With the buttons on the bottom-left of the Conditional material surfaces dialog room border surface templates can be 
handled similarly to the sets: 
 

• Click New to create new template.  
 

 
 
With the example above you can create a Living Room template in the Exclusive Flat directory. 
 

• Click Delete to remove a selected template. 

• Click Activate to make the template active. 

• Click Modify to save the modifications you made in the active template. The modifications will be saved in 
your project file. If you open a new project you will not see these modifications. 

• Click Rename to rename an existing template.  

• If you have modified any templates and try to leave the dialog the following message appears: 
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• Choose Overwrite the original set if you want to overwrite the original template. By choosing The changes 

will be saved in a new set you can save the modified template with another name or get back to the dialog. 
 
You can save the created room border surface templates into sets, then the sets to template files. So you can use the new 
preferences in the new project too.  
 

� See 3.2.3. Using sets of properties and 4.6. Managing templates chapters. 
  

! Don’t confuse room border surface template with Template file! 

Handling of description codes 

In the Conditional material surfaces dialog you can assign description codes to material categories. These description 
codes are handled in a separate file. You can manage these names in Select code name dialog. By default the 
Support/RoomMatEng.rbm file that can be found in the installation directory is loaded. However, you can load any other 
file with .rbm extension and similar format by clicking on Load external code file.  
On the left side you can select the required main group and sub group: 
 

 
 
The entries belonging to a sub group can be found on the right side of the dialog. These are codes of covering materials 
and work phases needed for finishing the room border surfaces that can be assigned to material categories of each border 
surface and footing. You cannot modify the original entries. New main groups, groups and entries can be 
created/deleted/renamed right mouse click or double click. An entry consists of code, description, material and price fields. 
Entries can be modified by double clicking. 
 

 
 
Click Ok to get back to Conditional material surfaces.  
The selected description code will be assigned to the actual material category and room border surface. Click Cancel to 
close the dialog without any modification. 
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Edit material categories 

• Click Edit material categories in the Conditional material surfaces dialog to modify the existing material 
categories. 
  

 
 

• Click  to add a new category or add a new material to the selected category. 

• Click  to delete the selected category or delete the selected material from the selected category. 

• Select the Save to global environment option and Click Ok to overwrite the content of your 
RoombookEng.mc file in the Support directory of program installation dir. In that case, you will see these 
material categories when you create a new project file. Without this option, the changes will be saved only 
in your project file. 

Embedded wainscotings option  

Depending on countries, there are different requirements against the modelling of Room wainscotings. 
In some countries, it is preferred to start from clean walls and cover these walls with wainscoting layers: 
In other countries, it is preferred to take wainscotings into consideration the as part of the walls: 
In that case, the wainscotings start from the inner wall surface and go to the outside direction. As a result, wainscoting 
thickness will not increase the wall thickness in the 3D model. The same is applied on other room bordering objects like 
slabs, roofs etc. 
 

• In the File menu -Options - Room dialog box select Embedded wainscotings option if you want to handle 
wainscotings as part of room bordering architecture objects. 
 

 
 

� In addition, you can create wainscotings for the outer walls by the Calculate Room outside the building Room 

command. However, we do not recommend using this option because of the incorrect wainscoting connections in the 
wall corners. 
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 Properties 

 

Click Properties to specify the visualization settings of 
room stamp. 

 
Room stamp data are organized in a table. On the top of the dialog you can specify the borderline type, borderline colour, 
border line thickness and priority, layer properties.  

 

 
In the Room wizard dialog the table text parameters of room name, room data, room number and flat name can be 
selected from text sets. 
You have to determine the features of text sets in advance in the Text Properties dialog box, or you have to create the 
proper set. Therefore, when you give the table properties of the Room, you just have to select the proper text set.  
You can also determine the line gap. 
 
With the Draw frame option the room stamp text will be bordered. 

Room partitioning properties 

On the bottom of the dialog you can switch on the Room partitioning enabled option. With this option the room will be 
partitioned into triangles, rectangles and circle pieces and the program automatically creates the dimensioning (side 

lengths) of these partitions. It works like  Room tool -  Room partitioning and dimensioning command on the left 
side. The only difference is that the details of area calculations will not be placed.) If you create room partitioning and the 
Room partitioning enabled option is switched on, you can specify the properties of the partitioning objects: the font type 
and height of the text used for the length dimensions, line type for the partitioning lines, colour and layer for the text and 
lines.  
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 2D borders 

 

Room profile  

By turning this option on the room stamp will include the room boundary, too. If you created this Room with free polygon, 
this boundary can be modified. In the following example there are two room stamps with Room profile in one room. 
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Representing the net area 

Using the options in the Room wizard dialogs it is possible to represent the real room boundary and the contour lines of 
the net area belonging to height of 1.9 m height. Also, the properties of these lines can be set here: 
For example on the floor plan of a building in the attic different line properties can be used for the room boundary and the 
net area contour. 
 

 
 

 
 

� At calculating of net area the program takes the default 1.9 m, in File menu -Options - Room dialog box, for basis.   

 Room Custom Stamp 

Instead of using the rigid form and look of room stamp defined on Room stamp text and Abbreviations pages, you can 
create and use your own style of Room stamp with a better look and free text layout.  

Creating a new room stamp template 

• Create a room stamp on the floor plan using drafting elements like lines, texts and hatches. This will be the 
skeleton of your customized Room stamp. 
 

 
 

• Use the Building menu – Room – Customize – Add parameter command to insert Room data variables into 
the skeleton.  

• Select variables you would like to insert into the skeleton in the Room Custom Stamp dialog and then place 
variables in the appropriate order into the skeleton. After that, you can still change the text format of the 
variables, if necessary. 
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• Use the Building menu – Room – Customize – Create Stamp command to create and save the final form of 
your customized Room stamp. 

• Select Room stamp elements you created before with rectangle selection. 

• Specify the reference points you can use when you will place your customized Room stamp. 

• Specify the name of your custom Room stamp to save it into your group library. 
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Using a predefined custom Room stamp 

As soon as you created and saved your custom Room stamp into the Room Custom Stamp category, you can use it for 
placing a Room stamp. 

• Click Room Custom Stamp in Room wizard. 

• Make the Room Custom Stamp enabled and select a predefined Room custom stamp. 
 

 
 

• Be sure that you enabled the necessary variables on Room stamp text page. 

• Enter a different scale factor if you want to make your room stamp larger or smaller. 

• Click Ok to close Room wizard dialog and place your customized Room stamp with the actual data. 

 Connection between Room sets and room border surface templates 

Similarly to other sets of architectural objects it is possible to manage Room sets, too. Click Sets in the Room wizard - 
define set dialog to manage Room sets. Sets dialog will appear on the right side. You can manage sets as usual using 
the buttons on the bottom of the dialog. 
 
For a given Room set the following Room settings are stored: 
 

� Norms and rules. 
� Clear height. 
� Room stamp text. 
� Abbreviations. 
� Border surfaces: only the name of the room border surface template. 
� Properties. 

 
The room border surface template settings (conditional material surface settings - description codes) don’t get saved in a 
Room set. Only the name of the used template is stored in the set. This means that a modification in a room border 
surface template will modify all the Rooms which use this template. 
Let’s create a set with the name Arcadom living rooms, for example. Arcadom living rooms set uses the Living room 
template. 
 

 
 
The conditional material surface settings of wall plane in Living room template are the followings: 
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Let’s modify the Living room template so that the last layer (emulsion paint called Disperzit) is replaced by wallpaper. 
 

 
 

• Click on OK and select the Overwrite the original set option. 
 
From now on if you create Rooms by Arcadom living rooms set or update your existing Rooms based on Arcadom living 
rooms set then the last layer of these Rooms will be set automatically to wallpaper without changing the settings of 
Arcadom living room set. 

1.69.2. Serial placing of more Rooms 

By this command you can quickly create Rooms in different rooms in sequence. In this case, the program will use the 
activated Room set and there is no way of applying rules that require input (for example manual selections of freely 
defined areas are not possible).  
 

• If You click right on the  Room tool, in the appearing Room wizard dialog select the proper Room set (or 
set the preferences), which You would like to use by Room placing. Ok 

• Point inside a room bounded by single walls.  

• Place the room stamp. 

• Repeat the above steps for other rooms, too.  

1.69.3. Room inside a free polygon  

Using the command the Room is created by the user defined polygon. 
You can modify its boundary and the Room calculation follows the modifications.  
 

! Of course this type of the Room is not associated to the walls, therefore does not follow the wall modifications. 

 
This command does not consider the surrounding walls, slabs or roofs; only a right prism with a polygon base will be 
created. 
 

We suggest you to use  Room inside a free polygon command in the next cases: 
 

� To create separate Rooms to areas that have different functionalities but are not separated by walls or other border 
surfaces. 

� This command is also very handy if you have areas you want to include in the room stamp calculations but these areas 
haven’t got side walls and roofs like balconies. In this case, it is enough to define the coverings for the floor only so other 
coverings will not appear in 3D.  
 

• Define a closed chain. Use the keywords if necessary. 

• Define the height of the room. 

• In the Room wizard dialog specify the Room parameters and close the dialog. 

• Place the room stamp on the drawing. 
 
The tooltip signs the type of the inserted Room:  
Room inside a free polygon 

•  

1.69.4. Modify the boundary of the Room 

With this command, you can modify the contour of an existing Room. 
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• Select the room stamp of the Room you want to modify. 

• Modify the profile of the room contour using the profile editing tools. 

•  
According to the changes made in the contour the Room will be updated. 
 

� The command is valid for the Rooms, which were created by the  Calculate Room inside a free polygon command. 

1.69.5. Calculate Room outside a building 

With this command you can place room stamps where room stamp data calculations (area and volume calculations) are 
applied on the outer contour of the bordering walls / buildings. Conditional material surface settings do not work here. 
 

• Select the outer walls of the building or define the outer contour using the POLYGON keyword. 

• In the Room wizard dialog specify the Room parameters and close the dialog. 

• Place the room stamp. 

1.69.6. Diagonal measuring 

By this command rooms bounded by walls can be divided into triangles using the diagonal measuring method. The 
program divides the room into triangles and creates a list, including the area of each triangle and sum of the triangle 
areas. This method is used as a verifying procedure for area dimensioning. 
This method can be used even for arched walls. In this case we have to define the resolution of the arc. 
 

 

1.69.7. Room partitioning and dimensioning 

This command can be found in Room tool. With the help of it the area of a room can be divided into rectangles. The 
program assigns numbers to the partitioning and shows the main dimensions in the selected rooms, and it is possible to 
place expressions verifying the results.  
 

• Click inside a room to create its division into rectangles. 

• The program automatically divides the room, numbers the parts and writes the parameters. 
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• Place the verifying expressions with the mouse wherever you want. These expressions show in details the 
area calculations of the area parts and it calculates the total area. 
 

 
 
Room partitioning with rectangles as a possibility can also be selected at the bottom of Room wizard - Properties dialog 
when you put the Room on the drawing, but the expressions verifying the area calculations cannot be placed in this case.  

1.69.8. Summarize flats 

A table summary can be created about flats and rooms with room stamps based on the current floor or the whole building. 
You can customize the tables as follows. 
 
The Summarized Room report dialog appears. Here you can compose your table for the report. Each row in the dialog 
represents a column in the report. 
 

 
 

• Use the Add button to add a new column to your report. The new object will appear in the last row. 

• Click All to add all options in a default order to the report. 

• Select an index and click Delete to delete a column from the report. 
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• Click Delete all button if you want to delete all columns and start the composing again. 

• Use the arrow buttons to move the selected object up and down. 

• Click on a column title to select another title from the roll down list. In the roll down list you can see all 
options available. 

• Click Ok to finish the composing of the table and then  

• Select the option Current floor or All floors to create the table based on the current floor or the whole 
building. 

• Insert the table on the drawing. 
 
For the composing of the table we suggest the following methods: 
 

� First use the Add button to add all columns you need in the appropriate order, then delete the unnecessary ones. 
� Use the Add button to create as many columns as you want to see in the table, and then do the column title assignment in 

each row. 
 
The alphabetical ordering in the table is made first by floors, and then by flats.  
The table structure is saved into the Support/RoomBookStamp.xml file so next time the program will remember to the 
previously defined table structure. 
 

� Empty columns are automatically detected by the program and will not appear in the table you place on the drawing. 

 

The  Refresh all command refreshes all the Rooms which were created by the Room inside a wall command on the 
drawing and the related summary table of all Rooms. 
The automatic refreshment will be executed on the first placed summary table on the drawing. The automatic refreshment 
is only an option. You can cancel the refreshment. In that case the table will be deleted. 

 Info apartments 

The command lists the used area of the rooms and sums them based on the apartment and floors in .rtf format (e.g. 
Word).  

 

 Info rooms 

The command prepares a detailed list about the rooms in .rtf format (e.g. Word): 
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1.69.9. Show Room volume solid 

The command: Show room volume solid – all Rooms. Generates the 3D volume of Room. 
  

 

1.69.10. Refresh all Room 

The command Refresh, refresh all the Rooms which were created by the Room inside a wall command on the 
drawing and the related summary table of all Rooms. 

Refreshing Room 
When you made changes on existing rooms that have room stamp data and these data are not valid because of the 
changes, by this command you can update all room stamp data automatically. 

Refreshing summary table  
If the summary table exists on the plan, before closing the Refresh command the Summarized Room report dialog 
appears and you can refresh the first instance of the Summarized room-book table placed on the drawing. 
Attention: Closing the dialog with Cancel button the first instance will be deleted from the drawing! 

Automatic area recalculation 
If you switch on the Automatic area recalculation option in the File menu- Preferences – General – Room dialog, the 
Rooms which were created by the Room inside a wall command follow the area modification. 

 

� The refreshing might take a long time, therefore we suggest you to switch off the option and use the Refresh command. 

 

1.69.11. Colour schemes 

Colour schemes are useful for visual representation of room categories. You can create a colour scheme by room area, 
type, or zones.  
Colour schemes represents rooms in floor plan by colours that you define.  
 

• Click Building - Room & Area – Colour Schemes. 

• In the Choose Color Scheme dialog select the color scheme and click OK,  
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• In the Edit Color Scheme dialog, assign colours from the list and click OK. 
 

 
• Click Ok to execute the command. 

 
The program will search and colour Rooms (set the hatch property for each Room) according to the settings. 
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� To cancel the colouring switch off the Hatch room option in the Room Properties dialog. 
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1.70. Stair 

Introduction 

 
The stair is one of the most complex architecture objects, especially in case of irregular stairs. It is easy to handle this 
complexity with ARCHLine.XP® functionalities which provide different possibilities of creating stairs. In case of new 
projects it is very handy to use predefined stair types first. Later the program enables to change the stair geometry as you 
like. This way the creation of irregular stair geometry can start with a predefined stair which gives freedom to the architect.  
The method of stair by threads can be used for special stair geometry or for stairs with given dimensions in a surveyed 
building. 

Stair ergonomics 
It gives help in design, in case of stairs chosen from the stair folder, if you look after continuously during the design, that 
ergonomics requirements specified in standards be realized. The ARCHLine.XP® signs the stepping over limits according 
to the DIN standard with red colour to the user. 
It doesn’t forbid the creating of the stair, if it doesn’t come up to ergonomics requirements. 

Cutting out slabs above stair 
The program enables to cut out slabs above stair. The program recognizes the slab(s) above the selected stair and cuts 
them out by command. The cutting width is determined by the stair width. The cutting length is determined by the free 
height defined by the user among the stair standards: the program searches for the stair step where the level difference 
between the bottom of the slab and the stair step reaches the free height. This way a man who is not taller than the given 
free height can go up to the stair. 

1.70.1. Stair standards 

If you monitor continuously the ergonomic requirements defined by standards in case of stairs selected from the stair 
library, it can help you in the drawing of stairs. For this give possibility the File -Preferences - Stair standard dialog box.  
 

� See the description in the chapter 3.1.5. Setting stair standard. 

1.70.2. Stair properties 

The general stair properties have to be defined before placing a stair. These properties are available through either the 

 Stair tool by right mouse click, or in the Building -Properties - Stair menu. 
Any change in the settings will be applied to the stairs constructed afterwards.  

 Stair parameters  

 

Click Stair properties on the left side. 2D view 
properties will appear: 
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Stair properties 

General 2D view settings can be made here: colour, width, layer, line type, priority.  
 

� For detailed description of Stair properties see chapter 3.2.1 on Specifying general properties, for Internal 

variables see chapter 3.2.4. on Assigning cost variables, for Sets see chapter 3.2.3. on Using sets of 

properties. 

2D view 
� You can specify the Nosing line type and its visualization. You can select from three visualization options: without nosing 

line, with nosing line along the stair and with nosing line up to the section line. 
 

 
 

� The visualization of cutting line is optional: the cutting elevation and the cutting line direction can be set. Partial line type 
and its visualization can be set, too.  

 
 

With the Section line – Wavy option you ca make the section line wavy:  
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Right clicking on the stair symbol and choosing Edit one side / Offset lets you handle one side of a stair as a single unit, 
instead of edit it thread-by-thread or node-by-node. 
 

 
 

Cut out rest of walking line 
Using this option, the program cuts the rest section from the walking line.   

Walking line before landing 
Using this option, the arrow of the walking line goes through the section line and stops before the landing. 
 

 
 
OFF  ON  ON 
 
On the last image the Cut out landings on walking line option is switch on.  

Walking line backward 
Using this option, you can reverse the direction of walking line. 
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Arrow fit the box 
The visualization mode of the walking line can be 
selected from a drop-down list. Different arrow 
types and the arrow fit the box option are 
available.  

Numbering 
The numbering of the stair steps is also possible. 

  

Show geometry text 
Show geometry text option will place the number of stair steps, the riser and tread on the walking line when the Text on 
walking line option is switch on, otherwise it will go below the 2D drawing of the stair. It doesn’t place, if you switch off the 
Show geometry text option.  
 

 

 Support 

 

Click Support the left side. 3D view properties will 
appear: 

 
Basic settings for stair 3D model can be set here. 
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� You can specify the elevation where the stair starts from. Elevation is relative to the related floor. 
� 3D creation. In the 3D window, the stair will not appear if you switch off this option. 
� Cut the walls. With this option, walls can be cutted by the stair. The cutting options are: own floor, all floors, no cutting, on 

own floor and below,   
� The architecture of the stair is optional. Either you can define a ramp with the Ramp option, or a stair with its components: 

Waist slab, Tread, Riser board. In case of ramp choice you cannot select the options of stair components. Independently 
from ramp or stair selection, you can apply the Support option.   

Ramp settings 

In case of ramp selection the program converts the stair into ramp. A message asks you to confirm this operation. The 
material of ramp can be defined by the waist slab material. The thickness of the ramp can be defined by the waist slab 
thickness parameter. You can also use the Construct the landing like a slab option. 

Section profile 
By default, the section of the ramp is rectangular. With the Section profile option you can define a different section by 
specifying a profile for the section. Either you can select a profile from the profile library or define a custom profile by 
editing the profile on the floor plan with the profile editing commands. Both profile definition options have an ellipsis button. 
Once you have selected a profile from the profile library by clicking on the ellipsis button for profile selection, the name of 
the profile appear beside the ellipsis button. Once you have edited the profile by clicking the ellipsis button beside Edit 
profile, User profile appears beside the ellipsis button for profile selection. 
 
By selecting the Waist slab option, you can convert the ramp into stair and the stair setting options will be available. 

Stair settings  

� In case of waist slab choice the waist slab material and thickness are available to set.  
� By the tread option you can place cover slips on the waist slab. Without waist slab option only the cover slips will appear. 

This way stairs with steelwork can be constructed.  
� For the tread you can specify the material, nosing depth and tread thickness. 
� You can place riser board between stair steps by checking this option. You can specify their material and thickness 

independently from treads. 

Support settings  

� By support option you can place supports on one side or on both sides of the stair or ramp.  
� Explanation to the support cutting settings: 

 

 

 
Right side vertical cut off at start is 10 cm; left 
side vertical cut off at start is 0 cm. Vertical cut 
off starts form the height of the first stair step 
downwards.  
Right side horizontal cut off at start is 10 cm; left 
side horizontal cut off at start is 0 cm. Horizontal 
cut off starts from the first nosing line outwards. 

 

Right side vertical cut off at end is 10 cm; left 
side vertical cut off at end is 0 cm. Vertical cut 
off starts form the height of the last stair step 
upwards. 
Right side horizontal cut off at end is 10 cm; 
right side horizontal cut off at end is 0 cm. 
Horizontal cut off starts from the back contour 
line of the last step outwards. 

Construct the landing like a slab 
Enable Construct the rest like a slab option to convert the bottom surface of the rest to a horizontal plane in case of stairs 
with rests. See the U form divided stair, for example. 
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Connection to the upper slab 
You can define the connection to the upper slab. There are three options: 

 
1.

 

 
In this case you can align the bottom of the connected slab 
with the bottom of the last step of the stair by the C 
parameter. 

2. 

  

In this case the bottom of the stair may run behind the last 
step of the stair, giving the possibility to keep the bottom of 
the stair straight. The C parameter must be equal with the 
thickness of the slab. 

3. 

 

In this case you can use the A, B and C parameters as shown 
on the figure, to create a smooth connection between the 
stair and the upper slab. 

 

Connection to the bottom slab 
You can define the connection to the bottom slab, too. There are seven options:  

1.

 

In this case the stair is independent from slab. The C 
parameter is irrelevant. 

2. 

  

In this case the stair starts from the base height. This 
connection is independent from slab thickness. The C 
parameter is irrelevant. 

 
The next connection types are used between floors: 
 

3. 

  

The bottom of the stair is aligned to the bottom face of the 
slab. Slab thickness (C parameter) is required. C parameter 
also defines the waist slab thickness, therefore you cannot 
modify the waist slab thickness. 
 

4. 

 

The bottom of the stair is cut horizontally according to the 
slab thickness. Slab thickness is required. Stair waist slab 
thickness will not change. 

5. 

 

The A, B and C parameters can be used to define the smooth 
connection between the stair and slab, in case of the 
connection type shown on the figure. 
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6. 

 

The A, B, D and E parameters can be used to define the 
smooth connection between the stair and slab, in case of the 
connection type shown on the figure. 

7. 

 

The A and B parameters can be used to define the smooth 
connection between the stair and slab, in case of the 
connection type shown on the figure. 

 Balustrade settings 

Click Balustrade settings on the left side. Predefined balustrade types will appear: 
 

 
 

� You can specify whether the Balustrade will be generated on the left side and on the right side. 
� The Regenerate checkbox can be activated when you modify an existing stair. The regenerate balustrade feature restores 

the original balustrade form deleting all eventual manual changes you did on it  

1.70.3. Creating stairs 

There are three ways of creating stairs. 
  

� Predefined stairs (stair library) 
� Stair by outline and landing (stairway) 
� Stair by threads (only the profile of the stair steps are given)  

You can create and place stair using the first three commands in  Stair tool: 

 

 

Stair - Predefined 

These are predefined stair forms in library with variable properties. The common stairs can be constructed this way. 

Stair - By outline and landing 

When you create a stair in this way, first you have to define the location of the stairway, and then you can divide this 
stairway area into stair steps. First you have to decide on the location of the stair by giving its route. This will be a stairway 
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defined by the right and left sides of both arms. All stair steps will be inside this area. The next step is to divide this area 
into stair steps by giving the geometry.  
The line sections given on both sides of the arms will be divided by the number of stair steps. The tread of stair steps will 
be equal to the length derived from the divisions. The rest will be resulted from the area between the arms.  

Stair by threads 

Many times you need stairs that are not found in the predefined stair library and cannot created by defining simply the 
arms, or even the rising of the stair steps is not equal along the arms, e.g. in case of surveyed stairs. Stair by threads 
method will help in these situations. In that case the step height can be assigned to the individual stair step profiles. 

  Predefined stairs 

This is the simplest way of creating new stairs. The predefined stairs library contains the most commonly used stair types. 
The method is the following: 
 

� Stair type and reference point selection 
� Graphic placing  
� Construction parameter settings 
� 2D view properties 
� 3D view properties 

Stair type and reference point selection 

•  

  
 

• Select your stair type and reference point. The active reference point is denoted by a red square. Close the 
dialog with Ok. You can place now the stair in the drawing with the selected reference point.  

• Place the stair on the 2D draw with the cursor by giving the main geometrical points. 

• At the main geometrical points you can use the keywords in the Command line if you want to change the 
stair route direction or you want to define a reference point on the opposite side. 
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Options: 

 
 

Right/left side You can define the point on the opposite side of the 
stair. 
 
 

Mirror In case of spiral stairs you can change the route 
direction. 
  
 

Width Define the width of the stair 
 
After placing a stair the Predefined stairs dialog box will pop up. Here you can set the construction parameters, 2D view 
and 3D view properties.  

Stair Calculator 

 

 

Click Stair Calculator to specify the parameters of the steps and the geometry of 
staircase. The available stair geometry parameters depend on the stair type. 

Parameters of the steps 
Depending on the stair type different parameters appear. Each parameter is denoted by a drawing symbol as follows: 
 

 

Total height of the stair (H) 
Check the Take the floor height option if you want to make the stair and floor height equal automatically. 

 

Stair ergonomics (2h + w) 
Beside the actual value the minimum and maximum values defined in the stair standards are shown 
here. If the actual value exceeds the stair standard limit the background of the field will change to red. 

 

Tread (w) 
Beside the actual value the minimum and maximum values defined in the stair standards are shown 
here (see the description of Stair standards). If the actual value exceeds the stair standard limit the 
background of the field will change to red. 

 

Riser (h) 
Beside the actual value the minimum and maximum values defined in the stair standards are shown 
here. If the actual value exceeds the stair standard limit the background of the field will change to red. 

 

Number of steps (n) 
This is the number of steps necessary to cope with the total height of the stair.  

In case of gathered stairs and stairs with more arms the number of stair step edges for each arm appears under the 
Number of steps. 
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Two types of connections to the top slab can be chosen: 
  

 

One option is when the last step of the stair goes on the slab. If the total stair height is 3 m and the riser 
is 16 cm for example, the stair body goes up to 2.84 m and the last step will be on the slab.  
 

 

The other option is when the level of the last stair step is equal with the top of the slab. In this example, 
the stair body goes up to 3 m. In that case, it is worth to cut out the profile of the last stair step from the 
top slab. The thickness of the slab can be specified in the 3D view dialog. 

 

� When you choose the Ramp option in the 3D view settings the types of connections to the top slab options are not 

available. 

Geometry of the staircase 
Depending on the stair type you can specify different geometry parameters. Each parameter is denoted by a drawing 
symbol. These can be as follows: 
 
 

 

Stair width 
This parameter is available for all stair types. 

 

Outer diameter of spiral 
This is available only for spiral stair types. 

 

Convolution angle 
Available only for spiral stairs. 

 

Inner radius or taper off distance 
Depending on the stair type this symbol represents either the inner radius or taper off distance of the 
stair. For example it means inner radius in case of spiral stairs, and inner taper off distance for U form 
winded stair. 

 

Outer radius or taper off distance 
Depending on the stair type this symbol represents either the outer radius or taper off distance of the 
stair. For example it means outer radius in case of spiral stairs, and outer taper off distance for U form 
divided stair. 

 

Walking line distance 
The distance between the walking line and the side of the stair.  

 

Square side length 
Available only for Spiral square stairs. 

 

Major axis length of an ellipse 
Available only for elliptic stair. 

 

Minor axis length of an ellipse 
Available only for elliptic stair. 

 

Twisting angle 
Available only for elliptic stair. 

 

Length on the left side 
Length of the stair on the left side measured in 2D view. 

 

Length on the right side 
Length of the stair on the right side measured in 2D view. 

 

Total stair width 
  

 

Length of the rest 
  

 

Total stair length 
Available only for T form stair. 

 

Total stair width 
Available only for T form stair. 

 

Length of the left arm of the stair 
Available only for T form stair. 

 

The length of the longer side of the bottom arm in 2D view 
 

 

The length of the longer side of the top arm in 2D view 
Available only for L form and angled stairs. 

 

Angle 
Available only for angle gathered and angle divided stairs. 
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Total length of the lower arm and the rest 
 

 

Total length of the upper arm and the rest 
 

 

Total stair width 
 

 

Length of the rest 
 

 

Length of the stair 
 

 

• During the construction of the stair you can specify both the parameters of the steps and the stair geometry. 
The architect can use lock buttons beside the parameters. According to the state of the lock buttons it is 
enable to give constrains or leave the parameters to be changed. The locks can have three states: 
 

 
Open  
The value of the parameter can change as a result of modification of any parameter. By clicking on an 
open-state lock you can switch to closed-state. 

 
Closed 
The value of this parameter is a given constrain and it will not change if we change any other parameter. 
Click the lock button again to turn its state into open.  

 
Inactive 
The value of this parameter may change if we modify other parameter values. Depending from the other 
parameter values you can either modify the value in the input field or not. It is not possible to change the 
state of this button by clicking on it. In this state there is no way to get to the open or closed state. 

• One change made in a state of a button can change the state of other buttons that are not closed. The 
parameter values in the fields are calculated automatically. Any change made in a field will be followed by a 
recalculation in the other fields. The time needed for the automatic recalculations depends on the modified 
parameter and the computer configuration but takes no more than a few seconds. 

 

• Sometimes the given constrains do not allow us 
to change a parameter value to the one we give in 
the input field. In that case all the parameter 
values remain unchanged; even the one we 
wanted to change. In that case the background of 
the geometry constrain parameter field turn into 
red. 

 

Stair Properties 

 

 

Click Stair properties to specify the general and 2D view properties: 

 
The same properties can be specified here as for the stair sets.    
 

� See the detailed description on 9.6.2.1 Stair Parameters. 
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Support 

 

 

Click Support to specify the Elevation, Ramp, Thread, etc properties. 

 
The same properties can be specified here as for the stair sets in general. Depending on the stair type the construct the 
rest like a slab and adjust to the bottom face of the top slab options are available. 
  
Construct the rest like a slab option converts the body of the rest into slab shape. 
   
Adjust to the bottom face of the top slab aligns the bottom face of the stair to the bottom face of the top slab. In this 
case, the slab thickness input is required. The waist slab thickness of the stair will not change. 

  
Predefined stairs examples: 
 

 

 

 
 

 

 
 

  Stair by outline and landing 

You can create stair by outline and landing as follows: 
 

� Construct the sidelines and the location of the rest of the stair. 
� Select the right and left side of the stairway. 
� Define the right and left side sections of the arms before and after the rest by point couples. 
� Specify the number of divisions on the arms. 
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Both sides of the arms will be divided to equal lengths and these divisions will define the stair steps on the arms. The rest 
will be the area between the arms defined. 

Some rules: 
� The point given first must be the endpoint of the stair. The stair will start upwards from here. 
� The hotspots of the arms are denoted by small squares. If you click outside the arms the program will select the closest 

existing hotspot on the arm automatically. However, if you select a point on the arm, the automatic hotspot selection 
function will switch off and the selected point will be accepted.   
 

• Draw the sidelines of the stairway. 

• Construct the location of the rest. 

• Click  Stair by outline and 
landing. 

• Select the right side objects of the 
stairway. Use the OPENCHAIN 
keyword and click on the endpoint if 
you have open object (1). Enter. 

• Select the left side objects of the 
stairway. Use the OPENCHAIN 
keyword and click on the endpoint if 
you have open object (3). Enter. 

•  
 

 

 

• Specify the first point of the bottom arm on the right side (1). 

• Specify the second point on the right side (2). 

• Specify the first point of the bottom arm on the left side (3). This point corresponds to the first point given 
on the opposite side. 

• Specify the second point on the left side (4). This point corresponds to the second point given on the 
opposite side. This way the arm before the rest is defined. 

• You can specify the point couples on the next arm similarly (5-6, 7-8). This way the arm after the rest will be 
defined. 

Option: 

PREVIOUS The first point of the couple will be the second point 
of the pervious interval. Available only when there 
is an existing couple. 

 
Enter Close the definition. 
 
Divide into steps dialog box will pop up then. Here you can define the number of stair steps in two ways: 
 

� Use the Calculate n step by all intervals option if you want to specify the total number of stair steps along the stair. 
� Use the Specify n step of intervals option if you want to specify the number of stair steps individually on each arm.  

 
In case of stair the most important requirement is that it must go up to the next floor.  
It has to be specified in the dialog the base level and the top level of the stair, the requested number of steps and the 
requested height of step. There are two ways to do this: 

Specifying the height difference 

• Enter the base level of the stair. 

• Choose the Top level option. 

• Enter the top level of the stair. 

• Enter either the requested number of steps or the requested height of step. 
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Specifying the number of steps and the height of step 

• Choose the Top level not defined option. In this case you have to specify both the requested number of 
steps and the requested height of step. These two data determine the top level of the stair.  
 
In both cases the program calculates the width of steps, the possible number of steps and rests, the number of risers and 
the height difference. All the calculated data are represented in the dialog. 
The stair appears and the main parameters will be placed: the number of steps, riser and tread. 
 

 

  Stair by threads 

The stair by threads method assigns the rising to each stair step profile individually. 

Some rules: 
� Regarding the stair step profile there is no limitation but it must have a closed contour.  
� First the 3D model will be represented by cover slips. Later you can change it by 3D view settings. This is available when 

you modify the stair. 
� If there is no connection between two stair steps then:  

- the walking line will not be created automatically,  
- it is not possible to build the support and the body of the stair in 3D view.  
 
This means that stair by threads functionality is available only when the back contour of a step will coincides with the front 
contour of the next step (or shifted parallel by the nosing depth). 
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• Construct the closed profile of each stair step: 

•  

 
 

• Click  Stair by threads. 

• Give the stair step contour for each step using the Profile definition tool in the Toolbox. Use the Internal 
point of a chain command if you have closed stair step profiles. 

• Give the rising of the stair steps. 

• Give the stair step contours of the remaining steps. 

• Enter Close the stair definition. 

• Right click on the stair and select the Shortcut menu – Property command,  

• In the User defined stairs dialog click Geometry of the staircase to modify the rising of each step individually. 
 

� For a description of the Profile definition, see Chapter 8.9. Specifying profile.  

 
 

First the 3D model will be represented by cover slips. Later you can change it by 3D view settings. This is available when 
you modify the stair. 
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1.70.4. Modification of the stair geometry  

You can modify the geometry of the placed stairs.  
Modification is available in the Predefined stairs or User defined stairs dialog box or by using the edit commands. The 
available edit commands are as follows: 
 

� Cut the slabs above the stair, 
� Move, add, delete nodes of 

thread, 
� Modify the sideline of the step 

contour, 
� Query stair heights 
�  

Commands can be chosen 
from the Shortcut menu: 

 

 

 Modification of stairs in the Predefined stairs or User defined stairs dialog box 

• Right click on the stair and select the Shortcut menu – Property command, make available either the 
Predefined stairs or User defined stairs dialog. This dialog box gives different constructional opportunities, 
compared to that dialog box, which is selected from the stair folder at placing stair.  
  

� If the stair is a predefined one, the Construction menu will be available.  

 

 
 

� The same settings are possible as after placing a predefined stair from the stair library. 
�   
� If the stair is not a predefined one, the Construction menu won’t be available.  
� If the geometry of steps is modified in the case of predefined stairs, the staircase does not suit the requirements of 

predefined stairs; this is the reason why the Edit command cannot be used in the dialog. 
� The Geometry of the staircase is available independently from the original stair type. 

Setting the geometry of staircase 

 

Click Geometry of the staircase to specify the geometry 
of individual steps. This menu is available after placing 
a stair.  

 
The riser pro step and step thickness can be set for each step. You can check if the step is a rest. 
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As we have seen, if the staircase is created by a user or it is a predefined one, but the staircase geometry has been 
modified, the Edit dialog cannot be selected, the height cannot be set there.  
 

 
 
When such staircases are modified, the Stair geometry dialog contains the stair height that can be varied. 

  Cut slabs above stair 

The program selects the slab above the stairs and cuts it automatically according to the position of the stairs. In this case, 
the width of the slab cut is defined by the width of the stair. The program finds the step from where the ’free height’, i.e. the 
height set by the user, is equal to the distance between this step and the slab. This allows an adult person to go up the 
stairs in upright position. 
 

• To execute the command, click on the stair, above you want to cut the slab. 

•  

 

 Move, add, delete nodes of tread 

With the Shortcut menu you can move or delete nodes and add new ones to the existing stair steps. 

Moving nodes 
To change the position of a tread, click on one of its corner points. 

Delete nodes 
Click on a corner point of a tread to select it, and delete it by choosing the DELETE NODE keyword from the command 
line. 

Add nodes 
To add new corner points to the stairs, click on one of the stair edges. 
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  From straight to arc 

For this purpose you can use the following commands in the shortcut menu: 
 

� Line � Arc 
� Arc � Line 

Line � Arc 

• Select a straight edge of the stair you want to modify or select an arched edge of the stair. In this case you 
can modify the radius of the arc. 

• Specify a point. The arched edge of the stair will touch this point. 

Options: 

DIAMETER Specify diameter. 

RADIUS Specify radius. 

PERIMETER Specify perimeter (the length of the arc). 

ARC Specify the height of the arc. 

Arc � Line 

• Select an arched edge of the stair you want to make straight. 

 

Rounded stair with water drip 

The program creates automatically the water drip, in case of stair rounding off, for the straight parts with the given value. It 
stretches the not cutting arch, so it will be ellipse arch from the circle arch.  
 

 

 Shadow 2D representation 

The floor plan visualization of the staircase can be set in the Predefined stairs - 2D view dialog. In such cases the 
staircase can be represented according to the cutting elevation on the floor plan.  
If the offered possibility is not enough, the Shortcut menu - Shadow 2D representation command can be used to modify 
the floor plan graphically without affecting the 3D model. 
 

• Select the staircase. Its ID appears. Do not forget this number. 

• Edit the floor plan as you wish. 
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If you would like to regain the original floor plan of the staircase, use the Shortcut menu - Original 2D representation 
command. 

 Original 2D representation 

The Shortcut menu – Stair 2D <- restore command recreates the original floor plan visualization of the staircase. 
In the appearing dialog the program shows the list of identifiers of those stairs which have been converted to 2D shadow. 
This way it is easy to select the required identifier and enter it into the command line. 
  

� If there is no real stair on the floor-plan and you cannot start the restoring command from the shortcut menu, it is worth 

to place a temporary stair to use its shortcut menu. 
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1.71. Balustrades 

In ARCHLine.XP you can control every aspect of balustrade design. 
Balustrades can be freestanding or anchored to stairs.  

Balustrade properties and creating balustrades 

When you create a balustrade, you have to define: 
  

� the Balustrade properties using the Balustrade wizard, 
� the balustrade path. 

Balustrade properties - Balustrade wizard 

The method enables the modelling of balustrades or other separator elements like fences on a final construction drawing 
level. 

Click with right mouse button on  Balustrade tool or use the Building menu - Properties - Balustrade command. After 
you activated this command, a Balustrade dialog pops up. This wizard includes the setting possibilities of all Balustrade 
components.  
 

� After defining balustrade properties, save those into a style. When placing a balustrade, balustrade wizard will not 

appear. Instead, it will be created along the defined path with the properties of the active style. 
 

1.71.1. Balustrade properties 

In the Balustrade dialog box you can set baluster and handrail properties. 
 
The general settings and the balustrade component properties are available on the following pages: 
 
 

� General settings      (General settings of the balustrade) 
� Distribution of primary balusters between balusters by big steps (1 - Primary balusters button) 
� Intermediate balusters between primary balusters  (2 - Intermediate balusters button) 
� Individual panels and bars     (3 - Panels and bars button) 
� Distribution of balusters by big steps between newel posts  (4 - Balusters by big steps) 
� Balusters on nodes of path segments     (5 - Newel post at the turn button) 
� Handrail       (6 - Handrail settings) 

 
On every pages you can use the following options: 

Automatic refresh on page 
With this option each modification on the balustrade will be visible immediately in the preview window. 

Update button (  ) 
With this button you can update the 3D model of the balustrade in the preview window manually. 

Preview mode button ( ) 
Click this button to select from wireframe, hidden line removal, textured or no preview options. The 3D model of the 
balustrade will be represented in the preview window according to the selection. 
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Increase or decrease the height of all balusters 
With this option you can increase or decrease the height of all balusters, panels and bars, handrail at once, relatively to 
their defined heights. To do so, click the checkbox, enter a height value (positive or negative) in the input field and click the 
update button or press Enter. You can see the change in the preview window. Please note that you may apply the 
Exclude from general increasing/decreasing of height option individually to the balustrade components. Depending on 
your choice, the increasing/decreasing of height will be applied selectively on the balustrade components. 

 General settings 

Click General settings button to set the general settings like color, layer, line type, line thickness and priority.  
Use the Representation by centerline option if you want to represent the balustrade by line on the floor plan. If you don’t 
use this option, the top view of the 3D model of balustrade will be represented on the floor plan. 
Dimension on layout: use this option for automatic dimensioning of the balustrade on the floor plan. 
Elevation of handrail reference point from the floor or from the selected stair: you can define the elevation of 
balustrade relative to the stair or the path of balustrade. When you place a balustrade by specifying a path, the elevation is 
measured from the zero level of the active floor. The elevation of each balustrade path node can be defined during the 
placement procedure. 
 

 
 

 Primary balusters 

Click the Primary balusters button to define primary balusters and the distribution and placement settings of primary 
balusters. 
  
You can define balusters by objects or profiles. 

Baluster by object 

• Click on the Object option, then the Object selection button to display the Object placement dialog box. 
• Select the desired baluster from Balustrades category. 
• Set the parameters of the selected object. Define the material of the object, as well. 
• Ok Returns to the Balustrade dialog box. 
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Baluster by profile 

 
 
If you want to define balusters with a sectional profile instead of an object: 
 

• Click the Profile option, then the Select profile button to display the Insert profile dialog box: 
• Select the desired profile from the profile directory. 
• Set the parameters of the selected profile. 
• Ok Returns to the Balustrade dialog box. 

 

� Read about the Insert profile dialog box in detail in Chapter 8.2.10. Select from list. 
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! You can define balusters by objects or profiles when you use the Primary balusters, Intermediate 

balusters, Newel posts at the turn or Balusters by big steps options. 

Primary balusters distribution settings 

 
 
Uniform step. The distance between balusters are equal and the distance of the first and last baluster from post is fix. 
Distance between balusters can be defined either by Clear spacing between balusters (D) or Default step (S) 
parameters. These two options make the definition of distance easier because in some cases you know the gap between 
two balusters, in other cases you know the distance between two balusters. The distance between two balusters (S) will 
always be longer than the gap between two balusters (D) by the width of baluster (object or profile). You can set the First 
baluster distance from post (X) and Last baluster distance from post (Y) parameters, too. This is the distance 
between the first/last baluster and the start/end of the balustrade part. Primary rule is the correspondence to X/Y 
parameters, secondary rule is the correspondence to D/S parameters. Since D/S distance matches rarely to the specified 
X/Y distances, you can select between Maximum step value and Minimum step value options. In the first case the 
gap/distance between balusters will be D/S or less, in the second case the distance between balusters will be D/S or 
more. 
 
Example: if X=Y 7 cm, D= 5 cm and the width of a baluster is 13 cm, 16 pieces of balusters will be created along a 2.85 
meter long path with the option of maximum step value, with the gap of D*= 4.2 cm between balusters. With the option of 
minimum step value 15 pieces of balusters will be created with the gap of D*=5.4286 cm between balusters. 
 
Fix step. The distance between balusters (S or D) and the first baluster distance from post (X) are fix values, exactly the 
same as defined. The Last baluster distance from post (Y) is not editable in that case. From the beginning and From 
the end options define whether the measuring of X must be started at the beginning or the end of the balustrade part. 
Based on our previous example, 16 pieces of balusters will be created with the gap of D= 5 cm between balusters. 
However, the last baluster will be drawn with the width of 8 cm instead of 13 cm. 

Primary balusters placement settings 

 
 
Offset from path (>0: right). Horizontal alignment relative to the path of balustrade. E.g. balusters can be installed on the 
side of a staircase structure. 
 

!  The value specified in the Offset from path aligns only the primary balusters. The offset of handrails can 

be defined in another dialog. 
 
Elevation from path (<0: down). Elevation of balusters relative to the path of balustrade. 
Baluster height. The height of balusters can be set here. If the baluster is created by object, its height cannot be modified 
here. 

Adjusting balusters to a top profile 

Inside a period you can define an open profile to which you can adjust the height of balusters. 
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• Switch on the Adjust balusters to a top profile option. 
• Click Top profile button and select Circular segment by height and width profile. 
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• After defining the top profile, the top of balusters will be adjusted to the profile. 

 
The stretching of the object is available by defining a cutting plane. 
This is the so-called Cut and Stretch property. In the three main directions cutting planes can be positioned in percentage 
of the main dimensions. The program cuts the object with the cutting plane at the defined position and inserts an 
appropriate piece with homogenous cross section at the place of cutting. 
Thus you can achieve changes in the dimensions with a non-linear transformation. 
After stretching, that’s why you find the decoration in the middle of the fence rod still with a constant height, horizontally 
along the balustrade part. 
 

 

Top and bottom ending of balusters 

 

 

 
You can define the top and bottom ending of balusters 
that can be horizontal or slanted. It comes into the 
picture when the path of balustrade is not horizontal. In 
that case the baluster endings can follow the slope if you 
select the slanted option. 
 

 Intermediate balusters 

It’s a frequent case when balusters in a fence are placed in two rows behind each other with an offset. This way the 
second row hides the gaps between balusters in the first row. With the intermediate balusters function it is available, too. 

• Click check box for Intermediate balusters button and then click the button itself. 
• You can define secondary baluster and its distribution and placement settings. 
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The baluster definition and its distribution and placement settings are the same as for the Primary balusters. You can 
select a different profile or object for balusters, a different top profile to adjust the top of intermediate balusters. An Offset 
from middle point (>0: forward) defines the offset relative to the midpoints primary balusters. In addition, you can specify 
the Offset from path (>0: right), Elevation from path (<0:down), Baluster height parameters. Also, you can define the 
baluster ending conditions. 

 Newel posts at turn 

Newel post is a tall post at the head or foot of a stair, supporting the handrail, for example. These are balusters in the 
nodes of balustrade path segments. 
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• Click the checkbox for Newel post at turn button, select a profile or object, then specify the profile/object parameters 
and placing conditions. The specified newel post will be placed in each node of the balustrade path. 

• Newel posts at turn may modify the distribution of primary and secondary balusters, therefore click Update button to see 
the changes in the preview window. The newel posts make the distribution period shorter on both ends of the balustrade 
part by the width of a newel post. 

 

 

 Balusters by big steps 

Balusters can be placed between the nodes of balustrade path with different distribution rule than the rule applied to 
primary and intermediate balusters distribution. Primary and intermediate balusters are distributed between these 
balusters. 

• Click the checkbox for Balusters by big steps button and then click the button. Here you can define balusters by profile 
or object and their distribution between two nodes of the balustrade path similarly as you can do it for the primary 
balusters. 
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On the figure below you can see two newel posts created by Newel posts at the turn and two balusters created by 
Balusters by big steps. 

 
 
Between balusters created by Balusters by big steps the distribution rules of primary balusters and intermediate 
balusters are applied. As a consequence, Top profile option used for the primary balusters is applied to each distribution 
between two balusters created by Balusters by big steps. 
This case is shown on the next figure: 
 

 

 Panels and bars 

In addition to the prior mentioned possibilities you can add individual components to the balustrade. For this you must click 
the checkbox next to the Panels and bars button first, and then click Panels and bars button.  You can add the following 
individual components in the appearing Panels and bars dialog: 

� Object 
� Bar 
� Frame 
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� Swept profile 
 
The individual elements are listed in a table in the dialog. The selected element in the list is highlighted in the preview 
window so you can easily identify it. 
 

 

Adding objects 

• To add an object, click Add object button. In the top-left part of the dialog a new component appears in the list with 
parameters of index, type, name, height, width, thickness and visibility. 

• To modify the object, click ellipsis button in the name column. The Object placement dialog comes up, where you can 
browse for and object and then define the parameters of the selected object. 

• With the buttons below the list of panels and bars you can rotate (Rotate button) and mirror (Mirror on X and Mirror on 
Y buttons) the selected object. 

• In the bottom-left part of the dialog you can specify the placement conditions. 

Offset from path (>0: right): defines the horizontal offset relative to the path of balustrade. 
Elevation from path (0<: down): vertical distance between the bottom of the object and the path of balustrade. 
Enlarge object to the available length: stretches the object so that it fills the gap between balusters created by Newel 
posts at the turn or Balusters by big steps. For example when you place a retainer as an object and you apply this 
option to this retainer, the program stretches this object between balusters created by Newel posts at the turn or 
Balusters by big steps. Using this option, you can define the Gap on the left side and Gap on the right side 
parameters, too. 
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Trim overhanging sides: when you specified an object that hangs over the space between balusters created by Newel 
posts at the turn or Balusters by big steps, the program cuts the overhanging parts automatically, avoiding the 
disturbing of the next baluster distribution period. Using this option, you can also define the Gap on the left side, Gap on 
the right side and Cut parameters. Gap means the gap between the object and newel posts at the turn/balusters by big 
steps. Cutting options are: symmetric, trim left, trim right. 
Adjust height to the frame: this option is available when frame is defined in the Panels and bars dialog. In that case the 
height of object is aligned to the height of the vertical side of the frame, which modifies the Elevation from path 
parameter of the object, too. 
 

 
 
Placement from: you can define whether the object should be placed to the left, right or middle of the balustrade period. 
Depending on the choice of Left/Right/Middle there are other tuning possibilities: Distance from left (>0: inside), 
Distance from right (>0: inside), Offset from the middle point (>0: forward).  
Cut balusters by top profile: this option is available when you use the Top profile option in the Panels and bars dialog. 
With this option the top of the defined panels and bars will be cut with the defined top profile. 
The figures follow the increase: when the path of balustrade is not horizontal, you can set the object either to stay 
horizontal or follow the slope along the path. 
Exclude from general increasing/decreasing of height: this option defines the application of the Increase or decrease the 
height of all balusters to the object. 
Code: you can write any information here, for example the part number of the individual object. 

Adding bars 

• To add a bar, click Add bar button. In the top-left part of the dialog a new component appears in the list with parameters 
of index, type, name, width, thickness and visibility. The field for height remains empty. 

• Click ellipsis button in the name column to open the Insert profile dialog, where you can define the section profile of the 
bar you want to create. The width and height values you define here will appear as width and thickness in the in the list 
of panels and bars. 

• In the bottom-left part of the dialog you can specify the placement conditions. 
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Offset from path (>0: right): defines the horizontal offset relative to the path of balustrade. 
Elevation from path (0<: down): vertical distance between the bottom of the object and the path of balustrade. 
Material: you can define the material of the bar. 
Direction: you can define horizontal, vertical, diagonal or tilted (with free angle of slope) directions. In case of diagonal 
direction you can select from left bottom -> right top or left top -> right bottom options. If there is a frame defined as 
individual component, you can use the Adjust to the frame option. 
Use available length: depending from the bar direction selection, you can use this option. In that case the bar extends to 
the available length. The available length depends on your choice: either spacing between newel post at the turn or 
spacing between posts (balusters by big steps). 
In case of Horizontal bar direction you can set The figures follow the increase option for the case the path of balustrade 
is not horizontal. 
Bar length: you can define custom bar length. In case of custom bar length definition you can set the position of the bar 
inside the balustrade period to the middle, right or left. Additional adjustment possibilities are the Offset from middle 
point (>0: forward), Distance from right (>0: inside) and the Distance from left (>0: inside) options.  
Bottom (start) ending: you can define the ending of the bottom of the bar. Click the ellipsis button to set the desired 
ending. 
Top (other) ending: you can define the ending of the top of the bar. Click the ellipsis button to set the desired ending. 
Exchange endings: 
With the Multiple placement option multiple copies of bars can be created by different rules. You can define the direction 
and spacing for the multiplication. The direction of multiplication can be horizontal, vertical or perpendicular to the direction 
of bar. You can define the spacing between bars with the By step of bars and By clear spacing between bars options. 
In case of horizontal and vertical bar orientations there are only two options for the direction of multiplication. You can 
specify the number of multiplication upside and downside by the Repeat upside and Repeat downside values. 
Wavy bar: check this option if want to turn straight bars to wavy bars. You can define the Wavelength and Amplitude as 
well. 
Code: you can write any information on the bar here, for example the part number of the bar. 

Adding a frame 

• To add a frame, click Add frame button. An element with frame appears in the list of individual components and then the 
Add frame button becomes inactive. Only one item can be created from this type of component. 

• Click the ellipsis button in the name column to open the Insert profile dialog, where you can define the section profile of 
the frame you want to create. The width and height values you define here will appear as width and thickness in the in 
the list of components in the Panels and bars dialog. 

The following properties can be set: 
Offset from path (>0: right): defines the horizontal offset relative to the path of balustrade. 
Elevation from path (0<: down): vertical distance between the bottom of the frame and the path of balustrade. 
Material: you can define the material of the frame. 
Frame height: the distance between the bottom and top of the oriented frame. This parameter appears in the list of 
components in the height column. 
Exclude from general increasing/decreasing of height: this option defines the application of the Increase or decrease the 
height of all balusters to the object. 
Gap on the left side: at the beginning of the balustrade period this is the gap between the first balustrade component and 
the frame. 
Gap on the right side: at the end of the balustrade period this is the gap between the frame and the last balustrade 
component. 
Code: you can write any information on the frame here, for example the part number of the frame. 

Adding profile along path 

With this function you can add individual ornamental elements to a balustrade. 

• Click Add swept profile button. In the list of individual components appears a new component with the type of profile 
along path. 

• Click ellipsis button in the name column to open the Insert profile dialog, where you can define the section profile of the 
component you want to create. The height value you define here will appear as thickness in the in the list of 
components. 

The following properties can be set: 
Offset from path (>0: right): defines the horizontal offset relative to the path of balustrade. 
Elevation from path (0<: down): vertical distance between the bottom of the component and the path of balustrade. 
Material: you can define the material of the component. 
Frontal profile: this profile defines the path on which the section profile specified in the name column of the individual 
component is swept along. 
 

! Only closed profile can be selected for frontal profile. 
 



 10. Building model 549 

ARCHLine.XP® 

Placement options: you can select from a drop-down list whether the component should be placed to the left, right or 
middle part of the balustrade period. Depending on the Left/Right/Middle selection you can specify the Distance from 
left (>0: inside), Distance from right (>0: inside) or Offset from middle point (>0: forward) parameters. 
Angle: the frontal profile can be rotated on a vertical plane with this angle relative to the vertical direction. 
 
Example: profile along path in the middle of the balustrade period, without rotation angle and with rotation angle of 45 
degrees. 
 

   
 
The figures follow the increase: when the path of balustrade is not horizontal, you can set the swept profile either to stay 
horizontal or follow the slope along the path. 
 
Example: profile along path with rectangle frontal profile, with and without the option of the figures follow the increase. 
 

  
 
Cut bars: when the frontal profile of the component intersects with bar components, you can define if bar parts inside the 
frontal profile must be removed or not. The cutting operation is executed even if different offset from the balustrade path 
values are specified for the swept profile and the bar. 
 
Example: profile along path, rectangle frontal profile, with and without cut bars option. 
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Code: you can write any information on the individual component here, for example the part number of the ornament. 
 

• Click Update button to see the changes in the preview window in the Panels and bars dialog. 
• Click OK to get back to the Balustrade dialog. Click Update to see the changes in the preview window. 

 Editing handrails 

To add handrails to the balustrade, click the checkbox next to the Handrail button and then click the button. Here you can 
define handrails. 
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The created handrails are organized in a table. Each row in the table represents a handrail. In the table rows you can read 
the following properties: 

� Index: row (handrail) number. 
� Profile: section profile of the handrail. 
� Shift vertical: this is the vertical distance between the bottom of the handrail and the path of balustrade. 
� Overhang at start: the overhang of handrail at the beginning of the path of balustrade. 
� Overhang at end: the overhang of handrail at the end of the path of balustrade. 
� Type of path: describes the path of the handrail. For example a handrail can go along the path of the balustrade or it can 

follow an individual path from layout.  
 

• To change the order of handrails in the table, use the Move up or Move down buttons. 
• Click Delete to delete a row (handrail). 
• Click Insert new to add a row (handrail). 
• To change the cross section of the handrail, click the ellipsis button in the Profile column. In the Insert profile dialog you 

can choose the appropriate profile. 

 

� In the middle of the page you can select whether the section profile of the handrail should be vertical or perpendicular to 
the path of balustrade. 

Vertical section profile: Perpendicular section profile:  

 

 
There are other setting possibilities on the bottom of the page: 

� Offset from path (>0: right): defines the horizontal offset relative to the path of balustrade. 
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� Material: you can define the material of the handrail by clicking the ellipsis button. 
� Invisible: use this option to make the handrail invisible. 
� Exclude from general increasing/decreasing of height: this option defines the application of the Increase or decrease the 

height of all balusters to the handrail. 
� Exchange ending: click the ellipsis button to exchange the settings of bottom (start) ending and top (other) ending. 
� Bottom (start) ending: you can set the ending of the start of the handrail by clicking the ellipsis button. The Beam ending 

dialog appears where you can set the appropriate ending. 
� Top (other) ending: you can set the ending of the start of the other end of the handrail by clicking the ellipsis button. The 

Beam ending dialog appears where you can set the appropriate ending. 
 
At this point you have defined all parameters of the balustrade. On the preview image displayed in the dialog you can 
check the result of your settings. To accept your settings, click Ok. 

1.71.2. Installing balustrade 

If you saved balustrade settings in a style and you made it active, the balustrade will be created along the specified path 
without showing up the balustrade editor dialog. 
 
The Balustrades tool offers two possibilities for installing a balustrade: 
 

 
 

 Create balustrade on stair 

Select one side of the stairs. The program uses this side as the alignment path of the balustrade. 
 

• Click on one side of the stairs. 

The program creates the balustrade on the stair with the active balustrade settings. 

 

 
 

 Create balustrade by path 

You have to define a path for the balustrade. The path can be either open or closed. 

 

• Define the points of the alignment path after each other. 
The path can contain lines and arcs. When these are joined, the next line or arc can join to the tangent of the previous 
arc. 

• Enter Completes specifying the alignment path. 

Path points with the same height 

• After specifying the nodes of the path and pressing Enter, base height defined in the balustrade settings will be assigned 
to all nodes of the path. 

Path points with different heights 

• After specifying the nodes of the path you can select the node to which you want to assign a different height. 
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• Give the height of the node relative to the base height defined in the general balustrade settings. 
• Repeat the node selection and height specification with any other nodes. 
• Pressing Enter, the balustrade is created. 

Height defined by stair 
For giving the height value you can choose a point of a stair. 
 

• After selecting the node and the STAIR subcommand, choose a point of a stair to obtain its height. 

Height defined by roof 
Similarly, for giving the height value you can choose a roof. 
 

• After selecting the node and the ROOF subcommand, choose a point of an edge of a roof to obtain the required height. 
By default, the top height of the roof plane at the selected point will be assigned. By selecting the BOTTOM 
subcommand, you can assign the bottom height of the roof plane at the selected point. 

Balustrade without balusters 

With the handrail settings defined in the 
Balustrade properties dialog there are three 
possibilities to draw balustrade without 
balusters in the Building menu - Balustrade 
submenu: Create sweep, Create sweep on 
stair, Create sweep on wall  

Create sweep 
It works the same as Create balustrade by 
path command with the difference that only the 
handrail is created. 

 

Create sweep on stair 
It works the same as Create balustrade on stair command with the difference that only the handrail is created. 

Create sweep on wall 
With this command you can place handrails along the side of a wall. 

• Start the command and then click on the side of a wall. 
• Place the layout of the side view of the wall on the floor plan. 
• Draw the open path of the handrail on the layout. 
• Press Enter to finish. 
• Specify more handrails by drawing open paths again on the layout or close the command by pressing Enter.  
• A message appears: Do you want to stop editing layout of balustrade? Click yes to exit from the command and to delete 

the layout. 

1.71.3. Modifying balustrades 

You can modify a balustrade after you have created it. You can change its: 
� properties, 
� alignment path, 
� geometry and components. 

If you click right of left mouse button on balustrade, shortcut menu appears with commands for modifying the properties or 
editing balustrade. 
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 Modify balustrade properties  

The balustrade editor dialog box that has been used before creating the baluster comes up. In this dialog box you can 
modify the properties of all balustrade path segments (balustrade parts) at once or each balustrade part separately. 
The additional options are the followings: 

Edit part segments 

 
With this option you can set the properties of each balustrade part separately. To switch between balustrade parts, use the 
arrow buttons or select a part from the drop-down list. 

Disable handrails on this part 
With this option you can remove handrails from the selected parts.  

Full regeneration using the same distribution on all parts 
With this option you can regenerate all parts (path segments) with the current settings. If the distributions are different on 
path segments, or there are individually modified balusters, you will lose them after this operation. 

Regeneration by parts 
With this option you can regenerate only those parts with the current modifications that hadn't been modified separately 
from other parts. 

Copy to baluster clipboard / Paste from baluster clipboard 
On the pages where you can edit balusters, you have the possibility to copy the current baluster settings to the clipboard 
or paste the balustrade settings from the clipboard. For this you can use the Copy to baluster clipboard or the Paste 
from baluster clipboard buttons. 

� If you want to customize the settings of a balustrade path segment (part), use the Edit baluster layout 

command. 

 Modify balustrade path 

To edit balustrade paths, select the Modify path command from the local menu. Edit profile commands appear in the 
floating menu. At this point you can edit the balustrade path on the floor plan (in top view). 
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� See the description of the Edit Profile tool in Chapter 8.2.9 Editable profile. 
 
With the Modify path command you can easily install a balustrade on only one side of the steps, instead of both sides. To 
do this, apply the Delete edge command. 

 
You can also use the marker commands by clicking on the node or edge of a selected balustrade part. 
 

 Edit baluster layout 

In the local menu of a balustrade or a balustrade layout you can find the Edit baluster layout command. 
With this command you can modify the geometry and components of an existing balustrade. 
 

 
 

• Place the side view of the balustrade layout on the floor plan. 
• side view of the balustrade layout appears on the floor plan with dimensions 
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Markers appear on the layout, by which you can activate the edit commands. Depending on the node or edge you click, 
different commands are available. 
 
Node marker menu items: 
 

 
 

 
 

 
 
Edge marker menu items: 
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Elevate node 

With this command you can modify the elevation of the balustrade node nearest to the click point graphically or entering a 
value. 

Elevate part 

Graphically or entering a value, with this command you can elevate the whole balustrade period at once. 

Elevate on the right side 

Graphically or entering a value, with this command you can elevate the selected balustrade periods and all the other 
periods that located to the right side of the selected period. 

Elevate on the left side 

Graphically or entering a value, with this command you can elevate the selected balustrade periods and all the other 
periods that located to the left side of the selected period. 

Edit baluster layout in this part 

With this command you can edit baluster layout of a balustrade period independently from the other balustrade periods on 
the Edit baluster page of the balustrade editor dialog. In addition to the editing possibilities we you have met before, two 
new options appear in the dialog:  

� Add baluster on the first post: check this option you to remove the baluster at the beginning of the balustrade period. 
� Add baluster on the second post: check this option to remove the baluster at the end of the balustrade period. 

Copy distribution 

With this command you can copy the baluster distribution from one balustrade period to other periods. You only have to 
click on the targeted balustrade periods to copy the distribution from the selected period. 

Insert node 

With this command you can insert a new node between two existing balustrade nodes. 

Move handrails or balusters 

With the Move command you can 
move 
 

� the selected handrail or 
� the selected balusters according to the 

direction of the balustrade. 
�  

• Select the balusters or the handrail. 
• Define the reference point. 
• Define the new position of the 

balusters/handrail.  
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Move a copy of handrails or balusters 

With Move a copy command you can 
duplicate: 
 

� the selected handrail or 
� the selected balusters, which you can 

move according to the direction of the 
balustrade. 
 

• Select the balusters or the handrail. 
• Define the reference point. 
• Define the new position of the 

balusters/handrail. 

 

Delete balusters and handrails 

With Delete command you can delete the selected balusters or handrails. 
 

• Select balusters and handrails you want to delete. 
• Press Enter to complete the deletion. 

Modify balusters and handrails 

With Modify command you can modify 
the type of the selected handrail or 
baluster. 

 

• Select the balusters or the handrail. 
• A dialog box appears, in which you 

can modify the properties of the 
selected object. 

• E.g. modify the last baluster of the 
balustrade: 

 

 

Modify balustrade inclination with balusters 

You can adjust the balustrade to the 
stairs. The handrail follows the angle of 
the stairs and the balusters follow the 
stairs. Select two balusters to define the 
part of the balustrade to be aligned with 
the stairs. 

 

• Select two balusters which indicate the 
part of the balustrade you want to 
adjust to the stairs. 
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Modify balustrade inclination with points 

With Modify inclination command you 
can define the angle of the selected 
balustrade period with the direction 
defined by the two selected points. 

 

• Select the handrail whose angle you 
want to modify. 

• Select the first point. 
• Select the second point to define the 

angle of the handrail. 

 

Add open handrail-extension 

You can add an overhanging end-part 
to the handrail. 

 

• Using the Profile definition tool in the 
Toolbox define the path of the 
overhanging handrail, which you add 
to the layout image of the balustrade. 
Apply also the OPENCHAIN 
subcommands. 

• Specify the reference point of the 
selected profile. (See point 1 in the 
figure.) 

• Add the new handrail part to the 
layout image of the balustrade. 
(Select point 1 in the figure.) 

•  

 

� For a description of the Profile definition, see Chapter 8.2. Specifying profile.  

Add bound handrail extension 

You can add a bound end-part to the 
handrail: 

 

• Using the Profile definition tool define 
the path of the bound end-part, which 
you add to the layout image of the 
balustrade.  

• Specify the reference point of the 
selected profile. 

• Add the handrail path to the layout 
image of the balustrade. 

Edit handrail trajectory 

You can modify the trajectory of the 
selected handrail section. 

 

• Select that part of the handrail you want 
to modify. 

• Apply the Edit profile commands (e.g. 
the Line -> Arc command). 
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Adjust balusters to stairs 

Adjusts balusters to the stairs. Only the 
bottom of the baluster is fitted to the 
stairs. The length of the balusters does 
not change. To adjust the baluster 
precisely to the stairs, apply the Adjust 
balusters to handrail command. 

 

• Select the balusters you want to adjust 
to the stairs. 

•  

 

Adjust top of balusters to handrail 

You can adjust the top of the balusters to the handrail. 

 

• Select the (appropriate side of the) handrail, to which you want to adjust the top of the balusters. 
• Select the balusters whose top point you want to adjust to the balustrade. 
•  

 

Change the height of balusters vertically 

With the Change height command you can apply this command to balusters in two ways: 
 

� You can adjust the bottom of the selected balusters vertically to the specified point. The length of the balusters does not 
change. 

� You can modify the length of the balusters by defining a new top point. 

 

• Select a baluster on the layout to move its elevation (click the bottom point of the baluster) or change its height (click the 
top of the baluster). 

• Specify the new position/height of the balustrade. 

Append straight edge 

This command is available at end node markers. With this command you can add a new balustrade period to the 
beginning or the end of balustrade. 

• Click a point on the layout to define the new endpoint of the balustrade. 

Join parts 

This command is available at node markers inside a balustrade path. With this command you can join two neighbouring 
balustrade periods together. 

• As soon as you click on the command, the program automatically joins the neighbouring periods. 
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Split part 

This command is available at a node marker if formerly two periods were joined at this node with the Join parts 
command. With this command you can split the two parts that were joined together earlier. 

• As soon as you click on the command, the program automatically splits the formerly joined parts apart. 

Delete node 

With this command you can delete the selected balustrade node. 

Move node 

With this command you can move the selected balustrade node. 

Elevate node 

With this command you can modify the elevation of a balustrade node graphically or entering a value. 
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1.72. Roof 

Introduction 

Constructing roof is one of the most complicated processes in architectural design.  
ARCHLine.XP® offers you a variety of options to create roofs.  
You can create roof automatically − the program performs the necessary calculations (works out the intersection lines of 
the roof planes) and immediately creates the complete roof. 
In case of simple roofs, you can create your roof by planes. 
In case of traditional roof types you can choose from a long list of default options (pitched roof, tent roof, mansard, arched 
roof etc.) When you need something different from the default forms, specify a profile and the program creates the desired 
roof. 

 
(János Varga, architect) 

 
 
There is no geometrical restriction for either the contour of the roof outline or the profile of the vertical sectional view. This 
enables you to draw a roof on the floor plan without any difficulty. You can modify the roof later, even by adding new roof 
planes, or you can add new roofs, glass roofs, extruded roofs, skylights or dormer windows, openings in the roof etc. 
The program is able to calculate the roof structure.  
The roof structure includes: rafters, eaves purlin, middle purlin, ridge board, collar beams, and battens for roof tiles. The 
position of these structural objects can be modified later, e.g. you can use beams in case of chimneys. 
The program is able to list the roof quantity take-off. 
The program lists the sizes of roof surfaces and the applied structural objects, which makes it simple to carry out a cost 
calculation. 
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1.72.1. Roof properties 

Before creating a roof, you can specify its properties. To do so, right-click on the Roof icon in the toolbox or select the 

Building menu - Properties − Roof command. 

 

� When you define an automatic roof, the command activates the Roof properties dialog. 

 
The Roof properties dialog comes up where you can set the roof properties. 
 

 
 
The interface consists of the following main parts: 

  
 

Feature 
buttons 

Properties panel Preview 

Controls 

Feature buttons 

You can find the Feature buttons at the left side of the Roof properties dialog. These buttons can be used to switch 
between main structural objects and properties of the roof. The schematic figure on top of the buttons will change 
according to the selection. (e.g.: when you select the Rafter button, you can see the rafter figure, explaining the values on 
the properties page.) 
 
There is a very important special feature for these buttons. They have a checkbox to enable / disable a structural part of 
the roof. 

Properties panel 

In the middle of the Roof properties dialog, you can find the Properties panel, which shows the properties of the selected 
feature (Rafter, Batten, Projections and Cut, etc.). 

Preview 

You can find the Preview at the right side of the Roof properties dialog. Click on the Refresh button when you would like to 
see the changes that you made in the settings. You can also switch between roof planes, by using the “<” and the “>” 
buttons on top of the 3D preview. You can cycle through the model representations with the Presentation settings button.  
Also, in some cases, when you need you can actually completely drop your changes for the rafters or battens if you use 
the Delete and rebuild all rafters and purlins and the Delete and rebuild all battens buttons. 
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Controls 

You can add Cost parameters, save or open sets by using the buttons on the Controls bar. Use the OK button to accept 
the changes and close the dialog, or use Cancel if you would like to drop all changes you made after opening the Roof 
properties dialog. 

 How to use the Roof properties dialog 

When you work with the Roof properties dialog you should use the Feature buttons on the left hand side of the dialog to 
switch between main roof features and structural parts. You can use the checkboxes next to the Feature buttons to enable 
or disable a specific structural part. 
 
You can make changes on the Properties pages for each feature and after using the Refresh button at the right top corner 
of the dialog, you can update the changes to the 3D preview. 
 
Finally you can use the Set button to store and/or recall sets to spare time. Use the OK button to accept the changes and 
close the dialog, or use Cancel if you would like to drop all changes you made after opening the Roof properties dialog. 

Multi-level roof structures 

By adding multiple raster for the same structural object ARCHLine.XP allows users to create complex and architecturally 
correct roofs in the details. This way it becomes very easy to handle one roof object with main rafters and raster for sub-
rafter. 

Eaves purlin, Middle purlin, Rafter, Batten, Ridge board 

On these four pages there is a profile cross-section button, used for defining the cross-section profile of the actual object. 
 

 
 
Also, on these pages of the Roof properties dialog window you can change these structural objects’ (except battens’) 
endings. You can set bottom and top endings one by one, and you can use profile endings also. 
 

 

Bottom (start) ending 
When you click to change Bottom (start) ending, you will see the following dialog window. 
 

 
 
You can choose from a list of ending types and you can set the desired one. 
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Top (other) ending 
When you click to change Top (other) ending, you will see the following dialog window. 
 

 
 
You can choose from a list of ending types and you can set the desired ending. By using the Equals to bottom (start) 
option you can make both endings similar in one single step. 

Exchange endings -  

If you defined different endings you have the possibility to exchange them in one single step by clicking on Exchange 
endings button. 

Endings of certain objects 

Eaves purlin, Middle purlin, Ridge board 

  
 

Perpendicular ending Profile ending Slanted ending 

Rafter - bottom ending  

   
Vertical ending 
 

Horizontal ending 
 

Perpendicular 
ending 
 

  

 

Profile ending Slanted ending  
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Rafter – top ending 

Vertical ending Horizontal 
ending 

Perpendicular 
ending 
 

Profile ending Slanted ending  

 Eaves purlin 

The height of the bottom of the eaves purlin determines the height of the roof. 

 
 

To adjust altitude of all eaves purlin to bottom of rafter 

With this option it is possible to 
represent those eaves purlins 
which do not match on the 
reference line. This is the case 
when the roof plane is defined by 
a reference line.  
By switching the option on, the 
eaves purlin on the opposite site 
of the reference line will be 
represented with the appropriate 
height, too. See the figure.  

Offset from roof baseline (axis) – B 

You can define how far the centreline of the eaves purlin indicated in the figure should be horizontally from the roof 
baseline. 

Distance between roof and purlin ends 

If this option is disabled, purlins reach to the edge of the roof. Enable the option to specify distance between roof and 
purlin ends. 
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Relative height from the roof base line  

This field is active when you specify the eaves purlin properties individually. (Shortcuts menu – Roof framing – 
Properties... command). This way you can specify the height of the selected eaves purlin relative to the reference line so it 
can be different from the height of other eaves purlins. 

 Middle purlin 

 
 

Relative height from roof baseline− F 

Of the individual properties, first specify the relative height of middle purlin from the roof baseline. 

Deepness in rafter− B 

After specifying the deepness the middle purlin should cut into the rafter. 
The parameters F and B define precisely the place of the middle purlin.  

Distance between roof and purlin ends 

If this option is disabled, purlins reach to the edge of the roof. Enable the option to specify distance between roof and 
purlin ends. 
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 Rafter 

 

Distance between roof and rafter ends − D 

If this option is disabled, rafters reach to the edge of the roof. Enable the option to specify distance between roof and rafter 
ends. 

Beam gap − E 

To put rafters into place specify the distance between the axes of the beams. 

Roof structure – representation by centreline 

Representation of each main structural parts of the roof (rafter, batten, purlins...) can be set one-by-one. To represent 
each structural part by centreline enable the option on the setting page of the object. 

Rafter placement with minimum distance from roof boundary 

In order to avoid the placement too short rafters you can define the minimum distance from roof boundary where the 
calculated rafters are ignored from placement rule. 
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 Collar beam 

 

2D representation 
The collar and tie representation in is extended. According to some EU countries norm, the standard of these objects also 
represent distinct ending. 

 
 

 

Distance 
You can specify the distance: C, in case of tie. The Left side and Right side options allow you to create one-sided ties; tick 
both for duplex ties.  
 
You can use this parameter from the rafter, if you switch on the Use rafter size option. 

Roof tie: one-sided or duplex tie 
The tie can be switched on and off side-by-side. This option lets you specify one-sided left, one-sided right ties or duplex 
tie as well. 
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Duplex tie 
oldalt 

Right side Left side 

Height 
You can specify the height of the collar beam: D relative to the roof reference line or relative to the actual floor: E. 
 

  

 Batten 

 
 

Distance between roof and batten ends 

If disabled, battens will be adjusted to the roof ends. 

The first batten from rafter end − B 

If this option is disabled, batten reach to the rafter end. Enable the option to specify distance between the first batten and 
rafter end. 

Distance of battens − C 

To put battens into place specify the distance between the axes of the beams. 
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 Ridge board 

 
 

Relative height from rafter intersection− B 

You can specify the relative height of ridge board from the rafter intersection. 
 

! If a B < D/3, then rafters ends are met at the top. Otherwise the rafter ends on the top are adjusted to the ridge board. (D 

is the height of the ridge board.) 

  
 
 B= 1 cm, D=16 cm  B= 13 cm, D=16 cm 

Distance between roof and purlin ends 

If this option is disabled, purlins reach to the edge of the roof. Enable the option to specify distance between roof and 
purlin ends. 

 Roof tiles 

The roof tiles will let you generate and manage tiling for roofs in ARCHLine.XP. 
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 Projections and cut 

 

Cut 
You can choose from the following options: 
 

 

� Cuts the walls on the current floor. 
Switch on this option in case of attic rooms. 

� Cuts the walls of all floors. 
This option is useful in case of alpine 
houses. 

� Does not cut walls automatically. 
� Cuts the walls on the current floor and on 

the floor below. 
This option is useful in case of walls under a 
so called “dog’s house roof”. 

Distance of cutting surface 

The software is able to cut the walls by the bottom surface of the roof plane. You can set the distance measured from the 
bottom roof plane surface by changing the value in the Roof properties dialog window’s Projections and cut page. 
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If you keep the value of Distance of cutting surface from bottom surface of roof (>0: upside) unchanged, the walls will be 
cut by the bottom roof plane surface. If you set a value that is different from zero, then the software will reposition the 
cutting surface measuring the given value from the roof bottom surface. 
 

  
Distance of cutting surface is 0m Distance of cutting surface is -0.1m 

 

 
 

Distance of cutting surface is 0m Distance of cutting surface is 0,15m 

On which floors visible? 
The roof can be shown on the 2D view, one floor above and/or below the roof level. The floors and the certain line types 
can also be defined. 

Ridge tile and roof valley 
You can set whether the section of the roof planes are covered with ridge tiles and roof valley or not. If enabled, you have 
to define their width, thickness and material. 

 Layers and geometry 

 

Geometry 

Roof thickness - B 
You can define roof thickness vertically or perpendicular to the roof plane. 
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Relative to the vertical projection, 
while the end of the roof is vertical. 

 
 

Roof thickness is perpendicular to the 
roof plane; the roof ending is also 
perpendicular. 

 
 

 
Roof thickness is perpendicular to the 
roof plane; the roof ending is vertical 
to the roof plane. 

 
 

�   Roof thickness at end - C 
You can apply this method with the different eaves types (see the examples). You can cut the end of the roof by using a 
value smaller than the one applied to the vertical projection. 
The No option means that there is no horizontal cut. 
 

• Click on the icon to create the desired roof, which connects to the wall, and then specify thickness. 
 

Example: roof thickness: 0.3 m 

   
Roof thickness at end: 

 No  0.2 m  0 m  0.3 m  

 
� Roof limit at top (E) 

The maximum height of the roof, parts above this value will be cut. 
� Load-bearing part of rafter cross-section 

Load-bearing part (dimension) of the rafter, this can be used for statics calculations. 
� Align and shift bottom of batten with bottom of layer 

 

 
 

 



 10. Building model 575 

ARCHLine.XP® 

� Align and shift bottom of rafter with bottom of layer 
 

 
 

 

Layer list 

At the top of the Roof layers dialog window you can see the layer list ordered from top to bottom as the top and bottom 
layers of the roof structure. In layer list you can check and edit roof layers.  

Layer number 
The No. column shows the number of each layer. 

Name 
The Name column shows the given name of each layer. You can modify these names. Please click on one name to retype 
it. 

Material 
In Material column you can change one layer’s material. The given material will be represented on sections and in 3D 
views. 

Thickness 
In Thickness column you can change the thickness of each layer. If you already set adjustments for roof previously and 
this affects the roof layers, you may see the following message when pressing OK.  
 

 

Representation in 3D 
Representation in 3D option makes each layer visible or invisible in 3D and on section views. You can use it for layers 
such as air / ventilation. 
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Editing roof layers 

In Roof layers dialog window you can change the order of layers, add new layers or remove existing ones. 

Move layer up 
You can change the order of the roof layer list by selecting one layer and pushing Move layer up if it is possible. 

 

Move layer down 
You can change the order of the roof layer list by selecting one layer and pushing Move layer down if it is possible. 

 

Add layer 
You can add new layer to the layers of the roof. 

 

Remove layer 
You can remove the selected layer from the roof layers. 

 

Mirror layers 
You can mirror the complete order of the layers of the roof. 

 

 Pitch and shape 

 
 
Edit roof planes to create a roof of various pitch and shape:  

 

Hipped 

 

Gable end 
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Half-hipped 

 

Hipped with 
gablet 

 

Mansard 

 

 Information 

The Information button displays the main summarized quantities of the roof. 
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1.72.2. Creating roofs 

Creating roofs is one of the most complicated tasks in architectural design. The program offers various methods to create 
roofs - besides frequently used roof-types you can also create special roof structures. 

With the icons of the  Roof tool you can create roofs using different methods. 
 

 
 
Working in 2D environment, you can use the icons of the Roof tool to create the following: 
 

� Automatic roof 
Automatically creates roofs made up of roof planes of a given slope. 

� Roof plane by reference line 
The command creates a roof as individual roof plane. Having specified the roof surface, the roof plane is defined by the 
reference line and the roof slope.  

� Roof plane by 3 points 
Creates a roof plane by defining 3 height points. This method is useful if there are walls of different height in buildings 
where a survey has been carried out.  

� Extruded roof with predefined or free profiles 
Creates roof structures with various predefined profiles (pitched roof, mansard roof etc.). You can create even the most 
complicated roofs with the help of the properties you specify. It is also possible to define special profiles i.e. the vertical 
cross-section of the roof can be defined freely. 

� Automatic roof with profile 
Creates a roof automatically with the help of a user-defined profile. 

  Automatic roof 

You can create roof automatically − the program performs the necessary calculations (works out the intersection lines of 
the roof planes) and immediately creates the complete roof according to the reference contour on the floor plan. 
After you define the reference contour of the roof, Properties dialog is displayed. It is important to specify the height of the 
roof reference line. With automatic roofs the reference lines of all roof planes are in the same height. In Roof Plane dialog 
you can specify the inclination of each roof plane. (In this case you do not have possibility to define the inclination in the 
Roof geometry dialog.)  

Define roof reference line  

The command offers two possibilities to define the reference line of the roof: 
 

� The reference line is defined by the area enclosed by the walls. 
� The reference line is created by the commands in Profile definition pop menu. 

 
In both cases you are allowed to offset the reference line horizontally, with the desired distance, relative to the given 
contour. 
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Area enclosed by the walls 

• Select the walls one by one, or select the building with the selection window. The reference line of the roof is 
created along the outlining contours of the selected object. 
Enter Completes selection. 

Profile definition pop menu 

• Select POPMENU keyword from the Command line to display Profile definition menu. Use this menu to draw 
the reference line of the roof.  

 

� For description see Chapter 8.9. Specifying profile. 

Shifting the reference line 

• Before defining the reference line, choose SHIFT keyword from the Command line. 

• Specify the length of the shift. If the reference line is within the specified contour, you have to define the 
length of the shift with a negative value. 

Defining roof planes 

After you define the reference line, 
Properties dialog box comes up. Specify the 
height of the reference line in the Eaves 
purlin dialog box. 

 
 

 

� For description see Chapter 9.8.1. Roof properties. 

 
Select Roof planes dialog.  
Here you can modify the slope of the roof 
planes one by one or together. You can also 
insert a new roof plane e.g. you can create a 
hip roof. 

 
The angle defined in the Roof property – Roof geometry dialog is the default value. You can modify it: 
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You can select the roof planes to be modified from the top figure in the dialog box. In the figure the active roof plane is 
indicated with gray. You can move on to other roof planes by using the arrow or by clicking on the desired plane. 
 

• Select the roof planes to be modified one by one, and then specify their slope. To select the roof planes you 

can use the arrows, too.  
If you want to assign the same inclination to all roof planes, select All planes option. 

• After specifying the inclination of the roof plane, apply Update to see the result in the dialog box. 

•  By clicking on this icon you can specify whether to display the image in a wireframe model, with hidden 
lines or with shading. In case of larger models it is recommended that you use a wireframe model or turn off 
the display.  
 

� If you set the slope of one of the planes at 90º, the roof plane disappears on the actual side, giving way to the pediment. 
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Adding a new roof plane 

Create a hip roof: add a new plane to that side of the roof whose inclination you set at 90°: 
 

• Select the side with 90° slope; for the selection use the arrows. 

• Enable Additional plane option. 

• Specify the inclination of the roof plane as well as the height of the reference line of the new roof relative to 
the reference line of the roof. 

• Click Refresh. 
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After defining the roof planes, you can return to the Properties dialog by using the arrow button

. 
 

• Ok  Closes the dialog box. 
The program creates the roof: 
 

 

Deleting the added roof planes 

• Select the roof plane to which you added the new roof plane. 
Additional plane option is enabled, which indicates that the roof plane contains an additional roof plane. 

• Disable Additional plane option. 

• Click Update. 

The additional roof plane is deleted. 

•  

� To add a new roof plane you can also apply  Hip roof icon  

  Roof plane by reference line 

With this command you can design each roof plane individually. 
You can also use this command when you wish to create a roof on walls of different height i.e. the reference lines of the 
roof planes are not in the same height. 
 
The steps are the following: 
 

� Define the contour of the roof plane 
� Define the reference line 
� Specify the height of the reference line and the angle of the roof plane 

Defining the contour of the roof plane 

• Define the contour of the roof plane:  
either by selecting the walls (the walls must form a closed contour),  
or by applying a command from POPMENU - Profile definition menu. 

� For a description of the Profile definition, see Chapter 8.9. Specifying profile.  

Option: 

SHIFT Apply this keyword if the contour of the roof plane reaches 
beyond the defined profile, or is smaller than that. 

Defining the reference line and the angle of the roof plane 
After defining the contour of the roof 
 

• Specify the reference line of the roof plane by its endpoints. (In the example below the line specified by 
endpoints 1 and 2.) The value for the actual elevation concerns this line. The arrow in the middle of the 
reference line symbolizes the upward direction. 
If you want to modify this direction, click on ENTER keyword. After this you can select the first point of the 
reference line again. 

• Define the roof slope, roof thickness and the height of the reference line in the appearing dialog. 
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  Roof plane by 3 points 

If you do not know the inclination of the roof planes when drawing your roof, you have to rely on other data. In case of 
surveys the known value usually is not the roof slope, but the roof height at different points. So, if you have these values it 
is recommended that you draw a roof plane by specifying 3 height points. 
When you define height you have the possibility to use the height of the object on the drawing. 
The steps are the following: 
 

� Define the contour of the roof plane 
� Specify three height points 

Defining the contour of the roof plane 

• Define the contour of the roof plane:  
either by selecting the walls (the walls must form a closed contour),  
or by applying a command from POPMENU - Profile definition menu. 

� For a description of the Profile definition, see Chapter 8.9. Specifying profile.  

Options: 

SHIFT Apply this keyword if the contour of the roof plane reaches 
beyond the defined profile, or is smaller than that. 

Specifying three height points 

• Specify the first point of the roof plane. 

• Specify the height of the bottom of the roof plane at the given point (2.5 m - wall height). You have to define 
the height of the points in relation to the active floor. By default, the program asks for the height of the 
bottom of the roof plane at the given point. By clicking on UPPER keyword you can specify the height of the 
roof plane top. 

•  
If you want to specify height by using the height of an already existing object, click on LIKE keyword. 
Select an object. Select a point on it. 
Using the icons, specify if you want the height of its bottom or top point. 
For instance, in case of walls you can decide whether you wish to apply the top or the bottom of the wall as reference 
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height. 
The program interprets the height relative to the current floor. 

•  

• Specify the second point of the roof plane and enter its height (2.5 m - wall height). 

• Select the third point of the roof plane and enter its height (3.5 m - wall height). 
These three points you specified clearly define the roof plane. 

Options: 

UPPER Point height means the height of the roof plane top. 

 
Uses the height of the top/bottom of the object as 
reference height. 

 

 

  Creating extruded roofs 

� You have the possibility to create roof structures with various predefined profiles (pitched roof, mansard roof, arched roof 
etc.) More complicated roofs can also be created by using properties that you specify. 

� You can design a roof of any form by defining an individual profile i.e. you define the vertical cross-section of the roof with 
a special, individual profile. 
 
Drag the selected profile along a straight line, or along an open or closed path to create the roof. 

The roof thus created can be projected into an automatic roof with  Project extruded roof command, and this way you 
can create e.g. so called “bull’s eye or dog house type roofs”. 
 
Follow these steps: 
 

� Define the profile; the profile can be predefined or free 
� Define ridge slope 
� Select the type of the path: line, open or closed path 
� Drag the profile along the path 

 
We discuss creating extruded roofs in two steps: first, when we use a predefined profile for the cross-section, second, 
when we define the cross-section with a free profile. 
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 Creating extruded roofs by predefined profiles  

 
 

• Select the icon the profile you want to apply. 

• Set the geometrical values for the profile. 
 
Some of these parameters are the same in case of some profile types. 
 

A Inclination or the angle of the tangent of the side that is 
drawn first, relative to horizontal direction. 

B Inclination or the tangent angle on the opposite side. 
E Inclination of the second roof plane relative to horizontal 

direction (e.g. in case of mansard roofs) 
F Inclination of the second roof plane on the opposite side (e.g. 

in case of mansard roofs) 
H&V Height difference between the reference lines of the two roof 

planes. 
 

• After you modified the values press Apply to refresh the image. 

• Set the inclination of the ridge, relative to horizontal direction. 

• Select the type of roof contour path by choosing from the following options: 
 

 
 

• Ok Closes the dialog. 
 
After this you can define the path, according to the selected path type: 

Line 

The profile is set onto a straight line. The top view of the roof is a rectangle: 
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• Define a line by specifying two points (in the example below points 1 and 2) to define the first side of the 
roof (it is also the reference line of the first roof plane). 

• Drag the cursor and specify a third point (point 3) to define roof width. 
 

 

Open path  

• Define a line by specifying two points. (In the example below points 1 and 2). These define the roof width. 

• Define the length of the first line of the roof with a new point (point 3). 

• Drag the cursor and specify other points to define the open paths of the other lines of the roof. 

• Enter Completes defining the path.  

Options: 

ARC Choose this keyword if you wish to define an arched 
path. 

SELOBJECT Choose this keyword if you select an already 
existent object as part of the contour of the path. 

INVERSE Choose this keyword if the width of the path is not 
in the appropriate direction. 

 

• Define the height of the points after each other. The program indicates those points whose height it 
requires. 

• If the height is the same in case of every point, after you specify the first value, press Enter for the other 
points. 

•  

 

 

Closed path 

In this case the contour of the roof forms a closed path. The determination of path is the same as in the former point, 
except if you press Enter, the program closes the roof contour i.e. joins the starting point and the end point of the contour. 
 
Let’s see the predefined roof types in detail: 

  Pitched roof 

The program creates the roof by two roof planes. 
The reference lines are in the same height. 
 
Example: 

  1.  2.  3. 

A  25º  -20º  35º 

B  50º  -30º  35º 

Ridge angle  0º  0º  35º 
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  Two pitched roofs with sloping ridge, joined 

 Mansard roof 

The program creates a mansard roof on the defined path. 
The reference lines are in the same height. 
 
Example: 

  1.  2. 

A  60º  30º 

B  60º  30º 

E 30º 40º 

F 30º 40º 

H 1.6 m 1 m 

V 1.6 m 1 m 
 

.   
 1.  2 

 Vault 1 

The program builds a vault following the contour of a rectangle. The convex vault follows the arc defined by two of its 
tangents. 
 
Example: 

  1.  2. 

A  60º  60º 

B  60º  30º 

  
 1.  2. 
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 Vault 2 

 

The convex vault follows the arc 
defined by one of its tangents, where 
you have to define the height 
difference between the reference lines 
of the opposite roof planes. 
Example: 
 

A 45º  

V 2 m 
 

 Vault 3 

 

The concave vault follows the arc 
defined by one of its tangents, where 
you have to define the height 
difference between the reference lines 
of the opposite roof planes. 
In the example below the created 
arched surface is mirrored on its ridge. 
Example: 

A 10º  

V 3 m 
 

 Vault 4 

 
 

The convex vault follows the contour of 
two tangentially joined arcs. You have to 
specify the angle of the two tangents and 
the height difference between the 
reference lines of the opposite roof 
planes. 
 
Example: 

A  45º 

B  45 

V  2 m 
 

 Vault 5 

The program builds two vaults following the contour of a rectangle. The concave vaults follow the contour of two joining 
arcs. You have to define the angle of the two tangents on the bottom and the height difference between the reference lines 
of the opposite roof planes. 
 
Example: 

  1.  2.  3. 

A  45º  30º  30º 

B  45º  60º  60º 

V  0 m  0 m  2 m 
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 1.   2.   3. 

 Projecting extruded roof by free profile 

Using this command you can draw a roof with any shape by customizing the profile. This command is similar to the 
previous one; however, here you have to define the vertical cross-section of the roof. You can also project the roof thus 
drawn onto an automatic roof, this way creating a so called “bull’s eye roof” for instance (see the example below). 

• Select the  icon. 

• Define the angle of the ridge relative to the horizontal plane. 

• Select the type of the roof path with one of the following options: 
 

 
 

• Ok Closes the dialog box. 

• Define the profile using the Profile definition tool in the Toolbox, or: 

Options: 

OPENCHAIN • You can select an already existing profile. Click 
on the endpoint of the open profile. Define the 
reference point of the selected profile. 

 

� For a description of the Profile definition, see Chapter 8.9. Specifying profile.  
 
Then define the path according to the selected type: 

Path 

• Define the reference line of the roof by its two points. The reference point previously defined will be placed 
on the reference line. 

•  

 
 

 

 
You can project the so called “bull’s 
eye roof” onto the automatic roof by 

clicking on the  Project extruded 
roof command. 
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Open/Close path 

• Define the points of the open/close 
path. The reference point of the 
profile will correspond to the first 
point. 

• Enter Completes path definition. 

• Define the height of the points 
indicated by the program. 

• In the case of the same height for 
each point press Enter for all the 
subsequent points after defining the 
first value. 
 
 

 

 
Using this command, you can place a roof above a staircase as well. See the example. You can insert a profile with 
different predefined height values on an open path or a free profile. 

 Automatic roof with predefined profile 

This command is different from the Automatic roof command in that instead of using simple roof planes it applies a profile. 
The defined profile can consist of both straight and arc segments. 
 

• Define a cross-sectional profile of the roof to move along the reference line of the roof using the Profile 

definition tool in the Toolbox.  

� See detailed description in chapter 8.9. Specifying profile. 

Options: 

OPENCHAIN You can select an already existing profile. Click on 
the endpoint of the open profile. 

 

• Define the reference point of the selected profile. 

• Define the reference line of the roof. 

For the next steps, see the description under the  Automatic roof command. 
 

� See detailed description in chapter 9.8.2.1. Automatic roof. 

 

 

 
 
 
 
 
 
The reference point of the selected profile. 
Either end of the open chain. 
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� It is recommended to determine the profile from right to left, so that its reference point will be on the right side.  

  Dome roof 

You can create a dome-like roof by using the Dome roof command. Basically, you have to place a circle on the floor plan 
by applying the keywords appearing in the command line. The diameter entered is actually the internal diameter of the roof 
and you can set the roof thickness in the Roof properties menu. 
 

  

  Open dome 

With the Open dome command, you can use a part of a dome roof cut out along the radius as roof. You can either define 
the open dome by three points on the floor plan (using the P3 command) or you can define the starting angle and the end 
angle in the Circular arc dialog box previously. 
 

 
 

 
 

1.72.3. Modifying roof properties 

You can modify the roof properties by selecting the Properties command from the Shortcut menu. The dialog box thus 
appearing contains the current values of the selected roof. If you change any value, the roof will change accordingly. 
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There are four dialog boxes within the Roof properties dialog box: Eaves purlin, Rafters, Battens, Projection and cut, and 
Roof planes. 

A ridge tile can only be modified globally. In other words, to do so right click on the  Roof icon or select the 
Properties menu - Roof - Roof properties dialog box. This is a global command for all existing roofs. 
 

� For details, see Chapter 9.8.1. Roof properties and Chapter 9.8.2.1. Automatic Roof. 

Modifying extruded roof 

In case of an extruded roof the Modify properties dialog box is different from the ones discussed above. 
 

� An extruded roof has fewer properties than an automatic one; consequently, you can modify fewer values in the General 
properties dialog box. 

� In the Roof planes dialog box you can modify both the Starting height and the End height. 
If you have placed the extruded roof on an open chain, the starting and the end heights refer to the segment with hatching. 
You can select the segments by either clicking or by arrows. The dialog box will calculate the slope of the ridge from the 
starting and the end heights. You can also define the end height with entering the slope. 

� You can modify the profile of the projected room in the Extruded roof dialog box appearing when clicking on the Roof 
slope - Projected button. 
 

 
 
With this option of modification, you can set the roof height at the breakpoints above the stair. 
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1.72.4. General editing of roof geometry 

There are several methods to modify or edit the geometry of an already existing roof. In this part, we will discuss the 
following: 
 

� Extruded roof 
� Extend roof 
� Hip roof 
� Multiple hip roof 
� Separating roof plane 

� Inverting slope of single roof 
� Modifying height 
� Deforming roof edge 
� Deleting deformed edge 
� Vault resolution 
� Roof window 

 
You can select these commands the following ways: 

� From the  Roof tool:  

 

 
 

� From the Shortcut menu: 

 

 

  Extruded roof 

This command identifies the overlapping of the different roof surfaces. It projects the extruded roof first selected onto the 
target roof by applying different merging methods. 
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! You can only project a roof created by the  Extruded roof command. The target roof can be of any type; however, 

you have to keep in mind that the geometry of the roofs must be adjustable when projecting. 

 

• Select a roof to be projected onto another roof plane. 

• Select the method of projection from the dialog box. This command will merge the selected roof and the 
target roof. 
 

 
 

• When the roof is projected, you can define the length of roof plane under the projected roof in the Projected 

roof dialog. 
 

 
 

• Select a target roof into which you want to merge the extruded roof. 
When selecting the third option, define a plane of the target roof by one of its internal points to which you 
can adjust the extruded roof. 

Before projecting: 
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After projecting when using the second option: 

 

After projecting when using the first option: 

 

Before projecting: 

 

After projecting when using the third option: 

 
 

� The extruded roof can be projected onto the prepared roof from both sides this way merging them as it is shown in the 
figure. Both sides of the extruded roof can be projected, so this way you can connect two already constructed roofs. See 
the following figure. 
 

 

 Stretching roof 

With this command you can modify the length of an extruded roof. 
 

• Select a side edge of the extruded roof to be extended. 

• Specify the new position of the edge. 
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  Hip roof 

By creating a new roof plane this command will build a hip roof of two front facing roof planes with a common edge. 
Depending on the type of the selected roof, you can use two different methods to insert a new roof plane. You can use the 
same command for deleting a previously inserted roof plane. 

Extruded roof into hip roof 

With this command, you can create a new roof plane to fully or partly close the open side of the roof. 
 

• Select an extruded roof to which you can add a new plane. 

• Specify the reference line of the new roof plane by one of its points on the projection of the roof’s open side. 
The point specified will define the height of the reference line. If you place the point on the corner point of 
the predefined roof, the new plane will fully close the open side of the roof. 

• The Roof plane dialog box appears. You can modify the slope and the thickness of the roof as well as the 
relative and the absolute heights of the reference line. 
OK Completes the command. 
 
Example: 
 

 
 
The height of the 
reference line (2.70 m) 
corresponds to that of the 
already existing roof’ 
reference line. The slope 
is 35º. 

 

The height of the 
reference line (3 m) 
extends that of the 
already existing roof’ 
reference line. The slope 
is 35º. 

 

Automatic roof into hip roof 

Here you can add a new roof plane to an automatic roof. You can place the new plane onto an already existing roof plane 
or onto an open side. 
You can define the height of the new plane’s reference line by either related to the reference line of the roof or by selecting 
a point of the roof. 
You can delete an added roof plane as well. 

Reference line by height: 

• Select a roof. 

• Click on one of its roof planes to add another plane. 

• Enter the relative height of the new roof plane’ reference line related to the reference line of the selected 
roof plane. 

• Enter the slope of the new plane. 

• Enter Completes the command. 

Reference line by selecting a point  

• Select a roof. 
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• Click on the SELECTPOINT keyword. 

• Select a point to define the height of the new plane’s reference line. 

• Enter the slope of the new plane. 

• Enter Completes the command. 

•  

 

Delete added plane 

• Select a roof. 

• Click on the DELETE keyword. 

• Select an added roof plane to delete. 

• Enter Completes the command. 
 

� In case of an automatic roof, you can add a hip roof by using the General properties - Roof planes dialog box. 

  Multiple hip roof 

In the case of creating more complex, multiple hip roof structures you may have to add another new plane to the a 
previously merged roof plane, that is, you may have to create a new hip roof. 
 

• Click on the roof plane (point 1) 
where you wish to create a new 
hip roof. (In case of a plane of 90 
º, click on the edge, otherwise 
inside the plane.) 

• Define the reference line of the 
new plane by specifying two 
points. (Point 2 and 3.) 

• You can set the exact height of 
the reference line in the 
appropriate field. 

• Enter the slope value of the new 
plane. 
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  Separating roof plane 

This command helps you to customize any selected plane of an automatic or a predefined roof. The corner points of the 

new roof are „free”, that is, they can be freely edited. You can, for example, apply the  Move node command. 
 

• Select a roof plane to be customized. 

• Enter Accepts the selected plane. 

• NO Selects another plane. 

• Enter Completes the command. 
 

� You cannot separate an automatic roof defined by a profile into roof planes. For such roof structures use the Edit 

structural node commands. 

 Inverse angle of single roof 

This command inverts the slope of a single roof. 
 

• Select a single roof to invert its slope 
 

� You can only apply this command for roofs created plane by plane (that is for roofs created by the  Roof plane by 

reference line or, the  Roof plane by 3 points commands). 

 Modifying height 

You can also modify the height of any point of the infinite plane belonging to the roof plane. If you modify a point, the 
program will rotate the roof around the reference line of the roof as axis. 
If the selected point is on the roof ridge, it means that the height of all the roof planes connected to the ridge will be 
changed. 

 

• Select a roof to be modified. 

• Select a point to define the height of the roof. 

• Enter the height of the roof above the point selected in the previous step, or click on the LIKE option of the 
Command line to use the selected point of the roof edge to give the height and select the point of the 
desired height. 

• Select the roof planes (by clicking on any of their internal point) which will be modified by the new height 
point. 

For example: 
In the case of an automatic roof the program will draw the planes by the given slope values. In case of more complex floor 
plans the roof ridges can have different heights. Use the Modify height command to move the selected ridges to the same 
height. This modification will, of course, change the slopes as well. 
 

 
 

� You cannot modify a point of the reference line. If you click on the reference line, the program will show its height, 

however, you cannot change it. 

  Deforming roof edge 

This command in the side menu will deform the roof plane by modifying its selected edge. You can change the roof planes 
and create arched surfaces by modifying the ridge. 
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You may need this method when the opposite walls of the building are not parallel. Here the ridge of the automatic roof is 
not horizontal. If you want to change the ridge horizontal, it means that the roof planes will be deformed and arched 
surfaces will be created. 
 
This building has been drawn with an automatic roof and two gables. 
 

 

 

 

 

 
Using the command, you can make the roof ridge horizontal. 
After selecting the ridge, use the commands of the Edit profile tool to deform the roof plane.  
 

• Select the roof for modifying the height. 

• Select the roof edge whose height you would 
like to modify. In the example, the ridge has 
been selected. 

• Place the layout image of the edge on the 
drawing area. 

• Use the Edit profile tool to add a node or to 
convert a side into an arc, etc. 
Now select the Move node option to move 
the higher endpoint of the ridge to the level 
of the lower endpoint. 

• Enter Completes defining the profile. 

• Enter Exist the Edit profile command. 
 

  

� See the description of the Edit Profile tool in Chapter 8.9.9 Editable profile. 
 

• Enter the value of resolution on the edge. The larger the set value is the higher the resolution becomes. This 
is important when you want to convert a selected edge into an arc. In the example, the value of resolution is 
1. 
OK Closes the dialog box and completes the modification. 

 

   

 
You can covert the edge into an arc. In this case, select the Edit profile tool - Line->Arc command. Define the arc. The 
resolution is of great importance here. Enter for example 64. 
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� In order to maintain the accuracy of the floor/roof geometry, split lines are often created automatically. The automatically 

created split lines are deleted when the condition that caused them to be created is no longer valid. For example, when 4 
non-planar vertices become planar.  

 In case you want to restore the original form of the modified roof edge, click on the Shortcut menu - Edit - Delete 
deformed edge command. 

 Delete deformed edge 

With this command, you can delete the edited roof edge and restore the original form. 
 

• Select the roof to be modified. 

• Select the pick point to be deleted. 

Options: 

ALL Use this option when you want to restore each edge 
of the roof. 

EDGE Use this option when you want to restore the edited 
roof edges one by one. 

 Vault resolution 

If the reference line of the roof follows a circle or an arc, the program will automatically create a coned roof. Use this 
command when you want to convert a coned roof into a plane one due to implementation or projection. 
You can transform a coned roof into a polygonal roof by entering the number of the nodes in relation to the arc and the 
direction of the polygon’s basic edge. 
 

• Select the extruded roof or an arched edge of the coned roof to modify the resolution. 

• Enter the resolution degree of the arched segment (0 means no resolution). 

• Define the direction of the pyramid’s basic edge. The program will offer the centre point of the circle for 
setting the direction. 
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 Roof window 

Use this command to place a roof window on the defined roof plane. The type of the roof window can be selected in the 
dialog box appearing. 
 

� For detailed description see Chapter Insert door/window – 9.3.2.5. Insert roof window section. 

1.72.5. Editing roof nodes 

The free nodes of the roof can be moved or deleted and its free edges can be shifted parallel or converted into an arc and 
back. 
 

� The free nodes of the roof are the ones not used in the creation of the roof profile, while the ones used in the profile 

creation are called structural nodes. 

 
� Each node and edge of a single roof plane is free. 
� An automatic roof has no free nodes. The arris and ridge are not free while the edges terminating a simple plane are free. 

The nodes added to the free edge are free as well. 
� An extruded roof has no free nodes. Only the ones added to the only free edges perpendicular to the projection are free. 

 
Consequently, if you want to edit the nodes of a roof plane in case of an automatic or extruded roof first you have to 

separate the desired roof plane form the current roof. Use the  Separate roof plane command to do so. The nodes 
and edges of the single roof planes thus created are free. 
In case of automatic roofs by profile and extruded roofs with arched surfaces, you can only apply the commands related to 
editing Structural nodes. 
 
You can find these commands in Shortcut menu:  

 

 
 

  Moving, adding or deleting nodes 

Use this command to move, add or delete free nodes.  

Move node 
Moves free nodes by clicking on any of them. 

Delete node 
Deletes a selected roof node by clicking on it and selecting the DELETENODE keyword. 

Add node 
Add new roof nodes by clicking on any free edges of the roof. 
 

• Select a free roof edge where you want to add a new node and specify the position of the node, or 
select the SPLOYGON keyword from the command line to create a closed polyline as part of the roof 
contour. 

• Specify the nodes to be inserted. 

• Enter Completes the command. 

 Parallel shift 

Use this command to move a selected side of the roof with a given distance. 
 

• Select the edge to be moved. 

• Specify the new position of the roof contour. 

• Enter Completes the command. 
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 Line <-> Arc 

You can do the following modifications with the help of this command: 

Arched roof side � Straight roof side 

• Select an arched roof side to convert it into a straight one. 

Straight roof side � Arched roof side 

• Select a straight roof side to be modified. 

• Specify a point. The arc will cross this point,  
or select any of the options of the command line. You can select and arched roof side as well to modify the 
arc radius. 

• Enter Completes the command. 

Options: 

DIAMETER Value of the diameter 

RADIUS Value of the radius 

PERIMETER Value of the perimeter (length of the arc) 

ARC Value of the arc cord 

 

 

 

1.72.6. Editing structural nodes 

The nodes involved in the creation of the cross-sectional profile of the roof are called Structural nodes. To edit structural 
nodes use the commands of Edit structural nodes (Edit nodes cannot be applied here). 
You can find these commands in the Shortcut menu: 
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 Moving structural nodes 

Use this command to move structural nodes. 
 

• Select the roof whose reference line you want to modify. 

• Select the node to be moved. 

• Specify the new position of the node. 

• Enter Completes the command. 

 Parallel shifting of structural line 

Use this command to move parallel a structural edge of the roof, that is, the reference line of the roof. 
 

• Select the roof whose reference line you want to modify 

• Select the edge to be moved. 

• Specify the new position of the edge. 

• Enter Completes the command. 

 Adding structural nodes 

You can add structural nodes used for the creation of profiles to the reference line of the roof. 
 

• Select a roof to be modified. 

• Select the segment of the reference line where you want to add a new node. 

• Specify the position of the new node. 

• Enter Completes the command. 

 Deleting structural nodes 

You can delete structural nodes on the reference line of the roof used for the creation of profiles. 
 

• Select a roof to be modified. 

• Select the node to be deleted. 

• Select other nodes, or 

• Enter Completes the command. 

 Structural line - Arc 

You can do the following modifications with the help of these two commands: 
 

 

Arched roof side� Straight roof side 

• Select an arched roof side to be converted straight. 
 

Straight roof side � arched roof side 

• Select a straight roof side to be converted arched. 

• Specify a point. The arc will cross this point,  
or select any of the options of the command line. 

• Enter Completes the command. 
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Options: 

DIAMETER Value of the diameter 

RADIUS Value of the radius 

PERIMETER Value of the perimeter (length of the arc) 

ARC Value of the arc cord 

1.72.7. Roof – Edit layers 

Roof layers can be edited similarly to editing slab layers. You can access Edit layers tool in Roof pop menu – Edit layers 
or the Roof Move marker menu – Edit layers. 

 
 
After selecting the Edit layers tool, you can make an offset to all endings of the active layer in one step. Click on the 
dashed contour marker of the roof active layer and select Move layer ending.  

 
 
The roof layers setting dialog is extended by new possibilities: 

• Roof layer bottom ending distance and type can be set. 
 
You can set the bottom ending distance by selecting from the dropdown list or you can type a value. 

 
 
If the roof layer bottom ending distance is not set to “Follows roof ending” then you can select a layer 
ending type by clicking on the ... button. Select an ending type in the appearing dialog window and click OK 
to accept it. 
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• Visibility of the layer can be set for each roof layers one-by-one. 

 

1.72.8. Roof hole 

You can use this command to create, delete or move a hole on the roof. Use the Hole command when drawing chimneys. 
You can find these commands in the Shortcut menu: 

 

  

 Creating a roof hole 

You may need to create a roof hole when constructing for example a chimney. This function is always related to a roof. 
 

• Select a roof on which you want to create a hole (the plane of this roof will be the reference plane of the 
hole). 

• Define the hole’s profile using Profile definition tool. 

• Enter Completes the command. 

� For a description of the Profile definition, see Chapter 8.9. Specifying profile.  

 

 
 
Another way to create a roof hole is to cut the roof contour with the defined profile: 
 

 

 

 Deleting a roof hole 

Use this command to delete an already existing roof hole. 
 

• Select a roof hole to be deleted. 

• Enter Completes the command. 
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 Moving a roof hole 

Use this command to move an already existing roof hole. 
 

• Select a roof hole to be moved. 

• Select the reference point of the roof hole then define the new position of the hole by moving it by its 
reference point. 

• Enter Completes the command. 

 Copy a roof hole 

Use this command to copy an already existing roof hole. 
 

• Select a roof hole to be copy. 

• Select the reference point of the roof hole then define the new position of the hole by moving it by its 
reference point. 

• Enter Completes the command. 

1.72.9. Roof framing 

You have to enable the Enable eaves purlin, Create rafters, Create battens options in the Properties dialog box and the 
program will create the framing of the roof. 
When drawing use the properties set in the Eaves Purlins, Rafters and Batten dialog box. 
 

 
 
The roof framing is displayed on the floor plan as well as on the 3D representation. To satisfy your needs with regard to 
the geometry of the framing the program enables its editing. You can edit the framing by its objects, one by one, or all on 
the roof plane at the same time. 
 
Use the following commands for editing in the Shortcut menu: 
 

 

 Moving 

Moves the whole framing of the selected roof plane. 
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• Select a beam by the point to be its reference point when moving. 

• Specify the new position of the beam. The whole framing of the roof plane follows the movement; however, 
the distances between the beams will remain the same. 

• Enter Completes the command. 
 

The following figure clearly illustrates that the opposite beams do not join: 
 

     
 

  
 
 
After moving: 

 
 

 
 

� You can also move the framing so that the outermost beam is adjusted to the roof edge (e.g. in the case of a gable wall). 

 Moving one beam 

Here you can only move the selected beam. 
 

• Select a beam by the point to be its reference point when moving. 

• Specify the new position of the beam. 

• Enter Completes the command. 

 Inserting 

This command inserts a new beam into the desired place. 
 

• Select a beam (the inserted beam will be parallel to this one and be placed on the same roof plane. 

• Specify the position of the new beam. The program will automatically insert a new beam into the specified 
place. 

 Deleting 

This command deletes the whole framing from the roof plane or the complete roof framing. 
 

• Select a beam on the roof. The program will automatically delete all the beams on the selected roof plane, or 

• Select the ALL keyword from the command line to delete the complete roof framing. Enter. 
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 Deleting one beam 

This command deletes the selected beam from the roof. 
 

• Select the beam to be deleted. Enter. 

 Move endpoint 

This command moves the endpoint of 
the selected beam closer to the point 
of selection. Beams can be both longer 
and shorter than the plane of the 
selected roof. 
 

• Select a beam. 

• Specify the new position of the 
selected beam. Enter. 

 

 

 Arc batten  

This command can divide the arched segment of the batten following the curve of the wall into equal parts. This command 
is similar to the Vault resolution command. 
 

• Specify the value of resolution. This is actually the number of the equal segments of the purlin. 

• Specify the new position of the framing. You can define the starting point from where the resolution of the 
batten’s arched part begins. 

 Modifying 

With this command, you can modify each beam property one by one. 
 

• Select the beam/beams to be modified. Enter. 

• Define the desired properties in the Beam properties thus appearing. The defined properties concern the 
selected beam(s) only. 

• Enter Completes the command. 

Example: 

You have defined the cross-section of the beams in the Roof properties dialog box. This cross-section is of global 
relevance. However, you have to assign a larger cross-section to the hip-beam due to the extra weight on it. 
Apply the Roof framing - Modify option to the selected hip-beam. Specify the desired cross-section. The newly defined 
cross-section is relevant to the hip-beam only.  

 

� See the detailed description of the properties in Chapter 9.8.1. Roof properties. 

 Restoring framing 

This command restores the original framing of each roof plane one by one. 
 

• Select an option in the Command line: 
 

HORIZONTAL It restores the battens for roof tiles only. 

PERPENDICULAR It restores the eaves purlins only. 

ENTER It restores the complete roof framing. 

 

• Select the appropriate roof lane. 

• Enter Completes the command. 
 

� To restore the complete roof framing use the Properties - Roof - Delete and rebuild all rafters and eaves purlins / battens 

options.  
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  Horizontal beams adjusted to roof  

You can adjust horizontal beams to roof with the help of command. The selected roof plane defines direction and height of 
beam. 
 

• Define the parameters of beam through the Beam dialog box.   

� See 9.2.2. Beam chapter. 

• Select a roof plane to adjust the beam. 

• Define the origin of beam. 

• Define the end of beam, or 

• Or choose an option from the Command line: 
 

INVERSE The profile of the beam mirroring to the path. 

FULL The roof plane determines the length of the beam. 

•  

� The beam cannot be longer than the roof plane.  

The beam, created like this is not part of the roof, so it is not part of the roof list either.  

  Beams adjusted to rafter direction 

You can adjust beams to rafter direction with the help of command. The selected roof plane defines the angle of beam. 
The beam cannot be longer than the roof plane. 
 

� See the detailed description in chapter 9.8.9.10. Horizontal beams adjusted to roof. 

  Beams adjusted to roof edge 

You can adjust beams to roof edge with the help of command. The selected roof edge defines the position of beam. The 
beam cannot be longer than the roof edge. 
You can use the command well for example, if you create the roof from roof planes.  In this case the hip-rafter and ridge 
purlin are not part of the built framework. 
 

� See the detailed description in chapter 9.8.9.11. Beams adjusted to rafter direction  

 Roof Framing – Convert to Beams 

With the help of this command, you can create individual architectural beams as a copy of roof framing. 
You can activate these commands either in the Shortcut menu the Roof framing / Convert to beams. 

1.72.10. Roof - Information 

You can ask for different types of information about the selected roof. 
You can activate these commands in the Shortcut menu  
 

 

  Intersection line 

This command finds the points of intersection of the two selected roof planes and inserts an editing line on their virtual 
intersection. 
 

• Select two roof planes to create the intersection line. The program will display the intersection line. 
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To join the planes by the intersection line move the nodes of both planes to the intersection line by using the  Move, 
add, delete node icon. 
 

 

 

  Level line - Outer - Inner 

This command draws the level line of the roof at the given height respectively on the outer or the inner surface of the roof.  
This level line can be used for example when inserting a roof window at a given height. 
 

• Select a part of the roof where you want to draw the level line. 

• Specify the height of the level line relative to the current floor. The program displays the line at the specified 
height. 

 
You can insert roof windows at the desired height by using the level line. 

  Querying height 

The dialog box appearing when activating this command provides information about the height of a selected roof edge at a 
given point. The information can be embedded into Word or Excel by activating the Copy to clipboard command. 
 

� You can paste the text from the clipboard into the drawing by activating the Text tool - Current text - Paste button. 

 

• Mark a roof edge at a desired point to define the height. The program displays the height of the top surface 
of the roof plane at the desired point, or  

• Select the BOTTOM keyword to query the bottom surface of the roof plane. 
The dialog box thus appearing will display the height. 

  Show numbering 

By activating this command, the program automatically numbers each roof planes and displays an identification number by 
them. 
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The Add - On menu – Quantity 
Take – Off - Building calculation 
dialog box displays several types 
of information about the roof. The 
ID among them helps you to 
identify the roof where the framing 
object belongs. 
 
This is a global command applying 
to each roof of the drawing. 

 

  Hide numbering 

This command deletes the numbering of each roof planes. 

  Building calculation 

The Add On menu – Quantity Take Off - Building calculation - Roof+beams command applied to a roof displays data 
about the roofs as well as the framing objects. 
 

� You can also obtain a building calculation list about a roof in Word or Excel from the Add - On menu. 

 
The following example shows a table of lists and its corresponding table in Word format. 
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1.72.11. Dormer roof 

With the help of Dormer roof tool, you can create detailed dormer roof structures; you don’t need to design all the details 
only to set the parameters. After setting up the setting, you can position the dormer roof object in one single step into the 
roof structure. 
 
After starting the Dormer roof tool, you will see the following dialog window.  
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The backgrounds of some rows will be shown in yellow. The rows in yellow cannot be modified after placement. 

  Roof 

In the roof section of the dormer roof setting window, you can set the details of the roof structure, used as the roof part of 
the dormer roof. 

 

Roof properties 

You can set detailed settings for roof structure of dormer roof. You can use previously saved sets. To change settings 

please press the  button at the end of the row. 

(OF) Overhang in front 

You can set the overhang of the roof at the front plane of dormer roof. Please type a value or choose one from the drop-
down list. 

(RA) Ridge Inclination 

You can set the inclination of the ridge (or at some specific cases, the angle of roof plane). Please type a value or choose 
one from the drop-down list. 

Roof elevation from: 

Please choose one from the drop-down list. 
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Roof elevation 

You can set the so-called base height of the roof; this will specify its position in the 3D space. The value given will be used 
as defined by the setting previously made at “Roof elevation from” value.  

Elevation from roof top 

Enable the Elevation from roof top option to make the previously set roof elevation value measure from the top roof 
surface. When you disable this option, the roof elevation value will be measured from the base level of the active floor. 

Fixed width 

If you enable this option, you will be able to give a value for the width of the dormer roof. This option can be used only for 
new dormer roofs and for predefined types. If you disable this option, you will be prompted to define the width graphically 
during the placement of dormer roof. 

Place on roof 

You can place dormer roof directly onto the surface of a selected roof plane. The option is available only when you enable 
and set the Fixed width option. The following examples are showing you the differences between enabled and disabled 
settings. If you enable this option the original roof and the dormer roof will be automatically joined to each other also. 

 
Place on roof option disabled 

 
Place on roof option enabled 

Ridge path 

You can choose from the drop-down list, and based on the setting you made you can design the path of ridge during 
placement. This option is available only when you disable the Place on roof option. 
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  Predefined roof 

In the predefined roof section of dormer roof setting dialog window, you can define the rules of how the dormer roof’s roof 
structure will be projected into the original roof. You can see more or less setting if you choose one certain type of the 
predefined roof.  

 

Type 

You can set the type of dormer roof shape. Please choose one from the drop-down list or click on the picture you can see 
at the right bottom corner of the dialog window to change type. 

 

(A), (B), (E), (F), (V), (H) values 

You can set the value, explained on the right side picture.  

Side roof 

Set this option enabled to design side walls by roof planes. In addition, you can set the bottom position of the side roof 
plane. 
 

  
Side roof disabled Side roof enabled 

 

 

Side roof enabled and value is set  

Bottom of side roof from roof top 

You can enable this option if you previously enabled Side roof option. In this case, you can define the distance between 
the original roof’s top plane and the bottom of side roof plane. If you disable this option, the value given will be measure 
from the base level of the active floor. 
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  Hip roof 

You can create hip roof in the roof structure of the dormer roof by using the settings of hip roof section in the dormer roof 
setting dialog window.  

 

Hip roof 

You can enable to create a hip roof, based on the settings of the hip roof section. 

  
Dormer roof with hip roof Dormer roof without hip roof 

Hip roof angle 

You can define the angle of hip roof. 

  
Hip roof with different angle values 

Hip roof elevation 

You can set the elevation of the base height of the hip roof, measured from the base level of the active floor. 

  
Hip roofs with different elevations 
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Hip roof elevation from roof top 

If you enable this option, the value given will be measure from the original roof’s top plane. If you disable this option, the 
Hip roof elevation value will be used. 

  Dormer roof settings 

In this section of the dormer roof setting dialog window you can set detailed settings for the dormer roof. 

 

(OL) Overhang in left 

You can set the overhang of the roof at the left side of the dormer roof. 

(OR) Overhang in right 

You can set the overhang of the roof at the right side of the dormer roof. 

 Wall properties 

You can set the detailed settings of the side walls of the dormer roof. To change the settings please press   button at 
the end of the row. 

Side walls 

You can enable or disable side walls on 2D and in 3D. 

  
Dormer roof with side walls Dormer roof without side walls 

Cut wall bottom 

If you enable this option, the bottom of the side walls will be cut by the top plane of the original roof. Otherwise, the 
settings of the wall properties will define the bottom of the wall. 

Hide walls on 2D 

Enable this option to hide wall symbols only on 2D. The 3D model won’t change using this option. 
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Walls on 2D are visible Walls on 2D are invisible 

 

  Window properties 

You can change the setting of the windows of the dormer roof. To change the settings please press   button at the end 
of the row. 

Number of windows 

Here you can set the number of windows you want to place into the front wall of the dormer roof. 

(WD) Distance between windows 

You can set the distance between the windows of dormer roof. 

Place windows centred 

Enable this option to align windows into the middle of the dormer roof front wall. Otherwise, the settings made in window 
properties dialog window will be used as the first distance of the first window on the left side. 

 Place windows on inner side 

Enable this option to place the window to the inner or outer part of the dormer roof front wall  

 (RPh) Parapet elevation from roof top 

If you enable this option, you can set parapet elevation measured from the original roof’s top plane. If you disable this 
option, the parapet elevation will be measured from the base level of the active floor. This option is available only when 
you create a new dormer roof, and if you previously enabled Place on roof option. 
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1.72.12. Gutter and downspout 

ARCHLine.XP supports the gutter and downspout design collecting rainwater from the roof. 
 
Menu: Building > Outdoor Tools > Gutter  
Menu: Building > Outdoor Tools > Gutter on Roof Edge 
 

 
 

 

Gutter on Roof Edge 

You can select the roof edges directly in 3D where the gutter will be aligned and later assign the points where a 
downspout will be installed. 

Downspouts 

You can add the downspouts in 3D with the Add downspout command. 
 



620 10. Building model 

Manual 

 

3D editing 

You can edit the gutter and downspouts in 3D with the markers related to nodes and edges. 

 

1.72.13. Roof Survey 

Menu :  Building > Roof 
 

Roof Survey is required in the following cases: 
1. To replace the roof covering with a heavier tile; 
2. Showing calculations for strengthening works for building regulations approval 
3. Recommended alterations to truss rafters / other structural supports 

 
From a Structural point of view, if the existing roof tile covering is to be replaced with a new heavier roof tile then a 
full structural appraisal is required to ensure that the current roof structure is suitable to carry the increased 
loadings. 
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ARCHLine.XP provides a new set of commands to support roof survey. It is based on measured inputs of roof 
edges, parallel ridge and eave (if exists) and diagonals and for specific cases like single roof plane a height 
difference between ridge and eave. 
Roof Survey offers two outputs. 

1. Create the model in 3D with the appropriate inclination angle, or 
2. Place horizontally the roof planes near to each other 

It displays all the measured length and calculates the plane area and exports it into XML output. 
 

 
 

Steps or roof survey: 

In the first phase, you have to draw the roof plane using the measured length of roof edges like the figure below. 
There is no need to be precise with the roof estimated 2D drawing but it is very important to measure the real 
length as precise as possible. 
The drawing below indicates the result of a surveyed roof with real roof edge annotations. 
The triangle with bold lines displays the difference between the annotated length and the 2D drawing line. 

  First surveyed roof plane  

Choose a roof plane that contains a horizontal roof eave: 
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Click on the horizontal roof eave and define its length. Later click on the next edges one after another and enter 
their length. 
When you close the loop, the following dialog displays: 

 
In case of the first roof plane, choose the first option. As the roof plane inclination is unknown at this point, you will 
place it in horizontal position temporary. 

 

  Second surveyed roof plane  
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The next roof plane to be surveyed must have a common edge with the previous one. 
Therefore, in this example the common edge will be the edge indicated with 5.233 m quote.  
 
Click on the horizontal roof eave and define its length. Click on the next edges consecutively and enter their length. 
When you close the loop, the following dialog displays: 

 
 
When the roof plane has only four nodes choose the first option. If you survey a roof plane containing more than 4 
nodes you have to define additional diagonals on the roof plane to reconstruct the shape precisely. You have to 
measure the nodes number minus 4 diagonals. IT means if you have 5 nodes you need to add one diagonal, and if 
you have 6 nodes you have to measure 2 diagonals additionally, etc. 
 
Select the parallel edges indicated with 5.663 m and 6.687 m quotes. 
 
When you close the parallel edges selection, the following dialog displays: 
 

 
 
In case of the second roof plane, choose the second option. The roof plane inclination is calculated as a result of 
the geometry of the first and the second roof plane common edge and surveyed values. 
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  Next surveyed roof planes 

The next roof planes must have a common edge with the previous one as well. 
So in this example the common edge will be the edge indicated with 5.565 m quote.  
 
Click on the horizontal roof eave and define its length. Click on the next edges consecutively and enter their length. 
When you close the loop, the following dialog displays: 
 

 
 
As the roof plane has five nodes you have to define one diagonal to complete the geometry. Choose the second 
option and click on the endpoints of the diagonal indicated with 5.874 annotation. Type this value and press 
ENTER. 
At this point, the same dialog comes again and selects the first option now to define the parallel ridge and eave. 
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When you close the parallel edges selection, the following dialog displays: 
 

 
 
In case of the third or more roof planes, choose the third option. The roof plane inclination is already calculated 
and the third roof plane will be adjoined using the same roof slope. 
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Note: At this point, you cannot continue the survey with the next roof plane as the common edge is horizontal. 
Horizontal common edge means indefinite condition to go further with.  
The roof survey has to continue in anticlockwise direction returning to the first surveyed roof plane. 

 
 
As you see the roof survey requires very precise input that is difficult to provide in most cases. For this reason, the 
final result will contain some error in the geometry that need to be edited and corrected at the end. 
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Select the roof planes to be rotated and click on the blue anticlockwise marker and select the Rotate from 
command and define the rotation graphically as indicated. 
 

 
 
Move the roof nodes to complete the survey. 

 
 
You will receive similar result like this: 
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  Display roof plane length and area 

You can get length and area information with Show Length and Area command. Select the command and click on 
the roof planes consecutively. 
 

    
 

  Add custom text to annotations 

You can assign your custom text to roof single and common edges with Add User Info to Single Edge and Add User 
Info to Common Edge command. Select the command and click on the roof planes  
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1.72.14. Same height 

Pop Up Menu: Roof > Same height 
 
The command adjusts the elevation of a ridge to another ridge. You have to select first the ridge to change its elevation 
and after the second ridge to pick up its elevation. Later click on the roof planes you wish to update. 
 

 
 

 
 
The result:  
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1.72.15. Asymmetric Roof: Different elevation 

Property dialog: Roof > Pitch and Shape 
 
The command enables to change the roof structural edge elevation separately. The rafter and the purlins are following the 
changes. The battens keeps its place if you wish to follow the rafter new position you have to press the “Delete and rebuild 
all battens” button. 
 

 
 
The result:  
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1.73. Objects and profiles 

Introduction 

ARCHLine.XP® has several categories (.oli) within the Object directory where you can select the object type. 
All types have alterable parameters, the value of which you can modify. 
This way, you can insert the same object with various parameters into the drawing, without increasing the size of the 
directory. 
However, there never can be such an objects directory, which for example contains all individual pieces of furniture. 
Therefore, the program provides the possibility of creating individual objects by using the Solid modeller. 

The icons of the  Object tool allow you: 
 

 
 

� To select, insert, and modify objects 
� To save 3D objects to the objects directory 
� To create and insert sprites (objects that have no width) 
� To save profiles to the profiles directory 

1.73.1. Object properties and placement 

You can select, set the properties of and insert objects in various ways in the program: 
� With the Interior menu – Single Object command 
� With the Toolbox - Building– Single Object command 
� With the Toolbox - Interior– Single Object command 
� In the Design center – Catalogue - Objects, for the detailed description of which see Chapter 2.16.9.Design center. 

 
Once you have selected an object and set its properties, you can place it in the drawing by using different options. 
Modifications you make to any object properties in the appearing dialog box will apply to objects you insert afterwards. 
 

 
 

We discuss object properties in the following order: 
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� Selecting object type 
� Main parameters 
� General properties 
� Attributes of placement 
� Placement 

 Selecting object type 

• Choose a category and a sub-category within that from the list in the objects folder. The 3D representation 
and the parameters of the selected object appear in the dialog box, those you can modify as required. 

• If you keep clicking the pant bucket icon, you can specify whether you wish to display the objects in the 
selected category by 3D view or by 3D image. 

 Main parameters 

When you double-
click the value, you 
may modify the 
parameters of the 
selected object. 
In the case of 
nonparametric 
objects, you may only 
modify the size of the 
bounding box of the 
object (Height, Width 
and Depth).  
 

  
 

In the case of 
parametric objects, 
you can modify the 
components and the 
size of the bounding 
box of the object 
(Height, Width and 
Depth).  
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Choose another door 
type or another 
material from the list 
below the 3D view. 
 

 
 

Materials 
For each object, you can specify the assigned materials. 
 

In the case of non-parametric objects, 
you can alter the material properties 
by clicking on the New material 
button. The Material dialog box pops 
up, where you can select the 
appropriate material display t 

 

 

 

In the case of parametric objects 
(created by the KBB tools), you can 
specify each material of the object in 
the Material tab below the 3D view.  

 

 

 
Once you have modified the parameters of the selected object type, click the Redraw button to see the modified object in 
the window. 
 

� When you set the main parameters, the program verifies the specified values on the basis of various internal criteria. If a 

value fails to meet the criteria, after clicking the Redraw button the program informs you that the values cannot be 
accepted and restores the original settings. 
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Therefore, we suggest that if you alter more parameters you should click the Redraw button after each value definition 
so that the program can instantly indicate if it accepts the specified value or not. 

 General properties 

As all other objects in ARCHLine.XP®, objects have colour, layer, line type and line width properties, too. 
 

� See:  
� the detailed description of general properties in Chapter 3.2.1 Specifying general properties, 
� the description of sets in Chapter 3.2.3. Using sets of properties, 
� the description of cost variables in Chapter 3.2.4. Assigning variables. 

Keep original layers 

You can apply this function when you want to display objects whose various parts you placed on different layers. By 
selecting this option, you can insert all parts of the object in the layers you defined for the object. 

 Attributes of placement 

Sprite in fixed direction 

This setting concerns sprite position. Sprites are objects that yet have no width practically they are 2D planes. By default, 
sprites are always displayed in front view, regardless of how you rotate the figure or set the perspective. As a result of this 
feature, they are like real solids. 
When you do not always need to see the selected sprite (people, cars, plants, etc.) in front view, turn on the Sprite in 
fixed direction option. In this case, they will be rotated together with other 3D solids, so from a certain angle you will only 
see a surface that has no width. 

Relative height 

You can set the elevation of the object relative to the active floor. 
 

Rotate at position 

You can define the angle at 
which you rotate the object 
when inserting. This rotation 
also affects the floor plan. If 
you do not specify the rotation 
angle here, you may still do 
that when you insert the 
object. 

Interactive length 

This option allows you to 
define the length of the object 
graphically when inserting. 
 

• Specify the starting point, 
then drag the mouse 
pointer in the appropriate 
direction and define the 
endpoint of the object. 

Place on terrain 

You may place objects not only in architectural drawings and floors, but also on terrains. 
 

• After closing the dialog box, select a terrain whose height you query. 

• Insert the selected object. 
 

The program places the object on the terrain at the height of the queried point. 
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3D insert 

Choose this command if you want to insert the selected object in 3D. In this case, after closing the dialog box the 3D 
drawing area is automatically activated, where you can fit in the object. 

Fix arch. object in 3D 

If you rendered the object to an architectural object with the Modify menu - Lock object in 3D command, this option is 
automatically turned on. By turning it off, you can deactivate the command. You cannot turn on this option in the dialog 
box. 
By locking objects, you can assign 3D images to architectural objects, which are independent of their 2D drawing. This 
way you can create detailed 3D views without displaying them in the 2D drawing. 

2D not visible 

In many cases, you only need to display objects in 3D, but not in the floor plan. That is what the 2D not visible button is 
for. 
When turning on this option, the object will be indicated on the floor plan by dotted lines, which are hidden in print. 

Show 3D 

If you deactivate this command, the object will only be displayed in the floor plan, but not in the 3D model. 

Place it as column 

If you choose this option, the program will insert the object as column. This means that it will be created like those 

structural objects you insert with the  Column icon in the Beam tool. 
The difference is that with the Column icon you can create objects defined by a profile, whereas here you can insert 
objects. 
 

� See Chapter 9.2.1. Column 
 
If the Place it as column command is turned on, you may activate the Slab-roof cutting and the Column hatch options. 

Slab-roof cutting 
The command functions the same way as in the case of walls.  
Turn on the option: 

If the Wall-slab-roof cutting option is activated in the  Build 3D model dialog box, the slabs and roofs that you 
selected for cutting will cut the objects placed as column together with the wall. The result is independent of the object 
being a part of the wall or not. 

Example 
Cutting is unnecessary in the case of chimneys for example, or when the column extends to the top of the slab (where the 
slab consists of beams) and is connected to another object there, e.g. rafter. 

Column hatch 
Turn on this option to indicate the object placed as column with hatches in the floor plan. Click the button to select the 
required hatch in the dialog box displayed. 
 

� See Chapter 11.7.1 Hatch properties. 

Insert into wall 

This command automatically inserts the object into the wall by cutting out its place in the wall. Thus the program does not 
display wall hatch and wall contour ‛behind’ the column in the floor plan. If you deactivate the option, the program restores 
the original status. 

Make only hole in the wall 
The command automatically inserts the object into the wall, but removes the object from the wall in the 3D view, that is it 
only makes a hole in the wall. This option is only enabled when the Insert into wall command is turned on. 
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With this method, you can create air holes, flues, 
service ducts, or even wall niches. 
When calculating wall parameters, the program 
subtracts the thus created ‛column places’ from 
the volume of the wall. 

Example: 

 
 
To create a wall niche, place the object of the 
required shape in the wall using the Make only 
hole in the wall option. This object is then cut out 
of the wall, so any customized wall niche can be 
created. 

 
If you do not wish to display the wall niche in the floor plan, activate the 2D not visible option, too: 
 

 

 Tilted objects 

Objects can be placed on a sloped surface. It can be useful when there is a need of placing objects on sloped slab, ramp 
or terrain. 
 
Tilting properties can be set in two ways: 
 

� Numeric:  
In the object properties dialog. You have to specify the tilting in two directions:  
 

 
 
Sometimes it is hard to specify the correct tilting angles, for example in case of a spiral ramp. In this case, it is better to 
use the second way: 
 

� Graphic, by selecting a 3D plane: 

 

• Activate the 3D window. 

• Select the object from the design center, press and hold down your right mouse button, and drag the object 
to the 3D window. 

• Select the Place object by tilting on a 3D plane command from the appearing list. 
 

 
 

• Select a plane. 

• Place the object. Rotate it, if necessary. 
In the Object dialog you can check the tilting properties. 
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 Placement 

Once you have selected the appropriate object and set its properties, click OK to close the dialog box. You may place the 
objects both in the floor plan and in the 3D view: 

Placement in 2D: 

• Place the object in the drawing by its hotspot. If you want to rotate the object but have not defined the 
angle in the dialog box, you may still do it by selecting the keywords in the command line.  

Options: 

XANGLE Define the rotation angle. Enter. Place the object in the 
drawing. 

GRAPHIC Define the centre of rotation, and specify the tip of the 
angle graphically. 

NEXT The next reference point of the object will be active. 

PREVIOUS The previous reference point of the object will be active. 

DEFHOTSPOT You can select from the picture the proper reference point. 

LENGTH You can determine the length interactive. 

Placement in 3D 

If you turned on the 3D position option in the dialog box, the program will automatically activate the 3D drawing area 
where you can fit in the object. 
 

• Select a plane where you place the object. The appearing workplane signs the selected plane. 

• Insert the object, or choose from the 3D point definition options in the POPMENU. 

Option: 

SSOLID Choose this option if selection of the plane is ambiguous. 
Click on the solid whose plane you want to specify for 
placing the object. 

 

� If the 3D window was active before selecting the  Place object command, the object will automatically be placed in 

the 3D view, even if you do not activate this option. 

1.73.2. Creating objects 

In the objects directory of the program you find several objects grouped in different categories: furniture, roof structures, 
plants, etc. In many cases, you may need to create other objects, for which you have various options in the program. You 
can 
 

� create custom objects, 
� create object assemblies, or 
� Define sprites. 

 
The objects created can be saved to the objects directory of the program in the specified category. Later on, you may 
modify three main parameters (width, height, depth) and the material of these objects. 
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Object and group names with special characters 

When objects and groups are created, the following special characters can be used: 
 
Space, 
& ! @ $ % + = ( ) [ ] { } ‘ ; , ~ 
 
The following characters cannot be used: 
\   ?   |   >  <   :  /  *  “ 

 Define custom object 

Basically, this command is like the Define custom door/window command.  
In this case, you also have to create the 3D solid of the object first. After you have selected the 3D solids, the program 
automatically creates: 
 

� the 2D symbol of the door/window based on the top view of the selected object, and 
� the 3D group, to which it assigns the four bottom corner points of the bounding rectangle as reference points. 

 

• Create the 3D model of the object with the solid modeller. 

• Select the  Define custom object command: 

• Select the 3D objects, and then complete the selection with Enter. 

• In the appearing dialog box, select the 2D and 3D group created by the program. 

• Specify the name of the object. 

• OK Closes the dialog box. 
 
The program displays the name of the object and asks if you want to save it. The program saves the new object to the 
specified category in the Objects directory. 

 Define custom object from 3D model 

Before using this command, you have to create the 3D solid of the object and make other preparations. The complexity of 
designing 3D models ensures a great deal of freedom in definition. 
 
Preparatory steps: 
 

� Construct the 3D model of the object. 
� Create a 3D group of the model. 
� Create the 2D symbol of the object if you wish to use a special symbol for its 2D representation. 

 

Use of the   Define custom object from 3D model command: 
� Select the 2D and 3D group already created. 

1. Creating a 3D model 

• Using the solid modeller, create the 3D solid of the object. 

2. Creating a 2D symbol of the object 

• Draw the 2D symbol of the desired object in the appropriate size using geometric objects (line, arcs, etc.). 
The program will display this symbol every time you insert the object. 

 
Group definition: 
 

• Create the 2D group with the Tools menu - 2D group - Create command. 

• Select the objects of the 2D symbol and define the reference points. You need four points for this method 
whose sequence of definition is important. You have to define the lower left, lower right, upper right, upper 
left points in the same order. 

• Assign a name to the group in the appearing dialog box. 
 

� You find an example of 2D symbol definition in Chapter 9.3.4. Define custom door/window. 
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3. Creating a 3D group 

• Create the 3D group with the 3D menu - Group in 3D- Define object command: 

• Enter the name of the group. The name of the 3D group can be identical with the one you defined for the 2D 
group. 

• Select the solids that form the new object. 

• Specify the reference points of the 3D group in the same order as you defined the reference points of the 2D 
group (lower left, lower right, upper right, upper left).  
If the four bottom corner points of the bounding box enclosing the solid are the reference points, simply 
select the ENTER keyword. 
 
When creating a 3D group the 2D symbol is automatically created, this is the top view of the 3D model. It is not always 
identical to the symbol of the object, that’s why it was necessary to create its own symbol. 

4.  Using the Define custom object from 3D model icon 

• Select the 2D group in the dialog box that you want to use as the symbol of the object in the floor plan. You 
may choose the group you created or the one offered by the program. 

• Select the appropriate 3D group. 

• Enter the name of the object. 

• OK Closes the dialog box. 
 
The program displays the name of the object, and asks if you want to save it. The program saves the new object to the 
specified category in the Objects directory. 

1.73.3. Sprites in photorealistic view 

About sprite 

Sprites make the program suitable for adding plants, people and cars to the 3D representation without slowing down the 
representation but providing a photorealistic view. For this, we need the photo of the objects. From these photos, the 
definition of sprites can be done very quickly, so you can extend your object library. Opposed to the RPC objects, sprites 
don’t have spatial effect; they are only planes with zero thickness. They look the same from all viewpoints. In many cases, 
they can be used very well. 

 Sprite creation 

You can find the command here: Manufacture menu - New object - Sprite definition 
 

 
 
For the definition of a sprite, you have to do the following steps in the Sprite definition dialog:  

• Load a previously saved raster image by Browse button. To make the image selection easier, you have access 
to http://skalgubbar.se by clicking Link collection, from where you can download many good quality images. 
Alternatively, you can select a previously imported raster image on your drawing by Select from drawing. 
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• Select the 2D symbol of the defined sprite object by Browse button. You can select from the predefined 
group elements in the design center. By default, you can use the Human-2D symbol. 

• Modify the object height if the default value is not convenient. 

• Transparency with wireframe. With this option, you can make transparent those areas of the image that 
have the selected background colour. Background colour is defined by a mouse click on the image.  

• The program automatically cuts out the areas defined by the background colour and makes those parts 
transparent in 3D. The precision of cutout is defined by Sprite resolution. The higher resolution number you 
defined by the slider, the higher precision of the cutout you get. 

• Click Create button to save your sprite object with its name, category and producer information into the 
Design Center. 

 

 

Sprite placement 

Once you have completed sprite definition, you can place the new object in the drawing using the Building menu - Single 
object command. The rendered photo of the sprite becomes visible if you display the model in the photorealistic view. 
 

 

Sprite properties 

In the Object placement dialog box the parameters of the selected sprite appear: its width and height. 
These are static values that only provide information on the main parameters. 
If you turn off the Sprite in fixed direction option in the Constrains group, the sprite will not rotate with the other 3D solids, 
but will always face the viewer, so it cannot be seen that it has no depth. 

1.73.4. Modifying objects 

You can modify 
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� the properties and 
� the position and display of the objects created. 

Modifying properties 

You can modify the properties of the object if you 
 

� click on the object and use the Properties tool, or 
� select the PropertiesU command in the Shortcut menu, or 
� use the Copy properties command. 

 
The Insert objects dialog box appears, displaying the current values of the selected object. The selected object will acquire 
the new values according to the changes you make in this dialog box. 
 

� For a description, see Chapter 9.11.1. Object properties and placement. 

Modifying position and display 

Users have several options to modify objects. 
 

� You can use the hidden mode when inserting objects into the wall, 
� You can move objects in 3D. 

 
Let us see the detailed description of the commands: 

 Hide wall outline 

When you insert an object into the wall to handle it together with the wall, the part of the wall within the display of the 
object is hidden. If you want to make this part visible, but still have the object as part of the wall, you may use the Hide or 
Show options. Using these commands, you can hide or show the part of the wall that falls within the display of the object. 
 

• Select in the command line what you wish to do with the contour of the object: 
 

Options: 

HIDE Hides the selected part of the wall falling within the 
display of the object. 

SHOW Shows the hidden part of the wall contour. 

HIDE: 

• Select an object that will hide 
the given wall from the point of 
clicking. 

• Select the other endpoint of the 
hidden part. 

 

• Repeat the command to hide another part, or 
Enter Ends the command. 
 
In this figure you see a chimney which is not part of the wall, but hides the relevant part of the wall as the HIDE option is 
activated. 

SHOW: 

• Select an endpoint of the 
hidden part of the contour to 
make it visible. 

• Repeat the command to show 
other parts, or 

• Enter Ends the command. 

 

 
In the above figure you see a chimney inserted into the wall (the chimney is part of the wall), which overlays the wall, but 
the wall contour is displayed as the SHOW option is activated. 
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 Move object in 3D vertically 

You can set the elevation of architectural objects in the Properties dialog box of the object concerned. 
In many cases however, it is easier to set height in the 3D view by moving the inserted object to the desired elevation 
point. 
For example, it is easier to adjust the height of a projected roof to an automatic roof in the appropriate 3D view than in the 
floor plan. 
 
With this command: 
 

� You can move a window, door or roof window in the 3D view. The 2D symbol of the object will automatically be updated 
according to the modification. 

�  
� You can move roofs, slabs, and objects vertically in the 3D view, or 
� You can alter the height of the wall’s top while leaving its base line intact. 

 

� In order to make these modifications as easy as possible, use the front view. 

 

• Select a 3D object whose elevation, or, in the case of wall, the height of the wall’s top, you wish to modify. 

• To move, select a reference point on the object. 

• Define the new location of the reference point. 

• Repeat the commands to move further objects, or 

• Enter Exits the command. 

Option: 

STEP Defines the elevation step. 

POPMENU Use the 3D point definition pop menu options 
 
Graphical definition of the elevation of the projected roof: 
 

 
 
After roof projection and modification of wall elevation: 
 

  

 Copy object properties 

With this command, you can ascribe the properties of an object to another object. Using this method, there is no need to 
modify each property of each object one by one, you only have to select the appropriate object then ascribe its properties 
to the other objects. 
 
You may also activate this command: 
 

� By right-clicking the object and choosing the Copy properties option in the appearing Shortcut menu, or 

� With the Edit toolbar -  Copy properties icon. 
 

� For a description, see Chapter 8.5.2. Properties of object groups - Copy properties. 
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1.73.5. Creating profiles 

The use of profiles is manifold in ARCHLine.XP®. You can apply them in: 
 

� creating wall or slab profiles, 
� defining columns or beams by profile, 
� defining the section profile of roofs, 
� defining the section or ending of roof beams, 
� defining the profile of decoration objects, defining the balusters and the rail of balustrades, etc. 

 
In addition to profiles offered by the program, you may also create new profiles. You can save these to the specified 
category in the profiles directory and use them any time afterwards. 
 
According to their application, there are two profile types: 
 

� Closed profiles and 
� Open profiles 

 Closed profile 

Users can create and save closed profiles. When the program asks you to define a closed profile while performing a task, 
you may select the created profile in the profiles directory. 
 

• Enter the name of the new profile. 

• Create the profile using the Profile definition tool in the Toolbox. 
For example, if you have already drawn the profile, you can select it with the Point of profile command. 

• Define the reference point of the created profile. 

• The program displays the dimensions of the profile and offers to save the profile created. 

• Yes Saves the new profile to the specified category in the Profiles directory. 

� For a description of the Profile definition, see Chapter 8.9. Specifying profile.  

 Open profile 

Users may create and save open profiles. When the program asks you to define an open profile while performing a task, 
you may select the created profile in the profiles directory. 
 

• Enter the name of the new profile. 

• Define the contour of the profile using 
the Profile definition tool in the 
Toolbox.  

• For example, if you have already 
drawn the profile, you can select it 
with the Select an open chain 
command. 

• Define the reference point of the 
created profile. 

• The program displays the dimensions 
of the profile and offers to save the 
created profile. 

• Yes Saves the new profile to the 
specified category in the Profiles 
directory. 

 

 

When using the profile, for example in the case of the projected roof by free profile command: 
 

• In the appearing Profile definition tool, select the Select from list option. 
The Insert profile dialog box pops up. 
 

� For a description of the Profile definition, see Chapter 8.9. Specifying profile.  
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 Multiple profile 

Users can create and save multiple profiles. When the program asks you to define a profile while performing a task, you 
may select the created profile in the profiles directory. 
 

• Define closed profiles with the Profile definitions commands. 

• Close the definitions by pressing Enter. 

• In the Create new 2D group/object dialog enter the name of the new profile and 
select/create a profile category. 

• Click Ok to save the profile in the library.  

 

 

 

� For a description of the Profile definition, see Chapter 8.9. Specifying profile.  

1.73.6. 3D Warehouse 

3D Warehouse™ is a free Google service by which anyone can download and use 3D models for free. 3D Warehouse is a 
continuously growing database of models, which can be represented in the projects with different textures and sizes. With 
the help of 3D Warehouse models, it is easy to furnish a flat in your design project because you can download a lot of 
furniture models and place them in a room. 
ARCHLine.XP is integrated with Google 3D Warehouse™ web portal. This integration means that the selected model can 
be inserted directly into an ARCHLine.XP project and ARCHLine.XP® object library. 

How to use 

The command, which can be used in a 2D and 3D window, too, is available in the File menu - Import submenu: 
 

 
 

! Please note that you need a live internet connection to use this command! 

 

• Click on the Import - 3D Warehouse command to access the 3D Warehouse from within ARCHLine.XP. On the 
web portal you can search for models or collections. 
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• Enter the name of model you're looking for in the "search" field. 

• Click on the Search button. Thumbnail icon representations of models are displayed. 

• Click on the thumbnail image of the model that you like to view the model. 

• Click on the Download button to download the model directly into ARCHLine.XP. 

• A list of SketchUp and Google Earth KMZ versions and formats appear.  
You can select any of these formats to start the download 
 

 
 
The program converts the selected model into ARCHLine.XP® object and then asks you to place it. 
The model is stored in the object library of  ARCHLine.XP® called ”3D Warehouse” and can be used anytime. 
Textures used on the surfaces can be freely modified. 

! Please be aware that in some cases the models are published with wrong scaling factors in the 3D Warehouse 

database, for example with the ratio of 1:10 or 10:1 compared to their real dimensions. Such scaling problems can be 
solved by the 'rescaling' command that is available in the shortcut menu if you click on the object with right mouse 
button. 

What types of files can be downloaded from the 3D Warehouse? 

 
� SketchUp 2014, 2015, 2016 (*.skp) 
� SketchUp 2013(*.skp) 
� SketchUp 8 (*.skp) 
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� SketchUp 7 (*.skp) 
� SketchUp 6 (*.skp) 

 
These formats can be used with SketchUp on Windows or Mac and any application that can read version SketchUp [n] 
files. 
 

� Google Earth 4 (*.kmz) 
 
This format can be used with Google Earth 4+. A KMZ file is only available for download if the model is geo-referenced, 
that is, it has Longitude and Latitude data. 

1.73.7. Furniture by photo 

Using the Furniture by photo tool, you will be able to use parts of photos in your design as surfaces of real 3D objects. 

Create an object in 4 steps 

 
The idea of making a furniture by photo consist 4 steps. 
Load photo 
Define orthogonal surface 
Save orthogonal image as material 
Define an object with the material on its surface 
 

 
 
How to snap a surface: 

• Load the photo of the furniture 

• Set 4 corners of one orthogonal surface on the photo. Accept definition and the surface will appear as an 
orthogonal image. 
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• Repeat previous steps to snap more surfaces. 

• Save orthogonal images as materials using Save as material command in the image pop menu. 
 

 
  

• Create a new furniture using Object by photo tool. 
 

 

Preview 

Here you can see the preview of the actual settings. The preview makes it easy to control the changes you make during 
the design process. 

Size 

Set the A, B, C size for the object. Type the size into the field, and when you click into another field you will see the 
change in the preview window. 

New object name 

Type the name of the object. This name will be applied when you save the finished object into a library. 
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Materials 

You can set materials to each sides of the object here. Click on the material button and select one in the appearing 
material browser. 

Mirrored 

Use this option to flip the selected material horizontally. 

Parameters 

Click on Parameters button to expand the parameters panel. Here you can type additional data of the object you design. 

Name 

Enter the name of the object here. 

Producer 

Enter the name of the manufacturer of the object here. 

Article number 

Enter the article number here. 

Description 

Enter a description of the object. The description can be a longer multiline text 
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You can enhance the realism of the final render of one simple object when you use the Bump mapping properties of the 
materials applied on its surfaces.  
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1.74. Freeform surfaces 

 
 
This tool can be used to create architectural structures like curved roofs and curtain walls, custom vaults or tent 
structures as well as textiles for interior design: draperies, curtains or table cloths. 
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1.74.1. Working with Freeform Surfaces 

1.74.2. Layout and 3D model 

The shape of a freeform surface is based on its layout. To create a freeform surface you have to define a layout 
first. Later, to make topological changes (inserting or deleting a node, cutting out a hole, etc.) you have to edit the 
layout of the surface. By default, the layout appears as a flat surface in the 3D space. You can distort it in many 
ways: by fixing or moving nodes or edges, by adding control lines, or by letting the gravity take effect. 

 

1.74.3. Physics 

Freeform Surfaces can have two different physical models: Membrane and Textile. Membranes always tenses between 
fixed points, textiles can crease. Typically, set the physical mode to Membrane for a tent structure and Textile for a table 
cloth. 

  
Membrane Textile 

 
You can tense the cables, outline edges and control lines separately; this will affect the shape of the freeform surface. 

  
Lower outline stretch Higher outline stretch 

1.74.4. Grid patterns 

Grid patterns determine the look and physics of freeform surfaces. Four patterns are available: Square, Triangle, 
Rectangle and Monodirectional. 

  

Square Triangle 
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Rectangle Monodirectional 

For textiles with realistic crease, use the triangle pattern. Use the square or the rectangle pattern for architectural 
structures like curtain walls. You can define surfaces with straight rulings like a conoid using the monodirectional pattern. 

 
Conoid with monodirectional 
pattern 

1.74.5. Control lines 

On the layout of the surface, you can define so called control lines. Once you have control lines on the layout, you can fix 
them in the 3D space to any existing curve or simply turn them into straight or curved line.  

 
Layout with the outline and two 
control lines 

3D curves to which the outline edges 
and control lines can be fixed 

 

 

1.74.6. Cables 

You can add cables to the surface, in this way you can create models of tent structures. 

 



654 10. Building model 

Manual 

1.74.7. Representation 

You can visualize a freeform surface in many ways. In the 2D window, you can select between outline and mesh 
representation. The outlines are drawn according to the general properties (colour, line type, line width) of the object, in 
case of using the mesh representation; you can specify separate properties for the gridlines. 

  
Outline Mesh 

 
In the 3D window the freeform surface can be visualized as a mesh or a surface, in addition you can combine these 
representations. The edges of the mesh can be represented as a simple line or you can define profiles for them. 

   

Outline Mesh Surface 

  

 

Surface and Outline Surface and Mesh  

You can assign different materials to the top and bottom side of the surface. By switching off the tiling support for a 
material, you can extend a picture to the whole surface. In the object has a positive thickness, you can define side material 
(material of the edges of the surface) and solid material (material of the cross section) as well. 

 

Top material with tiling support Top material without tiling support 

1.74.8. Thickness 

By default, the mesh is represented as a thin surface. You can turn it into a solid by changing its thickness value. You can 
use positive or negative values; in case of using negative thickness value the second surface of the solid will appear under 
the first one. 

 

 Perpendicular Vertical Box extension 

Positive 
thickness    

Negative 
thickness    

 
To create the solid the program extrudes the surface by the given thickness perpendicular to itself or vertical. In addition, 
you can select “Box extension”, in this case, the solid will be bounded by the freeform surface and a horizontal plane, the 
thickness is measured from the highest or lowest point of the surface, depending on the sign of the thickness value. 
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1.74.9. Structure 

You can represent a freeform surface as an architectural structure by assigning profiles to different types of edges. 
Different profiles can be assigned to outline edges, control lines, gridlines and cables. 

 

1.74.10. Creating a Freeform Surface 

Generally, the creation of a freeform surface begins in a floor plan window by defining the layout of the surface. The Profile 
definitions tools appear in the Toolbox; you can draw the profile or select the Point of profile or Point of profile with 
islands option to use an existing contour. Once you have the layout profile, the 2D drawing and the 3D model of the 
freeform surface will be created according to the default settings. Initially the 3D model is a horizontal flat surface at the 
default level, with fixed corners 
 

  
 
In addition, you can start to create a freeform surface in the 3D window. Here you can define points one after the other, 
finally click the first point again or press ENTER. Now the layout of the surface has been generated automatically as a 
polygon based on the 3D points projected to a horizontal plane at the default level. 
 

  

� The layout is generated by projecting the points to a horizontal plane; therefore start creating the freeform surface in the 

3D window only if the structure has a horizontal character like a tent structure. If the surface to be created is not of this 
kind, like a mainly horizontal hanging textile, first create the layout in the 2D window and then fix its nodes and edges to 
the appropriate 3D positions. 

1.74.11. Modifying the 3D model 

There is no further command in the Toolbox or in the main menu related to the freeform surfaces; you can work with them 
using the Popup menu and the markers 

1.74.12. Popup menu commands 

Edit layout 

First, you have to place the symbol of the layout, use the TAB key to choose the appropriate insertion point. Once the 
layout has been placed, the Edit profile tools appear in the Toolbox and you can edit the current profile of the layout: move 
or nodes or edges, add holes, etc. You can finish by pressing ENTER key. The surface will be regenerated based on the 
new layout, the fixed edges and nodes will be kept if necessary. 

Place layout 

First, you have to place the symbol of the layout, use the TAB key to choose the appropriate insertion point. The layout of 
the surface will be drawn based on its current 2D representation settings. 

Add control lines 

First, you have to place the symbol of the layout, use the TAB key to choose the appropriate insertion point. Once the 
layout has been placed, the Profile definitions tools appear in the Toolbox and you can draw one or more control lines on 
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the layout. Control lines cannot exceed the outline. If you have been finished, the new control lines appear on the 2D 
drawing and the 3D model of the surface and you can fix them in the 3D space to any existing curve or simply turn them 
into straight or curved line by selecting the appropriate command from the marker menu. You can modify the control line 
on the layout or delete it by selecting Modify Control Line On Layout or Remove Control Line in the marker menu. 

Reposition grid 

First, you have to place the symbol of the layout, use the TAB key to choose the appropriate insertion point. Once the 
layout has been placed, you can define the direction of the grid pattern graphically by drawing the direction vector. 

Fix nodes 

You can select points on the surface. If you have been finished, press ENTER. The fixed points can be moved, elevated; 
you can attach cables to them by selecting a command from their marker menu. To delete such a fixed point, form the 
marker menu select Release node. 

Define gravity vector 

By default, the gravity vector is vertical. You can specify a different direction graphically by drawing the direction vector. 

Recompute shape 

Normally, the shape of the surface is recomputed after all relevant modification. You can clear the Automatic 
Recomputation checkbox in the Property Manager; in this case the shape of the surface is recomputed only if you select 
this command from the Popup menu. 

1.74.13. Marker menu commands 

Move Node 

Moves the current node. If it was a free node, it turns into a fixed one. 

Elevate Node 

Elevates the current node. If it was a free node, it turns into a fixed one. 

Fix Node 

Turns a free node into a fixed one. 

Fix All Nodes 

Turns all of the free nodes into fixed ones. 

Release Node 

Turns a fixed node into a free one. 

Release All Nodes 

Turns all of the fixed nodes into free ones. 

Add Cable 

Attaches a cable to the current node by placing the other endpoint of the cable. 

Change Cable Length 

You can modify the nominal length by giving a different value in the dialog box. Note that the real length may differ from 
this value depending on the current physical settings and geometry. 

Delete Cable 

Deletes the current cable. 

Delete All Cables 

Deletes all the cables. 

Fix Edge 

Turns a free outline edge or control line into a fixed one. 

Fix All Edges 

Turns all of the free outline edges and control lines into fixed ones. 

Release Edge 

Turns a fixed outline edge or control line into a free one. 
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Release All Edges 

Turns all of the fixed outline edges and control lines into free ones. 

Turn Into Straight Edge 

Turns an outline edge or control line into a straight fixed edge. 

Turn Into Curved Edge 

Turns an outline edge or control line into a curved fixed edge by placing a third point of the arc. If you use this command in 
the 3D window, the curve becomes a real circular arc. By starting this command on the floor plan, the curve becomes a 
spiral if the heights of its endpoints are different. 

Turn Into Custom Edge 

Fixes an outline edge or control line to an existing curve (like arc, ellipse or spline) or to an edge of an existing solid by 
selecting the appropriate curve or edge. 

Turn All Into Straight Edge 

Turns all the outline edges and control lines into straight fixed edges. 

Modify Control Line On Layout 

First, you have to place the symbol of the layout, use the TAB key to choose the appropriate insertion point. Once the 
layout has been placed, the Edit profile tools appear in the Toolbox and you can edit the current control line. You can 
finish by pressing ENTER key. 

Remove Control Line 

Removes the current control line from the layout. 

1.74.14. Settings 

You can change these settings by selecting a freeform surface clicking Properties from the Popup menu or by modifying 
any of the values in the Property Manager. 

 

1.74.15. General settings 
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Layer and Drawing order relates to the whole object. The general colour, line width and style are applied to the outline 
edges only, the gridlines are represented according to the Gridline properties. 

1.74.16. Representation in 2D 

 

Representation in 2D 

On the floor plan, you can represent the whole grid or the outlines only. 

Gridline Colour 

Colour of the gridlines. The outline is represented according to the general settings. 

Gridline Type 

Line type of the gridlines. The outline is represented according to the general settings. 

Gridline Width 

Width of the gridlines. The outline is represented according to the general settings. 

1.74.17. Geometry 

 

Relative height 

Elevation from the floor level. The profile of the layout will be placed on that level. By changing this value, you can elevate 
the whole structure.  

Thickness 

By setting the thickness to zero the mesh is represented as a surface, otherwise as a solid. In case of using negative 
thickness value the second surface of the solid will appear under the first one. 

Solid Extrusion Mode 

You can extrude the freeform surface by the given thickness perpendicular to itself or vertical. In the third case (Cut by 
Plane) the solid will be bounded by the freeform surface and a horizontal plane, the thickness is measured from the 
highest or lowest point of the surface. 

1.74.18. Representation in 3D 

 

Representation in 3D 

In the 3D window, you can represent the outline, the gridlines, the surface or their combinations. 

Top Material 

Material on the top of the surface. Available only if the surface is represented in 3D. 

Bottom Material 

Material on the bottom of the surface. Available only if the surface is represented in 3D. 

Side Material 

Material of the sides of the solid. Available only if the surface is represented in 3D and the thickness is not zero. 

Solid Material 

Material of cross section of the solid. Available only if the surface is represented in 3D and the thickness is not zero. 
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Smooth Edges On Control Lines 

If control lines have been added to the layout, they will be represented as a smooth or hard edge according to this setting. 

1.74.19. Grid Layout 

 

Pattern 

The shape of a grid cell: Square, Triangle, Monodirectional or Rectangle. It has an effect on the computed shape of the 
mesh as well. To have a surface creasing realistically use the Triangle pattern. Use the Monodirectional grid to have 
Conoid surfaces. 

Direction 

Direction of the main gridlines on the layout. You can also define the direction of the grid layout by selecting the Reposition 
Grid command from the Popup menu. 

Spacing 

Distance between two parallel gridlines on the layout 

1.74.20. Physics 

 

Gravity 

Strength of the gravity force. You can set zero and negative values as well. In addition, you can set a custom gravity 
direction by selecting the Define Gravity Vector command from the Popup menu. 

Physical Model 

Membrane always tenses between fixed points, Textile can crease. 

Cable Stretch 

You can tense the cables by increasing this value. Cables can be added to the surface by selecting the Add Cable 
command from the marker menu of a node. 

Outline Stretch 

You can tense the edges on the outline by increasing this value. 

Control Line Stretch 

You can tense the edges on the control lines by increasing this value. Control lines can be added to the surface by 
selecting the Add Control Lines command from the Popup menu. 

Automatic Recomputation (in the Property Manager only) 

If disabled, the shape won't follow the changes until you select the Recompute Shape command from the Popup menu or 
enable this setting again. 

Enable Gravity For Control Line Areas 

Enables the gravity for the closed areas bounded by custom control lines. 

1.74.21. Structure 

 

Profile of Outline 

Profile of the edges on the outline. Available only if the outline is represented in 3D. If the profile is disabled, outlines are 
represented as simple lines and will not appear on rendered images. 
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Material of Outline 

Surface material of the profile of the edges on the outline. 

Profile of Control Lines 

Profile of the edges on control lines. Available only if the outline is represented in 3D. If the profile is disabled, control lines 
are represented as simple lines and will not appear on rendered images. 

Material of Control Lines 

Surface material of the profile of the edges on control lines. 

Profile of Gridlines 

Profile of the edges on gridlines. Available only if the mesh is represented in 3D. If the profile is disabled, gridlines are 
represented as simple lines and will not appear on rendered images. 

Material of Gridlines 

Surface material of the profile of the edges on gridlines. 

Profile of Cables 

Profile of the edges on cables. If the profile is disabled, cables are represented as simple lines and will not appear on 
rendered images. 

Material of Cables 

Surface material of the profile of the edges on cables. 

Use Low Resolution Profiles 

Use Low Resolution Profiles for cables, gridlines, outline edges and control lines. If disabled, the default resolution will be 
used while generating the 3D model. 
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1.75. Indoor Tools 

ARCHLine.XP® gathers all indoor tools in one single module.  
 

 
 
Indoor module contains the following tools: 
Pre-defined rooms 
Room Maker 
Mood board 
Picture on wall 
Soft furnishing 
Sanitary Ware 
Electrical Accessory 
Moulding 
Moulding by room 

1.75.1. Pre-defined room  

The Pre-defined room tool helps to choose among pre-defined room shapes with exact measurements. It makes easier to 
place a room on the drawing simply by giving the side lengths numerically. 

 
 
You can select one of the following room shapes: 

� Rectangle room 
� Bay window room 
� Diagonal room 
� T-shaped room 
� L-shaped room 

How to use the Pre-defined room tool? 

� Choose the appropriate shape and type the side length values. 
� Set the room orientation (0, 90, 180, 270 degree). 
� Change the wall Thickness and Wall height if you want. 
� Press Redraw to see the changes on the 2D and 3D previews. 
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� Press the Done button. 
� When the dialog is closed place the room shape on your drawing with the mouse. 

 
The Pre-defined room dialog has a few controls that you can use to customize a selected room shape. 

Pre-defined Room shapes 

The room shapes list contains the list of room shapes that you can create with the tool.  
The tiny thumbnails also contain letters to help you to understand the values that can be changed in the Room sizes list. 

Rotation 

You can rotate the chosen room shape by setting up the rotation. 

Redraw button 

Most of the changes in the dialog won’t be reflected on the preview contents automatically. Please press Redraw any time 
you want to see the changes you made in the dialog. 

Thickness 

The wall thickness can be defined for all walls of the current room. 

Wall height 

The wall height can be defined for all walls of the current room. 

Room sizes 

The Room sizes list shows a list of lengths that can be changed in the current room. Each length has a letter that helps to 
understand their relation to the sides of the room. Check the selected thumbnail to locate the value that you would like to 
change. 

3D preview 

The 3D preview is an active 3D content. It shows the current model of the room based on the changes you make. If you 
cannot see the changes, please press the Redraw button to update the model. 
 
You can also rotate the 3D preview content to check the model from any directions. To rotate the 3D preview content just 
click and drag the 3D model and move your mouse. When finished release the mouse button. 

2D preview 

The 2D preview shows the current 2D representation of the selected room. Use the Redraw button to update the preview if 
necessary. 

1.75.2. Room Maker 

Room Maker is an all-in-one design tool that highly speeds up the interior design starting from an empty room.   
Starting from walls that form the room, Room Maker allows you to create your room details as you want it - every step of 
the way. Place doors and windows then add your choice of objects and decorate the room to your satisfaction 
 
You can use Room Maker to detail an existing room whether it was created by using the Pre-designed Room Shapes tool 
or you designed a free-style room on your own. 
 
When you start the Room Maker, the software will ask you to click into a closed room. When you do so, the software will 
open the Room Maker dialog. 
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The Room Maker dialog window is built up of 3 main parts. These are the 3D view content, the controllers and the 
properties.  

How to use the Room Maker? 

Room Maker provides many opportunities to work inside the room. It is designed to be self-explanatory and easy to learn. 
However, you might find the following method useful. 
 

� Start the Room Maker tool. 
� Click into a closed room shape on your drawing. 
� Select a Tool from the toolbar. 
� Prepare an object – set the type, material and settings of it. 
� Create the object by pressing the Insert new button. 

 
You can add as many details and new objects using the Room Maker as you wish. Click Close to close Room Maker. 
You can start Room Maker at any time later to continue editing the room again. 

The Room Maker Interface 

 
 
The interface of ARCHLine.XP Room Maker is built up of the following main parts and controllers. 
 
1. Wall finder 
2. Toolbar 
3. Type finder 
4. Texture finder 
5. Favorites 
6. Other types 
7. Properties 
8. Add new object 
9. Zooming 
10. Undo / redo 
11. Floor plan 
12. 3D view 
 

 Main controllers 

Wall finder 

The room will turn to the left or right wall and display it in frontal view. You can work on this wall or some cases on floor or 
ceiling. 

 

Toolbar 

The toolbar is the container of Room Maker’s interior design tools. One of them is always active and Room Maker works 
with the selected one. 

 
For example when you would like to add or edit a door, simply just click on the Door object button. 
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Type finder 

It enables to see the last used types in the Favourites box. 

 
The type finder shows different icons based on the actual context. For example when you are working with doors, the type 
finder will button will show a door icon. 

Texture finder 

It enables to see the last used textures in the Favourites box. 

 
There are some cases when you can modify multiple materials of an object. In that case, you will see multiple Texture 
finder buttons. 

Favourites 

You see here the last used types or textures. The following example shows the door favourites list. 

 

Other types   

Here you can choose from the library of types or textures. 

 

Properties  

These values are used when you insert a new object or modify it. The following example shows the door properties dialog 
with the Insert new button. 

 

Insert new  

You can insert a new object with a click on the Green Tick. 

 

Zoom   

Zoom in or zoom out the 3D view. In order to centre the view of the selected object enable the Close-up checkbox. 
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Undo / redo   

The Undo button deletes the last change done by reverting it to the older state. The Redo button reverts the effects of the 
undo. You can undo and redo up to 16 actions. 

 

Floor plan   

The floor plan that focuses on the selected object (highlighted) 

3D view   

The 3D view is the three-dimensional view facing to the selected wall / floor. 

 Additional controllers 

Prepare new 

The “Prepare new” button appears in cases when an object of the current type already exists on the wall and there is the 
possibility to add more. This button appears on the left side of a panel. 

 

Remove actual 

The “Remove actual” button appears in cases when an object of the current type already exists on the wall and there is 
the possibility to remove it. This button appears on the left side of a panel. 

 

Object index 

The object index list appears at the left side of an object panel on top of the Prepare new / Remove actual buttons. It 
consists of two numbers separated by a “/” mark. The first number is the sequence number of the current object. The 
second number is the total amount of the available objects on the current wall. 

Edit 

In cases when you have the possibility to edit the current object in the Favourites list you can use the Edit button to do so. 

 Door Panel 

The Door panel allows you to place or modify a door in the room. Click on the Door panel button to see the properties. 

 
 

Door properties 

Width 
You can type the width of the selected door. You can also use the small arrow to select from template sizes. 

Height 
You can type the height of the selected door. You can also use the small arrow to select from template sizes. 

Sill height 
You can type the sill height of the selected door. You can also use the small arrow to select from template sizes. 

Distance from left or right 
Use the Distance from left or the Distance from right option to set the door position in a wall measured from the closest left 
or right wall corner. When you change a value, the corresponding other will be updated. 

Manual move buttons 
Use the manual move buttons to move the door in the wall by little steps to the left or to the right. 

Orientation 
The Orientation options help you to set the orientation of the opening on the 2D and in the 3D content. 
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How to add a door? 

• Select a wall with Wall finder.  

• Select a door from the favourites and change properties.  

• Click on the Texture finder button and select a material.  

• Click on Green tick – it will place the door in the wall centre point 

How to add more doors to one wall? 

• Press the Green Plus first to prepare the next door on the same wall. 

• Select a door from the favourites and change properties.  

• Click on the Texture finder button and select a material.  

• Click on Green tick – it will place the door in the wall.  

How to modify an existing door? 

• Navigate to the wall which contains the door that you would like to modify 

• Click on the door in the 3D content window. 

• Change its properties. 

• Click on the Update button to refresh changes. 
 

 Window Panel 

The Window Panel allows you to add windows into walls. 

 

Window properties 

Width 
You can type the width of the selected window. You can also use the small arrow to select from template sizes. 

Height 
You can type the height of the selected window. You can also use the small arrow to select from template sizes. 

Sill height 
You can type the sill height of the selected window. You can also use the small arrow to select from template sizes. 

Distance from left or right 
Use the Distance from left or the Distance from right option to set the window position in a wall measured from the closest 
left or right wall corner. When you change a value, the corresponding other will be updated. 

Manual move buttons 
Use the manual move buttons to move the window in the wall by little steps to the left or to the right.  

How to add a window? 

� Select a wall with Wall finder.  
� Select a window from the favourites and change properties.  
� Click on the Texture finder button and select a material.  
� Click on Green tick – it will place the window in the wall centre point 

How to add more windows to one wall? 

� Press the Green Plus first to prepare the next window on the same wall. 
� Select a window from the favourites and change properties.  
� Click on the Texture finder button and select a material.  
� Click on Green tick – it will place the window in the wall.  

How to modify an existing window? 

� Navigate to the wall that contains the window that you would like to modify. 
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� Click on the window in the 3D content window. 
� Change its properties. 
� Click on the Update button to refresh changes. 

 

 Soft Furnishing Panel 

The Soft Furnishing Panel contains a set of different soft furnishing objects and their customizable settings. 
 

 

Soft Furnishing Properties 

Pleats 
When using curtains you can set the waves of the surface to be smooth or wavy. Use the slider to set the desired shape.  

Retraction in the middle 
Retraction in the middle opens or closes a curtain. Use the slider to open or close the curtain. 

Pelmet 
The Pelmet option allows you to turn on or off a pelmet for the current sun shade or curtain. 

Top height 
Top height allows you to change the top height of some of the soft furnishing objects. 

Bottom height 
Bottom height can be changed for selected types of soft furnishing objects. 

Number of splitters 
In case of using special objects such as Venetian or roman blinds, you can set the number of their splitters. 

Strip rotation 
When using sun shades with horizontal or vertical strips you can change the rotation of them. 

Retraction 
In cases when you can change the Retraction option, you can actually open or close the object. 

Details:  
You are able to set further properties of the curtains, for example 

- Position and Sizes 

- Curtain 

- Pelmet 

- General settings 

- Save 
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How to add a curtain? 

� Select a wall with Wall finder. 
� Click on the window that you wish to add the curtain to. 
� Select a curtain from the soft furnishing list and change properties.  
� Click on the Texture finder button and select a material.  
� Click on Green tick – it will place the curtain in front of the window. 

How to modify an existing curtain? 

� Navigate to the wall that contains the curtain that you would like to modify. 
� Click on the curtain in the 3D content window. 
� Change its properties. 
� Click on the Update button to refresh changes. 

 Electric Accessories Panel 

The Electric Accessories Panel allows you to add switches and sockets to a wall surface. 
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Electric Accessory Properties 

Elevation from floor 
You can set the distance between the floor level and the middle point of the selected electrical accessory. 

Distance from left 
You can set the distance of the object from the left side corner of the current wall. 

Distance from right 
You can set the distance of the object from the right side corner of the current wall. 

Grouping 
Electric accessories can be grouped. You can group a selected number of electric accessory by changing the Grouping 
value. Horizontal and vertical grouping options are available. 

Manual move buttons 
You can manually move the current object on the wall surface by using the Manual move buttons. 

How to add an electric accessory? 

� Select a wall with Wall finder. 
� Browse for the required electric accessory and set the properties.  

� To modify the frame or inner materials, click frame ( ) or inner material ( ) tab and then click on the 
Texture finder buttons and select the required materials. This material setting possibility is not available for 
electric accessories that have only one material.   

� Click on Green tick – it will place the object. 

How to add more electric accessory to one wall? 

� Press the Green Plus first to prepare the next electric accessory on the same wall. 
� Browse for the required electric accessory and set the properties.  
� Click on Green tick – it will place the electric accessory on the wall. 

How to modify an existing electric accessory? 

� Navigate to the wall that contains the object that you would like to modify. 
� Click on the electric accessory in the 3D content window. 
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� Change its properties. 
� Click on the Update button to refresh changes. 

 Profiles Panel 

Using the settings of the Profiles Panel, you can add decoration profiles, cornices and plinths to a room contour. 

 

Profile Properties 

Profile mode 
You can change the profile mode to the following options: 

� Cornice 
� Décor 
� Skirting board 

Width 
You can change the width of the selected profile cross section. 

Height 
You can change the height of the selected profile cross section. 

Elevation from floor 
You can set the distance between the floor level and the bottom of the selected profile. 

How to add a cornice, a décor or a skirting board? 

� Select the cornice, décor or skirting board option on the profile properties panel. 
� Select a profile from the favourites list and change properties.  
� Click on the Texture finder buttons and select materials.  
� Click on Green tick – it will place the object according to the settings. 

How modify a cornice, a décor or a skirting board? 

� Select the cornice, décor or skirting board option on the profile properties panel. 
� Change properties and texture.  
� Click on the Update button to refresh changes. 

 Ceiling Lamps Panel 

The Ceiling Lamps Panel allows you to add lamps to the ceiling surface. If the page is unavailable, that means there is no 
ceiling that can be used. 

 
 

X position 
X position of the ceiling lamp can be changed. Zero means the origin (the middle) of the ceiling surface on top of the room 
shape. You can use positive and negative values. 

Y position 
Y position of the ceiling lamp can be changed. Zero means the origin (the middle) of the ceiling surface on top of the room 
shape. You can use positive and negative values. 

Elevation from floor 
You can set the distance between the floor level and the bottom of the selected lamp. 
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Manual move buttons 
You can manually move the current object on the ceiling surface by using the Manual move buttons. 

 Wall Lamps Panel 

The Wall Lamps Panel allows you to add lamps on wall surfaces. 

 

Wall Lamp Properties 

Distance from left 
You can set the distance of the object from the left side corner of the current wall. 

Distance from right 
You can set the distance of the object from the right side corner of the current wall. 

Elevation from floor 
You can set the distance between the floor level and the bottom of the selected lamp. 

Manual move buttons 
You can manually move the current object on the wall surface by using the Manual move buttons. 

Distance from wall line 
You can set the distance between the wall surface and the back surface of the lamp. 

How to add a lamp to a wall? 

• Select a wall with Wall finder. 

• Select a lamp from the favourites list and change properties.  

• Click on the Texture finder buttons and select materials.  

• Click on Green tick – it will place the object on the wall. 

How to add more lamps to one wall? 

• Press the Green Plus first to prepare the next lamp on the same wall. 

• Select a lamp from the favourites and change properties.  

• Click on the Texture finder buttons and select materials.  

• Click on Green tick – it will place the lamp on the wall. 

How to modify an existing lamp? 

• Navigate to the wall that contains the object that you would like to modify. 

• Click on the object in the 3D content window. 

• Change its properties. 

• Click on the Update button to refresh changes. 

 Wall Pictures Panel 

The Wall Pictures Panel allows you to add pictures on wall surfaces. 

 
 

Wall Picture Properties 

Frame option 
You can enable or disable the picture framing to be displayed. 
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Matting option 
You can enable or disable the picture matting to be displayed. 

Matting width 
If you enabled Matting, you can change the width of it. 

Elevation from floor 
You can set the distance between the floor level and the bottom of the selected picture. 

Width 
You can set the width of the current picture. 

Height 
You can set the height of the current picture. 

Keep aspect ratio 
When the Keep aspect ratio button is ON that means the changes either on the width or the height will reflect on the other 
value as the software will recalculate the other keeping the aspect ratio between the two. 
 
If the Keep aspect ratio button is OFF the two values can be changed individually and it will have no effect on each other. 

Manual move buttons 
You can manually move the current object on the wall surface by using the Manual move buttons. 

Distance from left 
You can set the distance of the object from the left side corner of the current wall. 

Distance from right 
You can set the distance of the object from the right side corner of the current wall. 

Distance from wall line 
You can set the distance between the wall surface and the back surface of the selected picture. 

How to add a picture to a wall? 

� Select a wall with Wall finder. 
� Select a picture from the favourites list and change properties.  
� Click on the Texture finder buttons and select materials.  
� Click on Green tick – it will place the object on the wall. 

How to add more pictures to one wall? 

� Press the Green Plus first to prepare the next picture on the same wall. 
� Select a picture from the favourites and change properties.  
� Click on the Texture finder buttons and select materials.  
� Click on Green tick – it will place the picture on the wall. 

How to modify an existing picture? 

� Navigate to the wall that contains the object that you would like to modify. 
� Click on the object in the 3D content window. 
� Change its properties. 
� Click on the Update button to refresh changes. 

 Floor Material Panel 

Using the Floor Material Panel, you can change the material on the current floor surface. 
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Floor Material Properties 

Browse another 
If you click on the Browse another button the software will open the Material page of the Design Center where you can 
search for any of the existing materials on your computer. When you select one, it will be added to the favourites list. 

Edit current 
The current selected material can be edited by using this button. 

Go to web 
The Go to web button will open the default web browser and automatically navigate to the Useful links page of the Official 
ARCHLine.XP website. This is a page where you can find links to web pages that contain textures and images can be 
used for materials in ARCHLine.XP. 
 
However, the button opens a website, please note that any other webpages can be used to download images for 
materials, not just the ones that can be found on the appearing page. 

Create new 
You can create a new material based on images or colours. The material will be automatically added to the favourites list 
when finished. 

Angle 
If the material is made out of a texture, you can set its rotation by changing the Angle. 

How to modify the floor material? 

� Navigate to the floor – Choose the floor Material Panel. 
� Choose the desired pattern from the favourites list. 

 Ceiling Material Panel 

Using the Ceiling Material Panel, you can change the material on the current ceiling surface. 

 
 

Ceiling Material Properties 

Browse another 
If you click on the Browse another button the software will open the Material page of the Design Center where you can 
search for any of the existing materials on your computer. When you select one, it will be added to the favourites list. 

Edit current 
The current selected material can be edited by using this button. 

Go to web 
The Go to web button will open the default web browser and automatically navigate to the Useful links page of the Official 
ARCHLine.XP website. This is a page where you can find links to web pages that contain textures and images can be 
used for materials in ARCHLine.XP. 
 
However, the button opens a website, please not that any other web pages can be used to download images for materials 
or just the ones that can be found on the appearing page. 

Create new 
You can create a new material based on images or colours. The material will be automatically added to the favourites list 
when finished. 

Angle 
If the material is made out of a texture, you can set its rotation by changing the Angle. 

How to modify the ceiling material? 

� Navigate to the ceiling – Choose the ceiling Material Panel. 
� Choose the desired pattern from the favourites list. 
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 Wall Material Panel 

Using the Wall Material Panel, you can change the material on the current wall surface 
. 

 

Wall Material Properties 

Browse another 
If you click on the Browse another button, the software will open the Material page of the Design Center where you can 
search for any of the existing materials on your computer. When you select one, it will be added to the favourites list. 

Edit current 
The current selected material can be edited by using this button. 

Go to web 
The Go to web button will open the default web browser and automatically navigate to the Useful links page of the Official 
ARCHLine.XP website. This is a page where you can find links to web pages that contain textures and images can be 
used for materials in ARCHLine.XP. 
 
Although the button opens a website, please not that any other web pages can be used to download images for materials 
or just the ones that can be found on the appearing page. 

Create new 
You can create a new material based on images or colours. The material will be automatically added to the favourites list 
when finished. 

All walls option 
All walls option allows you to handle all the walls of a room in one step when defining the material on their surfaces. When 
this option is on you can handle all walls together. When this option is off you can handle the current wall only. 

How to modify the wall material? 

� Select a wall with Wall finder. 
� Choose the desired pattern from the favourites list. 

 Wall Tiling Panel 

The Wall Tiling Panel allows you to add realistic 3D tiles on wall surfaces that can be also listed later on. 

 
 

Wall Tiling Properties 

Tile width 
You can set the width of a tile. 

Tile height 
You can set the height of a tile. 

Grout thickness 
You can set the thickness of the grout. 

Offset from left 
You can set the offset of the distribution starting point from the left side of the area. 

Offset from bottom 
You can set the offset of the distribution starting point from the left bottom of the area. 
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All walls  
All walls option allows you to handle all the walls of a room in one step when defining the tiling on their surfaces. When 
this option is on you can handle all walls together. When this option is off you can handle the current wall only. 

Angle 
You can change the angle of the tiling distribution. The default value is Zero when a regular horizontal/vertical distribution 
is applied. 

Alignment grid 
The alignment grid represents the starting point of the distribution on the current surface. Each option means an origin that 
can be used as the starting point on the current surface. 

Row shift  
Select from the following three options:  
  

 
There is no shifting between rows; the tiles are matched to each other by their corners precisely. 
 

 
If the button is switched on you can define the value of horizontal row shift. Every second row will be shifted with this value 
from the first one. 
 

 
If this option is selected, you can define horizontal and vertical shift values in the Row shift / Column shift fields 

Row shift value 
You can set the value of the row shift if one shift option was selected. 

Tile thickness  
The tile thickness information shows the tile thickness that will be used when creating the 3D tiling. 

 Floor Tiling Panel 

The Floor Tiling Panel allows you to add realistic 3D tiles on wall surfaces that can be also listed later on. 

 
 

Floor Tiling Properties 

Tile width 
You can set the width of a tile. 

Tile height 
You can set the height of a tile. 

Grout thickness 
You can set the thickness of the grout. 

Offset from left 
You can set the offset of the distribution starting point from the left side of the area.  

Offset from bottom 
You can set the offset of the distribution starting point from the left bottom of the area. 

All walls option 
All walls option allows you to handle all the walls of a room in one step when defining the tiling on their surfaces. When 
this option is on you can handle all walls together. When this option is off you can handle the current wall only. 

Angle 
You can change the angle of the tiling distribution. The default value is Zero when a regular horizontal/vertical distribution 
is applied. 

Alignment grid 
The alignment grid represents the starting point of the distribution on the current surface. Each option means an origin that 
can be used as the starting point on the current surface. 
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Row shift  
Select from the following three options:  
  

 
There is no shifting between rows; the tiles are matched to each other by their corners precisely. 
 

 
If the button is switched on, you can define the value of horizontal row shift. Every second row will be shifted with this 
value from the first one. 
 

 
If this option is selected, you can define horizontal and vertical shift values in the Row shift / Column shift fields 

Row shift value 
You can set the value of the row shift if one shift option was selected. 

Tile thickness  
The tile thickness information shows the tile thickness that will be used when creating the 3D tiling. 

 

 Kitchen Cabinets Panel 

You can create and edit an aligned series of kitchen cabinets in the Kitchen Cabinets Panel. Objects can be added to a 
wall surface and their position can be defined in relation to neighbouring walls or other objects. 

 
 

Kitchen Cabinet Properties 

Distance from left 
You can set the distance of the object from the left side corner of the current wall. 

Distance from right 
You can set the distance of the object from the right side corner of the current wall. 

Elevation from floor 
You can set the distance between the floor level and the bottom of the selected object. 

Manual move buttons 
You can manually move the current object on the wall surface by using the Manual move buttons. 

Distance from wall line 
You can set the distance between the wall surface and the back surface of the selected object. 

Dimensions 
You can see the dimensions of the selected object in the Dimensions information area. 

How to add a kitchen cabinet to a wall? 

� Select a wall with Wall finder. 
� Select a cabinet from the favourites list and change properties.  
� Click on Green tick – it will place the object on the wall. 

How to add more cabinets to one wall? 

� Press the Green Plus first to prepare the next cabinet on the same wall. 
� Select a cabinet from the favourites and change properties.  
� Set its relation and distance to the existing cabinet object.  
� Click on Green tick – it will place the cabinet on the wall. 

How to modify an existing cabinet? 

� Navigate to the wall that contains the object that you would like to modify. 
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� Click on the object in the 3D content window. 
� Change its properties. 
� Click on the Update button to refresh changes. 

 Sanitary Ware Panel 

The Sanitary Ware Panel contains sanitary ware objects that can be aligned to a wall surface. 

 

Sanitary Ware Properties 

Distance from left 
You can set the distance of the object from the left side corner of the current wall. 

Distance from right 
You can set the distance of the object from the right side corner of the current wall. 

Elevation from floor 
You can set the distance between the floor level and the bottom of the selected sanitary object. 

Manual move buttons 
You can manually move the current object on the wall surface by using the Manual move buttons. 

Distance from wall line 
You can set the distance between the wall surface and the back surface of the selected object. 

Dimensions 
You can see the dimensions of the selected object in the Dimensions information area. 

How to add a sanitary ware to a wall? 

• Select a wall with Wall finder. 

• Select a sanitary ware from the favourites list and change properties.  

• Click on Green tick – it will place the object on the wall. 

How to add more sanitary ware objects to one wall? 

• Press the Green Plus first to prepare the next sanitary ware on the same wall. 

• Select a sanitary ware from the favourites and change properties.  

• Set its relation and distance to the existing sanitary ware object.  

• Click on Green tick – it will place the sanitary ware on the wall. 

How to modify an existing cabinet? 

• Navigate to the wall that contains the object that you would like to modify. 

• Click on the object in the 3D content window. 

• Change its properties. 

• Click on the Update button to refresh changes. 

 Furniture 

The Objects Panel allows you to align 3D objects to wall surfaces. 
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Object Properties 

Distance from left 
You can set the distance of the object from the left side corner of the current wall. 

Distance from right 
You can set the distance of the object from the right side corner of the current wall. 

Elevation from floor 
You can set the distance between the floor level and the bottom of the selected sanitary object. 

Manual move buttons 
You can manually move the current object on the wall surface by using the Manual move buttons. 

Distance from wall line 
You can set the distance between the wall surface and the back surface of the selected object. 

Dimensions 
You can see the dimensions of the selected object in the Dimensions information area. 

How to add an object to a wall? 

• Select a wall with Wall finder. 

• Select an object from the favourites list and change properties.  

• Click on Green tick – it will place the object on the wall. 

How to add more objects to one wall? 

• Press the Green Plus first to prepare the next object on the same wall. 

• Select an object from the favourites and change properties.  

• Set its relation and distance to the existing object.  

• Click on Green tick – it will place the object on the wall. 

How to modify an existing cabinet? 

• Navigate to the wall that contains the object that you would like to modify. 

• Click on the object in the 3D content window. 

• Change its properties. 

• Click on the Update button to refresh changes. 

1.75.3. Mood board 

With this command, you are able to illustrate the atmosphere of the 
project and its visual direction. You can use hand sketches, photos and 
materials.  
The Mood Board command is in the Toolbox under the Building / Indoor 
Tools menu or in the Menu Bar – Building menu – Indoor Tools. 
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 Creating mood board 

First of all set the paper size what you would like to use for the mood board. Then click OK and a new window will appear 
where you can create your mood board.  
For further functions, open Menu Bar Building menu – Indoor Tools – Mood Board. These are: 

• Raster Image:  

You can select pictures from your computer with the help of this command. 

• Substitute material: 

This command replaces the material in the mood board with another selected 
one. 

• Scale image: 

We can change the size of the placed image. 

• Crop image: 

If there is a part of the picture what you do not need, you can cut it. 

• Flip horizontally / vertically: 

We can flip the placed image on the board. 

• Drop shadow: 

Shadow can be used for the placed pictures. 

• Draw order: 

You can specify which images and materials are in the front or in the back of the mood board and their position to one 
another. 

• Copy bitmap to clipboard: 

The program copies the drawing of the active window as an image file to the clipboard of Windows. 

• Publish: 

You can make a snapshot about the mood board and upload it to the web. 

The above-mentioned commands (scale image, crop image, flip horizontally or vertically) are accessible via the local 
menu of the images. 

1.75.4. Picture on wall 

Introduction 

With the Picture on wall function of ARCHLine.XP® it is easy to put pictures on different surfaces of interior spaces. 

 
The Picture on wall is a dynamic object that can be configured with its parameters in a few steps. The Picture on wall is 
always based on an image that is supplemented with matting as rag mats, or collage mats and frame. Once the image is 
framed and displayed matting helps separate the photograph from its surroundings. It gives it its own unique space and 
presence.  

 
The command is available in the Building menu – Indoor tools – Picture on wall. 
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 Properties 

In the Picture on wall property settings dialog, you can specify the how the object should look on the floor-plan and in 3D 
views. For this, you have to click on Building menu – Indoor tools – Picture on wall or Toolbox – Building – Indoor tools – 
Picture on wall icon 

 
A Picture on wall consists of three parts, as it is shown on the figure below (with the main properties): 

 

 
 

The total width and height depend on the dimensions of the above-mentioned parts. 
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Visualization 

In this property group, you can set the line representation. The following properties can be set: 
Colour, Layer, Line width, Line type, Draw order 

Properties of placement 

Elevation from floor 
The height of the bottom left point of the picture object relative to the zero level of the active floor. 

Image parameters 

Material 
You can select a material from the material manager dialog. This material will be the image. The program recognizes the 
width and height parameters of the selected material texture automatically, and their values appear in the Width and 
Height input fields. 

Maintain aspect ratio 
With this option the original width/height ratio of the image can be kept. 

Width 
You can modify the width of the image. This width parameter belongs to the image and not to the whole picture object. 

Height 
You can modify the height of the image. This height parameter belongs to the image and not to the whole picture object. 

Frame depth 
You can modify the depth of the frame. 

Frame parameters 

You can specify the profile of the frame around the picture along with its material. 

Enabled 
With this option, you can switch on the frame. 

Matting parameters 

You can specify the properties of the stripe between the picture frame and the border of the image. 
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Enabled 
With this option, you can switch on the matting. 

Width 
The value specified here is the width of the stripe between the picture frame and the border of the image. 

Colour 
The matting is represented with this colour. 

Glass 

You can specify the properties of the glass in front of the picture. 

Enabled 
With this option, you can switch on the glass. 

Material 
You can select a material from the material manager dialog. 

 Placing picture on wall 

In 2D 

Select Building menu – Indoor tools – Picture on wall or the Toolbox – Building – Indoor tools – Picture on wall command. 
Set the appropriate properties and then press Ok. 
Place the picture object on the floor plan.  

 

� Use the Graphic keyword if you want to rotate the object during the placement. 

In 3D 

Select Interior menu – Object  – Picture on wall or the Interior - Object – Picture on wall command. 
Set the appropriate properties and then press Ok. 
Move your mouse to the appropriate surface and then select it. 
Move the picture object to the appropriate position and then placed it. 

1.75.5. Soft furnishing – Window decoration and blinds 

Four types of indoor blinds are available: curtain, roman blind, venetian blind and vertical blind. 

 

       

 Creating indoor blinds 

You can create an indoor blind by selecting an 
opening (door or window) to place the blind in it 
or by drawing it directly on the floor plan. 
 
Menu :   
Interior > Indoor Tools > Soft Furnishing 
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To create a blind in an existing opening click 

on the appropriate side of a door or 

window. 

 

To draw the blind on the floor plan draw 

the bounding rectangle of the blind. You 

can mirror the rectangle to the blue line by 

pressing the F5 key. 

 
Once the indoor blind is placed a dialog appears and you can set the appropriate values. Finally, the blind appears on the 
floor plan and in the 3D window. 

 Editing blinds 

Once the object is selected, you can edit it by 
means of the markers: by using the node 
markers you can change its length or move 
an endpoint. By using the Offset command of 
the line marker, you can move the object 
perpendicular to itself. In the 3D window, you 
can adjust the top and bottom height of the 
blind, too. 

 

 

 Converting blinds 

Each indoor blind can be converted to another by clicking on it with right 
mouse button and selecting Convert toq command. You can convert an 
indoor blind to a general freeform surface, too. Once you have the freeform 
surface, it is possible to move each individual node of the model, fix edges to 
the appropriate position, etc. 

 

 

 Indoor blind types 

Each blind type has its own setting dialog. Once you have placed the blind on the floor plan, the dialog appears and the 
blind will be created based on the values set in it. 
To modify an indoor blind right click on an object and select Properties. 
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 Position and sizes 

 
This page is available for all blind types. 

Top height 

The height of the top of the blind from the story level. 

Bottom height 

The height of the bottom of the blind from the story level. 

Height 

The height of the blind. 

Width 

The width of the blind. 

Material 

The material of the blind. Pelmets and curtain rods have their own material settings. 
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 Curtain  

 

This page is available only for curtains. 

Thickness 

The width of the bounding rectangle of the curtain. If the blind is mirrored to its reference line, this value can be negative. 

Split Curtain 

If enabled, curtain is split into two parts. 

 
Split curtain enabled 

 
Split curtain disabled 

Gap between sides 

You can define the distance between the two parts of a split curtain. 

Pleats 

By means of this slider, you can adjust the wave-form of the curtain. The lowest value results in a straight line. 

  
Pleats: 0% 

  
Pleats: 50% 

 
 Pleats: 100% 

Retraction in the middle 

By setting this slider to the lowest value you can define a straight curtain without retraction, otherwise the middle of the 
curtain will be retracted towards the second point of the bounding rectangle. 
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Retraction in the 

middle: 0% 

  
Retraction in the 

middle: 50% 

  
Retraction in the 

middle: 100% 

Retraction distance from top 

If the “Retraction in the middle” value is positive, here you can set the vertical position of the retraction. By setting it to 0% 
or 100%, the upper or lower edge will be retracted instead of the middle of the curtain. 

 
 Retraction 

distance from 

top: 0% 

  
Retraction 

distance from 

top: 50% 

  
Retraction 

distance from 

top: 100% 

Randomness level 

 You can choose between regular and random waveforms. 

  
Randomness level: 0% 

  
Randomness level: 100% 

Detail level 

 The resolution of the freeform surface. 

  
Detail level: 1 

 
Detail level: 5 

Gravity 

The textile can “fall down” realistically by increasing the gravity value. 

 
Gravity: 0 

 
Gravity: 2 

 
Gravity: 4 
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 Roman blind properties  

 
This page is available only for roman blinds. 

Number of splitters 

The number of horizontal divisions can be set here. 

Retraction  

The lowest value means a fully shut roman blind, and the top value means a fully open roman blind. 

Detail level 

You can set the detail level of the surface of the generated roman blind. Higher value makes the final result more realistic 
while lower will make it rough. 
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 Venetian blind 

 
This page is available only for venetian blinds. 

Strip width 

The width of a strip. 

Strip spacing 

The distance between strips. 

Strip rotation 

The rotation of the strips. The 50% value results in horizontal strips. The maximum rotation angle is 80° in both directions 

Retraction  

The lowest value means a fully shut blind, and the top value means a fully open one. 
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 Vertical blind 

 
This page is available only for vertical blinds. 

Split curtain 

If enabled, curtain is split into two parts. 

 
Split curtain enabled 

 
Split curtain disabled 

Strip width 

The width of a strip. 

Strip spacing 

The distance between strips. 

Strip rotation 

The rotation of the strips. The 50% value effects strips perpendicular to the plane of the opening. The maximum rotation 
angle is 80° in both directions. 

Retraction  

The lowest value means a fully shut blind, and the top value means a fully open one. 
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 Pelmet properties  

 
This page is available only for curtains and vertical blinds. 
 
You can use an extruded profile or an object as pelmet. 

 

Profile pelmet 

 

The pelmet profile will be extruded along the top center line 

of the blind. (The selected hotspot of the profile will be 

aligned to this line.)  

 
Use the horizontal/vertical offset, overhang and lengthen 

to wall values to customize the pelmet path. 

 

 

Object pelmet 

 

The pelmet object will aligned to the top center line of the 

blind. If the blind is longer than the pelmet object, the pelmet 

object will be cut in the middle and stretched so that the ends 

of the pelmet object remain proportional. 

 

  
Use the horizontal/vertical offset and overhang values to 

customize the pelmet. 
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Pelmet  

You can enable or disabler the pelmet. 

 

Profile or Object  

You can extrude a profile or use an object. 

 

Pelmet Object 

The object used as pelmet or curtain rod. This setting is available for 
object pelmets only. 

 

Turn up/forward/right 

You can rotate the pelmet object. This setting is available for object 
pelmets only. 

 

Pelmet profile 

The section profile of the pelmet. The hotspot of the profile will be 
aligned to the top of the curtain. This setting is available for profile 
pelmets only.  

 

Profile width/height 

You can resize the section profile. This setting is available for profile 
pelmets only. 

 

Material  

The material of the pelmet. This setting is available for profile pelmets 
only. 

 

Vertical offset  

You can elevate the pelmet by changing this value. 
 

Horizontal offset  

You can shift the pelmet perpendicular to the curtain. 
 

Overhang 

You can lengthen / shorten the pelmet. 
 

 

Lengthen to wall  

You can lengthen the pelmet perpendicular to the blind. This setting is 
available for profile pelmets only. 

 

 

 General properties  
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This page is available for all blind types. 
 
You can define the relative height, colour, line width, layer, priority and line type of the blind. You can also choose 
the 2D representation here. 
 

Simplified 

 

 

 

 

Symbolic top view 

 

 

 
Curtain 

 

 
Roman blind 

 

 

 
Venetian blind 

 

 
Vertical blind 

 

Top view 
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 Load and Save  

 
This page is available for all blind types. You can save the blind in the Design Center or load an existing one. 

1.75.6. Soft furnishing - Other 

 Table cloth 

ARCHLine.XP® provides wizard to make easier the creation and 
modification of table cloths.  

 

 Creating a table cloth 

Menu :   
Interior > Indoor Tools > Soft Furnishing 
 

 

 
To create a table cloth first you have to define the profile of the table on the floor plan: the Profile definitions tools appear 
in the Toolbox, you can draw the profile or select the Point of profile option to use the contours of an existing table. Once 
you have the table profile, the Table cloth wizard dialog appears.  
 
The table cloth will be created based on the following settings: 
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Shape and profile of the table cloth 

You can select rectangle, circle and custom shape for the table cloth. In the first two cases, the sizes of the table cloth 
layout must be set: width and height or diameter.  

In the third case, you can define the profile of the table cloth layout by clicking the Define Profile ( ) button: first you 
have to place the table outline onto the floor plan and then the Profile definitions tools appear in the Toolbox and you can 
draw the new profile around the table. Note that the table cloth profile cannot intersect the table profile. 

Once have a custom cloth profile you can edit it by using the Edit profile ( ) button: first you have to place the table 
outline onto the floor plan and then the Edit profile tools appear in the Toolbox and you can edit the profile. Note that the 
table cloth profile cannot intersect the table profile. 
 
 

 

 

Rectangular table 

cloth 

Circle-shaped table 

cloth 

Custom oval table cloth 

Offset from table top 

To avoid overlapping surfaces in the 3D window 
and on the rendered images, the table cloth itself 
will be created above the table top level 
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Smooth edges 

Enable this option to hide the sharp edges 
appearing around the table contour. Use smooth 
edges to cover rounded objects like beds, etc. 
 

 

 General properties  

 
You can define the relative height, colour, line width, layer, priority and line type of the blind. You can also choose the 2D 
representation here. 

 Load and Save   

 
You can save the blind in the Design Center or load an existing one. 



696 10. Building model 

Manual 

 Textile 

You can find this command in the Toolbox – Building – Indoor tools – Soft furnishing – Textile or in the Building menu – 
Freeform surface. 

� See description in 9.12. Freeform surfaces chapter. 

1.75.7. Soft furnishing – External louvre 

ARCHLine.XP enhanced the soft furnishing tools with parasol and awning design. 
 
Menu :  Interior > Soft Furnishing 
 

 

 Awning 

Menu :  Interior > Soft Furnishing 
 
ARCHLine.XP comes with a tool that makes easy to design awning as a 
secondary covering attached to the exterior wall of a building. It is composed of canvas fabric that is stretched tightly over 
a structure of aluminium, or steel. 
You can parameterize its size, angle and its elevation from the floor. 
 

 
 

 Parasol 

Menu:  Interior > Indoor Tools > Soft Furnishing 
 
ARCHLine.XP enables to design parasol to protect against rain or sunlight. It is composed of canvas fabric that is 
stretched over a structure of aluminium or steel.  
You can parameterize its main components as sides, structure and umbrella measurement and elevation from the floor. 
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1.75.8. Sanitary Ware 

Objects from Sanitary Ware (Manufacturers tool) in ARCHLine.XP is a continuously expanding object database. 
With the help of this tool, you can access global sanitary, heating and air conditioner manufacturer companies’ product 
databases and use them free of charge in your design. 
The actual product database is free to access and download from the following webpage: http://www.shk-
branchenportal.de/ . After registration, you should choose Download Center and Badplandaten in the menu of the 
homepage. 

 

Please choose the database you would like to download, by clicking on the manufacturer’s name at the right side and 
install it after download. After installation the built in Object browser in ARCHLine.XP® will automatically contain the 
installed database logo. Select it and choose the desired object from the catalogue. 
The selected object can be insert to your design and parallel it will be saved into the object libraries of ARCHLine.XP®. 
The object will contain the name and production code of the product, making it really useful when you create lists of used 
products later on. 
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Object browser 

Open Toolbox –Building – Indoor tools –Sanitary ware to start Object browser. 

 

 

First start 

The first start of Object browser could take longer, because the software needs to prepare the downloaded new databases 
for use. If there are no new databases to prepare, Object browser will appear immediately.  

Main page 

The first or main page of Object browser is the starting point for every search.  

Navigation pane 

The Navigation pane is located at the top of the Object browser. 
 

 

Previous page – Next page 

Use the left and right arrows in the navigation pane to load previous and next page. 

    

Home 

The Home icon will navigate back to the Main page no matter where you stay actually in Object Browser. 

 

Search field 

Type a phrase into the search field and search for it. Search field is able to memorize previous search phrases. Next time 
you want to use the same or similar search phrase, the software will offer auto complete to help you. 

 

Filter by model or by database 
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Set filter to Models to search in model descriptions, collection names and article numbers. The result will be a list of 
objects. 
 
Set filter to Collections to search in Collection names only. The result will be a list of collections. You can select a 
collection in the result list to open its content and access models inside. 

Information link 

Click on Information to open the online description page of Object Browser. This link will navigate you to the 
ARCHLine.XP® webpage and needs internet connection.  

 

Brand pane 

All installed brand databases can be found here represented by their logos. Use the arrows at the left and right side to roll 
the list. Select one brand logo to open the database and browse its content. 

 

Recent models pane 

When you place an object on the drawing, the last used object will be stored in this list. There is no need to search a 
previously used object again, because from here you can select and place it again. 

 

Browsing objects 

Select an object by left click in the catalogue to open it. You will see the model and properties of the selected object. 
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3D View 

3D view helps you check the model of selected product before using it. Hold down the left mouse button over the model 
and move the mouse to rotate.  
Hold down CTRL + Mouse scroll and move the mouse to zoom in an out. 

Properties 

Right to the 3D View, there are the properties of the selected object. You can find brand name, collection name, article 
number and relative height here.  You can change the relative height to set the position of the object in the 3D space. 

Description 

If the selected product has a description, you can see it in the description field. 

Download model 

Click on Download model to place the selected product on your drawing. At the same time, it will be automatically saved 
into an object library under Objects / Brands. 

 
 
The object will automatically contain the name, description and article number of the product. This will be handy when you 
will create the lists of the objects and objects in your project, using ARCHLine.XP® listing tools. 

 

Good to know 

When you start your search by clicking on the Search button the time of search will depend on the number of installed 
brands. Please wait until the search results are displayed. 
 
When you use the navigation arrows on the Navigation pane of Object browser the previous search will be applied. This 
means if the previous search took long time to display, you should wait again to be able to access the results. 
 
The whole search phrase must be at least 3 characters long. 
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1.75.9. Electrical accessories 

 
With Electric accessories tool you can create and place different switches and sockets.  

 Electric Accessory properties dialog 

In the Interior menu - Properties - Electric Accessory dialog you can create, modify and save new or existing electric 
accessories. In addition, here you set the default Electric Accessory element that appears in the dialog when you use the 
Interior menu - Electric Accessory - Define Electric Accessory command. 

 Function 

On the function tab you can define the complexity of the electric accessory modelling. The selected 2D symbol represents 
the function of the electric accessory. 

Simple flat shape with texture   
To get the simplest 3D model, you can represent the electrical accessory by a flat shape and a texture on it. In that case, 
use the Simple flat design option. 

3D switches and sockets 
To have a more detailed representation, just select 3D switches or sockets option. This way you can determine the 
shape and material of the external (frame) and inner parts of the electric accessory separately. 

 

 
Flat shape with texture 

 

 
Model with 3D switches or 
sockets 

You can select 2D symbol (function) from the favorites or from the group libraries ( ). The dimensions of the selected 

group can be modified ( ). 

Grouping 
In case of 3D switches and sockets 
selection, switches and sockets can be 
grouped in one frame horizontally or 
vertically. Each switch or socket in a frame 
can have a unique function. 

 
 

1-5 Gang sockets and switches 
In case of 3D switches and sockets selection, you can group more switches and sockets in one external frame. The 
number of elements in the frame can be selected from the 1-5 Gang sockets and switches drop-down list. 

Direction 
If you select at least two elements, you can define the direction of placement (horizontal or vertical). 
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Same Functions 
Switch this option on if you want to define the same function to each electric accessories in the group. 
Switch this option off if you want to define different functions to one or more electric accessories in the group. In that case, 
you can assign 2D symbol, material and shape to each member of the group on the 3D switches and sockets tab. 

 Shape 

On the Shape tab, you can define a profile and material on two different sub tabs. 

 Material 
The texture you specify here appears on each side of the defined shape. You can select materials from the favorites or 

from the existing material libraries ( ). You can also download materials from the web ( ) or create a new material 

( ) or edit ( ) the currently selected material. 

 Profile 
If you selected the Simple flat shape with texture option on the Function tab, the profile defined here defines the frontal 
shape of the electric accessory. 
If you selected the 3D switches and sockets option on the Function tab, the profile defined here defines the frame of the 
electric accessory. 

You can select profiles from the favorites or from the existing profile libraries ( ). You can create ( ) custom profile 

or edit ( ) the currently used profile. Custom profiles can be saved ( ) into the profile libraries. The orientation of a 

pre-defined profile can be modified ( ). 
You can resize the profile with its Width and Height values. The Thickness value defines the thickness of electric 
accessory or the frame part. 

 3D model of switches and sockets 

If you selected the 3D model of switches and sockets option on the Function tab, you can define the 2D symbol, the 
shape and material of the inner part of the electric accessory on the side tabs. If you selected the Simple flat shape with 
texture option on the Function tab, you can set only the 2D symbol of the electric accessory.  

 2D symbol 
On this tab you can define the 2D symbol of the electric accessory. You can select a symbol from the favorites or from the 

existing group libraries ( ) or you can edit ( ) the currently selected symbol. If you selected the Same function 
option on the Function tab, you can specify only one symbol here, otherwise you can select symbols for each function on 
different pages. You can switch between pages by the forward/backward arrow buttons on the left side. You can also 
switch between pages by clicking the inner profile assigned to a function. 

Custom 2D Symbols 
On the floor plan you can represent an electrical accessory with its upper view or as a 
2D symbol. You can use any 2D symbol as an electrical accessory representation; 
even you can create your own symbols. To have the appropriate placement, the 
symbol must have at least one hotspot and the symbol (and the front face of the 3D 
model) must be oriented upward. 
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 Material 
The texture you specify here appears on the inner profile. You can select materials from the favorites or from the existing 

material libraries ( ). You can also download materials from the web ( ) or create a new material ( ) or edit (

) the currently selected material. Use the Same material option if you want to apply the selected material to every 
functions. 

 Inner profile 
The inner profile will be cut out from the frame profile with a specified Border Gap. 
If you selected the Same function option on the Function tab, you can specify only one profile here, otherwise you can 
select profiles for each function on different tabs. You can select profiles from the favorites or from the existing profile 

libraries ( ). You can create ( ) custom profile or edit ( ) the currently used profile. Custom profiles can be 

saved ( ) into the profile libraries. The orientation of a pre-defined profile can be modified ( ). 
You can resize the profile with its Width and Height values. The Thickness value defines the thickness of the inner part of 
electric accessory. The Border gap value defines the gap between the frame and the inner part. 

 General settings 

On this tab you can set general properties like line type, line thickness, color, priority, relative height. 
For the 2D representation, you can choose from two options: 

� Symbol: the representation on the floor plan is defined by the settings on the 3D model of switches and sockets tab. 
� Top view: the floor plan representation is defined by the top view of the 3D model. 

Symbol scale 
You can scale the 2D symbol representation on the floor plan to avoid overlapping the elements. 

Symbol offset in 2D 
This setting is useful when you group switches and sockets. You can set the distance between two elements in the group.  

 Save 

On this tab you can save the currently edited electric accessory by the Save as button or you can select one from the 
favorites or from the object library for further modifications. Use the Reset button if you want to reset your electric 
accessory to the default electric accessory element from the available template files. 

Shifting symbols 

To make your 2D plans easier to understand; you can move and rotate the 2D symbol of the electrical accessory 
independent from the 3D model if necessary. 

 
Switch above a socket in 3D 

 
Symbols next to each other 
     on the floor plan 

 

• Click the electric accessory on the floor plan. 

• Click the marker and select the desired operation. 



704 10. Building model 

Manual 

  

 Place Electric Accessory 

With this command you can select and place electric accessories from the existing object library. The function is available 
in Interior menu - Electric Accessory - Place Electric Accessory or in the Toolbox - Interior - Electric Accessory - 
Place Electric Accessory. 

• Select the desired electric accessory from the object library. 

• Click Ok to close the dialog.  

• Place the selected element. You can place as many instances as you want, one by one. You can close the 
command by pressing the ENTER or ESC key.   

 Define Electric Accessory 

With this command, you can select and place electric accessories from the existing object library or you can create and 
save electric accessories in the object library. The function is available in Interior menu - Electric Accessory - Define 
Electric Accessory or Toolbox - Interior - Electric Accessory - Define Electric Accessory. 
The appearing dialog works the same as the Electric Accessory properties dialog, with the following differences: 

� The last selected element and its properties have no effect on the default electric accessories properties. 
� When you close the dialog by clicking the Ok button, you can place the element you selected or created in the dialog. 

 Modifying the placed electrical accessory by marker commands 

There is no further command in the Toolbox or in the main menu related to the electrical accessories: you can work with 
them by using the markers or changing their properties. 

Marker menu commands 

In case of using a symbol for the 2D representation, a small node marker appears on a selected electrical accessory. By 
using the marker commands, you can shift the symbol independent from the 3D model. 

  
Symbol in default position 

  
Shifted symbol 

Shift Symbol 

You can move the symbol independent from the 3D model. 

Rotate Symbol 

You can rotate the symbol independent from the 3D model. 

Reset Symbol 

You can reset the symbol to its original position. 

 Electric accessory settings on the properties tab 

When you select an electric accessory on the floor plan or in 3D, you can set its properties on the properties tab. 

On which floors visible? (Except for its own floor) 

All floors 
Use this option if you would like to see the electric accessory at all levels of the building. 
Furthermore, you can select floors where the electric accessory should appear. 

Position 

Relative Height 
Elevation from the floor level. 
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Absolute height 
Elevation including the floor level. 

Function 

Symbol Scale 
You can rescale the 2D symbol by this value, independently from the 3D model. 

Design 

Material 
The material of the electrical accessory. If 3D Switches and Sockets option is enabled, this material is applied to the 
border. 

Thickness 
The thickness of the electrical accessory. If 3D Switches and Sockets option is enabled, it is applied to the border. 

Grouping 

1-5 gang sockets and switches 
Number of switches or sockets in a single frame. 

Same functions (available only when the value of 1-5 gang sockets and switches is bigger than 1) 
The function of the grouped elements in a single frame. If it was switched off previously, the function of all grouped 
elements will change to the first element. 

Direction (available only when the value of 1-5 gang sockets and switches is bigger than 1) 
You can set the direction of the grouped elements in the single frame to horizontal or vertical. 

Symbol offset in 2D (available only when the value of 1-5 gang sockets and switches is bigger than 1) 
The distance between two grouped elements in a single frame takes this value. This way you can avoid the overlapping of 
the grouped elements on the floor plan. 

3D model of Switches and Sockets 

Enabled 
If enabled, 3D switches or sockets appear in the frame and further settings available. Otherwise, the whole electrical 
accessory will be represented as a single shape with a stretched image on it. 

Material 
Material of the grouped inner parts. As many instances occur as the number of grouped elements in the single frame. 

Width 
The width of the grouped elements in a single frame (the same value applied to all elements). 

Height 
The height of the grouped elements in a single frame (the same value applied to all elements). 

Thickness 
The thickness of the grouped elements in a single frame (the same value applied to all elements). 

Border Gap 
Space between the border and the grouped elements in a single frame (the same value applied to all elements). 

Structure 
Click the ellipsis button you can modify the electric accessory in the appearing dialog. 

 Manage elevations 

With this function, you can assign and represent the relative height information of each Electric Accessory on the floor 
plan. 
The function is available in Interior menu - Electric Accessory - Manage Elevations or Toolbox - Interior - Electric 
Accessory - Manage Elevations or Toolbox - Electric Accessory - Manage Elevations. 
If you start the command, four options appear: 

� All elevations: the program automatically places the relative height information to each electric accessory on the floor 
plan. Right after executing the command, you have the possibility to modify the position of the appearing relative height 
information by clicking the electric accessory and then moving the mouse cursor to the desired position. The text 
properties are taken from the actual text properties settings.  

� All elevations with ID's: the program automatically places the relative height information plus the element ID to each 
electric accessory on the floor plan. Right after executing the command, you have the possibility to modify the position of 
the appearing relative height information by clicking the electric accessory and then moving the mouse cursor to the 
desired position. The text properties are taken from the actual text properties settings. 
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� Delete all elevations: the program deletes all the relative height and element ID information that have been placed 
previously. 

� One by one elevations: by clicking the electric accessory, you can place or modify individually the position of the relative 
height information of the electric accessory element on the floor plan. 

 Switches or sockets location relative to the wall and doors 

With this command, you can place dimensions that show the distances between electric accessories and main 
wall/door/window connection points. The function is available in Interior menu - Electric Accessory - Switches or 
sockets location relative to the wall and doors or Toolbox - Interior - Electric Accessory - Switches or sockets 
location relative to the wall and doors. 

• To execute the command, you have to click the wall side that has connection with electric accessories and 
then place the dimension chain graphically with your mouse. 

 Switches or sockets report list in Excel 

Using the Add-On menu Quantity Take-Off – Interior Design consignation command you can save switches and socket 
data in Excel (.xls or xlsx) file. 

1.75.10. Moulding 

Moulding is a particular shape to decorate the top or bottom of a wall, or a door, window, or piece of furniture. Moulding is 
available through Room maker too. You can vary in profile, size and finish 
 

 

� See description in 9.13.2.7. Room maker – Profiles panel chapter. Cabinet Wizard 

 
Using the cabinet wizard, you can design complex cabinets for kitchen or living room or for other purpose in a few steps. 
This tool is designed to offer simple and easy to use options to create a new cabinet. It is possible only by setting the main 
properties such as the Shelves, Doors, Legs, Drawers, and Handles, Materials (even photos of the original door), 
additional object Accessories and Data tool to build up the cabinet. 
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1.76. Furniture design 

1.76.1. Cabinet wizard 

The wizard helps you creating wardrobe, add and remove corpus to it and you can load or save the model in 
ARCHLine.XP library. 

 

 

 Corpus section 

The corpus section allows you manage more wardrobe corpus one by one.  

 
 

Add corpus button 

Use the add corpus button on the corpus pane to add a new corpus. 

Remove corpus button 

Use the remove corpus button to remove the active corpus. The last corpus cannot be removed as there should at least 
one remain. 

Navigation arrows 

Use left and right navigation buttons to switch to the next corpus to edit it or just to see its properties. 

 General page 

The cabinet box is defined by its width, depth and height. The box-like component is fitted with drawers, shelves, legs, 
doors in cabinet construction.  
The structure of cabinet wizard enables to define various types of enclosed furniture such as desks, bookcases, 
sideboards, etc. 

Height definitions 

The Cabinet wizard tool allows you to define the box overall height as the sum of the corpus height plus the leg height. 
You can lock one of them and you can modify the other two height values freely. 

Cabinet types  

The Cabinet wizard tool let you choose among four kind of structures: 
� Standard Shape 
� Shape with Profile 
� Curved Shape 
� Corner Wardrobe 
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Standard shaped cabinet 

By setting standard shaped cabinet front, you can design regular box shaped cabinets 

Shape with Profile cabinet 

By setting shape with profile, you can design irregular shaped cabinet fronts by selecting a frontal profile for them. 
Click on the Favourites list to select a frontal profile from the profile libraries. You can add a new profile to the Favourites 
list with the blue plus button and you can delete a profile from the list with the keyboard Delete button. 
 

 

Arch-shaped cabinets 

By setting Curved Shape, you can design corner cabinets closing the cabinet line. 

 
 

Frontal shape 

You can select four different options to round-off one side of the current cabinet object. There are two options to create a 
circle shaped side and two to create an ellipse shaped one. 
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Detail 

You can set the resolution of the curved side of the cabinet by changing the Detail level. Higher values result in a 
smoother curve, while lower values will create a rough approximation to a curve. 
 

  
 

Corner cabinets 

By using the Cabinet wizard, you can create corner cabinets. 
 
Change the Cabinet type to Corner Wardrobe. 

 

Joining width 

By defining the Joining width value, you can set the size of the side panel of the corner cabinet on which it is connected to 
other objects of the cabinet series. 

Materials 

 
In the General section, you can assign materials to the following parts: 

 
Cabinet solid material (general) 
Back Side Material 
Right Side Material 
Left Side Material 
Top Side Material 
Bottom Side Material 
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 Corpus Details page 

 
 

The cabinet box is mostly made from plywood or particle board and you can define its thickness in the Thickness field. 
Typical cabinet box thickness varies from 3⁄8 inch (9.5 mm) to 3⁄4 inch (19 mm). 
You can define separately the thickness for cabinet backs. 

Extension 

The Cabinet top Extension to front, Extension to back and Extension to width value lets you extend the top panel over the 
cabinet box. 

 

 

Crown moulding 

Crown moulding is an attractive detail to the cabinet box top edge. You can choose here Profile from the profile library or 
you can design your own profile and select it later. The Crown moulding width and height defines the enclosing box of 
the profile as cross section. 
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Cabinets may be either face-frame or frameless in construction. You can set it with the Has top face, Has bottom face and 
Has back face checkboxes. 

Back face connection 

In the Cabinet wizard, you can change the connection between the back face and the side panels of a cabinet. This option 
can be found on the Corpus details page in the Corpus section. 

 
 
If you set the option to “0” that means a default connection between the panels and the back face, when the side edge of 
the back face is perfectly aligned to the inner side of the side panels. 

 
 
If you change this option, using a different value the back panel will be cut into the side panel. 

 
 

Cabinet wizard allows you to choose between two cabinet box mounting options. 

 
Full overlay means the side face is enclosed by top and bottom frame. 
Traditional overlay means the top and bottom face is enclosed by side frame. 
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Full overlay Traditional overlay 

  

Raker 

 
You can add rakers to a cabinet on the Corpus details page of the Cabinet wizard. These structural parts of the cabinet 
can be set individually in the Rakers section. 
 

 

Add/remove raker 

Click on the Add/Remove raker buttons to add or remove a raker to the current cabinet. The raker list shows the list of the 
actual rakers added to the cabinet. When you select a raker from the list, you can see and edit the properties of it. 

Raker height 

One size of the raker can be changed by the raker height value. 

Raker orientation 

The raker can be horizontal or vertical, based on the selection from the Orientation options. 

X and Z Offset 

You can shift the selected raker to two directions by changing the X/Z Offset values. The default position of a raker is the 
origin when it is aligned to the frontal face of the cabinet. 
 
By changing the first value, you can move the raker to front or back. By changing the second value, you can elevate or 
lower the raker. 



 10. Building model 713 

ARCHLine.XP® 

 Doors page 

 
 

Door properties are: 

� Has door checkbox allows to add door 
� Side Count can be: Single, Double, 3 and 4 sided 
� Door overlay can be: Full or Traditional overlay 
� Gap defines the gap between the door and the cabinet frame 
� Door starts at height: door top elevation 
� Door ends at height: door bottom elevation as height or shelf number 
� Thickness: door thickness 
� Inset definition: profile, enclosing box, offset, thickness, materials 
� Handle: Type, Rotation, Offset, and Alignment 

 Door handles page 

With the help of the Door handles button you can place handles onto the doors. You can choose from Round, KLIP, Long, 
Sphere and Custom. 

Select Custom if you would like to create a special item then cklick Browse . The Insert Object window appears, 
where you can select the object by clicking Object selection. 
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Rotation around X/Y/Z Axis 

You can rotate the selected handle by changing the values of the Rotation around X/Y/Z Axis. The default is 0, 0, 0 and 
the unit is degrees. Select the desired angle to rotate the handle by a specific angle. 

X/Y/Z Offset 

The X/Y/Z Offset values of the door Handle properties let you to define a free offset of the selected handles in every 
direction. The left bottom alignment point is the origin (0,0,0). The three values are the X, Y, and Z directions. 

Position 

You can determine the location of handles on the doors. 

Material 

You can choose or modify the material of the handle. 

 Shelves page 

Click on the Shelves button in the Wardrobe wizard to enable shelves and set the settings of them. 
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Number of shelves 

Use the spin buttons or enter a value to set the number of shelves. 

Thickness 

You can set the thickness of a shelf board here. 

Gap 

Set the gap between the door panel plane and the edge of the shelves. 

Spacing between shelves 

Set the spacing between shelves by changing the value here. Double click on the value to change it. The first reference 
plane is the top of the corpus. If there is more than one shelf then the 2nd and other shelves’ positions are measured from 
the bottom plane of the previous ones. 

Equal spacing 

Press equal spacing to set it to all the actually existing shelves. 

 

 Drawers page 

 
 
Drawer properties are: 

• Vertical divider 

• Number of panels 

• Door Overlay 

• Gap 

• Inside Thickness 

• Door Front Material 

• Door Solid Material 

• Inset definition: profile, Cut Through Inset width/height, offset, thickness, materials 

Modify all drawers 

There is a convenient option in the drawer list of the Cabinet wizard. By using the All option, you can set the same 
properties for all of the drawers in the current cabinet. 
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How to use 

To set the properties of multiple drawers at a time go to the Drawers page of the Cabinet wizard and from the drawers list 
select “All”.  
Set the properties according to your needs. 
Click Refresh to see the results. 
 
When you would like to make changes to individual drawers one-by-one, please just select the number of the drawer and 
make the changes as you wish. 

 
Handle: Type, Rotation, Offset, and Alignment 

 Drawer handles page 

With the help of the Drawer handles button you can place handles onto the drawers. You can choose from Round, KLIP, 
Long, Sphere and Custom. 

Select Custom if you would like to create a special item then click Browse . The Insert Object window appears, where 
you can select the object by clicking Object selection. 

Rotation around X/Y/Z Axis 

You can rotate the selected handle by changing the values of the Rotation around X/Y/Z Axis. The default is 0, 0, 0 and 
the unit is degrees. Select the desired angle to rotate the handle by a specific angle. 

X/Y/Z Offset 

The X/Y/Z Offset values of the drawer handle properties let you to define a free offset of the selected handles in every 
direction. The left bottom alignment point is the origin (0,0,0). The three values are the X, Y, and Z directions. 

Position 

You can determine the location of handles on the drawers. 

Material 

You can choose or modify the material of the handle. 

 Legs page 

Click on the Legs button in the Wardrobe wizard to set legs. 
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Legs 

This option enables / disables the legs of the wardrobe. 

Width 

You can set the width of the legs here. 

Depth 

You can set the depth of the legs here. 

Height 

You can set the height of the legs here. 

X Offset 

You can set the offset measured from the two side edges of the active corpus. 

Y Offset 

You can set the offset measured from the front and back edges of the active corpus. 

Plank thickness 

You can set the thickness of the plank, if it is enabled. 

Shape 

You can set the shape of the legs. The following options you can choose:  
� Rectangle 
� Circle 

Plank 

You can set plank by selecting an option here. The following options you can choose:  
� No Plank 
� Front Plank 
� Front and Right Plank 
� Front and Left Plank 
� U-Shaped Plank. 

Leg Options 

When legs are enabled, you can set the pattern of legs here. The following options you can choose:  
� Both sides 
� Left side 
� Right side. 
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 Accessories page 

 
 

List of accessories 

The list of accessories has all of the items that have been added to the furniture. Choose one from the list for the 
modification. If you do not have any added items, the list is inactive. When you add an item, it will appear in the list with 
the next number and with the name of the object.  

X/Y/Z Offset 

The X/Y/Z Offset values of the drawer handle properties let you to define a free offset of the selected handles in every 
direction. The left bottom alignment point is the origin (0,0,0). The three values are the X, Y, and Z directions. 

Rotation around X/Y/Z Axis 

You can rotate the selected accessory by changing the values of the Rotation around X/Y/Z Axis. The default is 0, 0, 0 and 
the unit is degrees. Select the desired angle to rotate the accessory by a specific angle. 

Position 

You can determine the location of handles on the drawers. 

Object – Select object 

By clicking the Select object button the Insert Object window appears, where you can select the object by clicking Object 
selection. 

Add an object 

Click the Add button for a new accessory. Then you can select the new item with the Select object button. The name and 
the number of the added object will appear in the List off accessories, where you can switch between the other, previously 
added items, if you would like to modify or delete them. 

Delete 

Select an accessory in the List of accessories and click on the Delete button. Please note: you can’t withdraw this action. If 
you accidentally remove an item, you will need to enter it again. 

 Data page 

Click on the Data button in the Wardrobe wizard to type additional data for the wardrobe. 
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Name field 

Type the name of the wardrobe. 

Producer field 

Type the name of the manufacturer of the wardrobe. 

Article number field 

Type the article number of the wardrobe. 

Description field 

Type or paste the additional description of the designed furniture. 

 Preview panel 

On the right side of the Cabinet wizard dialog, you can find the 3D preview panel. Use this panel and its controllers to 
examine the changes during the design process in the wizard. 

Refresh button 

On the top of the 3D preview panel, you can find the Refresh button. This can be used to refresh the 3D preview content 
after changing values in the Cabinet Wizard. When you press the Refresh button, the software will update the door 
preview by using the current values. 

View mode button 

The View mode button can be used to switch between Wireframe, Hidden lines and textured views. Click on the button to 
switch to the next view. When you reach the last view, click on it again to set the first visual style again. On slower 
machines, this button can be used to turn off the 3D preview also, by setting the “X” state on it. 

3D Preview area 

The 3D preview area is the largest part of the 3D preview panel on the Cabinet wizard dialog. Click and hold your left 
mouse button and move your mouse to rotate the preview content. Use the scroll-wheel of the mouse to zoom in or out 
and pan the 3D preview content. 

 Edit wardrobe 

When you place a wardrobe designed in the wardrobe wizard, it will be automatically saved as an object. Later you can 
find it in the Design Center. 
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You can handle a wardrobe created by the wardrobe wizard in two ways. One is to handle it as a general object. In that 
case, you can access its main properties.  

Edit as general object 

Choose Properties... in the pop menu of the object on 2D or in 3D. 

 

 
 

The general Object Properties window will open. 
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Edit as wardrobe 

Choose Wardrobe Properties... from the pop menu. 

 
 
The Wardrobe wizard will open with the settings of the selected wardrobe. You can overwrite the previous settings or 
create a new version of the already existing object. 
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1.76.2. Worktop 

Using the Worktop tool, you can quickly design a worktop object on top of one or multiple cabinets. The worktop tool will 
let you customize detailed settings and to add or remove worktop holes using the same easy-to-understand dialog 
window. 
 

 

How to use it? 

To use the Worktop tool, follow these steps: 
 

� Click on the Worktop tool. The Worktop properties dialog will appear. 
� Set the settings you wish, and click OK to accept the changes and close the dialog. 
� Save the new worktop using a unique name and set the category you wish to save it into. 
� Place the worktop on your drawing. 

Worktop properties 

When you create a new worktop or change an existing one, you can use the Worktop properties dialog. This dialog is 
separated into 4 main parts. 
 
The Worktop properties dialog window has the following pages: Basic geometry and Holes. Click on these buttons to 
change see their details. 
 



 10. Building model 723 

ARCHLine.XP® 

 Basic geometry 

The Basic geometry section of the basic geometry page allows you to see and change the basic geometry details for the 
worktop. 

Width 

You can set the width of the worktop object. 

Depth 

You can set the depth of the worktop object. 

Thickness 

You can set the thickness of the worktop object. 

Relative height 

You can set the relative position of the worktop object in the 3D space measured from the zero level of the actual floor. 

Type 

The type of the worktop defines the shape of the worktop. You have the following options to choose from: 
� Rectangle shaped 
� Trim left 
� Trim right 
� Trim both 

Description 

The description field allows you to manually add extra data to the worktop, which can be visualized in lists later.  

Materials 

You can change the worktop and the worktop edge material. 

Material 
By default when changing the first material, all surfaces of the worktop will be changed. 

Edge material 
You need to enable the Edge material option to define material especially for the edges. 

Edges 

The edges section of the basic geometry in the Worktop properties allows you to set the edge round-off. 

Round-off edges option 
This option enables the additional round off profile to the edges of the worktop. Enable this option and choose the position 
of round-off from the Round-off edges list. 

Round-off edges list 
There are several options to choose from, when you would like to set the placement of the edge round-off for a worktop. 
This can be selected in the Round-off edges list. 

Size 
The round-off profile size can be changed by typing the desired value here. 

End panels 

End panels can be defined for a worktop in the End panels section. 

Left side panel option 
By enabling this option, you can turn on the vertical left side panel for a worktop. 

Right side panel option 
By enabling this option, you can turn on the vertical left side panel for a worktop. 

Height 
The height option allows you to change the height of the side panels if they are enabled for a worktop. 

 Holes 

You can add, remove and displace holes into the worktops. 
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List of current worktop holes 

The list of current worktop holes is a drop-down list. It allows you to browse through, view or modify existing holes. 

Add hole 
Click on the Add Hole icon to add a new hole into the current worktop. 

Remove hole 
When you click on the Remove hole button the software will automatically remove the currently selected one. 

X and Y size 
You can change the size of the current hole by changing the X and Y size values. 

X and Y Offset 
The offset of a worktop hole is 0 by default. This means that the hole is at the left bottom corner of the worktop. Change 
the X and Y offset values to displace the hole into the worktop. 

Hole profile list 
In the hole profile list you can select a top view profile of the current worktop hole. 

Browse profile 
Click on the browse profile button to browse another one from the profile libraries. The selected object will be automatically 
added to the list as a favourite. 

Edit profile 
Select a profile in the profile list and click on the Edit profile button to change its properties. 

Selected worktop 
The selected worktop button shows the name of the current worktop. When you make changes in a worktop and you click 
on the OK button of the Worktop wizard you will be prompted to save the changes. You can overwrite the current worktop 
or you can create a new one with a new name. 

1.76.3. Cabinet legend 

With the Cabinet legend menu commands detailed information can be gained in Excel (.xls or .xlsx) files about wardrobes 
created with Cabinet wizard function. 
 
Cabinet legend menu listing commands are accessible 

� in Architecture edition:  Building menu – Furniture design – Cabinet legend  
� in Interior edition:  Furnishing menu – Furniture design – Cabinet legend  

 
Two listing commands are available: General item list and Workshop drawing. 

General item list 

This command lists the quantities and properties of items of the selected wardrobes created by Cabinet wizard. All 
cabinets are listed on one worksheet. 

• Start the command on the floor plan where cabinets can be selected. 

• Select wardrobes created with Cabinet wizard. 

• Specify the path and file name of Excel file. 

• After saving, the file will open automatically. 
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Workshop drawing 

This command lists the main properties and items of the selected wardrobes created by Cabinet wizard. Each cabinet has 
a worksheet with its data and hidden line representation.  

• Start the command on the floor plan where cabinets can be selected. 

• Select wardrobes created with Cabinet wizard. 

• Specify the path and file name of Excel file. 

• After saving, the file will open automatically. 
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1.77. Outdoor Tools 

1.77.1. External louvres 

     
 

    

 Working with external louvres 

Frames 

 
An external louvre is based on a profile drawn on a floor plan. Frames are structures perpendicular to the floor plan path. 
They can be horizontal, vertical or you can define a custom frame by selecting Define custom frame command from the 
Popup menu. 

 
Horizontal 

 
Vertical 

 
Custom 

 

Louvres 
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Louvres are structures parallel to the 
floor plan path. You can rotate them 
around their axis and use a different 
louvre type for the first and last 
position. 
 

 

Distribution of frames and louvres 

By setting the frame distribution, you can enable or disable frames on path nodes: 

 
Frames on path nodes 
enabled 

 
Frames on path nodes 
disabled 

The main rules of frame and louvre distribution are the same. On a given distance you can distribute frames or louvres in 
three different ways: 

Align to start point 
 
The exact spacing value 
(1.00) is used 

 

Align to end point 
 
The exact spacing value 
(1.00) is used 

 

Evenly distributed 
 
The spacing value (1.00) is 
modified 

 
 

 Creating an External louvre 

First, set the default properties of the External louvre by selecting Building / Properties / External louvre in the Toolbox. 
You can place an External louvre by selecting Building / Outdoor Tools / External louvre. Draw an open profile by 
means of the Profile definition tools. While drawing the profile, you can mirror the structure to the path by selecting 
Change offsets to the other side of the path form the Toolbox. 

Modifying the 3D model 

There is no further command in the Toolbox or in the main menu related to the External louvres; you can work with them 
using the Popup menu and the markers. 

Popup menu commands 

Define custom frame 

To define a custom frame, first draw an open profile, 
and close the definition by pressing ENTER. Finally 
click on the insertion point of the profile (the frame 
will be aligned to the main path by this point) 
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This command is available only on the floor plan. 

Marker menu commands 

You can modify the floor plan path by using the following marker commands: 
� Move Node 
� Delete Node 
� Insert Node 
� Offset 
� Turn Into Curved Edge 
� Turn Into Straight Edge 
� Change Arc 
� Change Radius 

 

 Settings 

Position 

Relative Height 
Elevation from the floor level. 

Absolute Height 
Elevation including the floor level. 

Frame 

Frame Type 
Horizontal, vertical or custom. You can define a custom frame path by selecting the 'Define custom frame' command. 

Frame Size 
Length or height of the frame. 

Section Profile 
Section Profile of the frame. 

Material 
Material of the frame. 
 

Frame Distribution 

Spacing 
Distance between frames. 

Frames on Path Nodes 
If enabled, frames will be placed on each nodes of the floor plan path, and other frames will be distributed among them. 

Offset of First Frame 
Distance between the beginning of the floor plan path and the first frame. 

Offset of Last Frame 
Distance between the end of the floor plan path and the last frame. 

Distribution Mode 
You can align the sequence of frames to the first point or to the endpoint of the floor plan path, or distribute the frames 
evenly from the first point to the endpoint by changing the spacing value. 
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Louvres 

Section Profile 
Section profile of the louvres. 

Rotation 
Rotation of the louvres. 

Material 
Material of the louvres. 

Different First and Last Lamella 
If enabled, first and last louvres can have a different profile and material. 

Section Profile 
Section profile of the first and last louvres. 

Rotation 
Rotation of the first and last louvres. 

Material 
Material of the first and last louvres. 

Distribution of Louvres 

Spacing 
Distance between louvres. 

Offset of First Louvre 
Distance between the beginning of the frame and the first louvre. 

Offset of Last Louvre 
Distance between the end of the frame and the last louvre. 

Distribution Mode 
You can align the sequence of louvres to the first point or to the endpoint of the frame, or distribute the louvres evenly from 
the first point to the endpoint by changing the spacing value. 

Overhang at the First Frame 
Distance between the start point of the louvre and the first frame. 

Overhang at the Last Frame 
Distance between the endpoint of the louvre and the last frame. 
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1.78. Light Sources 

ARCHLine.XP® facilitates the creation and use of the light sources. You can attach a light source to any object. You can 
edit the properties of light sources and modify their positions in the 3D space. Light manager provides an easy way to 
manage light sources. 

1.78.1. Light Source Types 

You can choose between four different light source types. 
 

 
Point 

 
Spot 

 
Line 

 
Area  

 
 

 
Different light sources are based on different characteristics and have different properties. The type of the light source 
determines its look on the rendered images. 
 

� Point 
Point lights do not have any direction; they emit rays from their position in all directions uniformly. You can model for 
example light bulbs by means of this light source type. 
 

� Spot 
Spotlights have a well-defined direction. Its typical light cone is based on the light limit and fall-off limit. In the cone defined 
by the light limit angle the light effects with full intensity. From the border of the light limit cone the intensity of decreases 
and reaches zero at the border of the cone defined by the fall-off angle. You can use it typically to model spot lamps and 
reflectors. 
 

� Line 
Line light sources emit light from a straight line in the 3D space. You can model for example fluorescent lamps by means 
of this light source type. 
 

� Area 
Area lights emit light from a surface in the space uniformly. You can model for example office lamps with more fluorescent 
tubes or surfaces lit with a colour by means of this light source type. 
 

1.78.2. Light source browser 

   
 
You can browse and edit light sources in the Design center. By means of this tool you can manage Global light sources 
and Project light sources. 

Global light sources 

Global light source category includes light sources that are available right after the program has been installed. You 
cannot add new subcategories to that category. 
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Project light sources 

You can find all of the light sources used in the project in the Project light sources category. By clicking on the Project light 
sources category, the used light sources appear. 

Light Source Properties  

 
 
By clicking a light source In the Design center you can view and edit the properties of the selected light source. 

 

� You can edit only the light sources in the Project light sources and Global light sources – User category. 

 

Name 
You can add a unique name to the light source. The names of the factory default light sources represent their types and 
power consumptions 
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Type 
The type is related to the geometry of the light source. You can select between Sphere, Spotlight, Line and Area 

Category 

Defining the category of the light source has no effect to the appearance of the light; you can use this setting for 
classification purposes only. You can choose between incandescent bulb, compact, LED spotlight, Halogen and Neon. 
 

 
incandescent bulb 

 
compact 

 
LED spotlight 

 
Halogen 

 
Neon 

 

Brightness 
You can set the intensity of the light source in lumen. 

Colour 
You can set the colour of the light source. 

Fall-off 
The intensity falloff option can be:  

� Constant 
� Inverse to distance  
� Isl 

 
Default setting for the falloff is the Inverse to distance. This will result in the most realistic final render. 

1.78.3. Creating a light source  

You can create a new light source by creating a copy of an existing light source. First, click the appropriate light source to 
see its details. Click settings icon and select Make a copy.  
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A message window appears with a question. Click Yes to confirm. 
 

  
 
Specify the name of the copy: 
 

  
 

Once the new light source is created, you can find it in the Global light sources – User category and you can change its 
properties. 

Renaming a light source 

You can rename a user defined light source. Click the name of the light source with your right mouse button and select 
Rename.  

 



734 10. Building model 

Manual 

 

Deleting a light source 

You can delete a user defined light source. Click the name of the light source with your right mouse button and select 
Delete. 

 

1.78.4. Creating a lamp 

A so-called lamp is composed of a library object and one or more light sources attached to it. You can attach a light source 
only to a library object. 
 

� By Toolbox Command 
First select the Lighting – Add/Edit light source command form the Interior group of the Toolbox, and then select a library 
object. Once an object is selected, the Light manager appears. 
 

� From the Popup menu 
You can attach a light source to a library object by selecting the Lighting – Add/Edit light source command in its Popup 
menu as well. If you select this command, the Light manager appears. 

 

1.78.5. Managing light sources of a lamp 

Selecting a light source of a lamp 

If you work in a 2D or 3D window and select a lamp with one or more light source attached to it, in addition to the default 
markers the light source markers appear. 

 

 
Lamp selected on a 2D 
drawing 

Lamp selected in the 3D model. 

 
By clicking a light source marker, some other markers related to the selected light source appear instead of the default 
library object markers. 
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Light source selected on a 
2D drawing 

Lamp selected in the 3D model. 

 
If an object has light sources attached to it, you can view and edit their properties by means of the Property grid as well. 
To do this, select the lamp and choose the Light sources option from the drop-down list in the Property grid. 

 

 
 

You can view and edit the properties of 
the selected light sources in the 
Property manager. 

 

 
If there are more light sources attached to an object or you select more objects with light sources, you can edit only the 
common properties, in most cases the on/off state and brightness: 
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You can manage the light sources of a lamp individually in the Light manager. To do this, select the object and click the 
Light sources ellipsis button in the Property grid: 
 

 

1.78.6. Editing lamps 

If a lamp (an object with one or more light sources attached to it) is selected, you can edit it by selecting one of the light 
source editing commands from the popup menu. 
 

 

Add/Edit light source 

You can attach a light source to a library object by selecting the Lighting – Add/Edit light source command in its Popup 
menu. If you select this command, the Light manager appears. 
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On the left side of the dialogue, you can see the attached light sources. Click a light source to view and edit it. In the 
middle of the dialogue, you can see the position and direction of the selected light source. You can modify the position of 
the light source, the cone angles and the target point of the light source by clicking on the appropriate marker. You can 
select top/bottom/left/right/back/front view with the view button. For more precision, it is possible to specify the light source 
and target point coordinates manually, too. 
 

    
On the right side of the dialog you can set the own parameters of the light source: the on/off state and brightness. 

Add light source 
To add a new light source to an object, click Add. In the Light sources dialog you can browse and select the appropriate 
light source. 

Change light source 
To replace the selected light source to another one, click Change. In the Light sources dialog you can browse and select 
the appropriate light source. 

Delete light source 
To delete the selected light source, click Delete. 

Saving lamp into library 

You can save the selected lamp into an object library. You have to decide whether to overwrite the original library 
object or to create a copy of it. 
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If you confirm the question, the original object will be overwritten, otherwise a new object will be created and you 
have to name it.  
 

 
 
By pressing cancel at this point, no object will be saved into the library. 
 
If you try to save an object in a write-only library like factory default objects in the Design Center, the following 
dialog appears: 
 

 
 

1.78.7. Editing light sources 

Commands related to editing light sources can be found in the light source marker menus. 
Select a lamp and then click one of the attached light sources. Light sources are represented by yellow bulb icons.  
 

  
 
Click a bulb. The light source marker and the light source selection marker appear. With the light source selection marker, 
you can select the next/previous light source. 
 

  
The light source marker menu gives the following possibilities: 
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Move 

You can move the light source relative to the object. 

Move a copy 

By selecting this command, you can copy the current light source to a new position. The original light source remains 
unchanged. 

Elevate 

You can elevate the light source relative to the object. 

Add/Edit light source 

By selecting this command, you can modify the properties of the current light source in the Light manager. 

Switch light on/off 

You can switch on or off any light source. You can control the result in the 3D window: the light source that is switched on 
has a semi-transparent light solid; the one, which is switched off, has a wireframe only. 

  
Light source switched on Light source switched off 

 

Edit light source intensity 

You can modify the intensity of the light source, relatively to the original lumen value, in per cents. You can modify the 
intensity of the current instance of the given light source without affecting the other instances of this light source in the 
project. 

1.78.8. Representation of light sources 

ARCHLine.XP® provides more light representations to support the design process in the early phase, even before 
rendering any photorealistic images. 

Light source representation menu 

Activate the 3D view window and select the appropriate graphics settings in the property grid. The selected Light Scheme 
and Display light sources options define the light source representation. 
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    Display light sources off, lights 
off 
 

    Display light sources on, lights 
off 

 

    Display light sources off, lights 
on 

     Display light sources on, 
lights on 

Lights off – Display light sources off 

If the Display light sources option is off and the lights are off in the Light Scheme setting, the program does not display any 
lighting effects or light solids except the sunlight. 

Lights off – Display light sources on 

If the Display light source option is on and the lights are off in the Light Scheme setting, some shapes representing the 
lights appear in the model. The program does not display any lighting effects except the sunlight. 

Lights on – Display light sources off 

If the Display light source option is off and the lights are on in the Light Scheme setting, the program does not display any 
light solids, the sun is switched off and only the effects of lights that are switched on are visible. 

Lights on – Display light sources on 

If the Display light source option is on and the lights are on in the Light Scheme setting, the program displays both the light 
effects and the light solids of light sources that are switched on. 

1.78.9. Representation of light sources 

The different types of light sources are represented differently in the 3D model. The following table helps you to recognise 
the different types. 
 

 
 

Point 
 

Spot 
 

Line 
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 Area  

1.78.10. Lights on the rendered images  

The real effect of lamps and light sources appears on the rendered images. You will get different results depending on the 
used settings. With ARCHLine.XP® you can design the lighting of models and spaces in more versions, and you can show 
the result as photorealistic images. 
 

 

1.79. Modelling tools 
ARCHLine.XP introduces various modelling tools, to design complex objects as soft furniture. 
 
The 3D shape command is in the Toolbox under the Manufacture menu or in the Menu Bar – Building menu – Indoor 
Tools. 
Menu: Manufacture  

1.79.1. 3D shape 

With the 3D shape tool, you can create 3D shape elements by three profiles.  
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How does it work? 

• Define three profiles: floor plan profile, frontal profile and side profile. The program extrudes each profile 
along Z axis (floor plan profile), Y axis (frontal profile) and X axis (side profile) and then creates the 
intersection of these three solids. 

• Define the material of the 3D shape. 

• Define the general settings of the 3D shape 

• Place the 3D shape element or save it into an object category. 

 3D shape dialog 

When you create a new 3D shape or edit the properties of an existing 3D shape element, use the 3D shape dialog. The 
dialog includes four main tabs. 

 Sizes and profiles 

On this tab you can define three profiles on the three side tabs. The program extrudes each profile along Z axis (floor plan 
profile), Y axis (frontal profile) and X axis (side profile) and then creates the intersection of these three solids. 
 

 Floor plan profile 
The profile defined here is extruded along the Z axis. 
 

 Frontal profile 
The profile defined here is extruded along the Y axis. 
 

 Side profile 
The profile defined here is extruded along the X axis. 
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You can select profiles from the favorites or from the existing profile libraries ( ). You can create ( ) custom profile 

or edit ( ) the current used profile. Custom profiles can be saved ( ) into the profile libraries. The orientation of a 

pre-defined profile can be modified ( ). 
 
Use the Width, Depth and Height input fields to check or modify the dimensions of the 3D shape.  

 Material 

On this tab you can define the material of the 3D shape. You can select materials from the favorites or from the existing 

material libraries ( ). You can also download materials from the web ( ) or create a new material ( ) or edit (

) the currently selected material. 

 General settings 

On this tab you can set general properties like line type, line thickness, color, priority, relative height. 
For the 2D representation, you can choose from three options: 

� Simplified: the 3D shape element is represented on the floor plan by its floor plan profile. 
� Symbol: the 3D shape element is represented on the floor plan by a selected group. Groups can be selected from the 

favorites or from the group libraries ( ). The selected group can be scaled ( ). 
� Top view: the 3D shape element is represented on the floor plan by the top view of its 3D model. 

 Save 

On this tab you can save the currently edited 3D shape element by the Save as button or you can select one from the 
favorites or from the object library for further modifications. Use the Reset button if you want to reset your 3D shape object 
to a default 3D shape element from the available template files. 
 

1.79.2. Loft 

Loft is a 3D solid with various cross sections and extruded along a path a path. The path can be straight or curved. 
 
Menu:  Building > Furniture Design > Loft 
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This picture displays 3D model of a chair leg where three different cross-sections are connected along the curved path. 

Cross-Section Steps 

Cross-sections can be defined by two methods: 
 
Selecting existing profile from profile library. 
Click first on the red circle icon and then click on the blue plus icon in the middle of the panel. 
Select the new cross-section with its reference point in the upcoming Profile dialog. Press Ok to return to Loft dialog. 
The selected profile will be inserted into the Favourites List. 
 

 
 
Drawing the geometry as a profile. 
When you draw the cross-section, you must also define its reference point. 
Click first on the red circle icon and then click on the yellow five-pointed star icon. The dialog disappears temporary and 
you can draw the cross-section in the 2D or 3D workspace.  
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When you finish the profile definition press ENTER and the dialog comes back again. 
 
Add next cross-section 
Use the “Prepare new” button on the left side of a panel. This button appears as green plus icon. 
You can define the place of the new cross-section along the path with the path slider or type its distance from the path 
starting or ending point. You can resize the new cross-section width and height or change its profile with clicking another 
profile from Favourites or as written in point 1 and 2 either. 
See on the picture below. The above-mentioned controls are marked with red frames. The new cross-section is displayed 
with green shape. 
You will add the new cross-section to the loft with clicking on the green tick button on the right side of the panel. 

 
 

  
 
Smooth fit 
Specifies that a smooth surface or sharp edge is drawn between the cross sections. See the smooth connection for the 
same loft below. 



746 10. Building model 

Manual 

 

 
 
Delete cross-section 
The actually selected cross-section is highlighted with red colour. You can select the previous or the next crooks-section 
with the Object index. 
The object index list appears at the left side of the panel on top of the Prepare new / Remove actual buttons. It consists of 
two numbers separated by a “/” mark. The first number is the sequence number of the current object. The second number 
is the total amount of the available objects. 
Click on “Remove actual” button to delete the actually selected cross-section. 
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Hotspot control 
 
The path intersects the cross sections on the cross section hotspot. Click on the black gear like icon to change the hotspot 
position. 
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Path definition 

Cross-sections can be defined by two methods: 
Path can be defined by two methods: 
 
Selecting existing profile from profile library. 
Click first on left on the path like icon and then click on the blue plus icon in the middle of the panel. 
Select the new profile in the upcoming Profile dialog. Press Ok to return to Loft dialog. 
The selected profile will be inserted into the Favourites List. 
 

 
 
Drawing the geometry as a path. 
Draw the path as a polyline before you start the Loft command. 
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Click on the yellow five-pointed star icon. The dialog disappears temporary and you can select the objects drawn 
previously in the 2D or 3D workspace.  
When you click on an object and the dialog comes back again. The new path is inserted into the Favourites List as 
CUSTOM PROFILE.  

 
 
Ending conditions 
 
You can edit the beginning and end section of a loft upon your design request as horizontal, perpendicular or vertical 
separately. See this example: 
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Enclosing box control 
 
The dialog displays the size of the actual path. Changing these values, you can stretch the loft in both direction. See this 
example: 

 
 

Orientation 
 
The loft can have a vertical or horizontal orientation. You can switch between horizontal and vertical in the dialog box 
Orientation list. See this example: 
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2D general properties 

The 2D general properties contain the loft 2D representation properties as Layer, colour, etc. In addition, you can choose 
the loft 2D representation as simplified, symbol or top view.  
 

  

Save loft into OLI library  

The Save panel allows you to save the 3D model into Objects library. The saved model will be inserted into the Favourites 
List, so you can choose it directly to continue the editing on it. The Save as button allows saving a new object with a 
different name. 
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1.79.3. Smart Object Parts 

Smart object parts is a revolutionary 3D solid creator tool that enables to design as an example upholstery furniture parts 
as seat, armrest or backrest cushion with textured surface.  
 
Menu:  Manufacture > Smart objects > Smart object parts 
 
Smart object part consists of two guides, a horizontal and a vertical guide and a cross section profile. Guide curves and 
cross section profile control the shape of the 3D solid. 
 

 
 
This picture displays the 3D model of a backrest cushion. 

Guide curves 

Guide curves are series of lines or curves that define the form of the solid. 
Guide-curves can be defined by two methods: 
 
Selecting existing open profile from profile library. 
Click on the blue plus icon in the middle of the panel. 
Select the new open profile in the upcoming Profile dialog. Press Ok to return to Smart object parts dialog. 
The selected profile will be inserted into the Favourites List. 
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Drawing the guide curves. 
Click on the yellow five-pointed star icon. The dialog disappears temporary and you can draw the guide curves in the 2D 
or 3D workspace.  

 
When you finish the guide curves definitions press ENTER and the dialog comes back again displaying the smart object 
part with the new guide curves. The new guide is inserted into the Favourites List as CUSTOM PROFILE. 

 
 
Modify the guide curves 
 
Use the “Modify profile” button on the left side of a panel. This button appears as pencil icon. 
You have to place the guide curves on the drawing and edit it with clicking on the curves or corner points. When you finish 
the guide curves definition press ENTER and the dialog comes back again displaying the smart object part with the new 
guide curves. See on the picture below. . 
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Vertical guide curves 

Vertical guide curves can be defined in the same way as horizontal guide curves. 
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Cross-Section 

Cross-sections can be defined by two methods: 
 
Selecting existing profile from profile library. 
Click first on the red circle icon and then click on the blue plus icon in the middle of the panel. 
Select the new cross-section with its reference point in the upcoming Profile dialog. Press Ok to return to Smart Object 
parts dialog. 
The selected profile will be inserted into the Favourites List. 
 

 
 
Drawing the geometry as a profile. 
When you draw the cross-section, you must also define its reference point. 
Click first on the red circle icon and then click on the yellow five-pointed star icon. The dialog disappears temporary and 
you can draw the cross-section in the 2D or 3D workspace.  
When you finish the profile definition press ENTER and the dialog comes back again. 
 
Modify the cross-section 
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Use the “Modify profile” button on the left side of a panel. This button appears as pencil icon. 
You have to place the cross-section on the drawing and edit it with clicking on the curves or corner points. When you finish 
the cross-section definition, press ENTER and the dialog comes back again displaying the smart object part with the new 
cross-section. See on the picture below. . 

 

 

Textured surface effects 

You can assign textured various surface effects to the front and backside separately: 
 
Add the first effect 
Use the “Effects” button on the top side of a panel. This button appears as textured surface icon. 
Chose an effect from the predefined list. When you click on an effect the dialog will display the appropriate parameters of 
the effect. You can set always the affected area and the effect geometry. 
You will add the new effect to the smart object part with clicking on the green tick button on the right side of the panel. 
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Add next effect 
Use the “Prepare new” button on the left side of a panel. This button appears as green plus icon. 
Choose another effect from the predefined list. When you click on an effect the dialog will display the appropriate 
parameters of the effect. You can set always the affected area and the effect geometry. 
You will add the new effect to the smart object part with clicking on the green tick button on the right side of the panel. 
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Delete an effect 
The actually selected Effect- is highlighted in the Favourites list. You can select the previous or the next Effect with the 
Object index. 
The object index list appears at the left side of the panel on top of the Prepare new / Remove actual buttons. It consists of 
two numbers separated by a “/” mark. The first number is the sequence number of the current object. The second number 
is the total amount of the available objects. 
Click on “Remove actual” button to delete the actually selected Effect. 
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2D general properties 

The 2D general properties contain the loft 2D representation properties as Layer, colour, etc. In addition, you can choose 
the loft 2D representation as simplified, symbol or top view.  
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Save smart object part into OLI library  

 
The Save panel allows you to save the 3D model into Objects library. The saved model will be inserted into the Favourites 
List, so you can choose it directly to continue the editing on it. The Save as button allows saving a new object with a 
different name. 
 

 
 

1.79.4. Furniture Assembly 

Furniture Assembly is a platform that integrates flexible tools to compose complex furniture that consists of multiple pieces 
and requires assembly. 

  
 
The dialog consists of the following easy to use 3D panels: 
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-Accessories: 

 
 
Accessories can be defined by this method: 
 
Click on an existing object, displayed with red enclosing box. 
Click on the green plus icon in the left side of the panel. 
The selected object will be duplicated displaying the new object. If you wish to select another one choose from the 
Favourites list or insert a new one with a click on the blue plus icon... 
The new object will replace the actually selected one. 
 

  
 
You can adjust the placement plane and reference point of this object by clicking on the green or red stickers on the 3D 
preview. 
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You can change the position and the orientation of the new object before fixing it with the green tick icon. 

 
The new object is integrated now into the assembly. 
There is no need to be very precise in this phase as you can change the position later as well. 
 

 

2D general properties 

The 2D general properties contain the loft 2D representation properties as Layer, colour, etc. In addition, you can choose 
the loft 2D representation as simplified, symbol or top view.  
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-Materials 

The furniture itself is composed of different materials. Using the Material Panel, you can change the material on the 
selected surface. 
 
All the same option: 
 
All the same option allows you to handle all the surfaces in one step when defining the material on their surfaces. When 
this option is on you can handle all similar surfaces together. When this option is off you can handle the selected surface 
only. 
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Save into OLI library  

The Save panel allows you to save the assembled 3D model into Objects library. The saved model will be inserted into the 
Favourites List, so you can choose it directly to continue the editing on it. The Save as button allows saving a new object 
with a different name. 
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1.80. KBB 

With the KBB tools, you can create furniture that fit in in shape and size. With the Cabinet door, Cabinet and Countertop 
tools you can create a complete cabinet family with base cabinets and high cabinets, countertops and kitchen accessories. 

1.80.1. Cabinet 2D/3D representation 

With the Cabinet 2D/3D representation function, you can specify the general properties for the floor plan and 3D 
representation of cabinets. 
The function is available:  
 

Main menu: Interior – KBB – KBB properties – Cabinet general properties 

Toolbox: Interior – KBB – KBB properties – Cabinet general properties  

 Cabinet doors in 3D window 

You can define the representation mode of cabinet doors and drawers in 3D modelling. You can hide all doors and drawer 
fronts at once. 

Closed Slightly open Totally open Without fronts 
 

 Distance of the automatic dimensioning 

It you switch the Automatic dimensioning option on, this parameter defines the distance of the first dimension line from the 
cabinet. 

  
Distance of the dimension line: 600 mm Distance of the dimension line: 1000 mm 

 Base cabinet 

With the Base cabinet options, you can specify the representation settings for base cabinets. 

Representation in 2D 

You can choose from different 2D representation modes, with which you can represent the cabinet elements even in 
simplified or top view. 

3D MODEL 2D REPRESENTATION 
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 Simplifie

d 
With 
closed 
doors 

With 
opened 
doors 

Symbol Top view 

Layer 

You can specify the layer of the cabinet on the floor plan. 

Colour 

You can specify the color representation of the cabinet on the floor plan. 

Line type 

You can specify the line type for the cabinet representation on the floor plan. 

Line width 

You can specify the line width for the cabinet representation on the floor plan. 

Automatic dimensioning 

If you enable the Automatic dimensioning option, you can represent the cabinet together with its dimensions on the floor 
plan. The properties of dimensions depend on the actual dimension properties. You can specify the distance of the 
dimension line from the cabinet by the Distance of the automatic dimensioning parameter. 

 Wall cabinet 

Custom settings for wall cabinets 

If you switch off the Custom settings for wall cabinets option, you can take the representation settings of wall cabinets from 
the Base cabinet settings. 
 
If you switch on this option, you can enable the custom floor plan representation settings like representation mode, layer, 
color, line type, line width and automatic dimensioning. 

 High cabinet 

Custom settings for high cabinets 

If you switch off the Custom settings for high cabinets option, you can take the representation settings of wall cabinets 
from the Base cabinet settings. 
 
If you switch on this option, you can enable the custom floor plan representation settings like representation mode, layer, 
color, line type, line width and automatic dimensioning. 

1.80.2. Cabinet door 

With the Cabinet door function, you can create the detailed model of cabinet fronts. 
The function is available in Manufacture – KBB Manufacturer Tool – Cabinet door. 

 Dialog structure 

The structure of the Cabinet door dialog is the following: 
� On the top of the dialog, you can see the preview of the model. 
� On the bottom of the dialog, you can edit the model and define the preview. 
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Preview buttons 
 

 Click this button to select from Realistic / Hidden line / Wireframe / X-ray previews. 

 Undo button to undo the last operation. 

 Redo button to reverse the last undo operation. 

 Structure button to browse among the added/edited elements/editorial pages.   

 Zoom in button to enlarge the preview of the model. 

 Zoom out button to zoom out the preview of the model. 

 Update button to update the preview manually. 
Automatic refresh on page. With this option, you can automatically update the preview of the model as soon as you 
change something on it. 

Tabs of pages for editing and saving 
Depending on the modifications you want to make, different pages are available: 

 Frontal profile to set the profile and materials of the cabinet front. 

 Outer edges to set the rounding of edges and the angle of edges. 

 Inset to set the profile and materials of inset. 

 Hole to define the profile and materials of holes. 

 Subtract profile to remove a swept profile as ornament from the cabinet front. 

 Add profile to add a swept profile as ornament to the cabinet front. 

 Handle to add handle to the cabinet front. 
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 General settings of the representation on the floor plan. 

 Save to save the prepared cabinet door in the object library. 
 
On each tab, you can find subsequent tab(s) for further editorial functions. 
  
You can leave the dialog with clicking the Ok, Cancel, or Close buttons. When you click Cancel or Close, the program 
asks for a confirmation. 

 Frontal profile 

On the Frontal profile tab, there are four subsequent tabs on the left side. The functions of the tabs are as follows. 

 Frontal profile 

Here you can define the frontal profile of the cabinet door. There are more ways to define the profile: 

� Selection from the library. Klick the  button to open the Profiles dialog, where you can select from the existing 
library elements. The selected profile appears in the favourites. 

� Selection from favourites. When you select a new element from the library, it appears in the favourites. The frequently 
used and factory default elements can be found here. To select, click one of them with the left mouse button. To remove, 
click one of them with the right mouse button. Apply the Remove from favourites or the Remove multiple items from 
favourites command from the local menu. The Remove from favourites command removes one item. The Remove 
multiple items from favourites command pops up a subsequent dialog, where all the favourites are listed. In that dialog 
you can select multiple items from the favourites and you can remove them by clicking OK. 
 

 

� Define profile. Click the  icon, with which you can create a new profile on the floor plan. As soon as you finished the 
definition of the profile, it appears among the favourites with a unique symbol. 

  

 
 

Click the  save button on the right side if you want to save that custom profile into the library for using it later. The 
unused and unsaved profiles are deleted automatically from the favourites when you exit from the dialog. 

� Modify profile. By clicking the  modify profile icon you can modify both custom and other profiles from the favourites. 
If there is a custom profile and then you modify another profile from the favourites, the latest modified profile becomes the 
custom profile and the previous custom profile will be lost. 
 

 !  Important to know that only one custom profile can exist among the favourites. Any new custom profile 
definition overwrites the previous one. Also, you cannot delete a custom profile from favourites. Unused 
custom profiles are deleted automatically when you exit from the dialog. 

Modifying the properties of a not customized profile 
The properties of not customized profiles among the favourites can be modified as follows: 
Width. You can select a value from the drop-down list on the right side or you can enter another value in the input field. 
Height. You can select a value from the drop-down list on the right side or you can enter another value in the input field. 
Resize profile. The effect of changing the width/height of the profile depends on this choice. From the drop-down list, you 
can select between Rescale and Cut and stretch. The Rescale option stretches the width and the height of the profile. 
The Cut and stretch option works different: the program takes the contour parts of the profile that intersect the 
symmetrical axis of the profile and then stretches these contour parts according to the specified width and height values. 
The rest of the profile remains unchanged. 
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For example, when you want to make the width of the profile below double, the following happens:  
 

  
 
This is the symmetrical axis and the contour parts incorporated: 

 
This is the result: 

 

Modify profile 

Use the  modify profile button to modify the selected profile. Clicking this button, you can place the profile on the floor 
plan and edit it by the edit profile commands. You can finish the editing by pressing Enter. If it was not a custom profile 
previously, it becomes a custom profile after the modification.  
 

To modify a non-custom profile, you can use the  profile modification button, too. Clicking that button, the Insert 
profile dialog appears, where you can select the reference point of the profile, rotate or mirror it. The width and height 
parameters in the Insert profile dialog may differ from the actual width and height data of the profile. When you modify 
these values here, the actual width and height values will be overwritten. Click OK to finish the modification. 

Thickness 
The thickness of the cabinet door can be specified on the bottom of the dialog. You can select a value from the drop-down 
list or enter another value. 

Orientation 
On the left side of the dialog, there is a drop-down list to specify the orientation of the cabinet door. You can select 
between Vertical and Horizontal options. 

 Front material 

Here you can specify the front material of the cabinet door. There are more ways to specify the material: 
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� Selection from the library. Click the  button to open the Materials dialog, where you can select a material from the 
material library. The selected material appears among the favourites. 

� Selection from the favourites. The most commonly used materials are here. For the selection, click one of them with the 
left mouse button. To remove, click one of them with the right mouse button. Apply the Remove from favourites or the 
Remove multiple items from favourites command from the local menu. The Remove from favourites command 
removes one item. The Remove multiple items from favourites command pops up a subsequent dialog, where all the 
favourites are listed. In that dialog you can select multiple items from the favourites and you can remove them by clicking 
OK. 
 

 

� Create new material. Click the  button to create a new material. The Material properties dialog pops up, where you 
can create a new material. The newly created material gets into the favourites automatically. 

� Importing an image. Click the  button. You can select whether you want to download an image from our webpage in 
the Showroom or from the internet, by which you can define a material.  

Edit material 

Click the  button to modify the selected material in the Material properties dialog.  

Material direction 
On the bottom of the dialog, you can specify a rotation angle relative to the material direction specified in the Material 
properties. You can select a value from the drop-down list or enter another one in the input field. 

 Back material 

Here you can define the back material of the cabinet door. By default, the back material inherits its material properties 
from the front. When you want to specify a different back material then check the Use custom material option and follow 
the same process described for the front material settings.  

 Side material 

Here you can define the side material of the cabinet door. By default, the side material inherits its material properties from 
the front. When you want to specify a different side material then check the Use custom material option and follow the 
same process described for the front material settings. 

 Outer edges 

On the Outer edges page you can define the rounding of edges and the angle between the front and side planes of the 
cabinet door. 

Rounding the edges 
You can round either all edges or certain edges. 

• Check the Round all edges option when you want to round all edges. 

• Specify the side rounding value. Select a value from the drop-down list or enter another value in the input 
field. 

• Switch off the Round all edges option if you want to round only certain edges. 

• To round the side/front/back edges, select the appropriate values from the drop-down lists or enter the 
values manually in the input field. 

Angle between the front and side planes 
You can define the angle between the side and front planes. 

• Check the Same angles option if you want to set the same angle between the front plane and all side planes. 

• Specify the edge angle. Select a value from the drop-down list or enter a different value in the input field. 

• Switch off the Same angles option if you want to specify different angles between the front and side planes. 
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• Specify the top edge angle/right edge angle/bottom edge angle/left edge angle. Select a value from the 
drop-down list or enter a value in the input field. 

 Inset 

On the Inset page, you can define different insets. There are three subsequent tabs on the left side to define the profile, 
the front material and the side material of the insets. 

 Frontal profile 

There are more ways to define the frontal profile of an inset. The process is the same as you can define the frontal profile 
of the cabinet door. 

Automatic profile 
You can always find this profile with its unique symbol among the favourites. The automatic profile means that the profile 
follows the frontal profile of the cabinet door with a shift. In that case, you cannot resize the profile. 
 

! The modification of an inset profile works the same way as for the frontal profile of the cabinet door. 

Aligning the inset profile to the frontal profile 
The selected inset profile can be aligned to the frontal profile of the cabinet door. For this, you can use the Same offsets 

option and the lock buttons ( , ). 

• Switch on the Same offsets option and the locked status of the lock button ( ) if you want to use the 
same offsets relative to the front profile of the cabinet door on all sides. In this status the X offset and Y 

offset values are not editable.  

• Switch off the Same offsets option and use the appearing lock buttons if you want to apply different offsets 
relative to the front profile of the cabinet door on the sides. 

• To define the width/height and X/Y offset values of the inset profile, use the values in the drop-down list or 
enter other values in the input fields. 

 

! Depending on the shape of the used inset profile and the status of the lock buttons, the width/height and 
X/Y offset values may not modifiable. 

Inset depth 
On the bottom of the dialog, you can specify whether the inset should sink into the cabinet door or stand out. Negative, 
Positive and No depth options are available in the drop-down list. 

• Use the Negative option if you want the inset sinking into the front of the cabinet door. 

• Use the Positive option if you want the inset standing out from the front of the cabinet door. 

• Use the No depth option if you want the inset to be on the plane of the front of the cabinet door.  

• In case of selecting the Negative or Positive option, you also have to select a depth value from the drop-
down list or enter a value in the input field. In case of Negative option, the depth value must be smaller than 
the thickness of the cabinet door. 

Adding/deleting insets and switching between insets 
For a cabinet door, you can define more insets. 

• After specifying the properties of an inset, click the  button to add the inset to the cabinet door. 

• If you want to add more insets, click the  button and set the properties. To add the inset, click the  

button. To cancel the new inset definition, click the  button. 

• Repeat the steps above until you reach the required number of insets. When you add more insets, you can 

use the appearing arrow buttons ( , ) to step forward to the next inset or step backward to the 
previous inset you defined previously. You can modify the properties of the actual inset. 

• To delete an inset definition, click the  button. 
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• The new inset that hasn’t been added yet is represented by green color in the preview. The previously added 
and selected inset is represented by red color in the preview. The previously added and not selected insets 
are represented by blue color in the preview. 

 Front material of inset 

On this page, you can define the front material of the defined insets. The process is similar to the material setting of the 
back material of the cabinet door.  

 Side material of inset 

On this page, you can define the side material of the defined insets. The process is similar to the material setting of the 
back material of the cabinet door. 

 Copy and  paste function 

On the Inset, Hole, Subtract profile and Add profile pages it is possible to copy certain properties from one element to 
another. The function works only inside the same pages between the elements. All the properties will be copied that do not 
concern the shape and position of a frontal profile. 

• After specifying the properties of an actual (an existing or new) element, click the  button. 

• To modify the properties of an existing element, or when you create a new element, click the  paste 
button. 

 Hole 

On the Hole page you can define different hole profiles. Optionally, you can fill the holes with materials. It is usually used 
to create glass insets. 

 Hole frontal profile 

Similarly to the process described for the insets, it is possible to add different profiles. The defined profiles will be cut out 
from the cabinet door and then filled with material with a specified thickness.  

• In the Thickness field, you can define the thickness of the filling material. 

• In the Offset field you can specify position of the filling relative to the middle of the section of the cabinet 
door. 

 Filling material 

On this page, you can define the filling material of the hole, similarly to the back material definition process for the cabinet 
door. 

• Switching on the Empty hole option you can vanish the filling material, so there will be a hole in the cabinet 
door. 

 Side material of the hole 

On this page, you can define the side material of each hole, similarly to the process described for the cabinet door side 
material.  

 Subtract profile 

On the Subtract profile page, you can create different cuttings along a path. You have to define the path, the section 
profile used for the cutting and the material of the cutted surface. 

 Frontal profile 

Similarly to the process described for the inset, you can add different profiles. The program creates cutouts in the cabinet 
door along the path defined by the profile. 

 Section profile 

On that page, you can define the section profile of the cutout that goes along the path defined by the frontal profile. The 
definition of the section profile goes the same way as the definition of the frontal profile. 
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• Select the desired profile. The position of the profile appears on a point of the cutting path in the preview 
window. The reference point of the profile matches to this point. 

• By specifying the X offset and Y offset values you can modify the position of the reference point. X and Y 
directions are represented by green and red marker arrows. 

• With the  button you can modify the properties of the profile, mirror on X or Y axis, for example. For 
example if you want to create the same cutting on the front and the back of the cabinet door, then first you 
have to mirror the profile on the X axis and then you have to offset it along the Y axis by a negative value, 
with the thickness of the cabinet door. 

 Material 

On that page, you can define the material of the cutted surface if you check the Use custom material option. 
 

 Add profile 

On the Add profile page, you can add different section profiles along a path to the surface. Usually you can use it to add 
mouldings to the frontal surface of the cabinet door. You have to define the path, the section profile and the material of the 
moulding. 

 Frontal profile 

Similarly to the inset profiles, you can add different profiles. The program adds a swept section profile to the cabinet door 
along the path defined by the frontal profile.  

 Section profile 

It works similar to the section profile described for the subtract profile with the difference that it adds material to the cabinet 
door instead of cutting out. 

 Material 

On that page you can define the material of moulding. Check the Use custom material option if you want to apply a 
material different from the material of the cabinet door.  
 

 Handle 

On that page, you can add one handle by specifying its properties on two subsequent tabs. 

 Door handle 

Here you can select the handle and its position. 
The ways of selecting a handle: 

� Selection from the favourites. 

� Selection from the object library with the  button. The selected object appears among the favourites. 

� Creating a new object with the  button. The created object appears among the favourites as a custom object that can 

be modified by the  button or save with the  button. 
 

The properties of a non-custom object can be modified with the  button. The selected handle appears in the preview. 
Once you have a selected handle, you can make it disappear only with the Hide object option. 
In the preview window a dotted blue line appears. This is the bounding box of the placement area of the handle. 
With the Stretched option, you can stretch the handle to the borders of the bounding box. 
On the left side of the page, you can find a 3x3 radio button matrix, with which you can position the handle inside the 
bounding box.  
In addition, you can mirror the handle with the Mirror option, and rotate around the main axis by specifying the Rotate X / 
Rotate Y / Rotate Z angle values. Also, you can offset the handle along the main axis by specifying the Offset left/right, 
Offset front/back, Offset down/up values. By using the offset, rotate and mirror options the handle can get outside of the 
bounding box, of course. 
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! Only one handle can be added to a cabinet door. 

 Border for handle placement 

Here you can specify a profile that is represented by a dotted line. The handle is placed inside the border defined by this 
profile (not taking the shifting, rotating and mirroring into consideration).  
 

 General settings 

On that page you can specify the general settings of the cabinet door like line type, line thickness, color, priority, relative 
height. For the floor plan representation setting, use the Representation in 2D drop-down menu. 

� Simplified – the cabinet door is represented by a rectangle on the floor plan. 
� Top view – the cabinet door is represented on the floor plan by the top view of its 3D model. 

� Symbol – you can select a group from the favourites or from the existing library elements ( ) or you can modify the 

properties of the selected element ( ).  

  Save 

On that page you can save the actual element in the object library or you can select from the favourites or from the 
existing cabinet door elements to modify those. The saved element will be listed among the favourites so you can select it 
or modify it later.  
With the Save button you can resave the element with the same name. 
With the Save as button, you can save the actual element with another name. 
The text you type in the Description field will be saved along with the element. 
With the Reset button, you can select from the available default styles. Default styles may belong to each loaded template 
(see Design center – Templates). 

1.80.3. Cabinet 

With the Cabinet tool, you can create detailed models of cabinets. 
The availability of the function:  
 

Main menu: Manufacture – KBB Manufacturer Tool – Cabinet 

Toolbox: Manufacture – KBB Manufacturer Tool – Customized Cabinet 

 Dialog structure 

The structure of the Cabinet dialog is the following: 
� On the top part of the dialog you can see the preview of the model. 
� On bottom part of the dialog you can edit the model and define the preview. 
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Preview buttons 
 

 Exploded 3D model view. You can select from Not exploded, Slightly exploded and Totally exploded options. 

 Cabinet representation mode. You can select from Closed, Slightly open, Totally open and Without fronts options.    

 Click this button to select from Realistic / Hidden line / Wireframe / X-ray previews. 

 Undo button to undo the last operation. 

 Redo button to reverse the last undo operation. 

 Structure button to review and select cabinet side panels. 

 Zoom in button to enlarge the preview of the model. 

 Zoom out button to zoom out the preview of the model. 

 Update button to update the preview manually. 
Automatic refresh on page. With this option, the preview of the model is automatically updated as soon as you change 
something on it. 

Tabs for the editing and saving operations 
Depending on the type of modification, different tabs are available: 

  Sizes to define the general dimensions. 

  General cabinet door properties to define the default door and handle settings. 

  Default side panels to define the default side panel settings. 

  Default edge properties to define the default edge connection rules. 

  Default drawer, shelf and leg properties to define the default drawer, shelf and leg settings. 
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  Shape to define conventional or custom shape of the cabinet. 

  Custom panel properties to define the custom properties of the sides of the cabinet. 

  Custom edge properties to set the edge connection rules of the sides. 

  Dividers to divide the cabinet to create shelves or invisible sections. 

  Doors to place the fronts of the whole or the divided cabinet. 

  Drawers to define the drawers with or without fronts. 

  Appliances to place built-in household appliances. 

  Legs to define custom legs. 

  General settings to define floor-plan representation settings. 

  Save to save the cabinet into the library. 
 
On each tab you may find subsequent tabs for further editing. 
  
You can leave the dialog with clicking the Ok, Cancel, or Close buttons. When you click Cancel or Close, the program 
asks for a confirmation. 
 

  Sizes 

On that page you can specify the main dimensions of the cabinet and the cabinet type for the case you want to place it 
with the auto layout function. 
 

 
 

 

The Width (a), Depth (b) and Cabinet height (c) parameters define the outer 
dimensions of the cabinets. The leg dimensions are not included in that shape. The 
Total height (d) includes the leg dimensions, too. Also, the fully overlayed doors and 
the handles are excluded from the main dimensions. 

 

 
 

With the lock   buttons, you can define whether the Cabinet height or the Space for legs parameter should 

follow the change when you modify the Total height parameter. The locked  parameter value stays unchanged. 

Width 

Total width of the cabinet, excluding the cabinet door. 

Depth 

Total depth of the cabinet, excluding the cabinet door. 

Total height 

Total height of the cabinet, including the legs and excluding the cabinet door. 
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Cabinet height 

Height of the cabinet, excluding the legs and the cabinet door. 

Space for legs 

The height of legs. 

Cabinet type 

The function of the cabinet in the case when it is placed with the auto layout tool. 

  Default door front and handle 

 Default door front  

For default door front, you can choose a Cabinet door, a Cabinet family or any other object. On each door, drawer or 
built-in appliance this front will appear, except when you define a custom one. 

� Door type. This option is available only when you select a Cabinet family as default door front. In that case, you can 
specify which member of the family (glass-front cabinet door or panel cabinet door) should be the default. 

  
 

Regarding the use of Cabinet and Cabinet family elements, see chapter 1.80.4. 
For the details of custom fronts, see chapter 1.80.5. 
 

 Default handle 

You can select any object for default handle. Unless you define custom handle, this appears on each door, drawer and 
built-in appliance. 

  Default side panel properties 

For default side panels you can select a Cabinet door element or any other object. Except with the front, the selected 
panel appears on each side, except when you specify a custom object at the specific side. 
 
Regarding the use of Cabinet and Cabinet family elements, see chapter 1.80.4. 
Regarding the use of custom side panels, see chapter 1.80.3.8 and chapter 1.80.5. 

 Side panel 

The side panels of the cabinet. If there is no other definition for the Top, Back and Bottom panels, the side panels 
settings are applied. 

 Top panel  

If the Apply side panel properties for top panels option is switched off, a different default top panel can be defined. 
Unless a custom top panel is defined, the default top panel will be applied in each case. 

 Back panel 

If the Apply side panel properties for back panels option is switched off, a different default back panel can be defined. 
Unless a custom back panel is defined, the default back panel will be applied in each case. 

 Bottom panel  

If the Apply side panel properties for bottom panels option is switched off, a different default bottom panel can be 
defined. Unless a custom bottom panel is defined, the default bottom panel will be applied in each case. 
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  Default edge connection 

 On that page you can define the default edge connection rules. 
Regarding the use of custom edge connections, see chapter 1.80.3.9 

 Default drawer, shelf and leg 

 The default drawer, shelf and leg settings are applied to all identical element types. On the element specific pages 
you can define different drawer, shelf and leg, too. 
 
Regarding the use of Cabinet and Cabinet family elements, see chapter 1.80.4. 

 Drawers 

Any object can be chosen as default drawer. At the custom drawer page, you can modify the settings defined here. 
Choose the drawer that you use generally for the cabinet. 

 Shelves (dividers) 

For default shelf, you can choose a Cabinet door element or any other object. 
If the Apply side panel properties for dividers option is switched off, you can define a default shelf that is different from 
the side panel.  

 Legs  

You can choose any object for default leg. With the Hide legs option you can switch off all legs. 

  Cabinet shapes 

 To define the shape of a cabinet, you can choose from predefined shapes (cuboid, L shaped corner cabinet, 
pentagonal shaped corner cabinet), or you can define a custom shape, too. 

 

Default cuboid shape 

 

 

Corner cabinet shape.  
The depth of the corner cabinet (m) can be defined by the Block depth value.  

 

 

Custom shape. For a custom shape, you can choose any object that is made of a single 3D 
solid. 
Regarding the use of custom shapes, see chapter 1.80.3.17. 

Choose a custom shape on the  Custom shape tab. (Again, if you want to choose from 

the default cabinet shapes, you can do it on the Cabinet shape  tab.)  
 
If you change the shape of a cabinet with existing dividers, a question appears, with which you can decide to keep the 
current structure of dividers or you want to start again with a new cabinet without dividers. 

Custom cabinet shape 

When you select Custom from the Cabinet shape list, the Custom shape tab appears with the list of available custom 
shapes. 
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You can add your own custom shapes to the available default custom shapes by selecting them from the object library. 

  Custom panel properties 

 On that page you can set the properties of each cabinet side panel. The cabinet side panels can be selected by 

either clicking them in the  structure window or using the next/previous arrows . The following settings can 
be made on the selected panel. 

 Role of side 

The role of each side of the cabinet can be set here. The role of a side can be 
• front panel (where dividers, drawers, shelves etc. can be created) 
• side panel 
• top panel 
• back panel 
• bottom panel (where you can add legs). 
The role of a cabinet side determines which default side panel properties should be applied on the side.  
For the default side panel properties see chapter 1.80.3.4. 
Regarding the use of custom shapes, see chapter 1.80.3.17. 
 
In the preview window the selected side panel is marked by red lines. The actual role of the selected side panel appears in 
the list of roles. If you want to change the role, click another role in the list of roles.  

 Custom side panel  

Here you can set different properties of the selected cabinet side than the default side panel settings. 
For the use of custom elements, see chapter 1.80.5.  

• Apply the default 

When the Apply the default option is on, the custom side panel settings are not available. In that case, the panel properties 
are based on the default settings. When the Apply the default option is off, you can choose a panel from the available list. 

• Hide object 

You can switch off the custom panel by the Hide object option. When the Hide object option is off, the selected panel 
appears on the selected side. 

• Use original item side 

Using this option, the selected element does not fit to the size of the cabinet but it keeps its original size. 

• Rotate X 

The selected element slants forth or back, depending on the specified angle. 

• Rotate Y 

The selected element slants right of left, depending on the specified angle. 

• Rotate Z 

The selected element turns around its vertical axis to the left or right, depending on the specified angle. 

• Mirror 

Use this option to mirror the selected element. 

 Frontal profile 

Here you can modify the shape (frontal profile) of the selected side panel. 
Regarding the modification of the shape of the side panels, see chapter 1.80.6. 
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 Custom edge properties 

 On that page you can set each edge of the corpus shape. The edges can be selected in the preview window by 

mouse click or by the pager buttons . The following settings can be applied to the selected edge. 
 

 

Full overlay or traditional – At joining, the surface of the ending of one panel fits to the other 

panel’s inner surface. 

 

Bevelled edge – At joining the endings of the panels are cut along the bisector of the angle.  

 

Custom – Use this joining mode when the joining surfaces of the joining edges are prepared for the 

correct joining. In that case, both joining panels are represented without any change. 

 

  Dividers 

 Here you can create, modify or delete dividers at the front side of the cabinet. Regarding the creation of 
fronts, see chapter 1.80.7. 

 Position of dividers 

On that page you can specify the position of dividers inside the cabinet. 
• Type of dividers – you can select from single horizontal, single vertical, multiple horizontal, multiple vertical and single 

custom division types.   
When you apply multiple horizontal or multiple vertical division types, the created shelves will be identical and you can 
change them as a whole unit.  

• Shelf / Only division – it is possible to create real shelves (with thickness and material) or logic (without solid) 
divisions. 

 
Shelf 
 

 
Only division 
 

For this latter you need in case of a base cabinet, for example, where you want to place a shelf above a cabinet door – in 
that case you must divide the front with a single horizontal divider and then you can place the shelf to the top part and a 
door to the bottom part. 
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• Position – In case of single division, you can specify the position of the divider here. With the lock   
buttons you can control the behaviour of the divider in case of changing the dimensions of the cabinet: the locked 
value remains unchanged when you change the dimension of the cabinet. If none of the locks is closed, the ratio of 
the division values remain unchanged. 

 
Divider in the middle  

 

 
Divider position is 20 cm 
from top  

 

 
Divider position is 20 cm 
from bottom  

 

• Distribution – when you choose multiple division, you can specify the distribution of dividers. Regarding the 
distribution of dividers, see chapter 1.80.8. 

• Divide on front – here you can specify whether the position of the shelves should defined by the distance between 
shelves or the dimension of the cabinet front. 

 

 
Distribution is based on the distance 
between shelves: when specifying the position 
or distribution, the values mean the distance 
between shelves. In case of even distribution, 
the distances between shelves are the same.

 

 

 
Divide on front: when specifying the position or 
distribution, the values mean the dimensions of 
the fronts in front of the shelves. In case of even 
distribution, the distances between shelves are 
not the same. 

 
 
 
• Align front door edges – fronts in front of the shelves can be aligned to the top, middle or bottom of the shelves. It is 

also possible to use Custom offset.  
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Top shelf edge 

 
Middle of the shelf 

 
Bottom shelf edge 

 
Bottom shelf edge 
with positive 
custom offset 

 Custom shelf 

Here you can set the custom properties of the selected shelf if it is different from the default. 
About the use of custom elements, you can read in chapter 1.80.5.   

 Profile of the shelf 

Here you can modify the top view profile of the selected shelf. 
Regarding the modification of the shape of the shelves, see chapter 1.80.6. 

  Doors 

 Here you can place, modify or delete doors on the cabinet front. Regarding the fronts, see chapter 1.80.7. 

 Opening 

On that page, you can define the type of opening. 
• Opening – you can set doors with opening directions to the left or right, flip up, flip down, fix, 2, 3 or 4 sided, 

sliding, multiple side and bifold doors. 

  
When you create a door with more wings, the created wings will have the same size, you can change them only as a 
whole.  

• Opening right / left – in case of doors with left or right type, you can specify the opening direction. 
• Full overlay / traditional – see chapter 1.80.10. 
• Opening – the extent of opening can be set here in percentage. 

 Custom door  

Here you can set the custom properties of the selected cabinet door if it is different from the default. 
About the use of custom elements, you can read in chapter 1.80.5. 

 Custom handle  

Here you can choose a handle for the selected door if it is different from the default. About handles, see chapter 1.80.9. 

 Door frontal profile 

Here you can specify the frontal profile of the selected door. 
About the modification of door shapes, see chapter 1.80.6. 

 Drawers 

 Here you can place, modify or delete drawers on the cabinet front. For the details of editing fronts, see 
chapter 1.80.7. 

 Drawer  

On that page, you can specify the distribution of drawers. 
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• Type of drawer – you can define drawers with or without fronts, single or multiple drawers.  

  
When you create multiple drawers, the drawers will be the same; you can handle them as a whole.  

• Distribution – when you choose multiple drawer type, you can specify the allocation of the drawers. For more 
information, see chapter 1.80.8. 

• Full overlay / traditional drawer front – for more information about fronts, see chapter 1.80.10. 
• Opening – the extent of opening can be set here in percentage.  

 Custom drawer  

If you do not use custom drawer settings, the default drawer described in chapter 1.80.3.6. will be applied, where the width 
and depth values follows the dimensions of the corpus. 
On that page you can define custom drawer settings if the default drawer is not applied. For more information about 
custom elements, see chapter 1.80.5. 
• Gap – the distance between the drawer body and corpus sides, and the distance between the bottom of the drawer 

body and the divider lines.   
  

 Custom drawer front 

When you have drawers with fronts, here you can specify the custom settings of the fronts if you do not apply the default 
front settings. 
For more details about custom elements, see chapter 1.80.5.   

 Handle 

When you have drawers with fronts, here you can specify the custom settings of the handle for the selected front if you do 
not apply the default handle settings. For more details about handles, see chapter 1.80.9. 

 Frontal profile of the drawer front 

When you have drawers with fronts, here you can specify the frontal profile of the selected drawer. For more information 
about drawer fronts, see chapter 9.19.6. 

 Appliances 

 Here you can create, modify or delete kitchen appliances on the cabinet front. For more details, see chapter 
1.80.7. 

 Selecting a kitchen appliance  

On that page, you can choose the required kitchen appliance. If you do not apply custom settings, the selected object 
automatically fills the room available inside the corpus (its depth, length and height fit the inner dimensions of the cabinet). 
For more details about the object settings possibilities, see chapter 1.80.5. 
• Gap – you can specify the distances between the kitchen appliance and each side of the cabinet (top, bottom, left 

side, right side).  
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 Kitchen appliance front 

Here you can add a front in front of a built-in kitchen appliance, if necessary. 
• Front type – you can set built-in kitchen appliance with front with left or right opening directions or with flip down front.  

  
• Full overlay / Traditional – about full overlay and traditional fronts, see chapter 1.80.10. 
• Left / Right – for the Left or Right type fronts you can select between left and right opening directions. 
• Opening – the maximum limit of opening angle can be specified here in percentage. 100% stands for 90°. 

 Custom front 

If you apply a kitchen appliance front, here you can set its custom settings if not the default settings are applied. 
About custom setting possibilities, see chapter 1.80.5.   

 Handle 

If you apply a kitchen appliance front, here you can add handle to it. About handles, see chapter 1.80.9. 

 Frontal profile of the front 

If you apply a kitchen appliance front, here you can modify the frontal profile of the selected front. About the modification of 
frontal profile, see chapter 1.80.6. 

 Legs 

 Here you can specify custom legs for a cabinet. You can add any object as a leg and you can define the distribution 
of legs. 

 Cabinet legs 

Here you can apply custom settings for the legs defined on the Default drawer, shelf and leg properties page. 
� When Apply the default setting option is on, the settings specified on the Default drawer, shelf and leg page remain. 

When this option is off, you can specify custom leg by selecting an object that can be mirrored, rotated and shifted relative 
to the default leg allocation. 

� When Use original item size option is on, the object appears with its original dimensions, instead of the specified leg 
height. 

� When Hide object option is on, you can hide the legs individually. 
� With the left and right arrow buttons you can switch between legs. 

 Distribution of legs 

On that page, you can specify a profile that defines the allocation of legs by its vertices.  
� In case of Automatic profile, the shape of the bottom side of the cabinet defines the profile. 
� In case of custom profile, you can define or modify a custom profile. 
� You can also select profile from the existing profile library. 
� You can resize the defined profiles. 

 

  General settings 

The  General settings tab serves the settings like line type, line thickness, color, priority, relative height. For 
specifying the 2D representation, select from the Representation in 2D drop-down menu.   

� In case of Simplified selection, the cabinet will be represented by contour lines on the floor plan. 
� In case of With closed doors selection, the cabinet will be represented similarly to the simplified representation, including a 

closed door representation. 
� In case of With opened doors selection, the cabinet will be represented similarly to the simplified representation, including 

a slightly opened door representation. 
� In case of Top view selection, the cabinet will be represented on the floor plan by the top view of its 3D model. 
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� In case of Symbol selection you can select a group from the favorites, from the existing library group elements ( ) or 

you can modify the properties of the selected group ( ).   

  Save 

On that page, you can save the actual element in the object library or you can select from the favourites or from the 
existing cabinet elements to modify those. The saved element will be listed among the favourites so you can select it or 
modify it later.  
With the Save button you can resave the element with the same name. 
With the Save as button you can save the actual element with another name. 
The text you type in the Description field will be saved along with the element. 
With the Reset button you can select from the available default styles. Default styles may belong to each loaded template 
(see Design center – Templates). 

 Creating custom cabinet shapes 

You can define cabinet shapes by different objects from the existing object library or by individually created objects. 
Objects can be created by different methods and this way various shapes can be defined. 
 
For custom cabinet shapes, you can only use objects that consist of one piece of solid. You can easily create such a 
custom shape object from wall, slab or 3D modelling tools. The Manufacture menu – Shape command is a dedicated tool 
for this purpose. 

Example: Built-in cabinet under a stair 

� Create the stair with the stair commands of ARCHLine.XP. 
� In the stair properties dialog on the Support page, use the Cut the walls option to cut the wall above the stair. 
� Draw a wall under the stair. If necessary, update the 3D model to cut the wall above the stair. 
� Create an object from the wall by the Manufacture menu – New object – New object tool. 

The object defined this way consists of one piece so it can be used as custom cabinet shape. 

1.80.4. Using cabinet doors and cabinet door families for cabinets 

You can use any object for the sides or for the shelf of a cabinet. 

When you apply a Cabinet 
door element, the element 
follows the shape of the door 
or shelf. The handle on the 
cabinet front appears with the 
settings made in the handle 
properties of the cabinet. 

When you apply a Cabinet 
door family element, the 
appropriate member of the 
family is represented. On the 
custom cabinet door page the 
Custom door type option 
appears. With this option, you 
can define if the door should 

When you apply an Object 
element for the cabinet sides 
or for shelf, the dimensions of 
the object follows the 
dimensions of the cabinet but 
its shape does not change. 
The required handle must be 
included in the selected object 
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be a Panel cabinet door or a 
Glass-front cabinet door. The 
handle on the cabinet front 
appear with the settings made 
in the handle properties of the 
cabinet. 

because the handle setting 
made in the handle properties 
of the cabinet are not 
applicable in that case. 

1.80.5.  Using default and custom settings 

At start, all parts of the cabinet (cabinet front, cabinet side panels, shelf, leg etc.) appear with the default settings 
(see chapter 1.80.3.3, 1.80.3.4 and 1.80.3.6). However, it is possible to change the default settings of each part: 

• Apply the default – by switching off this option you can specify a shape or object that is different from the default.  
• Hide object – with this option you can switch off (hide) the cabinet element. 
• Use original item size – by default, the cabinet tool resize the selected object to make them fit to the current shape 

of the cabinet (see chapter 9.19.4). Using this option, the object appears with its original dimensions. In that case, the 

dimensions of the cabinet element can be set individually by the Modify object  or Object properties  
buttons, depending on the type of element. 

1.80.6. Modifying the shape of fronts, cabinet side panels and shelves 

You can modify the shape of fronts, side panels and shelves of the cabinet by offsets and profile editing commands. 
This way you can create even a detailed model of a complex cabinet. 

 Handling and editing profiles 

Automatic profile 

You can define the shape of fronts, side panels and shelves by different profiles. Among the available profiles, the 
so-called automatic profile has a major importance because with this you can define a profile that follows the 
shape of the current cabinet, instead a fix profile. The automatic profile appears in the list of available profiles with 
the following icon:  

 

Profile editing 

You can freely edit a profile with the  button. This freely defined custom profile appears in the list with the 
following icon: 
 

 

 Defining offsets for predefined profiles 

In case of predefined profile (profile from the library), the shape of the profile is the selected fix profile. You can 
influence the dimensions of this fix profile by different offsets and stretchings. 

Resizing of profile 

You can modify the dimensions of a predefined profile (profile from the library) with two options: 
� Resizing 
� Cutting and stretching 

About resizing of profile, see chapter 9.19.2.2. 
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Same offsets 

 
With the Same offsets option you can specify the same offsets in the main four directions. Switch off the option if 
you want to apply different offsets in each direction. For example, if you want to reduce the size of a shelf only in 
the cabinet front direction, you can achieve it by switching off the Same offsets option and then applying a positive 
offset value in the cabinet front direction. 

Locking the offset values 

You can lock the offset values by the lock buttons. The locked values remain unchanged even when you change the 
dimensions of the cabinet afterwards. Unlocking the offset values, the size of the profile changes back to its 
original dimensions. In that case, the position of the profile depends on the state of the lock in the opposite 
directions. If none of the locks is locked in the opposite directions, the profile appears with its original size in that 
direction and the position of the profile will get into the middle. 

X offset 

When the position of the selected profile is not locked along the X-axis (when none of the locks are locked in X 
direction), you can specify an X offset. The size of the profile in the X direction is defined by its original X 
dimension, the position of the profile is defined by the X offset value. 

Y offset 

When the position of the selected profile is not locked along the Y-axis (when none of the locks are locked in Y 
direction), you can specify a Y offset. The size of the profile in the Y direction is defined by its original Y dimension, 
the position of the profile is defined by the X offset value. 

 Defining offsets for automatic profile 

When you use the automatic profile, the profile is defined by the shape of the host element (for example the shape 
of the cabinet or the shape of the cabinet door). 

 

Same offsets 

With the Same offsets option you can define identical offsets in the main four directions. If you want to specify 
different offsets in each direction, switch off this option. For example, if you want to reduce the size of a shelf only 
in the cabinet front direction, you can achieve it by switching off the Same offsets option and then applying a 
positive offset value in the cabinet front direction. 

Locking the offset values and X/Y offsets 

It makes no sense to lock the offset values and using the X/Y offsets because the shape and position of the profile 
is defined by the host element (for example the shape of the cabinet or the shape of the cabinet door).  

1.80.7. Creating divisions and fronts 

According to different rules, you can divide cabinets symmetrically or asymmetrically, even embedding one division 
into another. Each division of the cabinet creates the base of defining other divisions or fronts. 
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Creating divisions 

You can divide a corpus by shelves, panels and virtual (without physically appearing) dividers. When you create a 

division, you can create subsequent divisions by selecting it. You can enter into a division with the  button. 

   
Before dividing After dividing Entering into the top division 

 

Switching between divisions 

You can switch between divisions by the „Enter into a division”  button. The selected division appears with 
markers. 

   
The top division is active Switching to the bottom division The bottom division is active 

 

Close one level up 

When you want to step up from an embedded division to an upper level of division, use the „Close one level up” 

 button in the top left corner. 

   
The bottom division is active Clicking the “Close one level up” 

button 

The division with one level up is active 
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Deleting divisions 

You can delete a division along with the embedded divisions. Select a division and then use the delete  button. 

  

 

The bottom division is selected After deletion the division will be 

cancelled 

 

 

1.80.8. Distribution of elements 

You can also define regular distribution of elements. You can exactly specify some parameters of the distribution 
and the rest of the parameters are calculated automatically. Using the lock button, you can lock or unlock the 
specified or automatically calculated parameters individually. 

 

Number of elements 

You can specify the number of elements to be distributed. 

Distance 

You can specify the distance between the distributed elements. 

First distance 

You can specify the position of the starting point of the distribution.  

Last distance 

You can specify the position of the ending point of the distribution. 

Way of distribution 

You can specify the way of distribution by selecting one of the available options. Also, the program can recognize 
the appropriate distribution mode by changing the distribution parameters. The following distribution rules are 
available: 

• By number of elements – The program creates the specified number of elements. 

• By minimum distance – The distance between the distributed elements must be at least the specified 
Distance parameter. 

• By maximum distance – The distance between the distributed elements must be maximum the specified 
Distance value. 

• From start – The distribution starts and continues exactly with the specified First distance and Distance 
parameters; the rest defines the last distance. 

• From end – The distribution goes and ends exactly with the specified Distance and Last distance 
parameters; the rest defines the first distance.  
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• Centered – Starting from the middle point of the distribution you can create a symmetrical distribution 
with the specified Distance parameter. 

• Interval centered – You can create a symmetrical distribution by starting an element in the center and 
then continuing the distribution in both directions with the specified Distance parameter. 

1.80.9. Handles 

On a cabinet or a cabinet door, you can place a handle. You can place either the default or a custom handle. 
 

 

Apply the default 

With the Apply the default option the handle specified as default will be used. When you switch off this option, you 
can use a different object as handle. 

Use original handle 

When a handle was defined originally to a used cabinet front or drawer front then you can force the use of original 
handles with the Use original handle option. 

Hide option 

With the use of Hide object option, you can cancel the handle in the representation. 

Use custom position 

With the use of Use custom position option, you can specify handle position that is different from the default. 
Enabling this option, you can quickly define the position with the appearing 3x3 grid. Relative to this position you 
can offset the handle with the offset values. 

Stretched 

With the Stretched option the size of the selected handle object depends on the path defined for the placement of 
handle. 

Rotate X 

You can rotate the handle around the X-axis by selecting or entering an angle value. 

Rotate Y 

You can rotate the handle around the Y-axis by selecting or entering an angle value. 

Rotate Z 

You can rotate the handle around the Z-axis by selecting or entering an angle value. 

Mirror 

With the Mirror option, you can mirror the selected handle object. Switching off the option, you can switch back to 
the original state. 

Offset left/right 

You can offset the handle to the right or left with the specified positive or negative distance value. 

Offset front/back 

You can offset the handle forth or back with the specified positive or negative distance value. 
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Offset down/up 

You can offset the handle down or up with the specified positive or negative distance value. 

Opening 

Cabinets with doors or drawers can be represented different ways in opened or closed state both on the floor plan 
and in 3D modelling. Here you can define the maximum of opening that is represented in totally opened state. The 
value of opening goes from 0% to 100%. 0% stands for the totally closed state, 100% stands for the totally opened 
state.  
For example if you use a value of 75%, then even in the totally open representation you cannot open the cabinet 
door perpendicular to the cabinet. 
This way you can modelling the real situation if there is not enough room to open the door of a cabinet totally. 

1.80.10. Full overlay and traditional fronts 

 
Full overlay door 
 

 
Traditional door 

The backside of full overlay cabinet doors fits to the front side of the cabinet shape. The front side of traditional cabinet 
doors fits to the front side of the cabinet shape. Full overlay cabinet doors are not included in the cabinet dimensions (see 
chapter 1.80.3.2). 

1.80.11. Countertop 

Using the Countertop tool, you can quickly design a countertop object on the top of one or multiple cabinets. The 
Countertop tool will let you customize detailed settings and to add or remove sinks, hobs and other objects using the 
same easy-to-understand dialog. 
The tool is accessible in Interior – KBB – Countertop.  

How to use it? 

To use the Countertop tool, follow these steps: 

• Click on the Countertop tool. 

• Select corpuses to create a countertop above them, or 

• Draw the path of the countertop. Use the Countertop – Profile floating menu for the path definition, if 
necessary. 

• The Countertop dialog will appear. Set the settings you wish, and click OK to accept the changes and close 
the dialog. 

• Save the new countertop using a unique name and set the category you wish to save it into. 

 Countertop properties 

When you create a new countertop or change an existing one, you can use the Countertop properties dialog.  
The structure of the dialog is the same as the Cabinet Door dialog. For more details about the dialog structure, please 
check the description of Cabinet Door.  

� On the top of the dialog you can see the preview of the model. 
� On the bottom of the dialog you can edit the model and control the preview. 
�  
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Tabs for editing and saving 
Depending on the type of modification you want to achieve on the countertop, there are different tabs: 

 Sizes and materials is to define the size and materials for each path segment of the countertop. 

 Joints is to define the joining mode between countertop segments.  

 Sink cabinet is to insert sink and tap into the countertop. 

 Hob cabinet is to insert hob into the countertop. 

 Other is to insert other objects into the countertop. 

 Wall strip is to define the countertop wall strip profile and material. 

 Countertop edge is to define the profile and material of countertop edge. 

 General settings is to define the floor plan representation settings. 

 Save is to save the countertop into the object library. 
 
On each tab you may find subsequent tab(s) on the left side with further editing functions. 

 Sizes and materials 

The Sizes and materials tab includes three subsequent tabs on the left side to define the top material, bottom material 
and side material of each countertop segment. By default, bottom and side materials are the same as top material. Use 
the Use custom material option if you want to define a different material for the bottom or side. For the details of setting 
materials, see the material settings for Cabinet Door. 
Further options: 

� Width: default width of countertop. To change the width of the selected countertop segment, use the Custom width option 
and specify another width. To switch to another segment, use the back or forth arrow buttons on the left or click on the 
appropriate segment in the preview. 

� Thickness: thickness of countertop. 
� End panels: with the Left side panel and Right side panel options you can define vertical panels to the start and the end of 

the countertop. In the drop down menu you can specify the height of panels. 
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 Joints 

The Joints tab allows you to define the joining mode between two neighbouring segments. Use the back and forth arrow 
buttons on the left to select the desired joining. There are four joining options you can select from: 

� Joint 1: the first segment has precedence. 
� Joint 2: the second segment has precedence. 
� Joint 3: mitre-joint. 
� No joint: there is no joining. 

 Sink cabinet 

On the Sink cabinet tab you can insert sink into the countertop. There are three tabs to define the inserted object, the cut-
out profile and the tap. 

  Object 

On the Object tab you can insert one or more sink objects into the selected countertop segment. The available tools for 
inserting a sink similar to the ones you can use for the cabinet doors.  

• Select the appropriate countertop segment by clicking on it in the preview. 

• Select a sink object to insert it into the countertop. 

• You can define the distance from the left or right side of the selected countertop segment. For this, you can 
use the input fields located between the tabs and the favorites. In the input field on the left, you can specify 
the distance of the object from the left side of the countertop. In the input field on the right, you can specify 
the distance of the object from the right side of the countertop. You can also change the position with small 
movements by clicking on the left or right arrows below the input fields. Below the arrow buttons you can 
read the distance of the center of the hole from the left and right side of the countertop segment. 

 With hole 

On the With hole tab you can specify a cut-out in the countertop segment for the selected sink object. 

• Click on the sink for which you want to edit the cut-out. The selection is visible in the preview window 
because the origin indicator appears at the center point of the hole. 

• With switching on the With hole option you can make the cut-out visible in the preview. 

• Define the cut-out profile of the sink. See the detailed description of the available tools at Cabinet Door. 

 

Note  Factory sink objects provided with the installation of the program have special settings. By default, their 
custom cut-out profile follows the contour of the sink object with an offset and their position goes a little bit 
above the top plane of the countertop. If you insert an external sink object, you must define the position of 
the object and the shape of the cut-out hole for the correct representation.  

 Tap 

On this tab you can assign one tap for the selected sink.  

• Select the tap by clicking on it. It appears in the preview window immediately at the selected sink. 

• Use the Hide tap option if you do not want to assign tap to the sink. 

 Hob cabinet 

On the  Hob cabinet tab you can insert one or more hobs into the selected countertop segment on the same way as 
sink. You can define the hob object and the cut-out on two different tabs. 

 Other 

On the  Hob cabinet tab you can insert one or more hobs into the selected countertop segment on the same way as 
sink. You can define the hob object and the cut-out on two different tabs. 
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 Wall strip 

On the  Wall strip tab you can add wall strips to the whole countertop. 

• Use the Front, Left, Right, Back checkboxes on the left side of the page to add strips to different parts of the 
countertop. 

• Specify the cross section of wall strip on the  Profile tab. 

• Specify the material of wall strip on the  Material tab. 
 

 Countertop edge 

On the  Countertop edge tab you can add countertop edge profile to countertop. 

• Use the Front, Left, Right, Back checkboxes on the left side of the page to add edge profile to different parts 
of the countertop. 

• Specify the cross section of edge on the  Profile tab. Use the Stretch profile to countertop thickness if 
you want the program to trim the height of the edge profile to the thickness of the countertop 
automatically. 

• Specify the material edge on the  Material tab. Use the Custom material option if you want to use a 
material different from the countertop material. 
 

 General settings 

The  General settings tab serves the settings like line type, line thickness, color, priority, relative height. For 
specifying the 2D representation, select from the Representation in 2D drop-down menu.   

� In case of Simplified selection the countertop segments will be represented by their contour lines on the floor plan. 
� In case of Top view selection the countertop will be represented on the floor plan by the top view of its 3D model. 

� In case of Symbol selection you can select a group from the favorites, from the existing library group elements ( ) or 

you can modify the properties of the selected group ( ).  

  Save 

On the  Save tab you can either save the currently edited element by the Save as button or you can select from the 
existing countertop library elements for further modifications. 
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11. Dimension 

Introduction 

This chapter describes the dimension properties and commands available for dimensioning drawings and how to use 
them. The dimension tools are essential part of creating clear and precisely measured drawings. 

Dimension 

Certain dimensioning types – called associative dimensioning – are related to objects or to special points of objects.  
When applying associative dimensioning the program automatically modifies the dimensioning if you modify any object.  
Example: if you delete a wall, the program deletes the relevant dimensioning as well. 
You can remove associative property of dimensioning. 
 
Any object of dimensioning (dimension line, text, marker, extension line, etc.) can be freely edited. 
 
The Quick dimensioning command automatically collects the most often used types of line, distance, radius, diameter, 
angle and parallel dimensioning. 
 
The Wall dimensioning command places the next dimensions in one step parallel to the wall: 

� wall endpoints and door and window axes, 
� wall endpoints and door and window endpoints, 
� wall connection points and wall endpoints, 
� wall endpoints only, 

1.81. Dimension properties 

Dimension has the following components: 

 
Before dimensioning the objects, set the appropriate dimension properties. Click on the Dimension Toolbox - Properties 
icon or select the Dimension menu – Properties command. 
 

 
 
The following Dimension properties dialog box appears: 
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You can set the following properties: 
 

� General properties, text, arrowhead 
� Text parameters 
� Format parameters 

1.81.1. General dimension properties, text, arrowhead 

General dimensioning properties 

Specify the general properties of dimensioning: colour, line width, layer and priority. 

  
 

� See the detailed description of:  
� General properties in Chapter 3.2.1. Specifying general properties. 
� Sets in Chapter 3.2.3. Using sets of properties. 
� Cost variables in Chapter 3.2.4. Assigning cost variables. 

 
The Extra text field is activated when you modify any property of an already existing dimensioning. The text you enter 
here will be displayed when dimensioning. 

  

Text 

You can set the text properties of dimensioning here. 
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You can specify: 

� the colour, 
� the line width (selecting an object of the list or entering the desired value directly), 
� the font type (selecting a Windows True Type font), 
� the style (regular, italic, bold, bold italic),  
� the character height (defining the height of the text character cells of dimensioning) of the text. 

Arrowhead 

You can set the arrowhead properties of dimensioning here. 

 
 
You can specify: 

� the colour, 
� the line width (selecting an object of the list or entering the desired value directly), 
� the type, 
� the size (at both ends of the dimension line) of the arrowhead. 

� Select a type from the list. 
You can see the available 
maker types on the right: 
 

Shape of arch length dimension 

You can set the arc’s extension 
line to be radial or extension-
directed in case of central angles 
under 90 degrees. 
 

 

 
 

1.81.2. Text parameters 

You can set other parameters related to the text of dimensioning by selecting the Text parameters option. 
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. 

 Placing 
You can set the actual position of the text. 
 

Upper The text is placed above the dimension line. 
On The text is placed on the dimension line. 
Below The text is placed below the dimension line.  
Outside The text is placed on the side of the dimension line farthest away 

from the defining points.  
These options useful at DXF/DWG import/export operations. 

Text direction 
This option sets the current direction of the text. 
 

Off Default text direction (in compliance with ISO 
standards. If the text is placed between 75 and 105 or 
255 and 285 degrees it is placed perpendicular to the 
dimension line. 

In The angle is marked horizontally, inside the arc. 
Out The angle is marked horizontally, outside the arc. 
Perpendicular The values of length and distance are marked 

perpendicular to the dimension line. 
Parallel The text direction is always parallel with the dimension 

line. 
Fix 0, 90, 180, 

270: 

The text of dimensioning is rotated from the horizontal 
line with the selected angle and fixed. 

Dimension text to other side, 
starting angle 

You can specify the 
starting angle from 
which the dimension text 
can be moved to the 
other side by rotating it 
with less than 180°. The 
default setting of the 
starting angle is 90°. 
 
This figure shows that – 
at 90° – the dimension 
text will be placed on the 
other side, if the angle of 
the line is more than 90° 
and less than or equals 
to 270°. 

 

Text direction of 3D dimensions  
You can fix the text direction of 3D dimensions on the projection with the help of switch according to the graphic: 
 

 Off On 
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1.81.3. Format parameters 

Click on the Format parameters or Dimension line option. You can set further properties of format, extension line, or other 
display characteristics of dimensioning. 
 

 

Parallel distance 
Set the distance between the texts in case of parallel dimensioning. 

Scale factor 
Set the current scale of the dimension figures. The dimension figures are multiplied by the set scale factor and are 
displayed in the dimension text. 

Show dimension line 
Shows or hides the dimension line. 

Extension line 
This checkbox allows showing or hiding the extension line. 
 
You can set the extension line length relative to the arrowhead or dimension base line. 
 
Activate the Distance from object or Distance from dimension line option and enter the desired value. 
 

 
Distance from object or 
object: 
200 mm 

Distance from dimension line: 
200 mm 
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� You can cut out a part of the 

extension line by selecting 
the Dimensioning shortcut 
menu – Delete from 
extension line command. 

Options 

You can select the standard of dimensioning for both length and angle dimensioning: 
 

 
 

In compliance with the technical standard. 
In compliance with the architectural 
standard, with an accuracy of 0.5 cm. 
In compliance with the architectural 
standard, with an accuracy of 1 mm. 
In compliance with the architectural 
standard, with an accuracy of 1 cm. 
In compliance with the architectural 
standard, with an accuracy of 25 mm. 

 
In the following table the DIN standard is set to an accuracy of four decimals, the SIA set for 1 cm rounds the value up to 
the second decimal while in the other two cases the accuracy of 1 mm or 0.5 cm is indicated by a superscript respectively. 
 

 

 
 
DIN 
 
 
SIA 0.5 cm 
 
 
SIA 0.1 cm 
 
 
SIA 1 cm 

 

� To use the SIA standard, set the current unit of measurement to meter in File menu – Options – General – Unit dialog 

box. 
 

 

 

You can select any of the following options of 
angle dimensioning here: 
It displays the angle in decimal units (e.g.: 30.5°). 
 
Degrees, Minutes, and Seconds (e.g.: 30°30'00'') 
 
Grads (unit of measurement in engineering) 400 
degrees 

Tolerance options 
It specifies the tolerance of length dimensioning in case of SIA 0.1 and SIA 0.5 standards. The program displays the upper 
values of dimensioning according to the selected standard. 
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The distance between the lower corner of 
tolerance and the bottom of the dimension text 
as the percentage of the height of the dimension 
text. 
The level of tolerance as the percentage of the 
height of the dimension text. 
The distance between the bottom of the 
dimension text and the dimension line as the 
percentage of the height of the dimension text. It 
is relevant to all dimensioning standards. 

Length and Angle 

Suppress trailing zeros 
If this option is on the non-significant zero decimals at the end of the index number for length or angle are hidden. 

Length decimals 
This option sets the current number of the decimals to be displayed when dimensioning. The program rounds off the figure 
appearing on the dimension line to the given number of decimals. 
When the Din norm is used, the maximal number of decimals is 6. If you work in meters, it means micron accuracy. 
 

� The number of decimals can only be set for the DIN standard. This property cannot be interpreted for the SIA standard. 

Length format 
This option specifies the format of the dimension text. The „#” character stands for the measured value and can be 
replaced or supplemented with other characters. 

� For detailed description, see Chapter 10.3.12. Format text. 

Angle decimals 
This option sets the number of decimals in the angle index to be displayed. 
Specify a negative value to display only decimals different from zero. 

Angle format 
With this option you can set the text format of the angle index number displayed. 

1.82. Creating dimensions 
You can activate the dimension commands 
from the Dimension menu or the 
Dimension toolbox. 
You can find different type of 
dimensioning: length, distance, parallel, 
angle dimension and so on. 
 
 
 

 
 

1.82.1. Quick dimensioning 

The  Quick dimensioning command automatically collects the most often used types of length, distance, radius, 
diameter, angle and parallel dimensioning. 
Click on the Dimension Toolbox –Quick dimensioning icon. 
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Quick dimensioning can identify the different drawing objects and can apply the following types of dimensioning within one 
command: distance, radius, diameter, and angle dimensioning as well as dimensioning of parallel lines. 
 

� You can activate any dimensioning function by clicking on the corresponding object. Use the cursor to display the format 
of the current dimensioning. You can move between the dimensioning commands by pushing Enter. 

If the selected object is a Line or a Polygon: 

• Select an object for dimensioning. 

• The program performs the Length dimensioning command, or 

• Enter Moves on to the Angle dimensioning command. 

• (If the second object is parallel to the first one, the program performs the Parallel lines dimensioning 
command), or 

• Enter Moves on to the Auxiliary angle dimensioning command. 

• Select the second object. 

• Specify the position of dimensioning. 
 

 

If the object selected first is a Circle or an Arc: 

• Select an object for dimensioning. 

• The program performs the Diameter dimensioning command, or 

• Enter Moves on to the Radius dimensioning through centre command, or 

• Enter Moves on to the General radius dimensioning command. 

• Specify the position of dimensioning. 

 

If the point selected first is close to an endpoint of an object: 

• Select an object for dimensioning. 

• The program automatically snaps to a special point. Then the program waits for the specification of another 
point to perform the dimensioning for the distance between the two points. 

• Specify the other point (the change of the cursor will sign the identification of a special point). The program 
performs the Distance dimensioning (X offset) command, or 

• Enter Completes the Distance dimensioning (Y offset) command, or 

• Enter Performs another Distance dimensioning command. 

• Specify the position of dimensioning.  
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� The process is not as complicated as it might look on the basis of the description. See it for yourself! 

 

1.82.2. Wall dimensioning 

The program places a dimension string parallel to the wall or group of walls selected by automatically snapping to the 
following special points: 
 

� wall connection points and wall endpoints, 
� wall endpoints and door and window endpoints, 
� wall endpoints and door and window axes, 
� wall endpoints only, 
� Wall connection points and wall endpoints with wall layer thickness. 

 
You can specify the sequence of the parallel dimensioning. 
After activating the command, the dialog box will appear. 
 

• Specify the desired option in the dialog box. 

• Press the Add button. The selected option is added to the bottom list. 
Specify the next option. 
The program places the dimension strings in a sequence outwards from within, according to the specified order of options. 
In case you wish to delete any option, click on the bottom list and press the Delete button. 

Door / Window dimensions. 

In the appearing dialog window you can set, that which parts of the openings will be on the dimension line in case of 
Door/Window frame and wall endpoints. 

� See the detailed description in chapter 9.3.1.5. Visualization group. 

Dimensioning refer to middle of walls 

The program will dimension the wall middles, if you switch on the option. 

 

• OK Closes the dialog box. 

Dimensioning wall by wall 

The most often used way of dimensioning is done by dimensioning the building by its outer walls. 
 

• Specify the outer side of the first wall for dimensioning. 

• By moving the cursor you can display a rubber line indicating the position of the innermost dimension lines. 
Specify the position of the dimension line. 

• Specify the next wall on the same front. The program displays the dimensioning in a distance from the wall 
similar to the previously specified one. This way the dimensioning on the same front. 
Enter Closes the dimensioning on the same front. 

• Continue dimensioning on the next front. Enter. 
Enter  Completes the command. 
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� In case the distances within the same front are different, after pressing Enter you can continue dimensioning by 

specifying the next distance. 

Dimensioning the complete building 

You can do the dimensioning of the complete building in one step. In case the program skips a wall segment from the 
process of dimensioning (see the example below), follow the above described method. 
 

• Click somewhere out of the corner points of the selected walls enclosing box. 
Enter Completes the command. 
 

• By moving the cursor, you can display a rectangle indicating the position of the innermost dimension lines. 
Specify the position of the dimension line, or  
if the front of the building is not parallel with either main axis (X, Y), select the ANGLE option. Now you can 
use either the LIKE option or the options of the Define angle menu to place the dimensioning parallel to the 
walls. Select the object on the drawing whose angle you refer to. 

• Enter, Enter Completes the command. 

 

� The inserted door, window, joined new wall or deleted wall connection updates automatically the related dimensions. 
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� To change the position of an already existing dimension string in one step, use the Shortcut menu – Edit group of 

dimensioning - Move dimension string command. 
Use the Dimensioning properties – Format parameters – Parallel distance option to specify the distance between parallel 
dimension strings. 

1.82.3. Distance dimensioning 

This dialog box allows you to select from seven types of distance dimensioning in three directions: 

Direction of dimensioning 

Specify the direction of dimensioning. Between two points you can define: 
� a horizontal dimension line, 
� a vertical dimension line, or 
� a dimension line at a given angle. 
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Type of dimensioning 

Select a type of dimensioning from the following: 
 

SINGLE Distance dimensioning between two points. 
ELEVATION For creating architectural elevation dimensioning. 
SERIAL Dimensioning of distances between points is placed 

in a sequence. 
CUMULATIVE It creates the dimensioning of the distance of 

points from an origin. There is no arrow added at 
the end of the dimension lines closer to the basis. 

PROGRESSIVE It creates the dimensioning of the distance of 
points from an origin. The dimension lines appear 
at the drawing of the arrow. 

HALFDIAMETER diameter dimensioning with radius determine  
PARALLEL It creates the dimensioning of the distance of 

points from an origin. The new dimension lines are 
moved to a certain distance. 

All cutting points 

The program dimensions automatically the virtual section points between the first and second point of dimensioning 
according to the graphic:  
 

  

Automatic text alignment  

With this option, at serial dimensioning, the dimension text will be lifted up or dropped down automatically when there is 
not enough room to place the text between two consecutive points we use for the serial dimensioning. 

 
 

• Specify the origin of the dimensioning (point 1). 

• Specify the second point. 

• Specify a point of the dimension line. 

• Specify the third point. 

• Define point nº. 
Enter Completes the procedure. 
Enter Completes the command. 

HALF DIAMETER: 
This option can be used for the dimensioning of symmetrical objects. First, define a point of the symmetry axis then the 
extreme points of the desired objects. The program displays the double value of the measured distance on the dimension 
line and marks it as diameter. 
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• Specify a point of the 
symmetry axis. 

• Specify the point of the object 
to be dimensioned. 

• Specify a point of 
dimensioning. 
Enter Completes 
the command. 
 
The picture on the left illustrates 
the dimensioning of the horizontal 
half diameter. 

 

 

Characteristics of dimensioning: 

� If a special point (endpoint, centre point or half point) is selected, the dimensioning is related to that point and is 
associative. 

� In case of serial, cumulative or progressive dimensioning you can move the text if it overwrites the arrow or another 
dimension text. Press Enter to move the text to its original position. 

� In case of parallel dimensioning, you can specify the distance between the dimension lines. See the description of 
dimensioning properties. 

� To insert or delete a dimension line in the series, use the Dimensioning shortcut menu – Edit group of dimension - Insert 
dimension, Delete dimension commands. 

Examples of horizontal dimensioning: 

 

Single 

 

Serial 
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Cumulative 

 

Progressive 

 

Parallel 

Example of slanted dimensioning: 

In case of slanted dimensioning, enter the angle of the dimension line or select the Like option, and then specify the object 
in the drawing whose angle you refer to. 
Use slanted dimensioning when the objects to be dimensioned are not parallel with either of the main axes (X, Y). 
 

 
 
 

 
Serial 

1.82.4. Elevation on floor plan 

You can indicate the elevation of walls, slabs, roofs or objects in the floor plan using predefined or user-defined symbols. 
In the Elevation category under the Groups directory in the Design centre you find various predefined symbols: 
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Symbols have two types: 

� In the case of Symbol with text, when inserting the symbol the program automatically displays the elevation value in the 
specified unit. 

� In the case of Symbol without text, the elevation value is not displayed. 

Define customized symbols 

You can create customized symbols with or without text in the following way: 

• Draw the symbol in the floor plan. 

• Insert a text next to the symbol if you want the elevation value to be displayed. The elevation value will be 
inserted in the place of the text. 

• Create a new 2D group including the symbol and the text. Adding the text to the 2D group is again optional, 
of course. 

• Save the 2D group under a name that begins with ElevationXP2 (e.g., ElevationXP2_gaspipe). It is on the 
basis of the group name that the program recognizes that it is a particular group used to indicate elevation. 

Place elevation symbol 

• Choose the Dimension tool-  Elevation on floor plan command 

• Choose an object to measure it. 

• Choose the point of the selected object the elevation of which you wish to display. 

• Define whether the point of your selection is the lower or upper point of the object. 

• Then in the dialog box the elevation value of the selected point is displayed. You can modify this number as 
you like. 

• From the displayed group dialog choose an elevation symbol. 

• Insert the elevation symbol into the floor plan. 

Place elevation symbol from Design centre 

• Find the predefined or customized symbol in the Design centre you wish to use to indicate elevation. 

• Click the symbol with the left mouse button and holding it down drag the symbol over the floor plan. Having 
released the left mouse button, select the wall, slab, roof or object the elevation of whose point you want to 
display. 

• Choose the point of the selected object the elevation of which you wish to display. 

• Define whether the point of your selection is the lower or upper point of the object. 

• Then a dialog box will appear where in the entry field the elevation value of the selected point is 
automatically displayed. You can modify this number as you like. 

• Insert the elevation symbol into the floor plan. 
 
The program will handle the inserted elevation as a group. 
 

� This parameter is not associative; the modification of the object will not affect this value. 

Elevation can be assigned to such objects only, what have existing 3D model. 
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1.82.5. Elevation on section 

Use this command to create the elevation dimensioning of the drawing by specifying the elevations points one by one. 
 

• Specify the first point of dimensioning to serve as a reference point for the program from which to measure 
all the other values. 

• Specify the next point to be measured. 

• Specify the location of the dimension line. 

• Repeat the process until you have measured the elevation of all the desired points. 
 
Each dimensioning is placed on the dimension line specified for the first point. 
 

 
 
 
 
 
 

� The placing of the text depends on that what kind of arrow 

ending we set. 
That means, that if we place the arrow down, then it sets the text 
down and, if to the top, the text will be on the top too. 
 

 

 
 

1.82.6. Door/Window 

This command  
� creates the dimensioning of the selected door/window according to the values given in the Door/Window properties – 

Dimensioning dialog box, or 
� Modifies the dimensioning direction of the placed door/window. 

 
The type of door/window dimensioning depends on the values specified in the Door/Window properties – Dimensioning 
dialog box. 
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Dimensioning 

• Select the doors/windows to be dimensioned. In case of window the value of the parapet height is placed on 
the clicked side. 
or 

• Select the ALL option to create the dimensioning of all the doors/windows in one step. The value of the 
parapet height is placed automatic on the inner side of the window. 
 
Example: 
Door width: 0.9 m,  
door height: 2.1 m, with different types of dimensioning: 

 

Modifying the direction of dimensioning 

This command places the dimensioning of the selected door/window on the desired side. 
 

• Select the door/window to which the door/window dimensioning belongs. 
Place the door/window dimensioning by clicking on the desired side. 

 

� Use the Modify menu – Copy properties command to copy the properties of the door/window dimensioning. 

Modifying the values of dimensioning  

By changing the door/window dimensioning values you can quickly modify the main parameters of a door/window. This 
means that the width, height and parapet height parameters can be modified through the dimensioning values. 
 

• Click on the door/window dimensioning value. 

• Specify a new value in the input field. The door/window will follow the change. 
 

 
 

 

� You can dimension the door/window from the shortcut menu of door/window.  

1.82.7. Deleting door/window dimension 

Use this command to delete the dimensioning of selected doors/windows. 
 

• Click on the dimensioning to be deleted, or 

• Select the ALL option to delete each door/window dimensioning. 

1.82.8. Labels 

Use this command to place the given text labelled with an arrow pointing to a given direction. 
The pointer consists of a poly line (with a maximum number of two segments) with an arrow at the end. 
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You can specify the object to which the labelled text with the arrow refers. From then on, the pointer is assigned to the 
specified object, so for example if you delete the object, the pointer will be automatically deleted as well. However, if you 
delete the pointer, it does not mean the automatic deletion of the object. 
If you do not specify any object, the pointer is not assigned to anything. 
 

• Enter the desired text in the dialog box. 

• Specify the object to which you want to assign a dimensioning pointer or press Enter to have a pointer not 
assigned to anything. 

• Place the text on the drawing by its centre point. 

• Specify the first segment of the 
pointer by its endpoint (the 
starting point is the centre point of 
the text). The first segment can 
only be either horizontal or 
vertical. 

• Specify the second segment of the 
pointer by its endpoint (the 
starting point is the endpoint of 
the first segment), or 

• Enter The pointer consists of 
one segment only. 
The program draws the pointer. 
Enter Completes the 
command. 

 

 

Multiple leaders 

Multiple leaders is a feature that helps you create leaders with more control and flexibility. A multiple leader consists of 
multiple arrowheads, leader lines or curves, and one text label. 
You can add any number of multiple leaders into a single leader Label dimension. 
 
 

 
 
Command:  
Right-click on the appropriate dimension to see the Add Multiple Leaders placement option in dimension context sensitive 
menu. In order to make the command visible you should click on the leader part of the dimension. 
 
Draw the additional leaders heading from the text label to leader landing location in a loop. Press Enter to close the 
command. 
 

1.82.9. Aligned 

You can measure the distance between two points as well as create their dimensioning. The direction of the dimension 
line can be similar to that of the line crossing the two points as well as horizontal or vertical.  
 

• Specify the first point. 

• Specify the second point. 

• The default setting of the program draws a dimension line of a direction similar to that of the line crossing 
both points, or  
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• ENTER if you want to have a horizontal dimension line, or 

• ENTER if you want to have a vertical dimension line, then 

• Place the dimensioning. 

• Enter Completes the command. 

 

1.82.10. Length (horizontal, vertical) 

This command creates the dimensioning of an object so that the dimension line crosses a selected point and is parallel 
with the object or either horizontal or vertical. 
 

• Select the object to be dimensioned. 

• The default setting of the program draws a dimension line of a direction similar to that of the line crossing 
both points, or 

• ENTER if you want to have a horizontal dimension line, or 

• ENTER if you want to have a vertical dimension line, then 

• Place the dimensioning. 

• Enter Completes the command. 

1.82.11. Length aligned 

The command projects the dimensioning of a selected object through a specified point in a given direction. 
 

• Specify the direction of the extension. 
 
Options: 

PICK UP Applies an angle similar to that of the drawing 
object. 

Type the value... Numerically defined angle 

ENTER Applies the current angle. 
 

• Select the object to be dimensioned. 

• Specify the place of dimensioning. 

• Enter Completes the command. 

1.82.12. Angle 

This command creates the angle dimensioning of two specified object through a selected point. 
 

• Select the first object. 

• Select the second object. 

• Place the dimensioning, or 

• Enter Measures an auxiliary angle. 

• Enter Completes the command. 
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1.82.13. Angle (Horizontal) 

The program creates the angle dimensioning of the selected object (or tangent) and the positive X axis through a given 
point. 
 
 

• Select the object. 

• Specify the position 
of the 
dimensioning, or  
Enter Measures the 
auxiliary angle.  

• Enter

 Completes the 
command. 
 

1.82.14. Angle (Vertical) 

The program creates the angle dimensioning of the selected object (or tangent) and the positive Y axis through a given 
point. 
 
 
 

• Select the object. 

• Specify the position of the 
dimensioning, or 
Enter Measures the auxiliary angle. 

• Enter Completes the command. 

 

1.82.15. Parallel lines 

The program creates the distance dimensioning of two parallel objects through a given point. 
 
 

• Select the first object. 

• Select the second object. 

• Place the dimension. 

• Enter Completes the 
command. 

•  

1.82.16. Arc - Dimension 

This command creates the radius dimensioning of a circle or an arc of a circle. 
The dimension line can be placed either outside or inside the circle. If it is inside the circle its starting point is the centre of 
the circle and the text is placed at the middle of the radius. If the dimension line is placed outside the circle, the text is put 
where you click on. 
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• Select the circle or arc of 
circle to be dimensioned. 

• Specify the place of the 
dimensioning. 

 

1.82.17. Diameter 

The command creates the diameter dimensioning of a circle. The dimension line crosses the centre point of the circle and 
the specified point. The text can be placed either outside or inside the circle. If the dimension line is outside the circle, the 
text is placed where you click on; otherwise it is placed at the middle of the diameter. 

• Select the circle or arc of 
circle to be dimensioned. 

• Specify the place of the 
dimensioning. 

1.82.18. Diameter at given angle 

The command creates the diameter dimensioning of a circle as well. Here you have to specify the angle of the dimension 
line (and the positive X axis). The dimensioning can be placed both outside and inside the circle. 
 

• Specify the direction of the dimensioning. 
 
Options: 

PICK UP Uses an angle similar to that of the drawing 
object. 

FIXDIRECTION Specifies the angle graphically. 

ENTER Uses the current angle. 
 

• Select the circle to be 
dimensioned. 

• Specify the place of 
the dimensioning. 

 

1.82.19. Arc length 

The command creates the arc length dimensioning of a circle or arc as well.  
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• Select the circle or arc to 
be dimensioned. 

• Specify the place of the 
dimensioning. 
 
In the Dimension properties 
dialog you can set the 
Shape of arch length 
dimension: 
The arc’s extension line to 
be radial or extension-
directed in case of central 
angles under 90 degrees. 

 

1.82.20. Area 

With this command, you can create the area dimensioning of the following objects: 
 
polyline, polygon Calculates the area of a polygon. 
open polyline (spline) Calculates the area of an imaginary 

closed polyline. 
circle, arc Calculates the area of a circle or a 

segment of a circle. 
ellipse, arc of ellipse Calculates the area of an ellipse or a 

segment of an ellipse. 
hatching Calculates the area of the hatching. 

 

• Select the object to which you want to assign the area dimensioning. 
 
Options: 

SPOLYGON Creates the dimensioning of a closed polygon. Use 
the objects in the Profile definition menu to create 
the contour. 

 

• Specify the position of the dimensioning. 
Enter Completes the command.  

 

 Polygon diagonal measuring 

By this command, area of free polygons can be divided into triangles using the diagonal measuring method. The program 
divides the polygon into triangles and creates a list, including the area of each triangle and sum of the triangle areas. This 
method is used as a verifying procedure for area dimensioning. 
This method can be used even for arched walls. In this case, we have to define the resolution of the arc. 

�  See the chapter 9.5.6. Diagonal measuring 
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 Polygon partitioning and dimensioning 

With the help of the command, a free polygon can be divided into rectangles. The program assigns numbers to the 
partitioning and shows the main dimensions in the selected rooms, and it is possible to place expressions verifying the 
results.  

�  See the chapter 9.5.7. Room partitioning and dimensioning. 
 

1.82.21. Aligned 3D 

You can measure the distance between two points in any 3D view, i.e. in axonometric view or in perspective view. The 
direction of the dimension lines are defined by the work plane automatically. 
 

� Before 3D dimensioning, it is recommended to define the appropriate work plane. 

 

• Specify the first point. 

• Specify the second point. 

• Place the dimensioning. 
Enter Completes the command. 

1.82.22. Length 3D 

This command creates the dimensioning of an object in any 3D view, i.e. in axonometric view or in perspective view. The 
direction of the dimension lines are defined by the work plane automatically.  
 

� Before dimensioning the edges of object surfaces, it is recommended to define the appropriate work plane. 

 

• Select the edge of an object to be dimensioned. 

• Place the dimension. 
Enter Completes the command. 

 
 

� You can fix the text direction in 3D dimension on the extension in the Dimension Properties – Text parameters dialog 

window. 
  

1.83. Modify dimensions 
You can reach the modifying commands in different ways: 
 

� From the Shortcut menu: you can activate the shortcut menu by right-clicking on the object. 
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� Graphical editing: 
 
Using of grips and controls. 

 

1.83.1. Moving 

You can change the position of the whole dimensioning by using the „rubber line” cursor. 
 

• Specify the new position of the selected dimension line. 

1.83.2. Moving dimension string 

You can change the position of the whole dimension string by using the „rubber line” cursor. 
 

• Specify the new position of the selected dimension string. 

1.83.3. Deleting dimension string 

Use this command to delete the whole dimension string in one step. 

1.83.4. Moving a part 

This command moves only a segment of the dimensioning. 
 

• Select a dimension line. Mark the part you want to modify: 
 
If the selected part of the dimensioning is actually the extension line, 
You can move the endpoint of the extension line closer to the point with dimensioning. 

Options: 

NODES Breaks the extension line of the dimensioning with 
a node. 

DELETE Reconstructs the original extension line. 
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• Select the dimension line where you 
want to insert a node. 

• Select the NODE option. 

• Specify an inner point on the 
extension line. 

• Specify the position of the next node. 
 

 
If the selected part of the dimensioning is actually the dimension line, you can move the endpoint of the extension line 
closer to the point where you have clicked on dimensioning. 
 
If the selected part of the dimensioning is the text, you can move it to a new place along the dimension line. 
 
If the selected part of the dimensioning is the arrow, you can move it to a new place (inside or outside). 
 

• Specify the new position of the part of the dimension line. Use the „rubber line” to assist the moving of the 
selected part. 

1.83.5. Moving text 

This command freely moves the dimension text anywhere. 
 

• Specify the new position of the text. 

1.83.6. Inserting dimension 

This command inserts a new point into the dimension string. 
 

• Specify a new point within the dimension string. 

• The command deletes the specified object of the dimension string and inserts two new objects into it, 
according to the adjacent points and the new point. 
 

 

1.83.7. Deleting dimension 

This command deletes the selected object of the dimension string and extends the closest object to the first adjacent 
point. 

1.83.8. Aligning 

This command aligns the parallel dimensioning. 
 

• Select the dimensioning to be aligned. 

• Give the reference point of the parallel dimensioning. 
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1.83.9. Parallel distance 

This command modifies the distance of the parallel dimension lines. 
 

• Enter the distance of the parallel dimension lines next to one another. 

• Select the two parallel dimensioning to modify the distance between them. 

• Enter Completes the selection. 

• Specify the reference point of the parallel dimensioning. 

1.83.10. Stretching 

This command stretches the extension line of a dimensioning, this way changing its angle with the extension lines. The 
dimension text remains the same. 
 

• Specify the new position of the selected dimensioning. Use the „rubber line” cursor to assist the stretching. 
 
Option: 

ANGLE Enter the angle of the dimension line and the extension 
line. 

 

� You can only use this command when length dimensioning. 

1.83.11. Transforming with object 

Use the options to switch on or switch off the transformation with object function (when rotating or mirroring). You can only 
use this command in case of dimensioning related to special points or objects. It is enabled by default, so the 
dimensioning moves together with the object. If it is off, only the direction of the dimensioning is fixed. It is a global option. 
 

 

On – the 
dimensioning 
moves together 
with the object. 
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Off – the direction 
of the 
dimensioning is 
fixed. 

1.83.12. Format text 

Use the Format text command to modify the measured value of the dimensioning. You can modify the dimension text 
marked by a double cross in the Current text dialog box. 
 

� If you replace the character „#” by a value, the program will display this value on the dimension line instead of the 

measured one. Keep in mind, that the program will always keep the given value, even if you modify the object itself. If 
you replace the entered value by the character „#”, the program will automatically calculate and display the actual values 
of the dimensioning again. 

•  
Special characters:  
 
#  -> value of dimension 
$u -> unit 
$- -> plus-minus sign 
$2 -> superscript 2 
$2 -> superscript 3 
$d -> degree sign 
$# -> # sign 
 
You can use any other character as usual. 
 
Example:  
If the measured size is 45.87, and you would like to have it displayed in the following format: "L=45.87 m", enter the next 
sequence of characters in the format field: "L=# $u". 
 

� The diameter and the radius automatically signed by „D” or „R” before the value respectively. 

The maximum length of the character string is 255. 

1.83.13. Second text 

You can place another text under the original text of dimensioning. 
 

• Enter the text to be added. 

• Select the dimensioning whose 
properties you want to modify. 

• Enter Completes the selection. 
 

 

� You can activate this command and also modify the second text added by it, if you select the Dimensioning Shortcut 

menu – Modify command. The Second text field  in the Properties dialog box is 
activated, and you can enter or change the second text here.  

 

1.83.14. Delete from extension line 

This command deletes a segment of the extension line between two given points. Use this command to eliminate a 
breakage of the extension line. 
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• Select the first point of the breakage in 
the extension line. 

• Select the second point of the breakage 
in the extension line. 
The program will break the extension line 
between the two points. 

 
 

Option: 

JOIN Eliminates the breakage of the extension line. 

1.83.15. Quick graphical editing of dimensioning 

It is possible to modify dimensioning quickly as follows: 
 

 
� By clicking on the text of the selected dimensioning, an input field will appear where you can enter the required text after 

the #character. (Analogous to the Format setting you find in the Shortcut menu– Edit text command). 
 

� The dimension line can be moved with the group found in the middle of the dimension line. 
� With the control found at the ends of the dimensioning line, the extension of the dimension line can be modified 

graphically. 

1.83.16. Dimension - Remove associativity 

With the help of this command, the length and distance dimensioning can be converted to non-associative dimensioning. 
The command does not change the non-convertible dimensioning like radius, diameter etc. 
The command is available in the Dimension menu – Options submenu. 
With this command, it is possible to copy wall dimensioning (created and converted to non-associative on a floor) to 
another floor if the walls are identical on both floors. So it is not necessary to create the same dimensioning again. 
 

 
 
The tooltip includes the associativity information. 
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12. 2D objects 

This chapter describes the 2D drawing objects properties and commands and how to use them.  
The tools are available from the Drafting toolbox or the Drafting menu: 
 

  

1.84. Point 

The commands of Point Tool define points: 
 

  

1.84.1. Point properties 

Before placing a point, set the global properties. Right click on the Drafting toolbox -  Point tool, or select the 
command Drafting menu - Properties – Point. Point properties dialog appears where the general and special properties 
of the point can be set. 

General properties 

Define the general properties of the point: the colour, the line width, the layer, the line type and the priority. 
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� See: 
� the detailed description of General properties in Chapter 3.2.1 Specifying general properties, 
� the description of Sets in Chapter 3.2.3. Using sets of properties. 
� the description of Cost variables in Chapter 3.2.4. Assigning cost variables. 

Special properties 

 

  
 
You can define the representation type of the point and besides the first symbol it is possible to define the width, 
length and the direction of it.  

 

1.84.2. Creating points 

The following point construction commands are available: 
 

 

Single Point 

 

Divide 
 
Divide for chain 
 
Measure 
 

Topographical input 
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 Point 

Left clicking on the Point icon the program places a point at the specified place. 
 

• Define the coordinates of the point or define a place on the drawing. 
 

 

 Divide 

Divide the selected object into a given number of portions of equal length. The command creates a new point at the 
endpoints. 
 

• Define the required number of portions. 

• Select the object to divide. 
 
Example: number of division: 5 (in the case of line, polyline, arc, spline) 
 

 

 Divide for chain 

This command divides not a single object but a chain of objects. Chain means objects connected to each other. (chain of 
sections, lines and arcs, etc.) Divide the selected chain along its length into a given number of portions of equal length. 
The command creates a new point at the endpoints. 
 

• Define the required number of equal portions. 

• Select the object to divide. 
 
Example: number of division: 5 (in the case of chain of lines and arcs) 
 

 
 

! When you select the first or last object of the chain (near the endpoint), the command divides the entire chain. When you 

select a different part of the chain, the command divides the chain from this point to the endpoint of the chain passing 
through the middle point of the selected object. 

 Measure 

The chain can be divided into parts by a given distance value. 
 

• Define the distance to be used for the division, this is going to be the distance between the division points 

• Select the chain to divide. 
 
Example: the distance, the length of the portions: 1 m (in the case of chain of lines and arcs) 
 

 
 

1.85. Line 
The commands of line tool define: 
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� Lines 
� Chain of lines 
� Construction lines 

Lines 
Line is defined by coordinates of its endpoints. 

Chain of lines 
Chain of lines is a series of connected lines. The starting point of a line always coincides with the endpoint of the previous 
line. 

Construction line 
Construction line is a special kind of line, which will be extended at the definition time from one border of the current 
window to its other border. 
 

! Do not confuse Chain of lines with polylines!  A polyline is a single object, while a continuous line is a series of single 

objects. 
 
The following line commands are available: 
 

 

1.85.1. Line properties 

Before drawing a line, set the global properties.  

Right click on the Drafting toolbox -  Line tool, or select the command drafting menu - Properties– Line.  
 
The Line properties dialog appears where the general properties of the line can be set: the colour, line width, layer, line 
type and the priority. 
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� See: 
� the detailed description of General properties in Chapter 3.2.1 Specifying general properties, 
� the description of Sets in Chapter 3.2.3. Using sets of properties. 
� the description of Cost variables in Chapter 3.2.4. Assigning cost variables. 

 Symbol at line end points 

Introduction 

 
With ARCHLine.XP it is possible to place symbols at end points of certain types of objects. Symbols can be placed at end 
points of the following object types: 
 

� Line 
� Polyline 
� Arc 
� Elliptic arc 
� Spline 
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Symbols can be placed at end points of objects in the 2D window. Placing symbols at end points in the 3D window is 
available only for those objects that were created with switched off work plane status. 

 Settings of line endings 

The properties of the above mentioned object types are extended with Symbol at line start point and Symbol at line 
end point groups. 
 

Symbol enabled 

Here you can enable the representation of symbol at each line ending.  

Symbol name 

Here you can select the symbol to be represented. 
By default, you can select a symbol from the Groups – Line endings – Arrowheads in the design centre. The reference 
points (hot spots) of the arrowheads found here are defined to the top and the base. 
 

  

Adjust symbol to line direction 

With this option, it is possible to adjust the symbol to the line direction. This means that the direction of the line defined by 
the two reference points of the symbol is adjusted to the direction of the line. If you switch off this option, the symbol will be 
placed with its default direction. The end of the line is adjusted to the selected hot spot of the symbol in both cases. 

  

Scale 

The scale of the symbol can be specified here. 

Exchange endings 

With this option, you can exchange the settings specified for Symbol at line start point with the settings specified for 
Symbol at line end point. 

 Customized arrowhead symbols 

If you do not find the appropriate ending in the design centre, you can define your own arrowhead as follows: 
 

• Draw the symbol with lines and hatches. 
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• Create a group (Tools/Create group in library). Define the top of the arrowhead symbol as the first reference 
point, and then define the middle point of the base of the arrowhead symbol as the second reference point.  

! For these groups you have to define exactly two reference points. 

 

• Select a line and enable the symbol in the Symbol at line start point settings through the property manager. 
Specify the symbol name: search and select the group you created previously. 

• Modify the size of the symbol by the Scale property, if necessary. 

1.85.2. Creating lines  

Select a line construction command: 

 

 Line 

This command defines series of connecting lines by their endpoints. The endpoint of a line coincides with the starting point 
of the next line. 
The individual segments of a continuous line remain separate objects. 
 

• Define the starting point of the first 
line. 

• Define the endpoint of the first 
line. 

• Define the endpoint of the next 
line. 

• Define the other points of the 
chain and then 

• Enter Terminates the chain. 

• Enter Terminates the command 

 

 Construction line 

Construction line is a special line that passes the whole screen and whose endpoints are on the frame of the actual 
graphical window. The construction line can be created by defining its endpoints. 
 

• Define a point of the construction line. 

• Define another point of the construction line 

• Repeat the command to draw more construction lines, or 

• Enter Terminates the command. 
 

� With command Modify menu – Construction line -> Line construction line can be transformed to line. Perpendicular line 
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This command defines a line that starts at the pick point and is perpendicular to the selected object. 
 

• Select the object to draw a perpendicular line at the pick point 

• Define the endpoint of the line, or move the mouse to the needed direction and type the precise length 
value. 
 

Options: 

OBJECT You can define the object that or whose extension will 
be touched by the perpendicular line. 

 

• Repeat the command or 

• Enter Terminates the command. 
 

� You can define a perpendicular line for every object type, including arcs. 

 Chamfer 

This command defines chamfer angle. The distance of the endpoint of the chamfer line from the intersection point of the 
two primitives is given, plus the direction of the bevel (which will be the last used angle, if not specified otherwise). This 
angle will be measured from the first object.  
The program: 

�  Creates the chamfer line, trims or extends both primitives 

� .  Creates the chamfer line, and then deletes/extends one of the objects to the intersection (PART option). 

�  Creates the chamfer line, and then extends both objects to their intersection (TRIM option). 
 

! The objects cannot be parallel! 

Distance is measured from the intersection point towards the pick point. 
 
If the distance between the pick point and intersection point is not bigger than the chamfer length, the program keeps the 
intersection; in the other case, the intersection will be deleted.  
 

• Define the value of chamfer angle. 
 

Options: 

PICK UP Angle equal to:  Select the object with the needed 
angle. 

Type the value... Numerically defined angle 
  

• Define the distance of the chamfer in the appearing dialog. 

• Select the first line. 

• Select the second line, or 
 

Options: 

PART Adjust the selected line. 

TRIM Extends the trimmed lines to their intersection 
point. 

 
Enter Terminates the 
command. 

 

� You can define chamfer between all 

object types, including arcs. For 
example, you can define a chamfer 
between a line and a circular arc. 
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 Offset 

You can draw a parallel line with the same length with this command.  
 

• Select the element what you would like to use to draw the parallel line. 

• Enter the point at which the parallel line passes. 

• Repeat the command if you need more parallel lines with the selected element, or 

• Enter To complete drawing parallel lines with the selected item. 

• You can select further elements and draw parallel lines with them, or 

• Enter Terminates the command. 
 

 Parallel line with the same distance 

The program draws lines parallel to the selected object that has the same length and is at a defined distance from the 
selected line. 
 

• Select the object to draw parallel line to. The positive direction is on that side of the object where the chosen 
point has fallen  

• Define the distance from the object. (In the case of positive distance, the parallel line will be on the positive 
side of the original object, in the opposite case it will be on the negative side.) 

• Selecting other objects the program draws parallel lines to them at the same distance. 

•  Enter Terminates the command. 

 Tangent between two objects 

This command defines a line that is tangential to both objects near the specified points. The endpoints of the line are on 
the selected objects. The objects can belong to these types: circle, circular arc, ellipse, elliptic arc and spline. 
 

• Select the first object; take note that 
the program draws that tangent which 
is closer to the pick point. 

• Select the second object. 

• Repeat the command or 

• Enter Terminates the command. 
 

 Line tangential 

Defines a construction line that is tangential to the given object:  
� close to the specified point., or 
� in a close point where the tangential passes at a defined angle. 

Define the point on the arch, where the tangential is going to pass. 

• Repeat command, or 

• Enter Terminates the command. 

Options: 

FIXDIRECTIO

N 
Define the angle. 
The program draws tangential close to the pick point at 
a defined angle 

 Line Tangent 

This command defines a line that is perpendicular to the first object and tangential to the second object close to the 
specified point. 
 

• Define the point of the first object the line will be perpendicular to. 

• Define the arc the line will be tangent to. 

• Repeat the command, or 
Enter Terminates the command. 
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 Tangent through a given point 

This command draws a line from a defined point that is tangent to the selected arc. 
 

• Define the starting point of the line. 

• Click on the arc. The program draws a tangent from the defined point to the arc.  

• Define the starting point of the new line, or 
Enter Terminates the command. 

 Line in half angle 

This command defines a line running in the half angle of the two selected objects from the intersection point. 
 

� You can define a half angle line for all object types including arcs. 

The command is valid for parallel objects as well. In that case, the starting point of the half angle line is the middle point 
between the two objects. 
 

• Select the first object. 

• Select the second object. 

• Define the starting point of the line.  

• Define the endpoint of the line. 

• Repeat the command, or 

• Enter Terminates the command. 

 

 Line axis 

Defines lines that radiate from a centre  
This command draws lines starting from the centre and can be horizontal, vertical or in arbitrary direction. 
The command helps drawing axes. 
 

� To draw axis lines in horizontal or vertical direction use HV option then follow the command according to the guide. 

 Line axis radial 

This command generates lines radiating from the centre; they can be horizontal, vertical or in arbitrary direction and the 
starting and endpoint of lines can be defined. 
Planning stairs, this command helps drawing the steps precisely. 

 
 

� To draw axis lines in horizontal or vertical direction use HV option then follow the command according to the guide. 
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Axis lines in arbitrary direction: 

• Define the centre. 

• Define the start point of the line. 

• Define the endpoint of the line. 

• Define more radial lines or 

• Define another centre or 

• Enter Terminates the 
command. 

 

 Triangle 

The command creates a triangle of lines or points by different methods: 
� Three sides 
� Base line and the opposite node. 
� Three nodes 
� Vertex opposite the base line 
� Base line and the right side. 

Three sides: 

• Select the base line of the triangle 

• Define the length of one side 

• Define the length of the other side. 

Base line and the opposite node: 

• Select the option POINT  

• Select the base line of the triangle 

• Define the length of one side 

• Define the length of the other side 

Three nodes: 

• Select the option P3  

• Define the first point of the base line 

• Define the endpoint of the base line 

• Define the length of one side 

• Define the length of the other side 

Vertex opposite the base line: 

• Select the option CPOINT  

• Define the first point of the base line 

• Define the endpoint of the base line 

• Define the length of one side 

• Define the length of the other side 

• Define the length of one side 

Define the length of the other side: 

• Select the option RIGHT  

• Select the base line of the triangle 

• Define the length of the other side 

• Define the length of one side 
 

� The position of node opposite the base of triangle depends on the position of pick point of the selected line. The program 

draws the first side from that endpoint of the base which is closer to the pick point. 
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THREE SIDES POINT P3 

 
CPOINT RIGHT 
  

 Convert temporary lines to construction lines 

The command converts temporary lines to construction lines. Temporary lines are horizontal and vertical dotted auxiliary 
lines that go through the cursor point if it stays in one place for some time. For this, you have to use the Sensible 
reference-markers option on the File menu – Options – Cursor and marker page. Here you can also set the maximum 
number of temporary lines.  
Please follow the steps below to convert temporary lines to construction lines: 

• Start or continue to draw an element. Before clicking, horizontal and vertical temporary lines appear at 
cursor points where you stay with your mouse cursor for a while. 

• As soon as you have the desired number of temporary lines, start the Convert temporary lines to 

construction lines command. 

• All temporary lines will be converted to construction lines and stays until you delete those.  

1.85.3. Modify line 

Commands for modifying can be achieved in more ways. 
 

� In the Line popup menu: appears when right click on an object. 
 

 
 

� Graphically: 
Using grips and controls: 
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� See the 2.15. Markers chapter. 

 Add node (->Polyline) 

Inserting new node into a line will convert the line into polyline. 
 

• Define the place of the new node. 

 Line -> Polyline 

The program creates polyline out of lines connected to each other. 
 

• Select those lines that you want to transform to polyline. 
 

Options: 

OPENCHAIN Select an open chain 
 
 

1.85.4. 3D extension of line nature objects  

There is a possibility to create line nature objects designed in the 3D window into 3D form. 
. 
You can create necessary simple models in the conception planning phase fast and easily, what’s more this method can 
be used well for creating surface nature objects necessary to the detailed spectacle plans. 
 

 

 Function 

You can create those line nature objects into 3D form that we placed in the 3d window with active global work plane. The 
3D surface or body is created, that we draw out the line to the space perpendicularly to its own plane. 
You can form the following types of objects into 3D: 
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�  
� Line 
� Polygon 
� Circle 
� Arc 
� Ellipse 
� Elliptic arc 
� Spline 

There is no own plans of straight lines, in this case the surface is 
created by drawing out the line parallel to the Z-axis. 

� The breaking of created arched surfaces is determined by that in the 

moment of drawing out in the  Build 3D model which resolution is set. If you change later the resolution by 
upgrading the 3D window this change has no effect on these objects. 

 Custom setup of the line nature objects  

In the 3D window you can reach the line transforming into 3D form by determine the following properties: (These 
properties can be found in the Property manager after selecting the object or they can be found in the shortcut menu 
under the Properties menu point after clicking with right mouse button on the object.) 

Line width 

These values determine the height of the 3D solid (the line nature object perpendicular dimension to its own plane, the 
value of lifting). The value is 0 by default then the objects behave as simple lines. 

Solid 

Closed formations (circle, ellipse, closed polygon) are formed in two ways to 3D solid: if the Solid 
button is switched off, the result will be a surface if it is switched on we create a solid 3D. 

Solid material 

After creating the 3D solid, the Solid material appears in the dialog window when you want to modify another property. 

 
 

1.86. Polyline 
Commands of Polyline tool draw polylines and polygons. 
 
A Polyline is a series of lines that represent a single object. It can also contain arcs and splines. 
A Polygon is a closed polyline. 
 
You cannot modify the lines of the polyline as individual objects. 
 
The line segments of the polyline are connected by nodes. The nodes represent the endpoints of the line segments. 
 
To construct them, you can use the PLINE tool both on 2D and 3D views. 
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1.86.1. Polyline properties 

Right click on the Drafting toolbox - Polyline tool or select the command Drafting menu - Properties– Polyline.  
The Polyline properties dialog appears where the general properties of the line can be set: 

General properties 

Set the general properties of polyline: colour, line width, layer, line type and priority. 
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� See:  
� Detailed description of General properties in chapter 3.2.1 Setting general properties. 
� Description of Sets in chapter 3.2.3 Attribute sets. 
� Description of Cost parameters in chapter 3.2.4 Define cost parameters. 

Line segment 

If the option Explode to lines is checked in, then the program draws individual lines instead of polyline. If it is checked off, 
the result is polyline. The latest is the default setting. 

Spline geometry 

The program makes Bezier curves by defining the nodes that makes computer aided design easier. 
In the program there are two possibilities to create splines: the quadratic curves and the smoother cubic curves. 
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Quadratic spline, no 
control points 

Cubic spline, 
one control point 

1.86.2. Creating polylines  

The following commands are available for drawing polylines and splines: 
 

 

 Rectangle 

Defines a rectangle by its opposite corners, the sides of the rectangle are vertical and horizontal. 
 

• Define the first corner. 

• Define the opposite corner. 

• Repeat the command or 

• Enter Terminates the command. 

 Polyline 

The polylines contain lines and arcs. Command draws: 
� open polyline, or 
� polygon: 

Specify the polygon as a chain of lines and arcs. 

Enter Closes the polygon. 

Options: 

Arc The next object of the polyline is an arc.  

Select an object The next object of the polyline is an existing object.  

Smooth The next object of the polyline is tangential to the 
previous object. 
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Open polyline: 

• Define the starting point 
of the polyline. 

• Define the next nodes. 
 

 
 

� To draw polygon choose option CLOSED and keep drawing on according to the description. 

 Multi line 

The command creates more parallels  
� open polylines, or 
� Polygons 

that are in a defined distance from each other. 

Draw open polylines: 

• Type the values of multi-line 
distance OK. 

• Repeat sequentially if you define 
more polylines, or 
Cancel Terminates 
definition of distances. 

• Define the starting point of the 
polyline. 

• Define the next node. 

• Define the more node or 

• Enter terminates definition of 
nodes, the program draws the 
multiline. 

 

 

 

� To draw polygon choose option CLOSED and keep drawing on according to the description. 

 General rectangle 

Defines a rectangle by giving the: 
� Base by two points, the height graphically, numerically or by a point of an existing object. 
� Width value and the height graphically 

Draw rectangle I. 

• Define the first corner of rectangle base line. 

• Define the second point of the rectangle base line. 

• Define the height of rectangle graphically, or numerically. 
 
Option: 

 

Draw rectangle II. 

• Select the option WIDTH. 
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• Define the width of rectangle value. Enter. 

• Define the left corner point of rectangle base. 

• Define the height of rectangle graphically. 

Draw rectangle IIl. 

• Select the option Define rectangle X/Y size... 
Dialog Rectangle size setup appears. 
 

 
 

• Type into X and Y fields the adequate values. 

• Select the reference point for the placement of the rectangle. OK. 

• Place the rectangle on the drawing. 

•  
Other options: 

Horizontal 

Vertical 
Define rectangle HV 

Multiple lines Define rectangle with multiline. 

 Polygon inscribed 

The command draws a regular n-sided polygon into a circle of defined centre. 
 

• Define the number of polygon edges (three or more). 

• Define the centre point of the regular polygon. 

• Define the position of a node. 

• Enter Terminates the command. 

 Polygon circumscribed 

The command draws a regular n-sided polygon around a circle of defined centre. 
 

• Define the number of polygon edges. 

• Define the centre point of polygon. 

• Define the position of the middle point of one side. 

• Enter Terminates the command. 

 Polygon by side 

The command draws a regular polygon. The length of sides and the number of vertices must be defined.  
 

• Define the length of sides of the regular polygon in the appearing dialog then close it with the OK button.  

• Define the number of polygon edges in the appearing dialog then close it with the OK button. 

• Place the polygon on the drawing area by its centre point.  

•  
Options: 

ANGLE Angle of rotation for positioning. 
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• Place more polygons or close the command with Enter. 

 Revision Cloud 

Revision cloud is commonly used on drawings to illustrate a design change. The revision cloud is made up of polyline 
arcs. 
 
Revision cloud works like polygon command: 

•  Define the start point and the next points of a polygon to create the cloudlike effect. 

• Complete the command by pressing mouse right click or Enter.  
 

 
 

� Revision cloud is usable for text and dimension as well. It is a new text frame around attribute selectable from the list of 

the "No bounding", "Bounding box" “Rounded Bounding box" and “Cloud” frame attribute. 

 Spline 

The program draws 
� open or  
� Closed spline on the given nodes. 

The length of tangent vector at the start and endpoints is 0. 
 

Open spline: 

• Define the first node. 

• Define the following nodes. 

• Define the control points. 

• Enter Finishes definition of 
nodes, the program draws the 
spline.  

 

� To draw closed spline, choose option CLOSED and keep drawing on according to the description. 

1.86.3. Modify polyline 

Commands for modifying can be achieved in more ways. 
 

� In the Polyline popup menu: appears when right click on an object. 
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� Description of modifying nodes is in chapter 8.9.9. Editable profile. 
 

� Graphically: 
Using grips and controls: 
 

 
 

 Move node in direction 

This command modifies the length of a polyline segment. The program adjusts the neighbouring side of the modified side. 
 

• Define the new length of the object, the new node. 
 

  

 Delete segment 

Delete the selected object of the polyline. The program deletes the object that was selected with the right button of the 
mouse. 

 Polyline -> Lines 

Polyline will be transformed into chain of lines. 
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• Repeat the command for another polyline or 

• Enter Terminates the command. 

 Polyline -> Spline 

Polyline will be transformed into spline that passes the nodes of polyline. 
 

• Repeat the command for another polyline or 

• Enter Terminates the command. 

1.86.4. Modify Spline  

Commands for modifying can be achieved in more ways. 
 

� In the Spline popup menu: appears when right click on an object. 
 

 
 

� Description of modifying nodes is in chapter 8.9.9 Editable profile. 
 

� Graphically: 
Using grips and controls: 
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 Delete part 

Delete a part of spline between two nodes. The program deletes that object of spline which was picked with the right 
button of the mouse. 

 Closed 

Transform an open spline into a closed one. 

 Tangent 

The line between the cursor and the selected spline node defines the direction of tangent at the selected node.  

 Spline -> Polyline 

Transform the selected spline into polyline using its nodes. 
 

• Select new spline to be transformed or 

• Enter Terminates the command. 

 Spline -> Polyline by selection 

The command transforms the selected splines into polyline. The spline whose popup menu was used to reach the 
command will not be transformed unless is selected again. 

 Spline -> Polyline with resolution 

The command transforms the spline; the resolution of a single curve can be defined here. 
 

• Define the resolution. The value must be bigger than 2. 

• Select the objects. 

• Enter Closes the command. 

 Spline ->Polyline with Bulge resolution 

The command transforms the selected spline to polyline and limits the bulges of arc.  
 

• Define the maximum bulge of arc  

• Define the proper radius for maximum bulge of arc. 

• Select the proper objects. 

• Enter close the command.   
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1.87. Circle and arc 
The program draws circles and arcs in anti-clockwise direction. 
 
The icons of the Circle tool: 
 

 

1.87.1. Circle and arc properties 

Right click on the Drafting toolbox  Circle tool or the  Arc tool or select the command Drafting menu - Format– 
Circle.  
 
The Circle properties dialog appears where the general properties of circle and arc can be set. 

General properties 

Set the general properties of polyline: colour, line width, layer, line type and priority. 
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� See: 
� the detailed description of General properties in Chapter 3.2.1 Specifying general properties, 
� the description of Sets in Chapter 3.2.3. Using sets of properties. 
� the description of Cost variables in Chapter 3.2.4. Assigning cost variables. 

Special properties 
Define the special properties of circle and arc. 
 

Diameter: Define the value of diameter. 
 

Radius: The program shows the radius value in an info field. It cannot be modified. 
 

Start angle: Set the actual start angle of circle. 
 

End angle: Set the actual end angle of circle. 

1.87.2. Creating circles 

Commands for drawing circles are the following: 

 

 Circle by centre point 

Defines a circle by its centre point and graphically defined radius. 
 

• Define the centre point. 

• Define graphically the radius of circle 
with a point on the circumference. 

 

 Circle with three points 

Draws circle by defining three points of its circumference. 
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• Define the first point. 

• Define the second point. 

• Define the third point. 

 

 Circle with tangent 

The command defines a circle that has a defined centre and is tangent to an object close to the pick point. 
 

• Define the centre point. 

• Define the object tangent to 
the circle. 

 

 Circle with diameter and two tangents 

Defines a circle that is tangential to both given objects near the specified points and whose diameter is the actual 
diameter. 
 

• Select the first object the circle will 
be tangential to, or 
 

Options: 

DIAMETER Modify diameter 

RADIUS Modify radius 
 

• Select the second object the circle 
will be tangential to. 
 

 

 Circle with two points and tangent 

This command defines circle that passes through the two given points and is tangential to the given object near the pick 
point. 
 

• Define the first point on the 
circle. 

• Define the second point on 
the circle. 

• Define the object the circle 
will be tangential to.  

 Circle with point and two tangents 

This command defines circle that passes through the given point and is tangential to both given objects near the specified 
points. 
 

• Define the point. 

• Define the first object. 

• Define the second object. 
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 Circle with three tangents 

This command defines circle that is tangential to all three given objects near the specified points. 
 

• Define the first object. 

• Define the second object. 

• Define the third object. 

 

 Circle with diameter, point and tangent 

This command defines a circle that passes through the given point, is tangential to the given object near the specified 
point, and whose diameter is the actual diameter. 
 

• Select the object the circle will be 
tangential to 
 

Options: 

DIAMETE

R 

Modify diameter 

RADIUS Modify radius 
 

• Define the point. 

 Circle by axes 

This command defines a circle that passes through two given points, which are the endpoints of the circle’s diameter axis. 
 

• Define the first point of diameter. 

• Define the second point of diameter. 

 

 Circle with two points and radius or diameter 

This command defines a circle that passes through two given points and has a given radius or diameter. 
 

• Define the first point of the circle. 

• Define the second point of the circle. 

• Define the placement, or 
 

Options: 

DIAMETE

R 

Modify diameter 

RADIUS Modify radius 
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1.87.3. Creating arcs 

 
  

 Circular arc with three points 

The command draws arc with defined: 
� Start and endpoints and a middle point or 
� By a defined tangent. 

Arc with start, end and middle points 

• Define the first /start point. 

• Define the endpoint. 

• Define an internal point of the arc or 
 

Options: 

DIAMETER Value of the diameter. 

RADIUS Value of the radius. 

PERIMETER The value of arc length. 

ARC Height of segmental arc. 

Arch with defined start and endpoints and a tangent 

• Define the first /start point of the arc. 

• Select the option TANGENT. 

• Define the tangent with a point. 

• Define the endpoint, or 
 

• Options: 

• RADIUS • Define the radius of arc 

• DANGLE • Define the endpoint of arc of given radius by the 
value of end angle. 

 Circular arc with centre point and endpoints 

Define a circular arc by its centre point and the two endpoints. 
 

• Define the centre point of arc. 

• Define the starting point of the circular arc. 

• Define the endpoint of the arc graphically in anti-clockwise direction or 
 

Option: 

BACKWARD Define the arc in clock-wise direction 
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 Circular arc with diameter and actual end angles 

Define a circular arc by its centre point, the actual radius, and the actual start and end angles. 
Angles are measured in anti-clockwise direction. 
 

• Place the arc with its centre point 
on the drawing area or 
 

Options: 

DIAMETER Modify diameter 

RADIUS Modify radius 
 

 

 Circular arc by a specified radius tangent to two objects 

The command draws arc with given radius tangent to two objects. The arc ends at the tangent point of the selected 
objects 

• Define the first tangent object. 
 

Options: 

DIAMETER Modify diameter 

RADIUS Modify radius 
 

• Select the second tangent 
object.  

 Circular arc by two points, and radius or diameter 

This command defines circular arc between the two endpoints using the actual radius or diameter. 
 

• Define the first endpoint of the arc, 
or 
 

Options: 

DIAMETER Modify diameter 

RADIUS Modify radius 
 

• Define the other endpoint of the arc. 

• Give the position of arc. 
 

 

 Rounding 

Define a rounded corner using the actual radius between two objects. 
The program deletes the parts outside the rounded objects and adds parts if it is needed. 

 
Two modes exist to select the objects to rounding:  
I) select both lines to adjust. 
II) If you click on the option INTERSECTION, the program deletes the line together with the closest line intersecting it.  

 

• Define the radius of the rounding or select the option PICK UP, if you refer to the length of an existing object. 



852 12. 2D objects 

 

Manual 

• Select the first and the second object for rounding or  
 

Option: 

ANGLESECTION Select an object to round it with the closest object 
intersecting it. 

 
The endpoints of objects closer to the pick point remain untouched.  
Enter  Exits the command. 
 

Further options: 

DIAMETER Define the value of rounding diameter. 

RADIUS Define the value of rounding angle. 

TRIM Enlarges the lines until their intersection point. 

  
Radius = 1m 

 

� It is important where you locate the selection point. The program calculates the rounding according the tangents of the 

pick point. 

1.87.4. Modify Circle and Arc 

Commands for modification can be achieved in more ways. 
 

� In the Arc Tool: 
 

 

Complement arc 

Line into arc 

Arc into circle 

 
� In the Shortcut menu: appears when right clicking on an object 

 

  
 

� Graphically: 
Using grips and controls: 
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 Complement arc 

Defines the complement of the selected circular arc and deletes the selected arc. 
 

• Select the arc. 

 
 

� This command can be used from the Arc shortcut menu - Complement as well. 

 Line into arc 

Transforms a line into an arc, or modifies the radius of the existing arc while keeping its endpoints. 
 

• Select the line or the arc to modify 

• Define a point of arc on the perimeter or 
 

Options: 

DIAMETER Value of diameter 

RADIUS Value of radius 

PERIMETER Value of perimeter (length of arc) 

ARC Value of height of the arc 

 Arc into circle 

Transform the arc into circle keeping the radius/ diameter of the arc. 
 

• Click on the arc you want to transform into circle. 
 

� This command can be used from the Arc shortcut menu – Close (->Circle) as well. 

 

 Modify Diameter  

Modify the diameter of the selected circle/arc. 
 

• Define the value of the new diameter. 

 Modify Radius  

Modify the diameter of the selected circle/arc. 
 

• Define the value of the new diameter. 

1.88. Ellipse and Elliptic arc 
The ellipse is defined geometrically by the focal points, length and direction of the major and minor half axes, elliptic arc is 
defined by the same properties and by the start and end angles of the arc. 
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The icons of Ellipse tool: 
 

 

1.88.1. Ellipse and elliptic arc properties 

Right click on the Drafting toolbox -  Ellipse tool, or select the command Drafting menu - Properties – Ellipse.  
 
The ellipse properties dialog appears where the general properties of the ellipse can be set. 

General properties 

Set the general properties of ellipse: colour, line width, layer, line type and priority. 
 

 
 

� See: 
� the detailed description of General properties in Chapter 3.2.1 Specifying general properties, 
� the description of Sets in Chapter 3.2.3. Using sets of properties. 
� the description of Cost variables in Chapter 3.2.4. Assigning cost variables. 

Special properties 
Define the special properties of ellipse. 
 

 

Minor axe: Set the value of half 
of the minor axe length. 
Major axe: Set the value of half 
of the major axe length 
Major direction: Set the 
direction of the ellipse or 
elliptic arc. 

 

� These settings have importance when using commands:  Ellipse tool -  Ellipse by centre point and lengths of 

axes and the  Elliptic arc by centre point and lengths of axes. 
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1.88.2. Creating ellipse 

Select the type of ellipse or elliptic arc: 
 

 

 Ellipse by focal points 

Define an ellipse by its focal points and one point on the perimeter. 
 

• Define the first focal point. 

• Define the second focal point. 

• Define a point of the circumference. 
 

 Ellipse with focal points and sum 

Defines an ellipse by its focal points and the sum of its circumferential point distances measured from the focal points. 
 

• Define the first focal point. 

• Define the second focal point. 

• Define the sum of the 
circumferential point distances 
measured from the foci.  

 Ellipse by centre point and lengths of axes 

Define an ellipse by its centre point, the actual lengths of the half axes, and the actual direction (the direction of the major 
axis). 
 

• Define the centre point. 

 Elliptic arc by endpoints of the major axis and arc 

Define an ellipse by the endpoints of major axis and the endpoints of the arc. 
 

• Define the first endpoint of the major 
axis. 

• Define the second endpoint of the 
axis. 

• Define the starting point of the 
elliptic arc. 

• Define the endpoint of the elliptic 
arc. 

 

 Elliptic arc by focal points and endpoints 

Define an elliptic arc by its focal points and the two endpoints. 
 

• Define the first focal point. 

• Define the second focal point. 

• Define the starting point of the 
elliptic arc. 

• Define the endpoint of the 
elliptic arc. 
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 Elliptic arc by centre point and lengths of axes 

Define an elliptic arc by its centre point, the actual lengths of the half axes, the actual direction (the direction of the major 
axis) and the actual end angles. Angles are measured in anti-clockwise direction. 
 

• Define the centre point of the elliptic arc. 

1.88.3. Editing Ellipse and elliptic arc 

Commands for modifying can be achieved in more ways. 
 

� In the Ellipse shortcut menu: appears when right click on an object. 
 

  
 

� Graphically: 
Using grips and controls: 

 

 Complement arc 

The command Elliptic arc shortcut menu – Complement arc defines the complement of the selected elliptic arc and 
deletes the selected arc. 
 

• Select the elliptic arc. 

 Close (->ellipse) 

The command Elliptic arc shortcut menu – Close (-> Ellipse) transforms the arc into ellipse by keeping the focal points 
or diameter. 
 

• Select the elliptic arc. 

 Modify axes by cursor 

Modify graphically the radius of the selected ellipse. 
 

• Define the new radius of the ellipse. 

 Arc -> line 

Transform the selected elliptic arc into lines crossing its nodes. 
 

1.89. Text 

With the commands of the Text set, you can create texts at specified places applying the current text properties. 
The text can be multiline text – you may type it in or insert it into the Windows clipboard. 
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� In the case of large drawings, inserting several texts in the drawing may slow down the redrawing process. 
To eliminate this, you can replace the texts by their bounding boxes. 

1.89.1. Text properties 

Before inserting texts, set the text general properties. 
 

 

To do so, right-click the Drafting Toolbox –  Text tool or select the Drafting menu - Properties   – Text command. 
The Text properties dialog box appears. 

General properties 

Define the general properties of the text: colour, line width, layer and priority. 

� See: 
� the detailed description of General properties in Chapter 3.2.1 Specifying general properties, 
� the description of Sets in Chapter 3.2.3. Using sets of properties. 
� the description of Cost variables in Chapter 3.2.4. Assigning cost variables. 

Font  

You can select the Windows True Type fonts, specify the style (Regular, Italic, Bold, Bold Italic), and the character height. 
This parameter defines the height of the character cell in the text. 

Alignment 

By this command, you can specify the current justification in the case of a multiline text. 
 

• Select an option from the list: 
 

Left Left alignment 
Centre Centre alignment 
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Right Right alignment 
 

Mirrored  
This command allows you to mirror texts. 
 

• Select an option from the list: 
 

 
OFF 
Inserts a legible text 

ON 
Inserts a mirrored text 

Style 

By activating the Strikeout option, the text will be stroked out, whereas you can underline the text if you turn on the 
Underline option. You can also specify whether you want a bounding box to enclose the text, and whether it should be 
rectangular, circular or cloud. 

Bounding 

The distance between bounding box and the text can be specified as a per cent value relative to the character height. 

 

Character width 

This setting defines character width relative to character height (percentage). By setting extreme values for this property, 
you can create very wide or very narrow characters. 
 

Character gap 

In this field, you can specify the spacing between characters. The setting defines spacing value relative to character height 
(percentage). 
 

 

0% 
 
31% 
 
60% 

Text direction 

Here you can set the current text direction. If you set 0, the text will be horizontal, while a value of 90 results in a vertical 
text. 

Gap between lines 

Here you can set the distance between the lines. The value of line spacing is interpreted relative to character height 
(percentage). 

Origin 

This command defines the origin of the text. If, for example, you choose the bottom-left option, the text will be inserted at 
the selected point by its bottom-left corner. 
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1.89.2. Creating texts 

You may insert texts using the following commands: 

 

 Place 

Using this icon you can insert a text. 
 

• Define the place of the text in the drawing. 

 Type text 

Using this command allows you to type a text directly in the drawing area. You can start a new line by pressing the Enter 
key. 
 

• Specify the place of the text. 

• Type the text. 

• Esc Ends the command. 

 Horizontal text 

The command inserts the current text horizontally at the defined point. 
 

• Specify the place of the text. 

 Vertical text 

The command inserts the current text vertically at the defined point. 
 

• Specify the place of the text. 

 Slanted text 

Inserts the current text slanted by a specified angle. 
 

• Define the angle of the slanted text. 
Options: 

PICK UP Applies an angle similar to that of the 
drawing object. 

Type the value... Numerically defined angle 
 

• Define the place of the text. 

 Perpendicular text 

The command inserts the current text perpendicular to the selected object. 
 

• Select the perpendicular object. 

• Specify the place of the text. 

•  



860 12. 2D objects 

 

Manual 

 Text in table 

You can create a table by describing the columns and rows the table is going to have. 

 
 
When the Keep settings for new tables are on, the current column and row number will be the new default value.  
 
Now you can place the new text table with empty text fields. 

Table text editing commands  

Select the table on the drawing with a left click to change its content or properties. 
 

 
The text table management tools are linked to markers. 

Table text properties  

If you click on the top left square marker, you can modify the table text properties with the following dialog box. 

 
 

 
 
Border line 

 
Border line width 

 
Border line colour 

 
Show invisible lines 
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Table text - Edit column  

To edit a column in a table text, follow these steps: 
 

• 1. Select the table 

• 2. Click the blue field above the column 

• 3. On the submenu, select a command how you would like to modify the column. 

 

Remove column  

Select the column to be deleted. 

Insert column to the left 

Insert a new column to the left of the column that is selected  

Insert column to the right 

Insert a new column to the right of the column that is selected. 

Resize column  

You can resize the width of a column with dragging the right line at a new position, and the column to the left of the line 
that is dragged, is resized. The part of the table to the right of the column that is resized will be repositioned (and not 
resized). 

Table text - Edit row  

To edit a row in a table text, follow these steps: 
 

• 1. Select the table 

• 2. Click the blue field left to the row 

• 3. On the submenu, select a command how you would like to modify the column. 

 

Delete row 

Select the row to be deleted. 

Insert row above 

Insert a new row to the top of the row that is selected. 

Insert row below 

Insert a new row to the bottom of the row that is selected. 



862 12. 2D objects 

 

Manual 

Edit fields 

You can edit a cell by selecting an existing table and click inside the cell. 
 

 
 
This dialog box can be used to control the following settings: 
  

 
 

 Input field  

When you press the Fill cell button, the text input is updated into the selected cell. Each field can be a multiline string. 
Alignment of columns and rows are handled dynamically. 

Cell Alignment 

It determines the vertical and horizontal position of the text within the cell: 
Left aligned text, right-aligned text or centred text 

 

Effects 

The effects property is used to specify text as bold, italic, underline or strikeout.  

 

Font names 

Choose from the list of font family names installed on your operating system. 

Colour 

This dialog defines the text colour. 

  

Font width 

You can change the font width. The value of font width is interpreted relative to font size (percentage). Type the 
value in % of font size or choose it from the list. 
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Character spacing 

You can change the spacing between characters. The value of character spacing is interpreted relative to font size 
(percentage). Type the value in % of font size or choose it from the list. 

 

Line spacing 

You can change the spacing between lines in case of multiline texts. You can stretch or compress an entire 
multiline text to make it fit and look the way that you want it to. The value of line spacing is interpreted relative to 
font size (percentage). Type the value in % of font size or choose it from the list 

 

Font size 

You can specify the font size in mm.  Negative values are not allowed. 

 

Set as global 

Set as global button applies all text formatting properties of the selected cell to the whole text table. 

 

Fill cell 

Fill cell button applies text changes of the selected cell. The changes are applied immediately and there is no need 
to close the dialog with OK button. 

 

Merge cells into one cell in a table 

You can combine two or more cells in the same row or column into a single cell. 
Press the „>” long vertical button to make the options visible. 
 

 
 

 

Merge right 

Select the cell you want to merge to the right. The contents of the cell to the right will be deleted. 
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Before merge Merge 

Merge down  

Select the cell you want to merge to the cell below. The contents of the cell below will be deleted. 

 
 

Before merge Merge 

Split right 

Select the cell you want to split to the right. The new cell will be empty. 
 

  
Before split Split 

Split below  

Select the cell you want to split to the below. The new cell will be empty. 

  

Before split Split 

 

 Text with pointer 

You can insert the text with an arrow pointing in a specific direction.  
The pointer consists of a chain of segments (not more than two segments), which ends in an arrowhead. 
You can select the object at which you want the text to point. 
 

 

 Find and replace 

Using this new tool, you can find and replace texts. Special characters can also be used to extend search. Click on 
Drafting menu – Text – Find and Replace command.  
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Search  

Type the text into the search field. 

Replace  

Type the text you would like to use as replacement of the search result when Replace or Replace all is pressed. 

Match case 

The search can be set as case sensitive with this option. Otherwise, the software will not make difference between 
uppercase or lowercase characters. 

Search hidden layers 

Enable this option if you want to extend the search for hidden layers also. 

Find next 

Push this button if you want to begin or continue the search for the next possible match. 

Replace 

Click on Replace to replace the result of search by the text given in the replace field. 

Replace all 

Click on Replace all to replace all the results of search by the text given in the replace field. 

 Place tooltip text 

The  icon in the Text tool menu allows you to place tool tips in the drawing. We mean those tool tip information tables, 
which will appear when you drag the mouse pointer over a given architectural object. In the case of wall, for example, the 
followings will be displayed in the tool tip: 
 

 
 

• After clicking the  icon, select the object about which you want to place a tool tip information table in 
the drawing. 

• Insert the table with the mouse: 
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! The inserted tooltip table is still 

linked to the selected object, i.e. 
it follows the modifications of the 
object. 

 

 

 

 Insert comment  

Comments, that are not visible on the printed document, can be placed on the drawings in a yellow label. The label should 
be a rectangle. 
 

• Click Text -  Insert comment icon. 

• In the appearing text input dialog enter the comment you want to place. Ok. 

• Click the object to which you want to connect your comment. In that case, the comment will be connected 
to the object. Moving or deleting the object will move or delete the connected comments as well. If you just 
want to place a comment without connecting it to an object, click the right mouse button (or press Enter). 

• Place the text on the drawing. 

 

 Insert text in 3D 

3D text is a new feature to place text in 3D window directly. You can place it on any plane, for example a wall face. You 
can specify the 3D depth, the text properties, and apply material to 3D text. 
3D text is editable so can change the text or the text properties any time. 
 

 
 

You can place and modify 3D letters on 3D plane with the  Insert text in 3D command. 
 

• Select a 3D window you want to work in. 

• In the text properties dialog set the desired font type, height, and other properties, if necessary. 

• Select the  Text tool-  Insert text in 3D command  
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• Type the appropriate text in the Input Text dialog. 

• Select a planar surface of a solid to place the text. 

• Specify the place of text on the selected surface (the bottom left corner of the text). 

• Specify the direction of text, or press the Enter, if the local 3D x axis is horizontal. 

• Enter the width of the text. 
 
The 3D text behaves as a 3D solid. You can modify its properties by double clicking on it: 
 

 
 

• If you want to change the font style and letter height with the actual text properties, use the Regenerate text 

with current 2D text set values option. 

1.89.3. Modify texts 

When you right-click the text, the Text shortcut menu pops up which contains the following modifying commands: 
 

 

 Modify text 

You can modify the selected text without changing its properties. 
 

• The Text actual dialog box appears where you can modify the selected text. 
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� You may also modify a text by double-clicking it and pressing the ’text’ button at the bottom of the appearing Properties 
dialog box. Again, the Text actual dialog box will pop up. 
Text Table allows you to create and edit group of texts in a formatted way. In this release, the text table management tools 
are linked to markers.  
 

1.90. Hatch 
With hatch commands you can apply different hatch patterns to enclosed areas. 

1.90.1. Hatch properties 

Before applying hatch to the desired area, set the global properties of hatching. 
Right-click on the Drafting toolbox - Hatch tool or select Drafting menu - Properties– Hatch command to display Hatch 
properties dialog. 

 

 Hatch general properties 

Set the general properties of the hatch: colour, line width, layer and priority. 

� See: 
� the detailed description of General properties in Chapter 3.2.1. Specifying general properties, 
� the description of Sets in Chapter 3.2.3. Using sets of properties. 
� the description of Cost variables in Chapter 3.2.4. Assigning cost variables. 

Special properties 

The program offers three types of hatches: 
 

� Normal hatch and 
� Gradient hatch 
� Image filled hatch 
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You can also set the 
 

� Transparent hatch 
This means that both the hatch background colour and the solid hatch are transparent. Transparent hatches always have 
pale colour. 
 
Example: 
On site plans there can be a need of merging sites, for example. It can be represented by hatch. At the same time, the 
original state should be represented underneath the hatch, too.  
By selecting the Transparency option, we can resolve the above mentioned task. 

 
 

� Hatch boundary 
You can use this option, when you define the contour of the area to be hatched as an imaginary polygon boundary. 

Normal hatch 

• Enable the Hatch option. 
 
 

 

 
Hatch spacing: 150 mm 
 

Angle: 45° 

 
 
Background colour: grey 
 
 
Colour: black 
 
 
Dash length: 250 mm 

Solid hatch 

The hatch can be defined as a solid hatch, too. For this enough to select the Solid option. 
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Hatch spacing (Y value) 
 
Define the line spacing of the hatch (in drawing units). The distance between the hatch lines is to be understood 
perpendicular to the hatch direction (y direction). 

Dash length (X value) 
Define the line spacing of the hatch (in drawing units). The distance between hatch lines is to be understood parallel to the 
hatch direction (x direction). 

Angle 
Define the direction of the hatch lines in angles (relative to the horizontal direction). 

Name 
Show you the name of the hatch pattern. 

Background colour 

 You can set the background colour for the hatch. By default, there is no background colour. 

 Pattern  

This command defines the pattern of the hatch. Click on the icon to display Hatch parameters dialog. If you click on the 
name or the image of the hatch, a choice of predefined patterns to choose from appears (architectural markings: brick 
wall, stone wall, pebbles, etc., patterns: ceramics, wall patterns, etc. The specified hatch spacing and dash length values 
determine the dimensions of a single unit of the pattern along the two main directions. 
 

 

 

New category 
Enter the name of the new category in the appearing field. The category you created is displayed in the list of hatch 
categories; you can rearrange the existing hatch patterns between the categories. 
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Move to another category 
Move a pattern to a selected category. Choose the pattern type you want to move to another category, and then select the 
desired category from the pull-down list. (The program asks you if you are sure about moving the pattern.) 

Delete 
Delete patterns and categories. The program asks you if you are sure about deleting the selected pattern.  
Only user-defined patterns can be deleted. 
 

! Only delete newly created patterns, because this modification will affect all patterns of the same name in the plan, and 

the patterns in completed plans that have been open, also get deleted. 

New pattern 

 
 
To create new patterns you can use the program’s default 2D pattern groups, but there is a possibility to apply user-
defined patterns (2D groups). 
 
Select the option Internal group to display hatch patterns. Choose a pattern and specify its name. Select the category 
where you wish to place it. 
 
With the command Keep aspect command, you can display the pattern in its original proportions; the option Shift even 
rows shifts every other row relative to the previous row. 
 
The pattern you defined is displayed in the list of hatches. Consequently, after setting its properties (hatch spacing, dash 
length, and pattern direction) you can apply it as one of the hatch patterns. 
 
 
By selecting User group those hatch patterns are displayed that you defined with the command Tools menu – 2D group – 
Create new hatch pattern: 
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The hatch patterns selected with the abovementioned methods can be used to apply hatch to floor plans (e.g. 2D display 
of walls), to create precise drawings of front views, for 3D material display and to demonstrate cross-sectional cutting 
planes. 

Modify 
This command modifies the properties of user-defined patterns: name, category, keeping proportions, pattern type etc. 

AutoCAD® style hatches 
In case of importing AutoCAD® drawing, default AutoCAD® style hatches are recognized automatically and handled 
differently from ARCHLine.XP style hatches. This means that scaling and rotating are the only possibilities for AutoCAD® 
style hatches, similarly as users can do it in AutoCAD®. 
 
For selecting these hatches switch on the AutoCAD® style hatches option. 

� See the 4.5.2.5. AutoCAD® style hatch selection, 4.5.2.6. Merge to built-in patterns and 4.5.2.7. Limitation 
chapters. 

 Hatch boundary 

You can set whether to show the hatch boundary or not. 
This option can be very useful when adding hatch to an area enclosed by a polygon boundary. The hatch boundary has its 
own properties. 
To set hatch boundary properties you should enable the option Show hatch boundary. Then select the option 

 on the left side of the dialog. In the dialog box appearing you can set the colour, the line type and line 
width of the hatch boundary. 
 

 
 

 Gradient hatch 

Enable Gradient option in the Hatch properties dialog to specify the properties of shaded hatch: 
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Type of shading: linear, centric, conic, quadratic. 
Angle: defines the direction of the hatch lines. 
Division: defines hatch density. 
Colour from – colour to: defines the lightest and the darkest shades. 
Origin: defines the origin of the light. (This is the focus of the shaded hatching.) 

 

Type: 
Conic  Quadratic Centric 

Origin: Centre Centre Centre 
 

� We suggest that you use shaded hatch when you wish to apply hatch to a 2D front view. In this case, you can add 

quadratic shade to the hatch of the glossy window panes. Try it! 

1.90.2. Hatch types 

Hatching means filling enclosed areas. With ARCHLine.XP you can fill such areas in the following ways: 
 

� with homogeneous colour, 
� with lines, 
� with a predefined pattern, 
� With image. 

 Filling with homogeneous colour 

Fill the selected area with homogeneous colour. 

The hatch can be defined as a solid hatch, 
too. For this enough to select the Solid 
option in the Hatch properties dialog. 
 

 

 Filling with lines 

This is the standard hatch type. 
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You should set the parameters of the hatch 
lines (pattern direction) in the dialog box 
Hatch properties. 

 

 Filling with predefined patterns 

This option fills a selected area with a predefined pattern. 
The patterns are basic graphical objects. The program offers 65 patterns to choose from in the dialog box Hatch properties 
– Pattern – Hatch parameters. 

You can modify the dimensions of 
the pattern. 
X direction: dash length 
Y direction: hatch lines 

 
 

Based on the program’s internal pattern 
groups or on user-defined groups you can 
also create a predefined pattern. 

 

� See point 11.7.1.1 Normal hatch and 

11.9.10 Creating hatch patterns. 

 

 Image filled hatches 

In ARCHLine.XP you can use images as filling for hatch areas. This option can be found in the Hatch Properties dialog. 
 

Properties: 

Hatch / Material option 

This setting allows you to set textures as hatch filling. 

Material setting 

This setting allows you to choose a material from the material library to use it as hatch filling. Click on the browse button to 
browse and select a material. 

 

Origin 
This setting allows you to set different texture alignment options for the material of the filling. 
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How to use image filled hatches? 

To use image-filled hatches, select the Material option in the Hatch settings section in the hatch properties dialog window 
and click on the Modify button at the Material property to select a material. 
 
When a material is selected, you can set its distribution origin as well, by using the Origin options. 

Filling a closed polyline or arc 

You can fill open or closed polyline, arc or ellipse in your drawing with solid colour, a one- or two-colour gradient fill, hatch 
pattern and texture. Filling with hatch pattern, you can select any predefined hatch pattern, or your own hatch pattern. 
Filling with texture you can choose any texture from the material library. 
 

 

1.90.3. Creating hatch 

The hatch is an individual drawing object. There is no strong relation between the hatch boundary and the hatch itself. You 
can delete or modify the object or the chain of objects enclosing the hatch without deleting or modifying the hatch. Of 
course, this does not apply to the hatch boundary when you add hatch to an area enclosed by an imaginary polygon. 
The hatching may consist of several, unconnected parts. Hatches created at the same time (e.g. if you select more than 
one closed contour lines) are considered as one object, so these can be modified together. Therefore, if you wish to 
modify a hatch, the command will apply to all hatches created at the same time. 
 
Hatching can be created with the following commands: 
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 Hatch by Pick point 

You can add hatch to a selected, 
enclosed area. To select the area you 
only have to click somewhere inside it. 
 

• Select a point inside the area to be 
hatched. 

 
 

! If you select more than one area, and the area you selected second is an inner chain of the first one, this area will not be 

hatched. 
 

� Make sure you select that side of the enclosed area where wish to add hatch. 

 Hatch by Pick point and island detection 

This command hatches a selected, 
enclosed area. To select the area it is 
enough to click inside it. 
Every closed chain of lines (island) inside 
the area will not be hatched. Island 
detection only goes one level inside, so 
the program does not search for islands 
inside the islands. 
 

• Select the area to be hatched. 
  

 Hatch imaginary polygon 

Hatches an area enclosed by an imaginary polygon. You can define this polygon with its apexes. 
 
Options: 

CIRCLE To define the area to be hatched, you can apply 
methods used to draw a circle.  

SHIFT You can shift the hatched area to a certain distance 
relative to the defined polygon. 
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WIDTH You can specify the path by a chain of lines and arcs. The 
value you specified in the dialog box defines the width of 
the path you wish to hatch. 

 

• Specify the apexes of the polygon. The polygon may contain arcs. 

• Enter Completes specifying the polygon and connects the first and the last apex. 
 

! If you select more than one area, and the area you selected second is an internal chain inside the first area, this area will 

not be hatched. 
 
Example: 

CIRCLE SHIFT WIDTH 

 
  

 Hatch imaginary polygon with island detection 

This command hatches the inside of an imaginary polygon, leaving out the closed chain of lines inside it. To define the 
imaginary polygon, specify its apexes. 

� For detailed description, see point 11.3.3.3 Hatch imaginary polygon. 

 Hatch by selecting boundary objects 

Hatches an enclosed area whose objects you selected one by one. 

• Select the sides of the object to 
be hatched one by one 

 
 

! Make sure you select an enclosed area. The intersecting parts of the areas to be filled behave like islands and remain 

without hatch. You can select the objects clockwise or anti-clockwise, but you must follow a sequential order. 

 Hatch 3D surface by Pick point 

With this command: 
� You can add hatch to a selected 3D plane. To do so, you have to specify the origin and the direction of the hatch. 
� You can delete a 3D hatch. 

Hatching 3D planes: 

• Select the plane of an object, which you wish to hatch. 

• Define the origin of the hatch on the selected plane. 

• Specify hatch direction. 
 

Option: 

ENTER The direction is the local 3D x-axis. 
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Deleting 3D hatches: 

• Select DELETE. 

• Select the plane from which you wish to delete the hatch. 

 Hatch 3D surface by Pick point and island detection 

With this command: 
 

� You can add hatch to a selected 3D plane, while the islands remain without hatch. To do so, you have to specify the origin 
and the direction of the hatch. 

� You can delete a 3D hatch. 

� For detailed description, see point 11.3.3.6. Hatch 3D surface by Pick point. 

1.90.4. Editing hatch 

Hatch editing commands can be enabled from the following locations: 
 

� Hatch tool: 

 

Text boundary 
Modify text boundary 

 
� Shortcut menu: 

 

 

 Text boundary 

The icon works as a button, which you can turn on or off. If you enable the option Text boundary, the program creates a 
boundary in the hatch pattern for the measurements, arrows and texts so that these are easier to read. 
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Text boundary ON 
 

Text boundary OFF 

  
 

! If you wish to create a boundary for texts, measurements or objects that are already hatched, apply the icon  

Modify text boundary. 

 Modify text boundary 

Modifies the text boundary created in a hatch pattern for texts, measurements or objects: 
 

� Deletes the boundaries in the hatch pattern created for the selected objects. 
� Creates new boundaries in the hatch pattern for the selected objects. 
� Deletes all boundaries created in the hatch pattern and creates new ones when necessary (e.g.: if the measurements of 

the object is modified), so it refreshes the hatch. 

Deleting the text boundary from the hatch pattern: 

• Select DELETE. 

• Select the appropriate text boundaries in the hatch that you wish delete. 

• Enter Deletes the selected text boundaries. 
 

Option: 

ALL Deletes all text boundaries. Select the hatch from which 
you wish to delete all text boundaries. 

Creating new text boundaries: 

This command creates new text boundaries for the selected objects. Cuts out a rectangular area from the hatch pattern 
around the selected object. 
 

• Select INSERT. 

• Select the hatches on which you wish to create new text boundaries. 

• Enter Completes the selection. 

• Select the texts, measurements or objects around which you wish to create a rectangular boundary in the 
hatch pattern. 

• Enter Creates the new text boundaries and completes the selection. 

Refreshing the hatch: 

• Select REGENERATION. 

• Select the hatches on which you wish to create the necessary text boundaries. 

• Enter Completes the selection. 

• Enter Completes the command. 

� See 11.3.4.1.  Text boundary for more details. 
After the hatch is created you can modify it using the Shortcut menu - Modify hatch origin command 

 Modify hatch origin 

With Shortcut menu −Modify origin command, you can modify the origin of the selected hatch and shift the hatch pattern 
on the selected area. 
 
By default the hatch global origin is the 0 0 point on the drawing. 
 

• Specify the new origin of the hatch. 
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Different origins Same origin 

 Editing hatch contour 

With the commands Shortcut menu − Edit and Closed chain you can edit the hatch contour: 
 

 
 
With the commands in Closed chain it is possible, for example, to create „holes” in a hatch pattern. 

� For a detailed description, see Chapter 8.9.9 Editable profile  

 

 Operations with regions 

With the commands of the Shortcut menu − Operations with regions you can unite or extract hatches, add hatch to the 
common part and omit this part from the hatch: 
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Union 

Unit the selected hatches. The hatches selected afterwards will have the properties of the hatch selected first. 
 

• Select the hatches to be united, or the closed objects whose contours you wish to unite for hatching. 

• Enter Completes the selection and unites the hatches. 

 

Extract 

Extract one from the other of the selected hatches. Select a hatch and the program extracts from this the hatches selected 
afterwards. 
 

• Select the hatches to be extracted. 

• Enter Completes the selection. 

 

Intersection 

Create a common part (intersection) of the selected hatches. The hatches selected afterwards will have the properties of 
the hatch selected first. 
 

• Select the hatches or closed objects whose intersection you wish to create. 

• Enter Completes the selection. 
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Omit intersection 

The program creates the „symmetric difference” of the selected hatches. This means that it produces a common part, and 
then omits it from the union of the hatches. The hatches selected afterwards will have the properties of the hatch selected 
first. 
 

• Select the hatches or closed objects whose symmetric difference you wish to create. 

• Enter Completes the selection. 

 
 

 

1.91. Raster images 

Introduction 

Raster images are part of the drawing. Raster images behave like other drawing objects, so you can rotate, move, copy, 
scale, clip them as well.  
You can apply special commands for raster images like adjust an image for transparency, crop, and clip the image with a 
rectangle or polygon. 
 
The image file formats supported by ARCHLine.XP include the most common formats like BMP, PNG, JPG, and TIF. 
Images can be 1-bit black and white, 8-bit, 16 bit, or 24-bit colour depth. ARCHLine.XP supports the transparent pixels. 
Transparency is scalable between 0-255. 
 
ARCHLine.XP can import Raster file formats that support transparency include GIF, PNG, BMP, TIFF, through an alpha 
channel. 
 

Select the raster image by click on image boundaries or click inside 

You can set the selection method for raster images in the Options Dialog – Item Settings tab: 

• Click on image boundaries or 

• Click inside. 
 
The raster image becomes part of the project when you save it.  

1.91.1. Insert raster image 

To insert and place a raster image, you can use the Drafting menu – Raster image command.  
The Open image dialog will pop up. 
 

� The maximum size of a raster image is limited to 30 mega pixels. Although you can insert larger image into a project, the 

program will automatically reduce its size to the limit. 
 

• If you cannot find the image selected in the default directory, browse for the relevant folder and open the 
image. 

• Click Open to close the Open image dialog. 

• Once you have selected the image, ARCHLine.XP brings up the image Dialog where you can enter the 
insertion point, change size, rotation and general properties. 
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Name 
In the Image dialog, click on the Browse button, if you wish to select another file. 

Path  

You can attach a reference to a raster image file to a drawing file using a linked image path. 

Embedded or External Reference  

 

Images can be placed in drawing files like external references (linked) and these images are not part of the drawing file. 
The image is linked to the drawing through the full path name. 

 

When you place images as (Attached) in your drawing it increases the drawing file size with the image file size. 

Insertion point 

• You can type the global X, Y coordinate of the insertion point into the fields you can specify it later 
graphically. 

Size 

• You can define the size of the image by typing the value in the fields or you can specify it later graphically. 
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The selection mode can be personalized. There are two ways to select a raster image by clicking the inside area, or select 
raster images by their visible frames only. In this mode, the inside area is not sensitive. The selection mode can be 
selected in File - Options dialog Global Values panel. The Image frames are displayed on the screen but NOT plotted. 

1.91.2. Manage raster images 

Raster images can be managed in the Image manager dialog: you can attach, detach, reload, hide an image or show only 
its frame on the current drawing. 
 
Click the Drafting menu – Image Manager Command. The Image manager dialog appears with a table. 
 

� You can activate the Image Manager dialog from the shortcut menu of a selected raster image on the floor plan, too. 

 

 
 

Name 
Show the file names of the loaded images. When a row is selected in the list, the full path name of the selected image file 
is shown on the bottom of the dialog. (See below: To change an Image path). 

Status 
Right after opening the image manager this column shows the status of each loaded image: Loaded, frame or hidden. 
Later you can specify what to do with the images; for example, you can unload reload, hide or show only the frame of a 
loaded image. Accordingly, you may see the Unloaded or To Reload status as well. 

Size 
Show the file size of the image. 

Type 
Show the file type of the image. 

Date 
Show the last date when the image was modified. 

Path 
Show the full path name of the image. 
 
In the Image Manager dialog you can manage the images as follows: 

Attach 

Attach an image in the appearing Open image dialog. This command is identical with the Drafting menu –Raster image 
command. 
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Detach 

Detaches (unloads) the selected image from your drawing. When you detach an image, all instances of the image are 
removed and the link to the image is removed. 
 

• Select the image name you want to detach (unload). 

• Click Detach. Click Ok. 

Reload 

This option loads again and displays the latest version of the image. 
 

• Select the image name that you want to reload. 

• Click Reload. Click Ok. 

Frame / Hide off 

You can show the image only with its frame if you do not need to show it the current drawing. Images with frame only are 
not displayed on the screen and only the frames will be printed. You can see only the rectangle frame of the image. 
 
To represent an image only with its frame: 

• Select the name of the image you want to represent only with its frame. 

• Click Frame to display only the frame of the image. Click Ok. 
 
To turn back to the original representation of the image: 

• Select the name of the image represented currently with its frame only.  

• Click Hide off to display the image. Click Ok. 

Hide On / Show 

You can hide images you do not need to show in the current drawing. Hidden images are not displayed on the screen and 
not printed at all. (Even the frame is not printed) 
 
To hide an image: 

• Select the name of the image you want to hide on the drawing. 

• Click Hide On. Click Ok. 

•  

• To turn back to the original representation of the image: 

• Select the name of the hidden image. 

• Click Show to display the image. Click Ok. 

Preview 

Clicking on the Preview the selected image appears with its properties. 
 

 

Properties 

Clicking on the Properties the Image dialog appears. 
You can modify the properties of the image. 
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� See the description of the Image dialog in the chapter Insert raster image. 

1.91.3. Edit raster images 

Select the raster image whose properties you want to modify. Click on Properties or right-click on the raster image and 
choose Properties form the Menu. 

Modify properties 

Choosing the Properties command from the shortcut menu, you can modify its properties. Beside the general properties, 
you can specify the background image location, the image size, rotation and transparency. 
 
By default, the raster image is saved into the project file. However, if you want to reduce the file size of your project, use 
the Insert only as reference option. With this option, only the path of the raster image will be saved. 
 
The dialog box displays the current size of the image and you can enter the new size here. Although no part of the image 
will be lost, its resolution decreases. 
 

� If you use the Insert only as reference option, do not forget to keep your raster image with its original path name, 

otherwise you will lose your raster image. 

Stretch 

Graphically stretches the raster image. When you click on the STRETCH option, the proportions of the image change 
during the transformation. 
 

• Specify the corner point of the image to stretch it. 

• Specify the endpoint of the stretching. 

Grips 

The raster images behave like any other drawing objects, so you can resize it using the Move palette – Scale command or 
using the Resize control grip of the selected raster image. 

  
 

Crop  

The command of cropping an image involves selecting the part of an image that you want to display and deleting the rest. 
The cropped image takes less space in the memory as the original image. 
 
Click on a Raster Image, and select the Crop command from the context sensitive menu. 
Move the sensitive rectangle boundary lines to the part of the image you want to show. 
Click on ENTER to close the command. 
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Flip  

You can flip a raster image horizontally or vertically:  

 
 

Clip the image with a rectangle or polygon 

You can clip a raster image in two ways:  
 

� with transparency or  
� with background colour.  

 
The clip is valid for the area of the polygonal boundary. You can choose the part of the image to be displayed:  

� inside or 
� outside of the polygonal boundary 
 

 
 

• Select the appropriate command from the shortcut menu. You can clip a part of the raster image. 
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• Specify a closed profile to mark the part to be clipped. 
 

  

 
 
 

 

Frame / Show 

You can hide images that only the image boundary is displayed. Hidden images are not displayed or printed. You can 
select the command from the Shortcut menu: 
 

• Click on the raster image on the floor plan with your right mouse button. 

• Select Frame / Show command to make visible or invisible the raster image. 
 

3D: Show/Hide Raster image 

You can display the raster image in 3D window placed on the current floor elevation. 
Later, you can switch off the 3D view of the raster by the Hide in 3D command. 
 

• Click on the raster image on the floor plan with your right mouse button. 

• Select Show in 3D command to show the raster image in 3D: 
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� When you delete the raster image form the floor plan, the 3D image will be deleted too. 

Flip 

This command mirrors the active image – i.e. rotates it by 180 degrees –horizontally or vertically. 

Rotate 

When using this command, the rotate image dialog box appears. Specify the angle of rotation. 
When selecting the Free option, enter the desired angle of rotation and choose between the methods of Expand or Clip. 

Expansion 
Use this option to modify the size of the image according to your needs. This option rotates the image with the specified 
angle; however, the full image is displayed in the original frame. Consequently, the size of the image must be decreased. 
 

Save as 

Using the Shortcut menu - Save as... Command you can make a copy of the image. You can save the image under a new 
name or to another location. 

1.91.4. Google Earth Plugin 

The ARCHLine.XP Google Earth Plug-in enables the living connection between your architectural 3D model and the real-
world environment.  
 
You can design your building where it will be located in the real world. You can visualize the building shadow in the 
morning or in the afternoon. 
 
Download the satellite image using the free version of Google Earth and import with one click into ARCHLine.XP.  
Place your architectural model or environmental impact into this real size, calibrated image in 2D or 3D window and 
display the new realistic environment of your design.  
 
Furthermore, you can export the model into Google Earth with one click again! Make your new presentation or simply view 
your building in colourful real-world environment. 

How to use it? 

• Open Google Earth and navigate to your location e.g. Rome. 

• Fly to the appropriate height to see well the required environment. 

• Go to ARCHLine.XP open the Google menu and click on Import from Google Earth command.  

•  
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•  
 

 
 

• Create or import your model in 2D plan over this Google™ image  

• Generate 3D model together with the imported Google™ image 

• Navigate in 3D to view and study the real world contact 

• Open the Google menu and click on Google Earth-export command to save your model as KML file (the 
supported file format by Google™ Earth) 

• Open the Google Earth again and import your KML file you saved before. Your model is displayed on 
Google™ Earth. Enjoy the view! 
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1.92. 2D group 

The 2D group command's aim is to integrate the objects found on the drawing, and preparing them for collective 
commands to execute. When any of the group's objects has been selected, all objects become selected belonging to the 
group. Graphical properties can be modified together. When creating the group, it can be saved in an OLI file, so it can be 
used in any plan later. The Explode command restores the original objects. The group can be edited uniquely: right-click 
on the group and choose the Enter into group command. After finishing the editing the group has to be closed: click on any 
object of the group and choose Close group command. 
 
Modifying of the placed group is only available for the given object. 
Creating and using 2D groups on the plan makes easier to handle the objects of the group together: 
 

� Using - Saved in an *.OLI file the group can be used in any plan later. 
� Moving, rotating - The objects of the group can be transformed one by one. 
� Editing - The objects of the group can be edited by entering into the group. 

 
Explode command restores the original objects. 

Local group 

Usage of local group is recommended if more objects are handled together on the actual plan. This group will not be 
saved in the group library; it cannot be loaded into other project. A local group can contain groups. 

Global group 

Usage of global group is recommended if the group is going to be used in other projects as well. Groups can be loaded 
from the Group library. A global group does not contain groups. 
 
Groups are described by the following components: 
 

• objects of the group , 

• Reference points or hotspots added to the group in arbitrary 
number. A group can be placed by the active hotspot. 

• Individual name. 
 
Place groups by command Tools menu – Insert group, or from the 
Design centre. 
Default groups of the program are in the Groups library.  
 
Groups created by users will be saved in the selected category.  
User defined groups cannot be saved in the default categories 
(these are marked with grey). 
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Group name with special characters 

When groups are created, the following special characters can be used in the group name: 
 
Space, 
& ! @ $ % + = ( ) [ ] { } ' ; , ~ 
 
 
The following characters cannot be used: 
\   ?   |   >  <   :  /  *  " 
Operations with 2D groups are available in Tools menu: 
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1.92.1. Group properties 

All groups have general properties. 
These properties cannot be changed directly. Click on the Property command in the shortcut menu of group. In the 
appearing dialog, modify the colour, line thickness, layer and priority of the group. 
 

� See:  
� detailed description of General properties in chapter 3.2.1. Setting general properties 
� description of Sets in chapter 3.2.3. Attribute sets. 
� description of Cost parameters in chapter 3.2.4. Define cost parameters. 
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When setting the general properties of group objects (colour, line thickness, and line type) there is possibility to set the 
Group properties as well. This may have importance if the properties of the group (colour, line thickness, line type) are 
controlled by the settings of group general properties.  
 
If properties of all objects of the group are controlled by the group properties settings, it is not necessary to set it in the 
case of each object, apply group properties to objects.  
Select from the options which properties will be forced to all the objects of the group. Layer, colour, line thickness, line 
type.  
Now all objects of the group take up the forced properties even if the properties of the objects were not selected earlier to 
be Group type. It is important to mention, that after applying the force option and then switching it off the original state will 
not be reset. It can be done only by entering the group and defining the properties of each object one by one. 
 
Let us see an example to make this function clear. 

Example: 

Create a group with three objects.  

� See chapter 11.9.2. Creating group. 
Draw two lines and a circle each line thickness 2.11 mm. 
 

• Enter the group by right clicking and selecting the command Enter into group.  

• In the case of circle set: 
 
Colour: Group 
Line thickness: 2.11 
Line type: Line 
 

• In the case of lines set: 
Colour: red 
Line thickness: 2.11 
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Line type: Group 
 

• Close the group by right clicking on any of the group objects, click in Close group command. 

 

 
 
Colour of the group is black, line 
type is Line. 
Therefore the colour of the circle 
becomes black, the colour of the 
lines remain red. 
 

In this group the colour of the 
circle and the line type of line will 
be controlled by the group general 
properties.  

 

• Right click on the group and select from the popup menu Modify command.  
Now set the group general properties. 
 
Colour: green 
Line thickness: 0 mm 
Line type: dotted 
 
Do not sign any of the Apply group properties to objects options in the bottom of the dialog, it will be explained later. 
 

 

The result: 
circle: 
colour: green 
line thickness: 2.11 mm 
line type: Line 
line: 
colour: red 
line thickness: 2.11 mm 
line type: dotted 
 
 

•  
Colour of the circle becomes green, because its colour was set Group. The line becomes dotted for the same reason. 
Line thickness will not be changing for any of them (remains 2.11 mm), because their line thickness is not Group type, but 
defined by value (in the example 2.11 mm). Group settings have influence on those properties of group members that 
were set to Group. 
 

• If the layer and line thickness properties of the group are to be applied to all the objects of the group, check 
in the Force layer and Force line thickness options. 

The result: 

 

Line thickness of both the lines 
and the circle becomes 0 mm. The 
circle and the lines will be placed 
onto the _Layer 0 layer.  
 

This state will not be changed in the 
following if you enter again into 
Properties dialog and check off the 
Force options. 

 

1.92.2. Creating group 

Steps of creating new 2D group and saving it into the Group library are the following: 
 

• Select the existing objects of the drawing area that you wish to handle as a new group.  
Enter Closes the selection. 
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• Define the hotspots. Any of the selected hotspots can be used later for placement the group, Or 

• Enter to use the corner points of the enclosing box of the group as reference points 
 
The program uses point pairs for adjusting the group on a line 

Enter Closes the definition of hotspots. 
 

� You can assign to the group so reference points, which are out of the enclosing box of group objects.  

 

• Give the name of the new group. Use alphanumeric characters; there must not be space in the name. 
OK Closes the dialog. 

 

 
 

• Select the group category where you would like to save the new group. If no such category exists, create it.  
 

� When selecting objects for a new group you can choose groups that 
already exist on the plan. These will not be subgroups in the new group. 
This is available only for local groups. 

 

 

Parametric groups 

Text can be part of a group. If a text starts with $ character, the program handles it as a variable. Values can be assigned 
to variables. These are parametric groups. 
Presentation of variables can be set in Group - Parameters command. 

1.92.3. Creating group from architectural objects 

Design offices often use pre-defined modules (drawing parts) for their work.  
For example, they use pre-defined bathroom modules in different flats. 
  
Currently designed floor-plan on the active floor can be saved as a new group into a program library. 
 
The group keeps the architectural object properties and the 3D model if possible to regenerate. 
Later you can place the group as a unit from the library onto the floor-plan. 
By entering into the group, you can modify its objects - the architecture objects as well. 
 
How to use it? 
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� Open the desired project where you want to insert the needed unit. 
� Drag and drop the group from the Design Centre to the floor-plan. 
� If necessary, enter into the group with mouse right click and modify its objects. 
� Close the group. 
�  

� With the Shortcut menu – Explode command you can explode the group in such a way that the architectural objects 

become available again. 
�  

�  

�  

 
 �  

 
 
 

1.92.4. Insert group 

Groups can be placed from Insert group dialog, or from the Design centre. 
Default groups of the program are in the Groups library.  
Groups created by users will be found in the selected category of Groups.  
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Activate command Tools menu – Insert group, with the help of the appearing dialog place the selected group on the 
drawing.  
Group can be placed from the Design Centre also. Double click on the group to open the dialog Place 2D group. 
 
In the list above the categories of Group library are listed. In the list to the bottom clicking on the name of groups the 
objects will be presented. 

Reference point 

The reference point for the actual placement can be selected directly in the drawing field of the dialog. The hotspots are 
identified graphically by small green points (the active hotspot is red). The group can be placed by its active reference 
point. (When creating a new group the first defined reference point becomes the default active hotspot.)  

Rotate 
Define the angle of rotation. The group will be rotated according to the value relative to its original position. In case of a 
North symbol, it is a must. 

Size of group 
The size of group can be given by scale or value. 

Scale 
Give the scale. It is divided into X and Y values. It is enough to define only one of the two if identical scale is checked in. 

Size 
Specify the size in X and Y directions. 

Place group simply 

• Having selected the group, reference point, rotation and size press Ok. 
The selected group appears on the drawing area. 

Place group advanced 

• Select an option among the possibilities of placing methods and press the Ok button. 
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Rotated 
If option Rotate is checked in: 
 

• Select the active hotspot. 

• Define graphically the angle of rotation, or  
Select the option XANGLE and give the value of rotation.  
The program places the group rotated according to the defined angle.  
Enter Terminates the program. 

Place on object, place on chain 
If option place on object or place on object options are checked in, you can place more copies of the group along an 
object or a chain (you can define or the distance between the neighbouring groups or the copies of the groups to be 
placed). In the case of option place on chain, you can place the same groups on more different objects.  
 
You can define the distance, which is regarding the distance between the hotspots of the neighbouring groups 

• Define the value, or select am option:  

Options: 

ENDIVIDED Places the symbol in 'n' copies.  

• Give a number of equal steps. 

LRATIO Defines the distance between groups by the ratio of the 
distance and the group width. 

• Give the values. 

 
You can define width of group. The group will be deformed relative to the original value. 

• Define the new width value or  
Select an option:  

Option: 

ORIGINAL Program uses the original width. 

ENTER Program uses the step distance as the width of the 
symbol.  

 
You can define the height of group. The group will be deformed relative to the original value. 
 

• Enter the new height of symbol, or 
Select the option ENTER to keep the original ratio of the width and height.  

• Define the number of extra hotspots to place the group closer to the objects.  
If the groups are placed along a spline or curve these extra hotspots help to follow the curve more precisely.  

• Choose an object to place a series of groups along it. 
Enter Terminates the command. 

 

Hook 
When you place a symbol on a line, the line will be cut and deleted between the hotspots. 
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• Select the place of the group origin (active hotspot) on a line.  

• Choose the direction of the hooked symbol on the line. Select the direction parallel to the line direction 
Enter terminates the command. 

 

 
Hotspots  

Place in scale 1:1 
When you place a group on the draw, the symbol will keep its original size independently of the drawing scale factor. For 
example you can use this check box to place the part of the drawing-paper (frame, stamp etc.) 

Place on 3D plane 
Places and glues the group on a surface of a 3D object. If you move the object, the view of the group follows the changes. 
Using this check box, you can place ornamental objects to a surface of a house. 
  

• V Select a planar surface of a solid to place the group on it. 
ENTER to accept the signed surface, or 
NO to select another surface. 

• Enter the place of the group origin, or 
 

Options: 

ROTATE  Define graphically or numerically (XANGLE option) the 
angle of rotation. 

DELETE Deletes a selected group from a 3D surface.  
 
Enter Terminates the command. 

To delete a group from a surface you can also select the option SURFACE of Edit toolbar -  Delete icon. 

1.92.5. Group options 

 

 Replace group 

Introduction 

ARCHLine.XP makes the replacement of 2D groups and 3D objects found in projects easier and more effective. With the 
replacement of identical objects, it is possible to replace groups, and objects identical with the selected one with another 
one.  
During the design work, it can happen that you need the replacement of the previously designed furniture objects of a 
bathroom or a living room. In that case, the Replace group function gives you an effective help. 

How to use 

The function is available in the Tools menu – Group options – Replace group. 
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The function works as follows: 
 

• Select a group. This is the group you want to replace. 

• Specify a group for the replacement. The previously selected group will be replaced with this one. 

• Specify the scope of objects for the replacement. The replacement will be performed on these objects. 
 

• Another option for doors and windows: if you right click on the 2D symbol of a door or window, you can 
choose the Change 2D group command to change the actual 2D representation, using another already saved 
2D group. 
 

 

Group to exchange window 

Here you can see the selected group you want to replace. 

Exchange group window 

Here you can see the group you want to use for the exchanging of the group you see in the Group to exchange window. 

Source of group to insert 

� Load from library 
You can select an object as exchange group from an existing library.  

� Select from drawing 
You can select an object as exchange group from the 2D groups or 3D objects that exist on the drawing. 



902 12. 2D objects 

 

Manual 

Replacement rule 

� Select one by one 
After specifying the Group to exchange and the Exchange group, you can select Group to exchange exemplars on the 
drawing you want to replace one by one. 

� Perform exchange on current floor 
The exchange is performed on all Groups to exchange exemplars on the active floor. 

� Perform exchange on all floors 
The exchange is performed on all Groups to exchange exemplars on all floors of the current drawing. 
 

� The Replace group command is available from the shortcut menu of groups/objects, too. Click an existing 2D 

group/object with your right mouse button and select Replace group/object from the appearing shortcut menu. 
 

Before replacement: 
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 Rename 

The groups can be renamed. 
 

• Activate the group you want to rename by clicking on the name of it. The group becomes visualized in the 
left part of the dialog. 

• Type the new name of the group in New name field. 
OK Closes the command. 
 

 Parameters 

As it was explained in Create group chapter text can be assigned to groups that start with $ and are handled as variables. 
Values can be assigned to variables.  
 
In Group Options, submenu parameters and values can be activated. 
 

Active The value of variable will be presented. 
Off  The name of variable and its value will not be 

visualized. 
Variable name The name of variable appears. 

 

1.92.6. Create local group 

Usage of local group is recommended when more objects are placed together on the actual drawing. This group will not 
be saved in the group library; it cannot be loaded into other project. A local group can contain groups. 

 

• Give the name of the new group. Use alphanumeric characters, space can also be used. OK. 

• Select the objects already existing on the plan that will be handled together in one group.  
Enter Closes selection. 

• Define the reference points, or 
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• Enter to use the corner points of the enclosing box of the group as reference points 
 
Any of these points can be used as reference point when placing the group.  

• Enter Closes definition of reference points. 

1.92.7. Create hatch pattern 

This command helps in creation of hatch pattern based on groups. 
User can define new line type with the help of command: Tools menu - Accessories – Create hatch pattern. 
 

• Select the objects of group. Enter. 

• Define the reference point for placing the group. Enter. 
In the appearing dialog, the new group is visualized. 

• Give the name of the group, the new hatch pattern.  

• Ok Closes the dialog. 
 
Dialog Hatch pattern based on symbol appears, where you can also select the hatch pattern category. 
 

 
 
This pattern can be used for hatch. 
It appears among the Architectural patterns in the Hatch properties dialog. 
 
It can be placed in a new category. 

� See chapter 11.7.1 Hatch properties. 
 

� A hatch itself can be pattern among the objects of user defined line type or 2D group of hatch pattern. This may have 

importance when a new line type with text in it is defined. E.g.—GAS-- In this case the text must be exploded by the 
command Modify menu – Explode with selection. The filled hatch created in this way can be used as pattern. 

1.92.8. Define line type pattern 

User can define new line types with the help of Tools menu - 2D Accessories – Create new line type based on groups 
that will be repeated periodically as part of the line. 
 
The method has two parts: 

� Create the 2D group that will serve as pattern. 
� Define the line type based on this pattern. 

Create pattern 

• Select the objects of the pattern.  
Enter Closes the selection. 

• Define the reference points.  
Enter Closes reference point definition. 

• Type the name of the new group. Use alphanumeric characters, do not use space. 
OK Closes the dialog. 



 12. 2D objects 905 

ARCHLine.XP® 

Define line type 

Dialog User line types appears. 

• Click on the New line button, switch on Symbol option and select from the list the group created for the line 
type. 

• Define the values of the new line type. 
Operation from this point is the same as that of Create line type. 
 

� See detailed description in the following, 11.9.9. Create line type chapter. 

1.92.9. Create line type 

User can define new line type with the help of command: Tools menu - Accessories – Create new line type. 
 

 
 

 

Define the ruler 
Visible part of ruler can be defined as follows. 
 

 

• set the length of the ruler, or 

• set the Visible periods of the line type 
on the ruler. 

• if you switch on the Auto length check 
box, the number of periods will define 
the length of the ruler,  
if you switch off the Auto length check 
box; it visualizes the defined period and 
the defined ruler length. 

Modify existing line type 

• Select the name of line type to be modified. Only user defined line types can be modified. 

• Define the sections and spaces within a period. 

Name line type 
Select the line type name from the combo box either to rename the line or to delete it. The first 22 entries are predefined. 
You cannot modify them. 
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Define new line type 

 
Pressing the New line button, a dialog appears. Here you can define the name of the new line type and decide that it will 
be made up.  

� of lines, or 
� Groups. 

 

• Give the name of the new line type. 

• Switch on the Line button. In this case the new line type can be defined by line sections and spaces, or 

• Switch on the Symbol button, the line type can be defined by the predefined patterns among the patterns 
appear those that were created by the Create line type pattern command. Choose a group from the list. 
 
Check in the Show button, the image of the selected group appears. 
 
Close the dialog. The new line type will be put at the end of the list, from where it can be selected. 
 

 

l. New line type by periods 

 

 
 

If you have selected the Line option when creating a new type, you can define the periods of repetition. 
The period of the new line type can be given by the definition of lines and the spaces between them.  
A period cannot contain more than six line part and six spaces. 
Using the slide fill in the adequate fields. 

Line 
Define the length of line parts. 



 12. 2D objects 907 

ARCHLine.XP® 

Space 
Define the distance between the line parts. 
By the definition of the last space the distance between the periods can be given. 

II. New line type by group 
 

 

Width and height 
Define the width and height of the group. By modifying these values, you can stretch the group. 

Max. number 
Define the maximum number of the groups. 
If there are more groups on the drawing than this value, the program displays the line only. 

Space 
Define the gap between the symbols. If the gap is 0, the symbols are connected. 

Keep aspect ratio 
If you check in this option, the width and height values of group will change proportionally. 

Anchor line 
In Anchor line is visible. 
Off Anchor line not visible. 
 

OK Closes the dialog. 
 

  

 
Space = 0 
 
 
 
 
Space > 0 
 
 
 
Anchor line in 
 

Rename 
Press the Rename button to change the name of the selected line type. 
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Delete 
Press the Delete button to delete the selected user defined line type 

1.92.10. Activate 

To be able to modify the objects of a group first enter the group. Having done the modifications closes the group. This can 
be done by commands Tools menu – Edit Group, or through the popup menu of the objects. 

 
 
Activation can be seen graphically on the screen. Objects that do not belong to the group become lighter and they cannot 
be modified now, but their point can be referred to. 
The objects in the active group have priority against the outside objects in the object selection operations. 
Select the group or symbol on the drawing to activate it. 

 

Popup menu 

Right click on the group. Select the Enter into group command. The selected group becomes active. 

 

 
 

� Each modification after activating the group will be attached automatically to the group. That way you can add new 
objects or modify, delete the existing ones.  

1.92.11. Close group 

The command Tools menu – Close group closes the editing of a group and returns to the top level of the drawing. 
Choose a subcommand: 
 
The group can be closed from its popup menu of the object. 
 

 

Close group 
Closes all groups and returns to the top level of the drawing. 

Close one level up 
Closes the active group and activates the group on the previous level.  

1.92.12.  Copy geometry to groups  

In the case of user 
defined groups the 
modification made on 
one group can be copied 
to the other similar 
objects. 
The command is in the 
Group popup menu. 
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Example: 

• Create a group and save it in an OLI library e.g. Cursor sign. 

• Use the Design centre to place some copies of the recently created group on the drawing area. 

 
• Right click with the mouse on one of the groups and select the Enter into group command from the popup 

menu. The group becomes active, so modifications can be done on it, the colour of other groups changes to 
light blue. 

• Modify the active group: e.g. draw a circle in the middle. 

 
• As changes have been done, right click on an object of the group and select the Close group command from 

the popup menu.  

• Click again with the right button of the mouse on this group and select the Copy geometry to groups with 

same name command from the popup menu.  

• All other Cursor signs of the drawing area will be changed; they become the same as the previously modified 
one. 

 

1.92.13. Continue tiling popup menu 

If tiling layout is placed on the drawing, there is a possibility to continue with distributing tiles or making other modifications 
on the decoration. If you right click on the decoration group of the drawing, the Continue tiling command can be selected 
from the popup menu of the group. In the appearing Tiling dialog, the option for continuing the decoration modifications 
can be selected. 
 
 

1.93. Detailed view 

When you want to get a detailed view of a part of a picture, a detailed group is created. 
The detailed group is defined by the objects, belonging to an area (rectangle or polygon). These objects are copied to the 
defined place and scaled by the given scale factor. 
The detailed group is useful when you want to enlarge a part of the drawing and place it near the original drawing. 
 
Use the Tools menu - Create detailed view command. 
 

• Define the corner points of the rectangle, or 
Choose any Profile definition command from Profile toolbar 

 

• Define the base and end points of the 
displacement. 

• Define the value of the new drawing 
scale, e.g. 3. 

• Dialog Scale factor appears. If it is 
needed select the adequate opening 
scale or the hatches scale.  
(We do not change scale factor in our 
example)  
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1.94. External references 
You can perform several operations on referenced drawing files including attaching, updating and detaching them. When 
you attach a drawing as external reference (referred later as xref), you link that referenced drawing to the current drawing; 
any changes to the referenced drawing are displayed in the current drawing when it is open or reloaded. Attached xrefs 
can be nested: that is, you can attach an xref that contains another xref. When you open a drawing, all xrefs update 
automatically. You can also update xrefs whenever you want to ensure that the most current versions are displayed in 
your drawing. When you archive final drawings that contain xrefs, you can choose how you store the xrefs in the drawings. 
The xref drawing can be DXF, DWG or ASC drawing. 

1.94.1. Load external reference 

Using the Tools menu –External Reference command you can load a DXF, DWG or ASC file like an external reference 
The Open file dialog appears: 
 

• Select the file type: .dxf, .dwg, or .asc. 

• Select the file you want to attach. 

• Click Open. 
 
In the External reference dialog, under Name, you can browse to select another file. 

•  

• Specify the insertion point, scale, unit, and rotation angle. Click Specify on-screen to use the pointing device. 
Attachment includes all nested xrefs. 

• Click OK. 
 

 

1.94.2. External reference manager 

External references can be managed in the External reference manager dialog; you can attach, list, bind, detach, reload, 
unload external references (xrefs) or modify their path in the current (or host) drawing. 
 
Click the Tools menu – Xref Manager Command. The External reference manager dialog appears. 

In the dialog you can see all xrefs in the drawing in a  tree view or a  list view: 

 Tree view 
This view represents the external references, displaying the relations between them. The tree view lists the level of nesting 
relations of the attached external references. In tree view you can overview the nesting of each xref. 
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 List view 
It displays the flat listing of the attached external references and their attributes. 
In list view you can see the reference name, status, size, date of modification, and path information of each xref.  
 

 

Ref name 
Display the external reference name in the list after an external reference is attached. When the attached external 
reference is selected in the list, its path is displayed in the Path column. (See below: To change an xref path) 

Status 
Shows whether the external reference is loaded, deleted, reload, not to load, bind, bind all, or open.  

Size 
Display the file size of the related reference drawing. 

Date 
Show the last date when the related reference drawing was modified. 

Path 
Show the saved path of the related reference drawing. 
 
In the External reference manager dialog you can manage the xrefs as follows: 

Attach 

Attach an external reference using the Open file dialog. This command is identical with the Tools menu –External 
Reference command. 

Detach 

Detach the selected external reference from your drawing. Only the external references attached to the current drawing 
can be detached. 
Nested external references cannot be detached.  
 

• Select the reference name that you want to detach. 

• Click Detach. Click Ok. 
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Reload 

This option updates the selected xref - use this if the external reference was changed. 
 

• Select the reference name that you want to reload. 

• Click Reload. Click Ok. 

Unload 

Removes an external reference, but retains the reference for future use. Unloaded external references can be reloaded. 
Unload hides the external reference in order to improve speed and performance. 
 

• Select the reference name that you want to unload. 

• Click Unload. 

• Click Ok.  

Bind 

Permanently attaches an external reference, so that it is part of the drawing.  
 

• Select the reference name that you want to bind. 

• Select Bind. Click OK.  
 
From that point, all objects of the drawing, except with the nested external references, will be part of the current drawing. 

Bind all 

Permanently attaches an external reference with its nested xref drawings to the current drawing: 
 

• Select Bind all. 

• Click OK.  
 
From that point all objects of the drawing, along with the subsequent xref drawings, will be part of the current drawing. 

Open 

Open the selected external reference drawing for editing in a new window.  
 

• Select the reference name of the drawing that you want to open in a different window. 

• Click Open. 

• Click Ok. In the Import file dialog select the first option to show the drawing in a different window. Click Ok. 

• The drawing will appear in a different window. Modify the drawing and save it. All the changes you make in 
this window will appear on the xref of this drawing after reloading it. 

To change an xref path 

• Select a reference name. 

• Use the Browse button on the bottom of the dialog to change the path. 

• Click Ok. The other external reference properties like insertion point, scale, unit and rotation will not change. 

• or 

• Double click on a reference name.  

• In the External reference dialog, under Name, you can browse to select another file (if you want to change 
the referenced file). 

• Specify the insertion point, scale, unit, and rotation angle. Click Specify on-screen to use the pointing device. 

• Click OK to exit from the External reference dialog and to place the xref. 
 

� The second method gives you the possibility to relocate an existing xref drawing. 

1.94.3. XREF Shortcut menu 

Right click on any object of the xref drawing appears the shortcut menu. 
The header of the shortcut menu shows the path of the xref drawing. 
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Display properties 

The properties of the drawing objects inside an xref can be viewed through the shortcut menu. 
 

• Click on the object with your right mouse button and select Display properties, or 

• Go over the object of an xref with your mouse and wait a little bit. You will see the information about the 
object in the tooltip. 

Copy properties 

In the shortcut menu of an xref you can copy the properties of an object inside the xref to other objects in your current 
drawing with the Copy properties command. 

Delete this external reference 

It detaches the selected xref. This command is identical with the Detach command in the External reference manager 
dialog. 

Switch off this external reference 

It unloads the selected xref. The referenced drawing will not be seen on the current drawing. This command is identical 
with the Unload command in the External reference manager dialog. 

Manage external references 

It displays the External reference manager dialog. 
�  

 

1.94.4. Move external reference command 

XREF allows many users to work on individual components of a project. As XREF can be updated, added, or unattached 
to the project the new Move command enables to relocate an XREF according to the user needs. 

 
Click on the external reference with right mouse button and select the Move this external reference command. 
You can move the external reference by clicking first on the reference point and then on the target point. 
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1.95. Attaching photo and description to objects 
You can attach pictures and photos to any object of a drawing. This can be useful during a survey of a building by using 
the original photographs and compare it with the actual state of the model or 2D drawing. 

 

 

1.95.1. Attaching photo and description to objects 

Click on an object with right mouse button and select the Attaching photo / description command from the local pop 
menu. The following dialog appears: 

 
You can select an image with the Browse button and describe the object in the text field. Press the + button to attach them 
to the object. If more objects are attached, you can step to the next one by pressing the arrow buttons. An object can be 
deleted by the X button. 

1.95.2. Viewing attached photos and descriptions 

Select an object on the 
drawing or in the 3D 
window. If an object 
has photos and 
descriptions attached 
to it, a 

marker appears 
besides to the regular 
ones. By clicking on it, 
you can see the 
attached photos and 
descriptions. If more 
objects are attached, 
you can step to the 
next one by pressing 
the arrow buttons. 
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13. Inquiry 

1.96. Query information 

ARCHLine.XP offers a wide range of options to query information concerning the drawing, geometry, properties and 
commands. 
You can access the information requesting commands in the Tools menu – Info commands 
: 

 

1.96.1. Entity Info 

This command lists the graphical properties of the selected objects with their respective assigned costs (if applicable). 
 

• Select an object. 
The Info dialog box concerning the selected object will appear. 
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You can copy and paste the content of the window to the Windows clipboard and use the information in other applications. 
 

� You can also query information concerning architectural objects by moving the mouse pointer over the object concerned. 

Then the information table tool tip appears. Use the Text –  Place tool tip text icon to insert this table into the 
drawing. 
 

           
 

! Any tool tip table placed into the drawing is still connected to the selected object, so it follows any modification to the 

object. 
 

1.96.2. 3D object info 

1.96.3. List of Objects 

The program lists all the objects of the current project floor plan. 
You can request the list from the floor plan window where you will see the following summary: 
The Info dialog box concerning the sum of objects will appear. 
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You can also request the list from the 3D window; the program will then list the 3D solids and surfaces, too. 

� The 3D solids taking the most space in the memory are listed when you start the tool in a 3D window. 

 

.  
 

! It is good to know the number of surfaces used in the drawing. An excessive number of surfaces may slow down the 

computer considerably. To prevent this, you can limit the number of surfaces in ARCHLine.XP. To limit faces, go to File 
menu – Options – General – 3D Preferences: 
 

 

1.96.4. Perimeter 

Define the length of the selected object. 
 

• Select the desired object. 

1.96.5. Length by chain 

With this command, you can measure the length of an open or closed chain of lines. 
 
The objects constituting the chain of line can even be walls. In the case of a closed external contour, you get the perimeter 
of the building. 
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1.96.6. Distance 

Display the distance between two points. 
 

• Specify the first 
point. 

• Specify the second 
point. 

 

 

1.96.7. Querying angle 

Display the angle of a selected object in the drawing. 
 

• Select the object whose angle you want to measure. 

� The program will measure the angle in the direction clockwise or anti-clockwise defined in the File menu – Options – 

General – Angle dialog box. 

1.96.8. Measured angle 

Measure the desired angle graphically. 
 

• Specify the vertex of the angle. 

• Specify a point on one of the rays of the angle. 

• Specify another point on the other ray of the angle. 

1.96.9. Coordinate 

Display the coordinates of any selected point on the screen. 
 

• Select the desired point of the screen. 
 

1.97. Quantity Take-Off 

Cost-estimation calculations constitute a basic part of projects. 
ARCHLine.XP is capable of extracting quantitative, geometrical and descriptive data of the objects (rooms surveyed, 
walls, slabs, roofs, etc.) used in a project. These data can contain calculations on length, perimeter, area, volume or 
lighting (the latter is based on the window area / wall area ratio). The calculations can be listed: 
 

� Graphically 
� In tables – Object geometrical info 
� in .RTF format – Word list 
� in .XLS format – EXCEL list 

 
You can assign material and labour costs to the objects in the Properties dialog box with the Cost parameters option. 
The program prepares cost estimation with the help of the geometrical data and the cost parameters. 
Results can be presented in an EXCEL list. 
 
You find the listing commands in the Add-On menu Quantity Take-Off list. 
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1.97.1. Graphic list 

If you want to make a detailed graphical list of the objects in the drawing and also wish to place that list in the drawing, use 
the Add-On menu Quantity Take-Off – Graphic list command. 
You can find several list schemes in the Groups – Archlist.oli directory, to be displayed (or some of them to be displayed) 
when using the Info – Object query command. You can request the front view and the axonometric view of the object (or 
both views if you like), and you can also colour them. 
 

• In the Insert group dialog box, select any list group from the Archlist.oli library. 
 

 
 

• Specify the properties for placing the group. 

• OK closes the dialog box. 

• Select the architectural objects with those parameters you want to display in the list. 
Enter completes the selection of the objects. 

• If you selected multiple objects, specify the number of columns of the graphical list of the objects. 

• Specify the origin of the list in the drawing. 
The program places the graphical lists in the drawing. 

• Select new objects, or 
Enter completes the command. 
 

 
 

� The list of parameters and the 3D view of the object forms a group. 

If you want to modify the text in the list or the 3D view image of the object, you must enter the group. To do so, use the 
Tools menu – Activate – Select command. To deactivate the group, use the Tools menu – Deactivate – Top level 
command. You may also use the Group shortcut menu – Activate group or Deactivate group commands. 
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! Lists already inserted are no longer connected to the selected object, so they do not follow the modification of the object. 

1.97.2. Cabinet Cut List 

If you want to make a detailed graphical list of the cabinet components and place that list in the drawing, use the 
Manufacture -> KBB Manufacture Tool -> Cabinet Cut list command. 
You find one predefined list scheme in the Groups – Cabinet Cut List folder. 
 

 
 

• Select the group from the folder. 

• OK closes the dialog box. 

• Select the cabinet with those parameters you want to display in the list. 
Enter completes the selection of the objects. 

• If you selected multiple objects, specify the number of columns of the graphical list of the objects. 

• Specify the origin of the list in the drawing. 
The program places the graphical lists in the drawing. 

• Select new objects, or 
Enter completes the command. 
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1.97.3. List by selection 

With the Add-On menu Quantity Take-Off – Selection command the program will list the calculation data concerning the 
selected objects in a dialog box as a table. 
 

• Select the objects to obtain calculation data about them, or 
Enter to select all the objects in the drawing. 
 
The Building calculation dialog box appears. 
Use the buttons on the right to select object types (walls, columns, beams and doors, etc.) for the information you want to 
display in the dialog box. 
 

 
 

• Press the Position as table button and place the table with the calculation lists on the screen, or 
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• Press the Copy to clipboard button. The program copies the content of the dialog box to the Windows 

clipboard, so you can export them to external applications. You can place the list in a Word or EXCEL 
document. 
OK Closes the dialog box. 

1.97.4. Building list 

ARCHLine.XP comprises quantitative, geometrical and descriptive data concerning the architectural objects (walls, slabs, 
doors and windows, roofs, etc.) used in the projects. 
The Add-On menu Quantity Take-Off – Excel list command lists the data in an .XLS list. 
The program calculates the list and after specifying the file name opens an Excel document, which displays relevant data 
of element types on different worksheets. 
The door and window worksheets refer to the consignation of doors/windows. The program will sum up object types in the 
integrated worksheet: 

 

Calculation sheets 

Excel lists created by the program can be used as calculation sheets. After creating the lists you have the possibility to 
add new columns with relevant cost data. Based on these data you can make further calculations and create tables. 

ARCHLine.XP link in the Excel list 

In the completed Excel list the tables contain the ARCHLine.XP ID of the objects. ARCHLine.XP can visualize the 
requested object in the drawing according to the object ID in the Excel list. 
 

• Right-click the object ID in the list.  

• Select the Show ID in ARCHline.XP command in the shortcut menu popping up.  
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� To enable this function, you have to move the ARCHLine.xls file from the ARCHLine.XP\Templates\XLStart folder to the 

Office\ ... \XLStart folder. 

1.97.5. Room consignation 

Using the Add-On menu Quantity Take-Off – Room consignation command you can create three kind of list of all Rooms 
referenced in the current plan sorted out by floors and apartments. 
 
Calculation of used area: 
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Room information in details 
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Combined list 

 
 

1.97.6. Tiling list 

Using the Tiling report feature, you can view four kind of list of all tiling and areas without tiles referenced in the current 
plan. 
 
Menu: Add-on > Quantity take-off > Tiling 
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� See chapter 15.1.Tiling. 

1.98. Legend of materials 
Architectural versions – Drafting menu – Legend of materials tool generates a legend of the selected objects’ materials 
representing the names and hatches of the materials used on the drawing. 
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14. Rendering 

1.99. Integrated Rendering 

ARCHLine.XP provides an integrated powerful, easy-to-use rendering and visualization technology based on the 
latest release of LightWorks product. 
 
This photorealistic-rendering engine includes a physically based lighting model supported by advanced sky, 
analytical anti-aliasing, ray-trace algorithms, and a range of global illumination techniques.  
This release contains High Dynamic Range Images, or HDRI’s, which makes easy Image Lighting and scene creation. 

1.99.1. 64 bit rendering support 

ARCHLine.XP comes with extended 64 bit rendering engine. ARCHLine.XP rendering engine runs on Windows 7 and 
8 with 32-bit and 64-bit, and Windows XP 32-bit operating system. 
The 64-bit version is able to access larger amounts of memory than 32-bit, providing customers increased 
efficiency, which is particularly useful for those working with very large and complex 3D models and lot of lights. 

1.99.2. More about rendering  

Techniques and quality of rendering can differ. We would like to introduce the background of this technology in 
the followings. 
Ray tracing 

Ray tracing is a technique for generating an image by tracing the path of light through pixels in an image plane. The 
technique is capable of producing a very high degree of photorealism. 
See more: http://en.wikipedia.org/wiki/Ray_tracing_(graphics) 
Global illumination 

Global illumination is a general name for a group of algorithms used in 3D computer graphics that are meant to add 
more realistic lighting to 3D scenes. Such algorithms take into account not only the light which comes directly from 
a light source (direct illumination), but also subsequent cases in which light rays from the same source are reflected 
by other surfaces in the scene, whether reflective or none (indirect illumination). 
Theoretically, reflections, refractions, and shadows are all examples of global illumination, because when 
simulating them, one object affects the rendering of another object. 
See more: http://en.wikipedia.org/wiki/Global_illumination 
Global illumination – Colour bleeding 

The transfer of colour between nearby objects is caused by the colour reflection of indirect light. This is a visible 
effect that appears when a scene is rendered with Radiosity. 
See more: http://en.wikipedia.org/wiki/Colour_bleeding (computer_graphics) 
 

  
Ray tracing Global illumination 

1.99.3. Usage of rendering 

You can make photorealistic pictures with ’rendering’ icon. 
 

 Icon is active if you work in the 3D window 
If you click on the icon you will go to ’rendering’ window. 
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1.99.4. Rendering Settings 

 Image size 

 
Standard size 
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You can use from the standard sizes in the list. The Window size option will make the software use the 3D window 
content size for rendering. This option is very useful when you would like to see the same part of the scene in the 
3D view and on the rendered image. 
Width 

The width of the final image in pixels. You can use custom values as well. 
Height 

The height of the final image in pixels. You can use custom values as well. 
Resolution 

The resolution (pixel density) of the final image. This value has an influence on printing size. 
Printing width 

This value is calculated from Image size and Resolution. 
Printing height 

This value is calculated from Image size and Resolution. 

 Quality settings 

Render templates are ready-made pre-sets of Ray tracing, Global illumination, Radiosity and Shading accuracy 
values for your convenience. Professional users still have the option to tweak all the setting by selecting the 
Custom template. Render templates can be found in the Quality settings paragraph of the Photorealistic Rendering 
dialog. 
 

 
 
You can choose the following templates: 

� Simple ray trace 
� Fast photo 
� Normal photo (resource-demanding) 
� Detailed(resource-demanding) 
� Custom 

 

As the names suggest there are simpler and rather detailed templates, very likely giving better results for longer 
render time. The largest difference between these templates is that the shading and lighting calculations become 
more accurate towards higher quality settings. In the name of Normal photo and detailed template, it is 
highlighted that these demand more resources than the others, meaning that using these the render time will very 
likely be longer. In case of using the Detailed template the render time is very likely be the longest - based on real 
life experiences this means double or longer time compared to Normal. Comparing the results of these two 
templates you will see better and more accurate shading and contact shadows between surfaces in favour to the 
Detailed render template. 
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Fast photo template 
Simpler shading and diffuse lighting representation 

� Rendering takes relatively short time 

Detailed template 
More accurate shading and diffuse lighting 
representation 

� Rendering takes longer 
 

For professionals there is the Custom template. If you choose this template you will see the details of a previously 
chosen other template and you can change all of these to your flavour. 

  
 

The Custom template lets you tailor these settings to perfectly match you current scene. This way you can save 
render time and you may also have better details in some cases if the ready-made templates are not ideal for 
special scenery. 
 
An example: In some cases, if the Shading accuracy is too high for the actual scene, the image might not be 
rendered at all. If this happens the renderer will give you a warning message, you can select the Custom template 
and select or type a smaller value in the Shading accuracy field to be able to create a rendered image. 
 
Ray Tracing 

Ray Tracing displays the model with tracing the path of direct light through pixels in an image plane. Higher quality 
will improve accuracy at the expense of performance." 
 
Radiosity 

Radiosity is a global illumination algorithm, an application of the finite element method to solving the rendering 
equation for scenes with surfaces that reflect light diffusely. In the renderer there are lower level and higher level 
radiosity settings. Lower level radiosity is a fast method while higher level radiosity takes longer to calculate.  
 
In practice Radiosity helps better representing the shading and lights in dark areas especially when these are barely 
lit or not even lit by direct light only diffuse light. A good example is a dark room which has a window to an open 
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brightly lit area, but the light source or that area doesn’t cast any light directly into this space. In this case, 
Radiosity solution provides a better and very likely brighter representation of the walls, ceiling and other surfaces. 
See more: http://en.wikipedia.org/wiki/Radiosity_(3D_computer_graphics) 

 

Visible model size 

You should set up this value to approximately the main, visible part of the model. Reducing this value will improve 
accuracy at the expense of performance. 
 

  
Large visible model size Small visible model size 

Anti-aliasing 
With the help of Anti-aliasing, the edges of a rendered scene will be more realistic, smoother. 
 

  
Without anti-aliasing Using anti-aliasing 

Bump Mapping 
Bump mapping is a technique used to add more realism to images without adding a lot of geometry. Texture 
mapping adds realism by mapping images to geometric surfaces. Bump mapping adds per-pixel surface relief 
shading, increasing the apparent complexity of the surface. This uses lighting properties and indicates which parts 
are dark and which are light on a texture, making it look more geometrically complex because of light refraction. 
 
Without Bump Mapping Using Bump Mapping 
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See more> http://www.tweak3d.net/articles/bumpmapping/ 
 
You can set Bump Mapping properties in Material Properties dialog: 

 
Shadows type 

You can select any of the following shading options from a list: 

 
Calculating shadows may slow down the rendering process, but provides more realistic images. 
 

  
Soft shadows Hard shadows 
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 Light effects 

 
Lights 

You can change the values of the artificial light sources, represented in your model before rendering or you can 
switch off all the lamps or groups of the lamps. 
 
Lumen based estimation of lights 
Unlike the definition of previous versions, the source of light is defined by lumen flux units. 
 
The below chart shows the utilization of different light sources which gives us practical help in defining flux (lumen) 
according to different lamp types. In ARCHLine.XP source of light’s type is based only on incandescent lamp. 
 
Luminous efficacy = Ratio of luminous flux emitted from a light source to the electric power consumed by the 

source lumen per watt lm/W  

Light source type Luminous efficacy (lm/W) Light source emission (Lumen)

Incandescent 
100 W (220 V) 

14,4 
 

1440 

Halogen 
100 W (220 V) 

17 
 

1700 

Compact fluorescent  
9–26 W  

57–72 513-1872 

Metal halide lamp  90  

High pressure sodium lamp 85–150  

Low pressure sodium lamp 100–200  

See more: http://hu.wikipedia.org/wiki/F%C3%A9nyforr%C3%A1s 
Sun 

You can set sun by defining the geographical location, the north direction, the date and the time, or you can set the 
sun to an optional position. 
Sky 

You can choose the aspect of the sky that influences the light from outside in HDRI panoramic images background. 
 

  
 
Panoramic background affects the light coming from the surroundings. HDRI panoramic background not only 
shows the realistic appearance of any models, but even more. With its help very near to reality it shows different 
light distributions. For example if we display a certain picture with morning light we will get totally different light 
conditions such as we try it with sunset lights where the rays will give slightly red colour light. 
 
Prospective in different panoramic backgrounds. 
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User defined ambient light 
Using this option you can set unique ambient lights. Basically, the HDRI panoramic background’s ambient light is 
shown in the picture which can be chosen at the „sky” option. The unit of lighting is in Lux. (lighting is 1 Lux if 1 
Lumen flux is perpendicular to 1 m2. 1 Lux is equal to the light of full moon and lights at noon is roughly equal to 
30,000 Lux) 
 
Ambient light in bigger volume is increasing lighting in the picture. The disadvantage is that it is decreasing the 
contrast of tones. 

 
Low ambient light High ambient light 

Camera light 
With the camera light you can switch on and control the camera’s high light. A light source is emitting light from 
the view position. No shadows are ever cast from a camera light. It can be well used for lighting dark or under 
lighted places. The light unit is defined in lux.  
In use of radiosity the camera light is going to switch off automatically. 
Light solids 

The source of the light is usually not visible on renders, as they have no visible bodies in 3D space. By enabling the Use 
light solids option, the software will generate tiny fake-light source-bodies where the light sources are present. 

  
Light solids OFF Light solids ON 
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 Background type 

 
User defined background 

The image background can be monochrome, uncoloured or an imported picture. If you switch off the user defined 
background option, you will see the HDRI panoramic background that has been chosen for ’sky’ option. In case of 
switching it on you can set properties of the image background behind the model. 
Plain 

Use this scroll down menu or the colour dialog box to set background colour. 
Set background colour with the colour table. 
Graduated 

Define a top and a bottom colour to set the background colour of the image. The colour of the background will 
change gradually from the top colour to the bottom colour. 
Set the top and the bottom colour of the background in the colour table. 
Image 

You can load an image into the background of rendering. 
In the Open image dialog box select the appropriate background image. 
 

   
Plain Graduated Image 

1.100. ARCHLine.XP Render 

1.100.1. Rendering with post-processes 

The simple interface of the ARCHLine.XP Render is offering ready-made templates to quickly set up the quality of the final 
image. The image is rendered with a progressive rendering method which gives you the ability to have an idea of the full 
image and make decisions based on that even at the initial phase of the rendering. You can also zoom and pane the 
image while it is still not finished to check the smallest details. If that is necessary, you stop the rendering at any time; you 
can make fundamental changes and start another render without closing the renderer.  
 
The post-processes are extremely useful as they allow you to make changes on the image even during rendering, so you 
can fine-tune features like brightness, contrast or many more without having to save the image and open it in an image 
manipulator tool. 
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1.100.2. Image area 

The largest part of the ARCHLine.XP Render interface is occupied by the Image area and Zoom tools. At the initial phase 
of rendering the Image area represents a snapshot of the scene to be rendered. The final image starts to be processed 
over the top of this snapshot once the calculations reach a certain level.  

Zoom image 

The image represented in the Image area can be zoomed and panned even during the rendering process. To zoom in or 
out use the Zoom buttons at the top of the Image area. You can also zoom the image by simply hovering your mouse over 
the image area and using the mouse scroll-wheel. Scroll up to zoom in and scroll down to zoom out. The current zoom 
ratio is represented next to the zoom buttons on the right hand side. To see the image in real size, just click on the 1:1 
button. 

Pan image 

If the represented image is larger than the Image area you can pan it even during rendering. To pan the image hover your 
mouse over the Image area, press and hold the scroll-wheel and move your mouse.  
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Stop / Re-render button 

At the bottom of the Image area you can find the Stop / Re-render button on the left hand side. If you push it during 
rendering, the process will be stopped immediately. When rendering is finished normally or stopped by the user, all the 
quality settings become editable under the Stop / Re-render button. If you make changes you can push the Re-render 
button to render a new image with these changes. 

Progress bar 

  
 
Right under the Image area you can see the Progress bar. The Progress bar is providing information about what actually 
happens. When the renderer appears model initialization starts. During this there is no rendering yet, only a snapshot of 
the model appears. When the calculations start you can see information about the time elapsed, the percentage of 
readiness of the whole rendering process and the estimated time left on the progress bar. 

1.100.3. Post-processes 

  
Once the image is ready some of its features are often need some fine tuning. The post-processes of the ARCHLine.XP 
Render are a great help in this job. Using the post-processes of the renderer you can change the brightness, contrast and 
many other features of the image, even on the fly when the renderer is still working. 

Brightness 

Use the Brightness post-process to change the image brightness even while the image is still rendering. Use the slider or 
type a specific value between -100 and +100 to see a darker or brighter version of the rendered image. 
Note: The Brightness post-process is not the same as the Brightness value of the Photorealistic Render settings dialog. 
The main purpose of the post-process is to give you an additional tool to change the brightness of an image that was 
already rendered with specific render settings. This setting has no effect on the quality of lighting – while the Brightness 
option in the Photorealistic Render Settings dialog actually has. 

Brightness: -100 Brightness: 0 Brightness: 100 

Contrast 

Use the Contrast post-process to change the image contrast even while the image is still rendering. Use the slider or type 
a specific value between -100 and +100 to see a different version of the rendered image. 
Note: The Contrast post-process is not the same as the Contrast value of the Photorealistic Render settings dialog. The 
main purpose of the post-process is to give you an additional tool to change the contrast of an image that was already 
rendered with specific render settings. This setting has no effect on the quality of lighting – while the Contrast option in the 
Photorealistic Render Settings dialog actually has. 
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Contrast: -100 Contrast: 0 Contrast: 100 

Saturation 

Use Saturation post-process to change the saturation of a rendered image. If you lower saturation, the image will tend to 
lose its colours. If you increase saturation you can boost the colour saturation of the image even over the normal level. 

   
Saturation: -100 Saturation: 0 Saturation: 100 

Vignetting 

Use the Vignetting post-process to make the corners and edges of the image a bit darker. This post-process also can be 
turned on or off. 

   
Vignetting: OFF Vignetting: 50 Vignetting: 100 

Colour temperature 

Use the Colour temperature post-process to create a warm-tone or a cool-tone version of the same image. Colour 
temperature is measured in Kelvin. Lower values result in warmer colour tones (deep orange tones) and higher values 
result in cooler colour tones (sky-blue tones). Using this post-process, you can create different colour tone versions of the 
same image without having to change the real light colours of the whole scene. 

   
Colour temperature: 3500 K Colour temperature: 6500 K Colour temperature: 9500 K 

 

1.100.4. Render modes 

Create Preview 
The image quality simplified compare to that of image created in Final Rendering mode. It takes less time to create 
images in Preview mode, and you can change the rendering parameters before starting the time consuming Final 
Rendering. 
Final Rendering 
Here you can start creating the final photorealistic image. 
 

Create Preview Final Rendering 
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Save to File 
When the rendering image is ready you can save the output to a file. 

• Define the name and the path of the image file in the Save as dialog box appearing. 

• Define the file format of the image file (.bmp, .jpg,.tiff, .tga). 
These formats differ in their quality and their respective size too. 
 

1.100.5. Render list – batch render 

Introduction 

Render list feature in ARCHLine.XP raises the efficiency of workflow of generating photorealistic spectacular 
views. Render list can store all necessary information and settings to create rendered images later on. You can add 
views of a model to render list, even if they are scenes from different projects.  

How to use render list 

You can access render list by pressing the Render list button at the bottom of Photorealistic Render dialog. You can 
find Photorealistic Render by clicking on its icon on 3D mode toolbar of ARCHLine.XP.  The tool is available when 
you are working in 3D view. 
 

 
 
Using render list is quite simple. First, you need to add a scene from the activated 3D view to the list with the 
previously set parameters of photorealistic render. There is the possibility to add one or more project’s several 
view to the same render list.  
 

� Please note that ARCHLine.XP keeps render list until it is running. When you close ARCHLine.XP the actual render list 

will be erased, and the list will be empty next time you start the software! 

Add to render list 

With the help of the Add to render list button you can add a specific scene to render list with the settings made in 

Photorealistic render dialog window.  
The Save as… window will appear where you can define the final picture’s path, name and extension. 
 
Click on Save, and the scene with the settings will be added to render list. The final image file will not be created 
this time, only when you render an object of the render list. 

Open render list 

When you click on Open render list button, the Render list window will open up. 
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At the left side of the dialog window, you can see the actual render list, in the middle, you can find the control buttons and 
the preview area, and at the right side you can check the render settings of the selected render list object. 

Render list 

The two rows of the render list are showing the name of image and the status of it. Image name shows the name of the 
final image after rendering the scene. You can change it any time before rendering by clicking on the  button. Status 
shows the actual status of the render list object. It can be the following: To be rendered, Rendering, Finished. 

 

Move up 

Using the Move up button, you can change the order of the render list, setting the selected object to be rendered earlier. 

 

Move down 

Using the Move down button, you can change the order of the render list, setting the selected object to be rendered later. 

 

Delete 

You can remove a render list object by pressing the Delete button. 

 

Stop rendering 

With the help of this button, you can stop rendering the render list. The already rendered images will be kept. 

 

Preview 

In the preview window, you can see a simple version of the scene. This will help you when you have multiple scenes to 
render, to find the one you are looking for. 

 

Render parameters 

You can check the render parameters of the selected render list object. 
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Render list 

By pressing the button, the rendering of the render list objects will begin in sequential order from the first object of the list. 
A render window will show up where you will see the actual state of rendering. 

 
 

� Rendering a photorealistic image costs a lot of the computer’s resources (like memory and processor). Because of this, 

we recommend you to start rendering a render list in times when it is not disturbing. 

1.101. DirectX 3D 

Introduction 

The ARCHLine.XP put the appearance of drawing and 3D contents on different technological bases. This new technology 
is the Microsoft DirectX. 
The DirectX is such a driver for computers running Microsoft Windows operating systems that you can also use for the 
accelerating methods offered by the hardware. 
With help of DirectX the ARCHLine.XP can use efficiently the ability of the video card, which is the most important device 
in the appearance. 
 

 
More about DirectX 

Microsoft DirectX is a collection of application programming interfaces (APIs) for handling tasks related to multimedia, 
game programming and video, on Microsoft platforms. Direct3D (the 3D graphics API within DirectX) is widely used in the 
development of video games for Microsoft Windows. Direct3D is also used by other software applications for visualization 
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and graphics tasks such as CAD/CAM engineering. As Direct3D is the most widely publicized component of DirectX, it is 
common to see the names "DirectX" and "Direct3D" used interchangeably. 

 
From the Windows XP the DirectX is the organic part of Windows. It is also applied in such software, where the fast and 
true-life appearance is important. 
It is important, that the DirectX gives a possibility to represent 3D and 2D contents faster and in higher quality. 
Due to this, you have a chance to handle larger and more complicated plans and other drawings or models, in such way, 
that the processor responsible for general calculations gets a little or not at all gets load. It is very useful because the work 
will be easier as the video card makes the representation, which is very hard work in many cases. 

Use DirectX 
When you start ARCHLine.XP, it recognizes automatically the ability of the graphic card and arranges the work for it. If the 
video card can do it, the hardware-accelerated appearance will be default automatically with the help of DirectX 
technology. 
On older computers, the program changes to a slower hardware not accelerated display method.  
 
So you do not have to switch on/off the DirectX representation, it’s automatic. You can get information from the 
representation method by controlling the icon on the left side of the header in the active window.  

If you see the   icon, it means, that the content of the window appears faster. If you see the  icon, the content of the 
window appears with a slower and processor load method. 

1.101.1. DirectX settings 

You have new settings and fine-tuning possibilities with introducing DirectX. 
It has to be emphasized that if the quality of the represented 2D and 3D content is required, you do not need the following 
mentioned settings modifications or fine tunes. 
 
When the ARCHLine.XP runs on such computer, that supports the DirectX technology, there is a possibility to fine-tune 
the quality of the displayed content. Fundamentally, we can mention two types of settings area in this respect: the 
representation settings of 2D windows and the 3D windows. 
 
The modification of settings depends on, that which window is active. For example if a 2D (floor plan) window is active, 
then you can modify that settings belonging to it with opening Property.  
For this click on Property on the bottom of Toolbox:  
 

 
 

� It is important not to select any drawing objects in the active window, because in this case the Property represents the 

preferences of the selected object.  

Visual settings in the 2D windows 

The available visual effects in the 2D windows are as follows: 
 

 

Anti-aliasing cursor 

With this option, you can apply the antialiasing on the markers. As a result, markers that appear at selection and drawing 
have a smoother look.  
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 Off On 

Antialiasing 

The antialiasing can be applied to the representation of the content in the selected window types. There are four options:  
 

� Off 
The Off setting means that there is no antialiasing. In that case, the contents of the 2D and 3D windows look coarser. 

� Only in 2D 
The Only in 2D setting means that antialiasing is applied only to the content of the 2D (floor-plan) windows. 

� Only in 3D 
The Only in 3D setting means that antialiasing is applied only to the content of the 3D windows. 

� In 2D  and 3D 
The In 2D and 3D setting means that antialiasing is applied to the content of all windows in the project. 
 

  
 

 Without antialiasing  with antialiasing 

Hardware vertex processing 

With hardware vertex processing the video card stores and processes the data of vertices found on the drawings. Since 
two vertices belong to each line, it is easy to imagine the amount of vertices on a drawing. Hardware vertex processing 
can speed up your work if you have a fast video card. 

Texture optimization 

Texture optimization is a useful setting if you have large drawings. Using this setting, the program anti-aliases only the 
visible content of a window, while the appearance of the content outside the window (which is not visible) is simplified 
substantially. 
 
This simplification is visible at pan. However, the visible content is refreshed as soon as the pan is finished, and then it 
looks smooth again. 
 
By enabling the texture optimization, it is possible to use the FPS limit and Model optimization (%) options too. 

FPS limit 

FPS stands for frames per second or we can say images/second. The program tries to represent the content of any 
windows with the highest speed that it is possible. This speed is expressed in frames per second, which means the 
number of frames represented consecutively in one second. (When representing a moving model or a video, at least 24 
frames/second are needed to make full motion for a human eye.) 
 
When the program detects that it is not possible to keep the limit value, it starts to simplify the representation of the 
content by texture optimization. 

Model optimization (%) 

Model optimization (%) is an adjustable checking function. Setting 10% here, for example, means that the program checks 
whether the specified FPS limit can be kept or not only at that time when 10% change has been made in the project 
compared to the previous checking. If yes, then it switches off the texture optimization automatically because there is no 
need of it for increasing the speed. If it finds that the specified FPS limit cannot be kept, then it leaves the texture 
optimization switched on to increase the speed. 
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15. Printing 

Introduction 

ARCHLine.XP offers two kinds of printing opportunities: 

I. Printing the active drawing: 

The program prints out the drawing in the current window using the command File menu – Print. 

II. Plot layout: 

ARCHLine.XP divides printing into two phases: 
 

� The first phase is the Prepare printing: 
It prepares the files to print. You can set the physical measurements of the plot layout. You can open projects and files 
and place them on the plot layout and save them as a printing. You can add to the plot layout stamp, north sign, notices 
etc. The plot layout belongs to the current project; the command save project will save the plot layout as well.  
 

� The second phase is the real printing, using the command File – Printing.  

1.102. Plot Layout 

ARCHLine.XP offers the environment to prepare plot layout where you can place projects, but independent files as well. 
The plot layout prepares the right printing with different functions.  
The plot layout belongs to the current project, as a new kind of window called plot layout. The project can contain several 
plot layouts in the same time.  
You find the commands to manage the plot layout in the Plot Layout menu. 
 

 

1.102.1. Prepare plot layout 

Select the Prepare plot layout command to activate the 'prepare printing' function: The Paper size setup dialog box 
appears. 
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Paper sizes 
Define the plot layout size. This format can be different from the current printing format. The user can also define the 
custom size. The default format is equal to the current paper size of the current printing device, so it is recommended to 
use. 

Orientation 
The Orientation setting indicates which way the paper you selected in Paper Size will be oriented. 

Margin 
The dialog displays the margin values that belong to the current printer driver. They are the absolute minimum; you should 
not enter values less than these because it might happen that some part of the drawing will be out of the paper printable 
area. 
 

� How to calculate a printable area? The dimensions of the printable area of a particular sheet of paper are simply the 

dimensions of the paper minus the minimum margins required by the printer. The dimensions of the printable area can 
be calculated as follows: Printable area length = paper length - (top + bottom margins Printable area width = paper width 
- (left + right margins) 

1.102.2. Project Navigator – Drag and Drop drawings 

In the next step the Project navigator will appear from where you can drag and drop the drawings from the previously 
saved version of the current project.  
 
You can place one or more floors in one step if you drag the drawing name onto the printing layout window. 
 
When you dropped the drawing you can set its scale factor. 
 

  

• If you wish to place only one floor, click on the floor plan name and drag it. 
• If you wish to place more floors click on more floor name while holding the SHIFT button down. 
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� You can add to the plot layout north sign, notices, and images. So you can place the render image you made before of 

your building. 

1.102.3. Import drawing 

The command loads and places the file on the layout for printing. The file can be part of the current project, any kind of 
.asc drawing or a drawing of another project as well. 
 
The submenu displays the drawings of the current project. Simply click one of them to place on the plot layout.  
 

 
 
Or: 

• When you wish to load a drawing from different project use the command Open file from project. This 
command is practically equal to the command Open Project. Choose the required project in the dialog. Press 
the Open button. 

 
 

• Define the drawing scale in the dialog. 

• Place the drawing on the plot layout. You can place several drawings from a project one by one or you can 
place the same drawing with different scale factor e.g. 1:100, and 1:200. 
 



 15. Printing 949 

ARCHLine.XP® 

 

1.102.4. Modify properties of drawing 

You can modify the properties of a drawing with a left button double click on it. The program displays the Open/Modify new 
drawing dialog where you can modify the scale factor, floor, layer, and class information. 
 
As an example you can visualize another floor of the building. 
 

 

1.102.5. Copy with rectangle/polygon 

The command is used to copy just a selected part of a drawing, which you would like to place on the plot layout. The 
selection can be defined by either a rectangle or a polygon. 
The command differs from the general Edit menu / Copy command, because with the Copy with rectangle/polygon 
command the selected part of the drawing is defined by a given borderline in a way that it even cuts the dimensioning, 
texts of the crossing rectangle/polygon. 
After the needed part has been copied, you can paste it on the plot layout in different scales with the Plot Layout menu - 
Paste command. 
 

• Define the two opposite corners of the selection rectangle, or 
Select the SPOLYGON option if you would like to define the selection with a polygon. 

• Define a reference point, which is going to be used to place the detail on the drawing surface. 
 

� See example at chapter 14.1.6. Paste on layout. 
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1.102.6. Paste on layout 

The command is used to place the contents of the clipboard on the plot layout with the needed scale. The advantage of 
this command is that not only complete drawings (floor plan, frontal view, section, etc.), can be placed, but if the previous 
Copy with rectangle/polygon command is used, parts of drawings, details, or only selected objects can be placed on the 
layout and printed with the needed scale. 
 

• Place the 
contents of the 
clipboard 
(selected with the 
Copy – Ctrl+C 
command or with 
the Plot layout – 

Copy with 

rectangle/polygo

n command) on 
the plot layout 
with the needed 
scale. The 
command offers 
the following 
scales:   

 

•  

• If you would like to define a different scale, select the Free command, write the new scale to the appearing 
dialog then place the drawing on the layout. 

Example 

Let us place a part of the floor plan onto the plot layout with the scale 1:50: 
 

• Be sure the floor plan window is the active one. 

• Choose Plot Layout - Copy with rectangle/polygon command. 

• Define the two opposite corners of the selection rectangle. 

• Define a reference point, as a bottom left point of the selection rectangle. 
 

 
 

• Click with the mouse left button to the plot layout window to make it active. 

• Choose the Plot Layout - Paste command. 

• Select the scale 1:50. 
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• Place the drawing on the layout. 
 

 
 

! Please do not use the Edit menu - Copy and Paste commands instead of the Plot Layout - Copy with rectangle/polygon 

and Paste commands.  

1.102.7. Edit drawing parts 

Introduction 

The plot layout developments made in ARCHLine.XP ensures more comfortable and flexible editing when you place 
drawing parts with different scale.  
After paste it is possible to edit the boundary of the drawing parts. During the design work, you may need to 
extend a previously placed drawing part; or to the contrary, you should cut it. This situation can be handled easier 
by the new plot layout functions. 
 
The command is available in the Plot layout menu – Edit after paste. 

How to use 

Assuming that you have a previously created plot layout: 
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• Select a part of the drawing with the Plot layout menu – Copy with rectangle/polygon command. 

• Make the appropriate plot layout window active and then place the previously selected drawing part with 
the Plot layout menu – Paste – Scale factor command. 

• Select the Plot layout menu – Edit after paste command and select the previously placed drawing part. You 
can also find this command in the shortcut menu of the drawing part. 

• Modify the contour with the Profile definitions commands that appear on the left, and then press Enter. 
 
The drawing part is represented on the plot layout with its modified contour: 
 

 
 
If the content of the drawing part was changed between the time of placing and the time of its contour modification, the up-
to-date state of the drawing part appears after the execution of the command. 
 

� The Plot layout menu – Refresh layout command updates all drawings on the plot layout. 
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! The Edit after paste command can be applied only to the drawings that have been placed with the Plot layout menu – 

Paste command. 
 

1.102.8. Open plot stamp 

When a plan is completed, plot stamp should be added to them. The command is used to place plot stamp on the plot 
layout. These plot stamps contain information about the drawing, like the name of the plan, the number of it, designer, 
scale, etc. 
Select a plot stamp from the appearing Place group dialog, from the Groups library– Stamp category. Select the Stamp 
file of the program, or the file containing your own Stamp. 
 

 

 
 

• Select a plot stamp. In this example we choose the A3 landscape stamp. 

• Define the parameters of placing then press the OK button. 

• Place the stamp on the Plot layout. Define the origin of the stamp, or 
select the ROTATE option if you would like to rotate the stamp first; then define the place of origin and the 
angle of rotation. 
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• Enter Close the command  

� The detailed description of placing groups can be read in chapter 11.9. 2D groups. 

 

1.102.9. Fill/modify plot stamp 

Used to fill in the data of the stamp, or to modify an existing stamp. 
 

• Select the stamp. 

• A dialog appears with the data of the stamp. 

• Fill in the necessary fields. 

• OK Close the dialog. 
 

� Only the original stamps can be filled with the command. In case 

of user-defined stamps, we suggest to use the Text command. 

 

1.102.10. Refresh Layout 

The program keeps the relation with the original files; the modifications made on the drawing appear on the layout as well. 
When the layout has already been created, but you are still working on the project, the modifications are automatically 
refreshed on the layout when the command is selected. 
When the layout contains a drawing that is not a part of the project, the command looks for this drawing on the hard disk 
and loads and refreshes it. 
When you move the project to another computer, the command is not able to find the drawing with the original path, 
therefore it asks for the new path of the drawing. 
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! Attention! Before you execute the Refresh Layout command please save the project because the layout will be updated 

with the latest version saved on the hard disk’ 

Placing the Image 3D window content on the plot layout 

It is possible to place the content of the Image 3D window on the plot layout. The resolution of the image will be the same 
as the resolution of the screen.  
Before printing, it is suggested to apply the Plot Layout menu – Refresh layout command, so the resolution of the image 
will change to the available best settings. 
 

! The refresh layout resolution means that the image size, together with the project file size, will be increased 

substantially. 
�  

 
 
 

1.102.11. Refresh One by One 

 Instead of refreshing the whole plot layout in one step, there is now a possibility to refresh a single drawing only by 
clicking on it with the right mouse button and selecting the Refresh this command. 
 

! New menu object for opening .pef (Printing environment) files from previous ARCHLine.XP versions in the Plot Layout 

main menu: New layout / Import layout 
 

1.103. Print dialog 
The Print dialog enables to output a single drawing to the selected printer/plotter and PDF file. 
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Printer  

On the top of the dialog, you see the type of the printer the paper size and the printable area. The dimensions of the 
printable area of a particular sheet of paper are simply the dimensions of the paper minus the minimum margins required 
by the printer. 
You can select here the type of the printer tool. 

Set 
The Setup button displays the MS-Windows standard Printer Setup dialog.  
Here you can set up the printer properties. 
If you would like to print in file, switch on the here appearing Print to file option. 
 
There values are valid for the current printing only! 
If you wish to use your new setup continuously, please use the MS-Windows standard Printer dialog (Start menu – Setting 
– Printers). 
 

� We recommend, that define the sheet size and orientation in the below found Paper size part.  

 
 

Tiling support 
Here you can divide the drawing on several pages.  
 
Define the new paper size. You can define a custom paper size as well.  
Click OK to return to the Print dialog. The Tiling button displays the number of pages needed in X and Y direction (e.g. 
your A4 printer can print an A3 size drawing as 2 pieces of A4 paper, adding the margin!). 
 

� See chapter 14.1.1. Start prepare printing. 
 

� As you wish to use the default paper size of your printer, please choose the DEFAULT object in the Paper size list. Any 

other choice will indicate you need more than one paper to complete the printing. 

Paper size 

Displays the paper size, orientation and number of copies that are available for the selected output device. 

Orientation 

Specifies the orientation of the drawing on the paper. You can select Default or Rotated drawing.  

! Don’t confuse the orientation with paper orientation. The first one means the drawing and the second one the paper 

sheet. 

What to print 

Specifies the area of 
the drawing to be 
printed. 
 

Entire drawing 
Displays  and prints the optimal enclosing box of the drawing. 

Current view 
Displays and prints only a portion of the drawing that actually appears on the current window. 

Window 
Displays and prints only the selected part of the drawing. Click the Window button to specify the two corners of the portion 
of the drawing to be printed. After the clicks, you see again the Print dialog. 

Printable area 
Shows and prints only the selected part of the drawing with predefined size. 
 

• First, choose a printing scale. 
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• Choose the paper size. 

• When you choose this option the Print dialog closes and the program and activate the drawing to select a 
part of the drawing with a predefined selection rectangle. It fits to the selected paper size multiplied by the 
scale factor. Later the program returns to the Print dialog. 
 

! We recommend using this option when you print only a part of your drawing! 

 

� The Printable area option uses the paper settings of default printer. So if you use the paper settings in Printer dialog 

window, or Rotated drawing option it gives incorrect result. We recommend in case of Printable area option using, set 
the paper in Windows – Control panel – Printer settings window. This problem is not in case of PDF printing.  

 

Scale 

You can define the scale factor in the 
following ways: 

Scale 
Choose a predefined scale factor: 
e.g.: 1:100 
The Scale to Fit calculates the best 
scale to fit the current paper size. 

User defined 
Enter the scale value in the edit box: 
1: 15 

 

 

! We recommend using for plot layout the scale 1:1! 

Scaled line width 
Scales the line width in proportion to the scale factor when activated. 

Line width active 
If the check box is switched Off state, all the lines are printed with zero line width. It can reduce the printing time 
significantly. 
If the check box is switched On, the program prints all lines with the defined line width. 

Shift 

X and Y 
The X and Y fields let you shift the printing origin. 

Centre point 
It moves the drawing centre point into the paper centre point. 

 

Colour 

There are different possibilities for printing. You can choose: 
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� All colour in grayscale 
� All colour in black 
� User defined 

Here you can change colours 
and associated line width. 

� Print all text in black 

 

Pen Colour assignment 
In this dialog, you can assign to colours of the drawing, another colour and different pen width.  
 

 
You can save your settings with the Save setting button and later you can reload it with the OPEN button. 
The Change all colour to checkbox assigns the same colour to each colour in the list. 

Visible floor in grey scale 

In the Print dialog window, you can find the Visible floor in greyscale option at the top right frame. When you turn on this 
option, you will be able to print out the content of the visible floor too, as you see it on the drawing. 
 
The content of the active floor will be printed out as previously set, and the content of the visible floor will be printed out in 
plain grey.  
Turn on this option if you want to print out the content of the visible floor as well. 

 

 
 



 15. Printing 959 

ARCHLine.XP® 

  
Visible floor in greyscale OFF Visible floor in greyscale ON 

Preview 

Preview feature helps you to be ensuring that your print is as you would like it. Then, when you are satisfied, click OK to 
print.  
The white rectangle represents the paper. The drawing size is represented by the grey rectangle. The rulers on the top 
and side helps you to move the drawing graphically. 
 

! If the drawing window exceeds any boundary of the paper size, that part will not be printed! 

 

 

Preview 
Display the print on the screen as a preview. 

Scale 
You can define the scale factor. 

Offset 

Centre point  
It moves the drawing centre point into the paper centre point. 

X and Y 
Enter the value in the edit boxes: the X and Y fields let you shift the printing origin. 

Update 
Update the preview using the latest scale and offset values. 
 

• Ok return the Printing dialog window. 

Sets 

You can save the printing settings to sets, and the sets to template file. 
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� See: description of sets in chapter 3.2.3. Using sets of properties  

Printing 

Start printing clicking on the button. 
 
 

1.104. Printing in PDF format 

Printing in PDF provides the document in the PDF file format. 
 

• For printing in PDF format please select the File menu – Print to PDF command. 

• If you select the File menu – Print command, switch on the Print to PDF option in dialog window. 
 

 
 

• Define the file name. The file extension will be .pdf. This file can be viewed or printed on any computer with 
a PDF viewer.  

• Specify the size of the paper. Custom size is also selectable (choose Custom from the list). In that case, you 
can specify the size in Horizontal and Vertical input fields. 

• To specify the paper orientation, choose portrait or landscape in the Orientation list. 

• File name and path can be specified by clicking on the File button. 

Tiled pages 

If one page is not enough to print out the drawing in the specified size, you can print out the whole drawing on tiled pages 
by specifying the size of the printing page in the Paper size setup dialog, for example A3 landscape. 
On the Tiled pages button you can check the number of pages you need for printing. 
The following message appears when you start to print: 
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In case of tiled pages, extra PDF documents will be generated automatically. The extra PDF files are identified by 
numbers added to the end of the specified file name. For example, if the file name is Printing_example.pdf and you need 4 
pages for printing out the drawing, 4 files will be created with the following names: Printing_example.pdf, 
Printing_example2.pdf, Printing_example3.pdf and Printing_example4.pdf. 
 

1.105. Printing the Image 3D image window 

Print directly  

It is possible to print out the Image 3D image window, or to save it as an image file. 

• Activate an Image window.  

• Select File menu – Print. 
The settings are analogous to the general printing dialog, with fewer possibilities. 
 

 

Print to file as picture 

The program saves the content of the Image 3D window as a jpg image file. The image can be printed out afterwards. 

Print to Pdf file 

If you select the File menu – Print to Pdf file command, a similar window will appear as the previous, where you have to 
define the name of PDF file. There is a possibility to set the image resolve. 
 
We recommend scaling the 1:100 (In case of 1:1 the file size will be too large.)  

Placing the Image window on the plot layout 

It is possible to place the content of the Image window on the plot layout. The resolution of the image will be the same as 
the resolution of the screen. Before printing, it is suggested to apply the Plot Layout menu – Refresh layout command, so 
the resolution of the image will change to the best available settings. 
 

! The refresh layout resolution means that the image size, together with the project file size, will be increased 

substantially. 

 

1.106. Print queue 
The Print Queue dialog lets you collect upcoming print documents.  You can add, modify and cancel documents before 
they print. You can print the documents as one PDF file with multiple pages or you can print directly to the selected printer.  
 
The Print queue list is stored in the project, which means you can collect print jobs of multiple drawings of your project into 
the same list. 
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The Print queue dialog has an actual job list, a preview area, a settings area and a controller area. 
 

1.106.1. Current job list 

The current job list is at the very top of the dialog, and it is empty by default. When a print job is added, it will be listed in 
this area. A print job has the following properties: 
 

� Printable 
� Document 
� Printer name 
� Filename 
� Error report 

 
Printable 
You can use the Printable option in the Current job list to enable or disable the printing of a print job.  
 
When you add a print job to the list, this option is enabled by default. If you do not want to print the selected print job, but 
you want to keep it in the queue just disable this option. When the print queue is started to be processed all disabled print 
jobs will simply be skipped. 
 
Document 
The document field of the selected print job shows the name of the document. You can rename it at any time. 
 
Printer name 
The Printer name shows the name of the printer that will be used to print the selected print job. 
 
If you selected the Print to PDF option, you will see the Print to PDF text here. 
 
Filename 
If a print job is selected to be printed into a PDF file, the name of the file is represented here. 
 
Error report 
If there was an error at processing the print queue you will see the error report message in the Error report field. 
 

1.106.2. Print preview 

The Print preview shows the preview of the selected print job. The quality of the print preview is usually lower than the final 
result. 

1.106.3. Print job information 

The Print job information list shows information about the selected print job, such as the print size, orientation and scale of 
the printed drawing. 
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1.106.4. Controllers 

The Print queue dialog has a few controllers, which allow you to modify the print queue by adding or removing a job or 
changing their execution order. 
 
Add print job 
You can add the current active drawing as a new print job to the print queue by pressing the Add print job button. 
 
If you would like to add another drawing to the print queue please press OK on the Print queue dialog, activate the 
drawing you wish to add, open the Print queue dialog again and press the Add print job button. 
 
Remove print job 
You can remove the currently selected print job from the print queue by pressing the Remove print job button. 
 
Print job details 
The Print job details button allows you to modify details of the currently selected print job such as: Paper size, printer, 
orientation, and scaling or pen settings. 
 
Move up 
The print queue is ordered by print priority. This means that the list that you can see is the actual printing order. The first 
object of the print queue will be printed first and the last object will be printed at last. If you press the Move up button, the 
selected print job will be moved up one level in the print queue. 
 
Move down 
The print queue is ordered by print priority. This means that the list that you can see is the actual printing order. The first 
object of the print queue will be printed first and the last object will be printed at last. If you press the Move down button, 
the selected print job will be moved down one level in the print queue. 

1.106.5. Start printing 

The Start printing button starts the print queue based on the current order. Print jobs will be sent to the printer (or printers) 
you set and PDF files will be saved and automatically open when the printing is done. 
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16. Add-On 

1.107. Tiling 
The Tiling function can be used on any surface designing the real arrangement of tiles and paving. 
 
Tiling layout definition means that the distance between the tiles and the direction of them have to be defined. The pattern 
given out by them can also be defined. Inside an area covered by tiles, it is possible to define another background area 
with arbitrary shape and different pattern.  
 
You can insert individual tiles too.  
The quantity take-off reports the number of tiles grouped according to the whole and cut size.  
 
To define new tiling use commands of the Interior menu -- Tiling 
 

 
 
 

        
Room 
Tiling layout can be added to the floor, to the soffit or to any sidewall of a room through its Room. 
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� Note that you can add tiling to these surfaces only if a room border surface template is attached to the 

Room. About Room border surface templates see the chapter 9.5.1.5. Border surfaces. 

   

 
 
The difference between the tiling added to the sidewall of a room and the sidewall decoration added through a 
Room is that in the first case the decoration will be defined along the full wall length, whereas in the second case 
only a part of the wall defined by the wainscot of the sidewall will be decorated.  
Apart from this, the tiling layout definition works like for any other objects. 
 

Creating a new tiling 

Decoration definition consists of two phases:  
� Background area definition 
� Tiling 

 
To decorate a surface of a wall/slab/room/terrain, click on the object by right mouse button. Select one of the 
Tiling… commands in the shortcut menu. If you have selected the Tiling In 3D, Slab/Tiling on Floor or Slab/Tiling on 
Ceiling command, you can start the decoration immediately, otherwise the program first creates the layout of the 
selected area and you have to place it on the drawing.  
 
Once the surface to decorate is selected, a number of decoration commands appear in the floating menu. You can 
start the decoration by selecting one of them. 
 
You can close the decoration process by selecting the “Close” command in the floating menu or pressing the ESC or 
ENTER key. Use the “Close and remove layout” command instead of “Close” if you do not want to keep the 
decoration layout on the drawing.  

 

1.107.1. Background area 

You can assign new material to the selected face of a wall or slab with the help of a contour. In this way, it is simple to 
create for example a plinth or other decoration that can be well presented on the photorealistic image. If your decoration 
includes only homogeneous materials then your decoration is complete with the background area definition. 
 
You can also use the created background area for the grounding of tiling. The material of the background area is 
important, because it defines the material representation of the gap between tiles. Additionally, the shape of the 
background area defines the surface geometrically where the distribution of tiles will apply (See later: Tiling). 
 

! Tiles can be placed only on those areas where the background has already been defined.  
 
With the help of the available options background area can be added, edited or modified: 
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� For the last command see the details in chapter 15.1.22. Modify Material  

1.107.2. Add New Background Area 

• Select the Add New Background Area command in the floating menu. 

• Define the profile of the decoration using any option in the Profile definition.  

• From the appearing Material dialog, select the material that will belong to the closed contour.  

� See the details of Profile definition in chapter 8.9. Specifying profile. 

 
In case of decorating a floor or ceiling select the ROOM option instead of defining the profile, if you want to assign new 
material to the entire floor (top face of a slab) surrounded by the walls.  
 
Decorations appear both on the wall layout, 3D view and on the photorealistic image. 

 

 
 

! Don’t be confused! The pattern you see on this drawing is only 

a background area used as decoration.  
Define a background area according to the glue line material 
used for tiling if you want to place tiles on this background 
area.  

 

1.107.3. Edit background area 

• Select the Edit background area command in the floating menu.  

• Click the background area you want to edit. 

• Enter to close the selection. 

• Select from the appearing Edit profile commands (move node, rounding, etc.) and modify the selected 
contour. 

� See the details of Profile editing in chapter 8.9.9. Editable profile. 
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1.107.4. Move background area 

• Select the Move background area command in the floating menu.  

• Select the areas to be moved. 

• Enter to close the selection. 

• Give the reference point of the selected area(s) and move it to another place. 

1.107.5. Move a copy 

• Select the Move a copy command in the floating menu.  

• Select the areas to be copied. 

• Enter to close the selection. 
Give the reference point of the selected area(s) and copy it to another place. 

1.107.6. Delete 

• Select the Delete command in the floating menu.  

• Select the areas to be deleted. 

• Enter to close the selection. 
When one background area overlaps another background area, you can use this command to subtract one background 
area from another.  

1.107.7. Subtract tiles 

If individual tiles are defined on an existing background area, you can subtract the area of them from the surrounding 
background area. 

 

• Select the Subtract tiles command in the floating menu.  

• Select a background area. 

• Select tiles. 

• Enter to close the selection. 
 

You can leave “gaps” between the area and the tiles by selecting the Offset option while selecting the tiles and entering 
an offset value. This way the program shifts the profile of the tiles with the given value and subtracts these increased 
areas from the background area. 

1.107.8. Tiling 

You can create the arrangement of tiles on the previously defined background area - on the surfaces of architectural 
objects. The material, type, size of tiles and gaps between them can be defined precisely here. 

 
Select from the following options: 
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� For the last command, see the details in chapter 15.1.22. Modify Material  

1.107.9. Add tiles 

With the help of this command, you can define the regular arrangement of tiles on the selected background areas. 

 

• Select Add tiles command in the floating menu. 

• Select a background area to define the tile arrangement on it or click on the Entire item option to place tiles 
on the whole surface of the architectural object. The Entire item with background option automatically 
creates a background area, too, if background area hadn’t been defined on the whole surface. 

To define the tiling, the following dialog appears: 
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Name 
Specify the name of tiling on the selected background area. 

Material 
Define the material of the tiles by clicking on the button, select from the material library of the program. 

Given row/column 
If you wish to cover only a part of selected area with tiles, type the number of rows and columns. If you want to cover the 
entire area, click on Whole area. 

Whole area 
If you wish to cover the entire area, activate this button. 

Orientation 
By default, the material properties of the tile defines the texture orientation through the direction setting. You can use this 
direction setting or you can apply a rotation to the left or right compared to the original material direction setting.  

Width / Height 
These values define the size of the tiles: type the width and height values. You can resize tiles with custom profile or 
complex tiling patterns by changing these values, too. 

Profile 
The default shape of tile is rectangular, but any other profiles from the program profile library can be used or you can 
cover the selected area with a complex Tiling pattern previously created of several unique tiles. 

 
Define the type of the profile of the tile:  
 

� Rectangle profile – If you select Rectangle profile, define the reference point of placement of the rectangle tile. 
� Profile selection – Click on the Profile selection button and select the adequate profile from the Profile library if the profile 

is not rectangle. 
� Tiling pattern – Click on the Tiling pattern button and select a complex pattern from the library. 
� Select Object – Click on the Select Object button and select an object from the library for tiling. 
� Built-in pattern – The most popular regular tiling patterns are available:  

-herringbone,  
-hexagon,  
-four square finger parquet, 
-five square finger parquet.  
 

 

 
 

Thickness 
Define the thickness of tiles. 
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Grout depth 
Define the raising value of tiles measured from the background area. If 0 is defined, the tiles will be placed exactly on the 
surface. 

Tipping angle 
By default, the flat surface of the tiles are parallel with the surface you tile. Optionally you can define an angle for the tiles 
so those will not be parallel to the surface you tile.  

Minimum ratio to display the whole tile 
If the size of the cut tile is above a certain % of the original tile size, the program counts it as an entire one. The aim of this 
option is the practical approach when we represent nearly whole tiles as a whole one in the list of tile calculation. 
In these examples we intentionally used extreme values for better illustration. 

    
50% 80% 100% 

 

Horizontal / Vertical tile grout 
Define the distance between the tiles in horizontal and vertical directions. 
The gap will be presented with the material of the background area.  

Row shift 
Select from the three graphical options:  

 
There is no shifting between rows or columns; the tiles are 
matched to each other by their corners precisely.  

 
If the button is switched on, you can define the value of 
horizontal row shift. Every second row will be shifted with 
this value from the first one. 

 
If this option is selected, you can define horizontal and 
vertical shift values in the Row shift / Column shift fields.  

Row/column shift  
Define the horizontal and vertical shift values of the tiles. The fields become active if the relevant options had been 
selected first. 

 

 
 

Example 1: (tiles: 

0,3x0,3) 

 , Row shift: 0,1 

Example 2: (tiles: 0,3x0,3) 

, Column shift: 0,1 

Row and column shifting Example  
There is a possibility to shift the tiles in X and Y direction.  You can use well this command at for example: placing Viacolor 
cover. 

 
In our example, we use the following profile: 
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• Choose the proper profile in Edit profile dialog box. 

• From the Row shift options select the second one. 

• Enter -0, 02 in the Horizontal tile grout field, and 0.15 in the Row shift according to the profile. 
 

 
 
The program will move exactly the tiling with zero horizontal/vertical tile grout.  

 
 

 

 

When you would like to have 0,5 cm horizontal and vertical tile grout, you have to use other profile and tiling 
parameters, for example: 
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Path finding 
If this option is switched off, the program will not take the contour of the area into consideration so the tiles will be 
arranged in a homogeneous pattern along the path.  
With this option, it is possible to place tiles along a path. This function is important because by this you are not restricted to 
align subsequent tiles only to the vertical edges of the tiles but even to a curved path.  
At placing, you have to define the start point and the end point of the path to which the path finding applied. In case of 
closed path like on the figure below the start point and the end point can be the same so the path finding will be applied 
along the whole contour. In case of path finding the number of rows has to be defined. Opposed to the default case when 
zero row and column numbers mean full coverage, row number of zero means one row here. The number of columns 
depends on the path. 
For example: 

  

  

Cutting the tiles in corners 
It is also possible to cut the tiles in corner according to the figure above. If the Path finding option is switched on the 
Minimum angle in corner to cut tiles with the half angle option will appear. You have to specify an angle here. If the angles 
of connected edges at path breakpoints exceed the specified angle, the program will cut the tiles in half angle. 
 
Let’s see an example:  
The edges meet in the corner in right angle and the specified minimum angle is 90°. In this case half angle cutting rule will 
not be applied therefore the tiles in the corner go to the edge without cutting.  
It the edges meet in the corner in right angle and the specified minimum angle is less than 90° (for example 45°), the 
program will cut the tile in half angle of the corner. 

 

  

  

Sort 
If the Path finding option is active, by switching on the Sort option you can precisely adjust the tiles to each other within the 
path. 
In the figure below on the left side, the decoration tiles are sorted so they are adjusted to each other. On the left side, the 
tiles are not sorted along the path. 
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• To place the decoration, please define the start and end point of the path if the Path finding option is 
activated.  

• Place the pavement on the background area with its reference point.  

• Define the direction of it by the cursor, or select from the options : 
 

Rotation angle… Define an angle for the rotation. 

Interactive 

rotation 
Define the angle by the endpoints of the sides of 
angle. 

1.107.10. Add One Tile 

This command is the simplified version of Add Tiles command. With the help of this, one piece of tile can be placed. It 
does not need any background area. 

 

• Select the Add One Tile command in the Toolbox. 

• The Tiling parameters dialog appears.  

� See the details in chapter 15.1.13. Add Tiles. 

1.107.11. Add Custom Tile 

With the help of this command, you can place custom tiles on the selected background areas. 

 

• Select the Add Custom Tile command in the Toolbox. 

• Define the profile of the tile using any option in the Toolbox – Profile definition tool.  

� See the details of Profile definition in chapter 8.9. Specifying profile (in manual). 

 
The following dialog appears: 
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• Similarly to the Add tiles function, you can give the names of tiles in this dialog; you can assign material to 
them from the program material library. 

• Besides, you can define the thickness of tiles and their raising from the background.  

• Finally, you have to define the Clipping border. Choose from the following options: 
 

No The whole selected area is going to be used. 

User profile The new pavement can be defined by an 
individual profile. By this, you can cut the tiles by 
the defined profile. 

Total clip With the help of Toolbox Profile options, you can 
design a profile on the background area to place 
the tiles on. The tiles can also be cut in this case. 

 

1.107.12. Tile Properties 

Decoration tiles can be modified by each or at once.  

 

• Select the Tile Properties command in the Toolbox. 

• Select the tile or tiles you wish to modify. 
Enter to accept the selection. 
The Modify the tiling dialog appears. 
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• You can modify the following parameters by clicking on the values in the Property column: 
 

� name of tiles, 
� material and its properties,  
� size,  
� thickness,  
� grout depth,  
� direction of tiles. 
� Profile: Switch on the Modify profile option so you can click on the Profile selection button to define a new profile for the 

tiles from the profile library. Profile modification is possible only for non-rectangular tiles with free contour profile definition. 
� The image properties of the material. 

 

These include the settings of the material assigned to the tiles. Setting possibilities are as follows:  
� Image rotation relative to tile: Opposed to the direction definition where the tiles are rotated the program rotates the 

material of the tile with the given angle. 
� Image width, image height.  

• You can make the rotation angle, the width and height of the image equal to the rotation angle, the width 
and height of the tile, respectively.   

• You can also define the origin of the image. 

• To validate the modifications, switch on the necessary options in the Modify column.  
 

� In case of individual tiling, the program use by appearing the material ordered to the hatching in decoration 

group. It could be more materials in one group. You can also modify the material of individual tiling. In this 
case, the program modifies all material, which has the same material as the selected in the decoration. 

1.107.13. Redistribute Tiles 

• Select the Redistribute Tiles command in the Toolbox if you wish to redesign the entire tiling area. 

• Select a tile that belongs to the area you wish to redistribute. 

• The Tiling parameters dialog appears. 

• You can select the new tile or the new rules to place the tiles: 

• Close the dialog and place the tiles with a new reference point. The program deletes the old tile pattern and 
replaces with the new one. 

1.107.14. Move Tiles 

• Select the Move Tiles command in the Toolbox  

• Select the tiles to be moved. 

• Give the reference point of the contour and move it to its right place. 

1.107.15. Copy Tiles 

• Select the Copy Tiles command in the Toolbox  

• Select the tiles to be copied. 

• Give the reference point of the contour and move it to its new place. 

1.107.16. Delete Tiles 

• Select the Delete Tiles command in the Toolbox  

• Select the tiles to be deleted. 
Enter to close the selection. 

1.107.17. Delete Tiles of Same Type 

You can delete in one step all of the tiles which have a same name. 

 

• Select the Delete Tiles command in the Toolbox  

• Select the tiles to be deleted. 
Enter to close the selection. 
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1.107.18. Modify material of background areas and tiles 

By means of these commands, you can modify the material of a background area or tile.  

1.107.19. Modify Material 

You can change the material of a background area. 

 

• Select the Modify Material command in the Toolbox  

• Select the contour whose material has to be changed.  
Enter closes selection. 

• Select a different material from the appearing Material dialog. OK. 

� To change the material of a tile sees the chapter 15.1.15. Tile properties. 

1.107.20. Reposition Material 

This command is used to modify the origin and the direction of texture pattern. It is useful when placing an image 
on a wall surface.  
 

• Select the Reposition Material command in the Toolbox  

• Select an area. 
Enter to close the selection. 

• Define the start point of the pattern. 

• Define the direction of the material pattern relative to the start point. 
Enter direction of the pattern is horizontal. 

1.107.21. Resize material 

By means of this command, you can modify the sizes of the texture of the selected background area or tile. 
 

• Select the Resize Material command in the Toolbox  

• Select the decoration to modify its size. 
Enter to close the selection. 

• Define the new width of the texture, or 
Enter accepts the original value. 

• Define the height of the texture, or 
Enter keeps the original ratio of height and width. 
 

1.107.22. Tiling - Show tile name on tiles 

To make the tile identification easier, it is possible to show the tile names on the decoration layout on the floor plan. For 
this, you only have to do the followings: 
 

• Click on the tiled decoration layout with your right mouse button. 

• Select the Display tile name command. 
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• The program will place the tile name on each tile, using the actual text properties: 

 
 

! The program lists the name of the tile, not the name of the material! 

Pay attention, when you use long tile name! 

1.107.23. Place tiling 

With the Interior menu – Tiling - Place tiling command, you can place the active tiling style (see Interior menu – Properties 
– Tiling) to a surface, typically on a wall. In a 3D window, you have to select a surface and then specify the reference point 
and the direction. In case of walls, you do not have to specify the reference point and direction. On a floor plan, you can 
use this command for tiling walls by clicking on a wall contour. 

1.107.24. Texture – as painting in 3D 

With the Interior menu – Tiling – Texture as painting in 3D command you can place a tiling background area with its 
material setting on the selected surface in the 3D window. 

• Select a material from the material library. 

• Select a surface in 3D. 

1.107.25. Texture – as tiling in 3D 

With the Interior menu – Tiling – Texture as painting in 3D command you can place tiling on the selected surface in the 3D 
window. 

• Select a tiling material from the material library. 

• Select a surface in 3D. 

1.107.26. Tiling in 2D 

With the Interior menu – Tiling – Tiling in command you can place tiling on wall side, wall part only, wall top, floor, ceiling 
and slab side. 
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• Select a function. 

• Select the appropriate part of wall/slab. 

• Use the appearing floating menu command for tiling the selected part. 

1.107.27. Delete tiling 

With the Interior menu – Tiling – Delete tiling command you can delete tiling on the selected surface in the 3D window. 

1.107.28. Tiling on any 3D surfaces 

Activate the 3D window and click on a surface. The selected surface is displayed with red colour. Choose for the 
command list the Tiling – Tiling Full Area. The tiling parameters dialog will be displayed. Choose here a texture for the tile 
and select the Whole area button. 
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Place the cursor reference point to the required tiling reference point on the selected surface. 
Now you can define the tiling rotation angle graphically or press ENTER to place it horizontally. 

 
 
You will receive the full tiling similar like that: 
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1.107.29. Copy tiling between surfaces 

You can copy an existing tiling to another surface with the Copy tiling commands. It makes quicker to make the tiling 
layout in a room, e.g. bathroom, where the tiles are frequently the same on more walls. 
 
Activate the 3D window and click on a surface. The selected surface is displayed with red colour. Click on the upcoming 
Green Tick icon.  
You can choose either the Tiling – Copy and Cut Tiling or the Tiling – Copy or Redistribute Tiling commands. 
Difference between the two commands: 
-Tiling – Copy and Cut Tiling copies the exactly same size of tiling to the new surface. 
-Tiling – Copy or Redistribute Tiling copies and fills with tiling the whole surface 
 
Now select the surface to copy the tiling on it. You will receive the tiling similar like this example: 
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.   

1.107.30. Listing tiles 

The tiling quantity take-off results an Excel list and displays the quantity of tile needed for the project.   

 

• Select the Add-On menu – Tiling – Quantity Take-Off command; switch on the Walls, Slabs, Rooms and Other 
checkboxes and the View results options.  
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1.107.31. Tile Patterns 

You can cover a surface of an architectural object not only with a rectangular or custom profiled tile but with a complex 
pattern as well. A tile pattern consists of separate tiles. 
 

 
 
Once you have a tile pattern, you can distribute it on a background area like distributing a single tile. 
 
Tile patterns are stored in an object library as a special group. You can find some predefined patterns in the Groups/Tiling 
patterns folder of the Design Centre 

Creating tile pattern 
This command is used to create a new tile pattern. 
 
In case of complex patterns, first draw the pattern precisely by means of drafting tools like lines or arcs. 

 
 

• Select Tiling/Create tile pattern in the Add-On menu. 

• Define the profile of the tile pattern unit using any option in the Toolbox – Profile definition tool. (On the 
figure above, the profile of the tile pattern unit is the square drawn by dashed line) 
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� Define a simple rectangle here: the program will use the height and width of the profile as a shift distance to 

multiply the tiles of the pattern, the exact shape of the profile will not be taken into consideration. 

 

� See the details of Profile definition in chapter 8.9. Specifying profile. 

 

• Select the Add One Tile or Add Custom Tile command in the Toolbox and create tiles on the pattern area.  
 
The tiles can overhang the profile of the tile pattern unit. Pay attention to define a pattern that can be distributed 
continuously on a surface. 

� You cannot change the gaps between two tiles of the same tile pattern unit in the dialog later; you should 

draw here the exact pattern including gaps. 

� See the details of adding tiles in chapter 15.1.13. Add One Tile and 15.1.14. Add Custom Tile. 

 

• Select the Close or Close and Remove Layout command in the Toolbox.  

• As the last step, you have to name the tiling pattern and save it in a user defined object library. 

� You can use your new tile pattern by means of the commands Add Tiles or Add One Tile. See the details of 

adding tiles in chapter 15.1.2.Tilling 
 
Modifying a tile pattern 

This command is used to modify a tile pattern previously created. 
  

• Select Tiling/Create tile pattern – continue in the Add-On menu and select a tile pattern layout on the 
drawing. You can also click on the tile pattern layout with right mouse button and select Continue decoration 

from the menu. 

� If you would like to modify a pattern in the object library, which is not present in any drawing window, first 

place it on a drawing. 

 

• Select a command in the Toolbox. You can add, edit and remove tiles here. 

� See the details of adding, editing and removing tiles in chapter 15.1.Tilling 

• As the last step, you give a different name to the tile pattern and save it in a user defined object library. 

 

 Example: Hexagonal Tiles with different colours 

You can cover a surface of a wall, slab or ceiling not only with a rectangular or custom profiled tile but with a complex 
pattern as well. A tile pattern consists of separate tiles. 
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Create the tile pattern for Hexagonal Tiles 
In case of complex patterns, first draw the pattern precisely by means of drafting tools like lines or arcs. Strongly 
recommended to draw a rectangle here that represents the repeat distance in X and Y. 
 
You cannot change the gaps between two tiles of the same tile pattern unit in the dialog later; you should draw here the 
exact pattern including gaps. 
 

 
 
 
Choose Tiling/Create tile pattern command 
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First, define a rectangle here: the program will use the height and width of the rectangle as a shift distance to multiply the 
tiles of the pattern.  
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Select the Add Custom Tile command in the Toolbox  
 

 
 
Select Polygon to trace on the first tile.  
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In the upcoming dialog, choose the material that will be assigned to the tile. 
 

 
 
Repeat the Add Custom Tile command as many times as you need. In this case, you have to repeat 3 times more to 
define the 4 tiles in this tiling pattern.  In this example, we chose 4 different materials (red, green, blue, yellow). 
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Click on Close command to finish the Add Custom Tile definition.  
 

 
 
Create the group that represents the tile pattern. In this last step, you have to name the tiling pattern and save it in a 
category.  
 

  Tip: Select the Tiling patterns category. 
 
When you press Ok, your new Tile Pattern is saved into a public object library, so you can use it later with other projects 
as well. 
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How to use the new Hexagonal Tiles with different colours? 
Select the Tiling on wall side command 
 

 
 
Define the background area 
Choose Toolbox / Add Tiles command 
 

 
 
Click on the Tiling pattern button in the dialog and select the new hexagon01 tiling group 
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The No. Of columns and No. Of Rows values must be 0 if you wish to fulfil the entire Tiling background area.  
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Press Ok, and place the group on the wall frontal layout. 
 

 
 
The software distributes the hexagon01 tile pattern and fills the entire tile background area.  
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Create the 3D model with the 3D Hammer button. 
 

 

 
 
How to modify the tiling to make it less regular? 
 
Later you can modify one by one the assigned material (colour) using the Tile Properties command. 
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The new tiling template enables to add tiling pattern to wall or any other surface as a one click definition. If you would like 
to try another tiling style, by a click you are able to change the whole tiling of the room or it is possible to modify the tiling 
styles wall by wall, so you can test the effects of them. 
 
Create tiling patterns from the tiles of the selected manufacturer and save them in styles. These styles can be used in the 
project or saved into templates, which are reachable in other projects as well. Please create the appropriate tiles first and 
then you are free to dream your tiling style. 

Create new tile 

 
The easiest way to create a new tile is via the Design Center. 
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Entering the Material folder the Settings icon in the upper right corner of the Design Center window becomes active. Click 
on the icon and choose “Create new material” command from the pop-up menu. You can set in the Material properties 
window for example the name of the material, its category, physical features image settings and dimensions. 
 

� For a description of material properties, see Chapter 3.8.1. The Material Properties. 

1.108. Tiling with real catalogue sets 

1.108.1. Create tiling style 

First, you should create the tiling styles using existing materials what you would like to use in the model, then it is possible 
to apply them. 
 
We can specify the orientation of the tile and other special properties while creating tiling style. You can activate the dialog 
box in the following ways: Manufacture / Properties /Tiling  
 

 
 
There is a Factory tiling style in the Tiling dialog box what you can use to create a new pattern or delete the rows to start a 
new one. 
 

 
 
The tiling style can be created horizontally (with rows) or vertically (with columns) what you can check in 3D drawing on 
the right lower corner of the dialog box. It is also possible to define where to start the tiling (From Bottom or From Top). 
 

Specify horizontal pattern 

Let us start by creating a horizontal pattern. The chosen tiles and the pattern stripes will form horizontal lines. You can 
specify the start of the tiling from top or from bottom. 
To define a pattern stripe you should specify the whole height of the stripe, the type of the tile and the color of the grout. 
The first line starts from 0, this is the relative height. The From Bottom / From Top option will take the exact location of it. 
With the placement options, you can set the position (left, right or center) of the stripe’s first tile. 
The created stripes are movable afterwards and their position is changeable too. In the preview window (right lower corner 
of the dialog box), you can check your work.  

Specify vertical pattern 

The method is the same as mentioned previously. There is one difference; we rotate the stripes by 90 degrees. 
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That is why it should be corrected on the Tiling parameters window. If you would like to keep the original position of the 
tile, you should choose Rotate left / Rotate right from the Orientation. 
 

 

 Navigation buttons 

Insert new: 

Creates a new stripe 

Delete: 

Deletes the selected stripe 

Move up / Move down 

Moves the selected stripe up / down 

Redraw: 

Updates the 3D model in the right lower corner 
 

  The properties of the stripes 

Please find below the modifiable or informative properties of the tile stripes. 
 

 

Index 

It shows the number of the exact tile stripe in the row. Using one index for the same tiles in one or more lines is 
recommended. If you would like to have more lines under an index number, please modify the height of the stripe. Please 
create a new stripe (with the next index number) by clicking on Insert new button if you would like to use another type of 
tile. 

Displayed layer 

We can adjust the visibility of the stripe. Use this solution for example in case of kitchen wall tiling between the lower and 
upper cabinets. The first line starts from 0 m, so we create a 0,9 m high stripe with No. 1 and switch off the visibility of it at 
the Displayed layer option. You will not see this tiling and the designed tiling starts with 0,9 m. 

Height 

Here you can specify the height of the tile (including grout). If you would like to place for example three rows with the same 
tile, you should add the height of the tile three times and calculate the grout thickness as well (between the mentioned 
three tiles). 
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The calculation of the height is n*(t+g)=h , where 
n = number of the rows (with the same type of tiles) 
t = height of the tile 
g = thickness of the grout 
h = total height (with the same type of tiles) 

Elevation 

Shows the relative height (from 0 m) of the stripe. 

Visibility 

You can control the display of tiles (by switching on or off). If you switch off the visibility (the tiles are invisible), you will 
only see the material of the grout behind the tiles. 

Tiles 

You can set the properties of the tiles in the selected stripe:  

� For a description of Tiling parameters see Chapter - 15.1.12. Add Tiles.  
Orientation: rotates tile. 

 
 

� Orientation plays important role when you create vertical patterns. 

Choose Rotate left / right option if you would like to keep the original position of the tile. 

Placement options 

You can set the starting place of the tiling (from the left side of the wall, from center or from the right side). 

Grout 

Choose a grout-material from the Materials library. 

1.108.2. Save tiling style  

Style button:   

Displays the window where you can save the adjusted tiling style as a new style or activate, modify, rename, delete an 
existing one. 

 

 
 
The following operations are can be done with styles: 

• Create new folder (including one or more styles) 
• Activation of style 
• Modify, rename, delete a style 
• Activate a style and create a new style with this active one. 
• Copy property with a style 
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1.108.3. Place tiling style from the Design Center 

The tiling is applicable by dragging into the surface the selected style. Its steps are as follows: 
 

• Search in the Design Centre from Templates the style what you would like to use. 

!  The program saves the created styles only into the Project folder. If you would like to reach it from another project as 

well, make a copy from this style to another folder, for example into the My folder. 

 

• Press and hold down the left button of the mouse and drag the style to the desired surface and release the 
button. 

• Select the “Place tiling” option in the pop up menu. 

• Click on the surface what you would like to cover. The program places the chosen tiling style on the selected 
surface. In case of floor covering, please define the direction of the tiling.  

• If you do not want to apply this style on further surfaces, press Esc to exit the command. 
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1.108.4. Place tiling style from the Room Maker 

 
 

The previously created sets are applicable in the Room Maker, and some details can be simply modified (for example 
change a tile or a row / column). How to use the Tiling styles in the Room Maker? 

• Start Room Maker. (Click on Toolbox – Start – Room Maker, then point inside an area bounded by single 
walls. The dialog box of Room Maker shows up.) 

• Click on Wall Tiling or Floor Tiling button to reach Tiling sets. 

 

• On the left side of the dialog box, there are the tiling modes and the first one is the Sets or Tiling styles. 
Several tiling styles show up in the Favourites by clicking on it and you can open existing ones by clicking on 
the Select new item from the library (blue plus). Select the set what you would like to use, press green thick 
and the tiling takes place on the wall. 

• The applied set can be modified or customized if it is necessary. 

� For description of the Tiling settings in Room Maker see Chapter 9.13.2.14. Wall Tiling Panel and 

9.13.2.15. Floor Tiling Panel. 
You can create a new set as well by clicking on the Tiling styles button (yellow star).  
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1.108.5. Place tiling style by command 

There are three ways to place tiling style by command: 

From Menu bar 

The command paths of “Place tiling” are different depending on the mode (Architect or Interior) of the software. 

   
 
 
Architecture edition: Interior edition: 
Add on menu / Tiling / Place tiling Furnishing / Tiling / Place tiling 
 

From Toolbox 

Place tiling in Toolbox is only accessible in the 
Interior edition on the following path: 
Furnishing menu / Tiling / Place tiling 
 
 
 

From Local menu 

Click on the wall with the right button of the mouse, the Local menu of the wall shows up, where you can find Tiling / Place 
tiling. This command is only accessible in 3D-window. 
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1.109. Drawing comparison 

Introduction 

In the design process, mainly in the case of building reconstruction plans, it is often required to show both the current state 
and the future plan on the same drawing. Sometimes we need to compare the previous state of our drawing with the 
current state, highlighting the differences. 
 
The program is suitable for representing the objects of the original drawing and the new objects with different colours, so 
you can easy follow the changes like demolished walls or relocated windows, by colours. 
 
Comparison can be made between two floor plans or two 3D views. Of course, any other 2D drawings can be compared. 
It is important to note that the comparison is made only on the level of drawing objects. This means, for example, that a 
change made in the parapet height will not occur in the comparison of floor plans. This will occur only in the comparison of 
facade drawings. 
The comparative drawing, which is always 2D vector graphics drawing, will come up in a new window, so it does not affect 
the existing drawings. 

1.109.1. Comparison of two floor plans 

• Open your project and activate the window that includes the original floor plan. The content of this drawing 
will be compared to the appropriate floor plan in your new project. 

• Select the Add-On menu – Drawing Comparison command. 

• Choose the drawing including your new floor plan or choose the new floor plan from a project. 

• In the appearing dialog, specify different colours for unchanged objects, objects of the first (original) 
drawing, and objects of the second (new) drawing. 
 

  
 
By default, the active floors of the selected floor plans will be compared to each other. 

All floors 

• With this option, the comparisons will be made for all floors, one by one. 

All buildings 

• With this option, if there are more buildings on the floor plan, all buildings will be compared by the program. 
 
By clicking on the Ok button the comparison will start and the result will appear in a new window. The content of this 
window is a vector graphics 2D drawing (without any 3D content), where the changed and unchanged objects are shown 
by different colours. You can switch between floors with the Page Down and Page Up buttons. 
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Original state  Future plan 

  

Comparative drawing 

 

 
Wall to demolish 
 
 
Wall to demolish, 
window to relocate 
 
 
 
 
 
Wall to rebuild 

1.109.2. Comparison of two 2D/3D drawings 

Comparative drawings can be made not only for floor plans but for any other drawings. 
 
For example: 

� A floor plan can be compared to the appropriate 2D DXF or DWG drawing. 
� Similar 2D drawings can be compared. 
� Different 3D window contents like main views, sectional views, or even two axonometric views with similar settings, can be 

compared. 
�  

In these cases, all go the same way as for floor plans. At the file selection, you have to specify the appropriate file type. 
 

 
 

� Using the all floors switch can make sense in these cases, too: for example, you can place the copies 3D views onto 

different floors of a floor plan window, which means that you are working with 2D drawings. Then you can make the 
comparison of these drawings, floor by floor. 
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1.110. Calibration and vectorization 

Introduction 

Drawing often requires raster images. You can create a raster image by using a general plan, a handmade plan, a contour 
map, etc. 
Raster images are either supplied in a digitalized form or available after scanning. Raster images can be imported into the 
drawing to create a background. 

Raster image 

The raster image created this way 
contains background points (pixels). 
The number of pixels defines the display 
resolution of the raster image and so its 
quality, however it represents no other 
specific value. Accordingly, the raster 
image cannot be considered particularly 
useful with respect to the actual 
drawing. 
The image imported into the 
background unquestionably increases 
the aesthetic value of the drawing but is 
only relevant if its scale aligns with the 
corresponding scale of the drawing 
area. Thus, the scale of the raster 
image has to be changeable. 

 

 

� To insert a raster image into the drawing area use Drafting menu- Insert raster image command to read the image into 

the drawing area.  

 

� See description in 11.8. Raster images chapter. 
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Calibration 

Calibration is a special method that coordinates the imported raster image with the vector drawing thus ensuring the 
possibility of specifying real distances, areas or angles in the raster image. 
 
When an imported raster image can be coordinated with the drawing (e.g. a general map), the true-to-scale size of the 
drawing can be configured by linear calibration. Linear calibration enables the setting of a certain scale to establish a 
proportional relationship between the pixels of the raster image and the drawing area (and its coordinates) of 
ARCHLine.XP. When the scale set for calibration matches the true scale, you can work in true scale (1:1) in the raster 
image as well. It means that each vector graphics operation, editing or query is performed by the program in true scale 
from the user’s point of view; however, the configuration of the size depends on the background. 
 

You find calibration in the Add-On 
menu - Raster Image Calibration. 
 

Depending on the available information 
calibration can be performed in different 
ways: 

 
� matching 2 points with 2 other points 
� with distances 
� with coordinates 

 
In the first case, use the Calibrate raster- Fast command, while in the second and third cases use Calibrate raster. Start 
the operation with the New option and use the Continue option for more accuracy. 

Vectorization 

The calibrated image still contains pixels, meaning that during drawing the program does not recognize the content of the 
image, e.g. the lines of the handmade plan. That is why vectorization is needed. 
 
ARCHLine.XP enables the vectorization of an imported image (a general plan, a contour map, a handmade plan). It 
means that the program recognizes the contours in the scanned image and generates lines on top of them. The result is a 
lined drawing. Using the command allows for the recognition of not only lines but of open and closed line chains. This 
method significantly decreases the time of planning by eliminating the time-consuming tracing of scanned general plans or 
models. 
 
After vectorization, you can turn off the image file and edit the already lined drawing further. 
 

� You can reach the command via the Add-On menu – Raster Image Calibration- Raster to vector. 

1.110.1. Calibrate Raster - Fast 

You can use the Add-On menu - Raster Image Calibration- Calibrate raster- Fast command when you have two 
coordinating reference points on both the general plan and the plan. The command renders the two original points 
selected first to the two other points. By specifying rototranslation the program configures the general map to the scale 
matching with that of the plan and rotates it in the right direction. This way calibration and matching are performed in one 
step. 
 
E.g.: One building on the general plan is also there on the plan. Here you can use the two endpoints of one of the building 
walls as reference points on both the general plan and the plan. 
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• Specify the start point of rotation and movement transformation: 1st point. 

• Specify the endpoint of rotation and movement transformation: 2nd point. 

 
• Specify the new location of the start point: 3rd point. 

• Specify the new location of the endpoint: 4th point. 

 
 

The program matches the general plan and the plan: 
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1.110.2. Calibrate Raster - New 

When you know distances or coordinates in the raster image, start the true-to-scale configuration of the image via the 
Add-On menu - Raster Image Calibration- Calibrate raster- New command. 
 
You can calibrate an image file in two ways or with their combination: 
 

� with distances, or 
� with coordinates. 

 
You can use coordinates for calibration, e.g. when they are indicated on the general plan. If coordinates are not available, 
use distances when calibration. 
E.g. If you know the location of the coordinate cross on the general plan, specify the coordinates. However, if later on you 
want to use the distance between the corners of two buildings or the width of the road, specify the relevant distance for 
calibration. 
In case of a handmade plan the length of the walls are available, consequently you specify the distance when calibration. 

With distances 

• Specify the start point for calibration. 

• Specify the endpoint. 
Specify the distance between the two points. 

• Specify further pairs of start and endpoints. 
Enter Finishes the specification of distances. 

With coordinates 

• Specify the start point of calibration. 

• Select XCOORD option to indicate that you wish to specify the points with true coordinates. Then enter the 
coordinates in the window thus displayed. 

• Chose the endpoint for calibration and specify its coordinates. 

• Specify further pairs of start and endpoints and indicate their true distances. 
Enter Finishes the specification of points. 

Options: 

PREVIOUS You can select the PREVIOUS option if you want to 
specify the start point of the previous pair of points 
as the start point of the next pair of points. 
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LAST • You can select the LAST option if you want to 
specify the endpoint of the previous pair of 
points as the start point of the next pair of 
points. 

 
The program asks in both cases if you really want to finish calibration. 
If the answer is yes, the Calibration dialog box appears and indicates the average quadratic error in case of all the 
distances used. 
The error equals the difference between the expected and the specified values and is indicated next to each distance. 
The maximum number of distances you can calibrate in the raster image is 100. You can exclude some of the distances 
by using the dialog box. You are suggested to exclude distances with larger values of error. Thus, you can decrease the 
value of the average quadratic error. The more distances you specify the more accurate your calibration is. 
 

 
 
E.g., exclude the 3rd value where the error of 0.9 is the largest. 
 

 
 
Thus, you have decreased the value of the average quadratic error. 

1.110.3. Calibrate Raster - Continue 

You can use this command if you have already started calibration but you would like to specify more points in order to 
increase the accuracy of the calibration: 
 

• Open the project containing the calibrated raster image. 

• Specify the new points for calibration. 
 
When you have finished calibration, the dialog box indicates the distances and the percentage of error for each calibrated 
point of the image (the list includes the points specified previously as well). 

1.110.4. Vectorization of images 

As mentioned previously, image files contain pixels. As the program does not recognize the content of the image that is 
why vectorization is needed. 
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The Add-On menu – Raster Image Calibration – Raster to vector command enables the transformation of the imported 
image file into a vector drawing. The image file can be a general plan, a contour map or a handmade plan. 
 
The algorithm finds the contours on the image file and generates lines on top of them. The result is a lined drawing. The 
algorithm allows for the recognition of not only lines but of open and closed lone chains. 
 
You can set the following parameters in the Vectorization dialog box thus appeared: 
 

� The properties of the generated lines: colour, width, and layer. 
� The tolerance that influences the accuracy of vectorization. 
� The type of vectorization: line or contour vectorization. 

 
Line vectorization recognizes e.g. the boundary of a site as a line. 
Contour vectorization generates a line on both sides of the boundary line. 
 

 
 

This method can be effectively applied together with the calibration function. 
 
For example: In the case of a general plan, first you have to use calibration. After calibration, your general plan is true-to-
scale. Now you can use vectorization. The result is a true-to-scale lined drawing. You can switch off the image file if it is no 
more needed. You can further edit the lined general plan. 
 
The general plan as an image file after calibration: 
 

 
 
The general plan after line vectorization: 
 



 16. Add-On 1009 

ARCHLine.XP® 

 
 
We have erased the unnecessary words (that have been generated into lines, too) of the lower site in the lined drawing. 
 
The general plan after contour vectorization: 
 

 

� There is a difference between the Vectorization function and the Find edges function of photogrammetry. Find edges can 

be applied for photos and measures the difference between the grey levels of the image file pixels. 
 

1.111. Model to a photo  
Model to Photo tools enable you to align a photo of an architectural site with the 3D model 
 
ARCHLine.XP offers two methods: 
Method I – Estimation 
Method II – Known Distances 
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1.111.1. Method I – Estimation 

This method requires a set of point correspondences between characteristic edges of the 3D model and their respective 
depictions on the photo you want to match to. 
 
There is no need for exact distances.  
 
Method I – Estimation means the following steps to perform: 
 

� Import Raster Image  
� Define a reference box and use it later to find the approximate viewpoint on the photo. 
� Set up perspective view. 
� Refine perspective view 
� Create the photorealistic image 
� Edit matched photo 

 Import Raster Image 

Select Add-on/ Method I.  - Estimation / Import Raster Image command.  
 
Select the photo in which you want to insert the model and then place it into the 3D window by giving its bottom-left and 
top-right corner.  

 Define a reference box 

Select Add-on/ Method I.  - Estimation / Set up Reference 3D model command.  
 
This command is a necessary step prior work on aligning 3D models to photo. 
The dialog offers the reference box with the size of the enclosing box of the 3D model.  
 
Accept it or use dimensions, which make the aligning to the photo easier, e.g. room height. 
The software aligns this box to the imported photo. 

 

 Set up Perspective 

Select Add-on / Model to a Photo / Method I.  - Estimation / Set up Perspective command.  
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The established correspondences is in turn allow to find an approximate viewpoint of the 2D depiction with respect to the 
3D model. 
This command works with perspective guidelines. 
 
1. Vanishing point bar:  

The two red bars with dashed lines should match characteristic edges on the photo on one side, and the two green 
bars with dashed lines should match lines on the other side. You find square marker on each end. Click and drag the 
grips to align these bars with characteristic edges on the photo. 

 

� Use the zoom in and out commands with the mouse wheel to make sure your lines are as accurate as possible. 

 
2. Horizon line:  

This blue horizontal line aligns with the horizon in your model. You can move up and down the horizon line according 
to the photo but most of the times the horizon line takes care of itself. 

 
3. Axis bars:  

The solid green, red, and blue lines represent each axis. As you adjust the vanishing point bars, the axis bars move 
automatically 

 
4. Axis origin:  

The origin is where the three axes meet. Click on this marker and drag to align this point to locate the 3D model 
properly on the photo. 

 
5. Scale marker:  

Click on this marker and drag up and down the blue axis bar to scale the 3D model on the photo. 

 
 

 
 
6. Options marker:  
 
You find some additional options on the Anchor marker. 

• Rotate 90 ccw: You can rotate the model in 90 degree units counter clockwise. 
• Rotate 90 cw: You can rotate the model in 90 degree units clockwise. 
• You can fix the horizon line with Fix horizon line when moving vanishing point bars”. You can give priority to the 

horizon line against the vanishing point bars or the opposite. 
• Relocate the 3D model relative to the image means to relocate the 3D model relative to the image. The axis origin will 

follow the move.  
• Relocate marker on the screen command enables to move the Options marker on the screen to a more convenient 

position.  
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 Refining perspective 

You can continue to find more precisely the approximate viewpoint of the 2D depiction any time by selecting  
Add-on / Model to a Photo / Method I.  - Estimation / Refine perspective command.  
The command offers the same tools like described in the previous chapter. 

1.111.2. Create photorealistic image 

Select Add-on / Model to a Photo / Rendering command. 
 
This command executes the accurate matching of the model’s photorealistic image and the photo. 
 
The Render Properties dialog automatically appears on the screen. Set the Rendering properties and press Start 
Rendering. 
 
The Render application creates two images. The first file contains the photo with the model and the second one contains 
only the photo.  
Press SAVE when the first render is finished. The creation of the second image starts only when you press the Save 
button. 
The size and the tone of the second image correspond to those of the first one. 
 
When the second rendered images is completed, the two images are placed on the floor plan automatically. 
 
You can make the necessary corrections by using the Edit matched photo command. 
 

� The rendering applies the current light settings of the 3D view. 

1.111.3. Edit matched photo 

Select Add-on / Model to a Photo / Edit matched photo command.  
 
This command allows you to make the necessary corrections on the rendered image. 
You can often face typical problems such as for example when the side of the building covers the adjacent building in the 
photo. To overcome these obstacles, you need to edit the image. 
 
Click on the images to start the editing. 
Now you have two images on the drawing in a group. The first file contains the photo with the model in it and the second 
one contains only the photo. The size and the colour of the second image correspond to those of the first one. 

Image editing floating toolbar  

The floating toolbar automatically appears on the screen when you click on the images to start the editing.  
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The following table explains the individual functions on the Image editing toolbar  
 

Icon Command 

 
Use Polygon to draw and copy a part of the background image to the rendered 
image. 

 
The degree of transparency of the rendered image can be adjusted between 0% 
(fully transparent) and 100% (opaque) 

 
Edit any of the polygons. Click inside the polygon to start editing. 

 
Choose a polygon to delete 

 
Delete all polygons 

 
Save the edited image in a new file. 

 
1. Transparency slider to adjust the transparency of the rendered image. 

  
 
2. Draw a polygon. The polygon area is forwarded from the background image and covers the rendered images. You 

can add more polygons to forward more details. Later you can edit, delete and delete all polygons. 
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3. Display the result of the two images. Move the slider to the maximum position. 

  
 
4. Save the result of the two images. 
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1.111.4. Method II. - Known Distances 

The Known Distances method requires exact distances. 
You find the command in the Add-On menu – Insert 3D Model in photo’s context menu: 

 Set up view by block 

Activate the 3D window. 
Select Add-on/Insert 3D model in photo’s context / Import Raster Image. Select the photo in which you want to insert 
the model and then place it into the 3D window by giving its bottom-left and top-right corner.  
You must define the perspective of the photograph. For this, you have to use a reference block. 
 
The following example will demonstrate this method. The task is to insert the model into the place of the second building 
on the right. 

 
 
Select the 2. Set up Axis Markers on Raster Image command to display the following dialog box: 
 

 
 
This dialog box contains the dimensions of the model to be inserted. Of course, you can freely change the values 
according to your needs. 
 
You can choose here whether you would like to use the horizontal or the vertical plane for the perspective plane. In this 
example, we use the vertical plane. 
 

• Specify the dimensions of the enclosing rectangle with the help of the distances measured on the 
photograph: 
 
Width: 12 m, the distance between the two neighbouring houses, this equals the width of the model. 
Height: 18.5 m, the height of the building shown in the photograph, up to the cornice. 
Depth: 6.19 m 

• Define the name of the perspective transformation: Persp_1 
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The program inserts the reference block according to the dimensions that you have defined. 

 
• Define the perspective of the photograph in a way that you move the nodes of the block to the appropriate 

places on the photograph that is in points 1, 2, 3 and 4. 

 
 

• Press Enter to display the result on the screen. 

• Move the edge of the block representing its depth along the hyperbole, taking account of the edges 
representing the depth of the building. 

• If you are satisfied with the perspective you have created, press Enter, and the program completes the 
definition of the perspective. 

 Update 3D model on Raster Image 

If you are dissatisfied with the perspective formerly defined, you have the possibility to modify the perspective definition 
later. 
By applying the Update 3D model on Raster Image command, you can adjust the position of the nodes of the previously 
defined perspective block. 
 

• Select the point of the perspective plane you wish to move. 

• Specify the location of the new point. 
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 Assign 3D model on Raster Image  

With this command, you can insert the object into the perspective of the photograph in a way that you assign a point of the 
perspective plane to the corresponding point of the 3D model (see the previous figure). 
 
The program fits the 3D model into the original viewpoint of the photograph. If you apply precise values, the program 
performs the command with high accuracy. 
 

• Define a point on the perspective photograph: point 1. 

• Define the appropriate 3D plane on the object: point 2, or 
choose from the options of SSOLID MENU. 

• ENTER The selected plane is rotated in the appropriate direction. 
NO Selects another plane. 

 
• Specify the corresponding reference point on the 3D plane: point 3, or select an option from 3D point 

definition. 
As a result, the program projects the 3D model into the photograph. 

 
 
This way we have inserted the model into the photograph and now it is displayed in the same perspective as its 
surroundings. 
 

� If the perspective has not been defined precisely, the result can be imprecise. In this case, modify the definition of the 

perspective by applying the Modify definition command. 
 
There are two more tasks to be completed: 

� to create the photorealistic display of the model, and 
� to edit the ready image in a way that the sides of the building does not hide the parts of the photograph. 

 
If you are satisfied with the result of the previous perspective transformation, select insert 3D model into perspective in 
Render window command.  
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1.112. Surveyed room 

Introduction 

You can use the survey function of ARCHLine.XP to draw up the reconstruction drawings of old buildings. 
In ARCHLine.XP, a surveyed room refers to an architectural unit and the walls are actually the areas between the different 
rooms. 
This group of commands can be very useful if you want to make an exact plot of an "irregular" area with many corners and 
distorted angles.  
You can start the planning with a traditional on-the-spot survey. It is difficult to measure the angle of the walls so you have 
to measure the length of the sides and diagonals in the room to be reconstructed instead. You can calculate the accurate 
geometry of the rooms using these parameters.  
 
You can also use the surveyed room command for the conversion of old hand made plans. You do not have to do the on-
the-spot survey in an already existing building if you have a handmade plan with recesses and walls of special structure or 
different width available as a raster image. 
After the calibration (true-to-scale conversion) of the drawing you can redraw each room. In this case you do not need to 
use diagonal measuring, the true-to-scale plan is sufficient for the editing. You have to define the rooms as well as the 
outer wall, as the rooms and the areas between the rooms create the walls of the building. 

1.112.1. Specifying room properties 

The wall structure of the room surveyed is different from that of the real walls. 
You cannot create a layered structure or cannot set the reference line of the wall. The Room properties dialog box 
contains significantly less number of properties than the Wall properties dialog box. 
Besides, you cannot apply special wall editing functions such as the creation of front view or section profiles. 
That is why you are recommended to change the surveyed walls into real walls after finishing the survey. 
 
You can set the general properties of the room with Building menu – Properties – Surveyed room command. The following 
dialog box appears: 

 

 
 

Rooms - like any other objects of ARCHLine.XP - have general properties such as colour, layer, and line type and line 
width. 
Further room properties: 
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� Height 
� Base offset from the floor 
� Wall finish 

� See 3.2.1 Specifying general properties. 

1.112.2. Surveyed room 

The Building menu – Surveyed room command group contains the methods used for the on-the-sport survey. The 
commands follow each other in the usual order of the real surveys. 
 

 
 

� First, you can create a new room and draw up its sketch. 
� After drawing up the sketch, you can increase the accuracy of the room structure with using diagonal measuring. Drawing 

the rooms is based on the triangle method. The three sides of the triangle clearly define its real angles and its geometrical 
shape. 

� You can further modify your sketch by editing the nodes. 
� You can connect the rooms with windows or reference points. 
� You can create outer walls that can be further edited based on the survey data. 
� The walls surveyed can be transformed to real walls after finishing the survey. 

 

Both 2D drawing and 3D modelling are completely integrated in the program. 
When drawing, the program will automatically generate the 3D model of the building. 

 

� Room walls are not the same as real Walls.  

Room is a logical unit and room walls exclusively exist in the room itself. 
A real wall is an independent object not related to any room. 

 Creating or selecting a room 

This dialog box helps you to create a new room or select one from the already existing rooms. 
 
You can choose between two methods when creating a room: 
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� you can select an already existing contour, or 
� you can draw the contour of the room yourself. 

Creating a room with the selection of an already existing contour 

• Click on the Select contour option in the dialog box.  

• Specify the name of the room and close the dialog box by clicking on the OK button. 

• Select the objects of the contour made previously to create a room. When choosing the CLOSE option the 
program will select the polygon closest to the location of where you have clicked on and will use it as a 
contour. 

• You can finish selecting the room wall by pressing the Enter button. 
 

! If the contour you have specified is not closed or its objects do not intersect each other, the program sends you an error 

message and will not generate the transformation. 

Specifying a room by editing the contour 

 

• Turn off the Select contour option. 

• Enter the name of the room and close the dialog box by clicking on the OK button. 

• Draw the contour defining the walls of the new room. The contour can consist of lines and arcs.  

� For more details see: 8.9. Specifying profile -polyline chapter. 

• When pressing the Enter button the program will automatically close the line chain of the walls, however, 
the walls cannot intersect each other. 

• After created the room, click on the  Select/deselect room icon. The dialog box list the rooms: 
 

 

Room name and area 
After the specification of the contour, the program will automatically indicate the name of the room and its area in the 
geometrical centre of the room. 

If you do not need the indication of the name of the room and its area, click on the  Undo button in the Reference 
toolbar. 
The area measuring is associative; consequently, if you change the contour of the room the number indicating the area 
will be automatically changed. 
 
You can modify the room name by the Shortcut menu - Edit - Rename command. 

Selecting or activating a room 

If you want to modify the text (name, area) indicated in the existing room you have to activate the room. 
Select the room name from the list in the dialog box. The New room field remains empty. When closing the dialog box by 
clicking on the OK button the selected room is activated. Now you can modify the text and its position. 

 

� You can use the combination of Ctrl+T buttons for the same purpose. Press the buttons to select a new active room. 
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Deactivating a room 

If you have an active room, you cannot access the other rooms. After you have completed modifying the text of the room, 
you have to return to the level of the other rooms: 
 

• Use the combination of the Ctrl+T buttons. 

• Select the TOP option  

Options: 

TOP Closes the activated group and returns to the top level. 

BACK Closes the activated group and moves one level back. 

 

� You can also use Tools - Deactivate command to deactivate a room. 

 Diagonal measuring 

After drawing the sketch of the room, you can measure the room diagonals to finalize the shape of the room. 
You have several methods available in ARCHLine.XP to define the appropriate angles of the room. You can apply more 
than one method in the same room. 

 

� You have to specify the basic shape of the room and the minimum number of diagonals - usually n-3, n referring to the 

number of the sides of the room - to draw a room. If the number of diagonals exceeds n-3, the room will be „over 
defined”. 

 
When you select the command, the following dialog box appears:  
 

 
 

• Select the most suitable method. 
You can select from the following methods: 

By triangles 
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If you want to specify the length of the sides and the diagonals in succession, you have to divide the room into triangles. 
This single method will enable you to modify the shape of the room step by step. 
In other words, this method will use triangles for the measuring, so you have to fix two vertices of the triangle previously. 
(The level of freedom of the succeeding triangle can be only one.) In the case of the first triangle, however, you do not 
need to fix the vertices in advance. 

 

• Define the contour of the room to be modified. 
 

Fixing the first side or diagonal: 

• Define a wall node to be the basis point. The basis point keeps its position and the next point is measured 
from it. (point 1) 

Options: 

MOVENODE Replaces the wall node defined by clicking on it to the 
preferred position. The basis point and the newly 
defined wall node create a wall section. 
This is the only way to define the position of the 
second wall node. 

ENTER • You can select another basis point instead of 
the previous one. 

 

• Define the opposite point of the diagonal, which can be the wall node next to the basis point as well (point 

2). This point can change its position. The program displays the diagonal between the two wall nodes. The 
dialog box displays the actual length of the diagonal: 

• Select either of the following two options: 
 

Absolute The new length refers to the full length. 

Relative • The new length refers to the relative value 
related to the original length. 

 

• Enter the new length of the diagonal. Click OK 
If you have modified the actual length, it means that the point defined for the second time can change its position. 
You have fixed the basis of the first triangle (by points 1 and 2). 
The program displays the new shape of the room. 

 
Fixing the first triangle: 

• Specify an undefined point to fix the first vertex of the triangle. This vertex can change its position (point 3). 

• Define the second vertex of the triangle (select either of the already defined vertices, point 1). 

• The dialog box appears and displays the actual length of the diagonal. Enter the new length. Click OK. This 
way you have defined the first side of the triangle (by points 3 and 1). 

• Define the third vertex of the triangle by selecting one of the already defined points (point 2). 

• The dialog box appears and displays the actual length of the diagonal. Enter the new length. This way you 
have defined the second side of the triangle (by points 3 and 2). 

•  

 



1024 16. Add-On 

Manual 

Option: 

ANGLE You can modify the shape of the triangle by defining the 
angle. Select the third vertex of the triangle. The program 
hatches the defined triangle. Select one of the vertices of 
the triangle and enter its angle. 

 
The program displays the new shape of the room. 
 

• Define further undefined points to create other triangles:  
The basis of the triangle given in the example is the diagonal defined by points 2 and 3. The next (and last) 
undefined point is point 4. The first side of the second triangle is defined by points 4 and 3 and its second 
side is defined by points 4 and 2. 

Options: 

BACKWARD You can undo your previous modifications by the 
BACWARD option during the algorithm. 

FORWARD • You can move forward again by the FORWARD 

option. 

•  

• Press Enter to complete the command. 
The Diagonal measuring dialog box reappears. 

• You can select another method for the reconstruction of the geometry of another room, or 
Click Cancel to exit the command. 
 

• Defining the centre - Using the CPOINT option 
You can use this option when you cannot survey any of the room walls (e.g. because of a furniture object objecting it). 
Here you have to define a reference point in the real room from where you can measure each corner of the room. From 
then on, you will measure the distance of the corner points in relation to this reference point. You have to measure the 
length of the other (measurable) sides as well. You will generate triangles again without defining the unknown side. When 
finishing the algorithm the program will establish the length of the missing side. 
The method is the following: 
 

• Define the contour of the room to be modified. 

• Click on the CPOINT option and define a point to be a reference point. (point 1) 

• Select one of the corner points of the room (point 2) and enter its distance from the reference point. This 
way you have defined the basis of the triangle (by points 1 and 2). 

• Define another (undefined) corner point (point 3) next to point 2 and the previous corner point (point 2) as 
well and enter their distance. This way you have defined the first side of the triangle (by points 2 and 3). 

• Select the reference point and enter its distance from the previous corner point. This way you have defined 
the second side of the triangle (by points 3 and 1). 

• The basis of the next triangle is the second side of the first triangle (defined by points 3 and 1). Continue the 
same way and select the next undefined point (point 4, then point 5) and generate other triangles. 

• When you have no more undefined points, use Enter to finish the specification of the points. 
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The length of the side defined by 
points 2 and 5 is unavailable. The 
program has established the missing 
length (4.6 m). 

By nodes 

 
 
Disable the By triangles option in the dialog box and enable the By nodes option. 
With this method, you can move only the previously defined nodes. The first defined node is the reference point of the 
moving. You do not generate the triangles based on each other. You can have several open triangles at the same time but 
will have to close them once. 
 

• Define the contour of the room to be modified. 

• Select a wall node to be the basis point. The basis point does not change its position. You can measure the 
sides next to it as well as the diagonals starting from it. (point 1) 

Options: 

MOVENODE Replaces the wall node defined by clicking on it to 
the preferred position. The basis point and the 
newly defined wall node create a wall section. 
This is the only way to define the position of the 
second wall node. 

ENTER • You can select another basis point instead of 
the previous one. 

 

• Define the opposite point of 
the side or diagonal (point 2). 
This point can change its 
position. The program displays 
the side or diagonal between 
the two wall nodes (points 1 

and 2). The dialog box displays 
the actual length of the side or 
diagonal: 

• Select either of the following 
two options: 

 

 

 

Absolute The new length refers to the full length. 

Relative • The new length refers to the relative value related to 
the original length. 

 

• Enter the new length of the diagonal. OK 

• If you have modified the actual length, it means that the point defined for the second time can change its 
position. 
The program displays the new shape of the room. 

• Specify all the sides that can be measured from the first basis point or the diagonal and specify the lengths 
(points 3 and 4). 
Press Enter to complete the specification of lengths in relation to the first basis point. 
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Define another basis point from 
where you can measure the 
length of sides and the 
diagonal.  
In the example point 4 becomes 
the new basis point from where 
you can measure the length of 
the sides defined by points 4 
and 2 and by points 4 and 3 
respectively. 

 
 

By selecting a new basis point (3rd point) you can establish the length of the diagonal defined by points 3 and 2. This way 
you will over define the room. In the case of measuring inaccuracy, the program offers to start an iteration process for the 
elimination of the error. 
 

� See Eliminating measuring inaccuracy when using the By nodes method at the end of the chapter. 
 
The program displays the new shape of the room. 

•  
Enter Completes the modification of the room. 
The Diagonal Measuring dialog box reappears. 

• You can select another method for the reconstruction of the geometry of another room and then click on 
the OK option, or 
Cancel Exits the command. 
 

• Defining the centre - Using the CPOINT option 
You can use the CPOINT option here as well, just like in the case of the triangle method. Here you have to define a 
reference point in the real room from where you can measure each corner of the room. From then on, you will measure 
the distance of the corner points in relation to this reference point. You have to measure the length of the other 
(measurable) sides as well. 
First, you enter the distance measured between the reference point and the corner then the lengths of the walls with the 
exception of the unknown side. When finishing the algorithm the program will establish the length of the missing side. 
The method changes in the following way: 
 

• Define the contour of the room to be modified. 

• Click on the CPOINT option and define a point to be a reference point. (point 0) 

• Select one of the corner points of the room (point 1) and enter its distance from the reference point. (Points 

0 and 1). 

• Select all the corner points in succession and enter their distances from the reference point, (point 2, points 

0 and 2, point 3, points 0 and 3, point 4, points 0 and 4). 

• Use Enter to finish the specification of the distances from the reference point. 

• Define a new basis point to establish the length of the sides as well. (point 1) 
Define the vertices next to it and their distances from the basis point. 
In the example given the length of the side defined by points 1 and 2, and that of the side defined by points 1 
and 3 are established. 

• Continue the selection of new basis points until you have defined all the measurable sides. The new basis 
point is point 3 and establishes the length of the side defined by the points 3 and 4. 

• Use Enter to finish the specification of the points 

• Use Enter to finish the specification of the basis points 
 
In the example given the length of the side defined by point 2 and 4 are established. 

•  
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Method of Fixed nodes and method of Fix structures 

The application of the following two methods are recommended when 
 

� a certain part of the room has the required size and shape and you do not wish to modify them or 
� the shape of the room is too complex with too many nodes to use diagonal measuring in one step. 
�  

Use the following algorithm in these cases: 
 

� Perform diagonal measuring by nodes for the given part of the room. 
� Select the Fixed nodes or Fixed structures option in the dialog box and turn on By triangles or By nodes option at the 

same time. 
� Fix the already accurate nodes or structures. 
� Perform the diagonal measuring using the triangle or the nodes method for the unfixed nodes of the room. 

Fixed nodes 

 
 
You can fix points selected from among the corners of the room. These points will keep their coordinates. 

 

• Besides enabling the Fixed nodes option enable either the By triangles or the By nodes option as well. 

• Select the contour of the room to be modified. 

• Select the nodes to be fixed.  
Press Enter to complete the selection of the nodes. 

• Perform the diagonal measuring with the help of the chosen method for the unfixed nodes of the room as 
well. 

Fixed structures 

 
 
You can fix a previously selected part of the room contour so that the internal nodes of the fixed structure keep their 
relative position but the structure itself can be moved. 
 

• Enable the Fixed structures and either the By triangles or the By nodes option. 

• Select the contour of the room to be modified. 
Define the structure to be fixed: 

• Select either of the endpoints of the fixed part (point 1). 

• Select the other endpoint of the part to be fixed (point 2). 

• Select an internal point of the fixed part (point 3.). 

• Repeat the commands to fix further structures, or 
Press Enter to complete the selection of fixed structures. 

• Perform the diagonal measuring for the unfixed nodes of the room using the chosen method (By triangles or 
By nodes). 
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Measuring diagonals and sides 

 
 
Only the reference point remains fixed. The undefined lengths are picked up from the drawing. 
You can measure the defined sides by the application of the By nodes method. 

Eliminating measuring inaccuracy when using the By nodes method 

On-the-spot surveys often lead to inaccuracy. The program offers an iteration method to eliminate this problem. This 
method is based on the over definition of the room survey. You need to specify at least a number of n-3 diagonals (n 
referring to the number of the sides of the room) to define the accurate geometry of a room. If the number of diagonals 
surveyed exceeds n-3, the room is over defined. 
 
When applying the survey method the program will indicate the measuring inaccuracy following the specification of the 
diagonals. 
 

 
 
The dialog box offers a tolerance value for acceptance. You can either accept the suggested value or continue the 
application of the operation for another diagonal. 
If you are sure that the specified wall or diagonal length is accurate, you do not need to change it, however, for other walls 
or diagonals you can set the allowable tolerance value yourself. This method of approach allows for the elimination of 
inaccuracy with regard to the triangles. The tolerance value of measuring inaccuracy is 1 cm for the survey, so you can 
create the geometry of the room within the accuracy of 1 cm. In case the tolerance value of 1 cm is not sufficient and the 
measuring inaccuracy exceeds it, it is recommended to perform the survey of the room in question again. If you do not 
repeat the survey, you can increase the tolerance value, this way allowing the acceptance of less accurate survey values. 

 Move, add, or delete corner point 

You can move, add, or delete any selected room node with the help of this icon. 

Moving a corner point 
You can change the position of any corner point in the active room. 

Adding a corner point 
You can add new corner points to the sides of the selected room. 
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Option: 

POLYLINE You can add a polyline as a new part of the room. This is 
a quick way to insert new wall nodes. 
You can use either the option or the TAB button for this 
end. 

Delete a corner point 
Select the DELETENODE option to delete a corner point. 

 Straight wall - Arc wall 

Using this command, you can do the following modifications: 

Arc wall � Straight wall 

• Specify a straight wall to transform it into an arc wall. 

Straight wall � Arc wall 

• Specify a straight wall to be transformed. 

• Specify a point. The arc wall will cross this point. You can also select one of the options. 

• Press Enter to complete the command. 

Options: 

DIAMETER Value of the diameter 

RADIUS Value of the radius 

PERIMETER Value of the perimeter (arc length) 

ARC Value of the cord height of the arc 

 Placement of doors 

You can use this command to place openings on a point in a distance specified from the wall endpoint. To use this 
command first you have to specify the type of the opening and its properties. 
 

• Specify a room wall where you wish to place a door. 

• Enter the distance between the reference point of the door and the closest node. OK. 

• Click on the door to specify the opening direction.  

• Press Enter to complete the modification of the opening direction. 

• Press Enter to complete the command. 

 Connecting rooms by doors 

You can connect two rooms by specifying a door in case the wall separating the two rooms has a constant thickness. First, 
you have to place the door in both rooms the same way as they are in reality. You also have to specify the wall thickness. 
The program will connect the two rooms by the door. 
 
You can also modify the walls separating the rooms subsequently. You can create walls of not constant thickness by 
moving or adding nodes. The properties of the door connecting the two rooms do not change so you can simply connect 
the two rooms after the modification of the wall structure. Use the Room shortcut menu - Connect door/window command 
or the Building menu - Survey – Connect rooms by doors command. 

 
• Specify a door to connect the two rooms. (door 1) 

• Specify the identical door in the other room. (door 2) 
Specify wall thickness. 
Press Enter to complete the command. 
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•  

� Use  the Connect rooms by reference points command if the thickness of the wall separating the rooms is not 

constant  

 Connecting rooms - By reference points 

You can use this method of connecting rooms when the thickness of the wall separating the rooms is not constant. To 
apply this method you need two reference points in both rooms and the distances of the corresponding reference points. 
You can specify the reference points in the rooms by the Shortcut menu - Define reference points command. You also 
need a door connecting the two rooms through which you can measure the distances of the corresponding reference 
points. 

 

• Specify a reference point in the room not moving. (P1) 

• Specify a reference point in the room moving. (P3) 

• Enter the distance of P1 and P3. (L1) 

• Specify another reference point in the room moving. (P4) 

• Enter the distance of P1 and P3. (L2) 

• Specify another reference point in the room not moving. (P2) 

• Specify another reference point in the room moving. (P4) 
Enter the distance of P4 and P3 (L3). 

 
The program connects the two rooms. 
If you are not satisfied with the result, activate the same command again and you can restart the process of connecting 
the two rooms. 

 Creating an outer wall 

The program creates an outer contour parallel with the walls, using the value of wall thickness. The result is a special new 
room called “an outer wall”. 
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If the wall thickness between the different rooms exceeds the double of the distance between the outer contour and the 
wall the program draws two or more separate outer contours around the rooms. This is when actually the building is 
created which already has a 3D model. 
 

• Enter wall thickness. 

• Specify the room around which an outer wall is to be constructed, or 
Press Enter to specify each wall. 

 

 Dividing a room 

You can use this command to divide an active room into two new rooms with a wall of defined thickness. You can also 
specify the name of the new rooms. 

 

• Enter wall thickness. 

• Specify a room. 

• Specify the first point of the dividing wall. 

• Specify the second point of the dividing wall. 

• Enter the name of the new room. Press Enter. 

• Specify the direction of the text or press the Enter button and place the text on the drawing.  

•  
Enter to complete the command. 

 

 Defining reference point 

When drawing a room you may need some fixed points to serve as general reference points. You can use these reference 
points when you connect rooms or when you transfer a straight wall into an arc wall. You need special measuring to fix 
these reference points. 
In the case of an existing building with a fixed reference point, survey the distances of the reference point from the two 
corner points of the wall. 
These distances and the distance between the two corner points create a triangle, which helps to clearly establish the 
reference point on the drawing. 
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• Select the command from the Shortcut menu. 

• Specify the room where you wish to fix a reference point. 

• Specify a wall node in the room. (point 1) 

• Specify another wall node in the room. (point 2) 
You can define the reference point as the third vertex of the triangle with the basis line defined by the two wall nodes 
previously specified. (by points 1-2) 

• Enter the length of the first side of the triangle. (2.0 m) 

• Enter the length of the second side of the triangle. (3.0 m) 

 Transforming into a wall 

After asking for the confirmation of the transformation, the program transforms each surveyed room into individual walls. 
 
This command is especially important in cases where you would like to continue drawing after the completion of the 
survey, e.g. you want to connect a new part to the surveyed building. Although the walls of the surveyed building have a 
few general properties, to individual walls you can apply all the wall editing functions. (You can create a layered wall 
structure, you can specify both longitude and cross-sections of wall profiles, you can place individual doors or windows on 
the drawing, or create sills and chamfers, etc.) 
 
You can set the status of the walls of the 
surveyed building that have been transformed 
into real walls in the Wall properties dialog box: 

� Existing wall 
� Wall to be demolish  

 
When you renew or expand a building, this option allows you to distinguish between existing walls and walls to be 
demolished in the plan by applying different colours. Walls to be demolished are not displayed in the 3D view. 

1.112.3. Edit and modify rooms  

You can activate further editing, modifying and other survey-related commands from Shortcut menu: 
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 Editing - Adding arcs 

Using the given radius this command rounds off the selected room corner. 

 

• Specify the room node to be rounded off or select one of the following options: 

Options: 

RADIUS Modifies the value of the given radius.  

DIAMETER Modifies the value of the given diameter. 

 

• Enter the new value, and then specify the room corner to be rounded off. 
Enter Completes the command. 

 Editing - Changing length I 

You often need to modify the wall length according to the survey results. The program has several methods to accurately 
establish, for example the length of the outer wall, in case of an external survey.  
The first type of Change length modifies the length of the specified wall based on the triangle method. In this case, the 
next wall only changes its direction but not its length. 

 

• Click on the side to be modified. The dialog box appears and indicates the original length of the wall. 

• Enter the absolute or the relative value of the new length. 
Enter Completes the command. 

 Editing - Changing length II 

This command changes the length of the specified wall without changing its direction. The wall next to the specified one 
follows the moving node and both its length and its direction change. 

 

• Specify the side to be modified. The node closest to the place where you have clicked on will move while the 
other node will not change its position. 
The dialog box shows the original length of the wall. 

• Enter the absolute or the relative value of the new length. 
Enter Completes the command. 
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 Editing - Joining 

This command joins two rooms by specifying the mutual wall between them. The length of the mutual wall must be the 
same on both sides. 
The command joins the two rooms together to be one. The names and areas of the rooms as well as the doors or 
windows - if there are any - are transformed accordingly. The name of the new room keeps the name of the first room. 

 

• Specify the side of the first room to be joined to the adjoining room. 

• Specify the appropriate side of the second room. 
 
The command unites the two walls. 

 

 Editing - Renaming 

This command renames the specified room. 

 

• Select the name of the room from the list in the dialog box. 

• Enter the new name in the name field. OK. 

 Editing- Placement of the name 

This command places the indication of the name of the room to the required position. 

 

• Specify a room to replace its name. Select the AREA option if you want to move the indication of the room 
name together with the indication of its area. 

• Specify the direction of the text and press the Enter button. Place the text onto the drawing. You can also 
select any of the options. 

Options: 

Tab Press Tab to pick up an object angle.  

POPMENU Select one of the options in the Text specification pop 

menu to define the direction of the text. 
 

Enter Does not change the position of the text on the drawing. 
Enter Completes the command. 

 Editing - Room hatching 

This command applies a special hatch pattern to the specified room by applying the given hatching properties. The walls 
are automatically considered to be the boundary of the new hatch area. 

 

• Specify a room. 
Enter Quits the command. 

 Editing - Wall hatching 

This command automatically applies a hatch pattern to each wall by applying the given hatching properties. 

 

� You can activate the specified room by the Ctrl+T button combination. You can modify the properties of the active room 

(wall) by clicking twice on its hatch pattern. After the modifications use the Tools - Deactivate command. 



 16. Add-On 1035 

ARCHLine.XP® 

 Editing - Delete hatching 

This command deletes the hatch pattern of a specified room/wall. 
 

• Specify a room/wall to delete its hatch pattern. 
Enter Completes the command. 

 Creating an outer wall by selection 

You can transform an existing profile into the outer contour of a room. 
First, you have to draw a closed profile around the room using any of the Line, Polyline, or Arc 2D drawing objects. The 
Create outer wall by selection command can transform this shape into an outer wall. An error message is displayed if the 
contour line is not closed or its sections intersect and the transformation is not performed. 
 

• Select each object of an already existing profile or select the CHAIN option to specify an already existing 
chain. Press Enter to finish the specification, 
or 

• Press the Enter button and draw the outer contour directly, using lines and arcs. Press Enter to close the 
contour. 

 Connecting doors or/and windows 

With the following commands, you can connect doors or windows to the room or disconnect them from the specified walls. 
You can also use these commands if you have unconnected doors or windows in the room, however, you wish to create 
an outer wall. 
 

 

 Connecting doors or/and windows - Connecting all the doors or/and windows 

After connecting the rooms and drawing the outer contour of the building, you can connect the doors and the windows to 
the outer side of the wall. This command automatically connects each door and window to the wall. 

  

 Connecting doors or/and windows - Connecting one door or window 

This command connects the selected door or window to the wall. 
 

 Specify a door or a window to be connected to the wall 

Enter Completes the command. 

 Connecting doors or/and windows - Disconnecting one door or window 

This command disconnects the specified door or window from the dividing wall or from the outer wall. 
 

• Specify a door or a window to be disconnected from the other wall. 
Enter Completes the command. 
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 New window 

You can place a new window in the surveyed building in a distance specified from the corner point of the wall. First, you 
have to select the appropriate window type in the Window properties dialog box. You can move the selected window to 
the required position with the command in the Shortcut menu. 

 Data 

It is very important to be able to query the survey data when drawing the survey plan. 
 

� Both Toolbox – Reconstruction tool – Data - Building calculation command and Add-On menu - Quantity Take-Off - 
Building calculation command displays the same dialog box. 

� The Wall numbering command facilitates the use of the list by making it possible to clearly identify the values of the list. 
� The Wall dimensioning command is a quick way to see the length of the walls. 
� After application, you can also delete wall dimensioning. 

 

 

 Data - Building calculation 

The program creates two types of lists. 
The first list contains the values of the rooms in the drawing, that is: room name, floor name, room area, room capacity, 
and room perimeter, the size of the surface to be illuminated and its proportion to the total wall surface, and the total area 
of the rooms. 
 

 
 
The detailed list displays the values related to each wall in each room, that is: wall numbering, wall height, wall length, and 
gross and net wall surface. The gross wall surface consists of the net wall surface and the area of the openings. 
 

 
 
These lists can be displayed in the drawing area, as well as printed, or exported into Word or Excel. 

 Data - Wall numbering 

This command numbers the outer and inner walls. The objects are displayed in the lists of building calculation according to 
this numbering. 



 16. Add-On 1037 

ARCHLine.XP® 

 

 Data - Deleting wall numbering 

This command deletes the numbering of the wall in the drawing. 

 Data - Wall dimensioning 

This command automatically measures the length of each wall in each surveyed room to facilitate dimensioning. The 
values are indicated parallel to the walls. 

 

 Data - Delete wall dimensioning 

This command deletes all the indicated values in the surveyed room. 
 

1.113. Reconstruction - Photogrammetry  

1.113.1. Introduction 

The topic to be discussed in this part is Photogrammetry. You find the commands in the Add-On menu - Survey – 
Photogrammetry and in the Reconstruction toolbox 
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Photogrammetry 

In architecture, photogrammetry means the proportional documentation of building fronts. 
This documentation provides the data necessary for the calculation of reconstruction or rebuilding costs, and makes 
possible to create the plans. 
Without photogrammetry, surveying and drawing building fronts, frescos or different architectural objects would be the 
most time-consuming and costly tasks in architecture. 

Photograph 
A photograph is used to survey the object to be documented (a building). 
The photograph always implies a perspective, even if we have a front view photo of the object. As a reference document, 
you can use a traditional photograph or an image taken with a digital camera. In the former case, you must scan the photo 
to create the image file. The extension of the file can be .jpg, .bmp, or .tiff. 
 
With perspective calibrating the photogrammetry tool of ARCHLine.XP enables you to make the photograph proportionate, 
so that later on you can work on the image. This way, with the help of the photographs, the measured values and the 
photogrammetry tool you can reconstruct damaged buildings, parts of buildings or other objects, of which no plans or 
drawings are available. 
 
Practical advice 
It is advised to mark the selected points on the building so that they can be recognized during calibration. 
For the sake of precise measurements, we suggest that you use calibration points located at the sides of the photograph. 
To get even more precise values you should define distances that represent 70−80% of the base or the height of the 
photograph. 

Overlay image 
The next step is loading the image file. With the Drafting menu − Insert raster images command you can adjust the 
preferences of the loaded image file, i.e. the overlay image, and apply Perspective calibration. 

Perspective calibration 
The aim is to gather overall, proportionate measurements about the object during calibration, based on the measured 
distances and the photograph. 
With perspective calibration, you can proportionately represent in the Descartes coordinate system the points of that plane 
of the object that is displayed on the photograph. This way, you can define a complex transformation. 

 

I. Defining orthogonal view 

With this function, you can create – based on a perspective photograph – an orthogonal photograph, on which you can 
carry out the survey of a building front. 
 
In this case, the program transforms the original photograph into a proportional frontal view, which has the shades of grey, 
after you have defined the following: 

� a horizontal and a vertical distance, and  
� At least two horizontal and two vertical directions. 
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II. Finding edges 

This method is used in particular when you have to carry out a quick survey and there are complex forms, decorations or 
stonework on the frontal view. The Find edges method means that the program recognizes the edges of the object 
displayed on the photograph by identifying the shades of grey. Therefore, with this method you can demonstrate the 
frontal structure of the building. Naturally, the Find edges method does not substitute drawing the frontal view plan, but it 
can supplement it. 
 
We recommend that you use this method if you wish to carry out a quick survey, but there are complex forms, decorations 
or stonework on the building front. 
The Find edges function means that on the orthogonal photograph the program recognizes the edges by distinguishing 
between the different shades of grey. This way we can demonstrate the frontal structure of a building. Of course, this 
method cannot substitute drawing the frontal view plan, but it can supplement it. 
It is best to use a photograph on which the edges, sills etc. on the building front can clearly be distinguished, and which 
contains the fewest possible shady areas, because these can be considered edges by the program. 
 

 

1.113.2. Define orthogonal view 

To define an orthogonal view you need to define the following: 
 

� a horizontal and a vertical distance, specifying the dimensions of the orthogonal photograph, and 
� at least two horizontal and two vertical directions, to calculate the focus points, 
� a diagonal, to select that part of the image you wish to display on the orthogonal view. 

 
Following these steps, the program transforms the perspective photograph into an orthogonal view. 
 
The function is demonstrated on the photograph of a tower (campane.jpg). 

Defining horizontal lines: 

 

• Select the raster image. 

• Define a line on the photograph that 
is horizontal in real. 

• Specify the length of the line (the 
width of the tower: 6 m) 

• Define at least two more horizontal 
lines according to the figure. After 
this, the program asks you to define 
the distances again. If you do not 
know the precise numbers, tick the 
Distance unknown option. 

• Enter Completes the definition of 
horizontal lines. 

Defining vertical lines 

• According to the above figure, draw the vertical line at the edge of the column that is between the two string 
cornices. 

• Specify the length of the line: 5.5 m. 

• Define at least two more vertical lines, according to the above figure. 

• It is not necessary to define distances. 

• Enter Completes the definition of vertical lines. 
 
When you define a direction with horizontal and vertical lines, in order to get a more precise result, draw these lines longer 
than they are in real life. You can be even more precise if you zoom on the photo when tracing the lines. 

Defining a diagonal 

Select the part of the image you wish to display on the orthogonal view by defining the diagonal. 
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• Draw a diagonal from the bottom left corner to the top right corner of the photograph. As a result, the front 
view of the tower will be fully visible. 
 

� To display only part of the photograph in frontal view, you should draw the diagonal only on the part you wish to display. 

In this case, the rest of the image will not be visible. 
 
When you have finished the definition, the program creates the orthogonal image of the tower. The easiest way to check 
the accuracy of your work is to press Shift and draw actually horizontal and vertical lines along the most visible horizontal 
and vertical sides and edges on the photograph. 
 

 
 

� The program creates the orthogonal photograph under a new name, CAMPANEOrto.jpg, and saves it in the project.  

Creating a frontal view plan 

The frontal view of the tower has 
become proportional during the 
transformation process, so you can 
measure real values. Each object you 
draw on this image with the help of the 
geometrical drawing tools will 
correspond to the original dimensions 
of the tower. 
 
After defining the orthogonal image the 
Perspective – Frontal transformation 
command becomes active. 
 

• Switch off the transformation by 

clicking on the  camera icon in 
the Photo toolbar. 

• Trace the contours of the image on 
the frontal view image. This way 
you get the frontal view plan of the 
building. 

 

1.113.3. Find edges – General 

Drawing building fronts is a very demanding and time-consuming task. The Find edges function of ARCHLine.XP offers 
two possibilities to facilitate this work. The Find edges – general function distinguishes every line on the photograph by 
recognizing the different shades of grey. 
 

• Select the raster image. 
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The Automatic line recognition on orthogonal photo dialog box appears. 

 

General 

• First, specify the general properties (colour, layer, line type). 
It is recommended to choose a colour that is distinctly visible on a grey photograph. 
 
Assign separate layers to the edges you have found. 

Find contours 

• The smaller value you determine for new lines minimum length, the more lines the program will draw. We 
suggest you set 0 as minimal length. 

• The pixel neighbourhood gravity for line value should be the smallest possible, while the colour contrast 

sensitivity value should be the highest possible. 
The show lines as pixels option can be turned on or off. 
 

 

• Click OK when you have defined all 
the properties in the dialog box. The 
program begins the line recognition 
process. 
 
To be able to see the lines drawn on the 
building front better, display the drawing 
without the photograph. 
 

• Select from the photo shortcut menu 
the Frame / Show command. Then 
just the frame of the photo appears. 
 
The displayed image is a real vector 
graphics drawing, which can be enlarged. 
On this image you can continue drawing 
your building front, by using any 
geometrical objects. 

1.113.4. Find HV edges 

Find HV edges are very similar to the previous command. The only difference is that in this case the program only 
searches for the horizontal and the vertical lines on the drawing. 
 
 



1042 16. Add-On 

Manual 

1.114. Animation 

Introduction 

The Animation module of ARCHLine.XP makes a film in .avi format by sequencing rendered images. 

1.114.1. Creating animation by path 

To create animation you need a path to be followed by the camera and you also have to define the target point in each 
point of the path. 
 
The animation will be created with the following method: 
 

� Definition of the animation path by spline. 
� Setting the timeframe of animation and the number of frames. 
� Graphical adjustment of the path: moving, inserting and deleting nodes. 
� Setting viewpoints and target points on the basis of display when viewing the animation. 

Setting correct timeframes and refining animation. 
This is facilitated by the DirectX technology. 

� Creating animation: making the AVI file. 
 
For this method, you can use the commands in the Add-On menu – Animation submenu or in the Define path submenu: 

 Defining the path 

You can specify a 3D animation by the definition of the following data: 
� default height of camera path, 
� places of viewpoint/observer, 
� the target point/observed object in the individual viewpoints, 
� the height of the observer and the target points (e.g. always changing in the case of stairs). 

 

• Specify the default height of the animation path; each point of the path will have the same height. 

• Give the observer’s path by defining the points of the spline. The spline can be open or closed. In the case of 
closed path, select the CLOSED option. 

• Enter Closes the path. 

• Define one by one the location of target points in the case of each viewpoint. 

� For details, see Chapter 11.2.9.  Spline. 
 
The program will show the current observer and target points of the path. 
 

• Select a viewpoint with a 
target point to be modified 
and define the location of the 
new target point. 

• Select the next viewpoint, or 

• Enter completes individual 
modification. 
 
The Animation path dialog box 
will appear, showing the height of 
the viewpoints and target points: 
 

 
 



 16. Add-On 1043 

ARCHLine.XP® 

 
 

• Select the observer/target points with the heights to be modified. 

• Type the new values in the appropriate fields. 

• Click on the Edit selection button. 
If you select multiple observer/target points, the program will assign the value given to each selected point. 
If you want to adjust value only, you can type in that value directly in the Observer height/Target height field. 

• OK Closes the dialog box and ends the command. 
 
The animation path has been completed and you can modify anytime afterwards: 

 Settings of animation 

Picture 

After creating the animation path, you have to specify the length of time and the number of frames of animation per 
second. 
 

• Choose the animation path. 
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• Type the length of animation in seconds. 

• Type the number of frames of animation per second. For real film, this value is between 25 and 30 images. 
With this number of images can perceive as a film. Under 25 frames per second, the film is broken. 

• Type the value of the Camera angle. 

Image polygon limit (Face limit) 

You can watch the animation in 3D view window before finishing the creation, that is why the setting of Image polygon limit 
is very important. You can reach the image polygon limit (Face limit) through Build 3D model dialog box too. 

� For details see Chapter 13.2.1. DirectX settings. 

 Adjusting node height 

• Select the animation path. 

• In the appearing dialog box, as in the case of definition, select the points with the height to be modified and 
set their new values. 

 Graphical adjustment of the path 

To adjust the path graphically, use 
the commands 
 

� Move node 
� Add node 
� Delete node 
� Move destination point. 

 
You can access these commands 
in the Add-On menu – Animation 
submenu or in the Shortcut menu 
of the path. 
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 Move node 

With this command, you can modify 
the place and height of observer 
and target points. 

Changing the place of observation 
points. 

• Select the animation path. 

• Select the node to be relocated. 

• Define the place of the new 
node. 

• Enter closes the modification of 
observation points. 

 
 

In the figure you can see the observation and target points. 

Modify target points + height. 

• Select the observation point with the target point to be modified. 

• Specify the new place of the target point. 

• Specify the height of the selected observation and target point: 

• Select a new point pair, or 

• Enter completes modification. 

•  

� You can run the Move node command by first selecting the animation path, then clicking on a node, and selecting the 

node to be moved and defining the new place for the node. 

 Add node 

With this command, you can add a new observation point to the animation path. You can modify the place of the 
corresponding target and you can also define the height of the new pair. 
 

• Select the animation path. 

• Select the edge of the spline where you want to add a new observation point. 

• Specify the place of the new observation point. 
 
The observation and target points now appear. 

Modify the place of target points + height. 

• Select the observation point with the target point to be modified. 

• Specify the new place of the target point. 

• Specify the height of the selected observation and target point: 

• Select a new point pair, or 

• Enter completes modification. 

 Delete node 

With this command, you can delete an observation point from the animation path. 
 

• Select the animation path. 

• Click on the node to be deleted. 

• Select another node to be deleted, or 

• Enter Completes the command. 
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 Move destination point 

With this command, you can modify 
the place of the target points. 
 

• Select the animation path. 

•  
In the figure you will see the 
observation and the target points. 

•  

• Select a target point and move 
it to its new place. You can 
move multiple target points if 
you want. Enter. 

• The Animation path dialog box 
will pop up where you can 
modify observation and target 
point height. 

 

 Animation preview 

After defining the animation path and making graphical modifications open the preview of the animation where you can: 
 

� Play the animation promptly. 
� Set animation time. 
� With the perspective setting on key frames you can fine tune the spatial location of the observation point and the target 

point. 
� You can record the animation. 
�  

• Select Add-On menu – Animation – Preview command and select the animation path. 
The Animation editor window will appear. 
 

 
 
The Animation editor window is made up of different parts: 
 

� Animation settings 
� Time line 

The timeline toolbar belongs to the bottom of the animation window. 
� Player toolbar 

 Animation settings 

Before playing the animation, you have to define the timeframe of the animation and the number of frames per seconds. If 
you click on the gear icon, the Animation settings dialog box will appear: 
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If you failed to set parameters with Add-On menu – Animation – Animation settings command, you can set these values 
here. 

 
 

• Type in the length of the animation in seconds, then 

• Type in the number of frames per second to be created. In the case of real films, this number is between 25 
and 30. The human eye would see it as a film. Under 25 frames per second, the image will be jerky. 

• Set the visual angle of the camera. 

• Image polygon limit: The setting of Image polygon limit is necessary here, because you can see the animation 
in Image 3D window before creating. 
 
Polygon limits set here will concern motion only. If you do not have a high performance graphic card, you should enable 
polygon limit to avoid the slowdown of the model. 

Playing the animation 

After setting the animation path, you can play the definition. 

To do so, click on the Player toolbar –  Play icon. 
The animation will be shown in the frame. You can check this with the blue indicator in the timeline. 

Timeline 

The timeline expresses the total length of the animation in seconds. This corresponds to the timeframe you entered in the 
Animation settings dialog box. 
If you have failed to set a timeframe, the program will assign to each path section (edge between the nodes of the spline) 
1 second, and 25 frames to each second. 
 

 
 
The green dots in the timeline are key frames corresponding to the nodes (spline nodes) of the path. 
 
The image frame will always show the status corresponding to the position of the blue slider. You can move the blue 
slider in different ways: 
 
Click on any point of the timeline and the blue slider will jump there and the model will take the corresponding status. 
Use the Arrow icons of the Player toolbar to step or to jump to the next frame in the timeline: 
 
Move 
You can move the timeline toolbar as a floating window anywhere on the workspace. To move the bar, move the mouse 
over the grip point on the right side and left click and drag it to where you want to place it and release the mouse button. 
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Resize 
Move your cursor to the right size of the window. You will see the cursor change appearance. Hold down the left mouse 
button and drag the window to the size you want, and then release it. 

 
 
Restore 
You can restore the timeline toolbar to its factory default state with a mouse right button click on the grip point. 

 

 

Player toolbar 

 
 

Besides playing the animation, you can use the icons of the Player toolbar to step in the animation and to launch the 
creation of animation. The meaning of the icons is the following (from left to right): 
 

� Jump to first frame 
� Jump to previous key frame 
� Jump to previous frame 
� Stop animation 
� Play animation 

� Jump to next frame 
� Jump to next key frame 
� Jump to last frame 
�  Create animation with photorealistic 

rendering, 
� Create animation with quick AVI 

rendering 

Setting animation time section by section in the path 
You specify the total animation path time when setting the animation. The program distributes that total time evenly among 
the path sections. 
 
You can modify the time intervals of the individual path sections. You can do this in two different ways: 
 

� Redistribution of the total timeframe 
� Time by path sections  

Redistribution of the total timeframe – Sliding key frames 

• Click on a key frame in the timeline. The green dot representing the key frame will turn into a double arrow. 

• Hold the mouse button and 

• Drag the key frame. 
 
Now you have modified the time relating to the path section before and after the key frame. The total timeframe did not 
change, only the distribution of time related to the two path sections. 

Time by path sections – Right-click on the key frame 

• Click on a key frame in the timeline. The green dot representing the key frame will turn into a double arrow. 
Right-click the double arrow. 
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You can define the time of the path section before the key frame in the dialog box popping up. This will not influence the 
next interval, so the total timeframe of the animation may be affected. 

Relocate the observation point and the target point 

 
� On key frames, the perspective-setting icon appears and you can fine-tune the spatial location of the observation point 

and the target point. 

 
 
The changes will be applied on the animation path on the floor plan after closing the Perspective setting dialog. 

1.114.2. Create animation 

After playing the animation several times and performing the necessary adjustments, the final step is to create the 
animation: 

! Please note that the Animation editor window is not saved into the project. 

 Quick AVI rendering 

Add – on menu – Animation – Preview animation editor is extended with a quick AVI rendering command (camera icon). 
This command creates an animation video in AVI file format. The quality of the video corresponds to the 3D representation 
(wireframe, hidden lines, textured, x-ray view etc.). 

 
 

• Enter the name and path of the animation file. The file will be in .AVI format. 
 

� There is no need for Rendering Module to use quick AVI rendering command. This tool is based on the settings of the 

active DirectX or OpenGL 3D window. 

 Create animation by rendered images 

Use this command to start creating animations. 

 
 
In the Rendering dialog box set animation parameters: 
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• Click on the Final Rendering button. 

• Enter the name and path of the animation file. The file will be in .AVI format. 
 

• Set further rendering parameters;  

� See Chapter 13.1 Rendering for their detailed description. 
 

• Click on the Start button. 
 
After creating the first image, the program will ask to select the video compression method you want to apply. 
 

 
 

� You can select the uncompressed file format if you want. This will work with all computers; however, the size of the AVI file 
will be extremely large. 

� You should select a compression method, which is available in your operating system. For example, you may want to use 
Indeo video codec. 
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! You can download codec’s from the Internet. Please note, that if you copy your films to other computers, they must have 

the codec’s you used to be able to play the films! 
 
The program will create your rendered images according to the values entered. 
When creation is finished, close the last window. 
Find the saved .avi file with Windows Explorer and double-click to play the film. 

 Create Partial animation 

You can record a part of the animation from key frame to key frame. Press CTRL and mouse left click over the timeline 
and drag it to the required key frame and release the mouse button. The selected part will be highlighted. 
 

 
 
 This function is useful when you record relatively big video over 30 seconds or more. 
 

1.114.3. Virtual reality 

With the virtual reality tool of ARCHLine.XP the program creates a virtual reality out of the rendered image of the 3D 
model, having a *.mov format. 
Unlike the .avi format, this display tool creates an apparently still picture, where you can move with the mouse among the 
pre-set camera positions. 
You can activate the completed virtual reality with Quick Time Player, and then you can move the camera, or take a look 
around in the virtual model. 
 
To activate the command, select Add-On menu – Animation – Virtual reality. 
 

! Before starting to create the virtual reality, do not forget to set perspective. The virtual reality tool of ARCHLine.XP will 

consider the view set in the perspective. 
Quick Time Player is available on http://www.apple.com/quicktime/download/ 

 
You can run this command from the active 3D window; you can set the properties of the virtual reality in the Virtual reality 
dialog box appearing after the launching of the command. 

Defining the parameters of horizontal motion 

� Horizontal camera angle:  
This angle refers to the interval of horizontal camera movement; the viewpoint is always in the centre of the interval. For 
example: a 20º interval means that the visual angle is 10º on both sides, i.e. left and right. 

� Number of frames: set the number of frames within the horizontal motion angle of the camera. If you increase the number 
of frames, camera movement slows down and the film quality will be better and smoother; however, this will increase the 
film making time. 

� Auto repeat: if this option is disabled, object movement will be jerky. This means that the film ends at the end of the actual 
visual angle and you can move the model in the opposite direction with the mouse. 
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� If this option is enabled, the motion of the model will be continuous, so if you move the mouse at the end of the visual 
angle, the film jumps back to the starting angle and will repeat motion within the given angle. 
Auto repeat gains its significance if the angle of the motion is 360º. In this case, motion will be uninterrupted, and if you 
move the mouse, you can go back from the last frame to the first frame automatically; you can walk around the model this 
way. Auto repeat is very useful for the rendering and visual inspection of indoor spaces. 

Defining the parameters of vertical movement 

These values refer to the vertical movement of the model. They correspond to the horizontal parameters in respective of 
their adjustment and other properties. For a detailed description, see Heading Defining the parameters of horizontal 
motion. 

Compression 

Define the size and the quality of the film. The higher the value of compression is, the smaller the size and the poorer the 
quality of the created film will be. 

� Max. Compression 
The size of the film is small, but its quality is poor. 

� Min. compression 
large size, but good quality. 

� No compression 
this option allows for the best quality, but the size of the film is the largest in this case. 
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Moving 

The different figures of the dialog box indicate the movement of the camera and the object. By selecting from the three 
figures, you can decide what to move in the picture: the camera, the object without the Sun, or the object with the Sun. 
Select one of the three options: 
 

 

The camera position will remain the same the whole 
time but the camera will be rotated around its own 
axis. This option corresponds to the situation where 
you are standing in a room and look around. 
The Sun does not move relative to the object therefore 
the shadow will not change. 

 

The camera moves around a static object. It resembles 
the way planets are orbiting the Sun. 

 

Compared to the previous option, here the position of 
the Sun is changing relative to the object. The angle 
defined by the camera and the Sun will not change. 

File name 
Specify the name and the path of the .mov file. You cannot continue your work without defining the name of the file. 

Rendering parameters 

 

 
 

• Click on the Settings button, then 

• Define the rendering parameters in the Rendering dialog box. 

•  

� See the description of the Rendering dialog box in Chapter 13.1. Rendering. 

1.114.4. Solar access protection  

Introduction 

The ARCHLine.XP provides a great opportunity to survey the solar access of the building or its rooms. The 
advantage of the function is that it is prepared in clear graphical form, which is easy to survey and with its help we 
can support the proper solar access of the designed building’s room.  
 
In case of not proper solar access (because of the parameters of the building or the place), you can make a decision 
about modifications according to the prepared model. 
 
Further advantage is that you can use the Solar access in any phase of designing. So you can prepare the building 
with equal efficiency on the volume model, on the sketch plan or on the authorization plan and on the working 
draw. 
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Information 

Before using the solar access, shadow analysis functions, it is worth knowing certain rules and features. 

Calculation basis on 3D model  

The shadow graphic is prepared according to the information of actual 3D model of the project. It is important now 
to mention, that the ARCHLine.XP can represent and hide certain parts of the model according to the user settings. 
Before using the solar access function, it is worth making sure, that the 3D model has all the information or you 
have to refresh it with other settings. 

Appearance 

The appearing of the solar access depends on the set representation features. You can represent colour or black sketch 
depending on that you need spectacular or technical draw. 

How to use 

Before use you have to activate the 3D model window, in which you want to prepare the solar access analysis. It is 
important, that you can make the solar access analysis draw only in the 3D window. Because of the complexity of 
the calculation, the drawing doesn’t follow the model changing, and the changing of the 3D model view. So it’s 
worth setting in advance the 3D view, before the solar access analysis. 
 
Start the shadow analysis with the Add-On menu – Animation – Solar access command.  
 

 
 
Then the Shadow analysis window appears where you can determine the sun position, north direction and 
preferences of the created graphic, for example: Shadow, Shade, and Contour.  

 

Follow these instructions step by step: 
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Location, date, north 

You can determine the location, date and north, which is important for the shadow analysis 

Time setting 

The shadow analysis will be finished according to the here determined Start- and finish point and step.  

Line type on not exact hour 

You can determine, that the shadow contours between whole hours (for example 08:00 and 09:00) which line type 
will draw, if it is needed according to the interval time. 

Set name for time text 

When the shadow analysis is finished, on the shadow contours time points appear belonging to it for easier 
identification. You can select the set name for time text. 

Contour 

It determines the layer of the shadow’s contour.  

Shadow hatch background colours 

You can determine even two different hatch backgrounds. The first colour is the starting, while the second will be 
the finishing colour. If you determine two different colours, the program makes transition between the first and 
last colour. 

Hatch properties 

Set the shadow and the hatch properties. 
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On the example draw we used the Shadow with contour lines + hatches options, and in the Hatch properties 
window the Solid and Transparency option is switched on. 

Shading 

Because of the complex counting method of the function, it is offered to use the hidden lines. 

 

Types to colour 

Select those types of objects (wall, roofq) where the shadow appears. 

Types for making shadow 
Select those types of object (wall, roofq) which throw a shadow. 
Limiting the two groups, you can reduce the time consuming process of shadow analysis in case of a mass model. 

Shadow receiving surfaces 

In the Shadowing or shading dialog window, you can select the Shadow on selected surfaces only option. If you 
switch it off, the program prepares the shadow analysis on all surfaces of the model, which can take long time in a 
case of a complex model. If you switch the option on, then the program considers only the surfaces selected by the 
user. Select this option, if the shadow receiving surfaces are determined and their number is low. 

Face limit 

 
 
Switching on the option if the face number of the model is higher than the selected face number, the limitation is executed. 
It means that only the object with the selected face number is created.  

Creating shadow analysis 

After clicking on OK in the Shadow analysis dialog window, and selecting the shadow receiving surfaces (if the option is 
switched on), begins the shadow analysis and the process mark of the program informs about its actual state. (You can 
interrupt the counting by pressing the ESC.) 
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1.114.5. Shadow animation 

With shadow animation, you can create your films in accordance with the position of the Sun at a given geographical 
location. The viewpoint will be unaffected in the case of such animation, and the Sun will make its way according to the 
settings within the defined interval. 
To activate the command, select Add-On menu – Animation – Shadow animation. 
 
In the dialog box popping up you can set the properties concerning shadow animation: 
 

 

Location 

Select the city in the scroll down menu whose position you want to set. ARCHLine.XP will automatically display the image 
of the selected city with its longitude and latitude. 
If you want to add a new location to the list, use the Add button. 

Date 

Set the date for shadow analysis (month, day). 

Setting time intervals 

After giving the date, you have to define a time interval. This will be an interval within which the shadow analysis is 
performed. Use the Step option to define periods within an interval for the creation of images. The more frames you set 
(i.e. the shorter interval you define) the more realistic shadow analysis you get and it takes a lot more time to make the 
film, too. 

North 

Set the northern direction. The northern direction will be defined relative to the horizontal zero degree. To set the direction, 
enter the values or use the indicator. 
 

• use the OK button to close the dialog box, 
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• choose a 3D window for the selection of the desired 3D view, 

• Define the properties of rendering in the Rendering dialog box popping up. 
The format of the film will be .avi. 

� For the description of the Rendering dialog box, see Chapter 13.1 Rendering. 
 

� In the Render dialog do not forget to select the Shadow; otherwise, shadows will not be displayed in the film. 
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17. Virtual Home Staging 

Virtual staging is a fast, easy and economical way to illustrate the complete potential of a vacant property. 
ARCHLine.XP Virtual Staging transforms the 2D room photo into a 3D virtual showroom. 

 

        
 
Virtual Home Staging means the following 4 step creation process 
 

� Import and transform the room photo into a 3D virtual room 
� Clean the room of any disorder 
� Add furniture and other decorative elements. 
� Create the photorealistic image 

 

1.115. Importing room photo 

Select Interior / Virtual Staging / Import raster image command and load the image file (the picture of the room). The 
program automatically places it in the 2D floor plan. 
 

       

1.116. Transform 2D image into a 3D virtual room 

The next step is to transform the photo into 3D virtual room. 
Select Interior / Virtual Staging / Transform 2D image into a 3D virtual room command and click on the photo. 
 

� Select the method according to the photo: 2 or 3 visible walls you see on it.The working method is the same, the number 
of markers and distances to measure are different only. 
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Examples: 

        
Typical photo with 2 walls     Typical photo with 3 walls 
 

� Click on the blue dots and move them to the corner points along the vertical and horizontal edges on the room photo. 

 
 

� Assign all the required measurements and press Enter. 

 
 

� Select the first option in the pop-up dialog and let the software convert it into real 3D room. 
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� In some photos, it is difficult to find the parallel edges. In this case, it might be useful to prepare it with construction lines, 

with the following method. 
 1. Draw two lines along two clear visible edges on the same surface. 
 2. Trim both to find the focal point. 
 3. Draw the third line starting from the focal point and passes through the required point on the photo. 

  

1.117. Clean the room surface images 

The room photo is very rarely perfect to place new furniture. You have to “clean” it frequently to remove unwanted details.  
You can improve the quality using the following three commands: 

� Pick up the room photo 
� Clean the room photo. 
� Resave the room photo. 

 

Step 1.  

 

• Select Interior / Virtual Staging / Pick up the room photo command. 
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• Click on the wall or floor in the 3D view and place the texture layout on the view anywhere. 

  
 
 

        
 
Step 2.  

 

• Select Interior / Virtual Staging / Clean the room photo command.  
• Click on the photo layout and draw a closed polygon around the unwanted detail. 

 
 

• Click on a similar color pixel on the photo you wish to fill the polygon. The program fills the polygon with the selected 
color. If you are not satisfied with the result, you can repeat the color pick with a new click in a loop.  
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• Alternatively click on the color keyword on the floating menu and choose a color using the Color dialog. 

 
Step 3.  
 

• Select Interior / Virtual Staging / Resave the room photo command. 
• Click on the photo layout again. The program updates the texture with the modified one and replace the original 

automatically on the wall or the floor. 

 

 
 



1064 17. Virtual Home Staging 

Manual 

 
 
Step 4.  

 

• Drag it and drop the new furniture, fabrics, light, and other decorative elements in the floor plan or directly in the 3D 
window. 

• Change wall colors, floor or try to add a rug. 
• Create a rendering image. 
• Publish it for you clients. 

 

 

 
 

 

1.118. Refining perspective 
You can improve the room definition points or distances any time by selecting Interior / Virtual Staging / Refine 
perspective command. You can work with the same tools like described in the previous section. 
 

1.119. Rendering 
Use the rendering command to prepare the final image for your client. 
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